Contents

Volumes 1 & 2 i

Send Us Your Comments ............................................................................................................. xix

Preface ........................................................................................................................................... xxi

Audience for This Guide ........................................................................................................... xxi

How To Use This Guide ............................................................................................................ xxii

Documentation Accessibility ..................................................................................................... xxiii

Finding Out What’s New ........................................................................................................... xxiv

Other Information Sources ....................................................................................................... xxiv

Online Documentation ............................................................................................................. xxiv

Related User Guides ................................................................................................................ xxv

User Guides Related to All Products ....................................................................................... xxv

User Guides Related to This Product ..................................................................................... xxvii

Reference Manuals ................................................................................................................ xxviii

Installation and System Administration Guides .................................................................. xxix

Training and Support ................................................................................................................ xxxi

Conventions .......................................................................................................................... xxxii

Notational Conventions ........................................................................................................... xxxii

Text Conventions .................................................................................................................... xxxii

Do Not Use Database Tools to Modify Oracle Applications Data .......................................... xxxiii

About Oracle ........................................................................................................................... xxxiii

Your Feedback .......................................................................................................................... xxxiv
1 Overview

Introducing Oracle Advanced Planning Suite ................................................................. 1-2
Oracle Advanced Supply Chain Planning ................................................................. 1-3
  New ASCP Features ........................................................................................................ 1-4
Oracle Inventory Optimization ...................................................................................... 1-11
  New Inventory Optimization Features ........................................................................ 1-11
Oracle Global Order Promising .................................................................................... 1-15
  New Global Order Promising Features ....................................................................... 1-16

2 Setting Up

Setup Overview .............................................................................................................. 2-2
Deployment Configurations .......................................................................................... 2-2
  One-Machine Implementation .................................................................................... 2-2
  Two-Machine Implementation .................................................................................. 2-3
  Three-Machine Implementation .............................................................................. 2-4
  Four-Machine Implementation ................................................................................. 2-5
Setup Flowchart ............................................................................................................ 2-6
Setup Steps for the Source ............................................................................................ 2-7
Setup Steps for the Destination ..................................................................................... 2-13

3 Planning Business Flows

Business Flows .............................................................................................................. 3-2
  APS Information Flows ............................................................................................ 3-2
  The Demand-to-Make / Demand-to-Buy Business Flow ............................................ 3-3
  The Inquiry-to-Order Business Flow ......................................................................... 3-4
A Day in the Life of a Planner ....................................................................................... 3-5
Specify Sources of Demand .......................................................................................... 3-5
Run Collections ............................................................................................................. 3-6
Create a Plan .................................................................................................................. 3-6
Launch the Plan .............................................................................................................. 3-6
Review Key Performance Indicators (KPIs) .................................................................. 3-6
Review Exceptions ......................................................................................................... 3-7
Review Workflow Notifications .................................................................................... 3-8
View Pegged Supply and Demand ............................................................................... 3-9
# Running Collections for ASCP

4 Overview of Running Collections for ASCP ................................................................. 4-2

## Definitions............................................................................................................. 4-2

## Collection Strategy ............................................................................................. 4-3

- Multiple Source Instances ................................................................................. 4-4
- Pull Architecture ................................................................................................ 4-4
- Detect Net Change to Synchronize Oracle Applications and Oracle ASCP .......... 4-4
- Multi-Process Collection Architecture ................................................................. 4-4
- Data Consolidation .............................................................................................. 4-4
- Projects/Tasks, and Seiban Numbers .................................................................. 4-5
- Oracle Applications Version and RDBMS Version .............................................. 4-5
- Support for Several Configurations ..................................................................... 4-5

## Architecture ........................................................................................................ 4-5

- Supported Configurations .................................................................................. 4-7

## Collection Methods ............................................................................................. 4-10

- When To Use Each Collection Method ................................................................. 4-10

## Running Collections Steps ................................................................................. 4-12

## Data Changes That Can Be Collected in Net Change Mode ................................. 4-18

## Legacy Collection ................................................................................................ 4-20

## Process .................................................................................................................. 4-21

# Defining Plans

5 Overview of Defining Plans .................................................................................... 5-2

## Global Supply Chain Planning ............................................................................. 5-2

- Prerequisites for Running a Global Supply Chain Plan ....................................... 5-3
- Advantages of the Single Plan .............................................................................. 5-3

## Subset Plans .......................................................................................................... 5-9

- Pitfalls of Subset Planning .................................................................................. 5-10
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choosing Between Global Supply Chain and Subset Plans</td>
<td>5-12</td>
</tr>
<tr>
<td>Choosing a Plan Type</td>
<td>5-14</td>
</tr>
<tr>
<td>Choosing Plan Classes</td>
<td>5-18</td>
</tr>
<tr>
<td>Constraints</td>
<td>5-18</td>
</tr>
<tr>
<td>Enforce Demand Due Dates</td>
<td>5-18</td>
</tr>
<tr>
<td>Enforce Capacity Constraints</td>
<td>5-18</td>
</tr>
<tr>
<td>Optimization</td>
<td>5-19</td>
</tr>
<tr>
<td>Setting Plan Options</td>
<td>5-21</td>
</tr>
<tr>
<td>The Main Tab</td>
<td>5-21</td>
</tr>
<tr>
<td>The Aggregation Tab</td>
<td>5-25</td>
</tr>
<tr>
<td>The Organizations Tab</td>
<td>5-28</td>
</tr>
<tr>
<td>The Constraints Tab</td>
<td>5-30</td>
</tr>
<tr>
<td>The Optimization Tab</td>
<td>5-32</td>
</tr>
<tr>
<td>The Decision Rules Tab</td>
<td>5-34</td>
</tr>
<tr>
<td>Using an Existing Plan as a Demand Schedule For New Plan</td>
<td>5-35</td>
</tr>
<tr>
<td>Inline Forecast Consumption</td>
<td>5-36</td>
</tr>
<tr>
<td>Overwrite Options</td>
<td>5-40</td>
</tr>
<tr>
<td>Backward/Forward Forecast Consumption Days</td>
<td>5-45</td>
</tr>
<tr>
<td>Demand Priority Rules</td>
<td>5-47</td>
</tr>
<tr>
<td>Peg Supplies by Demand Priority</td>
<td>5-50</td>
</tr>
<tr>
<td>Choosing Aggregation Levels</td>
<td>5-51</td>
</tr>
<tr>
<td>Choosing Time Aggregation Levels</td>
<td>5-51</td>
</tr>
<tr>
<td>Choosing Product Aggregation Levels</td>
<td>5-52</td>
</tr>
<tr>
<td>Choosing Resource Aggregation Levels</td>
<td>5-52</td>
</tr>
<tr>
<td>Controlling Material Aggregation Levels</td>
<td>5-55</td>
</tr>
<tr>
<td>Controlling Routing Aggregation Levels</td>
<td>5-56</td>
</tr>
<tr>
<td>Choosing an Objective Function</td>
<td>5-57</td>
</tr>
<tr>
<td>Inventory Turns</td>
<td>5-57</td>
</tr>
<tr>
<td>Plan Profit Objective</td>
<td>5-57</td>
</tr>
<tr>
<td>On-time Delivery Objective</td>
<td>5-58</td>
</tr>
<tr>
<td>Implicit Objectives</td>
<td>5-59</td>
</tr>
<tr>
<td>Combining Objectives</td>
<td>5-59</td>
</tr>
<tr>
<td>Factors Affecting Objectives</td>
<td>5-60</td>
</tr>
<tr>
<td>Computational Burden Considerations</td>
<td>5-62</td>
</tr>
<tr>
<td>Optimized Plans Data Requirements</td>
<td>5-62</td>
</tr>
<tr>
<td>Optimization Effects on Sourcing</td>
<td>5-63</td>
</tr>
</tbody>
</table>
6 Supply Chain Modeling

Overview of Supply Chain Modeling ................................................................. 6-2
Setting up the Supply Chain ............................................................................ 6-2
Setting Supplier Capacity .................................................................................. 6-4
  Constraints ...................................................................................................... 6-4
  Setting Up Supplier Capacity ........................................................................... 6-5
  Setting Supplier Capacity by Time Periods ....................................................... 6-6
Setting up Alternate and Simultaneous Resources ........................................... 6-10
  Required Setup .............................................................................................. 6-11
  Ensuring that Related Resources are Used for the Same Job ......................... 6-28
Setting Up Routings ......................................................................................... 6-36
  Operation Resource Schedule Flag ............................................................... 6-36
  Minimum Transfer Quantity (MTQ) ............................................................... 6-37
  Multiresource Scheduling ............................................................................. 6-42
Planned Inventory Points .................................................................................. 6-47
  PIP Capability ............................................................................................... 6-48
  Using PIP ..................................................................................................... 6-52
Setting Up Batch Resources ............................................................................ 6-54
Allocating Demand to Suppliers ...................................................................... 6-58
Sourcing Example ............................................................................................. 6-60
  Allocations for Demand #1 .......................................................................... 6-62
  Input Data for Demand #2 ............................................................................ 6-66
  Allocations for Demand #2 .......................................................................... 6-66
  Enforce Sourcing Splits ................................................................................ 6-69
Viewing the Supply Chain ............................................................................... 6-74
Performing Tasks on the Planning Server ....................................................... 6-75
Audit Statements Report ................................................................................... 6-76

7 Simulations

Overview of Simulations .................................................................................. 7-2
Simulation Scenarios ......................................................................................... 7-2
  Supplier Capacity ......................................................................................... 7-2
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Availability</td>
<td>7-2</td>
</tr>
<tr>
<td>Supplies</td>
<td>7-2</td>
</tr>
<tr>
<td>Demands</td>
<td>7-2</td>
</tr>
<tr>
<td>Optimization Objectives</td>
<td>7-3</td>
</tr>
<tr>
<td>Simulation Modes</td>
<td>7-3</td>
</tr>
<tr>
<td>Net Change Replan</td>
<td>7-3</td>
</tr>
<tr>
<td>Running Net Change Replan Simulations</td>
<td>7-5</td>
</tr>
<tr>
<td>Using Undo to Reverse Actions or Make Changes</td>
<td>7-9</td>
</tr>
<tr>
<td>Comparing Scenarios Quantitatively</td>
<td>7-12</td>
</tr>
</tbody>
</table>

8 Optimization

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Optimization</td>
<td>8-2</td>
</tr>
<tr>
<td>Optimization Objectives</td>
<td>8-2</td>
</tr>
<tr>
<td>Setting Penalty Factors</td>
<td>8-4</td>
</tr>
<tr>
<td>Setting Late Demand Penalty Costs</td>
<td>8-4</td>
</tr>
<tr>
<td>Setting Penalty Factors for Exceeding Material Capacity</td>
<td>8-9</td>
</tr>
<tr>
<td>Setting Penalty Factors for Exceeding Resource Capacity</td>
<td>8-13</td>
</tr>
<tr>
<td>Setting Penalty Factors Using Plan Options</td>
<td>8-17</td>
</tr>
<tr>
<td>Setting Penalty Factors Using Optimization Profile Options</td>
<td>8-18</td>
</tr>
<tr>
<td>Comparing Different Optimization Runs</td>
<td>8-19</td>
</tr>
</tbody>
</table>

9 Performance Management

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Performance Management</td>
<td>9-2</td>
</tr>
<tr>
<td>Key Performance Indicators (KPIs)</td>
<td>9-2</td>
</tr>
<tr>
<td>Inventory Turns</td>
<td>9-4</td>
</tr>
<tr>
<td>Margin Percentage</td>
<td>9-5</td>
</tr>
<tr>
<td>Planned Utilization</td>
<td>9-5</td>
</tr>
<tr>
<td>On time Delivery</td>
<td>9-6</td>
</tr>
<tr>
<td>Margin</td>
<td>9-6</td>
</tr>
<tr>
<td>Cost Breakdown</td>
<td>9-6</td>
</tr>
<tr>
<td>Service Level</td>
<td>9-7</td>
</tr>
<tr>
<td>Inventory Value</td>
<td>9-7</td>
</tr>
<tr>
<td>KPI Setup</td>
<td>9-8</td>
</tr>
</tbody>
</table>
Tracking Plan Performance Using KPIs ................................................................. 9-10
Making Improvements Based on KPIs ................................................................. 9-10
Exception Messages ....................................................................................... 9-12
  Exception Summary Window .............................................................. 9-12
  Exception Groups for Different Plans .............................................. 9-13
  Planning Exception Sets .................................................................. 9-18
  Prioritization and Navigation .......................................................... 9-18
Making Decisions Based on Exceptions ...................................................... 9-20
  Using Online Planning ................................................................. 9-20
  Late Sales Orders and Forecasts ....................................................... 9-22
  Material and Resource Capacity ....................................................... 9-34
  Transportation and Distribution ...................................................... 9-41
  Shortages and Excess .................................................................. 9-43
  Reschedules .................................................................................. 9-45
  Substitutes and Alternates Used ..................................................... 9-49
  Projects/ Tasks ............................................................................ 9-54
  Item Exceptions .......................................................................... 9-56
Recommendations ...................................................................................... 9-59
Identifying Differences Between Plans .................................................. 9-60
  Filtering Criteria ........................................................................ 9-69

10 Planner Workbench/User Interface

  Overview of Planner Workbench/User Interface ................................... 10-2
  General Navigation ........................................................................ 10-2
  Tailoring the User Interface .......................................................... 10-11
  Using the Left Pane and the Navigation Tree .................................. 10-15
  Using the Right Pane and the Navigation Tree ................................ 10-19
    The Key Performance Indicators (KPIs) Tab .................................. 10-19
    The Horizontal Plan and Vertical Plan Tabs ................................. 10-25
    Actions/Exceptions Tab .............................................................. 10-35
  Viewing Pegging Supply and Demand Information ......................... 10-44
  Viewing the Supply Chain .............................................................. 10-45
Implementing Planning Recommendations ........................................... 10-48
  Creating and Implementing Firm Planned Orders ........................... 10-48
Releasing Recommendations ................................................................. 10-48
Releasing All Recommendations .............................................................. 10-50
Reviewing a BOM or Supply Chain Bill .......................................................... 10-50
Interactive Scheduling Using the Gantt Chart ................................................. 10-52
  The Order-Centric View ........................................................................ 10-53
  The Resource-Centric View .................................................................... 10-55
  Color Codes ............................................................................................. 10-55
  Find Window ............................................................................................. 10-55
  Right-Click Menu Options ....................................................................... 10-56
  Viewing Information on an Operation ...................................................... 10-57
  Specify Resources to Plot in the Lower Pane ........................................ 10-60
  Specifying Time Buckets ........................................................................ 10-60
  Rescheduling Operations ........................................................................ 10-62
  Firming an Operation .............................................................................. 10-64
  Resolving Overload of an Operation ....................................................... 10-65
  Gantt Chart Menu Options .................................................................... 10-68
  Gantt Chart Pegging ................................................................................. 10-68
  Gantt Chart Split Views ........................................................................... 10-69
  Saving Changes ....................................................................................... 10-71
Planning Detail Report .................................................................................. 10-71
  Capability .................................................................................................. 10-72

11
Constraint-Based Planning

  Overview of Constraint-Based Planning .................................................. 11-2
Constraint Types ....................................................................................... 11-2
  Items ......................................................................................................... 11-3
  Manufacturing Resources ....................................................................... 11-7
  Transportation Resources ....................................................................... 11-8
  Sourcing Constraints/Suppliers .............................................................. 11-8
  Demands .................................................................................................. 11-9
Enabling and Disabling Constraints ........................................................... 11-10
  Setting Hard and Soft Constraints ......................................................... 11-11
Setting Constraints for Different Plan Types ............................................. 11-13
Rules Used in Constrained Plans ............................................................... 11-15
  Look-Ahead Heuristic ............................................................................ 11-15
Flexible Shift Times ................................................................. 11-16
Partial Demand Satisfaction .................................................... 11-18
Phantom Routings ................................................................. 11-21
Planning Time Fence .............................................................. 11-21
Engineering Change Orders Use-Up Effectivity ....................... 11-26

12
Planning in Mixed Mode Environments

Overview of Mixed Mode Manufacturing ................................. 12-2
Common Features in Hybrid Manufacturing Environments .... 12-2
  Phantom Routings .......................................................... 12-2
  Utilization Efficiency ...................................................... 12-6
  Routing Effectivity ......................................................... 12-6
  Simultaneous, Aggregate, and Alternate Resources .............. 12-7
Oracle Project Manufacturing .................................................. 12-11
  Hard and Soft Pegging .................................................... 12-12
  Supply Chain Project Planning with Hard Pegging ................. 12-13
  Group Netting .............................................................. 12-13
  Borrow Payback ............................................................ 12-13
  Model/Unit Effectivity (Serial Effectivity) ......................... 12-16
  Workflow Based Project Exception Messages ...................... 12-18
  Project Planning Implementation Steps .............................. 12-19
  Project Planning Logic ................................................... 12-21
  Viewing the Plan ........................................................... 12-22
Oracle Flow Manufacturing ..................................................... 12-22
  Supply Chain Synchronization ........................................ 12-23
  Support for Flow Schedules ............................................. 12-23
  Demand Management .................................................... 12-24
  Line Design and Balancing .............................................. 12-24
  Kanban Planning and Execution ..................................... 12-24
  Product Families .......................................................... 12-25
Oracle Process Manufacturing .................................................. 12-26
  OPM Data for Oracle ASCP ............................................ 12-26
Oracle Shop Floor Management ............................................... 12-36
  Lot-Based Jobs ............................................................ 12-36
  Coproducts ................................................................. 12-37
  Operation Yield ............................................................ 12-40
Network Routings ........................................................................................................................................ 12-42

13  Collaborative Planning

Overview of Collaborative Planning ........................................................................................................... 13-2
Collaborating with Customers ....................................................................................................................... 13-2
  Sharing Forecasts/Demand Plans .............................................................................................................. 13-2
  Customer Submissions ............................................................................................................................... 13-3
Collaborating with Suppliers ........................................................................................................................ 13-4
Performance Management and Supply Chain Partners ............................................................................. 13-4
  Measuring Supply Chain Partner Performance ....................................................................................... 13-4
Using Workflow in Oracle ASCP ................................................................................................................ 13-5
  Workflow Enabled Exceptions .................................................................................................................. 13-5
  Workflow Process Summary .................................................................................................................... 13-6
  Workflow Process Details ....................................................................................................................... 13-8
  Setups Associated with Oracle ASCP Exception Workflows ................................................................ 13-17

14  Configure to Order

CTO Enhancements ......................................................................................................................................... 14-2
Multilevel ATO with Example ....................................................................................................................... 14-2
  Forecast Explosion .................................................................................................................................. 14-4
  Planning Process .................................................................................................................................... 14-4
  Order Promising .................................................................................................................................... 14-7
Set Up Required to Use Multilevel ATO .................................................................................................... 14-10
  Order Promising Related Attributes ..................................................................................................... 14-10

15  Cross-Instance Planning

Overview of Cross-Instance Planning .......................................................................................................... 15-2
Instances ..................................................................................................................................................... 15-2
Collections .................................................................................................................................................. 15-3
Sourcing Rules .......................................................................................................................................... 15-4
Planning ................................................................................................................................................... 15-6
Global Order Promising ............................................................................................................................. 15-8
Execution .................................................................................................................................................... 15-8
16 Oracle Global Order Promising

Overview of Oracle Global Order Promising ................................................................................. 16-2
Key Features ...................................................................................................................................... 16-2
Integration with Other Oracle Applications ...................................................................................... 16-4
Architecture ...................................................................................................................................... 16-4
ATP Methods ..................................................................................................................................... 16-6
ATP Based on Collected Data ........................................................................................................... 16-6
ATP Based on Planning Data ............................................................................................................. 16-6
Order Promising for Unplanned Items ................................................................................................. 16-7
Data Collection ................................................................................................................................. 16-8
Running Collection for ATP Based on Collected Data .................................................................... 16-8
Running Collection For ATP Based on Planning Output ................................................................... 16-9
Basic ATP .......................................................................................................................................... 16-10
Basic ATP Business Application ........................................................................................................ 16-10
Basic ATP Setup Steps ...................................................................................................................... 16-10
Basic ATP Data Collection ............................................................................................................... 16-11
ATP Inquiry ....................................................................................................................................... 16-11
ATP Logic .......................................................................................................................................... 16-12
Single-Level Supply Chain ATP ....................................................................................................... 16-13
Single-Level Supply Chain ATP Business Application ................................................................... 16-13
Single-Level Supply Chain ATP Setup Steps ................................................................................... 16-13
Single-Level Supply Chain ATP With or Without APS ................................................................... 16-16
Single-Level Supply Chain ATP Data Collection ........................................................................... 16-17
ATP Inquiry ....................................................................................................................................... 16-17
ATP Logic for Single-Level Supply Chain ATP .............................................................................. 16-18
Single-Level Supply Chain ATP Example ........................................................................................ 16-18
Notes .................................................................................................................................................. 16-21
Multilevel Supply Chain ATP .......................................................................................................... 16-22
Multilevel Supply Chain ATP Feature Description ......................................................................... 16-22
Multilevel Supply Chain ATP Business Application ....................................................................... 16-23
Multilevel Supply Chain ATP Setup Steps ...................................................................................... 16-23
Data Collection and Running a Plan .................................................................................................. 16-26
ATP Inquiry ....................................................................................................................................... 16-27
ATP Logic for Multilevel Supply Chain ATP ................................................................................... 16-28
Multilevel Supply Chain ATP Example ........................................................................................... 16-29
Notes .............................................................................................................................. 16-38

Allocated ATP ............................................................................................................................... 16-39
Allocated ATP Feature Description ............................................................ 16-39
Allocated ATP Business Applications .......................................................... 16-39
Allocated ATP Setup Steps ............................................................................. 16-40
Allocated ATP Data Collection ........................................................................ 16-45
ATP Inquiry and Viewing Allocations ........................................................... 16-45
Refreshing Allocations ......................................................................................... 16-48
Allocated ATP Example ....................................................................................... 16-49
Notes .............................................................................................................................. 16-55

Demand Class ATP ................................................................................................................... 16-57
Demand Class ATP Feature Description ....................................................... 16-57
Demand Class ATP Business Application ..................................................... 16-57
Demand Class ATP Setup Steps .......................................................................... 16-57
Demand Class ATP versus Allocated ATP .................................................. 16-58
Demand Class ATP Data Collection ............................................................... 16-59
ATP Inquiry ...................................................................................................................... 16-59
ATP Logic for Demand Class ATP ................................................................. 16-60

Other ATP Functions .......................................................................................................... 16-61
Time Fence Options ................................................................................................. 16-61
Computation Options .............................................................................................. 16-62
Supply and Demand ................................................................................................. 16-62
Component Substitution .......................................................................................... 16-64
Using Multiple Plans ............................................................................................... 16-65
Support for Batch Resources ............................................................................... 16-65
Regional Level Sourcing Support ........................................................................ 16-67
Improved ATP Performance Based on Summarized Demand and Supply ............................................. 16-71

ATP Inquiry ...................................................................................................................... 16-74
ATP Criteria ..................................................................................................................... 16-74
Using Global ATP Server from Non-Oracle Applications ............................................... 16-79

17 Inventory Optimization

Overview of Oracle Inventory Optimization ............................................................ 17-2
Business Process ........................................................................................................... 17-2
Key Inventory Decisions ............................................................................................. 17-3
Input ............................................................................................................................... 17-4
Output ............................................................................................................................ 17-5
Defining a Plan ............................................................................................................................... 17-6
Global Inventory Planning and Subset Planning................................................................. 17-6

Key Setups and Inputs ........................................................................................................ 17-10
Setting Target Service Levels ......................................................................................... 17-10
Setting Plan Options....................................................................................................... 17-18
Set Supplier Lead Time Variability ................................................................................ 17-42
Setting Penalty Costs....................................................................................................... 17-44
Setting Item Purchase Price by Supplier ....................................................................... 17-45
Setting Performance Indicators ..................................................................................... 17-46

Viewing Output ............................................................................................................. 17-47
Performance Indicators................................................................................................. 17-47
Time-Phased Supply and Demand .................................................................................. 17-48
Safety Stocks and Target Safety Stocks......................................................................... 17-50
Resource Requirements ................................................................................................. 17-51
Material/Resource Availability...................................................................................... 17-53

Reviewing Exception Messages ...................................................................................... 17-54
Capacity Exceptions ...................................................................................................... 17-54

18 Business Topics

Overview of Business Topics ............................................................................................ 18-2
End-Item-Level Substitution ............................................................................................. 18-2
User Procedures Overview ............................................................................................... 18-3
Define a Substitution Relationship .................................................................................. 18-3
Viewing Substitution Display .......................................................................................... 18-9
Substitution Logic ............................................................................................................. 18-13
End-Item Substitution Features ........................................................................................ 18-16
Exception Messages ........................................................................................................ 18-36

End Item Substitution and Oracle Global Order Promising .............................................. 18-42
Examples to Explain Substitution Logic in Oracle Global Order Promising .................... 18-43
Display of Possible Substitutes ....................................................................................... 18-49
Creation of Planned Supplies ......................................................................................... 18-51
Searching Supply Chain for Substitutes ........................................................................ 18-53
Evaluating Supplies After Request Date ........................................................................ 18-54
Resolving Ties in the Substitution Chain ........................................................................ 18-61
Substitution in Allocated ATP ........................................................................................ 18-61
Allocated ATP In a Supply Chain ................................................................. 18-63
End Item Substitution Workflow for Oracle Global Order Promising ........ 18-66
**User-Defined Alternate Decision Rules** .................................................. 18-69
  User-Defined Alternate Decision Rules for Constrained Plans ............... 18-69
  Simulations and User-Defined Decision Rules ........................................ 18-87
  User-Defined Alternate Decision Rules for Optimized Plans .................. 18-88
  Planning Search Logic ............................................................................. 18-92
  Lead-Times and User-Defined Decision Rules ......................................... 18-100
  Pegging and User-Defined Decision Rules ............................................. 18-101
  Exception Messages .............................................................................. 18-101
**Organization Security** ......................................................................... 18-103
  User Procedure Flow ............................................................................ 18-103
  Organization Validation .......................................................................... 18-105
  Supply Chain Plan Names Form ............................................................ 18-105
  Plan Options Form .............................................................................. 18-106
  Example: ............................................................................................... 18-107

**A  Profile Options**

  Profile Options ...................................................................................... A-2
    Oracle ASCP Scheduling Profile Options ............................................. A-2
    Oracle ASCP Optimization Profile Options ........................................ A-12
    Other Oracle ASCP Profile Options: ................................................ A-14
    ILOG CPLEX Solver Profile Options ............................................... A-15
    Oracle ASCP Flexfield Attribute Profile Option ............................... A-17
    Oracle Global Order Promising Profile Options ............................... A-18
    Oracle Inventory Optimization Profile Options ............................... A-20

**B  Oracle ASCP Flexfields**

  Oracle ASCP Flexfields ........................................................................ B-2
  Applying Flexfields to Different Versions of Oracle RDBMS ................. B-3
    Transportation Capacity .................................................................... B-4
    Creating Demand Priority Flexfield Numbers Manually .................... B-4
C  Order Backlog Workbench
Overview of the Order Backlog Workbench ................................................................. C-2
Selection Criteria for Scheduling with the Order Backlog Workbench ...................... C-7
Scheduling Order Lines with the Order Backlog Workbench ...................................... C-15

D  Control Files
Setup Data Control Files ................................................................................................ D-2
Supplies Control Files .................................................................................................. D-3
Demand Control Files .................................................................................................. D-3
User-Defined Keys (UDK) ............................................................................................ D-4

Index
Send Us Your Comments

Oracle Advanced Planning and Scheduling Implementation and User’s Guide, Volumes 1 & 2, Release 11/1
Part No. B10144-01

Oracle Corporation welcomes your comments and suggestions on the quality and usefulness of this document. Your input is an important part of the information used for revision.

- Did you find any errors?
- Is the information clearly presented?
- Do you need more information? If so, where?
- Are the examples correct? Do you need more examples?
- What features did you like most?

If you find any errors or have any other suggestions for improvement, please indicate the document title and part number, and the chapter, section, and page number (if available). You can send comments to us in the following way:

- Electronic mail: mfgdoccomments_us@oracle.com

If you would like a reply, please give your name, address, telephone number, and (optionally) electronic mail address.

If you have problems with the software, please contact your local Oracle Support Services.
Preface

Audience for This Guide


This manual is intended for both users and administrators of Oracle Advanced Supply Chain Planning (ASCP), Oracle Inventory Optimization, and Oracle Global Order Promising.

This guide assumes you have a working knowledge of the following:

- The principles and customary practices of your business area.
- The Oracle Applications graphical user interface.

To learn more about the Oracle Applications graphical user interface, read the Oracle Applications User Guide.

Note: The other components of Advanced Planning and Scheduling, namely Oracle Demand Planning, which is documented in the online help for the product and in the Oracle Demand Planning User Guide, Oracle Manufacturing Scheduling, which is documented in the Oracle Manufacturing Scheduling User Guide, and Oracle Supply Chain Exchange, which is documented in the online help for the product, are not documented in this guide.

It is for those who will both use and implement these products. It discusses how to perform common tasks using these applications, high-level conceptual issues, and why they must be resolved in certain ways.

This guide assumes you have a working knowledge of the following:

- The principles and customary practices of your business area.
- The Oracle Applications graphical user interface.

To learn more about the Oracle Applications graphical user interface, read the Oracle Applications User Guide.
See Other Information Sources for more information about Oracle Applications product information.

How To Use This Guide

This guide contains the information you need to understand and implement Oracle Advanced Supply Chain Planning, Oracle Inventory Optimization, and Oracle Global Order Promising.

This preface explains how this document is organized and introduces other sources of information that can help you. This guide contains the following chapters:

- Chapter 1 gives an overview of Oracle ASCP, Oracle Inventory Optimization, and Oracle Global Order Promising and describes new features in this release.
- Chapter 2 instructs you how to set up Oracle ASCP, Oracle Global Order Promising, and Oracle Inventory Optimization.
- Chapter 3 describes the flows of information between the components of Oracle APS and how Oracle ASCP functionality relates to a planner’s daily business processes.
- Chapter 4 describes the ASCP data collections process and architecture.
- Chapter 5 describes features that help you select a plan that best satisfies your business requirements. It describes various issues to consider when setting up a plan including: deciding whether to run a subset plan, choosing a plan type, choosing a level of optimization, choosing an objective function, and choosing aggregation levels.
- Chapter 6 instructs you how to set up a supply chain.
- Chapter 7 describes Oracle ASCP’s advanced simulation capabilities which let you rapidly simulate changes to a plan and respond to changing conditions.
- Chapter 8 describes Oracle ASCP’s optimization capabilities.
- Chapter 9 discusses Oracle ASCP’s integration with Oracle Business Intelligence System (BIS), a performance management tool.
- Chapter 10 describes the Planner Workbench, a powerful graphical tool that lets you perform advanced simulation, review plan performance, and take actions based on system recommendations.
- Chapter 11 discusses constraint-based planning and scheduling, an approach for balancing material and plant resources while meeting customer demand.
Chapter 12 describes Oracle ASCP’s support for mixed mode manufacturing which lets you plan distribution and manufacturing operations for hybrid environments.

Chapter 13 discusses Oracle ASCP’s support for powerful Internet-based collaboration, which allows you to communicate seamlessly with your customers.

Chapter 14 discusses Configure to Order which supports Multilevel Configurations where you can have configurations under configurations. You can source the configurations from anywhere in the supply chain.

Chapter 15 discusses Cross-Instance Planning, a methodology that enables you to define, run, and execute a single plan across multiple source instances, which is a key feature for companies that implement a hub-and-spoke planning model.

Chapter 16 discusses Oracle Global Order Promising, a tool that enables sophisticated, fast, accurate, and flexible order promising.

Chapter 17 discusses Oracle Inventory Optimization, a feature that enables you to optimize your strategic inventory investment decisions by helping you to identify optimal inventory stocking levels, order quantities, order frequency, and other operational policies given a set of requirements and objectives.

Chapter 18 discusses Business Topics offering high-level information on end item-level substitution, user-defined alternate decision rules, and organization security.

Appendix A contains a list of the APS profile options.

Appendix B contains a list of ASCP flexfields.

Appendix C discusses the Order Backlog Workbench.

Appendix D contains a list of control files and user-defined keys.

**Documentation Accessibility**

Our goal is to make Oracle products, services, and supporting documentation accessible, with good usability, to the disabled community. To that end, our documentation includes features that make information available to users of assistive technology. This documentation is available in HTML format, and contains markup to facilitate access by the disabled community. Standards will continue to evolve over time, and Oracle Corporation is actively engaged with other market-leading technology vendors to address technical obstacles so that our documentation can be accessible to all of our customers. For additional information,
visit the Oracle Accessibility Program Web site at http://www.oracle.com/accessibility/.

Finding Out What’s New

From the HTML help window for Oracle Advanced Supply Chain Planning, Oracle Inventory Optimization, Oracle Global Order Promising, and Oracle Demand Planning, choose the section that describes new features or what’s new from the expandable menu. This section is available in the Overview section. The new features section describes:

- New features in 11i. This information is updated for each new release of Oracle Advanced Supply Chain Planning, Oracle Inventory Optimization, Oracle Global Order Promising, and Oracle Demand Planning.
- Information about any features that were not yet available when this document was printed. For example, if your system administrator has installed software from a mini pack as an upgrade, this document describes the new features.

Other Information Sources

You can choose from many sources of information, including online documentation, training, and support services, to increase your knowledge and understanding of Oracle Advanced Supply Chain Planning, Oracle Inventory Optimization, Oracle Global Order Promising, and Oracle Demand Planning.

If this guide refers you to other Oracle Applications documentation, use only the Release 11i versions of those guides.

Online Documentation

All Oracle Applications documentation is available online (HTML or PDF).

- **Online Help** - The new features section in the HTML help located in the Overview section describes new features in 11i. This information is updated for each new release of Oracle Advanced Planning and Scheduling. The new features section also includes information about any features that were not yet available when this guide was printed. For example, if your administrator has installed software from a mini-packs upgrade, this document describes the new features. Online help patches are available on MetaLink.
- **11i Features Matrix** - This document lists new features available by patch and identifies any associated new documentation. The new features matrix document is available on MetaLink.

- **Readme File** - Refer to the readme file for patches that you have installed to learn about new documentation or documentation patches that you can download.

### Related User Guides

Oracle Advanced Supply Chain Planning, Oracle Inventory Optimization, Oracle Global Order Promising, and Oracle Demand Planning share business and setup information with other Oracle Applications products. Therefore, you may want to refer to other documents when you set up and use Oracle Advanced Supply Chain Planning, Oracle Inventory Optimization, Oracle Global Order Promising, and Oracle Demand Planning.

You can read the guides online by choosing Library from the expandable menu on your HTML help window, by reading from the Oracle Applications Document Library CD included in your media pack, or by using a Web browser with a URL that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle store at http://oraclestore.oracle.com.

### User Guides Related to All Products

**Oracle Applications Concepts**

This guide provides an introduction to the concepts, features, technology stack, architecture, and terminology for Oracle Applications Release 11i. It provides a useful first book to read before an installation of Oracle Applications. This guide also introduces the concepts behind Applications-wide features such as Business Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

**Installing Oracle Applications**

This guide provides instructions for managing the installation of Oracle Applications products. In Release 11i, much of the installation process is handled using Oracle Rapid Install, which minimizes the time to install Oracle Applications, the Oracle8 technology stack, and the Oracle8i Server technology stack by automating many of the required steps. This guide contains instructions for using Oracle Rapid Install and lists the tasks you need to perform to finish your
installation. You should use this guide in conjunction with individual product user’s guides and implementation guides.

**Upgrading Oracle Applications**
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or Release 11.0 products to Release 11i. This guide describes the upgrade process and lists database and product-specific upgrade tasks. You must be either at Release 10.7 (NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i. You cannot upgrade to Release 11i directly from releases prior to 10.7.

**Maintaining Oracle Applications**
Use this guide to help you run the various AD utilities, such as AutoUpgrade, AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and others. It contains how-to steps, screenshots, and other information that you need to run the AD utilities. This guide also provides information on maintaining the Oracle applications file system and database.

**Oracle Applications System Administrator’s Guide**
This guide provides planning and reference information for the Oracle Applications System Administrator. It contains information on how to define security, customize menus and online help, and manage concurrent processing.

**Oracle Applications User Guide**
This guide explains how to enter data, query, run reports, and navigate using the graphical user interface (GUI) available with this release of Oracle Advanced Supply Chain Planning, Oracle Inventory Optimization, Oracle Global Order Promising, and Oracle Demand Planning (and any other Oracle Applications product). This guide also includes information on setting user profiles, as well as running and reviewing reports and concurrent processes. You can access this user’s guide online by choosing”Getting Started with Oracle Applications” from any Oracle Applications help file.

**Oracle Alert User Guide**
Use this guide to define periodic and event alerts that monitor the status of your Oracle Applications data.
Oracle Applications Implementation Wizard User Guide

If you are implementing more than one Oracle product, you can use the Oracle Applications Implementation Wizard to coordinate your setup activities. This guide describes how to use the wizard.

Oracle Applications Developer's Guide

This guide contains the coding standards followed by the Oracle Applications development staff. It describes the Oracle Application Object Library components needed to implement the Oracle Applications user interface described in the Oracle Applications User Interface Standards. It also provides information to help you build your custom Oracle Developer forms so that they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products

This guide contains the user interface (UI) standards followed by the Oracle Applications development staff. It describes the UI for the Oracle Applications products and how to apply this UI to the design of an application built by using Oracle Forms.

User Guides Related to This Product

Oracle Applications Product Update Notes

Use this guide as a reference for upgrading an installation of Oracle Applications. It provides a history of the changes to individual Oracle Applications products between Release 11.0 and Release 11i. It includes new features, enhancements, and changes made to database objects, profile options, and seed data for this interval.

Oracle Applications Demonstration User’s Guide

This guide documents the functional storyline and product flows for Vision Enterprises, a fictional manufacturer of personal computers products and services. As well as including product overviews, the book contains detailed discussions and examples across each of the major product flows. Tables, illustrations, and charts summarize key flows and data elements.

Oracle Bills of Material User’s Guide

This guide describes how to create various bills of materials to maximize efficiency, improve quality and lower cost for the most sophisticated manufacturing
environments. By detailing integrated product structures and processes, flexible product and process definition, and configuration management, this guide enables you to manage product details within and across multiple manufacturing sites.

**Oracle Business Intelligence System Implementation Guide**
This guide provides information about implementing Oracle Business Intelligence (BIS) in your environment.

**BIS 11i User Guide Online Help**
This guide is provided as online help only from the BIS application and includes information about intelligence reports, Discoverer workbooks, and the Performance Management Framework.

**Oracle Capacity User’s Guide**
This guide describes how to validate a material plan by verifying that there are resources sufficient to perform the planned work for repetitive and discrete jobs. Using finite capacity planning techniques, you learn how to use rough-cut capacity planning to validate a master schedule and capacity planning to validate the material plan.

**Oracle Demand Planning User’s Guide**
This guide explains how to use Oracle Demand Planning, an Internet-based solution for creating and managing forecasts.

**Oracle Flow Manufacturing User’s Guide**
This guide describes how to use Oracle’s Flow Manufacturing functionality to support the processes of flow manufacturing. It describes design features of demand management, line design and balancing, and kanban planning. It also describes production features of line scheduling, production, and kanban execution.

**Oracle Inventory User’s Guide**
This guide describes how to define items and item information, perform receiving and inventory transactions, maintain cost control, plan items, perform cycle counting and physical inventories, and set up Oracle Inventory.
Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide
This guide describes how to anticipate and manage both supply and demand for your items. Using a variety of tools and techniques, you can create forecasts, load these forecasts into master production schedules, and plan your end-items and their component requirements. You can also execute the plan, releasing and rescheduling planning suggestions for discrete jobs and repetitive schedules.

Oracle Project Manufacturing User’s Guide
This guide describes the unique set of features Oracle Project Manufacturing provides for a project-based manufacturing environment. Oracle Project Manufacturing can be tightly integrated with Oracle Projects. However, in addition to Oracle Projects functionality, Oracle Project Manufacturing provides a comprehensive set of new features to support project sales management, project manufacturing costing, project manufacturing planning, project manufacturing execution and project quality management.

Oracle Self Service Web Applications User’s Guide
This guide describes how Oracle Self Service Web Applications enable companies to provide a self-service and secure web interface for its employees, customers and suppliers. Employees can change their personal status, submit expense reports or request supplies; customers can check on their orders; and suppliers can share production schedules with their trading partners. This guide is available in HTML only.

Oracle Work in Process User’s Guide
This guide describes how Oracle Work in Process provides a complete production management system. Specifically this guide describes how discrete, repetitive, assemble-to-order, project, flow, and mixed manufacturing environments are supported.

Oracle Workflow Guide
This guide explains how to define new workflow business processes as well as customize existing Oracle Applications-embedded workflow processes. You also use this guide to complete the setup steps necessary for any Oracle Applications product that includes workflow-enabled processes.
Reference Manuals

**Oracle eTechnical Reference Manuals**
Each eTechnical Reference Manual (eTRM) contains database diagrams and a detailed description of database tables, forms, reports, and programs for a specific Oracle Applications product. This information helps you convert data from your existing applications, integrate Oracle Applications data with non-Oracle applications, and write custom reports for Oracle Applications products. Oracle eTRM is available on Metalink.

**Oracle Manufacturing APIs and Open Interfaces Manual**
This manual contains up-to-date information about integrating with other Oracle Manufacturing applications and with your other systems. This documentation includes API's and open interfaces found in Oracle Manufacturing.

**Oracle Applications Message Reference Manual**
This manual describes all Oracle Applications messages. This manual is available in HTML format on the documentation CD-ROM for Release 11i.

**Oracle Project Manufacturing Implementation Manual**
This manual describes the setup steps and implementation for Oracle Project Manufacturing.

**Oracle Self-Service Web Applications Implementation Manual**
This manual describes the setup steps for Oracle Self-Service Web Applications and the Web Applications dictionary.

**Oracle Applications Flexfields Guide**
This guide provides flexfields planning, setup, and reference information for the Oracle Advanced Supply Chain Planning, Oracle Inventory Optimization, Oracle Global Order Promising, and Oracle Demand Planning implementation team, as well as for users responsible for the ongoing maintenance of Oracle Applications product data. This guide also provides information on creating custom reports on flexfields data.
Installation and System Administration Guides

Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade, AutoPatch, AD Administration, AD Controller, Relink, and others. It contains how-to steps, screenshots, and other information that you need to run the AD utilities.

Training and Support

Training
Oracle offers a complete set of training courses to help you and your staff master Oracle Applications and reach full productivity quickly. These courses are organized into functional learning paths, so you take only those courses appropriate to your job or area of responsibility.

You have a choice of educational environments. You can attend courses offered by Oracle University at any one of our many Education Centers, you can arrange for our trainers to teach at your facility, or you can use Oracle Learning Network (OLN), Oracle University’s online education utility. In addition, Oracle training professionals can tailor standard courses or develop custom courses to meet your needs. For example, you may want to use your organization structure, terminology, and data as examples in a customized training session delivered at your own facility.

Support
From on-site support to central support, our team of experienced professionals provides the help and information you need to keep Oracle Advanced Supply Chain Planning, Oracle Inventory Optimization, Oracle Global Order Promising, and Oracle Demand Planning working for you. This team includes your Technical Representative, Account Manager, and Oracle’s large staff of consultants and support specialists with expertise in your business area, managing an Oracle8i server, and your hardware and software environment.
Conventions

In this manual, we use a number of notational and text conventions to visually identify different kinds of information.

Notational Conventions

The following notational conventions are used in this manual:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>bold type</strong></td>
<td>Bold type is used to designate certain user interface objects, including button, radio button, and window names.</td>
</tr>
<tr>
<td>&lt;drive&gt;&gt;</td>
<td>A drive followed by a right caret denotes the Windows NT command prompt (for example, ).</td>
</tr>
<tr>
<td><em>italic type</em></td>
<td>Italic type can mean one of two things: a) user-supplied information; or b) the title of a book, chapter, or section.</td>
</tr>
<tr>
<td><strong>monospace text</strong></td>
<td>Text in this typeface one of three things: a) feedback from Oracle ASCP; b) information you enter; or c) filenames and pathnames.</td>
</tr>
</tbody>
</table>

Text Conventions

The following text conventions are used in this manual:

**Note**

A Note calls attention to an important feature or fact that is related to the contents of the previous paragraph. Here is an example of a Note:

———

**Note:** This note is used to call attention to some feature or fact related to the previous paragraph.

———

**Caution**

A Caution represents information about a condition that could prevent the application from working correctly. Here is an example of a Caution:

———

**Caution:** This is a caution to pay attention to some feature or fact that could prevent Oracle ASCP from working correctly.

———
Code Examples
In code examples, an implied carriage return occurs at the end of each line, unless otherwise noted. You must press the Return key at the end of a line of input.

Choosing Menu Options
In procedures, an instruction to choose successive menu and sub-menu options is noted in an abbreviated way. For example, an instruction to select Action from the menu bar, then choose Save from the Action menu, is noted as follows:

| To save your work choose Menu > Action > Save. |

Do Not Use Database Tools to Modify Oracle Applications Data

Oracle STRONGLY RECOMMENDs that you never use SQL*Plus, Oracle Data Browser, database triggers, or any other tool to modify Oracle Applications tables, unless we tell you to do so in our guides.

Oracle provides powerful tools you can use to create, store, change, retrieve, and maintain information in an Oracle database. But if you use Oracle tools such as SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using an Oracle Applications form can update many tables at once. But when you modify Oracle Applications data using anything other than Oracle Applications, you might change a row in one table without making corresponding changes in related tables. If your tables get out of synchronization with each other, you risk retrieving erroneous information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications automatically checks that your changes are valid. Oracle Applications also keeps track of who changes information. But, if you enter information into database tables using database tools, you may store invalid information. You also lose the ability to track who has changed your information because SQL*Plus and other database tools do not keep a record of changes.

About Oracle
Oracle Corporation develops and markets an integrated line of software products for database management, applications development, decision support, and office
automation, as well as Oracle Applications, an integrated suite of more than 160 software modules for financial management, supply chain management, manufacturing, project systems, human resources and customer relationship management.

Oracle products are available for mainframes, minicomputers, personal computers, network computers and personal digital assistants, allowing organizations to integrate different computers, different operating systems, different networks, and even different database management systems, into a single, unified computing and information resource.

Oracle is the world’s leading supplier of software for information management, and the world’s second largest software company. Oracle offers its database, tools, and applications products, along with related consulting, education, and support services, in over 145 countries around the world.

Your Feedback

Thank you for using Oracle ASCP, Oracle Inventory Optimization, Oracle Global Order Promising and this document.

Oracle values your comments and feedback. This guide contains a Reader’s Comment Form you can use to explain what you like or dislike about Oracle Advanced Supply Chain Planning, Oracle Inventory Optimization, Oracle Global Order Promising or this document.

Send electronic mail to mfgdoccomments_us@oracle.com.
1

Overview

Topics covered in this section include the following:

- Introducing Oracle Advanced Planning Suite on page 1-2
- Oracle Advanced Supply Chain Planning on page 1-3
- Oracle Inventory Optimization on page 1-11
- Oracle Global Order Promising on page 1-15
Introducing Oracle Advanced Planning Suite

Oracle’s Advanced Planning Suite includes the following products:

- Oracle Advanced Supply Chain Planning (ASCP)
- Oracle Manufacturing Scheduling
- Oracle Global Order Promising
- Oracle Inventory Optimization
- Oracle Demand Planning
- Oracle Supply Chain Exchange

Note: This document covers Oracle Advanced Supply Chain Planning, Oracle Inventory Optimization, and Oracle Global Order Promising.
Oracle Advanced Supply Chain Planning

Oracle Advanced Supply Chain Planning (ASCP) is a comprehensive, Internet-based planning solution that decides when and where supplies (for example, inventory, purchase orders and work orders) should be deployed within an extended supply chain. This is the supply planning function. Oracle ASCP addresses the following key supply planning issues:

- How do I plan my supply chain in the least amount of time possible?
  - How do I minimize the number of plans and iterations?
  - How do I plan my entire supply chain?
- How do I involve my trading partners?
- How can I access my plan from anywhere?
- How do I keep improving my plans?
- How can I plan all manufacturing methods?

The key capabilities of Oracle ASCP are:

- Holistic Optimization, Planning, and Scheduling. Oracle ASCP can plan all supply chain facilities simultaneously. Short-term detailed scheduling and long-term aggregate planning are supported within a single plan. This single plan also supports multiple manufacturing methods, including discrete, flow, project, and process manufacturing.
- Finite Capacity Planning and Scheduling. Oracle ASCP generates feasible supply chain plans that consider both resource and material constraints.
- Optimization. Users can easily configure Oracle ASCP to optimize specific business criteria. No programming is necessary to access Oracle ASCP’s powerful mathematical optimization capabilities.
- Backward Compatibility. Oracle ASCP’s component architecture allow it to be deployed against any combination of Oracle 10.7, Oracle 11 and Oracle 11i transaction systems.
- Workflow-Driven Exception Messaging. Oracle ASCP’s exception messages alert planners to critical issues across the extended supply chain. Workflows that drive these exceptions route data to and feedback from trading partners as required, thus effectively involving them in the supply chain planning process.
- Global Accessibility. Oracle ASCP’s database-centric architecture stores plan data in a central planning server database. These data are accessible from
anywhere via a simple browser. It is possible for multiple planners to simultaneously access data from a single plan.

- Integrated Planning and Execution. Oracle ASCP's Advanced Planner Workbench user interface not only displays plan results, but also allows planners to execute planning recommendations. Planners do not have to move to the transaction system to perform plan execution.

- Simulation Capability. Oracle ASCP allows many types of changes to supply, demand, plan options, and resource profiles to simulate changing business conditions. You can generate a plan considering all the changes that have been entered via the Planner's Workbench. Unlimited numbers of scenarios can be simulated and compared using online planning, copy plans, and exceptions. Examples of the types of changes are firming, changing sources, modifying quantities and dates, modifying priorities, modifying resource availability, modifying supplier capacity, and modifying objective weights.

New ASCP Features

**Peg Supplies by Demand Priority**
Oracle ASCP will allocate both firm and nonfirm supplies to demands in the order of demand priority. Oracle ASCP will follow the following guidelines to allocate supplies to demands:

- Allocate supply to demand in the order of demand priority instead of closest quantity pegging
- Minimize pegging of a given supply to multiple demands
- Avoid multiple pegs to higher priority demands

**End Item Substitution**
ASCP and Global Order Promising now consider end-item substitution for demanded items. Previously, only BOM component substitution was considered. Substitute items may be defined using the Oracle Inventory Item Relationships form. Ease-of-use features include the ability to define a reciprocal substitute relationship, the ability to infer chained substitution relationships, and the ability to define customer/ customer site specific relationships and whether this customer will allow an order to be filled by a combination of the original requested item and the substitute item. Item substitution relationships are time effective. Item
relationships may also include a reference to a Substitution Set that can be selected in the Plan Options window.

End-item substitution capability applies only to standard items. It is not supported for assemble-to-order items or models.

**User-Defined Alternate Decision Rules**

You can specify the types of alternates (sources, bills of material/routings, end items, components, resources) that ASCP is free to consider during planning, and you can do so without having to enter extensive cost data.

You can define alternate types of supply such as end-item substitutes, component substitutes, alternate sources, and alternate bills of material/routings across your supply chain. You can define multiple alternates and assign appropriate priorities to the alternates. Oracle ASCP honors these sources of supply when calculating the best means of satisfying demand.

For example, you can define an item A to have multiple substitute components with appropriate priorities (for example, component B - priority 1; component C - priority 2). ASCP will exhaust supply from a higher priority alternate (component B) before using supply from a lower priority alternate (component C).

You can control which alternate sources of supply ASCP considers. ASCP will try as far as possible to use only the primary method of supply to meet demand on time. But if the material or resource capacity is violated for any supply, ASCP will try to maximize the available supply by using additional supply from the alternates that you enabled.

**Organization Security**

This new feature allows you to restrict access to plan information to authorized individuals. You can associate job responsibilities to organizations for security purposes. This ensures that the only way you can see or change planning data in an organization is if you have a job responsibility associated with the organization.

**Identify Differences Between Plans**

ASCP provides an easy way to compare plan exceptions and plan setups between two plans. This is useful for determining whether actions taken by a planner to solve a specific problem have the desired overall effect.

For example, a planner may choose to address a late sales order by increasing the priority of the sales order, and then replanning (generating a new plan in the process). By comparing the new plan to the original plan, the planner can see
whether the problem sales order is now on time, and whether any other sales orders have been pushed out as a result of pulling the problem sales order in. Also, a planner may wish to know what plan setup changes led to changes in key indicator performance. To facilitate this diagnosis, ASCP displays the plan option settings for two plans side by side. Results of comparisons between plans are shown in both graphical and tabular format.

**Planning Detail Report**

ASCP provides a consolidated report that helps you understand and analyze the output of the supply chain planning process. For a given supply chain plan, the report lists details about items, resources, gross requirements, scheduled receipts, planned orders, plan constraints, and exceptions in separate worksheets. You can filter report information according to plan, organization, item, resource, project, and other parameters. The basic structure of the MRP Planning Detail Report in Release 11 of Oracle Applications has been retained. The Planning Detail Report is implemented in Discoverer 4i, which allows you to manipulate report formatting. You can selectively print individual worksheets of the report.

**Collections from Legacy System**

Collections is the process by which data from execution and ERP transaction systems are loaded periodically into the ASCP planning server for use during planning. Previously, collections were supported only for Oracle (10.7, 11, 11i) transaction systems. This feature makes it easy to load data from legacy (non-Oracle) transaction systems into the ASCP planning server. A new user interface allows you to initiate the population of Oracle APS interface tables using batch upload of flat files. A preprocessing engine validates the incoming legacy application data. This provides an open framework for you to bring data from legacy systems into Oracle Advanced Planning.

**Planned Inventory Points**

During manufacturing, certain items may need to be used up prior to a specific time or they need to be transformed or consumed into another item. This can occur because an item is chemically or mechanically unstable or because there is no physical storage space allocated for the item on the shop floor. ASCP allows you to specify if an item can be stocked via the Planned Inventory Point (PIP) attribute for the item at the Item-Organization level. It schedules jobs for non-PIP items even if the jobs do not have demands to peg to, and continues to create supplies and schedules the supplies for higher-level items on the bill all the way up to and including the next Planned Inventory Point item. A new plan option (Move Jobs to PIP) turns this scheduling behavior on.
Backward/Forward Forecast Consumption

Backward/forward forecast consumption days create a window of time in which to compare sales orders and forecasted demand for the purposes of forecast consumption. Previously, you could only specify backward/forward forecast consumption days in a forecast set, consume the forecasts in the forecast set during Master Demand Schedule load, and then collect the resulting MDS to the APS planning server for use by ASCP as independent demand. However, for forecast scenarios generated within Oracle Demand Planning and fed directly into ASCP as independent demand, there was no mechanism for specifying backward/forward forecast consumption days. Now, you can specify these parameters at the plan level via new fields in the ASCP plan options form.

Partial Demand Satisfaction

When multiple supplies are required to satisfy a single demand, Oracle ASCP sets the demand satisfied date to be the due date of the latest supply. By default, it also tries to realign the dates of the earlier supplies with the demand satisfied date so that inventory is held for as little time as possible. When the demand is satisfied late, this realigns all the supplies to be late, even though it may be possible to ship out some of the supplies on time (by the demand due date).

Partial Demand Satisfaction is a new scheduling feature that causes the supplies that can be available by the demand due date to be planned for that date, with the remainder of the supplies planned for the demand satisfied date. This allows you plan for sending a partial shipment to your customer by the customer's due date.

Flexible Shift Times

Previously, ASCP restricted resource shift breaks to occur on the hour. A shift could start or end on, say, 11:00, but could not start or end on 11:15. ASCP now permits resource shift start and end times at any minute within the hour.

Minimum Transfer Quantity Phase 2

Oracle ASCP allows you to specify a Minimum Transfer Quantity (MTQ), which is the minimum amount of completion of an operation that is required to trigger the start of the next operation. MTQ is used to model production operations in which materials are transferred in lots smaller than the processing lots, resulting in subsequent operations that start before the current operation is completely finished. You can specify Minimum Transfer Quantities between routings as well as between operations of a routing. Oracle ASCP respects Minimum Transfer Quantity while scheduling operations.
In this release the functional enhancements to MTQ logic are:

- In the process of scheduling an operation, Oracle ASCP dynamically uses the production rate of the selected alternative resource to determine when to begin the material transfer to the subsequent operation.
- Production breaks are honored.

**Targeted Replacement of Business Entities in Collections**

Collections is the process by which data from execution/ERP transaction systems are loaded periodically into the ASCP planning server for use during planning. It can constitute a significant fraction of the duration of the overall planning cycle. This enhancement allows the collections duration to be reduced in cases where information about just some, but not all, planning-related business entities on the planning server needs to be updated.

Heretofore, ASCP has supported two modes of collection. Complete Refresh mode clears all transaction data from the planning server, then copies over information about the user-selected entities. Net Change mode copies only incremental changes to business entities to the planning server (and is thus faster), but is supported mainly for demand and supply business entities only. The new Targeted Replacement mode clears from the planning server transaction data for only the user-selected business entities, and then copies the entity information over from the transaction instance. Information about non-selected entities remains intact on the planning server. All planning business entities are supported by Targeted Replacement collections.

**Enforce Sourcing Splits**

Supplier contracts may require that a company source its materials from suppliers based on specified allocation percentages. Similarly, requirements such as labor agreements may necessitate adherence to sourcing allocation percentages from internal organizations. You can tell Oracle Advanced Supply Chain Planning to enforce (and not override on the basis of cost considerations) sourcing percentages specified in sourcing rules and bills of distribution when it makes sourcing decisions.

**Floating Point Precision Profile Options**

Certain quantities (usages in routings, planned order quantities, transportation lane capacities by weight by volume, and planned order start and end times) used by ASCP may in practice have fractional (non-integer) values, but for the purposes of internal processing by the ASCP planning engine are required to have integer
values. ASCP addresses this problem by providing five floating-point precision profile options that act as internal multipliers. When one of the concerned quantities is encountered, it is multiplied by the appropriate floating-point precision profile option value, and the resulting equivalent integer is processed by the ASCP planning engine. The functional enhancement with this release is that the number of floating-point precision profile options has been increased from one to five. This gives you more flexibility to control the precision with which to consider each quantity, as well as more flexibility to avoid numerical overflow on 32-bit platforms, where the rule is that each equivalent integer processed by ASCP must not exceed approximately 210000000.

The five floating-point precision profile options are:

1. MSO: Floating Point Precision for Usages in Routings
2. MSO: Floating Point Precision
3. MSO: Floating Point Precision for Transportation Capacities (Weight)
4. MSO: Floating Point Precision for Transportation Capacities (Volume)
5. MSO: Floating Point Precision for Planning Bucket Efficiency

**Engineering Change Order Use-Up Effectivity**

ASCP calculates use-up effectivity dates for engineering change orders (ECO). The use-up effectivity date is determined to be the day when the on-hand quantity for an item will be exhausted based on projected gross requirements. This date is calculated for all items in the plan (from end assembly items down through components). ASCP considers scheduled receipts in calculating the use-up effectivity date if the profile option MRP:Include Schd Rcpts in Use-up is set to Yes. The recommended use-up effectivity date is pushed to the source system (Oracle Engineering) by running the current program Push Plan Information.

All items used in the plan are updated with recommended use-up dates. You can override the recommended use-up effectivity date in Oracle Engineering by querying the ECO, selecting the item, and modifying the use-up date.

**Avoiding Excess Splitting of Planned Orders**

In optimized plans, ASCP by default generates a separate planned order for each item in each planning period (if demand/supply netting indicates that creation of planned order supply in the planning period is necessary.) Even if the planned orders create requirements on the same resource or line for the same item in
consecutive planning periods, there will be separate planned orders for each planning period for the item.

You might end up with a planned order for Item A, quantity 100 on Day 1 that results in requirements on Processing Line 1, and a planned order for quantity 150 on Day 2 that results in requirements on the same Processing Line 1. This is best from a scheduling flexibility point of view, because it allows ASCP to time shift or offload the second planned order independently of the first. However, it may cause a higher number of work orders on the shop floor than desired, and may also result in scheduling inaccuracy if the routing for Item A incorporates setup as the first operation because separate planned orders result in an extraneous setup being incurred on Day 2 in our example.

You can now direct ASCP to create, in the above example, a single consolidated planned order for 250 on Day 2. Consolidated planned orders will still be split if resource or line capacity so dictates. In the above example, if the capacity of Processing Line 1 is 100/day, and an alternate Processing Line 2 is available on Day 2, then two separate planned orders would be created: Item A, quantity 200, Day 2, Processing Line 1; Item A, quantity 50, Day 2, Processing Line 2.

**Support for Procurement of Configured Assemblies**

When planned orders for purchased configured items are released, ASCP passes the configuration bill of materials on to Oracle Purchasing so that it can be attached to the resulting purchase order to the supplier.

**Data Setup Audit Reports**

The Audit Statement Report concurrent request checks for common data setup errors that can lead to collection or plan failures or incorrect planning outputs. You can run the report for any of the following data setup areas:

- Collections Data Setup
- Planning Data Setup
- UI Data Setup

You can control the level of detail of the resulting audit report. The supported levels of detail are: Summary; Detailed - Errors Only; Detailed - Errors and Warnings; Detailed - Complete (a complete listing of errors and warnings along with properly executed data setups).
Oracle Inventory Optimization

Oracle Inventory Optimization is a comprehensive, Internet-based inventory planning solution that determines, on the basis of demand, supply and lead-time variabilities, when and where to hold inventories across the supply chain and extended supply chain so as to attain desired customer service levels. Oracle Inventory Optimization is a strategic planning tool that addresses the following key business issues:

- How can I improve customer service while reducing inventory?
  - How can I make inventory postponement decisions?
  - How can I manage demand and supply variability?
- How can I identify my strategic sources?

Key capabilities of Oracle Inventory Optimization are:

- Considers Demand, Supply and Lead Time Variability. Oracle's exclusive stochastic optimization technology allows the interdependence of demand, supply and lead time variabilities to be accounted for when generating time-phased safety stock recommendations.
- What-if Capability. Oracle Inventory Optimization allows multiple inventory planning scenarios (featuring, for example, different sets of customer service levels, different demand/supply variabilities) to be quickly evaluated, and the results to be graphically compared.
- Integration to Oracle Advanced Supply Chain Planning. The safety stock recommendations of Oracle Inventory Optimization can be automatically fed into Oracle Advanced Supply Chain Planning to drive tactical supply chain planning decisions.

New Inventory Optimization Features

Inventory Optimization Reports

Users of Oracle Supply Chain Intelligence have access to a series of reports designed for analysis of Inventory Optimization output. These reports facilitate strategic decisions such as "What product lines, sales channels or customers should I focus my investments on (because they are the most profitable)?" or "What service level do I need to achieve in order to hit my revenue target?"
These reports contain both graphic and tabular content. You can view them along different dimensions and at varying levels of detail. The following is a list of the reports:

**Planned Service Level vs. Profit**  This report shows you graphically the correlation between profit and service level. This information helps you to determine the service level you should target in order to meet your revenue or profit objectives.

**Planned Service Level**  This report shows you the service level that can be attained given the constraints that you have. You can view planned service level by customer to understand which customers you should serve better in order to maximize your profit.

**Planned Cost Breakdown Summary**  This report shows you the breakdown of your product cost. Product cost includes production cost, purchasing cost, carrying cost and penalty costs. You can view the cost breakdown for a product line to understand how you can improve the profit margin of that product line.

**Planned Purchasing Cost**  This report shows you where you are spending your purchasing money. You can view purchasing cost by supplier and purchasing cost by item to understand which suppliers and items consume the largest proportion of your procurement budget, and therefore where you should focus procurement savings efforts.

**Planned Inventory Value**  This report shows you the Inventory Optimization-prescribed carrying costs and inventory values for different locations within your supply chain. Within a location (organization), you can view prescribed carrying costs and inventory values for finished goods, subassemblies and raw materials. This report tells you what inventory to hold, and where to hold it.

**Planned Gross Profit**  This report shows you the revenue and profit breakdown for a specific service level. You can view revenue and profit breakdown by product line to understand which product lines you need to focus on to improve your bottom line.

**Cumulative Demand Distribution**

You can specify demand uncertainty in terms of a cumulative probability distribution. This is in addition to the existing functionality of being able to specify demand uncertainty in terms of a (non-cumulative) probability distribution. A new profile option MSR: Probability Distribution Type allows you to indicate whether the demand variability is in terms of forecast set probabilities or in terms of forecast...
set cumulative probabilities. You can view the demand probability in the Supply/Demand window of the Planner Workbench.

**Enforce Sourcing Splits**
Supplier contracts may require that a company source its materials from suppliers based on specified allocation percentages. Similarly, requirements such as labor agreements may necessitate adherence to sourcing allocation percentages from internal organizations. You can tell Oracle Inventory Optimization to enforce (and not override on the basis of cost considerations) sourcing percentages specified in sourcing rules and bills of distribution when it makes sourcing decisions.

Sourcing percentages are enforced for Rank 1 sources only.

**Sourcing Allocation Window** You can specify a Sourcing Allocation Window in days (say, \(x\) days). The intent of this parameter is to allow Inventory Optimization some flexibility to trade off strict adherence to the allocation percentages in sourcing rules against more cost-effective sourcing decisions. Inventory Optimization will ensure that sourcing decisions are made such that at only the end of every \(x\) days, the cumulative supply sourced from any supplier or internal organization matches the percentage allocation in the sourcing rule as closely as possible. (In between, the sourcing may differ from the rule.) You can specify this parameter via a profile option called MSO: Sourcing Allocation Window.

**Allocation History Start Date** You can specify a global allocation percentages start date from which the sourcing history is collected and accumulated for making sourcing decisions. This is done via the new profile option called MSC: Start Date Offset for Sourcing History (Months).

**Exceptions** You can specify a tolerance band for the difference between the user-specified allocation percentages and the plan-derived allocation percentages. If the difference is greater than the tolerance, then an exception will be triggered. The tolerance is specified in the new profile option called MSC: Sourcing Variance Tolerance.

**Inter-Organization Allocations** The allocation percentages are enforced for all sourcing types:
- External supplies from suppliers
- Transfer supplies from internal organizations
- Make supplies within an organization
Item Purchase Price by Supplier

In its inventory planning calculations, Inventory Optimization considers item purchase prices that vary by supplier site. The prices are obtained by taking the unit prices from applicable purchase order lines. If multiple purchase order lines are applicable, the maximum unit price is used.

Data Setup Audit Report

The Audit Statement Report concurrent request checks for common data setup errors that can lead to collection or plan failures or incorrect planning outputs. You can run the report for any of the following data setup areas:

- Collections Data Setup
- Planning Data Setup
- User Interface Data Setup

You can control the level of detail of the resulting audit report. The supported levels of detail are: Summary; Detailed - Errors Only; Detailed - Errors and Warnings; Detailed - Complete (a complete listing of errors and warnings along with properly executed data setups).
Oracle Global Order Promising

Oracle Global Order Promising is a comprehensive, Internet-based order promising solution that determines, on the basis of the current and projected demands and supplies across a supply chain and an extended supply chain, when a customer order can be fulfilled. Oracle Global Order Promising addresses the following key business issues:

- How can I promise the most accurate dates?
- How quickly can I respond to a customer request?
- How can I get availability information from anywhere?

Key capabilities of Oracle Global Order Promising are:

- Available-To-Promise/Capable-To-Promise/Capable-To-Deliver. Oracle Global Order Promising can calculate promise dates on the basis of not just current on-hand supplies (available-to-promise), but also on the basis of future demand versus supply. It checks for availability at multiple bill-of-material levels and at multiple supply chain locations, drilling down into resource and supplier capacities as necessary (capable-to-promise). It also considers intransit resources and lead times in its calculations.

- Flexible and Configurable. Oracle Global Order Promising’s order promising solution is flexible and configurable. You can control the list of potential sources to be considered in the availability check. You can also control the number of levels in your supply chain bill to be considered in your check. At each level in the supply chain bill, you can specify the key components and bottleneck resources for which to check availability. You can also check the group availability of products that must ship together.

- Global Access. Oracle Global Order Promising is implemented as a PL/SQL package which is callable from web stores, order entry applications such as Oracle Order Management, and from the menu structure of the Oracle Advanced Planning Suite.

- Single Statement of Availability. You can consolidate data from multiple instances and different versions of Oracle Applications. Existing Oracle Applications Release 10.7 and 11.0 customers need not upgrade other applications. Multiple Order Entry systems can thus access a global statement of availability.

- Scalability. Oracle Global Order Promising leverages the multi-threading capabilities of the Oracle database to provide support for multiple concurrent order promising requests. Locking and read consistency of the data are
maintained so that the same supply is never promised to multiple concurrent users.

**New Global Order Promising Features**

**Consideration of Batch Resources During Capable-to-Promise Checks**
Oracle Global Order Promising considers batch resource constraints during capable-to-promise (CTP) checks based on planning data. Batch resources are resources that can process multiple items/multiple units simultaneously. Order Promising respects batch resource capacities in the form of units, weight, or volume over time. Order Promising Batch resource constraints are honored only when all of the following conditions are met:

- Order promising is based on planning output.
- The plan upon which order promising is based respects resource constraints.
- Routing aggregation in the plan is at the Routing (not Bill of Resource) level.
- Item aggregation in the plan is at the Item (not Product Family) level.
- The profile option MSO: Global Batchable Flag is set to Yes.

When performing CTP calculations, Order Promising ignores the resource batching window.

**Regional Level Sourcing Support in Global Order Promising**
In order to provide accurate promise dates to its customer, a company needs to specify which of its facilities or warehouses serve each customer, and the transit times between each of the company's facilities and each customer site. This can lead to a large data maintenance problem for companies with many (say, thousands of) customers. To address this data maintenance problem, Oracle Shipping and Oracle Global Order Promising have been enhanced to respect sourcing rules tied to geographic regions, transit lead-times between geographic regions, and transit lead-times between organization locations and geographic regions.

**Geographic Regions and Zones** Oracle Shipping supports country, state/province, county, city and zip code geographic region levels. In addition, you can group the regions into user-defined zones. For example, you can group all the west coast states into a zone called West Coast.
Transit Times Based on Region or Zone  Oracle Shipping has enhanced the Transit Lead Time form to allow you to enter, for each ship method, a transit lead-time between your warehouse location and a geographical region or zone.

Sourcing Rules at Region or Zone Level  You can assign a sourcing rule to any region or zone. The prescribed sourcing will default down to any customer site within the region or zone. If a more specific sourcing assignment exists (for example, a customer site-specific assignment), then it will override the default.

Order Promising Based On Region and Zone Level Sourcing  When calculating promise dates, Global Order Promising will determine which region or zone level sourcing rule applies to the customer site initiating the inquiry and apply the relevant organization location-to-region/zone transit time.

Improved ATP Performance Based on Summarized Demand and Supply  Order promising response times have been improved by means of a summary approach that stores summary supply and demand information in a separate table. It allows each ATP request to quickly retrieve summarized availability information without computing availability from detailed supply and demand.

The summary approach is supported whether you promise orders based on collected data or planning output. The summary process is automatically run after each data collection or planning run.

This feature is supported for non-distributed environments only, in which the transaction data source and the Global Order Promising planning server are on the same database instance. Thus it is of most benefit to Order Management users who do not use Advanced Supply Chain Planning. ASCP users who have deployed ASCP on a separate planning server instance than their transaction data source instance will not be able to use this feature.

Order Promising for Unplanned Items  Global Order Promising calculates promise dates on the basis of either planning output or transaction data. The former is required for capable-to-promise checks. Previously, when you performed order promising inquiries on the basis of planning output (by setting the profile option INV: Capable to Promise to Enable PL/SQL based ATP with Planning Output), the inquiry returned with an unsuccessful status if the item could not be found in the ATP plan. Now, when that situation arises, Global Order Promising will automatically revert to an ATP inquiry on the basis of transaction data; that is, internally perform a second check as if the INV: Capable to
Promise profile option had been set to Enable PL/SQL based ATP without Planning Output, and return that result.

---

**Note:** Unplanned items refer to items not appearing in the ATP plan, not to items with the Planning Method item attribute of Not Planned.

---

**Simplification of ATP Data Collection from Order Management**

ATP Data Collection is used to refresh the transaction data used for ATP purposes. It is intended for use by customers who perform simple (single-level) ATP checks from Order Management. This process is invoked from the Order Management menu.

In order to streamline the user experience when invoking this process, the number of input parameters have been reduced. The input parameters which formerly specified which types of business object data to collect (on-hand, work-in-process, and so forth) have been eliminated. The following is a list of the new input parameters:

- **Instance:** the user-defined code for the transaction data instance
- **Number of Workers:** number of processes used to pull transaction data
- **Timeout (minutes):** the collection process will error out if it has not finished within the specified time
- **Collection Type:** Complete Refresh or Net Change
- **Sales Orders Collection Type:** Complete Refresh or Net Change

Specifying Collection Type = Complete Refresh; this refreshes all transaction data used for order promising.

Specifying Collection Type = Net Change; this enables a faster process, but refreshes only demand and supply data.

The Sales Order Collection Type should typically be set to Net Change for computational burden reasons (even if Collection Type is set to Complete Refresh); it can be set to Complete Refresh when a complete purging of the data used for order promising calculations is deemed necessary.
Data Setup Audit Report

The Audit Statement Report concurrent request checks for common data setup errors that can lead to collection or plan failures or incorrect planning outputs. You can run the report for any of the following data setup areas:

- Collections Data Setup
- ATP Data Setup

You can control the level of detail of the resulting audit report. The supported levels of detail are: Summary; Detailed - Errors Only; Detailed - Errors and Warnings; Detailed - Complete (a complete listing of errors and warnings along with properly executed data setups).
Topics covered in this section include the following:

- Setup Overview on page 2-2
- Deployment Configurations on page 2-2
- Setup Flowchart on page 2-6
- Setup Steps for the Source on page 2-7
- Setup Steps for the Destination on page 2-13
Setup Overview

This section describes setup steps for Oracle Advanced Supply Chain Planning, Oracle Global Order Promising, and Oracle Inventory Optimization. Set up for Oracle Demand Planning is briefly covered for the sake of completeness, but is described fully in the Oracle Demand Planning Installation and Configuration Guide.

Deployment Configurations

The first step in the setup process is to decide on the overall hardware configuration.

Oracle Advanced Planning Suite has a component architecture that separates the transaction data and associated processing (for example, inventory receipts and order entry) in a source instance from the planning calculations done in a destination instance. This allows planning calculations to be done on a different physical machine than the machine that performs transactions and results in better system response. It also allows planning calculations (demand planning, inventory planning, supply planning and order promising) to be applied simultaneously to information from across multiple source instances, which is useful when transaction information for a global supply chain is spread across multiple instances. Oracle Demand Planning also uses a third instance, an Express database, to hold data while multi-dimensional manipulation of demand data occurs.

The source can be any ERP system, but out-of-the-box integration to the Oracle Advanced Planning Suite destination instance (planning server) exists if the source is Oracle Applications Release 10.7, 11.0 or 11i. The planning server is an 11i instance.

One-Machine Implementation

For small implementations, source, destination, and Express can reside on the same machine and be in the same instance. The following figure illustrates this configuration.

---

**Note:** ASCP means Advanced Supply Chain Planning and DP means Demand Planning.
Two-Machine Implementation

For larger implementations where system throughput is more important, the various instances can be deployed on separate machines. A two-machine deployment configuration is appropriate when the size of the demand planning data is relatively small. The following figure illustrates this configuration.
Three-Machine Implementation

A three-machine deployment allows for the manipulation of high-dimensionality, large-scale demand planning data to occur on a machine separate from the planning calculations done on the planning server. The following figure illustrates this configuration.
Four-Machine Implementation

The Advanced Supply Chain Planning concurrent manager may also be deployed on a separate machine. This creates even greater system performance. The following figure illustrates the four-machine implementation.
In all deployment configurations, a collection process brings data from the source to the destination (planning server). A build process brings data from the planning server to the Express engine. A separate collection process takes data from the Express engine back to the planning server. Finally, a publish process takes data from the planning server back to the source Oracle Applications instance.

Global Order Promising and Inventory Optimization planning calculations are also performed on the planning server.

**Setup Flowchart**

Set up for Oracle Advanced Planning Suite consists of steps for the source, steps for the destination, and steps for Express. Steps for Express are covered in the *Oracle Demand Planning Installation and Configuration Guide*.

The following figure is a flowchart illustrating the source and destination setup steps.
Setup Steps for the Source

1. Install the source instance patch

Before beginning the functional setup of the source instance(s), a patch must be applied that will create several new concurrent programs, flexfields, profile options, and database objects on the source database. The patch that is required is determined by the versions of the application and database on the source instance. The current patch requirements are given in the table below.

<table>
<thead>
<tr>
<th>Applications version</th>
<th>RDBMS version</th>
<th>Patch</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>8.x</td>
<td>1238811</td>
</tr>
<tr>
<td>10.7</td>
<td>8.0</td>
<td>1260711</td>
</tr>
<tr>
<td>10.7</td>
<td>7.3</td>
<td>1268507</td>
</tr>
</tbody>
</table>
When successfully applied, the patch should:

- Create the Create Planning Flexfields, Create Global ATP Flexfields, and Refresh Snapshot programs under the All SCP Reports Request group.
- Create several new profile options prefixed by MRP as listed below, and described fully in Appendix A, Profile Options.
  - MRP: ATP Components at Item Level
  - MRP: ATP Database Link
  - MRP: Aggregate resource name flexfield attribute
  - MRP: Check ATP at Bill Level
  - MRP: Check ATP at Item Level
  - MRP: Check CTP at Department Resource Level
  - MRP: Check CTP at Routing Level
  - MRP: Cost of using a BOM/Routing flexfield attribute
  - MRP: Penalty cost factor for exceeding material capacity (Organization) flexfield
  - MRP: Penalty cost factor for exceeding material capacity (Supplier-Item) flexfield
  - MRP: Penalty cost factor for exceeding material capacity flexfield attribute
  - MRP: Penalty cost factor for exceeding resource capacity (Organization) flexfield
  - MRP: Penalty cost factor for exceeding resource capacity (Resource) flexfield
  - MRP: Penalty cost factor for exceeding transportation capacity (Organization)
  - MRP: Penalty cost factor for exceeding transportation capacity flexfield attribute
  - MRP: Penalty cost factor for late demands (Organization) flexfield attribute
  - MRP: Penalty cost factor for late demands flexfield attribute
  - MRP: Penalty cost factor for late forecasts
  - MRP: Penalty cost factor for late sales orders
Setup Steps for the Source

- MRP: Plan Revenue Discount Percent
- MRP: Plan Revenue Price List
- MRP: Principal Resource for operation flexfield attribute
- MRP: Principal resource for an operation flexfield attribute
- MRP: Priority for substitute items flexfield attribute
- MRP: Priority of resources for an operation
- MRP: Resource group for a line flexfield attribute
- MRP: Resource step number flexfield attribute

Create several new database objects that will be used in the data pull process

2. Create a database link pointing to the planning server.

**Note:** Before beginning the installation of the source patch, count all (if any) invalid database objects. If after the patch is installed there are more invalid objects than before, there was a problem with the patch application.

A database link must be established on the source instance that points to the destination (11i planning) instance. This database link will be referenced in a newly created profile option, MRP: ATP Database Link, discussed in Step 7. This database link will also be used, along with a database link established on the destination instance, in setting up the instances on the planning server.

3. Create an Advanced Supply Chain Planner responsibility.

You must create a responsibility in the source instance that conforms to the following specifications:

Responsibility Name: Advanced Supply Chain Planner
Application: Oracle Manufacturing
Description: Used for running ASCP Report
Menu: SCP_TOP_4.0
Data Group Name: Standard
Setup Steps for the Source

This responsibility is used to run the concurrent program Refresh Snapshot during all data collection runs. The data collection process is discussed in Chapter 4, Running Collections for ASCP.

**WARNING:** The responsibility name must match Advanced Supply Chain Planner exactly. During the data collection process which runs on the destination server, the Refresh Snapshot program is launched automatically in the source from this responsibility. The refresh snapshot process will not complete properly if the responsibility name is not correct.

The Create Planning Flexfields concurrent program creates new segment definitions in existing descriptive flexfields to hold data that may be required for constrained and/or optimized planning. The program also populates profile values with the value corresponding to the descriptive flexfield attribute number for each attribute (planning parameter) created. The table below shows the descriptive flexfield attributes that are required, the name of the attributes that are created, the tables in which the data resides, and the profile options that correspond to each attribute.

<table>
<thead>
<tr>
<th>Descriptive Flexfield Names</th>
<th>Parameter Name</th>
<th>Base Table Name</th>
<th>Profile Option Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items</td>
<td>Late Demands Penalty (Item)</td>
<td>MTL_SYSTEM_ITEMS</td>
<td>MRP: Penalty cost factor for late demands flexfield attribute</td>
</tr>
<tr>
<td>Items</td>
<td>Material Over-Capacity Penalty (Item)</td>
<td>MTL_SYSTEM_ITEMS</td>
<td>MRP: Penalty cost factor for exceeding material capacity flexfield attribute</td>
</tr>
<tr>
<td>Organization Parameters</td>
<td>Late Demands Penalty (Org)</td>
<td>MTL_PARAMETERS</td>
<td>MRP: Penalty cost factor for late demands (Organization) flexfield attribute</td>
</tr>
<tr>
<td>Organization Parameters</td>
<td>Material Over-Capacity Penalty (Org)</td>
<td>MTL_PARAMETERS</td>
<td>MRP: Penalty cost factor for exceeding material capacity (Organization) flexfield attribute</td>
</tr>
<tr>
<td>Descriptive Flexfield Names</td>
<td>Parameter Name (In flexfield form and report parameter)</td>
<td>Base Table Name</td>
<td>Profile Option Name</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------------------------------------------------</td>
<td>----------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Organization Parameters</td>
<td>Resource Over-Capacity Penalty (Org)</td>
<td>MTL_PARAMETERS</td>
<td>MRP: Penalty cost factor for exceeding resource capacity (Organization) flexfield</td>
</tr>
<tr>
<td>Organization Parameters</td>
<td>Transport Over-Capacity Penalty (Org)</td>
<td>MTL_PARAMETERS</td>
<td>MRP: Penalty cost factor for exceeding transportation capacity (Organization)</td>
</tr>
<tr>
<td>Department Resource Information</td>
<td>Aggregate Resources</td>
<td>BOM_DEPARTMENT _RESOURCES</td>
<td>MRP: Aggregate resource name flexfield attribute</td>
</tr>
<tr>
<td>Department Resource Information</td>
<td>Resource Over-Capacity Penalty (Resource)</td>
<td>BOM_DEPARTMENT _RESOURCES</td>
<td>MRP: Penalty cost factor for exceeding resource capacity (Resource) flexfield</td>
</tr>
<tr>
<td>Attribute (Purchasing)</td>
<td>Material Over-Capacity Penalty (Supplier)</td>
<td>PO_ASLATTRIBUTES</td>
<td>MRP: Penalty cost factor for exceeding material capacity (Supplier-Item) flexfield</td>
</tr>
<tr>
<td>Substitute Component Information</td>
<td>Substitute Items Priority</td>
<td>BOM SUBSTITUTE COMPONENT</td>
<td>MRP: Priority for substitute items flexfield attribute</td>
</tr>
<tr>
<td>MTL Interorg ship methods</td>
<td>Transport Over-Capacity Penalty (Ship Method)</td>
<td>MTL_INTERORG_SHIP_METHOD</td>
<td>MRP: Penalty cost factor for exceeding transportation capacity flexfield attribute</td>
</tr>
<tr>
<td>Bill of Material Information</td>
<td>BOM/Routing Cost</td>
<td>BOM BILL_OF_MATERIALS</td>
<td>MRP: Cost of using a BOM/Routing flexfield attribute</td>
</tr>
<tr>
<td>MRP Forecast Dates</td>
<td>Late Forecasts</td>
<td>MRP FORECAST_DATES</td>
<td>MRP: Penalty cost factor for late forecasts</td>
</tr>
<tr>
<td>Additional Line Information</td>
<td>Late Sales Order Penalty</td>
<td>SO_LINES</td>
<td>MRP: Penalty cost factor for late sales orders</td>
</tr>
<tr>
<td>Production Line</td>
<td>Resource Group (Line)</td>
<td>WIP_LINES</td>
<td>MRP: Resource group for a line flexfield attribute</td>
</tr>
</tbody>
</table>

4. Launch the Create Planning Flexfields report from the newly created Advanced Supply Chain Planner responsibility. The parameters that must be set for the report are the attributes that you wish to utilize for the new flexfield definitions.
The list of values for each parameter lists only the available attributes in the subject descriptive flexfield.

**Note:** Keep track of the attribute number that you select for each flexfield segment. You will need to verify that each corresponding profile option was populated with the correct attribute number when the process completes.

After submitting the program, eleven additional processes should be spawned. These jobs are compiling the descriptive flexfield views.

**WARNING:** Check that the profile values corresponding to each flexfield attribute were populated with the correct attribute number. Some profile values may retain the value of unassigned after the Create Planning Flexfield program completed. You must change any unassigned profiles to the attribute number corresponding to the flexfield attribute where the new segment was defined.

5. Create the Global Order Promising flexfields.

   The Create Global ATP Flexfields is very similar to the Create Planning Flexfields program. It creates new flexfield segments to hold global ATP data at the item, BOM, routing, and resource levels. The same process, including warnings and suggestions, applies for the Create Global ATP Flexfield program.

6. Set up source data with BOMs, resources, routings, supplier data, flexfields, purchasing information, item masters, Oracle BIS targets, and any other data required by your plans.

7. Set profile values.

   If Global Order Promising is going to be utilized, the following two additional profile options must be set.

   The MRP: ATP Database Link profile option must be set with the database link. The profile value is the name of the database link that resides on the source and points to the destination. There is no validation on this profile value. If Global Order Promising is not utilized, this need not be set.
Setup Steps for the Destination

The INV: External ATP profile must be set to Global ATP. This is a choice from the list of values. If Global ATP is not utilized, this need not be set.

8. Execute the Refresh Snapshot concurrent program.

The Refresh Snapshot process must be run on the source. This concurrent program is available in the Advanced Supply Chain Planner responsibility created earlier. The process has no parameters to be set at run time. Verify that the process completes without error.

Setup Steps for the Destination

1. Install the destination instance patches.

   After installing the 11i application on the destination server, be sure that the proper patches are applied to the install. The patches can be found on Metalink. Query for patches for the following products:
   - msc - Oracle Supply Chain Planning, Oracle Global Order Promising
   - msd - Oracle Demand Planning
   - mso - Oracle Constraint Based Option
   - msr - Oracle Inventory Optimization

2. Create a database link pointing to each source.

   These links will be needed when defining instances later on in this setup procedure.

3. Define the source instances to be collected from.

   The define instances setup establishes the means of communication between the source and destination instances. It also specifies the organizations in the source database for which data will be pulled.

4. From the Navigator, choose Setup > Instances.

   The Application Instances window appears.
Setup Steps for the Destination

Figure 2–6  Application Instances

![Application Instances Window](image)

Enter each of the Application instances for which you would like the Planning Server to plan.

5. Complete the fields and flags in the Application Instances window as shown in the table below.

**Note:** You are only required to set up Applications Instances before the first time you perform data collection.

<table>
<thead>
<tr>
<th>Field/Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance Code</td>
<td>This is a user-defined 3-character short form for the instance to be planned. It is subsequently prepended by ASCP to organization names and other designators to enable the user to positively identify the owning instance. For example, if two transaction instances TA1 and TA2 are to be planned, and both instances have an internal organization named M1, ASCP will display TA1’s organization as TA1:M1 and TA2’s organization and TA2:M1.</td>
</tr>
<tr>
<td>Instance Type</td>
<td>The valid values here are Discrete, Process, Discrete and Process. This controls whether discrete manufacturing data or process manufacturing data (or both) are collected from the transaction instance to the planner server for planning.</td>
</tr>
<tr>
<td>Version</td>
<td>The Oracle Application version of the transaction instance.</td>
</tr>
</tbody>
</table>
6. Enter the organizations on each of the instances from which to collect the Planning data and plan for on the Planning Server by clicking Organizations. The Organizations window appears.

<table>
<thead>
<tr>
<th>Field/Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Database Link</td>
<td>A link to connect the Applications database(s) to Oracle ASCP. This link is determined by the database administrator. This database link is defined on the transaction instance and points to the planning server. This link is used to publish releases from the ASCP back to the transaction instance as purchase orders or work orders.</td>
</tr>
<tr>
<td>Planning Database Link</td>
<td>A link to connect Oracle ASCP to the Applications database(s). This link is determined by the database administrator. This link is defined on the planning server and points to the transaction instance. This link is used to positively locate the source of the transaction data to be planned.</td>
</tr>
<tr>
<td>Enable Flag</td>
<td>Select this option to enable the collection process.</td>
</tr>
<tr>
<td>GMT Difference</td>
<td>The difference between instance time zone and GMT</td>
</tr>
<tr>
<td>Assignment Set</td>
<td>Enter the default assignment set for this instance. The assignment is used to resolve sourcing for order promising inquiries.</td>
</tr>
</tbody>
</table>
7. Select the organizations for a particular instance. Be sure to select the master organization.

8. Close the Organization window.

9. Save the Instance Definition setup.
Topics covered in this section include the following:

- Business Flows on page 3-2
- A Day in the Life of a Planner on page 3-5
- Specify Sources of Demand on page 3-5
- Run Collections on page 3-6
- Create a Plan on page 3-6
- Launch the Plan on page 3-6
- Review Key Performance Indicators (KPIs) on page 3-6
- Review Exceptions on page 3-7
- Review Workflow Notifications on page 3-8
- View Pegged Supply and Demand on page 3-9
- Modify Objectives on page 3-10
- Modify Supply/Demand on page 3-11
- Modify Resources on page 3-11
- Modify Supplier Parameters on page 3-12
- Run Net-Change on page 3-12
- Release or Firm Orders on page 3-13
Business Flows

This section describes the flows of information between the components of the Oracle Advanced Planning Suite and provides an overview of how these components are to be used together in order to accomplish several key business flows.

Topics covered in this section include the following:

- APS Information Flows
- The Demand-to-Make / Demand-to-Buy Business Flow
- The Inquiry-to-Order Business Flow

APS Information Flows

The major information flows between the components of the Oracle Advanced Planning Suite and the rest of Oracle Applications are shown in the figure below.
The Demand-to-Make / Demand-to-Buy Business Flow

The demand-to-make /demand-to-buy business flow begins with the establishment of independent demands that will drive the activities of the supply chain. On the basis of sales history from Oracle Order Management, Oracle Demand Planning generates statistical demand forecasts. After adjustment by planners, these forecasts are then input into Oracle Inventory Optimization.
Using user-supplied information about the variability of this forecast demand and
the variability of supplier lead times, Oracle Inventory Optimization generates an
optimal time-phased safety stock plan.

Oracle Advanced Supply Chain Planning (hereafter, Oracle ASCP) considers three
streams of independent demand: the safety stock planned demand from Oracle
Inventory Optimization, forecasts from Oracle Demand Planning, and sales order
demand from Oracle Order Management. Oracle ASCP outputs a time-phased
supply plan (planned orders) that can then be released directly to the appropriate
execution systems: Oracle Purchasing, Oracle Work in Process (for discrete
manufacturing), Oracle Process Manufacturing, Oracle Flow Manufacturing, Oracle
Project Manufacturing, or Oracle Shop Floor Management (for semi-conductor
manufacturing).

The Inquiry-to-Order Business Flow

The demand/supply picture output by Oracle ASCP serves as the basis for the
order promising results calculated by Oracle Global Order Promising. Oracle Global
Order Promising can be called either from a customer-facing order capture
application such as a web store or from Oracle Order Management.

In the inquiry-to-order business flow, an inquiry for a potential order is sent from
Oracle Order Management to Oracle Global Order Promising. The fulfillment date
returned by Global Order Promising, if later than the original request date, is
populated as the new request date of the order. This request date validation process
is called scheduling. Once an order is successfully scheduled, then it can be booked
and made visible to Oracle ASCP for supply planning purposes.
Specify Sources of Demand

A Day in the Life of a Planner

This section describes an end-to-end planning flow that a planner might perform during the course of a planning cycle. The flow demonstrates the key features of Oracle ASCP that a typical planner would use in the course of their work.

The general flow that occurs during a planning cycle is shown in the figure below.

Figure 3–1  A Day in the Life of a Planner

Specify Sources of Demand

➢ To specify sources of demand:
1. Load the adjusted (unconstrained) forecasts into a Master Demand Schedule (MDS) for use by Oracle ASCP.

   **Note:** You can generate forecasts using Oracle Master Scheduling/MRP and Oracle Supply Chain Planning, or Oracle Demand Planning. If you generate a forecast using Oracle Demand Planning, you do not have to load an MDS or run collections. The forecast is available directly to Oracle ASCP on the APS Planner Server.

2. Choose MDS > Names to create the name of a new MDS or to use an existing MDS.
3. Choose MDS > Source List to associate individual forecasts with your MDS.
4. Individual forecasts for customers, sales regions, and so on, can be loaded into a single MDS so that all designated forecasts can be planned at once.
5. Choose MDS > Load-Copy-Merge to load merge your new or updated MDS with another MDS.

If you are using basic forecasting and MDS functionality found in Oracle Master Scheduling/MRP and Oracle Supply Chain Planning, see “Overview of Forecasting” in the Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide. If you are using Oracle Demand Planning, see the Oracle Demand Planning User’s Guide.

Run Collections

Run collections to bring planning data from the source instance to the planning server, where the data will be accessible to Oracle ASCP. See “Chapter 4, Running Collections for ASCP” for more information.

Create a Plan

After an MDS has been defined, a Production, Manufacturing, or Distribution plan/schedule can be created.

To create a plan:
1. Choose Supply Chain Plan > Names to create a new plan/schedule or modify an existing plan/schedule.
2. Select Plan Options to specify plan options.
3. Save your work.

See Chapter 5, "Defining Plans" for more information.

Launch the Plan

After you have created your MRP, MPS, or DRP plan/schedule and saved it, choose the plan from [Production, Manufacturing, or Distribution Plan] > Names and select Launch Plan.

You can view the run status of your plan by choosing Other > Requests.

Review Key Performance Indicators (KPIs)

Once your new plan has completed running, you can evaluate the performance of the plan by comparing it to Key Performance Indicators (KPIs). Evaluating a plan
based on its impact to KPIs is a good way to see the high level impact of the plan without doing off-line analysis and looking at plan details to see which demand is fulfilled on time and which is not.

The Key Indicators compare actual plan values to target values defined in the Target Repository. Evaluating plans against KPIs lets you select the plan which best meets organizational objectives that you have defined.

You can drill down to the trend over time using the right-mouse menu.

**To review KPIs for a plan:**

1. Navigate to the Planner Workbench.
2. Choose either the Organizations tab or the Items tab in the left pane.
3. Select the Key Performance Indicators tab in the right pane.
4. In the left panel, select the plan to evaluate or the plans to compare.
5. View the results on the graphs in the right panel.

See Chapter 10, “Planner Workbench/User Interface” and Chapter 9, “Performance Management” for more information.

**Review Exceptions**

After you have evaluated your plan(s) based on KPIs, you can evaluate a plan based on the number and types of exceptions it generates. Reviewing the exceptions generated by a plan lets you evaluate a plan’s performance in more detail than a KPI comparison provides. For each exception type displayed in the Planner Workbench, you can click and drill down on an exception to get more detailed information about the nature of the exception.

Oracle ASCP provides a range of exception messages for all plans. You can easily manage your plan by displaying only those items and orders that require your attention, and you can further narrow your search using other criteria such as by buyer or by line. By saving the exception messages each time you replan simulations, you can compare different versions of the same plan or analyze the strengths and weaknesses of a single plan.

For guidelines on evaluating and interpreting the exceptions generated by your plan, see Chapter 9, “Performance Management.”
To review exceptions for a plan:

1. Navigate to the Planner Workbench.

2. Choose the Organizations or Items tab in the left pane and select the plan(s) for which you want to view exceptions.

3. Choose the Actions tab on the right portion of the window. Exceptions are displayed by exception type on the top portion of the window. Exception counts can be viewed graphically at the bottom of the window.

4. Double click on an exception to drill down to detail.

Refer to Chapter 9, “Performance Management” for more information.

Review Workflow Notifications

Oracle ASCP’s powerful collaboration features enable you to automate and streamline your interactions with customers and suppliers.

You can automate the processing of exceptions which lets you take corrective action more quickly and efficiently, driving overhead costs out of your process.

You can define the process that a Workflow Notification should follow which includes the routing for the exception notifications, actions available to the recipient of the notifications, and the approval steps. The messages can be viewed either in Applications (see on page 3-7, “Review Exceptions”) or via e-mail. Certain response actions may be required.

---

**Note:** Oracle ASCP comes with five standard workflow processes which generate various types of exceptions, which is shown in the table below.
**View Pegged Supply and Demand**

You can easily analyze the impact of changing a supply or demand order at any level of your bill of material using the powerful graphical pegging feature. Full pegging traces supply information for an item to its corresponding end demand details. Full pegging can also link a demand order to all corresponding supply. You can trace a purchased item or subassembly shortage to the sales order that would be affected. You can use this information to prioritize critical material and capacity resources.

---

**Table 3–1**

<table>
<thead>
<tr>
<th>Process</th>
<th>Exception Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Workflow</td>
<td>• Item is over committed</td>
</tr>
<tr>
<td></td>
<td>• Item has a shortage</td>
</tr>
<tr>
<td></td>
<td>• Item has excess inventory</td>
</tr>
<tr>
<td></td>
<td>• Items with expired lots</td>
</tr>
<tr>
<td></td>
<td>• Past due forecast</td>
</tr>
<tr>
<td></td>
<td>• Late supply pegged to a forecast</td>
</tr>
<tr>
<td></td>
<td>• Items below safety stock</td>
</tr>
<tr>
<td>Rescheduling Workflow</td>
<td>• Item has orders to be rescheduled in</td>
</tr>
<tr>
<td></td>
<td>• Item has orders to be rescheduled out</td>
</tr>
<tr>
<td></td>
<td>• Item has orders to be cancelled</td>
</tr>
<tr>
<td></td>
<td>• Item has orders with compression days</td>
</tr>
<tr>
<td></td>
<td>• Item has past due orders</td>
</tr>
<tr>
<td>Sales Order Workflow</td>
<td>• Past due sales orders</td>
</tr>
<tr>
<td></td>
<td>• Late supply pegged to a sales order</td>
</tr>
<tr>
<td>Project Workflow</td>
<td>• Items with shortage in a project</td>
</tr>
<tr>
<td></td>
<td>• Items with excess in a project</td>
</tr>
<tr>
<td></td>
<td>• Items allocated across projects</td>
</tr>
<tr>
<td>Material Workflow</td>
<td>• Material constraint (supplier capacity constraint)</td>
</tr>
</tbody>
</table>

See the *Oracle Workflow Guide* for more information on creating notifications and building new workflows.
Modify Objectives

To use graphical pegging you must select Pegging in the Plan Options window. You must also have the Pegging item attribute (in Oracle Inventory) set to one of the pegging options.

See Chapter 10, “Planner Workbench/User Interface,” and Chapter 9, “Performance Management,”. Also, please refer to “Item Attribute Controls” in the Oracle Inventory User’s Guide for more information.

Modify Objectives

If you are unsatisfied with the results of your plan, you may wish to change your optimization objectives to improve the plan’s performance against KPIs or reduce the number of exceptions.

Available Supply Chain Optimization objectives are:

- Maximize Inventory Turns
- Maximize Plan Profit
- Maximize On-time Delivery

To run an optimized plan:

Choose Supply Chain Plan > Options > Optimization tab to check the Optimization check box and adjust optimization objectives or associated penalty costs.

Once you have changed objectives, you can run a new, separate plan, or you can run a simulation in net change mode to view only the differences between the baseline plan and the simulated plan.

See Chapter 8, "Optimization" and Chapter 7, "Simulations" for additional information.

Alternatively, you may evaluate your plan or check feasibility based on available material and resources by running an unconstrained plan.

To run an unconstrained plan:

1. Choose Supply Chain Plan > Options.
2. Choose the Constraints tab and check Constrained Plan and Enforce Demand Due Dates.
3. Select No for the material and resource constraint settings.
4. In the Optimization tab, uncheck Optimize.
Once you have made the change you can run a new, separate plan, or you can run a simulation in net change model to view only the differences between the baseline plan and the simulated plan.

See Chapter 8, "Optimization" and Chapter 7, "Simulations" for additional information.

**Modify Supply/Demand**

After you have run additional plans or simulations based on changes to your optimization objectives, you may still be unsatisfied with the results of your plans.

At this point, you may wish to consider the impact to changing demand and supply levels. You can quickly and easily simulate the impact of changes in inventory, purchase order schedules, and product demand. Changes to demand can be performed directly in your MDS or to individual forecasts associated with your MDS. Changes to supply may consist of changes to material availability (for example, supplier capacity) or to resource availability. You can make changes to either capacity or materials and see the effects of these changes on your plan.

To modify demand/supply:
1. Navigate to the Planner Workbench.
3. Select the Supply/Demand you want to change from the list of values.
4. Make the desired changes and close the window.

**Modify Resources**

To increase available supply, you may wish to modify resource availability.

There are a number of ways in which to modify resources:

- Add additional production resources (for example, add shifts).
- Define alternate resources available for producing particular items.
- Change the resource consumption for an item (for example, change the amount of an item that can be produced in a given amount of time).

To modify resources:
1. Navigate to the Planner Workbench.
2. Choose Tools > Resources.
3. Make the desired changes and close the window.

Modify Supplier Parameters

At this point you might choose to modify supply parameters such as Supplier Capacity, Supplier Order Modifier, and Supplier Tolerance Fence. For more information see Chapter 6, “Supply Chain Modeling.”

Run Net Change

After you have changed optimization objectives, demand, supply or resources, you can run simulated plans in net-change mode to view only the differences of the simulated plan compared to a baseline plan.

Net-change is used for:
- changes in item supply and demand, resource availability
- changes in your objectives
- changes to demand priority rules
- changes to sourcing
- changes to BOM/Routing effectivity

See on page 7-5, “Running Net Change Replan Simulations” for more information.

Review a Constrained Forecast that Results from Net Change Planning

The forecast or MDS that is loaded into a Supply Chain Plan is generally a prediction of total customer demand, regardless of your company’s ability to produce the demand.

After a Supply Chain Plan has been run based on an unconstrained forecast/MDS as an input, the resulting plan that has been constrained by material and resource availability is a demand plan constrained by production capabilities.

The easiest way to view the differences between an unconstrained demand plan and a constrained demand plan is to view the exceptions that occur after the Supply Chain Plan is run with material and resource constraints set to Yes in plan options.

The exception set Late forecast for customer demand will show all demand that could not be met due to material and resource limitations.
An alternate way to compare an unconstrained demand plan to a constrained plan is to run your Supply Chain Plan once with material and resource constraints set to No in plan options and run a second plan with material and resource constraints set to Yes. The two plans can then be compared side by side via KPI comparisons or exception comparisons.

Release or Firm Orders

To release or firm orders:

1. From the Planner Workbench, choose Tools > Supply/Demand.
2. In the Order tab, choose an organization and an item then choose to release or firm orders for that organization or item.

   You can also redefine release properties for the organization or item.
Running Collections for ASCP

Topics covered in this section include the following:
- Overview of Running Collections for ASCP on page 4-2
- Definitions on page 4-2
- Collection Strategy on page 4-3
- Architecture on page 4-5
- Collection Methods on page 4-10
- Running Collection Steps on page 4-12
- Data Changes That Can Be Collected in Net Change Mode on page 4-18
- Legacy Collection on page 4-20

A Day in the Life of a Planner
Overview of Running Collections for ASCP

Oracle ASCP has a component architecture that allows a single instance of Oracle ASCP to plan one or more transaction instances. The transaction instances can be a mixture of Oracle 10.7, Oracle 11, and Oracle 11i instances. The Oracle ASCP planning instance (referred to as the planning server) can sit on the same instance as one of the transaction instances, or be a separate instance altogether. In either case (even if the planning server shares an instance with the transaction instance to be planned), data to be planned is brought from the transaction instance(s) to the planning server via a process called Collection.

This section describes the architecture used in the collection of planning data from multiple operational sources into Oracle ASCP. These sources could be different versions/instances of Oracle Applications or other legacy systems. Oracle ASCP uses a data store based on the planning data model that is exposed through interface tables. The data is pulled from the designated data sources into its data store; Oracle ASCP Collections are responsible for synchronization as changes are made to the data sources. The configurability of the collections is enabled through a pull program based on AOL concurrent program architecture. Thus, for example, different business objects can be collected at different frequencies. Supplies and demands, which change frequently, can be collected frequently. Routings and resources, which change relatively less often, can be collected less frequently.

The data collection process consists of the Data Pull and the Operational Data Store (ODS) Load. The collection process lets you collect across Oracle Application Versions 10.7 or higher. It supports several configurations. You can run a complete refresh, an incremental refresh, or a targeted refresh. All three of these are explained later. You can also choose the frequency of refresh.

Definitions

You should be familiar with the following terms before examining the data collections architecture:

**Oracle Applications Data Store (ADS)** The set of source data tables in each transaction instance that contain data relevant to planning.

**Operational Data Store (ODS)** The planning data tables in the planning server that act as destination for the collected data from each of the data sources (both ADS and Legacy).
Planning Data Store (PDS)  The outputs of the planning process. The PDS resides in the same data tables as the ODS. However, PDS data are marked with plan IDs that show which plans they correspond to, while ODS data are marked with plan ID = -1.

Data Collection  Data collection consists of the following:

- Pull program
  Collects the data from the ADS and stores the data into the staging tables. This pull program is a registered AOL concurrent program that could be scheduled and launched by a system administrator. If you are using a legacy program, you must write your own pull program.

- ODS Load
  A PL/SQL program which performs the data transform and moves the data from the staging tables to the ODS. This collection program is a registered AOL concurrent program that could be scheduled and launched by the system administrator.

Collection Workbench  The Collection Workbench is a user interface for viewing data collected over to the planning server from the transaction instances. The functionality here is similar to Planner Workbench functionality. For more information on the Planner Workbench, see Chapter 10, Overview of Planner Workbench/User Interface.

Collection Strategy

Major features of the collection process include:

- Multiple Source Instances
- Pull Architecture
- Detect Net Changes to Synchronize Oracle Applications and Oracle ASCP
- Multi-Process Collection Architecture
- Data Consolidation
- Projects/Tasks, and Seiban Numbers
- Support for several Oracle Applications Versions and RDBMS Versions
- Support for Several Configurations
Multiple Source Instances
You can register any number of source data instances and non-Oracle data sources on each Oracle ASCP installation.

Pull Architecture
You can collect new source data instances into Oracle ASCP with minimal impact. The data is pulled from the source data instance by Oracle ASCP. Each instance can have its own refresh interval. A failure in one instance will not affect data collections from other instances.

Detect Net Change to Synchronize Oracle Applications and Oracle ASCP
You can synchronize the data in Oracle Applications transaction instances and the Oracle ASCP planning server in a net change mode. Thus, only the changed source data is collected each time, reducing the computational burden on the collection process.

Multi-Process Collection Architecture
You can enhance the performance of the pull program by distributing the tasks to multiple collection workers.

Data Consolidation
The collection program can consolidate the entities shown in the following table across instances based on the corresponding user-defined keys.

<table>
<thead>
<tr>
<th>Entity</th>
<th>User Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>MTL_SYSTEM_ITEMS</td>
<td>Concatenated Item Segments</td>
</tr>
<tr>
<td>MTL_CATEGORIES</td>
<td>Concatenated Category Name</td>
</tr>
<tr>
<td>MTL_CATEGORY_SETS</td>
<td>Category Set Name</td>
</tr>
<tr>
<td>PO_VENDORS</td>
<td>Vendor Name</td>
</tr>
<tr>
<td>PO_VENDOR_SITES</td>
<td>Vendor Site Code</td>
</tr>
<tr>
<td>RA_CUSTOMERS</td>
<td>Customer Name</td>
</tr>
<tr>
<td>RA_SITE_USES_ALL</td>
<td>Customer Name, Site Use Code, Location Operating Unit</td>
</tr>
<tr>
<td>Unit Of Measure</td>
<td>UOM Code</td>
</tr>
</tbody>
</table>
For all the entities not described in the table, the instance ID together with the entity key in each instance uniquely identifies each row.

**Projects/Tasks, and Seiban Numbers**

You can consider Projects, Tasks, and Seiban Numbers to be unique within the context of an Oracle Applications instance; no consolidation is required.

**Oracle Applications Version and RDBMS Version**

You can plan across Oracle Applications version 10.7 or higher. The following table shows you which version of the RDBMS supports which version of Oracle Applications.

<table>
<thead>
<tr>
<th>Version of Oracle Applications</th>
<th>Version of RDBMS</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.7</td>
<td>8.0 and 8i</td>
</tr>
<tr>
<td>11.0</td>
<td>8.0 and 8i</td>
</tr>
<tr>
<td>11i</td>
<td>8i</td>
</tr>
</tbody>
</table>

**Support for Several Configurations**

You can perform centralized and decentralized configurations based on the scale of the enterprise and specific business needs. Source data applications and Oracle ASCP can reside on one server or on separate servers.

**Architecture**

Oracle ASCP’s data collection architecture, shown in the figure below, depicts the data objects, procedures, and data flow between source data and Oracle ASCP. The major repositories are ADS, ODS, and PDS. Procedures enable data cleansing, data collecting, data communication, and net-change handling between data repositories.

When Oracle ASCP and its source data reside on the same instance, communication between them is enabled by PL/SQL based public API procedures or interface tables. In a distributed environment, procedure calls are made using database links.
Figure 4–1 Data Collections Architecture
Supported Configurations
Oracle ASCP supports the following configurations for installation and deployment.

- centralized planning
- decentralized planning

These configurations offer you enough flexibility to design a mode of planning that suits your business objectives. Both configurations are supported using a consistent architecture as outlined in the previous section. The sole distinction is that centralized planning uses database links to pull data into the Oracle ASCP data store.

Centralized Planning
The following figure shows the centralized planning configuration:

Figure 4–2  Centralized Planning

Oracle ASCP works as a central Planning Server across several source data instances. The collection program is installed on the planning server and the data stripped by instance_id is moved into staging tables within Oracle ASCP during the data collection process.

After the planning process, results can be pushed back to each instance.
Decentralized Planning
The following figure shows the decentralized planning configuration:

Figure 4–3  Decentralized Planning

Oracle ASCP and its source data reside in the same database. No database link is required in this case. Two components can communicate through the planning object APIs and the interface tables defined in Oracle Applications.

In this configuration, shown in the following figure, a simplified architecture is used, and the data transformation is not required.
Figure 4-4  Simplified Data Collections Architecture
Collection Methods

Collecting data can take a significant amount of time compared to the time for the overall planning cycle. Because of this, ASCP now provides a collection method that allows the collections duration to be reduced in cases where information about some – but not all – planning-related business entities on the planning server needs to be updated.

There are three collection methods:

- The Complete Refresh method clears all transaction data for all business entities from the planning server (for the source instance being collected), then copies over information about the user-selected entities. This method can be time consuming.

- The Net Change Refresh method copies only incremental changes to business entities to the planning server (and is thus faster), but is supported mainly for demand and supply business entities only.

- The Targeted Refresh method clears transaction data for only the user-selected business entities from the planning server, and then copies the entity information over from the transaction instance. Information about nonselected entities remains intact on the planning server. All planning business entities are supported by Targeted Refresh collections.

When To Use Each Collection Method

You should use Complete Refresh the first time you perform collections from a source instance to the planning server. You may also wish to use complete refresh collections after a significant proportion of the setup data in your transaction system has been altered, and you would like to make a fresh copy of all source instance business entities (items, bills of material, sourcing rules, resources, and so on) on the planning server. You typically collect all business entities in a Complete Refresh Collection.

You should use Net Change Refresh if you would like to update the supply and demand picture on the planning server as quickly as possible, and the incremental changes to supply and demand in the source instance since the last collection have not been extensive relative to the existing (already collected) body of supply and demand information. In this case, Net Change Refresh is the fastest way to achieve the desired update of the planning server operational data store, because it copies over from the source instance only the incremental changes in supply and demand since the last collection.
You should use Targeted Refresh if you would like to update the planning server information for some (but not all) business entities, and some of these entities fall outside the category of supply and demand entities supported by Net Change Refresh. For example, to update the planning server with a newly rebuilt manufacturing calendar, you would run Targeted Refresh collections for just the calendar business entity. Data on the planning server about all other business entities would remain unaffected by this collection.

You would also use Targeted Refresh (in lieu of Net Change Refresh) to bring over the latest picture of supply and demand to the planning server in cases when the incremental changes to supply and demand on the source instance since the last collection are very extensive. In this case, the update mechanism employed by Targeted Refresh collections (wholesale deletion followed by rebuilding of data on the planning server) is faster than the mechanism employed by Net Change Refresh collections (incremental insertions into existing data on the planning server).
Running Collections Steps

To collect data from an Oracle Applications transaction instance (10.7, 11.0 or 11i):

1. Sign on using the Advanced Supply Chain Planner responsibility.
2. From the Navigator, select Collections > Oracle Systems > Data Collection.

The Planning Data Collection window appears.

This window shows you that the collections process consists of two sequentially executed concurrent programs. The first program, Planning Data Pull, copies information from the source instance into the APS staging tables on the planning server. Here, against the data held in the staging tables, ASCP performs some basic cleansing. For example, it ensures that items with the same names that are collected from different source instances will be assigned the same internal IDs (recognized as the same item). Further cleansing operations
on the staging tables (if desired) may be done at this point via any custom concurrent program. This custom concurrent program would need to be inserted into the Planning Data Collection request set, in between Planning Data Pull and Planning ODS Load. The second program, Planning ODS Load, copies information from the APS staging tables into the operation data store on the planning server, where it becomes available for use during planning.

3. Select the Parameters field for the Planning Data Pull program.
   The Planning Data Pull Parameters window appears.

   **Figure 4-6 Data Pull Parameters window**

4. Use the information in the following table to set up parameters in the Planning Data Pull Parameters window.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance</td>
<td>Source instance code from list of values.</td>
</tr>
</tbody>
</table>
Running Collections Steps

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Workers</td>
<td>One or greater. Increase this number to increase the amount of computational resources to devoted to the Planning Data Pull process. This allows you to specify the number of workers for the Data Pull, which can now be different from the number of workers specified for the ODS load process.</td>
</tr>
<tr>
<td>Timeout (Minutes)</td>
<td>The maximum amount of time you would like to allocate to the Planning Data Pull process. If the Planning Data Pull process has not completed within this amount of time, it will be terminated with an error.</td>
</tr>
<tr>
<td>Purge Previously Collected Data</td>
<td>Yes (default) or No. Setting this to Yes wipes out all data in the APS planning server operational data store associated with the selected source instance as the first step in the collections process. If you set this to Yes, the only allowable collection method is Complete Refresh. If you set this to No, the allowable collection methods are Targeted Replacement and Net Change.</td>
</tr>
<tr>
<td>Collection Method</td>
<td>Complete Refresh/Targeted Refresh/Net Change Refresh.</td>
</tr>
<tr>
<td>Analyze Staging Tables</td>
<td>Yes or No (default). Set this to Yes periodically to recompute database access statistics on the APS staging tables. This speeds up the subsequent Planning ODS Load process.</td>
</tr>
</tbody>
</table>

The remaining parameters in the Planning Data Pull Parameters are a list of business entities. Selecting Yes for an entity means collect the information for that entity over from the source instance. Selecting No for an entity means don’t collect the information for that entity over from the source instance.

**Note:** The default value for these entities is set to Yes. Collecting information for Resource Availability and Sourcing History takes a significant amount of time. Collect this information only when necessary.

5. Select OK.
6. Select the Parameters field for the Planning ODS Load program.
   The Parameters window appears.
7. Use the information in the following table to specify the fields and options in this window.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance</td>
<td>Source instance code from list of values.</td>
</tr>
<tr>
<td>Timeout (Minutes)</td>
<td>Number of minutes before the concurrent program will end.</td>
</tr>
<tr>
<td>Number of Workers</td>
<td>One or greater. Increase this number to increase the amount of computational resources to devoted to the Planning ODS Load process.</td>
</tr>
<tr>
<td>Recalculate Resource Availability</td>
<td>This defaults to the value (Yes or No) that you set for the Resources Availability business entity in the Planning Data Pull Parameters window. The value that you set here is the one that actually determines whether resources availability is collected or not.</td>
</tr>
</tbody>
</table>
8. Select OK.

9. Select Submit in the Planning Data Collection window to run collections immediately, or select Schedule to schedule collections for some later time.

   If you select Schedule, the Schedule window appears.

   **Note:** If you want to perform an incremental refresh frequently, use this feature.
You have complete control over the timing and frequency of the collection of data from the transaction systems, and the timing and frequency of planning. You can manage the balance between network traffic and the need to monitor current status in your plans.

10. Select a frequency for running the job in the left pane. Complete any additional fields that appear based on your selection.

11. Click OK.

12. Choose Submit in the Planning Data Collection window.

13. From the toolbar, choose View > Requests to view the status of the collection process.

   The Find Requests window appears.
14. Select a type of requests to view then select Find. The Requests Window displays data collection progress.

15. After the collection process completes, view your results.

16. From the Navigator window, choose Collection > Workbench.

*Figure 4–9  The Collection Workbench*

Notice that data is brought over from selected instances.

**Data Changes That Can Be Collected in Net Change Mode**

When the net change mode for collections is selected (by setting the collections parameter Complete Refresh to No), the data changes shown in the following table can be collected. All other data changes must be collected by running full collections (by setting the collections parameter Complete Refresh to Yes). Net change collections run more quickly than full collections.

<table>
<thead>
<tr>
<th>Data Element</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales orders</td>
<td>Cancellations of or modifications to sales orders are captured. The Pull Sales Orders collections parameter must be set to Yes.</td>
</tr>
</tbody>
</table>
### Data Changes That Can Be Collected in Net Change Mode

<table>
<thead>
<tr>
<th>Data Element</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reservations against demands</td>
<td>Reservations against both external and internal sales order demands are captured. The Pull Reservations collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>Master production schedule demands</td>
<td>MPS demands that are added, modified or relieved in the source instance are captured. The Pull MPS collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>Master demand schedule schedule</td>
<td>The Pull MDS collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>WIP component demands</td>
<td>Demand changes due to cancellation of WIP jobs, changes in the state of WIP jobs (for example, operations within a job have been performed or cancelled), and changes to WIP jobs because of changes in item information are captured. The Pull WIP collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>WIP repetitive item demands</td>
<td>Demand changes due to cancellation of WIP repetitive schedules, changes in the state of WIP repetitive schedules, and changes to WIP repetitive schedules because of changes in item information are captured. The Pull WIP collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>Forecast demands</td>
<td>Changes and deletions in forecasts are captured. The Pull Forecast collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>User demands</td>
<td>Changes to user demands because of changes to item information are captured.</td>
</tr>
<tr>
<td>Master production schedule supplies</td>
<td>Changes in supply schedules or item information are captured. The Pull MPS collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>User supplies</td>
<td>Changes to user supplies because of changes to item information are captured.</td>
</tr>
<tr>
<td>Purchase order supplies</td>
<td>Changes to PO supplies because of rejections, returns, or cancellations or changes to item information are captured. The collections parameter Pull PO collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>On-hand supplies</td>
<td>The Pull On Hand collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>Work orders in Oracle Work in Process</td>
<td>Changes in WIP Jobs are captured. The Pull WIP collections parameter must be set to Yes.</td>
</tr>
</tbody>
</table>
## Legacy Collection

Legacy Collection provides a more open framework for consulting and system integrators to bring data from legacy systems into Oracle APS/SCE. This feature is intended to make the collections process free of Oracle systems and to extend it to non-Oracle systems. You can upload data by batch upload of flat files. This is achieved in part by extending the interface table capabilities. A preprocessing engine validates the incoming data from legacy application and ensures that referential integrity is maintained. All business objects can be imported into APS via flat files.

### Legacy Collection

<table>
<thead>
<tr>
<th>Data Element</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource availability</td>
<td>The Recalculate NRA collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>Supplier capacity</td>
<td>The Pull Supplier Capacity collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>Bills of material</td>
<td>All BOM changes are captured: new components, disabled components, component quantities, effectivity dates, BOM revisions, and component substitutes. The Pull BOM/Routing collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>Routing operations</td>
<td>Changes to and deletions of routing operations as a result of changes to operation sequences (for example, the addition of new operations, the disabling of operations, or the changing of operation dates), the disabling of a routing, the changing of routing dates, or changes to item information (for example, the disabling of an item, the creation of a new item) are captured. The Pull/BOM Routing collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>Components needed for a routing operation</td>
<td>Changes to and deletions of components needed for a routing operation are captured. The Pull BOM/Routing collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>Resources attached to a routing operation</td>
<td>Changes to and deletions of operation resources or operation resource sequences within a routing are captured. The Pull BOM/Routing collections parameter must be set to Yes.</td>
</tr>
<tr>
<td>Resource requirements for WIP jobs</td>
<td>Changes in resource requirements of WIP jobs because of completion of the WIP jobs, completion of operations within the WIP jobs, or changes in item information are captured. The Pull WIP collections parameter must be set to Yes.</td>
</tr>
</tbody>
</table>
Process

You push legacy data, such as items, bills of materials, routings, etc. into Oracle APS interface tables using batch upload. Batch upload is done using Oracle SQL*Loader. SQL*Loader requires that data is brought over in a format described in a control file. Oracle has provided control files for all the interface tables. The list of control files is available in Oracle iSupport.

The following diagram shows the movement of data from legacy systems into the Oracle APS server via interface tables using the batch upload process.

![Diagram showing the movement of data from Legacy Application to APS Server]

Setting up Batch Uploads

The System Integrator must do the following to set up the batch uploads:

1. Map the Oracle APS interface tables' control files (a control file is a template that specifies the input data format) to the legacy system's tables. The list of control files is available in Oracle iSupport.

2. Create scripts to extract data from the legacy system in the format prescribed by the control files.

   For example, the following is the control file for Purchase Order Supplies (MSC_ST_SUPPLIES_PO.ctl)

   OPTIONS (BINDSIZE=1000000, ROWS=1000, SILENT=(FEEDBACK,DISCARDS))
LOAD DATA
INFILE 'MSC_ST_SUPPLIES_PO.DAT'
APPEND
INTO TABLE MSC.MSC_ST_SUPPLIES
FIELDS TERMINATED BY ' ~ '

(ITEM_NAME,
ORGANIZATION_CODE,
NEW_SCHEDULE_DATE,
SUPPLIER_NAME,
FIRM_PLANNED_TYPE " NVL(:FIRM_PLANNED_TYPE,1)",
SUPPLIER_SITE_CODE,
PURCH_LINE_NUM,
ORDER_NUMBER,
SR_INSTANCE_CODE,
REVISION " NVL(:REVISION,1)",
UNIT_NUMBER,
NEW_ORDER_QUANTITY,
NEW_DOCK_DATE,
PROJECT_NUMBER,
TASK_NUMBER,
PLANNING_GROUP,
DELIVERY_PRICE,
QTY_SCRAPPED,
FROM_ORGANIZATION_CODE,
ORDER_TYPE CONSTANT '1',
DELETED_FLAG " DECODE(:DELETED_FLAG,1,1,2,2,2)",
COMPANY_NAME " NVL(:COMPANY_NAME,-1)",
END_ORDER_NUMBER,
END_ORDER_RELEASE_NUMBER,
END_ORDER_LINE_NUMBER,
ORDER_RELEASE_NUMBER,
COMMENTS,
SHIP_TO_PARTY_NAME,
SHIP_TO_SITE_CODE,
SR_INSTANCE_ID CONSTANT '0',
PROCESS_FLAG CONSTANT '1',
DATA_SOURCE_TYPE CONSTANT 'BATCH',
LAST_UPDATE_LOGIN CONSTANT '-1',
LAST_UPDATE_DATE SYSDATE,
CREATION_DATE SYSDATE)
The script to extract Purchase Order data for this format from a legacy system hosted on an Oracle database could look like the following:

```sql
SET HEAD OFF;
SET LINESIZE 200;
SET PAGESIZE 50000;
SPOOL ON;
SPOOL MSC_ST_SUPPLIES_PO.dat;
SELECT
DISTINCT
ITEM_TAB.ITEM_NAME || '~' ||
ITEM_TAB.ORGANIZATION_CODE || '~' ||
PO_TAB.EXPECTED_DELIVERY_DATE || '~' ||
SITES_TAB.TP_NAME || '~' ||
1 || '~' || /* All orders are treated as Firmed */
SITES_TAB.TP_SITE_CODE || '~' ||
PO_TAB.LINE_NUM || '~' ||
PO_TAB.PO_NUMBER || '~' ||
&SR_INSTANCE_CODE || '~' ||
NVL(ITEM_TAB.ITEM_REVISION,1) || '~' ||
YES || '~' ||

PO_TAB.MRP_PRIMARY_QUANTITY || '~' ||
PO_TAB.EXPECTED_DOCK_DATE || '~' ||
PO_TAB.PROJECT_ID || '~' ||
PO_TAB.TASK_ID || '~' ||
YES || '~' ||
PO_TAB.UNIT_PRICE || '~' ||
0 || '~' ||

YES || '~' ||
1 || '~' || /* All records are either for Insert/Change. No deletions are being uploaded */
-1 || '~' ||
YES || '~' ||
YES || '~' ||
YES || '~' ||
YES || '~' ||
YES || '~' ||
YES || '~' ||
YES || '~' ||
```
YES  |  | -1  |  |
0  |  | -1  |  |
1  |  | -1  |  |
'BATCH'  |  | -1  |  |
SYSDATE  |  | -1  |  |
SYSDATE

FROM  <LEGACY_SUPPLY_TABLE> PO_TAB,
      <LEGACY_ITEMS> ITEM_TAB,
      <LEGACY_PARTNER_SITES> SITES_TAB
WHERE PO_TAB.ORGANIZATION_ID = ITEM_TAB.ORGANIZATION_ID
AND PO_TAB.ITEM_ID = ITEM_TAB.INVENTORY_ITEM_ID
AND PO_TAB.VENDOR_ID = SITES_TAB.SR_TP_ID
AND PO_TAB.VENDOR_SITE_ID = SITES_TAB.SR_TP_SITE_ID;

3.  Run the scripts to get the Data files and ftp these to the APS concurrent
    manager node. The steps to upload these files into Oracle APS are described
    below under Running Legacy Collections.

Sequence of Data Uploads

Load all this information either together or in the following order:

1.  Upload calendar data information. All the calendar data files corresponding to
    calendar’s control files (MSC_STCALENDARS.ctl, MSC_ST_WORKDAY
    PATTERNS.ctl, MSC_ST_SHIFT_TIMES.ctl, MSC_STCALENDAR_
    EXCEPTIONS.ctl, MSC_ST_SHIFT_EXCEPTIONS.ctl) need to be uploaded in
    one single run. Based on the information provided, the calendar is built in the
    planning system. If calendar already exists in ODS tables (Planning System) and
    you want to rebuild the calendar again, then the entire information (all the
    above mentioned files) must be sent again. Also, in this case for MSC_ST_
    CALENDAR5.ctl the OVERWRITE_FLAG should be sent as Y.

2.  Upload the UOM information. The control file for this is MSC_ST_UNITS_OF_
    MEASURE.ctl.

3.  Upload the Demand Class information.

4.  Upload the Trading Partner information. The control files for setting up trading
    partners are MSC_ST_TRADING_PARTNERS.ctl, MSC_ST_TRADING_
    PARTNER_SITES.ctl, MSC_ST_LOCATION_ASSOCIATIONS.ctl, MSC_ST_
    SUB_INVENTORIES.ctl and MSC_ST_PARTNER_CONTACTS.
The trading partner sites, location associations, sub inventories and contacts can be uploaded along with the trading partner information and also in subsequent runs. Only MSC_ST_TRADING_PARTNERS.ctl can be uploaded in the first run.

MSC_ST_TRADING_PARTNERS.ctl has CALENDAR_CODE field. This should refer to a valid calendar code existing in the planning system or to a calendar code that you are uploading in this run of collections. If calendar does not exist in the planning system and has not been uploaded either, then the trading partner record is not accepted and is marked as error.

5. Upload the category sets information. The control file for setting up category sets is MSC_ST_CATEGORY_SETS.ctl

6. Upload the designators information for forecast, MDS and MPS. The control files required are: MSC_ST_DESIGNATORS_MDS.ctl, MSC_ST_DESIGNATORS_FORECAST.ctl and MSC_ST_DESIGNATORS_PLAN_ORDERS.ctl. The forecast, MDS and MPS records can be uploaded now or in subsequent runs.

7. Upload the projects and tasks information. The control file name is MSC_ST_PROJECT_TASKS.ctl

8. Upload the items information as per the MSC_ST_SYSTEM_ITEMS.ctl file. If the UOM_CODE of the data file has an invalid value (that is, a value that does not exist in the planning system and is also not being uploaded along with items as per the MSC_ST_UNITS_OF_MEASURE.ctl in this upload) the item records are errored out.

9. Upload the item related information; for example, supplier capacity, supplies and demands, categories, uom conversions, and sourcing rules. Upload the data as per the preprocessing diagram shown below and make sure that the items are valid; that is, the items exist in the planning system or are being uploaded in this run of legacy collections.


14. Upload bill of materials using the following control files: MSC_ST_BOMS.ctl, MSC_ST_BOM_COMPONENTS.ctl, and MSC_ST_COMPONENT_
SUBSTITUTES.ctl. You can upload BOM components and substitutes to BOM at the same time or upload these in later runs.

15. Upload routings using the following control files: MSC_ST_ROUTINGS.ctl, MSC_ST_ROUTING_OPERATIONS.ctl, and MSC_ST_OPERATION_RESOURCES.ctl. You can upload resources to operations at the same time or upload these in later runs.

16. Upload supplier capacity using the following control files: MSC_ST_ITEM_SUPPLIERS.ctl, MSC_ST_SUPPLIER_CAPACITY.ctl, and MSC_ST_SUPPLIER_FLEX_FENCES.ctl. You can upload MSC_ST_SUPPLIER_CAPACITY.ctl with MSC_ST_ITEM_SUPPLIERS.ctl or in subsequent runs. You can also upload MSC_ST_SUPPLIER_FLEX_FENCES.ctl with MSC_ST_ITEM_SUPPLIERS.ctl or in subsequent runs.

17. Load material supply for work order after routings are loaded because there is a field ROUTING_NAME in MSC_ST_SUPPLIES_WO.ctl.

18. Upload resource demand using the control file MSC_ST_RESOURCE_REQUIREMENTS.ctl. If WIP_ENTITY_NAME is not valid (it was not previously loaded using the MSC_ST_SUPPLIES_WO.ctl and also is not loaded in this run using this control file) the record is errored out.

Preprocessing

After data from legacy application has been loaded into the planning system, it undergoes preprocessing before it can be used by the planning engine.

Preprocessing generates IDs for the entities coming into the planning system based on a set of user-defined keys (UDKs). For example, to identify an item record in the planning system, the UDK is Instance Code, Organization code, Item Name and Company Name (Company Name is required only if SCE is installed. For standalone APS, this is defaulted to -1). A UDK uniquely identifies an existing record in the planning system. UDKs are used as reference to update existing records in the planning system.

The preprocessing program is a concurrent program that runs independently from the planning engine and global ATP engine.

After the data files have been brought over to the concurrent manager node, as described in the Running Legacy Collections section below, the legacy collection’s request set program can be configured to read and load the data files into interface tables. Following which, this program can preprocess the data and finally load the data into the main planning tables, all in a single run.
The preprocessing engine has the intelligence to handle scenarios wherein transaction data and any prerequisite setup data needed to perform this transaction co-exist in a single data load.

The figure below shows the sequence in which the uploaded data is processed by the preprocessing engine. The preprocessing engine possesses parallel processing capabilities. Parallel processing is enabled for processing Items and Item-related entities as shown in the diagram. Items, supplies and demand records can further be broken into sub-batches and processed in parallel.

**Figure 4–10 Preprocessing**
The above architecture also makes it necessary to ensure that all the setup related data is sent to the planning system to avoid errors while processing the transactions. For example, a purchase order line coming into the planning system referring to an item that has not been sent to the system is flagged as an error. Also, the supplier for the item should have been defined on the system as a valid one.

Records in the staging tables are checked for multiple occurrences of the same UDK combination. For instance, in the case of data coming in via XML, if two or more item records are found in the interface table having the same combination of instance code, organization code, item name and company name, preprocessing picks the latest record for further processing and the older records are flagged as errors. For instance, for data coming in via batch upload, if two or more item records are found in the interface table having same combination of instance code, organization code, item name and company name, preprocessing flags those records as errors because preprocessing is not able to determine which is the correct record to be picked up.

**Setting up Legacy Instance**

1. Apply the legacy integration patch on the concurrent manager node on which you have installed Oracle APS. If you have multiple concurrent manager nodes that are not NFS mounted, then you need to apply this patch on all the nodes. The patch copies all the control files to the $MSC_TOP/patch/115/import directory. You will have to enter the complete path of this directory as a value to the Control Files Directory parameter of the Flat File Load stage when you run the Legacy Systems’ Data Collection.

   Use steps 2 through 6 to create a partition for a new instance.

2. Log in using the System Administrator’s responsibility.

3. From the Navigator, select Requests > Run.

   The Submit a New Request screen appears.

4. Select Single Request and select the OK button.

   The Submit Request form appears.

5. In the Name field, select Create APS Partitions and select the OK button.

   The Parameters screen appears.

6. Enter the number of plan partitions and instance partitions and select the OK button.

   The partitions are created.
7. Change to the Advanced Planning Administrator responsibility. From the Navigator, select Admin > Instances.

The Application Instances screen appears.

![Application Instances](image)

**Figure 4-11 Application Instances**

8. Specify the Instance Code for the Legacy Instance and set the Instance Type as Other. Leave the fields From Source to APS and From APS To Source blank. Fill the other fields for the instance as specified in the on-line help.

You are now set to use the Batch Load solution. Using the Running Legacy Collections process described below, upload the Workday Calendar data and Planning Organizations for this instance. This data can be uploaded along with the other entities' data. Preprocessing has the intelligence to consider the new organizations that have come in the same batch upload. After Legacy Collection is completed, you can view these organizations using the Organizations button at the bottom of the Instance Setup form.
Running Legacy Collections

1. Copy all the data files conforming to the control files in the $MSC_TOP/patch/115/import in a directory on the concurrent manager node. If there are more than one concurrent manager nodes and if these are not NFS mounted, then the data files need to be copied to all the nodes in same directory structure. This directory (or all the directories in case of multiple non-NFS mounted concurrent manager nodes) should have read/write privileges to all users, because SQL*Loader discards files for the data that could not be uploaded due to errors.

2. Choose the Advanced Planning Administrator responsibility.

3. In the Navigator, choose Collections > Legacy Systems > Collect Flat File Data.
   
   The Planning Data Collection screen appears showing three programs: Flat File Loader, Pre-Process Monitor, and Planning ODS Load. Planning ODS Load moves the data from the interface tables to the planning system's main tables.

4. Choose the Parameters field for Flat File Loader.
   
   The Parameters screen appears.
5. Enter the required information and the File Names for all the data files that you want to upload. You can either enter the directory path in the Data File’s Directory field and then enter the file names for each entity to be uploaded in the File Name fields, or you can leave the Data File’s Directory field blank and enter the complete path and file name of each entity in the File Name fields. The second option is useful if all the data files are not kept in the same directory.

The Total Number of Workers field specifies the number of maximum number of loader workers that should be running in parallel at any given point in time. A loader worker is launched for each File Name specified.

6. When finished entering information for this screen, choose the OK button.

7. Choose the Parameters field for Pre-Process Monitor.

The Parameters screen appears.
8. Specify the entities that you want to be preprocessed for the legacy instance.

The Processing Batch Size field determines the size of batches while processing the records in the interface tables. A larger batch size is faster but requires more system resources. The current default batch size is 1000.

The Total Number of Workers field specifies the number of concurrent processes to be launched to process the data in parallel.

9. When finished entering information for this screen, choose the OK button.

10. Choose the Parameters field for Planning ODS Load.

The Parameters screen appears.
11. Specify whether you want Resource Availability and Sourcing History to be recalculated after the data has been moved.

12. When finished entering information for this screen, choose the OK button. The Planning Data Collection screen appears.

13. Press the Submit button to allow the concurrent manager to schedule the request as per the schedule options that you specify in the At these Times… section.

14. Use the View Requests Form to monitor the progress of the different programs.

15. Use the View Collected Data menu option under Collections in the Navigator to view the data coming into the planning system.
Purge Program

The Purge program deletes the data from the ODS table as well as the local id table (MSC_LOCAL_ID_XXX). Depending upon the option selected while submitting the concurrent program, it behaves differently as explained below.

To access purge UI:
1. Choose the Advanced Supply Chain Planner responsibility.
2. From the Navigator, choose Collections > Legacy System > Purge Collected Data.

If you selected Yes for Complete Refresh when you submitted the concurrent program, the following screen appears.

Figure 4–15  Purge Parameters screen

The following table shows the values for this screen.
In this case, the following tables get purged from ODS:

- MSC_SYSTEM_ITEMS
- MSC_BOMS
- MSC_BOM_COMPONENTS
- MSC_COMPONENT_SUBSTITUTES
- MSC_ROUTINGS
- MSC_ROUTING_OPERATIONS
- MSC_OPERATION_RESOURCES
- MSC_OPERATION_COMPONENTS
- MSC_OPERATION_RES发生的
- MSC_PROCESS_EFFECTIVITY
- MSC_DEPARTMENT_RESOURCES
- MSC_RESOURCE_SHIFTS
- MSC_RESOURCE_CHANGES
- MSC_SIMULATION_SETS
- MSC_PROJECTS
- MSC_PROJECT_TASKS
- MSC_ITEM_CATEGORIES
- MSC_DESIGNATORS (Here program updates disable date as current date instead of deleting)
- MSC_DEMANDS
- MSC_SALES_ORDERS
- MSC_SUPPLIES
- MSC_INTERORG_SHIP_METHODS
- MSC_ABC_CLASSES
- MSC_ST_RESOURCE_GROUPS
- MSC_ST_DEMAND_CLASSES
- MSC_ST_RESERVATIONS
- MSC_ST_SAFETY_STOCKS

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance</td>
<td>Legacy instance against which the purge program is to be run.</td>
</tr>
<tr>
<td>Complete Refresh</td>
<td>Yes</td>
</tr>
<tr>
<td>Delete records up to date</td>
<td>User-entered date (defaults to the current date)</td>
</tr>
<tr>
<td>Delete supplies</td>
<td>Yes (will always be Yes if complete refresh is Yes)</td>
</tr>
<tr>
<td>Delete demands</td>
<td>Yes (will always be Yes if complete refresh is Yes)</td>
</tr>
</tbody>
</table>
In addition, the entities listed in the following table, which are stored in the LID table will be deleted.

<table>
<thead>
<tr>
<th>Entity Name</th>
<th>LID Table Name</th>
<th>BO's Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>SR_INVENTORY_ITEM_ID</td>
<td>MSC_LOCAL_ID_ITEM</td>
<td>Item</td>
</tr>
<tr>
<td>ABC_CLASS_ID</td>
<td>MSC_LOCAL_ID_MISC</td>
<td>Item</td>
</tr>
<tr>
<td>BILL_SEQUENCE_ID</td>
<td>MSC_LOCAL_ID_SETUP</td>
<td>BOM</td>
</tr>
<tr>
<td>COMPONENT_SEQUENCE_ID</td>
<td>MSC_LOCAL_ID_SETUP</td>
<td>BOM</td>
</tr>
<tr>
<td>ROUTING_SEQUENCE_ID</td>
<td>MSC_LOCAL_ID_SETUP</td>
<td>Routing</td>
</tr>
<tr>
<td>OPERATION_SEQUENCE_ID</td>
<td>MSC_LOCAL_ID_SETUP</td>
<td>Routing</td>
</tr>
<tr>
<td>RESOURCE_SEQ_NUM</td>
<td>MSC_LOCAL_ID_SETUP</td>
<td>Routing</td>
</tr>
<tr>
<td>DEPARTMENT_ID</td>
<td>MSC_LOCAL_ID_SETUP</td>
<td>Department/Resources</td>
</tr>
<tr>
<td>LINE_ID</td>
<td>MSC_LOCAL_ID_SETUP</td>
<td>Department/Resources</td>
</tr>
<tr>
<td>RESOURCE_ID</td>
<td>MSC_LOCAL_ID_SETUP</td>
<td>Department/Resources</td>
</tr>
<tr>
<td>PROJECT_ID</td>
<td>MSC_LOCAL_ID_MISC</td>
<td>Project/Tasks</td>
</tr>
<tr>
<td>TASK_ID</td>
<td>MSC_LOCAL_ID_MISC</td>
<td>Project/Tasks</td>
</tr>
<tr>
<td>COSTING_GROUP_ID</td>
<td>MSC_LOCAL_ID_MISC</td>
<td>Project/Tasks</td>
</tr>
<tr>
<td>SR_CATEGORY_ID</td>
<td>MSC_LOCAL_ID_MISC</td>
<td>Categories</td>
</tr>
<tr>
<td>DISPOSITION_ID_FCT</td>
<td>MSC_LOCAL_ID_DEMAND</td>
<td>Demand (Forecast)</td>
</tr>
<tr>
<td>DISPOSITION_ID_MDS</td>
<td>MSC_LOCAL_ID_DEMAND</td>
<td>Demand (MDS)</td>
</tr>
<tr>
<td>SALES_ORDER_ID</td>
<td>MSC_LOCAL_ID_DEMAND</td>
<td>Demand (Sales Order)</td>
</tr>
<tr>
<td>DEMAND_ID</td>
<td>MSC_LOCAL_ID_DEMAND</td>
<td>Demand (Sales Order)</td>
</tr>
<tr>
<td>DISPOSITION_ID</td>
<td>MSC_LOCAL_ID_SUPPLY</td>
<td>Supplies</td>
</tr>
<tr>
<td>PO_LINE_ID</td>
<td>MSC_LOCAL_ID_SUPPLY</td>
<td>Supplies (PO/Req)</td>
</tr>
<tr>
<td>SCHEDULE_GROUP_ID</td>
<td>MSC_LOCAL_ID_SUPPLY</td>
<td>Supplies (MPS)</td>
</tr>
<tr>
<td>DISPOSITION_ID_MPS</td>
<td>MSC_LOCAL_ID_SUPPLY</td>
<td>Supplies (MPS)</td>
</tr>
<tr>
<td>SR_MTL_SUPPLY_ID</td>
<td>MSC_LOCAL_ID_SUPPLY</td>
<td>Supplies (On Hand)</td>
</tr>
<tr>
<td>WIP_ENTITY_ID</td>
<td>MSC_LOCAL_ID_SUPPLY</td>
<td>Supplies (WIP)</td>
</tr>
</tbody>
</table>
The Purge program does not delete records related to following BO’s from ODS or LID tables.

- Trading partners (organization, supplier, customer)
- Calendars
- Category sets
- Sourcing rules
- UOM

If you selected No for Complete Refresh when you submitted the concurrent program, the following screen appears.

**Figure 4–16  Purge Parameters screen**

![Purge Parameters screen](image)

The following table shows the values for this screen.
In this case, only supply/demand BO’s records and those records whose creation date is less than user-entered date get deleted from the ODS and LID tables.

**Customization**

System integrators may want to add custom validations for enabling preprocessing to filter out unwanted incoming data. The preprocessing engine provides hooks for each entity, which can be used to plug-in custom validations.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance</td>
<td>Legacy instance against which the purge program is to be run.</td>
</tr>
<tr>
<td>Complete Refresh</td>
<td>No</td>
</tr>
<tr>
<td>Delete records up to date</td>
<td>User-entered date (defaults to the current date)</td>
</tr>
<tr>
<td>Delete supplies</td>
<td>Yes /No (defaults to Yes)</td>
</tr>
<tr>
<td>Delete demands</td>
<td>Yes /No (defaults to Yes)</td>
</tr>
</tbody>
</table>
Defining Plans

Topics covered in this section include the following:

- Overview of Defining Plans on page 5-2
- Global Supply Chain Planning on page 5-2
- Subset Plans on page 5-9
- Choosing Between Global Supply Chain and Subset Plans on page 5-12
- Choosing a Plan Type on page 5-14
- Choosing Plan Classes on page 5-18
- Setting Plan Options on page 5-21
- Choosing Aggregation Levels on page 5-51
- Choosing an Objective Function on page 5-57

A Day in the Life of a Planner
Overview of Defining Plans

This section describes features that help you select a plan type that best satisfies your business requirements. You can choose to run a global supply chain plan or a subset plan to suit your supply chain environment or single organization environment, respectively. You can also select constrained, unconstrained, or optimized plan class based on business objectives such as maximizing inventory turns, ontime delivery, and plan profit. Lastly, you can specify aggregation levels to view plans at varying levels of detail.

Global Supply Chain Planning

Oracle ASCP can generate planned orders for an entire supply chain within a single multiorganization supply chain plan. This is illustrated below with a sample supply chain (see Sample Supply Chain) and bill of material (see Sample Bill of Material).

Figure 5–1  Sample Supply Chain

Figure 5–2  Sample Bill of Material
In this sample supply chain, SF1 and SF2 are subassembly facilities, AF1 is a final assembly facility, DC1 and DC2 are distribution centers, C1, C2, C3 and C4 are customers and S1, S2, S3 and S4 are suppliers.

A single plan of the entire supply chain has the following inputs:

- Demand quantity (forecast + actual sales orders) for A01 at DC1 for each of the time buckets in the planning horizon. This is captured in a Master Demand Schedule (MDS) for DC1.
- Demand quantity for A01 at DC2 for each of the time buckets in the planning horizon. This is captured in an MDS for DC2.

The plan output contains planned order quantities, start dates, and completion dates for A01 and all of its components and subcomponents.

**Prerequisites for Running a Global Supply Chain Plan**

To run a global supply chain plan, the following prerequisites are required:

- Each planned organization must be set up on the source instance.
- Collection programs must be directed to collect data from the transactional instance of each planned organization.
- Items to be planned must be enabled in each organization that can produce (or distribute) the item. During item setup, items can be enabled in all organizations or only in specific organizations.
- Routings and/or Bills of Resource for each planned item must exist or be enabled in each organization that is planned centrally.
- Suppliers and sourcing rules must be enabled in all relevant organizations.

**Advantages of the Single Plan**

The single-plan approach is advantageous for the following reasons:

- Least planning effort. Fewer plans need to be generated; fewer planning servers need to be deployed and maintained.
- Data consistency. Without the single-plan ability, requirements must be repeatedly transferred upstream within the supply chain to each successive supplier facility. Each transfer presents an opportunity for miscommunication or data loss.
Global optimization. Intelligent tradeoffs between the performance of individual facilities (as measured by, for example, plan profit) can be made because Oracle ASCP optimizes the supply chain planned orders as a whole.

Minimum communication lag:
The effects of decisions made at the highest level of the supply chain are immediately visible at the lowest level of the supply chain. If individual facility plans are used, there is at least a one planning-run duration lag between the receipt of requirements at a facility and the passing of the dependent requirements to the facility’s suppliers. Moreover, this lag is often much greater due to differences in working hours between upstream and downstream facilities (for example, if the facilities are in different time zones). Also, the planning cycles of upstream and downstream facilities may not be synchronized (for example, customer facility AF1 runs its plan on Monday, while supplier facility SF1 runs its plan on Sunday). This results in even longer communication lags.

The overall effect of plan communication lag is to make the supply chain less responsive to meeting changes in customer demand.

To create a global supply chain plan:
1. From the Navigator, choose Supply Chain Plan > Names.

The Supply Chain Names window appears.
Use the information in the following table to specify the fields and options:

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Define a plan name.</td>
</tr>
<tr>
<td>Description</td>
<td>Define a plan description.</td>
</tr>
<tr>
<td>ATP</td>
<td>If this is checked, this means that this plan will be used for availability check.</td>
</tr>
<tr>
<td>Production</td>
<td>If this is checked, this means that this is a product plan. Planned orders will be automatically released within their release time fence.</td>
</tr>
<tr>
<td>Plan Type</td>
<td>Valid values are Manufacturing Plan, Production Plan, and Distribution Plan. This setting interacts with the Planning Method item attribute to determine which subset of the items that pass the condition imposed by the Planned Items parameter will in fact be planned. Please see Choosing a Plan Type on page 5-14 for further details.</td>
</tr>
</tbody>
</table>

2. Select Plan Options.
   The Plan Options window appears.
3. Continue setting plan options and parameters.

The following table lists the three controls that together determine which items are planned in a global supply chain plan, and the possible values for each control.

<table>
<thead>
<tr>
<th>Control</th>
<th>Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned items option in the ASCP Plan Options form</td>
<td>All planned items&lt;br&gt;Demand schedule items only&lt;br&gt;Supply schedule items only&lt;br&gt;Demand and supply schedule items</td>
</tr>
<tr>
<td>Planning type option in the ASCP Supply Chain Names form</td>
<td>Manufacturing Plan&lt;br&gt;Production Plan&lt;br&gt;Distribution Plan</td>
</tr>
</tbody>
</table>
The relationship between the above three controls is summarized in the following table:

<table>
<thead>
<tr>
<th>Planned Items</th>
<th>Distribution Plan Planning Type includes...</th>
<th>Production Plan Planning Type includes...</th>
<th>Manufacturing Plan Planning Type includes...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include all planned items</td>
<td>All items in the planned organizations having an MRP planning code of:</td>
<td>All items in the planned organizations having an MRP planning code of:</td>
<td>All items in the planned organizations except ones having MRP planning code of Not Planned.</td>
</tr>
<tr>
<td></td>
<td>▪ DRP planning</td>
<td>▪ MPS planning</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ MRP and DRP planning</td>
<td>▪ MPS and DRP planning</td>
<td></td>
</tr>
<tr>
<td></td>
<td>▪ MPS and DRP planning</td>
<td>▪ MRP planned and MRP/DRP planned items that are in between the above items in the bill structure.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>MRP planned and MPS planned items that are in between the above items in the bill structure.</td>
<td>All items in the input schedules.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>All items in the input schedules.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Planned Items

<table>
<thead>
<tr>
<th>Distribution Plan Planning Type includes...</th>
<th>Production Plan Planning Type includes...</th>
<th>Manufacturing Plan Planning Type includes...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include demand schedule items only</td>
<td>All items in the input demand schedules, and all components of these items that have an MRP planning code of:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- DRP planning</td>
<td>All items in the input demand schedules, and all components of these items that have an MRP planning code of:</td>
</tr>
<tr>
<td></td>
<td>- MRP and DRP planning</td>
<td>- MPS planning</td>
</tr>
<tr>
<td></td>
<td>- MPS and DRP planning</td>
<td>- MPS and DRP planning</td>
</tr>
<tr>
<td>MPS and MRP planned items that are in between the above items in the bill structure.</td>
<td></td>
<td>MRP planning</td>
</tr>
<tr>
<td></td>
<td></td>
<td>MRP and DRP planning</td>
</tr>
<tr>
<td>Include supply schedule items only</td>
<td>All items in the input supply schedules, and all components of these items that have an MRP planning code of:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- DRP planning</td>
<td>All items in the input supply schedules, and all components of these items that have an MRP planning code of:</td>
</tr>
<tr>
<td></td>
<td>- MRP and DRP planning</td>
<td>- MPS planning</td>
</tr>
<tr>
<td></td>
<td>- MPS and DRP planning</td>
<td>- MPS and DRP planning</td>
</tr>
<tr>
<td>MRP planned and MPS planned items that are in between the above items in the bill structure.</td>
<td></td>
<td>MRP planning</td>
</tr>
<tr>
<td></td>
<td></td>
<td>MRP and DRP planning</td>
</tr>
</tbody>
</table>
Subset Plans

Defining Plans

For more information, see “The Main tab” on page 5-21.

Subset Plans

There are some situations in which it makes sense to plan a portion of the supply chain separately, outside of the overall supply chain DRP plan.

Scenario 1: Unique Local Objectives Must be Respected Along with Global Objectives

Suppose that subassembly plant SF1 (Figure 5–1, “Sample Supply Chain”), which makes M12 (Figure 5–2, “Sample Bill of Material”), contains very expensive capital equipment. SF1 is the overall supply chain constraint, so every minute that its resources are utilized brings extra profits to the enterprise. Resource utilization is the most important objective for SF1. For the supply chain as a whole, however, due to rapid product life cycles and a fickle market, inventory turns might be the most important objective. In this situation you could run a two-stage planning process.

- An MRP for organization SF1 with resource utilization as the objective to generate planned orders for M11, M22, B31, and B21 (the portion required at SF1).

<table>
<thead>
<tr>
<th>Planned Items</th>
<th>Distribution Plan Planning Type includes...</th>
<th>Production Plan Planning Type includes...</th>
<th>Manufacturing Plan Planning Type includes...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include demand and supply schedule items only</td>
<td>All items in the input demand and supply schedules, and all components of these items that have an MRP planning code of:</td>
<td>All items in the input demand and supply schedules, and all components of these items that have an MRP planning code of:</td>
<td>All items in the input demand and supply schedules, and all components of these items that have an MRP planning code of:</td>
</tr>
<tr>
<td></td>
<td>- DRP planning</td>
<td>- DRP planning</td>
<td>- MRP planning</td>
</tr>
<tr>
<td></td>
<td>- MRP and DRP planning</td>
<td>- MRP and DRP planning</td>
<td>- MRP and DRP planning</td>
</tr>
<tr>
<td></td>
<td>- MPS and DRP planning</td>
<td>- MPS and DRP planning</td>
<td></td>
</tr>
<tr>
<td></td>
<td>MRP planned and MPS planned items that are in between the above items in the bill structure.</td>
<td>MRP planned and MPS planned items that are in between the above items in the bill structure.</td>
<td>MRP planned and MPS planned items that are in between the above items in the bill structure.</td>
</tr>
</tbody>
</table>
A DRP for organizations DC1, DC2, AF1, SF1, and SF2 with the above MRP as a supply schedule with inventory turns as the objective to generate planned orders for A01, M12, B13, B23, and B21 (the portion required at SF2).

**Scenario 2: Local Restrictions Not Captured in Global Planning Inputs** Suppose that item B21, a subcomponent of item M11 (Figure 5–2, “Sample Bill of Material”), has volatile pricing. In lieu of implementing the default planned orders in facility SF1 that a global DRP would generate for M11 and its subcomponents (B21), one could plan the supply chain as follows:

1. DRP plan for organizations DC1, DC2, AF1, and SF2 to generate planned orders for A01, M12, B13, M22, and M11.
2. Load the DRP as a demand schedule into a Master Production Schedule (MPS) for organization SF1. Dependent demand for M11 is derived from the planned orders for A01.
3. Run the MPS.
4. Manually adjust the planned orders for M11 in the MPS (for example, to pull ahead the orders for M11 in order to take advantage of a time-sensitive special promotion on B21.)
5. Run an MRP for organization SF1 with the adjusted MPS as input to create planned orders for M11 components and subcomponents (B21 in this case).

**Situation 3: Single Global Data Model Not Available** The one-step supply chain planning capability of Oracle ASCP presumes either the installation of ASCP as part of an enterprise-wide implementation of Oracle Applications, or the existence of collection programs to pull cross-supply chain transaction data from various Oracle Applications instances or from legacy systems. Cross-supply chain data must be accessible to build the net change snapshot used by Oracle ASCP to generate planned orders.

This may not be the case. For example, one or more facilities in the supply chain perform planning and/or transaction processing on legacy systems not yet integrated to Oracle ASCP via some sort of collection program. In this situation, the renegade facilities must be scheduled outside the global DRP plan according to the same steps as used in Scenario 2 above.

**Pitfalls of Subset Planning**

The two principal pitfalls of subset planning (as opposed to global, single-plan supply chain planning) are:
- local optimization as opposed to global optimization
- plan infeasibility due to supply chain interdependencies

The first pitfall is the fact that plans that optimize individual facilities may not be compatible with the optimum global supply chain plan. Take the case of the two distribution centers DC1 and DC2 in Figure 5–1, “Sample Supply Chain.” The way to maximize ontime delivery for DC1 is to allocate all production from AF1 to DC1. The same logic holds for DC2. The global optimum solution, which would be missed via subset planning, comes from some allocation of AF1 output to both DC1 and DC2.

A simple example of supply chain interdependency is Supplier S3 in Figure 5–1, “Sample Supply Chain.” This supplier supplies item B21 to both subassembly facilities SF1 and SF2. Individual plans run for SF1 and SF2 could not recognize the shared capacity at supplier S3 and could not evaluate, if the combined SF1 and SF2 demands for B21 are too high, how best to allocate the B21 to SF1 and SF2. In such a situation the SF1 and SF2 individual plans would be infeasible, but would not even generate any exception notices to alert the planners.
Choosing Between Global Supply Chain and Subset Plans

In general, resource and material capacity are most efficiently utilized in a global supply chain planning environment where planning distributes production requirements across multiple organizations. However, the choice of global supply chain versus subset planning should depend on a number of factors including:

- **Physical proximity of the organizations being planned** – If planned organizations are geographically dispersed, it is generally more difficult to fulfill demand in one region from a plant or distribution center far away because of transportation costs and longer lead times. Note, however, that the costs associated with fulfilling demand from remote plants can be modeled in planning. Planning can then optimize production allocation across plants to meet the objectives that have been set. For example, if balancing resource loads is the primary objective of a multi-organization plan, planning will distribute production across plants to meet that objective.

- **Commonality of the items produced** – If you have multiple organizations that produce similar products, global supply chain planning is beneficial because planning can consider factors like material and resource availability, material costs, and resource costs to create an optimal supply chain plan.

- **Commonality of the supply base** – Similar to producing common items, organizations sharing suppliers are good candidates for global supply chain planning because supply can be optimally distributed across plants depending on each plan’s production requirements. Global supply chain planning will ensure that supplier capacity is most effectively used to meet end customer demand and to minimize inventory.

- **Linkage among plants** – If production at one plant must be coordinated with production at other plants, global supply chain planning should be used. For example, if Plant A provides subassemblies to Plant B (Plant A is a feeder plant), both plants should be planned together.

- **Corporate structure** – The internal organizational structure of a corporation is also a major determinant of the planning method used. If there are clear organizational boundaries between divisions, global supply chain planning is difficult to implement.

The table below summarizes the factors to consider when deciding whether to run a global supply chain or subset plan.
### Choosing Between Global Supply Chain and Subset Plans

<table>
<thead>
<tr>
<th>Factor</th>
<th>Global Supply Chain Planning</th>
<th>Subset Planning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Physical proximity</td>
<td>Close Physical Proximity</td>
<td>Distant Physical Proximity</td>
</tr>
<tr>
<td>Commonality of items produced</td>
<td>High Commonality</td>
<td>Low Commonality</td>
</tr>
<tr>
<td>Commonality of supply base</td>
<td>High Commonality</td>
<td>Low Commonality</td>
</tr>
<tr>
<td>Linkage among plants</td>
<td>Tight Linkage Among Plants</td>
<td>Loose Linkage Among Plants</td>
</tr>
<tr>
<td>Corporate structure</td>
<td>Centralized Corporate Structure</td>
<td>Decentralized Corporate Structure</td>
</tr>
</tbody>
</table>
Choosing a Plan Type

In Oracle ASCP you can launch three type of plans:

- Production Plan
- Manufacturing Plan
- Distribution Plan

Each creates time-phased planned orders that satisfy independent and dependent demand while seeking to respect material and resource constraints.

A choice of plan types lets you tailor the degree of subset planning that is performed for the supply chain: from a single, global supply chain plan down to manually adjusted plans for each item in each organization of the supply chain.

To do this, the three types of plans need to be used in conjunction with the MRP Planning Type item attribute that is set for each item. Possible values for this attribute are:

- MRP Planning
- MPS Planning
- MRP/DRP Planned
- MPS/DRP Planned
- DRP Planned

To set the MRP Planning Type item attribute at the item level:
1. Sign on with the Manufacturing and Distribution Manager responsibility.
2. From the Navigator window, choose Inventory > Items > Master Items.

To set the MRP Planning Type item attribute at the more detailed item-organization level:
1. Sign on with the Manufacturing and Distribution Manager responsibility.
2. From the Navigator window, choose Inventory > Items > Organization Items.

Each type of plan includes or ignores an item for planning depending on the setting of its MRP Planning Type attribute. The discussion below focuses on the principal ways in which plan type (Distribution, Production, or Manufacturing) can be used in conjunction with MRP Planning Type item attribute values (MRP Planning, MPS Planning, DRP Planned, MRP/DRP Planned, MPS/DRP Planned).
There is a logical equivalence between the different planning types as shown by the fact that the following plans, applied to the sample supply chain (Figure 5–1, “Sample Supply Chain”) and BOM (Figure 5–2, “Sample Bill of Material”), yield identical planned orders across the supply chain. In the BOMs illustrated in the next four figures, the values in parentheses indicate the setting of the MRP Planning Type item attribute.

**Figure 5–5  Sample Bill of Material**

The usefulness of the different types of plans comes in when subset planning is used. Suppose, for example, that subset plan M12 and all its components and subcomponents are used. Some reasons for needing to do so are discussed above.

1. Run a Distribution plan to generate planned orders for all items except for the components and subcomponents of M12 (Figure 5–6, “Sample Bill of Material”):

**Figure 5–6  Sample Bill of Material**

Plan Name: DRP-1
Plan Type: Distribution
Planning Orgs: SF1, SF2, AF1, DC1, DC2

A01 (DRP)

M11 (DRP) M12 (DRP/IMPS) B13 (DRP)

B21 (DRP) M22 (MRP) B23 (MRP)

B31 (MRP)
Choosing a Plan Type

This combination of plan type and MRP Planning Type item attribute values creates cross-supply chain planned orders for A01, M11, B13, B21, and M12 and omits M22, B23, B31.

2. Use the Distribution plan as a demand schedule for a Production plan run. This generates planned orders M12.

Figure 5–7 Sample Bill of Material

<table>
<thead>
<tr>
<th>Plan Name: MPS-1</th>
<th>Plan Type: Production</th>
<th>Planning Orgs: SF2</th>
<th>Input Demand Schedule: DRP-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>A01 (DRP)</td>
<td>M11 (DRP)</td>
<td>M12 (DRP/MP)</td>
<td>B13 (DRP)</td>
</tr>
<tr>
<td></td>
<td>B21 (DRP)</td>
<td>M22 (MPS)</td>
<td>B23 (MPS)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>B31 (MRP)</td>
</tr>
</tbody>
</table>

3. Manually modify the MPS for M12 as necessary.

---

**Note:** With Oracle ASCP, this step is less frequently necessary than before. This is because the finite-capacity planning performed by Oracle ASCP takes resource and material availability into account, and therefore eliminates much of the need to manually smooth production via an MPS.

---

4. Run a Manufacturing plan, using the Production plan as an input demand schedule. This generates planned orders for M12, M22, B23, and B31 (Figure 5–8, “Sample Bill of Material”).
Figure 5–8  Sample Bill of Material

Plan Name: MRP-1
Plan Type: Manufacturing
Planning Orgs: SF1, SF2
Input Demand Schedule: MPS-1

A01 (DRP)

M11 (DRP)  M12 (DRP/IMPS)  B13 (DRP)

B21 (DRP)  M22 (MRP)  B23 (MRP)

B31 (MRP)
Choosing Plan Classes

Oracle ASCP allows for the following options for generating plans.

- Unconstrained
- Resource Constrained
- Material Constrained
- Material and Resource Constrained
- Optimized

Before discussing these options in the table below, please take note of the following key concepts.

Constraints

Oracle ASCP lets you prioritize how you enforce Capacity Constraints or Demand Due Dates. Whichever constraint takes precedence over the other is the hard constraint; the other is the soft constraint. You must choose one and only one type of constraint.

Enforce Demand Due Dates

If you choose to enforce Demand Due Dates (setting Demand Due Dates as a hard constraint), then primary resources are used and loaded to capacity to satisfy demand due dates. The system also evaluates alternate resources if additional capacity is required. If there is insufficient capacity to meet demand due dates, the primary resource is overloaded. The choice of whether to use an alternate resource or overload capacity depends on cost considerations if optimization is selected. Oracle ASCP returns exception messages if capacity is overloaded.

Enforce Capacity Constraints

If you choose to enforce Capacity Constraints (setting Capacity Constraints as a hard constraint), then resources are loaded to their limit to satisfy demand (if required). Unsatisfied demand is pushed into the future. In this case, Oracle ASCP returns late replenishment exception messages.
Oracle ASCP allows for multiple levels of optimization in generating plans. These are described in the table below along with the situations under which each would be most useful.

<table>
<thead>
<tr>
<th>Optimization Level</th>
<th>Planning Horizon</th>
<th>Question/Goals</th>
<th>Scenario</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unconstrained Plan</td>
<td>Long Term Future</td>
<td>How much resource capacity and material availability do I need to arrange in order to satisfy all anticipated demand in a timely manner?</td>
<td>Decisions can be made on resource acquisition/disposition and supplier sourcing to address the exceptions.</td>
</tr>
<tr>
<td>Resource Constrained Plan</td>
<td>Long Term Future</td>
<td>How much material availability do I need to arrange in order to satisfy all anticipated demand in a timely manner?</td>
<td>Difficult to change resource capacity, but increased outsourcing is an option. Decisions can be made on supplier sourcing to address the exceptions.</td>
</tr>
<tr>
<td>Material Constrained Plan</td>
<td>Long Term Future</td>
<td>How much resource capacity do I need to arrange in order to satisfy all anticipated demand in a timely manner?</td>
<td>Difficult to change material availability but internal resource acquisition/disposition is an option. Decisions can be made on resource acquisition/disposition to address the exceptions.</td>
</tr>
<tr>
<td>Material and Resource Constrained Plan</td>
<td>Near Term Future</td>
<td>Generate a feasible plan that respects material, resource, distribution, and transportation constraints.</td>
<td>Impossible to overcome material and resource constraints and therefore must respect them in order to generate a feasible supply chain plan.</td>
</tr>
</tbody>
</table>
Choosing Plan Classes

The scope of optimization levels is summarized in the table below:

<table>
<thead>
<tr>
<th>Optimization Level</th>
<th>Planning Horizon</th>
<th>Question/Goals</th>
<th>Scenario</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optimized Plan</td>
<td>Near Term Future</td>
<td>Generate an optimized and executable plan based on plan objectives and material, resource, and transportation constraints.</td>
<td>Impossible to overcome material and resource constraints and therefore must respect them in order to generate a feasible supply chain plan.</td>
</tr>
</tbody>
</table>

The scope of optimization levels is summarized in the table below:

<table>
<thead>
<tr>
<th>Optimization Level</th>
<th>Scope</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nonoptimized (unconstrained, resource constrained, material constrained, material and resource constrained) (Optimized option unchecked which applies to the entire planning horizon)</td>
<td>Local settings that can be applied to temporal subsets of an overall supply chain plan. These simply dictate which types of constraints (material and resource) are obeyed in which portions of the plan. The planned orders for the Resource Constrained, Material Constrained and Material and Resource Constrained time portions of the plan are generated via a fast heuristic. The planned orders for the Unconstrained time portion of the supply chain plan are always generated using traditional MRP type logic.</td>
</tr>
<tr>
<td>Optimized (Optimized option checked which applies to the entire planning horizon)</td>
<td>Global setting that applies to the entire supply chain plan. The planned orders for the resource constrained, material constrained and material and resource constrained time portions of the plan are generated via a linear programming planning algorithm which explicitly optimizes objectives that are important to the user.</td>
</tr>
</tbody>
</table>

One should always check the Optimized option if execution time constraints permit.
Setting Plan Options

This section describes how to set plan options. In the plan options forms, plan options are organized as follows:

- Main
- Aggregation
- Organizations
- Constraints
- Optimization
- Decision Rules

The Main Tab

To access the Main tab from the Navigator, choose Supply Chain Plan > Options.

The Plan Options window appears with the Main tab selected.

---

Note: If you have purchased and are using Oracle Inventory Optimization, please refer to Oracle Inventory Optimization on page 17-2 for further options.
Use the information in the following table to specify the fields and options:

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plan Type</td>
<td>This is a display field only. Please see the Supply Chain Names window on page 5-5. Valid values are Manufacturing Plan, Production Plan, and Distribution Plan.</td>
</tr>
<tr>
<td>Planned Items</td>
<td>This parameter and the Plan Type field in the Supply Chain Names window, control the items that are planned in the supply chain plan. An item must satisfy conditions imposed by both parameters before being included in the supply chain plan. Please see Choosing a Plan Type on page 5-14 for further details.</td>
</tr>
</tbody>
</table>
### Object Description

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material Scheduling Method</td>
<td>Choose from Operation Start Date or Order Start Date scheduling methods. If you choose Operation Start Date, material is scheduled to arrive at the start of the operation for which it is required. If you choose Order Start Date, material is scheduled to arrive at the start of the order for which it is required. Order State Date is usually an earlier date than the Operation Start Date and therefore this selection represents the more conservative planning logic of the two options.</td>
</tr>
<tr>
<td>End Item Substitution Set</td>
<td>Select a substitution set. These are defined in the Planning Details - Substitute window discussed in Chapter 18, “Business Topics”. You can use a set of substitution relationships to be effective for a given plan by selecting the substitution set as an option for the plan. This allows you to run simulations of possible substitutions and evaluate performance indicators given possible future substitutions.</td>
</tr>
<tr>
<td>Assignment Set</td>
<td>The assignment set that holds the sourcing rules and bills of distribution that define the rules for material flow within your supply chain.</td>
</tr>
<tr>
<td>Demand Priority Rule</td>
<td>When ASCP does detailed scheduling, it schedules demands one by one. The rule specified here dictates the order in which demands will be considered during detailed scheduling, and thus which demands will get the first opportunities to take up available materials and resource capacities. Please see the section Demand Priority Rules on page 5-47.</td>
</tr>
<tr>
<td>Overwrite</td>
<td>Overwrite planned orders. For further details, please see Overwrite Options on page 5-40.</td>
</tr>
<tr>
<td>Demand Class</td>
<td>If you are creating a Production Plan, enter the appropriate demand class. This field is active only for a Production Plan.</td>
</tr>
<tr>
<td>Demand Time Fence Control</td>
<td>Check this option to enforce demand time fence control.</td>
</tr>
<tr>
<td>Planning Time Fence Control</td>
<td>Check this option to enforce planning time fence control.</td>
</tr>
<tr>
<td>Append Planned Orders</td>
<td>Appends new planned orders to current plan. For further details, please see Overwrite Options on page 5-40.</td>
</tr>
<tr>
<td>Move Jobs to PIP</td>
<td>Check this option if you want to generate planned order supply even in the absence of demand in order to ensure that inventory is held on the manufacturing floor only for items designated as Planned Inventory Points.</td>
</tr>
</tbody>
</table>
### Setting Plan Options

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lot for Lot</td>
<td>Check this option to force the creation of a separate supply for each demand. This prevents the creation of aggregate supplies that satisfy multiple demands, and overrides order quantity modifiers such as Minimum Lot Size and Fixed Lot Multiple.</td>
</tr>
<tr>
<td>Default Forecast Consumption Days Backward Days</td>
<td>If you are bringing in unconsumed forecast scenarios from Oracle Demand Planning as demand schedules into Oracle ASCP and would like to do forecast consumption inside ASCP (as opposed to bringing in preconsumed forecasts contained in master demand schedules as demand schedules into Oracle ASCP), then set the forecasts consumption backward days parameter here. This parameter allows a sales order demand to consume forecast demand even if the forecast demand is up to the specified number of days earlier than the sales order demand. This parameter applies only to Oracle Demand Planning scenarios that are used as demand schedules in Oracle ASCP plans. Please see the section Backward/Forward Forecast Consumption Days on page 5-45 for more details.</td>
</tr>
<tr>
<td>Default Forecast Consumption Days Forward Days</td>
<td>This parameter allows a sales order demand to consume forecast demand even if the forecast demand is up to the specified number of days later than the sales order demand. Please see the section Backward/Forward Forecast Consumption Days on page 5-45 for more details.</td>
</tr>
<tr>
<td>Enable Pegging</td>
<td>Check this option to calculate pegging information. Oracle ASCP traces supply information for an item to its corresponding end demand details, which you can then view in a graphical display. This field is checked by default.</td>
</tr>
<tr>
<td>Peg Supplies by Demand Priority</td>
<td>Check this option to calculate pegging so that supplies are pegged to demands in demand priority order (as defined by you in a priority rule) within the time period set by the profile option MSO: Firm Supply Allocation Window (days). For more information, please see Peg Supplies by Demand Priority on page 5-50.</td>
</tr>
<tr>
<td>Enable Pegging – Reservation Level</td>
<td>Choose a reservation level: Planning Group, Project, Project-Task, or None.</td>
</tr>
<tr>
<td>Enable Pegging – Hard Pegging Level</td>
<td>Choose a hard pegging level: Project, Project-Task, or None.</td>
</tr>
</tbody>
</table>
The Aggregation Tab

To access the Aggregation tab from the Navigator, choose Supply Chain Plan > Options > Aggregation tab.

Figure 5–10 The Aggregation tab

Use the information in the following table to specify the fields and options:

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plan Start Date</td>
<td>Choose a start date for your plan. This is a view-only field, whose value equals the start date of the plan if the plan has already been run. Otherwise, it defaults to the system date.</td>
</tr>
<tr>
<td>Plan End Date</td>
<td>Shows the calculated end date for your plan. This is a view-only field, calculated based on the bucket sizes you specify.</td>
</tr>
<tr>
<td>Start Date</td>
<td>Start date for each bucket.</td>
</tr>
</tbody>
</table>

Defining Plans 5-25
How the Planning Horizon Relates to the Time of the Plan Run

During planning, planned orders, recommendations, and resource requirements are generated. Resource requirements need to be generated at the time of plan run.

The planning horizon is synchronized with time of the plan run. As a result, planned orders, recommendations, and resource requirements are generated starting at the time of plan run.

The next figure shows how resource utilization is calculated. The resource requirements are calculated as of Time t2 and the resource availability as of Time t1.

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Buckets</td>
<td>Specify bucket size in days, weeks, and periods.</td>
</tr>
<tr>
<td>Items</td>
<td>Choose to plan at either the Item level or Product Family level. If you select Items in the first bucket, the other buckets can be set to either Items or Product Family. However, if you select Product Family in the first bucket, the remaining buckets are set to Product Family by default.</td>
</tr>
<tr>
<td>Resources</td>
<td>Choose to plan at either the Individual level or Aggregate level. If you select Individual in the first bucket, the other buckets can be set to either Individual or Aggregate. If you select Aggregate in the first bucket, the remaining buckets are set to Aggregate by default.</td>
</tr>
<tr>
<td>Routings</td>
<td>Choose to plan at either the Routings or BOR level. Whatever level you select in any of the buckets, all the rest of the buckets are assigned that level by default.</td>
</tr>
</tbody>
</table>
There is a small disparity between the times of resource requirement calculation ($t_2$) and resource availability calculation ($t_1$).
The Organizations Tab

To access the Organizations tab, from the Navigator, choose Supply Chain Plan > Options > Organizations tab.

Figure 5–12  The Organizations tab

Use the information in the following table to specify the fields and options:

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add All Authorized Orgs</td>
<td>When this is selected, all user-authorized organizations are displayed in the Org field.</td>
</tr>
<tr>
<td>Org</td>
<td>Your plan’s organization.</td>
</tr>
<tr>
<td>Description</td>
<td>The name of your organization.</td>
</tr>
<tr>
<td>Object</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Net WIP</td>
<td>Select to consider discrete jobs and other production orders as supply in the planning demand/supply netting process.</td>
</tr>
<tr>
<td>Net Reservations</td>
<td>If checked, ASCP generates pegging of on-hand supply to sales orders that matches the reservations recorded in the source transaction system.</td>
</tr>
<tr>
<td>Net Purchasing</td>
<td>Select to consider purchase orders, purchase requisitions, in-transit shipments and other nonproduction order scheduled receipts as supply in the planning demand/supply netting process. This option covers all scheduled receipts not covered by the Net WIP option.</td>
</tr>
<tr>
<td>Plan Safety Stock</td>
<td>Select to consider plan safety stock demand and supply in the planning demand/supply netting process.</td>
</tr>
<tr>
<td>Include Sales Order</td>
<td>Select to invoke forecast consumption within ASCP for the selected organization. Check this if the demand schedules for the organization are unconsumed forecasts. Uncheck this if the demand schedules for the organization are consumed forecasts plus sales orders in the form of master demand schedules.</td>
</tr>
<tr>
<td>Bill of Resource</td>
<td>Select Bill of Resources from the list of values.</td>
</tr>
<tr>
<td>Simulation Set</td>
<td>Select a Simulation Set from the list of values. A simulation set is a set of adjustments to the base availability calendar of a resource, and is defined via the Oracle Bills of Materials Department Resources form. You can define different simulation sets to model different availability scenarios (for example, the base availability calendar could reflect 5-day operations; simulation set 1 could reflect working 6 days/week for a certain period; simulation set 2 could reflect working 7 days/week for a certain period). The simulation set that you select is applied to all resources within the organization.</td>
</tr>
<tr>
<td>Demand Schedules</td>
<td>Select the name of your demand schedule/forecast/plan.</td>
</tr>
<tr>
<td>Interplant</td>
<td>Check this to use interorg orders and interorg planned order as demands. Leave unchecked to use all planned orders as demands.</td>
</tr>
<tr>
<td>Supply Schedules</td>
<td>Select the name of your supply schedule for each organization.</td>
</tr>
<tr>
<td>Subinventory Netting</td>
<td>Opens the Subinventory Netting window.</td>
</tr>
</tbody>
</table>
The Constraints Tab

To access the Constraints tab from the Navigator, choose Supply Chain Plan > Options > Constraints tab

Figure 5–13  The Constraints tab

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constrained Plan</td>
<td>If checked, Enforce Demand Due Date is checked as the default, all fields in the Constrained Plan region are updateable, all constraints are defaulted to Yes. This option is unchecked by default.</td>
</tr>
<tr>
<td>Object</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enforce Demand Due Dates</td>
<td>Check this option if you want demand due dates to be your hard constraint (that is, respected in lieu of material and resource capacity constraints, if there is conflict). For more information, see Setting Constraints for Different Plan Types. on page 11-13 in Chapter 11, Constraint-Based Planning.</td>
</tr>
<tr>
<td>Enforce Capacity Constraints</td>
<td>Check this option if you want material and resource capacity constraints to be respected in lieu of demand due date constraints. For more information, see Setting Constraints for Different Plan Types. on page 11-13 in Chapter 11, Constraint-Based Planning.</td>
</tr>
<tr>
<td>Start Date</td>
<td>This is a display only field that shows the start date for each bucket.</td>
</tr>
<tr>
<td>Buckets</td>
<td>This is a display only field that shows the bucket size in days, weeks, and periods.</td>
</tr>
<tr>
<td>Resource Constraints</td>
<td>Select Yes to consider resource constraints.</td>
</tr>
<tr>
<td>Material Constraints</td>
<td>Select Yes to consider material constraints.</td>
</tr>
<tr>
<td>Minutes Bucket Size</td>
<td>Specify the bucket size in minutes for the Days planning period.</td>
</tr>
<tr>
<td>Hours Bucket Size</td>
<td>Specify the bucket size in hours for the Days planning period.</td>
</tr>
<tr>
<td>Days Bucket Size</td>
<td>Specify the bucket size in days for the Days planning period.</td>
</tr>
<tr>
<td>Calculate Resource Requirements</td>
<td>If this is checked, the program will calculate resource capacity utilization.</td>
</tr>
<tr>
<td>Planned Resources</td>
<td>Choose all resources or bottleneck resources. If selecting bottleneck resources, you must first specify a Bottleneck Resource Group, which you can do in the next field.</td>
</tr>
<tr>
<td>Bottleneck Resource Group</td>
<td>If you have defined bottleneck resource groups in Oracle Bills of Material and you want to plan only those groups, designate them here.</td>
</tr>
</tbody>
</table>
The Optimization Tab

To access the Optimization tab from the Navigator, choose Supply Chain Plan > Options > Optimization tab.

Figure 5–14 The Optimization tab

Use the information in the following table to specify the fields and options:

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optimize</td>
<td>Select this check box if you are running an optimized plan.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: For this check box to be enabled, you must check the</td>
</tr>
<tr>
<td></td>
<td>Constrained Plan check box in the Constraints tab.</td>
</tr>
</tbody>
</table>
Enforce Sourcing Constraints

Check this option if you want to enforce the sourcing splits as defined in the item sourcing rules. When used with an optimized plan, the effect of this parameter is that, by default, ASCP’s optimization engine may override sourcing percentage splits suggested in sourcing rules if a less costly planning solution can be obtained by doing so. For unconstrained and constrained plans, ASCP will adhere to sourcing percentages specified in sourcing rules, regardless of the setting of this parameter.

Objectives: Maximize Inventory Turns

Specify a weighting percentage for this objective using the sliding bar or by entering a value between 0 and 1.

Objectives: Maximize Plan Profit

Specify a weighting percentage for this objective using the sliding bar or by entering a value between 0 and 1.

Objectives: Maximize On Time Delivery

Specify a weighting percentage for this objective using the sliding bar or by entering a value between 0 and 1.

Plan Level Penalty Factors: Exceeding material capacity

Enter a numerical value to quantify the impact of exceeding material capacity.

Plan Level Penalty Factors: Exceeding transportation capacity

Enter a numerical value to quantify the impact of exceeding transportation capacity.

Plan Level Penalty Factors: Exceeding resource capacity

Enter a numerical value to quantify the impact of exceeding resource capacity.

Plan Level Penalty Factors: Demand Lateness

Enter a numerical value to quantify the impact of late demand.

---

**Note:** Penalty factors set using the Optimization tab are plan level values that are overridden by values set at more detailed levels (for example, the organization or item levels) in the source instance. Penalty factors set in the Optimization tab override those set via profile options.
The Decision Rules Tab

To access the Decision Rules tab from the Navigator, choose Supply Chain Plan > Options > Decision Rules tab

*Figure 5–15 Decision Rules tab*

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use End Item Substitution</td>
<td>Checked - Use end item substitute prior to creating new planned orders. Unchecked - Use only the demanded item. Do not use the end item substitute.</td>
</tr>
<tr>
<td>Use Alternate Resources</td>
<td>Checked - Use primary sources as far as possible and use alternate sources only if necessary. Unchecked - Use primary sources only. Alternate sources (sources of rank 2 or higher) will not be used as a source of supply.</td>
</tr>
</tbody>
</table>
Using an Existing Plan as a Demand Schedule For New Plan

The plan for one organization can be used as a demand (or demand schedule) for the plan of another organization.

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Substitute</td>
<td>Checked - Use primary items as far as possible and use substitute component only if necessary. Unchecked - Use primary items/components only.</td>
</tr>
<tr>
<td>Components</td>
<td></td>
</tr>
<tr>
<td>Use Alternate</td>
<td>Checked - Use primary routing as far as possible and use alternate only if necessary. Unchecked - Use only primary BOM/Routing.</td>
</tr>
<tr>
<td>BOM/Routing</td>
<td></td>
</tr>
<tr>
<td>Use Alternate Sources</td>
<td>Checked - Use primary resource as far as possible and use alternate resource only if necessary. Unchecked - Use only primary resources.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: Users can collect forecasts into the APS planning server. Optionally, they can choose to consume forecasts by sales orders when they run ASCP plans. Forecasts are consumed if the Include Sales Order check box in the Organizations tab of the Plan Options window is checked. For multilevel ATO items, forecasts are consumed at all levels if the forecast explosion has occurred in the source instance prior to the collection.

To use an existing plan as a demand schedule for new plan:

1. Choose Supply Chain Plan > Names to create a new plan for the organization that will use an existing plan as a source.
   
   The Supply Chain Plan Names window appears.

2. Select Plan Options.
   
   The Plan Options window appears.

3. Choose the Organizations tab.

4. Specify the plan name to be used as a source for the new plan in the Demand Schedule portion of the window.

5. Click Subinventory Netting.
   
   The Subinventory Netting window appears.
Use the information in the following table to specify the fields and options:

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Shows all active inventory for your organization. This is a view-only field.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the subinventory. This is a view-only field.</td>
</tr>
<tr>
<td>Net</td>
<td>Select whether to net the subinventory.</td>
</tr>
</tbody>
</table>

**Inline Forecast Consumption**

This section explains some of the features related to forecast consumption. For a complete description of forecast consumption, please refer to the Forecasting chapter, Forecast Consumption section of the *Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide*.

**Setups in Collection** If you want to consume a forecast with already shipped sales orders, the collection engine uses the profile option MSC: Sales Orders Offset Days. This option is used to set the number of days before the current day during which the collection engine will collect all shipped sales orders for consumption. So, for example, if you set this option to 5 days, the collection engine will collect all shipped sales orders for consumption starting from 5 days before the current day. The default for this option is 99999.
Setting Plan Options

Defining Plans

Setups in Plan Options When you intend to consume a forecast with sales orders from any organization, you need to set up the following in the Plan Options window:

- In the Demand Schedule region of the Organization tab, specify the appropriate forecast sets
- In the Organizations region of the Organization tab, check the Include Sales Order check box.

Planning The forecast consumption process happens in the snapshot phase. When you launch a plan, make sure that the Launch Snapshot field is set to Yes (the default is Yes).

To see consumption results:

1. Run the plan.
2. Navigate to the Planner’s Workbench.
3. Select the plan name, organization, and item.
4. Select the Item.
5. Right click on the item name.
   A list of choices appear.
6. Select either Demand or Supply/Demand.
7. If you want to see how a forecast entry is consumed, in either the Demand or the Supply/Demand window, select any forecast in the Order Type column and right click on the forecast name.
   A list of choices appears.
8. Select Consumption Details.
9. If you want to see how a sales order is consuming forecasts, go back to Step 6.
10. In either the Demand or the Supply Demand window, select a sales order entry in the Order Type column and right click on the sales order name.

Note: All partially or nonshipped sales orders are collected regardless of this profile option value.
11. Select Consumption Details.

Example
The following table shows the forecast and sales orders for Item 1.

<table>
<thead>
<tr>
<th>Order Type</th>
<th>Quantity</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forecast</td>
<td>50</td>
<td>June 1, 2001</td>
</tr>
<tr>
<td>SO1 (sales order 1)</td>
<td>10</td>
<td>June 1, 2001</td>
</tr>
<tr>
<td>SO2</td>
<td>25</td>
<td>June 1, 2001</td>
</tr>
</tbody>
</table>

After the plan is run, there are three demand entries in the Demand window for Item 1, as shown in the following table:

<table>
<thead>
<tr>
<th>Order Type</th>
<th>Quantity</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forecast</td>
<td>15</td>
<td>June 1, 2001</td>
</tr>
<tr>
<td>SO1</td>
<td>10</td>
<td>June 1, 2001</td>
</tr>
<tr>
<td>SO2</td>
<td>25</td>
<td>June 1, 2001</td>
</tr>
</tbody>
</table>

To see the consumption details for line 1, select the forecast and right-click. Choose Consumption Details from the list that appears. The following table represents what will be shown:

<table>
<thead>
<tr>
<th>Fcst Qty</th>
<th>Fcst Date</th>
<th>Consumed Qty</th>
<th>SO Date</th>
<th>SO Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>June 1</td>
<td>10</td>
<td>June 1</td>
<td>SO1</td>
</tr>
<tr>
<td>50</td>
<td>June 1</td>
<td>25</td>
<td>June 1</td>
<td>SO2</td>
</tr>
</tbody>
</table>

To see how Sales Order 1 is consuming forecast, select sales order 1 and right-click. Choose Consumption Details from the list that appears. The following table represents what will be shown:

<table>
<thead>
<tr>
<th>Fcst Qty</th>
<th>Fcst Date</th>
<th>Consumed Qty</th>
<th>SO Date</th>
<th>SO Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>June 1</td>
<td>10</td>
<td>June 1</td>
<td>SO1</td>
</tr>
</tbody>
</table>
Advanced Consumption Features: Backward/Forward Consumption Time Windows
Backward/forward consumption time windows are defined in the source database at the forecast set level by using the Consumption Options region of the Forecast Sets window. If the backwards window is defined as eight days and the sales order is on day eight, the sales order will consume the forecast entries from day eight back to day one. Forecast entries closest to the sales order are consumed first.

Advanced Consumption Features: Consumption Level
Consumption can be defined at four levels:
- Item Level:
  - Most general level. No restriction in consumption
- Customer Level:
  - Only if forecast and sales order share the same customer can consumption take place
- Ship to Level:
  - Only if forecast and sales order share the same customer and ship address can consumption take place.
- Bill to Level:
  - Only if forecast and sales order share the same customer and billing address can consumption take place.

Consumption level is defined at forecast set level in the source database.

Advanced Consumption Features: Outlier Percentage
Outlier percentage controls the effects of abnormal demand with a maximum percent of the original quantity forecast that a single sales order can consume.

For example, if the outlier is 50%, the forecast is for 100, and the sales order is for 70, the sales order can only consume 100*50% = 50 from this forecast.

Advanced Consumption Features: Demand Class
Demand Class can be defined at the forecast level. If it is not defined at this level, the planning engine takes the value of the demand class from the organization to which the demand class belongs. If the sales order has no defined demand class, the sales orders takes the default demand class from the organization.

Consumption takes place only if the demand class of the sales order and forecast match.
Using an Existing Plan as a Supply Schedule for a New Plan
The plan for one organization can be used as a constraint (or supply schedule) for the plan of another organization.

To use an existing plan as a supply schedule for a new plan:
1. Choose Supply Chain Plan > Names to create a new plan for the organization that will use an existing plan as a source.
2. Click Options.
   The Plan Options window appears.
3. Choose the Organizations tab.
4. Specify the plan name to be used as a source for the new plan in the Supply Schedules portion of the window.

Overwrite Options
When you launch the planning process, you generate new planned orders and suggested repetitive schedules to meet your net requirements. Since you can firm a DRP, MPS, or MRP planned order, you may not want the planning process to overwrite any firm planned orders. You can use the Overwrite and Append plan level options to limit how the planning process reacts to firm planned orders and to stabilize the short term material plan.

Overwrite
When you enter All in the Overwrite field in the Main tab of the Plan Options form, the planning process overwrites all entries, planned and firm planned, from the current material plan. When you enter None in the Overwrite field, the planning process does not overwrite any firm planned orders. It does, however, overwrite any suggested planned orders that are not firm. When you enter Outside planning time fence in the Overwrite field, the planning process overwrites all entries from the current plan, planned and firm planned, outside the planning time fence, and overwrites only planned orders inside the planning time fence. It does not overwrite any firm planned orders within the planning time fence. The planning time fence can be different for each item, so the planning process looks at the planning time fence for each item when choosing what to delete.
Append Planned Orders

When you uncheck the Append Planned Orders field in the Main tab of the Plan Options window, the planning process does not append any planned orders to the current plan. Additional demand does not cause planned order recommendations. Instead, the projected quantity on hand may go negative in response to demand that was not met by a suggested planned order.

When you check the Append Planned Orders field, the planning process appends additional planned orders after the last entry on the current material plan to meet any additional demand. The overwrite and append options work in combinations, as described below.

Overwrite All, Append Planned Orders

This option allows you to create a new material requirements plan for the plan name you specify, deleting all previous planned and firm planned entries while regenerating new planned orders. You can use this combination the first time you run your plan or if you want your plan to reflect all sources of new demand. For example, if an existing material plan has the following orders for an item:

<table>
<thead>
<tr>
<th>Schedule Date</th>
<th>Quantity</th>
<th>Order Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>01–FEB</td>
<td>100</td>
<td>Planned</td>
</tr>
<tr>
<td>08–FEB</td>
<td>200</td>
<td>MRP firm planned</td>
</tr>
<tr>
<td>15–FEB</td>
<td>300</td>
<td>Planned</td>
</tr>
</tbody>
</table>

And the following MDS is used to plan the material plan using All in the Overwrite field and Yes in the Append Planned Orders field:

<table>
<thead>
<tr>
<th>Schedule Date</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>02–FEB</td>
<td>110</td>
</tr>
<tr>
<td>09–FEB</td>
<td>220</td>
</tr>
<tr>
<td>16–FEB</td>
<td>330</td>
</tr>
</tbody>
</table>

Then the resulting material plan would have the following suggestions for planned orders:
The planning process always suggests planned orders. You can change planned orders to a firm status using the Items window in the Planner Workbench.

**Overwrite Outside Planning Time Fence, Append Planned Orders**

This option allows you to create an extension to the material requirements plan for the plan name you specify, deleting planned and firm planned orders outside the planning time fence and deleting all planned entries inside the planning time fence for each item. The planning process creates (appends) new planned orders after the planning time fence date. In this case, since you are overwriting after the planning time fence, you are also appending new planned orders after that date. You can use this combination to stabilize the short-term plan and allow the long-term plan to react to new sources of demand.

### Attention:
If an item has no time fence specified and this option is chosen, all planned and firm planned orders are overwritten.

For example, if an existing MRP has the following orders for an item:

<table>
<thead>
<tr>
<th>Schedule Date</th>
<th>Quantity</th>
<th>Order Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>02–FEB</td>
<td>110</td>
<td>Planned</td>
</tr>
<tr>
<td>09–FEB</td>
<td>220</td>
<td>Planned</td>
</tr>
<tr>
<td>16–FEB</td>
<td>330</td>
<td>Planned</td>
</tr>
</tbody>
</table>

And the following MDS is used to plan the MRP using Outside Planning Time Fence in the Overwrite field and Yes in the Append Planned Orders field:

<table>
<thead>
<tr>
<th>Schedule Date</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>02–FEB</td>
<td>110</td>
</tr>
<tr>
<td>09–FEB</td>
<td>220</td>
</tr>
</tbody>
</table>
Then the resulting material plan would have the following suggestions for planned orders, assuming the planning time fence is 05–FEB:

<table>
<thead>
<tr>
<th>Schedule Date</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>05–FEB</td>
<td>110</td>
</tr>
<tr>
<td>09–FEB</td>
<td>220</td>
</tr>
<tr>
<td>16–FEB</td>
<td>330</td>
</tr>
</tbody>
</table>

Since the entry on 01–FEB is not firmed, the MRP planning process overwrites this entry. If it was firmed, the process would not overwrite the entry. The additional demand from the MDS of 110 on 02–FEB was appended on the planning time fence date of 05–FEB. The MRP firm planned order on 08–FEB was deleted because it falls outside the planning time fence of 05–FEB. The planning process always suggests planned orders. You can change planned orders to a MRP firm status using the Items window in the Planner Workbench.

**Overwrite None, Append Planned Orders**

When you choose not to overwrite an existing plan, the planning process does not overwrite existing firm planned orders, but deletes any suggested planned orders. The planning process then creates (appends) new planned orders after the planning time fence date. This is analogous to firming sections of your short-term material requirements plan. You can extend the plan horizon without altering existing firm planned orders. For example, if an existing MRP has the following suggested planned orders for an item:

<table>
<thead>
<tr>
<th>Schedule Date</th>
<th>Quantity</th>
<th>Order Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>01–FEB</td>
<td>100</td>
<td>Planned</td>
</tr>
<tr>
<td>08–FEB</td>
<td>200</td>
<td>MRP firm planned</td>
</tr>
<tr>
<td>15–FEB</td>
<td>300</td>
<td>Planned</td>
</tr>
</tbody>
</table>
And the following MDS is used to plan the MRP using None in the Overwrite field and Yes in the Append Planned Orders field:

<table>
<thead>
<tr>
<th>Schedule Date</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>02–FEB</td>
<td>110</td>
</tr>
<tr>
<td>09–FEB</td>
<td>220</td>
</tr>
<tr>
<td>16–FEB</td>
<td>330</td>
</tr>
</tbody>
</table>

The resulting material plan would have the following suggestions for planned orders assuming the planning time fence is 05–FEB:

<table>
<thead>
<tr>
<th>Schedule Date</th>
<th>Quantity</th>
<th>Order Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>05–FEB</td>
<td>110</td>
<td>Planned</td>
</tr>
<tr>
<td>08–FEB</td>
<td>200</td>
<td>MRP firm planned</td>
</tr>
<tr>
<td>09–FEB</td>
<td>20</td>
<td>Planned</td>
</tr>
<tr>
<td>16–FEB</td>
<td>330</td>
<td>Planned</td>
</tr>
</tbody>
</table>

The firm order on 08–FEB remains on the MRP since the overwrite is None. However, the planned entries are deleted. Although additional demand exists on the MDS, no planned orders are suggested until the planning time fence (on 05–FEB). The MDS demand of 110 on 02–FEB was satisfied by a new planned order for 110 on 05–FEB. The demand for 220 on 09–FEB was partially met by the firm MRP planned order on 08–FEB. Thus an additional planned order was suggested on 09–FEB for 20 to meet the MDS demand of 220. A suggested planned order was created on 16–FEB for 330 to meet the demand from the MDS on 16–FEB.

**Overwrite None, Do Not Append Planned Orders**

In this case, the planning process does not overwrite existing firm planned entries, but deletes any suggested planned orders. In addition, it does not append additional demand to the end of the plan. Instead, it reports the instances where the material requirements plan is out of balance with the master demand schedule, and allows you to solve these problems by manipulating the plan manually. This gives maximum control to the material planner. For example, if an existing material plan has the following orders:
And the following MDS is used to plan the MRP using None in the Overwrite field and No in the Append Planned Orders field:

<table>
<thead>
<tr>
<th>Schedule Date</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>02–FEB</td>
<td>110</td>
</tr>
<tr>
<td>09–FEB</td>
<td>220</td>
</tr>
<tr>
<td>16–FEB</td>
<td>330</td>
</tr>
</tbody>
</table>

The resulting MRP would have the following suggestions for planned orders:

<table>
<thead>
<tr>
<th>Schedule Date</th>
<th>Quantity</th>
<th>Order Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>08–FEB</td>
<td>200</td>
<td>MRP firm planned</td>
</tr>
</tbody>
</table>

The reason the additional demand from 02–FEB, 09–FEB, and 16–FEB was not planned for is because with the Overwrite None and Do Not Append Planned Orders, you choose not to overwrite firm planned orders nor create new planned orders to meet additional demand. In this case, the projected quantity on hand would go negative since no planned orders were suggested to meet the additional demand. The material planner can use on-line inquiries and reports with exception messages to identify material shortages.

**Backward/Forward Forecast Consumption Days**

Consumption of forecasts by sales orders is required to avoid double counting of demand. Consumption days parameters are used when an exact match between the sales order dates and the forecast dates is not found, or when a match is found and the forecast quantity is not sufficient to cover the sales order quantity. In both of these situations, consumption first moves backwards from the sales order date in workdays, looking for a forecast quantity to consume. If that search is unsuccessful, consumption moves forward from the sales order date in workdays. If a suitable forecast entry to consume is still not found, or the sales order quantity has not been
completely consumed, an over-consumption (negative demand) entry is added to the forecast.

The following examples and diagrams describe forecast consumption logic for a variety of cases.

The following diagram shows how the process tries to consume a forecast entry on the 12th (the sales order date) because the forecast is stated in daily buckets and no backward consumption days exist. Since there are no forecasts on the 12th, an overconsumption entry is created on the 12th and the forecasts remain the same.

The next diagram shows how the process tries to consume a forecast entry between the 12th (the sales order date) and the 9th (backward 3 days). The forecast entry of 20 each on the 9th is consumed. The remaining sales order quantity of 5 creates an overconsumption entry.

In this next diagram, the process tries to consume a forecast entry between the 2nd (back 3 days from the sales order date of the 5th) and the 10th (forward 3 workdays,
skipping the weekend). Going backward, the forecast entry of 20 each on the 2nd is consumed. Going forward, the forecast entry of 20 on the 9th is reduced to 15.

**Demand Priority Rules**

In ASCP, planning decision-making occurs sequentially in the following phases:

- Selection of alternates (routings, substitute components, internal source organizations, suppliers).

  **Note:** Intelligent selection of alternates occurs in optimized plans only. Constrained and unconstrained plans choose only the primary alternative (for example, the primary routing) and always respect the sourcing rank and percentages specified in sourcing rules.

- Pegging of supplies (on-hands, scheduled receipts, and planned order supplies) to demands

  **Note:** This phase is enabled only if the Constrained Plan checkbox in the Constraints tab of the Plan Options form is checked

- Detailed scheduling of individual operation steps on resources

  In the detailed scheduling phase, demand quantities that are pegged to planned order supplies are considered in internal priority order. Demands with higher internal priority get the first opportunities to take up available resource and
material capacities; demands with lower internal priorities can only use remaining resource and material capacities and are therefore more likely to be satisfied late.

The internal priorities described above are different than the external priorities that can be attached to sales orders and master demand schedule entries. Internal priorities are generated for a plan on the basis of a priority rule that you attach to the plan in the Main tab of the Plan Options form.

To define a priority rule:
1. Sign on using the Advanced Supply Chain Planner responsibility.
2. From the Navigator, select Setup > Priority Rules.
   
   The Define Priority Rules window appears.

Figure 5–17  Define Priority Rules window

Use the information in the following table to fill in the fields in this form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for your priority rule. You will refer to this name when defining plan options for a supply chain plan.</td>
</tr>
</tbody>
</table>
To attach a priority rule to a supply chain plan:

1. Enter the priority rule name in the Demand Priority Rule field in the Main tab of the Plan Options form. Please see the section The Main Tab on page 5-21 for further details.

By using the priority rule shown in the screenshot above, you ensure that the demands with the most urgent external priority will have the best chance of being satisfied on time, since they will have the first opportunity to utilize available resource and material capacities.

The default priority rule (if you do not specify one in the Demand Priority Rule field in the Plan Options form) is Schedule Date. Thus, by default, demands are prioritized in due date order.
Peg Supplies by Demand Priority

Oracle ASCP will allocate both firm and nonfirm supplies to demands in the order of demand priority. Oracle ASCP will follow the following guidelines to allocate supplies to demands:

- Allocate supply to demand in the order of demand priority instead of closest quantity pegging
- Minimize pegging of a given supply to multiple demands
- Avoid multiple pegs to higher priority demands.
Choosing Aggregation Levels
Oracle ASCP allows planning to occur at different levels of aggregation within the same plan. This allows detailed scheduling and long-range planning to take place within a single integrated plan. Flexible aggregation levels exist along several planning dimensions:
- time
- product
- resource/routing
Aggregation level options for each dimension is described below.

Choosing Time Aggregation Levels
In ASCP, the available time aggregation levels are:
- minutes
- hours
- days
- weeks
- periods
In order to reduce the computational effort to calculate a plan and to reduce the volume of plan output (for clarity), time bucket sizes should be set only as small as is necessary to capture the necessary detail.
Time bucket size must increase or stay level over the planning horizon; it cannot decrease.
The following sequences of time aggregation levels are examples of those (but not all) that are valid within a single plan:
- minutes-hours-days-weeks-periods (check Constrained Plan in the Constraints tab)
- days (Aggregation tab)
- days-weeks (Aggregation tab)
- hours-days-periods (check Constrained Plan in the Constraints tab. Note: weeks time aggregation level is skipped.)
Choosing Time Aggregation Levels

- Planning at the minute and hour aggregation levels is referred to as scheduling, and is enabled only when the Constrained Plan check box in the Constraints tab of the Plan Options window is checked.
- Periods default to months.
- All lower level demand that occurs within a higher level time bucket (for example, a daily demand occurring in the middle of a weekly time bucket) is moved to the last day of the higher level bucket for planning purposes. This is the information lost through aggregation.
- Supplies are always scheduled to arrive at the last day of periods.

Choosing Product Aggregation Levels

In ASCP, the available product aggregation levels are:

- item
- product family

Planning at the item level explodes material and resource requirements down to each bottom-level component (provided that the component’s MRP Planning Type item attribute matches the type of Manufacturing, Material, or Distribution Plan being run).

When planning at the product family level, no explosion of material or resource requirements occurs. Information concerning the resources required to make a product family are taken from the routing for the product family. Therefore, if planning is to be done at a product family level, there needs to be a routing defined for each product family. No material requirements are considered when planning at a product family level.

Choosing Resource Aggregation Levels

There are two ways in which the aggregation level of resource information may be specified in Oracle ASCP. The first is to employ the following resource aggregation levels:

- individual
- aggregate

The second is to employ the following routing aggregation levels:

- routing
Resource aggregation levels can either be individual or aggregate.

- **Individual**: all resources listed in all item routings (if the item aggregation level is set to Item) or all product family routings (if the item aggregation level is set to Product Family) are considered in planning.

- **Aggregate**: only resources specified as aggregate resources are considered in planning. Aggregate resources are specified in the window accessed by the Operations Resources button during routing definition (Use the Manufacturing and Distribution Manager responsibility. From the Navigator window, choose Bills of Material > Routings > Routings). Each operation resource can have a designated aggregate resource (which may be itself or another resource).

Routing aggregation levels serve a similar function.

- **Routing**: all resources listed in all item routings (if the item aggregation level is set to Item) or all product family routings (if the item aggregation level is set to Product Family) are considered in planning. This is identical in meaning to the individual resource aggregation level described above.

- **Bill of resource (BOR)**: only resources listed in bills of resources for items (if the item aggregation level is set to Item) or product families (if the item aggregation level is set to Product Family) are considered in planning. Bills of resource are lists which associate items or product families with individual resources and the processing times (usages) incurred on those resources for each item/product family. (To define a bill of resource, use the Manufacturing and Distribution Manager responsibility. From the Navigator window, choose Capacity Planning > Bill of Resources > Bill of Resource.) The usages in a bill of resource may be automatically generated by summing the resource usages from the routings for an item and its components and subcomponents. A bill of resource may also be manually defined, allowing you to include only certain key resources and to manually adjust the usage quantity for each key resource as necessary.

- When using the routing aggregation level BOR, Oracle ASCP generates resource requirements during planning only for those items or product families that have defined BORs.

---

**Note**: Resource aggregation levels do not have any effect unless the Constrained Plan check box in the Constraint tab of the Plan Options window is checked.
When using the routing aggregation level BOR, operation sequencing information from the routings that are used to generate the BOR is lost. The BOR aggregation level is for use with the weekly and period buckets for an approximate rough-cut capacity planning. When using BOR’s, constraint-based planning is not recommended because the resource sequencing and interdependence is not considered. BOR Aggregation is not compatible with routing aggregation in the same plan, and BOR aggregation is not available when scheduling in minutes and hours.

The higher levels of resource aggregation (aggregate) and routing aggregation (BOR) both have the effect of limiting the number of resources considered in planning.

Resource and routing aggregation level have overlapping effects.

- If either the resource aggregation level is set to individual or the routing aggregation level is set to routing, all individual resources for items (if the item aggregation level is set to Item) or product families (if the item aggregation level is set to Product Family) are considered in planning.

To set the resource aggregation levels for a time horizon:

1. From the Navigator, select Supply Chain Plan > Options.
   - The Plan Options window appears.
2. Choose the Constraints tab.
3. Enter the time horizon in days, weeks, or periods.
   - You can specify different levels of aggregation in different time buckets so that detailed information is considered more frequently and less detailed information is considered less frequently.

Resources can be scheduled either individually or in aggregate. Selecting individual resource scheduling generates schedules down to the individual resource level and considers the available capacity of each resource in the schedule recommendations.

Selecting aggregate resource scheduling considers the overall capacity of all resources in a resource group required for an item. For example, the overall capacity of a department to which the individual resources are assigned are used.

For more information, see “Defining a Resource” in the Oracle Bill of Materials User’s Guide.
Controlling Material Aggregation Levels

You can specify material aggregation levels for each of the three planning time horizons.

To set the material aggregation level for a time horizon:
1. From the Navigator, select Supply Chain Plan > Options.
2. Choose the Constraints tab.

Figure 5–18  The Constraints tab

3. Enter the time horizon in days, weeks, or periods.

You can specify different levels of aggregation in different time buckets so that detailed information is considered more frequently and less detailed information is considered less frequently.

You can schedule the product at either the item level or the product family level.
Choosing Time Aggregation Levels

Ensure items are correctly assigned to a product family and that a planning percent is specified when setting up your BOMs.

Controlling Routing Aggregation Levels

You can specify routing aggregation levels for each of the three planning time horizons.

**To set the routing aggregation level for a time horizon:**

1. From the Navigator, select Supply Chain Plan > Options.
   
   The Plan Options window appears.

2. Choose the Constraints tab.

3. Enter the time horizon in days, weeks, or periods.
   
   You can specify different levels of aggregation in different time buckets so that detailed information is considered more frequently and less detailed information is considered less frequently.

Either routings or bills of resources can be selected for plans. For detailed scheduling in the minute, hour and daily buckets, routings are used. For long-range simulations in the weekly and monthly buckets, routings or bills of resources can be used. Note that routings and BOR's cannot be used in the same plan.

Selecting routing level aggregation will result in schedules that consider the capacity of each resource as well as the sequencing of the resources during the production of an item. Selecting BOR level aggregation will only consider the resource requirements needed to produce an item without considering the sequencing and interdependence among the resources required for an item.

The BOR aggregation level is for use with the weekly and period buckets for an approximate rough-cut capacity planning. When using BOR's, constraint-based planning is not recommended because the resource sequencing and interdependence is not considered. BOR aggregation is not compatible with routing aggregation in the same plan, and BOR aggregation is not available when scheduling in minutes and hours.
Choosing an Objective Function

When generating plans via the Optimized option, Oracle ASCP lets you specify the objectives to be considered in generating planned orders across the supply chain.

All objectives are expressed in units of dollars.

This section describes each of the available objectives and how multiple objectives can be combined into a single objective function which captures trade-offs between competing objectives.

You can optimize your plans to the objectives shown in the following table.

<table>
<thead>
<tr>
<th>Objective Function</th>
<th>How is the Objective Achieved?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximize Inventory Turns</td>
<td>Minimize inventory carrying cost</td>
</tr>
<tr>
<td>Maximize Plan Profit</td>
<td>Maximize plan revenue minus plan cost</td>
</tr>
<tr>
<td>Maximize On-Time Delivery</td>
<td>Minimize penalty cost for late demand</td>
</tr>
</tbody>
</table>

Inventory Turns

The inventory turns are maximized by minimizing inventory carrying cost. Inventory carrying cost is summed up for all items in all time buckets. Inventory carrying cost is calculated as follows:

\[
\text{inventory carrying cost} = (\text{average inventory per bucket}) \times (\text{carrying cost percent}) \times (\text{item cost})
\]

Plan Profit Objective

Selecting Plan Profit Objective has the net effect of asking the optimization engine to do a dynamic cost rollup for all planned items. All other optimization objectives use standard costs and do not dynamically calculate a rolled-up cost.

The margin percentage objective is calculated as follows:

\[
\text{margin percentage} = (\text{plan revenue}) - (\text{plan cost})
\]

\[
\text{plan revenue} = \left(\left(\text{sales order line price}\times \text{sales order quantity}\right) + \left(\text{item list price}\times \text{item discount}\times \text{forecast quantity}\right)\right)
\]

- Plan revenue is calculated and summed up for all items with independent demand in all time buckets.
Choosing an Objective Function

plan cost = (item cost) + (transportation cost) + (inventory carrying cost)

- Plan cost is calculated and summed up for all items, resources, and ship methods in all time buckets.

item cost = (resource cost)*(resource quantity used) + (buy item cost)*(buy item quantity) + (process cost)*(quantity using process)

transportation cost = (transfer quantity)*(item weight)*(shipping cost per unit weight) + (buy quantity)*(item weight)*(shipping cost per unit weight)

inventory carrying cost = (average inventory per bucket)*(carrying cost pct)*(item cost)

- Margin percentage is the most aggregate of objectives in the sense that it combines multiple costs.

Ontime Delivery Objective

The ontime delivery objective is calculated as follows:

ontime delivery = - (penalty cost for late demand)

- Ontime delivery is calculated and summed up for all items with independent demand in all time buckets.

penalty cost = (penalty cost factor for late demand [$/unit/day])*(days late)*(quantity of late demand) + (penalty cost factor for unmet demand [$/unit/day])*(days late)*(quantity of unmet demand)

- Ontime delivery sums two types of costs: late demand cost and unmet demand cost. An unmet demand is simply a very late demand. Specifically, it is a demand for which the plan generates supply that exceeds the demand due date by more than allowable days early/late. Allowable days early/late is a user-set profile option.

- Penalty cost factor for late demand is a user-specified plan option.

- Penalty cost factor for unmet demand is a system-supplied plan option, obtained by multiplying the penalty cost factor for late demand by a constant that is greater than 1. This makes unmet (very late) demands cost more than late demands.
Implicit Objectives

In addition to the above objectives, which you can select/weight or deselect, Oracle ASCP maintains a set of implicit (hidden) objectives that it takes into consideration no matter what you select. These objectives are defined to be the negative of various penalty costs, as follows:

\[
\text{implicit objectives} =
\begin{align*}
&-\text{(penalty cost for late demand)} \\
&-\text{(penalty cost for resource capacity violation)} \\
&-\text{(penalty cost for transport capacity violation)} \\
&-\text{(penalty cost for material capacity violation)} \\
&-\text{(penalty cost for safety stock violation)} \\
&-\text{(penalty cost for using alternate sources)} \\
&-\text{(penalty cost for using alternate routings)} \\
&-\text{(penalty cost for using alternate resources)} \\
&-\text{(penalty cost for using substitute items)} \\
&-\text{(percentage of carrying cost)}
\end{align*}
\]

Maximizing implicit objectives results in minimization of the penalty costs.

Penalty costs are the product of the penalty factor and some other parameter such as list price, item cost, resource cost, or transportation cost. For example:

\[\text{penalty cost for late demand} \ [\$/\text{unit/day}] = (\text{penalty factor}) \times (\text{list price})\]

You can set penalty factors at different levels using flexfields, plan options, or profile options. Flexfields let you set penalty factors at the most discrete level. For example, you can set the Penalty Factor for Late Demand at the Demand, Item, or Org level using flexfields. Plan options and profile options let you set the same penalty factor at the plan level and site level, respectively.

Combining Objectives

Oracle ASCP combines the above objectives into the following objective function:

\[
\text{overall objective} = \text{maximize} w1 \times (\text{plan profit}) + w2 \times (\text{on-time delivery}) + w3 \times (\text{inventory turns}) + 1.0 \times (\text{implicit objectives})
\]

Objective weights \(w1\)-\(w3\) are restricted to the range 0 to 1. Setting an objective’s weight to 0 directs Oracle ASCP not to consider that particular objective. Setting an objective’s weight to 1 places the maximum possible emphasis on that objective. Objective weights \(w1\)-\(w3\) may be set independently.

Objective weights \(w1\)-\(w3\) in general do not precisely show the relative importance of each objective in planning decisions. As can be seen from the above definition of
the overall objective, the percentage of the overall objective value occupied by a particular objective depends also on the dollar magnitude of the objective, and it is the product of the weight and the dollar magnitude of the objective which reflects the relative importance of each objective in planning decisions.

Take special note of interdependent objectives. Some costs are contained in more than one objective. For example, inventory carrying cost is a part of both the Plan Profit and Inventory Turns objectives. Therefore, only use these two objectives together if it is desired to artificially weight inventory carrying cost higher than the other costs (item cost, transportation cost) contained within plan profit.

A more subtle case is penalty cost for late demand, which appears both in the On-time Delivery objective and in the implicit objectives not seen by the user. Thus, no matter what the weight on-time delivery, Oracle ASCP considers late demand cost in its planning decision-making.

**Factors Affecting Objectives**

Implicit and explicit objectives are affected by several factors and rules. The following two tables presents the relationship of these objectives to costs, prices, priority rules, and sourcing ranks. These tables also provide you with the minimum data requirements for optimized plans based on different objectives.

<table>
<thead>
<tr>
<th>Cost-Price/Objectives</th>
<th>Inventory Turns</th>
<th>On-time Delivery</th>
<th>Plan Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Cost</td>
<td>n/a</td>
<td>n/a</td>
<td>yes</td>
</tr>
<tr>
<td>Item Standard Cost</td>
<td>yes</td>
<td>n/a</td>
<td>yes</td>
</tr>
<tr>
<td>Carrying Cost Percentage</td>
<td>yes</td>
<td>n/a</td>
<td>yes</td>
</tr>
<tr>
<td>Late Demand Penalty Factor</td>
<td>n/a</td>
<td>yes</td>
<td>n/a</td>
</tr>
<tr>
<td>List Price and Selling Price</td>
<td>n/a</td>
<td>yes</td>
<td>n/a</td>
</tr>
<tr>
<td>Transportation Cost</td>
<td>n/a</td>
<td>n/a</td>
<td>yes</td>
</tr>
</tbody>
</table>

yes means cost/factor affects the objective.
Choosing an Objective Function

<table>
<thead>
<tr>
<th>Factor</th>
<th>Penalty Cost for Late Demand</th>
<th>Penalty Cost for Resource Capacity Violation</th>
<th>Penalty Cost for Transport Capacity Violation</th>
<th>Penalty Cost for Material Capacity Violation</th>
<th>Penalty Cost for Safety Stock Violation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Cost</td>
<td>n/a</td>
<td>yes</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>Item Standard Cost</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Carrying Cost Percentage</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>Exceeding Item Capacity Penalty Factor</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>yes</td>
<td>n/a</td>
</tr>
<tr>
<td>Exceeding Resource Capacity Penalty Factor</td>
<td>n/a</td>
<td>yes</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>Exceeding Transport Capacity Penalty Factor</td>
<td>n/a</td>
<td>n/a</td>
<td>yes</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>Late Demand Penalty Factor</td>
<td>yes</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>List Price and Selling Price</td>
<td>yes</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>Transportation Cost</td>
<td>n/a</td>
<td>n/a</td>
<td>yes</td>
<td>n/a</td>
<td>n/a</td>
</tr>
</tbody>
</table>

yes means cost/ factor affects the objective.

<table>
<thead>
<tr>
<th>Factor</th>
<th>Penalty Cost for Using Alternate Sources</th>
<th>Penalty Cost for Using Alternate Routings</th>
<th>Penalty Cost for Using Substitute Resources</th>
<th>Penalty Cost for Using Substitute Items</th>
<th>Implicit Carrying Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Cost</td>
<td>n/a</td>
<td>n/a</td>
<td>yes</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>Item Standard Cost</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Carrying Cost Percentage</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>yes</td>
</tr>
<tr>
<td>Sourcing Rank</td>
<td>yes</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>Substitute Item Priority</td>
<td>n/a</td>
<td>n/a</td>
<td>yes</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>BOM/Routing Priority</td>
<td>n/a</td>
<td>yes</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>Alternate Resource Priority</td>
<td>n/a</td>
<td>n/a</td>
<td>yes</td>
<td>n/a</td>
<td>n/a</td>
</tr>
</tbody>
</table>

yes means cost/ factor affects the objective.
Choosing an Objective Function

Computational Burden Considerations

At all levels of optimization except for unconstrained plan (see Choosing Plan Classes on page 5-18), Oracle ASCP performs some type of finite-capacity scheduling. This is computationally much more complex than the infinite-capacity planning performed in older versions. Therefore, formulating the planning problem so that it is less computationally intensive is worthwhile.

The computational burden of a planning problem increases with the number of resources, the number of items, and the number of demands.

Ways to decrease the number of resources include:

- Leave non-critical (non-constraint) resources out of routings. For example, an entire cell in a cellular manufacturing system might be modeled as a single resource instead of as a group of resources.
- Maximize the use of resource and routing aggregation (see Choosing Resource Aggregation Levels on page 5-52).

Ways to decrease the number of items include:

- Enable each item in as few organizations as possible because each combination of item-organization counts as a separate item.
- Maximize the use of item aggregation (to the product family level) in the plan options.
- Set the Planned Items option in the Main tab of the Plan Options window to something other than All Planned Items. For example, set it to Demand Schedule Items Only.

Ways to decrease the number of demands include:

- Maximize the use of time aggregation (larger time buckets) in plan options. This collapses multiple demands occurring within a larger time bucket to a single demand at the end of the time bucket.
- Maintain long-term forecasts in larger time buckets (for example, weeks or periods) instead of shorter time buckets such as days. This reduces the number of MDS demands once the forecast is loaded into an MDS for input to the planning process.

Optimized Plans Data Requirements

The majority of the data required for optimized plans for different objectives are available in ERP systems. These data include:
Choosing an Objective Function

- Item Standard Cost, List Price, Selling Price, Discount
- Carrying Cost Percent
- Resource Cost
- Transportation Cost
- Sourcing Rank
- Substitute Item Priority
- BOM/Routing Priority
- Alternate Resource Priority

The remaining data can be set up at the profile option level or plan level to expedite the implementation of optimized plans. These data include:

- Exceeding Item Capacity Penalty Factor
- Exceeding Resource Capacity Penalty Factor
- Exceeding Transport Capacity Penalty Factor
- Late Demand Penalty Factor

Oracle ASCP considers some default values for these fields, such as 0.01 for the Standard Cost. The Optimization process cannot produce very valuable results based on these default values alone. It is recommended that you specify starting values for these fields at the profile option level at the start of implementation.

Optimization Effects on Sourcing

Oracle ASCP optimization does not consider allocation percentages specified in the sourcing rules and/or bills of distributions. Sourcing decisions are made based on capacity, item standard cost, and rank with respect to penalty costs and constraints.

Example 1: Enforce Capacity Constraints Scenario

Item A is sourced from organizations O1 and O2 with ranks equal to 1 and 2 respectively. If the total costs (item plus penalty costs) are equal in both organizations, and capacity is available only in O2; then this organization is used as the source for item A and ranking is overridden.
Example 2: Enforce Demand Due Dates Scenario

Item A is sourced from organizations O1 and O2 with ranks equal to 1 and 2 respectively. If the total costs (item plus penalty costs) are equal for both organizations, Organization O1 with rank 1 is loaded (or overloaded) to source item A.

Example 3: Enforce Demand Due Dates Scenario

Item A is sourced from organizations O1 and O2 with ranks equal to 1 and 2 respectively. If the total cost (item plus penalty costs) in organization O1 is greater than organization O2, Organization O2 with rank 2 is loaded (or overloaded) to source item A and ranking is overridden.

Nervousness

Nervousness is the condition in which small changes in demand cause large changes in supply (planned order releases). In traditional MRP, plan nervousness causes lost time due to extra setups (and confusion and frustration) on the plant floor. With Oracle ASCP’s ability to generate a single global supply chain plan, the effects of nervousness are magnified because they extend to trading partners (who may not have the same urgency to constantly replan manufacturing to accommodate rapidly changing requirements).

Consider the following example. End-item A has lead time 1 day and order modifier of Fixed Order Period = 3 days. End-item A contains one component B, which has a lead time of 3 days and order modifier Lot for Lot. Initial planned orders for A and B are shown in the next two tables.

<table>
<thead>
<tr>
<th>Item A</th>
<th>Current</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gross Requirements</td>
<td>0</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>50</td>
</tr>
<tr>
<td>Scheduled Receipts</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Project On-Hand</td>
<td>15</td>
<td>5</td>
<td>-5</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Net Requirements</td>
<td>0</td>
<td>0</td>
<td>5</td>
<td>10</td>
<td>10</td>
<td>50</td>
</tr>
<tr>
<td>Planned Order Due Date</td>
<td>0</td>
<td>0</td>
<td>25</td>
<td>0</td>
<td>0</td>
<td>50</td>
</tr>
<tr>
<td>Planned Order Start Date</td>
<td>0</td>
<td>25</td>
<td>0</td>
<td>0</td>
<td>50</td>
<td>0</td>
</tr>
</tbody>
</table>
Now suppose that the demand for A on day 2 decreases by 5 units. Revised planned orders are shown in the two tables below.

<table>
<thead>
<tr>
<th>Item B</th>
<th>Current</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gross Requirements</td>
<td>0</td>
<td>25</td>
<td>0</td>
<td>0</td>
<td>50</td>
<td>0</td>
</tr>
<tr>
<td>Scheduled Receipts</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Project On-Hand</td>
<td>25</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>-50</td>
<td>0</td>
</tr>
<tr>
<td>Net Requirements</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>50</td>
<td>0</td>
</tr>
<tr>
<td>Planned Order Due Date</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>50</td>
<td>0</td>
</tr>
<tr>
<td>Planned Order Start Date</td>
<td>0</td>
<td>50</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item A</th>
<th>Current</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gross Requirements</td>
<td>0</td>
<td>0</td>
<td>70</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Scheduled Receipts</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Project On-Hand</td>
<td>25</td>
<td>25</td>
<td>-50</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Net Requirements</td>
<td>0</td>
<td>0</td>
<td>50</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Planned Order Due Date</td>
<td>0</td>
<td>0</td>
<td>50</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Planned Order Start Date</td>
<td>0</td>
<td>50*</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item B</th>
<th>Current</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gross Requirements</td>
<td>0</td>
<td>10</td>
<td>5</td>
<td>10</td>
<td>10</td>
<td>50</td>
</tr>
<tr>
<td>Scheduled Receipts</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Project On-Hand</td>
<td>15</td>
<td>5</td>
<td>0</td>
<td>-10</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Net Requirements</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>10</td>
<td>10</td>
<td>50</td>
</tr>
<tr>
<td>Planned Order Due Date</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>70</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Planned Order Start Date</td>
<td>0</td>
<td>0</td>
<td>70</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
* Late Start

- Note that the decrease in demand caused the planned orders for A to change from 25 on Day 1 and 50 on Day 4 to 70 on Day 3. This is an example of nervousness at work.

- Note further that the resulting change in dependent demand for B causes the planned orders for B to become infeasible, resulting in a late start - this after the demand for A decreased.

Several steps may be taken to reduce planning nervousness of the sort illustrated above.

- Eliminate the use of the order modifier Fixed Order Period for end items. Instead, use Fixed Lot Multiple or Fixed Order Quantity. Reserve Fixed Order Period for lowest-level items only.

- Make use of a planning time fence. A planning time fence of $x$ days freezes planned orders in the interval $[\text{plan start date}, \text{plan start date} + x]$. This eliminates near-term disruptions to the manufacturing schedule.

- Make use of a release time fence. A release time fence of $x$ days automatically firms and releases to the execution system planned orders in the time interval $[\text{plan start date}, \text{plan start date} + x]$. Subsequent planning runs then treat these planned orders as scheduled receipts, not subject to manipulation via order modifiers. This reduces planning nervousness.

Time fences can be used to freeze near-term plans and reduce nervousness. However, they also reduce the ability of the planning process to accommodate changes in demand. They should be set to the lowest values possible.
Topics covered in this section include the following:

- Overview of Supply Chain Modeling on page 6-2
- Setting up the Supply Chain on page 6-2
- Setting Supplier Capacity on page 6-4
- Setting up Alternate and Simultaneous Resources on page 6-10
- Setting Up Routings on page 6-36
- Planned Inventory Points on page 6-47
- Setting Up Batch Resources on page 6-54
- Allocating Demand to Suppliers on page 6-58
- Sourcing Example on page 6-60
- Viewing the Supply Chain on page 6-74
- Performing Tasks on the Planning Server on page 6-75
- Audit Statements Report on page 6-76

**A Day in the Life of a Planner**
Overview of Supply Chain Modeling

Oracle ASCP is a tool that integrates manufacturing and distribution into a single planning process. With Oracle ASCP, you can generate plans that include the entire supply chain. In a single step you can schedule and plan material and distribution requirements for multiple organizations, or centrally plan the entire enterprise. You can also include customer and supplier inventories in the supply chain planning process.

Oracle ASCP lets you plan finished products, intermediate assemblies, and purchased items for all facilities in your supply chain. Material plans for feeder plants and distribution centers automatically consider requirements originating from any number of other facilities. You can load planned order demand from multiple user organizations into the master schedule of supplying organizations.

In addition to planning the material requirements of your supply chain, you can plan the requirements for your distribution network. This includes all warehouses, distribution centers, and any location that ships products. You can use these distribution requirements plans (DRPs) as input for your material plans.

You can combine centralized distribution and material planning for items with significant inter-organization supply or demand. You can perform subset planning where you prefer autonomous local planning. Output from the central plan can go into plant-level material plans and vice versa.

Oracle ASCP gives you a transparent view of the virtual enterprise, where all inventory locations participate in the planning process.

Setting up the Supply Chain

You can define the rules that govern the movement of goods throughout your supply chain. This network is the backbone of your material flow, and you can further control its behavior by defining a time-phased replenishment strategy. Oracle ASCP implements this strategy with sourcing rules and bills of distribution (BODs).

Sourcing rules and BODs both describe sourcing supply; in other words, for any organization, they answer the question “where do I get part A?” (They never say “where do I send part A.”) Sourcing rules apply the answer to one organization or all the organizations in your enterprise. BODs define this behavior across multiple organizations (not just one or all).
Defining Sourcing Rules
You can define sourcing rules that specify how to replenish items in an organization, such as purchased items in plants. Sourcing rules can also specify how to replenish all organizations, as when the entire enterprise gets a subassembly from a particular organization.

If there are conflicts in Sourcing, a predetermined hierarchy will resolve the sourcing conflict. For instance, if you assign a bill of distribution to an organization AUS that tells it to source the part from another organization NYC, you can still define a local sourcing rule at organization AUS to source the part from yet another organization SAC. In this case, the local sourcing rule overrides the bill of distribution.

For more information on defining sourcing rules, see “Defining Sourcing Rules.” in the Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide. For information on viewing sourcing rule assignments, see “Viewing the Supply Chain” on page 6-74.

Defining BODs
You can define BODs that specify a multilevel replenishment network of warehouses, distribution centers, manufacturing centers (plants), and trading partners.

For more information on defining BODs, see “Defining Bills of Distribution” in the Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide. For information on viewing BOD assignments, see “Viewing the Supply Chain” on page 6-74.

Defining Assignment Sets
Once you have defined your sourcing rules and BODs, you must assign them to particular items and/or organizations. These assignments are grouped together in assignment sets. This is where various sourcing strategies define a particular supply chain network.

Each assignment set represents a selection of organizations and/or items you want planned. To influence the planning process, you must include an assignment set in your plan options.

In an assignment set, you can assign your sourcing rules and BODs at different levels, as follows:

- Item-Instance-Organization
Setting Supplier Capacity

Constraints

Oracle ASCP considers the following supplier capacity constraints.

Allocation of Demand Based on Historical Allocations
You can allocate planned orders to sources taking historical allocations into account. Planning uses history to determine the allocations necessary to achieve your targeted allocations.

Allocate Planned Orders With Capacity Constraints
You can specify the capacity of individual suppliers to supply specific items. You can allocate planned orders taking capacity constraints of the suppliers into account. Planning uses the ranking information you specify and first attempts to source the planned orders with the primary sources. If the primary source does not
have the capacity to fulfill the demand, planning suggests sourcing with the alternative sources you have specified, in the priority you have specified.

**Supplier-Specific Order Modifiers**
You can specify supplier-specific order modifiers at an item/supplier site level. Planning respects the order modifier quantities defined for the sources of the item. This enables you to specify more precisely the conditions related to each source.

**Supplier-Specific Lead Times**
You can specify supplier-specific lead times for items. This ensures orders are placed early enough to provide the supplier time to react to your needs.

**Delivery/Reception Frequency Calendars**
You can specify the valid delivery dates for each of your suppliers or supplier/item combinations. The reception schedule defines the dates an organization is able to receive an item from each vendor. Planning adjusts planned orders so that deliveries are planned for valid dates.

**Flexible Tolerance Fences**
You can define capacity tolerance percentages that vary over time for each source. This allows the allocation of demand over capacity by a variable amount depending on the time in the future.

**Setting Up Supplier Capacity**
Please note the following when setting up supplier capacity.

- It is important to select Global in the Supplier Capacity window.
- Processing lead time can be selected in number of days. This is a lead time at the supplier end before the order is processed.
- The delivery calendar should be entered to reflect the days the supplier can deliver the order. Examples: M, W or M, W, F.
- Minimum order quantity can be entered if the supplier has to deliver some minimum quantity if an order is placed. For example, if you have set the minimum order quantity to 25, and if 20 is ordered, 25 will be delivered.
Setting Supplier Capacity

- Fixed lot multiple value needs to be entered if the supplier delivers only in certain multiples. For example, if you have set the fixed lot multiple to 5, if quantity 103 is ordered, 105 will be delivered.

- The capacity area of the Supplier Capacity window is used to specify supplier’s capacity for a specific time period. The supplier could have different capacity on different days. For example, from 10/11/00 to 10/22/00, the supplier could have 50 units/day, and from 10/23/00 to 10/31/00, the supplier could have 70 units/day.

- Tolerance fence values can be determined to reflect how much capacity a supplier can adjust if given enough advanced notice. For example, on 10/24/00, if tolerance percentage is 10, this means that on 10/24/00, the capacity will be 77 units (in the above example).

Setting Supplier Capacity by Time Periods

Supplier capacity can vary by time period. You can specify one daily capacity for period 1 and a different capacity for period 2. Time periods are specified from a start date to an end date.

---

Note: The methods you use to set capacity by time period vary depending on which version of Oracle Applications you are using.

If you are using version 11i, to set capacity by time period:

1. Navigate to the Purchasing module (you must use the Manufacturing and Distribution Manager responsibility).
2. Choose Purchasing > Supply Base > Approved Suppliers List.
3. Choose the searchlight icon in the toolbar to search for an item. The Find ASL Item/Commodity window appears.
4. Choose an item or commodity. Supplier information appears.
5. Choose a supplier by clicking in the Supplier field.
6. Select Attributes.
7. Choose the Planning Constraints tab.

8. Enter the numbers of days in advance and the tolerance percentage.

For example, entering 15 days and 5% means that within 15 days, the supplier can increase the capacity by 5%.

**Note:** You can define capacity tolerance percentages that can vary for each of your items. The tolerance fence data in Oracle Purchasing is used to adjust production according to capacity changes for item/supplier combinations when the order is placed. Tolerance fence values can be specified for the capacity fluctuation allowed for available to promise; and used to determine demand based on the amount of advanced notice given to the supplier.

To see an example of how this might be used, please refer to Tables 6-3, 6-4, and 6-5.
If you are using version 10.7 or 11.0, to set capacity by time period:
1. Choose Collection > Workbench.
2. Locate the Item/Supplier combination.
3. [Right-click] the Item/Supplier combination. Select Supplier Capacity.

Figure 6–2  The Supplier Capacity window

4. Enter your supplier capacities by time period.

If you are using version 10.7 or 11.0, to set supplier flexfences:
1. Choose Collection > Workbench.
2. Locate the Item/Supplier combination.
3. [Right-click] the Item/Supplier combination. Select Supplier Flexfences.
Setting Supplier Specific Planning Constraints

To set a supplier specific lead time:
Enter a value in the Processing Lead Time field.

Using Delivery and Reception Frequency Calendars
You can specify delivery dates for each supplier or supplier/item combinations and create a schedule to define the dates an organization is able to receive items. The planning engine adjusts planned orders so deliveries are scheduled for the dates the receiving organization is available. You can define the delivery calendar just like a regular manufacturing calendar and you can define valid delivery dates and choose the calendar when you associate an item to a supplier site when defining the approved supplier list. The Delivery Calendar is independent of your workday calendar.
To set a delivery and reception frequency calendar:
Choose the value for the delivery/reception calendars.

Using Supplier Specific Order Modifiers
Order modifiers can be specified at the supplier site level, this overrides item level order modifiers. Two order modifiers can be specified:

- Minimum Order Quantity to specify minimum quantities that can be placed on a single order to a particular supplier site.
- Fixed Lot Multiple to specify order lot sizes that must be considered when ordering from a particular supplier. For example, if the Fixed Lot Multiple is 100 units, a planning order requirement for 125 units will result in a recommended order to the supplier for 200 units.

To set an order modifier:
Enter the order modifier value for Minimum Order Quantity or Fixed Lot Multiplier.

Setting up Alternate and Simultaneous Resources
This section discusses some of the advantages of setting up simultaneous and alternate resources and shows you how to set them up.

Advantages
- You can schedule two or more resources (simultaneous resources) to be used at the same time within the job operation. For example: you can schedule a person resource operating a machine resource (i.e., a lathe).
- You can define resource groups within the operation. This lets you give your primary resource a group number. This group can then be replaced by other resource(s). For example: a group of lathes can be replaced by a group of computer numerical control (CNC) machines.
- You have the ability to define substitute resource(s) for each primary resource group defined. This enables you to specify resource sequences that can replace the primary resource group. For example: a group of lathes can be replaced by a group of CNC machines.
- You can assign a priority to the substitute resource groups, and specify under what circumstances the substitute groups are to be considered. For example: you can assign a less expensive resource(s) as priority 1, and a more expensive
resource(s) as priority 2. This means that resource(s) with priority 1 (less expensive) will be used first.

Required Setup

To set up an alternate resource if you use 11 i source:

1. Sign on using the Manufacturing and Distribution Manager responsibility.
2. From the Navigator, choose Bills of Material > Routings > Routings.
   The Routings window appears.

Figure 6–4 Routings window

3. Select the Find (flashlight) icon.
   The Find Routing window appears.
4. Use this window to find your routing, then select Find.
   The Routing window appears with your routing.
5. From the main tab, select the operation sequence within which you want to set up alternate resources.


The Operation Resource window appears with the first resource already entered. This resource is considered as a primary resource.

**Figure 6–5  Operation Resource**

7. Select the Scheduling Tab.

8. Enter Schedule Sequence number so that you can enable the Alternate button. Schedule sequence number is used to tie the two resources together to establish alternate relationship. Schedule Seq. Number overrides Resource Sequence number.

9. Check the Principal Flag for the resource.

10. Select Alternate.
    The Operation Alternate Resources window appears.
11. Enter the alternate resource and choose Replacement Group. Replacement Group number establishes relative priority. Enter a value of 1 or higher. If you have multiple alternates, enter them as multiple rows with appropriate Replacement Group #s to indicate priorities.

12. Check the Principle Flag for your alternate resource.

To set up an alternate resource if you use 10.7 or 11.0 source:
1. Sign on using the Manufacturing and Distribution Manager responsibility.
2. From the Navigator, choose Bills of Materials > Routings > Routings.
3. Select the Find (flashlight) icon.

   The Find Routings window appears.
4. Use this window to find your routing, then select Find. The Routings Summary window appears.
5. From the Main tab, select the operations sequence for which you want to set up an alternate resource.

6. Select Operation Resources.
   The Operation Resources window appears.

7. Select a routing and select Open.
   The Routings window reappears populated with routing information.
8. Select an operation sequence for which you want to set up an alternate resource.
10. Enter the two resources you want to use as alternates.

11. Select the flexfield for the first resource (LBR-TEST, in this example).

   The Operation Resource Information window appears.
12. Designate this resource as a principal resource. Assign this resource an integer priority greater than or equal to 0.

13. Select OK.

The Operation Resource Information window closes.

14. Select the flexfield for the alternate resource (TESTER in this example).

The Operation Resource Information window reopens.
Figure 6–13  Operation Resource Information window (alternate resource)

15. Set the priority number higher than that of the first resource, and make sure the Resource Step Number matches that of the first resource.

The two resource will behave as alternates.

To set up simultaneous resources if you use 11 i source:
1. Sign on using the Manufacturing and Distribution Manager responsibility.
2. From the Navigator, choose Bills of Material > Routings > Routings.
3. Select the Find (flashlight) icon.
   The Find Routing window appears.
4. Use this window to find your routing, then select Find.
   The Routing window appears with your routing.
5. From the main tab, select the operation sequence within which you want to set up simultaneous resources.
   The Operation Resource window appears with the first resource already entered.
7. Enter Schedule Sequence number. Schedule sequence number is used to tie the two resources together to establish simultaneous relationship. Schedule Seq. Number overrides Resource Sequence number.

8. Check the Principal Flag for the first resource.

9. Enter the simultaneous resource for the resource in step number 6 as a second row in the operation resources window. Ensure that schedule sequence number you entered is the same as in step number 7.

10. Do not check the Principle Flag for your simultaneous resource. You can have only one principal resource in a given simultaneous group.

To set up simultaneous resources if you use 10.7 or 11.0 source:

1. Sign on using the Manufacturing and Distribution Manager responsibility.

2. From the Navigator, choose Bill of Materials > Routings > Routings.
3. Select the Find (flashlight) icon.

The Find Routings window appears.
Figure 6–15  Find Routings window

4. Use this window to find your routing, then select Find.
   The Routings Summary window appears.
5. From the Main tab, select the operations sequence for which you want to set up a simultaneous resource.

6. Select Operation Resources.
   The Operation Resources window appears.

7. Select a routing and select Open.
   The Routings window reappears populated with routing information.
8. Select an operation sequence for which you want to set up a simultaneous resource.

The Operations Resources window appears.
10. Enter the two resources you want to use as simultaneous resources.
11. Select the flexfield for the first resource (LBR-TEST, in this example).
   The Operation Resource Information window appears.
12. Designate this resource as a principal resource. Assign this resource an integer priority greater than or equal to 0.

13. Select OK.

   The Operation Resource Information window closes.

14. Select the flexfield for the simultaneous resource (TESTER in this example).

   The Operation Resource Information window reopens.
15. Set the Principal Resource flexfield to No, the Priority flexfield should match that of the first resource, and the Resource Step Number should match that of the first resource.

Ensuring that Related Resources are Used for the Same Job

The following two scenarios illustrate how to ensure that related resources are used for the same job.

Scenario 1: Resources are related because they belong to the same manufacturing cell

A manufacturing enterprise has two manufacturing cells, each with machining and deburring stations. The manufacturing cells are far apart on the shop floor or perhaps in different facilities altogether. The planning process must ensure that if a job is assigned to the machining station in Cell 1, it must be assigned to the deburring station in Cell 1. If it is assigned to the machining station in Cell 2, it must be assigned to the deburring station in Cell 2. After deburring, all material is processed through a common packaging operation.

In ASCP, assuming an 11i source, the routing scenario is modeled as shown in the following two tables:
Setting up Alternate and Simultaneous Resources

Each primary resource is associated with a single alternate resource. These alternate resources are listed below. CELL2_MACHINING is the alternate resource for CELL1_MACHINING, and CELL2_DEBURRING is the alternate resource for CELL1_DEBURRING. There is no alternate resource for CELL3_PACKAGING.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>10</td>
<td>2</td>
<td>CELL1_MACHINING</td>
<td>Yes</td>
<td>100</td>
<td>0</td>
</tr>
<tr>
<td>10</td>
<td>20</td>
<td>4</td>
<td>CELL1_DEBURRING</td>
<td>Yes</td>
<td>100</td>
<td>0</td>
</tr>
<tr>
<td>20</td>
<td>10</td>
<td>1</td>
<td>CELL3_PACKAGING</td>
<td></td>
<td></td>
<td>n/a</td>
</tr>
</tbody>
</table>

For a 10.7 or 11.0 source, primary and alternate resources are modeled differently, leading to the routing scenario shown in the following table:

<table>
<thead>
<tr>
<th>Sched. Seq.</th>
<th>Resource</th>
<th>Principal Res.</th>
<th>Activity Group ID</th>
<th>Replacement Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>CELL2_MACHINING</td>
<td>Yes</td>
<td>100</td>
<td>1</td>
</tr>
<tr>
<td>4</td>
<td>CELL2_DEBURRING</td>
<td>Yes</td>
<td>100</td>
<td>1</td>
</tr>
<tr>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
</tbody>
</table>

The common Activity Group ID of 100 indicates that the four activities (or task-resource combinations) CELL1_MACHINING, CELL2_MACHINING, CELL1_DEBURRING and CELL2_DEBURRING form a group within which ASCP will search for related resources on which to schedule the same job.

Within each Activity Group, ASCP looks for activities with the same Resource Priority or Replacement Group value. These are considered to be related. ASCP ensures that related resources are used as a job makes its way through its routing. In the above example, the activities CELL1_MACHINING and CELL1_DEBURRING have the same Resource Priority (0), so they would always be used together. Similarly, the activities CELL2_MACHINING and CELL2_DEBURRING have the same Replacement Group value (1), so they would always be used together.

Therefore, selection of CELL1_MACHINING automatically guarantees selection of CELL1_DEBURRING, and selection of CELL2_MACHINING automatically guarantees selection of CELL2_DEBURRING.

For a 10.7 or 11.0 source, primary and alternate resources are modeled differently, leading to the routing scenario shown in the following table:
The functions of the Activity Group ID and Resource Priority parameters are the same as in an 11i source.

Scenario 2: Perform setup and processing on the same resource

A second scenario that can be modeled using the concept of related resources is the following. Either of two injection molding machines, INJECT1 and INJECT2, can run a number of polypropylene parts. Prior to running any particular part, a setup (die change) must be performed. Obviously, the machine that incurs the setup should be the machine that runs the part.

In Oracle Applications, setup is typically modeled as the initial activity within an operation. Subsequent activities model processing. In the above scenario, if a setup activity employing INJECT1 is selected, the processing activity must be assigned to INJECT1. If INJECT2 is selected for setup, INJECT2 should do the processing. Accomplishing this behavior in ASCP (to return to the concept of related resources) requires a resource to be related to itself.

In ASCP, assuming an 11i source, this second scenario is modeled as shown in the following two tables:

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>10</td>
<td>CELL1_MACHINING</td>
<td>2</td>
<td>Yes</td>
<td>100</td>
<td>0</td>
</tr>
<tr>
<td>10</td>
<td>20</td>
<td>CELL2_MACHINING</td>
<td>2</td>
<td>Yes</td>
<td>100</td>
<td>1</td>
</tr>
<tr>
<td>10</td>
<td>30</td>
<td>CELL1_DEBURRING</td>
<td>4</td>
<td>Yes</td>
<td>100</td>
<td>1</td>
</tr>
<tr>
<td>10</td>
<td>40</td>
<td>CELL2_DEBURRING</td>
<td>4</td>
<td>Yes</td>
<td>100</td>
<td>1</td>
</tr>
<tr>
<td>20</td>
<td>10</td>
<td>CELL3_PACKAGING</td>
<td>1</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
</tbody>
</table>

Each primary resource is associated with a single alternate resource. These alternate resources are listed below. INJECT2 is the alternate resource for INJECT1.
Alternate Resource

<table>
<thead>
<tr>
<th>Sched. Seq.</th>
<th>Resource</th>
<th>Principal Res.</th>
<th>Activity Group ID</th>
<th>Replacement Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>INJECT2</td>
<td>Yes</td>
<td>100</td>
<td>1</td>
</tr>
<tr>
<td>4</td>
<td>INJECT2</td>
<td>Yes</td>
<td>100</td>
<td>1</td>
</tr>
</tbody>
</table>

If INJECT1 (Resource Priority 0) is chosen for the setup task (Resource Sequence 10), then INJECT1 will be also chosen for the processing task (Resource Sequence 20), because the Resource Priority for that activity is also 0. If INJECT2 (Replacement Group 1) is chosen for the setup task (Resource Sequence 10), then INJECT2 will be also chosen for the processing task (Resource Sequence 20), because the Replacement Group number for that activity is also 1.

For a 10.7 or 11.0 source, the routing scenario is shown in the following table:

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>10</td>
<td>INJECT1</td>
<td>2</td>
<td>Yes</td>
<td>100</td>
<td>0</td>
</tr>
<tr>
<td>10</td>
<td>20</td>
<td>INJECT2</td>
<td>2</td>
<td>Yes</td>
<td>100</td>
<td>1</td>
</tr>
<tr>
<td>10</td>
<td>30</td>
<td>INJECT1</td>
<td>4</td>
<td>Yes</td>
<td>100</td>
<td>0</td>
</tr>
<tr>
<td>10</td>
<td>40</td>
<td>INJECT2</td>
<td>4</td>
<td>Yes</td>
<td>100</td>
<td>1</td>
</tr>
</tbody>
</table>

The functions of the Activity Group ID and Resource Priority parameters are the same as in an 11i source.

**Note:** Only operation resources within the same operation sequence can be designated as related resources. You cannot designate related resources across multiple operation sequences. Also, you cannot model complex resource dependencies. For example, if a job runs on CELL1_MACHINING, it cannot then run on either CELL1_DEBURRING or CELL5_DEBURRING. The type of resource relationship supported is strictly one-to-one.
To establish resource relationships using an 11i source:

**Note:** You must first complete the setup steps for alternate resources using an 11i source, as described on page 6-11 in the Required Setup section. Then, use the following steps to enter four additional pieces of information:

- (Data #1) The Resource Priority of all primary operation resources.
- (Data #2) The Activity Group ID of all primary operation resources.
- (Data #3) The Replacement Group of all alternate operation resources.
- (Data #4) The Activity Group ID of all alternate operation resources.

1. Sign on using the Manufacturing and Distribution Manager responsibility.
2. From the Navigator, choose Bills of Material > Routings > Routings.
   The Routings window (blank) appears.
3. Select the Find (flashlight) icon.
   The Find Routings window appears.
4. Enter routing search criteria (for example, the name of the item for which you wish to find a routing), then select Find.
   The Routings Summary window appears.
5. Select a routing from this window, then select Open.
   The Routings window (populated with routing data) appears.
6. Select a particular operation sequence.
7. Select Operation Resources.
   The Operation Resources window appears.
8. Select the Scheduling tab.
9. Select a primary resource, and select the corresponding flexfield at the right side of the window.
   The Operation Resource Information window appears.
10. Enter the Resource Priority (Data #1) and Activity Group ID (Data #2) of the primary resource.

11. Select OK to close the Operation Resource Information window and return to the Operation Resources window.

12. Select Alternates to enter information about alternate resources for the selected operation resource.

The Operation Alternate Resources window appears.

13. Select the Scheduling tab.

14. Select an alternate resource. Enter the Replacement Group (Data #3) for the alternate resource.

15. Select the flexfield at the right side of the window corresponding to the selected alternate resource.

The Operation Resource Information window appears.
16. Enter the Activity Group ID (Data #4) of the alternate resource.

17. Select OK.

➢ To establish resource relationships using a 10.7 or 11.0 source:

**Note:** You must first complete the setup steps for alternate resources using a 10.7 or 11.0 source, as described on page 6-11 in the Required Setup section. Then, use the following steps to enter two additional pieces of information:

- (Data #1) The Resource Priority of all operation resources
- (Data #2) The Activity Group ID of all operation resources

1. Sign on using the Manufacturing and Distribution Manager responsibility.
2. From the Navigator, choose Bills of Material > Routings > Routings.
   The Routings window (blank) appears.
3. Select the Find (flashlight) icon.
The Find Routings window appears.

4. Use this window to enter routing search criteria (for example, the name of the item for which you wish to find a routing), then select Find.

The Routings Summary window appears.

5. Select a routing from this window, then select Open.

The Routings window (populated with routing data) appears.

6. Select a particular operation sequence.

7. Select Operation Resources.

The Operation Resources window appears.

*Figure 6–23 Operation Resources window*

8. Select the Scheduling region.

9. Select a resource, and select the corresponding flexfield at the right side of the window.

The Operation Resource Information window appears.
10. Enter the Priority (Data #1) and Activity Group ID (Data #2) of the selected resource.

11. Select OK to close the Operation Resource Information window.

Setting Up Routings

The manufacturing process or routing to make a product includes the operations that are required to be performed in a predetermined sequence.

Operation Resource Schedule Flag

Some resources are also required to carry out these operations and these resources need to be scheduled. The schedule flag determines whether a resource is scheduled.

When the schedule flag has been set to No, the corresponding operation resource is not brought over to the planning server as a part of the routings and is not scheduled. When the schedule flag has been set to Yes, Prior, or Next, the corresponding operation resources are brought over to the planning server as a part of the routings collection.
To model the resource schedule:

1. Sign on using the Manufacturing and Distribution Manager responsibility.

2. From the Navigator, select Bill of Material > Routings > Routings.
   The Routings screen appears.

3. Select Operation Resources.
   Operation Resources screen appears.

4. Set up resource schedule from the Scheduling tab. The possible values for the schedule flag are: Yes, No, Prior, Next.

   For details on other columns and functionality, refer to the Routings chapter in the Oracle Bills of Material User’s Guide.

Minimum Transfer Quantity (MTQ)

Oracle ASCP allows you to specify a Minimum Transfer Quantity (MTQ), which is the minimum amount that an operation must be completed in order to trigger the start of the next operation.
MTQ is used to model production operations in which materials are transferred in lots smaller than the processing lots, resulting in subsequent operations that start before the current operation is completely finished. You can specify Minimum Transfer Quantities between routings as well as between operations of a routing. Oracle ASCP respects Minimum Transfer Quantity while scheduling operations.

In the process of scheduling an operation, Oracle ASCP dynamically uses the production rate of the selected alternative resource to determine when to begin the material transfer to the subsequent operation. Production breaks are honored.

The following diagram shows how MTQ is used:

**Figure 6–26  MTQ Example**

![Diagram showing MTQ example]

**Capability**

You can specify Minimum Transfer Quantities between routings and between operations. Oracle ASCP schedules operations with respect to Minimum Transfer Quantity.

**To set up the Minimum Transfer Quantity:**

1. Sign on using the Manufacturing and Distribution Manager responsibility.
2. From the Navigator, choose Bill of Materials > Routings > Routings.
3. Define Routing.
5. Select the WIP tab.

**Interrouting Minimum Transfer Batch Size**

You can specify Minimum Transfer Quantity between routings by using the Minimum Transfer Quantity field in the WIP region of the Routings form. The interrouting MTQ is specified for the last operation of the upstream routing.

**Intrarouting Minimum Transfer Batch Size**

You can specify Minimum Transfer Quantity between operations by using the Minimum Transfer Quantity field in the WIP region of the Routings form. The intrarouting MTQ (between operations) is specified for the current operation.
Consideration of Resource Breaks

When resource breaks are present, then ASCP will manipulate the start time of the next operation relative to the start time of the current operation so as to both respect MTQ constraints and avoid starvation of the next operation. This behavior is illustrated through the examples below.

**Advanced Example 1 - Resource Break in the Current Operation, No Resource Break in the Next Operation: First Variation**

The figure below illustrates that MTQ is available before the break. Considering the no starvation rule, the second operation starts after MTQ Production Time plus Break. The break postpones the start of the second operation.

*Figure 6–28  MTQ - Example 1*

![Diagram showing MTQ availability and resource break](image)

Next Operation Start = MTQ Production Time + Break

**Advanced Example 2 - Resource Break in the Current Operation, No Resource Break in the Next Operation: Second Variation**

The figure below illustrates that MTQ is available after the break. The break delays the start of the downstream operation by delaying the time at which MTQ units are completed by the first operation.
**Figure 6-29 MTQ - Example 2**

Current Operation

Next Operation

MTQ Production Time = A1 + A2
Next Operation Start = A1 + A2 + Break

**Advanced Example 3 - No Resource Break in the Current Operation, Resource Break in the Next Operation**

The figure below illustrates that the break in the second operation does not affect when material is initially required at the second operation, so the second operation starts exactly after MTQ units are completed at the first operation.

**Figure 6-30 MTQ - Example 3**

Current Operation

Next Operation

Next Operation Start = MTQ Production Time
Multiresource Scheduling

For some types of manufacturing operations, the duration can be shortened by applying greater numbers of processing resources. For example, the duration of a visual inspection operation can be approximately halved by increasing the number of inspectors from one to two. For these types of divisible manufacturing operations, it is important to accurately plan for the shrinking of the operation duration as greater numbers of processing resources are deployed. It is also important to be able to designate certain operations as divisible and others as indivisible (one resource per operation). The multiresource scheduling feature of Oracle ASCP accomplishes these aims.

Using Multiresource Scheduling

Shown below are examples of how this feature can be used in various manufacturing scenarios.

Note: In the following scenarios, the notation Res 1, Res 2, etc., refers to multiple identical units of a single resource defined in Oracle Bills of Material, not to multiple distinct resources.

Scenario 1

In this scenario, multiple resource units work together on an operation (divisible).

A manufacturing house is assembling telephone handsets. The handset assembly job consists of one assembly operation that takes one hour. The manufacturing house has one resource called RES. The resource RES has 4 resource units which are 4 assemblers (Res 1, Res 2, Res 3, Res 4). Please note that within ASCP, a resource can be either a single or a multiple resource unit of the same type.
Job parameters:

Job                  handset assembly
Job Qty              6
Resource RES units   Res 1, Res 2, Res 3, Res 4
Usage rate           1 hr. per operation

The following figure shows how the resource unit allocation should be done.

**Figure 6–31 Scenario 1**

![Diagram showing resource allocation](image)

Total processing time for the Job = 1.5 hours (when multiple resources can work together on a job)

**Scenario 2**

This scenario shows a single unit per operation (indivisible).

In printed circuit board assembly, one resource unit is required to finish the entire operation. This is because the item is so small, only one person can handle it. Sometimes even from the process perspective it is not possible to use two units on one job at one time. After soldering, cleaning is done by a machine in which the
board goes inside the cleaning machine. In this case, two cleaners cannot work together on a single board.

**Job Parameters:**

Job Quantity 6

Resource RES Res 1, Res 2, Res 3, Res 4

Usage Rate 1 hour per operation

The following figure shows how resource unit allocation should be performed in this situation.

---

**Note:** In the following figure, Oracle ASCP assumes that during the second hour, Res 3 and Res 4 remain consumed for the purpose of calculating resource utilization, and are not available for any other job. To overcome this approximation, you can define Res 1, Res 2, Res 3, and Res 4 as individual resources (instead of multiple units of the same resource).
To assign resource units on a one-to-one basis:
You select a rounding control attribute in the item master. When the Round Order Quantities flag is checked, it means only one resource unit can work on one assembly at a time.

1. From the Manufacturing and Distribution manager responsibility
2. Select Inventory > Items > Master Items.
3. Use the scroll arrow so that the MPS/MRP Planning tab appears.
4. Check or uncheck Round Order Quantities.

Following are the few examples of behavior when rounding control attribute is checked.

Example 1:
Job quantity: 4
Number of assigned resource units: 5
Job duration: 1 hour

Here, four resource units are assigned 4 jobs and the fifth resource unit is idle. The job takes one hour to complete.

Example 2:
Job quantity: 4
Number of assigned resource units: 3
Job duration: 2 hours

Here, all 3 resource units are occupied for first two hours (job duration). For the next two hours, only one resource unit is occupied. The job takes four hours to complete.

Example 3:
Job quantity: 8
Number of assigned resource units: 3
Job duration: 1 hour
Here, all 3 resource units are occupied for first two hours. For the next hour, two resource units are occupied. The job takes 3 hours to complete.

The following table also explains Example 3.

**Figure 6–33  Example 3**

![Example 3 Diagram]

**Note:** In ASCP, the number of resource units per operation/activity is controlled by the Assigned Units field in the Routing form.

**Example 4**

Since Oracle ASCP treats the capacity of multiple units of a single resource as a large bucket (instead of as independent buckets for each resource unit), certain detailed scheduling decisions will be approximate and may not be locally optimal. For example, in the situation below:

Job Parameters:

- Assigned units 2
- Job 1 quantity 2
- Job 2 quantity 4
- Job duration 1 hour
- Max/available resource units 3
In the figure below, the table to the left shows what happens when Job 2 is scheduled first and the table to the right shows what happens when Job 1 is scheduled first. Both of the outcomes shown in the figure below are possible, depending on the order in which the jobs are assigned to the resource units.

**Figure 6–34  Example 4**

![Figure showing job and resource assignments](image)

**Planned Inventory Points**

One of the major functions of production control is to release work to the shop floor and monitor its progress. Once you release the work to the shop floor, the normal path is to complete the work as planned. If the demand pegged to the work being performed disappears, you may end up with excess supply. In some manufacturing environments, work can be stopped right after you realize that the demand no longer exists. However, work cannot be always stopped after demand cancellations due to practical reasons. The most important reasons are the possibility of losing materials to scrap, needing to reprocess some of the steps at enormous cost, and the need to control the production process and corresponding yields. It is not desirable to leave the discrete jobs on the floor for excessive amount of time as it adds to confusion, occupies precious space, and increases work in process value. Therefore, the need is to continue processing until the product reaches a stage in the Bills of Material where it can be safely stored until the next demand comes along. These stages in the Bills of Material can be visualized as major staging or stocking points. These stages will be referred to as Planned Inventory Points (PIPs).

The following are some examples of work that cannot be stopped for various reasons:
In semiconductor manufacturing, if wafers are left alone for a long period of time after they are processed in the furnace, they oxidize and run the risk of being scrapped.

In certain semi-conductor fabrication processes such as Ion Implantation, Defusion, and Photo Lithography, acid clean activity is involved. If you leave the parts alone for a long time after they are acid cleaned, they have to be recleaned before they are passed on to the next process.

In semi-conductor operations, between fabrication and testing, a critical closed loop exists to measure performance and adjust production processes based on tests. There is a need to provide timely test results and act on corrective actions. If work orders spend too much time without generating results, it affects process control and yields.

In Consumer Product Goods manufacturing, bottling fluids such as food supplements need to happen after certain number of hours following an extraction and condensation process. If you fail to bottle within a specified amount of time, you will have to destroy the product as it will not be suitable for consumption.

The following list summarizes some of ways in which PIP functions:

- tries to allocate supplies that are not pegged to a demand to a different sales order or a forecast
- recognizes an item attribute called Planned Inventory Point
- continues to process the work until you reach a PIP even if the demand driving the supply in work in process does not materialize
- works on the jobs that are not pegged to a demand at a much slower pace than the jobs that are satisfying other valid demands

**PIP Capability**

This section contains examples of how the PIP features work.

**Specify Inventory Point at Item Level**

You can specify if the item can be stocked by specifying it as an Inventory Point. If you are using the 11i version of the transaction system, you can choose the PIP Attribute for an item at Item-Organization level.
If you are using the 11.0 version of the transaction system, you can choose the attribute in the flex field at the item attributes form. The name of the flex field is Inventory Point and the possible values are Yes or No.

If you designate the item as an Inventory Point item, it suggests that the material can be stored at this item level without the fear of losing the materials or losing quality characteristics of the materials. PIPs generally point to major stocking phases in manufacturing cycle.

**Move Jobs to PIP Level**

If you have an existing job and it does not have any demands to peg to, you can move the job to the next PIP level. For example, the figure below shows a BOM, where item Z is a purchased item that gets processed to become item A. It goes through several stages of manufacturing, changing the item number several items as mentioned on the BOM.

Assume that you have demand for item A, you have purchased item Z, and are working on creating item D using a discrete job. If for some reason, the end demand for A disappears, you can continue scheduling the discrete job for D instead of recommending a cancellation. You can allocate the discrete job to other valid demands (sales orders, forecasts, order modifiers) if they exist. Please note that allocating unconsumed supplies to other valid demands is the standard Oracle APS behavior.

*Figure 6–35  Bill with Inventory Point*

Once you start a job, your goal is to reach the next Inventory Point, that is (referring to the previous figure), you need to generate and schedule orders for items C and B.
If you fail to do so, you run the risk of scrapping or reworking the discrete job for item D. This means that you would have to introduce fictitious demand at a PIP so that the system would generate and schedule planned orders for item C and B.

Order Modifiers and Planned Inventory Points
If the item at the PIP has an order modifier, you can add demand at the PIP that honors the order modifiers. In the previous example, you have a Discrete Job for 15 units at item D, you do not have a committed end demand for it, and item B has an the following order modifier: the Minimum Order Quantity is set to 30 units. For this example, Oracle APS will add a fictitious demand of 30 units for Item B, which is a PIP. If you have order modifiers for an item, you will have excess supplies, and therefore, you can expect excess supplies at lower levels in the Bills of Material.

Addition of Fictitious Demand
Oracle APS adds the necessary amount of fictitious demand so that the jobs and planned orders are scheduled with their normal lead times (cumulative lead time). If orders need to be created at different levels (items), the cumulative lead times are added for all such items. If the lead times for item Z and D are 4 and 3 days respectively, the fictitious demand is added 7 days from the due date of the job assuming that the job is for item D.

Pegged Jobs at Different Levels on the BOM
You may have jobs opened at two or more levels that peg to each other. In such cases, the amount of fictitious demand added is equal to the maximum quantity of the jobs that needs to be moved to PIPs. The fictitious demand is not just a sum total of all the open unpegged jobs. For example, using Figure 6–35 as a template, you could have two jobs pegged to each other: a job for item D for 10 units and a job for item C for 5 units. If there is a cancellation of end item demand from item A, the fictitious demand would be for 10 units. This means there would be extra supplies (planned orders) created at item C for 5 units. You can analyze item excess exceptions to figure out any excess.

On-Hand Quantities
On-hand quantities for items below a PIP may affect the logic of moving unpegged jobs to a PIP. Assume that you have 10 units on hand for Item C and you have an unpegged job for Item D for 5 units. The normal logic for PIP is to add 5 units of fictitious demand at Item B, which is the next PIP. Because 5 units of fictitious demand is smaller than the 10 units that are on-hand at Item C, you will not be able
to pass the demand to the job at Item D. This affects the movement of the job to the next PIP.

Oracle APS assumes that you will issue any on-hand material present at levels below a PIP to jobs at higher levels. This is logical as you do not want to have any inventories sitting below a PIP.

It is possible to have multiple Inventory Points in a BOM as shown in the next diagram:

*Figure 6–36  Bill with Multiple Inventory Points*

If you have a job started at item Z and lose the demand, Oracle APS generates and schedules orders to reach Item D including item D. If you have started a discrete job for item C and lose the end demand, Oracle APS generates and schedules orders to reach item B including item B.

**Job Properties: Firm and Status**

PIP logic schedules jobs to the next PIP even without a valid demand for it instead of canceling it. The idea is to reach a point in the bill of materials where materials could be stored without the fear of losing them. Firm jobs are also scheduled similar to nonfirm jobs in order to aid the process of scheduling materials to reach a PIP.

Firm jobs by nature are not open to rescheduling; hence, any scheduling of higher level items to reach the next PIP need to work around the scheduling that is done.
for firm jobs. For example, you might have a firm job for item Z due on day 25 and the demand that the firm job was pegged to does not materialize. This leaves you with the task of moving materials being processed by the firm job to the next PIP. Because you cannot change the scheduling already done for firm job, you must work around the firm job schedule. The planned order generated for item D to help the process of moving materials from firm job to the next PIP is scheduled such that it starts on D25. If item D has a lead time of 5 days, the planned order start for item C is scheduled on D30.

Oracle ASCP treats jobs with statuses of Released and Unreleased in the same manner. Jobs with both these statuses are subject to rescheduling to aid the process of scheduling materials to reach the next PIP.

**Generate PIP Orders Exception**

Scheduling of jobs even after cancellation of committed demand is an exception condition. In the application, you can see scheduling of such orders as exceptions. The exception Orders Moved to Next PIP Level is generated for each order moved to the next PIP. Please note that this exception is created only for orders that are completely pegged to the fictitious demand.

**Using PIP**

The following procedures show how to use PIP.

**Step A: To specify that an item should be treated as a PIP:**

1. Sign in using the Manufacturing and Distribution Manager responsibility.
2. From the Navigator, select Inventory > Items > Master Items.
   
   The Master Item screen appears.
3. Define an item and specify the item attributes.
4. Select the MPS/MRP Planning tab.
5. Select the Planned Inventory Point checkbox.
6. Save your work.

**Step B: To choose a plan level option to enable PIP:**

1. Sign in using the Advanced Supply Chain Planner responsibility.
2. From the Navigator, select Supply Chain Plan > Names.
   
   The SCP Names screen appears.
3. Define a plan name.

4. Select the Options button.
   The Plan Options screen appears.

5. Select the Move Jobs to PIP checkbox.
   By checking this checkbox, if you have discrete jobs, lot-based jobs or
   nonstandard jobs with no end demand, Oracle APS will create and schedule
   supplies for all items between the item which has discrete jobs and the Planned
   Inventory Point.

6. Save your work.

7. After completing Steps A and B, run the plan.

**Step C: To review and analyze scheduling of orders:**
1. Sign in using the Advanced Supply Chain Planner responsibility.
2. From the Navigator, select Supply Chain Plan > Workbench.
   The Planner Workbench appears.
3. Access either the Resource Requirement window or the Gantt chart to review
   scheduling for the supply. See steps D and E below.

**Step D: To access the Resource Requirement window:**
1. From the Planner Workbench, select a plan and an item.
2. Select the item and select Supply from the Tools menu.
   The Supply window appears.
3. Select and item, then right click and select Resource Requirements.
   The Resource Requirements screen appears.
4. Review scheduling for the supply.

**Step E: To access the Gantt Chart:**
1. From the Planner Workbench, select a plan and an item.
2. Select Supply/Demand from the Tools menu.
   The Supply/Demand window appears.
3. Select an item, then right click and select Gantt chart.
The Gantt chart appears.

4. Review scheduling for the supply.

**Step F: To analyze exceptions:**

1. Sign in using the Advanced Supply Chain Planner responsibility.
2. From the Navigator, select Supply Chain Plan > Workbench.
   
   The Planner Workbench appears.
3. Select a plan and then select the Actions tab on the right pane.
   
   A list of action types appears.
4. Double-click Reschedules (this is a type of exception summary).
   
   A list of exceptions appears.
5. Select Orders scheduled to next inventory point.
   
   The Exception Details screen appears.
6. Review the exceptions.

**Setting Up Batch Resources**

Batch operations can process multiple items simultaneously. Typical examples of batch operations are heat treatment, sand blasting, electro-plating, specialized drying, and gamma ray treatment to kill bacteria.

Work scheduled via batch processing is characterized by the same work performed on multiple items simultaneously for a preset amount of time. Some of the other characteristics of batch processing are similarities in processing, capacity available to hold the items, and minimum batch size considerations.

The critical issues for scheduling batch operations are:

- Grouping items for scheduling
- Constraining resources along multiple dimensions
- Honoring minimum and maximum batch sizes
- Delaying or prebuilding to make up a batch

The following steps show the basic business process flow for scheduling batch operations:

1. Group orders for an item or across items for batch operations.
2. Evaluate batch resources availability along multiple dimensions.
3. Determine minimum and maximum batch sizes.
4. Determine delaying and/or prebuilding criteria for batching.

**Capability**

Oracle ASCP allows you to specify a resource as a batch type resource at the department resource level. A batch type resource is consumed only on a Lot basis. Oracle ASCP batches several orders for an item or across items when scheduling batch resources. Oracle ASCP batches operation sequences that carry the same batchable resource and schedules them as a batch. The criteria for batching depends on the following factors:

- Sharing same standard operation code
- Same usage on the routing

If you do not assign a standard operation code to an operation sequence that uses a batchable resource, Oracle ASCP only batches orders with matching durations.

**To set up Resource Batching:**

1. Sign on using the Manufacturing and Distribution Manager responsibility.
2. From the Navigator, select Bills of Materials > Routings > Departments.

*Figure 6–37 Departments*
3. Select the Department field and use the flashlight icon to select a Department.

4. Select Resources.
   The Department Resources form appears.

*Figure 6–38  Department Resources form*

5. Select the Planning tab and open the flexfield.
   The Department Resource Information form appears.
Figure 6–39  Department Resources Information

This form contains the setup parameters for a batchable resource.

6. Specify a resource as a batch type resource at the department resource level by setting the Batchable Flag to Yes.

7. Specify a window to batch orders.

8. Specify minimum and maximum batch quantities for batch type resources.

9. Specify a unit of measure (volume or weight) at the resource level.

Batching Window
Oracle ASCP allows you to specify a window to batch orders. You can specify the window size at the department resource level. If the system does not find orders in the Batching window which is equal to or more than the minimum batch quantity, it starts a batch with less than minimum quantity. In this case, an exception message is generated.

Minimum / Maximum Batch Capacity
You can specify minimum and maximum batch quantities for batch type resources. The minimum batch size is implemented as a soft constraint. The maximum batch size is a hard constraint. Oracle ASCP continues to batch orders until the maximum batch size is met or until the Batching window is exceeded.

Batchable Unit of Measure
You can specify a unit of measure (volume or weight) at the resource level that is appropriate to your resource. In addition to the resource availability (time
Oracle ASCP allows you to constrain a resource in one other dimension (batching dimensions are time, volume, and weight).

The batching activity is constrained by the maximum capacity set for a resource.

**Example: Batching orders for 2 items**

The following table presents order quantities for two items, A and B, sharing the same batchable resource:

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Item A</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>3</td>
<td>0</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>Item B</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>3</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

Batching Window = 3

Maximum Capacity = 6

Considering the batching window and the maximum capacity of the resource, the first batch is processed on day 2 for the total quantity of 4:

First Batch on Day 2 = 2 + 2 = 4

Because there is a maximum capacity of 6, the 3 units on day 5 is not included in the first batch.

Second Batch on Day 5 = 3 + 3 = 6

**Allocating Demand to Suppliers**

For more information on the following topics, see “Sourcing Rules and Bills of Distribution” in the *Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide*.

**Setting Rank and Allocation**

You can define a rank for each source of supply named in the sourcing rules and BODs. You can then define a sourcing percentage for each source within a rank, allowing you to allocate a portion of the total orders to each source.
Splitting Demand According To Sourcing Percentages

In unconstrained plans, demand can be divided and allocated to multiple sources according to target sourcing percentages set in the rules.

The data in these tables demonstrate how allocation percentages for planned orders are divided according to ranking information.

The demand for Item A is shown in the following table.

<table>
<thead>
<tr>
<th>Demand</th>
<th>Due Date</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>07/15</td>
<td>300</td>
</tr>
</tbody>
</table>

Sourcing for Item A is shown in the following table.

<table>
<thead>
<tr>
<th>Item</th>
<th>Source</th>
<th>Rank</th>
<th>Percentage</th>
<th>Effective From</th>
<th>Effective To</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>S1</td>
<td>1</td>
<td>40</td>
<td>05/15</td>
<td>12/31</td>
</tr>
<tr>
<td>A</td>
<td>S2</td>
<td>1</td>
<td>30</td>
<td>05/15</td>
<td>12/31</td>
</tr>
<tr>
<td>A</td>
<td>S3</td>
<td>1</td>
<td>30</td>
<td>05/15</td>
<td>12/31</td>
</tr>
</tbody>
</table>

Demand is assigned using the ranking information and calculating the percentages assigned to each source to calculate the planned orders.

- S1: $300 \times 0.40 = 120$
- S2: $300 \times 0.30 = 90$
- S3: $300 \times 0.30 = 90$

Three planned orders are created for the quantities of 120, 90, and 90 respectively.

---

**Note:** All planned orders generated in this process are subject to item order modifiers.

If you run a constrained plan and did not use optimization, the supplies calculated above will be scheduled based on the supplier capacity established for the item. If optimization is used, Oracle ASCP will not split the orders per the sourcing splits in sourcing rules; it will evaluate the suppliers by rank and considers supplier capacities to come up with allocations to suppliers. The rank, lead time and capacity of 3 suppliers is shown in the following table.
Allocating Demand to Suppliers Based on Historical Demand

You can allocate planned orders taking into account historical allocations in unconstrained plans. The enhanced sourcing logic considers historical allocations and allows the splitting of demand to achieve target sourcing percentages.

Sourcing Example

Tables 6-1 through 6-8 contain the set up data required to explain the example. Table 6-9 has historical allocation data, which results from previous allocations.

**Table 6-1 Demand for Item A**

<table>
<thead>
<tr>
<th>Demand for Item A</th>
<th>Due Date</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>7/15/98</td>
<td>310</td>
</tr>
<tr>
<td>2</td>
<td>7/16/98</td>
<td>280</td>
</tr>
</tbody>
</table>

**Table 6-2 Sourcing Rules Data for Item A**

<table>
<thead>
<tr>
<th>Item</th>
<th>Source</th>
<th>Rank</th>
<th>Percentage</th>
<th>Effective From</th>
<th>Effective To</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>S1</td>
<td>1</td>
<td>50</td>
<td>5/15/97</td>
<td>12/31/97</td>
</tr>
<tr>
<td>A</td>
<td>S2</td>
<td>1</td>
<td>50</td>
<td>5/15/97</td>
<td>12/31/97</td>
</tr>
<tr>
<td>A</td>
<td>S1</td>
<td>1</td>
<td>100</td>
<td>1/1/98</td>
<td>7/14/99</td>
</tr>
<tr>
<td>A</td>
<td>S2</td>
<td>2</td>
<td>60</td>
<td>1/1/98</td>
<td>7/14/99</td>
</tr>
<tr>
<td>A</td>
<td>S3</td>
<td>2</td>
<td>40</td>
<td>1/1/98</td>
<td>7/14/99</td>
</tr>
</tbody>
</table>

**Table 6-3 Supplier Capacity Profile for Item A**

<table>
<thead>
<tr>
<th>Source</th>
<th>7/10/98 (Thurs)</th>
<th>7/11/98 (Fri)</th>
<th>7/14/98 (Mon)</th>
<th>7/15/98 (Tues)</th>
<th>7/16/98 (Wed)</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>60</td>
<td>60</td>
<td>60</td>
<td>60</td>
<td>60</td>
</tr>
<tr>
<td>S2</td>
<td>80</td>
<td>80</td>
<td>80</td>
<td>80</td>
<td>80</td>
</tr>
</tbody>
</table>
Table 6-4 Supplier Capacity Tolerance Percentages for Item A

<table>
<thead>
<tr>
<th>Source</th>
<th>7/10/98 (Thurs)</th>
<th>7/11/98 (Fri)</th>
<th>7/14/98 (Mon)</th>
<th>7/15/98 (Tues)</th>
<th>7/16/98 (Wed)</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>10</td>
</tr>
<tr>
<td>S2</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>5</td>
<td>10</td>
</tr>
<tr>
<td>S3</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>5</td>
<td>10</td>
</tr>
</tbody>
</table>

Table 6-5 Supplier Capacity Profile with Tolerance Percentages for Item A

<table>
<thead>
<tr>
<th>Source</th>
<th>7/10/98 (Thurs)</th>
<th>7/11/98 (Fri)</th>
<th>7/14/98 (Mon)</th>
<th>7/15/98 (Tues)</th>
<th>7/16/98 (Wed)</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>60</td>
<td>60</td>
<td>60</td>
<td>60</td>
<td>66</td>
</tr>
<tr>
<td>S2</td>
<td>80</td>
<td>80</td>
<td>80</td>
<td>84</td>
<td>88</td>
</tr>
<tr>
<td>S3</td>
<td>20</td>
<td>20</td>
<td>21</td>
<td>22</td>
<td></td>
</tr>
</tbody>
</table>

The numbers in Table 6-5 come from applying tolerance percentages from Table 6-4 to the supplier capacity profile in Table 6-3. For example, for supplier S1 on 7/16/98, total supplier capacity is 60 + 10%(60) = 66.

Table 6-6 Supplier Delivery Patterns for Item A

<table>
<thead>
<tr>
<th>Source</th>
<th>Reception Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>Mondays and Wednesdays</td>
</tr>
<tr>
<td>S2</td>
<td>Mondays</td>
</tr>
<tr>
<td>S3</td>
<td>All days except Fridays</td>
</tr>
</tbody>
</table>

Table 6-7 Supplier Processing Information for Item A

<table>
<thead>
<tr>
<th>Source</th>
<th>Processing (days)</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>3</td>
</tr>
<tr>
<td>S2</td>
<td>2</td>
</tr>
<tr>
<td>S3</td>
<td>2</td>
</tr>
</tbody>
</table>
Table 6-8 Order Modifiers at Each Source for Item A

<table>
<thead>
<tr>
<th>Source</th>
<th>Min. Order Quantity</th>
<th>Fixed Lot Multiple</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>50</td>
<td>5</td>
</tr>
<tr>
<td>S2</td>
<td>25</td>
<td>25</td>
</tr>
<tr>
<td>S3</td>
<td>21</td>
<td>7</td>
</tr>
</tbody>
</table>

Order Modifiers for Item A:
- Minimum Order Quantity: 17
- Fixed Lot Multiple: 88

Lead Times for Item A:
- Preprocessing: 0
- Postprocessing: 1

Table 6-9 Historical Allocation Totals

<table>
<thead>
<tr>
<th>Source</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>S2</td>
<td>1400</td>
</tr>
<tr>
<td>S3</td>
<td>1000</td>
</tr>
</tbody>
</table>

Table 6-10 Horizontal Plan

<table>
<thead>
<tr>
<th>Item A</th>
<th>7/10/98</th>
<th>7/11/98</th>
<th>7/14/98</th>
<th>7/15/98</th>
<th>7/16/98</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>310</td>
<td>280</td>
</tr>
<tr>
<td>Excess Schedule Receipts</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>16</td>
<td>0</td>
</tr>
<tr>
<td>Planned Orders - Org S1</td>
<td>0</td>
<td>0</td>
<td>288</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Planned Orders - Org S2</td>
<td>0</td>
<td>0</td>
<td>125</td>
<td>100</td>
<td>0</td>
</tr>
<tr>
<td>Planned Orders - Org S3</td>
<td>0</td>
<td>0</td>
<td>21</td>
<td>56</td>
<td>0</td>
</tr>
</tbody>
</table>

Allocations for Demand #1

Allocation Calculation Using Historical Allocation Information and Target Percentages for Demand #1:

Quantity = 310
Due Date = 7/15/98 (Tuesday)
Based on the input demand data, we can now calculate how the demand for Item A will be satisfied.

**Step 1: Allocation to S1.**
Monday 7/14/98 is the latest reception date (from Table 6-6) before due date (7/15/98). This respects the processing and postprocessing lead times (Table 6-7).
Cumulative capacity = 180 from Table 6-5 (tolerance percentage = 0)
Unsatisfied demand = 310 - 180 = 130
Allocation to S1 = 180
Table 6-11 shows you the resource availability after the allocation of 180 items consumes capacity.

<table>
<thead>
<tr>
<th>Source</th>
<th>7/10/98 (Thurs)</th>
<th>7/11/98 (Fri)</th>
<th>7/14/98 (Mon)</th>
<th>7/15/98 (Tues)</th>
<th>7/16/98 (Wed)</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>60</td>
<td>66</td>
</tr>
<tr>
<td>S2</td>
<td>80</td>
<td>80</td>
<td>80</td>
<td>84</td>
<td>88</td>
</tr>
<tr>
<td>S3</td>
<td>20</td>
<td>20</td>
<td>20</td>
<td>21</td>
<td>22</td>
</tr>
</tbody>
</table>

The values in Table 6-11 are derived from subtracting demand satisfied from Table 6-5.

**Step 2: Calculation of Historical Allocations for Alternate Sources.**
Consider S2 and S3 from Table 6-9 with rank 2. Historical allocations beginning 1/1/98.
- \( S2 = 1400 \)
- \( S3 = 1000 \)
Total allocations for S2 and S3 = 2400

**Note:** The first date of planning horizon is 7/9/98. Only the last three rows in the Source Rules Data (Table 6-2) apply due to effectivity dates. S1 has rank 1 with allocation percentage = 100 (Table 6-2). This indicates that the system should allocate as much as possible to S1 before allocating the excess to other sources.
Step 3: Calculate Allocations to S2 Based on Historical Allocations and Target Sourcing Percentages.

Note: Because S2 has a higher sourcing percentage, we will begin with allocations to S2.

Target source percentages: S2 = 60% (see Table 6-2)

Total target allocation = historical allocation + unsatisfied demand = 2400 + 130 = 2530

Using the S2 target allocation percentage, calculate the allocation to S2.

Allocation to S2 + 1400 (historical allocation)/2530 (total target allocation) = 0.6 (source percent)

S2 allocation = 118

Step 4: Respect Order Modifiers If They Exist.

S2 Allocation: 118 becomes 125 because S2 has a fixed lot multiple of 25 (see Table 6-8). To respect that, 125 needs to be allocated.

Step 5: Allocation to S2 with Following Constraints: Capacity, Lead Times, and Reception Calendars.

S2: Allocation = 125, Date = 7/15/98

Monday, 7/14/98, is the latest reception date before the due date. This respects the processing and postprocessing lead times.

Cumulative Available Capacity = 240 (tolerance percentage = 0)(see Table 6-11).

Table 6-12 shows you the resource availability after all allocations so far have consumed capacity.

<table>
<thead>
<tr>
<th>Source</th>
<th>7/10/98 (Thurs)</th>
<th>7/11/98 (Fri)</th>
<th>7/14/98 (Mon)</th>
<th>7/16/98 (Tues)</th>
<th>7/16/98 (Wed)</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>60</td>
<td>66</td>
</tr>
<tr>
<td>S2</td>
<td>80</td>
<td>35</td>
<td>0</td>
<td>84</td>
<td>88</td>
</tr>
<tr>
<td>S3</td>
<td>20</td>
<td>20</td>
<td>20</td>
<td>21</td>
<td>22</td>
</tr>
</tbody>
</table>
**Step 6: Calculate Allocations to S3 Based on Allocation to S2.**
Remaining quantity to allocate = 130 - 125 = 5

**Step 7: Respect Order Modifiers If They Exist.**
S3 allocation: 5 becomes 21 because the minimum order quantity for S3 is 21 (see Table 6-8).

**Step 8: Allocation to S3 with Following Constraints: Capacity, Lead Times, and Reception Calendars.**
Tuesday is a valid reception date. The reception date must be moved to Monday 7/14 due to postprocessing lead time. This respects all lead times (see Table 6-6 and Table 6-7).
Cumulative Available Capacity = 60

Table 6-13 shows you the resource availability after all allocations so far have consumed capacity.

<table>
<thead>
<tr>
<th>Source</th>
<th>7/10/98 (Thurs)</th>
<th>7/11/98 (Fri)</th>
<th>7/14/98 (Mon)</th>
<th>7/15/98 (Tues)</th>
<th>7/16/98 (Wed)</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>60</td>
<td>66</td>
</tr>
<tr>
<td>S2</td>
<td>80</td>
<td>35</td>
<td>0</td>
<td>84</td>
<td>88</td>
</tr>
<tr>
<td>S3</td>
<td>20</td>
<td>19</td>
<td>0</td>
<td>21</td>
<td>22</td>
</tr>
</tbody>
</table>

**Note:** Scheduled receipt excess = 16 (for netting gross requirements for the next planning period) (see Table 6-10).

**Table 6-14 Summary of Planned Order Allocations for Demand #1**

<table>
<thead>
<tr>
<th>Source</th>
<th>Allocation</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>180</td>
<td>7/14/98</td>
</tr>
<tr>
<td>S2</td>
<td>125</td>
<td>7/14/98</td>
</tr>
<tr>
<td>S3</td>
<td>21</td>
<td>7/14/98</td>
</tr>
</tbody>
</table>

The values for S1 come from "Step 1: Allocation to S1.", the values for S2 come from "Step 4: Respect Order Modifiers If They Exist.", and the values for S3 come from "Step 7: Respect Order Modifiers If They Exist.".
Input Data for Demand #2
(see Table 6-1)
Quantity = 280
Due Date = 7/16/98 (Wednesday)
Unsatisfied Demand = 280 - 16 (scheduled receipt excess) = 264

Allocations for Demand #2

Step 1: Allocation to S1.
Wednesday is a delivery date. The receiving date must be moved to Tuesday, 7/15, due to postprocessing lead time.
Tuesday is not a reception date. The allocation date is moved to Monday, 7/14/98.
Cumulative available capacity = 0 (tolerance percentage = 0) (see Table 6-13), hence allocation to S1 = 0
Unsatisfied demand = 280 - 16 (excess supply due to order modifiers from previous bucket(s) = 264

Step 2: Calculation of Historical Allocations for Alternate Sources.
Consider S2 and S3 with rank 2 from Table 6-9 and Table 6-14.
Historical Allocations beginning 1/1/98.
S2: 1400 + 125 = 1525
S3: 1000 + 21 = 1021
Total Allocations for S2 and S3 = 2546

Step 3: Calculate Allocations to S2 Based on Historical Allocations and Target Sourcing Percentages.

Note: Because S2 has a higher sourcing percentage, we will begin with allocations to S2.

Target Sourcing Percentages: S2 = 60%
Total Target Allocation = Historical allocation + New allocation = 2546 + 264 = 2810
Using the S2 target allocation percentage, calculate the allocation to S2.

\[
\frac{S2 + 1525}{2810} = 0.6
\]

S2 Allocation = 161

**Step 4: Respect Order Modifiers If They Exist.**

S2 Allocation: 161 becomes 175 because S2 has a fixed lot multiple of 25 (see Table 6-8), and to respect that \(7 	imes 25 = 175\) needs to be allocated.

**Step 5. Allocation to S2 With Following Constraints: Capacity, Lead Times, and Reception Calendars.**

S2: Allocation = 175.

Date = 7/16/98 (Wednesday)

Reception date must be moved to Tuesday 7/15 due to postprocessing lead time of one day (see Table 6-8). Tuesday is not a reception date. Allocation date moved to Monday 7/14/98. This respects the processing and post-processing lead times.

Cumulative Available Capacity = 115 (see Table 6-13)

Respecting order modifiers: allocation of 115 becomes 125 because S2 has a fixed lot multiple of 25. To respect that, \(5 \times 25 = 125\) needs to be allocated. However, accumulated capacity for S2 by 7/14/98 is 115, which is not a multiple of 25. Therefore, 100 units, which is the next lower value respecting order modifier and capacity will be scheduled.

Table 6-15 shows you the resource availability after all allocations so far have consumed capacity.

<table>
<thead>
<tr>
<th>Source</th>
<th>7/10/98 (Thurs)</th>
<th>7/11/98 (Fri)</th>
<th>7/14/98 (Mon)</th>
<th>7/15/98 (Tues)</th>
<th>7/16/98 (Wed)</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>0</td>
<td>0</td>
<td>60</td>
<td>66</td>
<td></td>
</tr>
<tr>
<td>S2</td>
<td>15</td>
<td>0</td>
<td>0</td>
<td>84</td>
<td>88</td>
</tr>
<tr>
<td>S3</td>
<td>20</td>
<td>19</td>
<td>0</td>
<td>21</td>
<td>22</td>
</tr>
</tbody>
</table>

**Step 6: Calculate Allocations to S3 Based on Allocation to S2.**

Remaining quantity to allocate = 264 - 100 = 164
Step 7: Respect Order Modifiers If They Exist.
S3 Allocation: 164 becomes 168 because S3 has a fixed lot multiple of 7, so \(24 \times 7 = 168\) needs to be ordered.

Allocation date moved to Tuesday 7/15/98 due to post-processing lead time. Tuesday is a valid reception date. This respects all lead times.

Cumulative Available Capacity = 60
Respecting order modifiers: allocation of 60 becomes 63 because S3 has an order modifier of 7. To respect that, \(9 \times 7 = 63\) needs to be allocated. However, accumulated capacity at S3 by 7/14/98 is 60, which is not a multiple of 7. Therefore, 56 units, which is the next lower value respecting order modifiers and capacity will be scheduled.

Unsatisfied quantity = 164 - 56 = 108
Table 6-16 shows you the capacity available after all allocations so far have consumed capacity.

<table>
<thead>
<tr>
<th>Source</th>
<th>7/10/98 (Thurs)</th>
<th>7/11/98 (Fri)</th>
<th>7/14/98 (Mon)</th>
<th>7/15/98 (Tues)</th>
<th>7/16/98 (Wed)</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>60</td>
<td>66</td>
</tr>
<tr>
<td>S2</td>
<td>15</td>
<td>0</td>
<td>0</td>
<td>84</td>
<td>88</td>
</tr>
<tr>
<td>S3</td>
<td>4</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>22</td>
</tr>
</tbody>
</table>

Search for Alternative Sources:
- S1: Not possible due to post-processing lead time and reception date constraints.
- S2: Wednesday is not a delivery date. Tuesday is not a delivery date.

Allocation of Excess Demand:
- Excess Demand = 108
- Allocate excess demand to primary source S1.
- Post-processing = 1 day becomes Tuesday, 7/15/98 (7/16 minus 1 day of postprocessing = Tuesday, 7/15).
Because Tuesday 7/15 is not a delivery date, the load excess is moved to Monday 7/14/98.

Table 6-17 shows you the capacity availability after all allocations so far have consumed capacity.

**Table 6-17 Final Capacity Profile**

<table>
<thead>
<tr>
<th>Source</th>
<th>7/10/98 (Thurs)</th>
<th>7/11/98 (Fri)</th>
<th>7/14/98 (Mon)</th>
<th>7/15/98 (Tues)</th>
<th>7/16/98 (Wed)</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>0</td>
<td>0</td>
<td>60</td>
<td>66</td>
<td></td>
</tr>
<tr>
<td>S2</td>
<td>15</td>
<td>0</td>
<td>9</td>
<td>88</td>
<td></td>
</tr>
<tr>
<td>S3</td>
<td>4</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>22</td>
</tr>
</tbody>
</table>

Table 6-18 shows the summary of allocations for planned order #2, and Table 6-19 shows the planned order allocations summary.

**Table 6-18 Summary of Allocations for Planned Order #2**

<table>
<thead>
<tr>
<th>Source</th>
<th>Allocation</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>108</td>
<td>7/14/98</td>
</tr>
<tr>
<td>S2</td>
<td>100</td>
<td>7/14/98</td>
</tr>
<tr>
<td>S3</td>
<td>56</td>
<td>7/16/98</td>
</tr>
</tbody>
</table>

**Table 6-19 Planned Order Allocations Summary**

<table>
<thead>
<tr>
<th>Source</th>
<th>7/10/98 (Thurs)</th>
<th>7/11/98 (Fri)</th>
<th>7/14/98 (Mon)</th>
<th>7/15/98 (Tues)</th>
<th>7/16/98 (Wed)</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>0</td>
<td>0</td>
<td>288 (180 + 108)</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>S2</td>
<td>0</td>
<td>0</td>
<td>125</td>
<td>100</td>
<td>0</td>
</tr>
<tr>
<td>S3</td>
<td>0</td>
<td>0</td>
<td>21</td>
<td>56</td>
<td>0</td>
</tr>
</tbody>
</table>

**Enforce Sourcing Splits**

Supplier contracts require that a company source its materials from suppliers based on specified allocation percentages. Similarly, requirements such as labor agreements necessitate adherence to allocation percentages from internal organizations.
You can control whether the planning process treats contractual sourcing allocation percentages as constraints, or is free to flex the allocation percentages to achieve plan objectives.

Oracle ASCP and Inventory Optimization impose the sourcing allocation percentages during optimization.

**To invoke enforce sourcing splits functionality:**

1. Specify Allocation Percentages.
   
a. Sign on using the Advanced Supply Chain Planner responsibility.
   
b. From the Navigator, choose Sourcing > Sourcing Rules.

The Sourcing Rule screen appears.

**Figure 6–40 Sourcing Rule screen**

![Sourcing Rule screen](image)

c. Specify the sourcing Allocation Percentages in the Sourcing Rule form using the Allocation % field.
2. Specify Sourcing Allocation Window.
   a. Sign on using the System Administrator responsibility.
   b. From the Navigator, choose Profile > System. 
      The Find System Profile Values screen appears.
   c. Enter the profile option name, or use the search feature to search for a 
      component of the profile option name (for example, you could search on 
      the word Sourcing).
   d. Select the Find button. 
      The System Profile Values screen appears.

   ![System Profile Values screen](image)

   You can specify the new profile option called MSO: Sourcing Allocation 
   Window in the System Profile Values form. The default value is 7 days.

   You can specify a length of time (in days) used to satisfy the allocation 
   percentages. This time period during which the allocation percentages are 
   enforced is called Sourcing Allocation Window. The sourcing constraints 
   are enforced in a rolling horizon manner, in multiples of the Sourcing 
   Allocation Window, with the finest granularity being the specific time 
   bucket.

In the System Profile Values screen, you can specify the new profile option called MSC: Sourcing Variance Tolerance in the System Profile Values form. The default value is 0.05 (5%).

The system allows you to specify a tolerance band for the difference between the user-specified allocation percentages and the plan-derived allocation percentages. If the difference is greater than the tolerance, then an exception is triggered.

4. Specify Allocation History Start Date.

In the System Profile Values screen, you can specify the new profile option called MSC: Start Date Offset for Sourcing History (Months) in the System Profile Values form. The default value is Null (system collects all history if the collection parameter Recalculate History is set to Yes).

The system allows you to specify a global allocation percentages start date from which the sourcing history is collected and accumulated for making sourcing decisions. The allocation history is ignored if the sourcing rule effectivity date is after the plan date.

5. Enforce Sourcing Constraints.

At the plan level, the system allows you to enable sourcing constraints for all sourcing rules. You can enable sourcing constraints by selecting the Enforce Sourcing Constraints checkbox in the Options tab of the Plan Options form.

a. Sign on using the Advanced Supply Chain Planner responsibility.

b. From the Navigator, choose Supply Chain Plan > Options.

The Plan Options screen appears.

c. Select the Enforce Sourcing Constraints checkbox.

**Enforce Sourcing Splits Example**

The following example shows how to use the enforce sourcing splits feature.

Suppliers S1 and S2 have the following contractual allocations:

- Supplier S1: 50%
- Supplier S2: 50%

The table below summarizes supply and demand and sourcing allocation percentages for suppliers S1 and S2.
On Day 2, it is not possible to exactly achieve the contractual 50%/50% split, so planned order supplies that achieve the closest possible split (67%/33%) are generated.

On Day 4, S2 is given a higher allocation in order to bring the cumulative allocation to the desired 50%/50%.

In this example, the sourcing allocation window is assumed to be equal to one day.

**Constraints Precedence**

If you select the Enforce Sourcing Constraints at the plan option level, the precedence among the above constraints are established as follows:

**Case 1 - Enforce Demand Due Dates**

You have selected the Enforce Demand Due Dates or the Enforce Service Levels plan option. In this case, the order of priority among the constraints is as follows:

1. Enforce Demand Due Dates/Enforce Service Levels (highest priority)
2. Enforce Capacity Constraints
3. Enforce Sourcing Constraints (lowest priority)

**Case 2 - Enforce Capacity Constraints**

You have selected the Enforce Capacity Constraints plan option. In this case, the order of priority among the constraints is as follows:

1. Enforce Capacity Constraints (highest priority)
2. Enforce Demand Due Dates/ Enforce Service Levels
3. Enforce Sourcing Constraints (lowest priority)
Note that in either case, the sourcing constraints have the lowest priority; that is, these constraints may be violated, if required, to satisfy the capacity constraints or to meet demands.

**Consideration of Rank 1 Sources**

Only Rank 1 sources are considered for enforcing sourcing allocation percentages. The allocation percentages are ignored for sources of ranks 2 and higher.

The system considers sources of ranks 2 and higher only if there is insufficient capacity among rank 1 sources to meet the required supply. If one or more rank 1 sources fall short of capacity, the sourcing allocation percentages are ignored, and the system allocates supply quantities among the sources of ranks 1 and higher based on cost and capacity considerations. The enforcement of ranking priority functionality is unchanged and it is accomplished by means of internal penalty factors.

**Inter-Organization Allocations**

The allocation percentages are enforced for all sourcing types:

- External supplies from suppliers
- Transfer supplies from internal organizations
- Make supplies made within an organization

**Penalty Cost for Violation of Sourcing Allocation Percentages**

The system automatically uses internal penalty factors (i.e., not exposed to user) to minimize deviations from the desired allocation percentages. The system chooses penalty factors such that the sourcing constraints violations are penalized less than the unmet demands and capacity violations.

**Viewing the Supply Chain**

There are several view options with Oracle ASCP including:

- Viewing Sourcing Rules
- Viewing BOD
- Viewing Sourcing Rule and BOD Assignment Set
- Viewing Sourcing Assignment Hierarchy
Viewing Sourcing Rules
You can retrieve sourcing rules for reference. After retrieving a sourcing rule, you can display it in a convenient, hierarchical representation, or you can locate the assignment sets in which it is assigned.

For more information, see “Viewing Sourcing Rules” in the Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide.

Viewing BODs
You can quickly and easily retrieve BODs for reference. After retrieving a bill of distribution, you can display it in a convenient, hierarchical representation, or you can locate the assignment sets in which it is assigned.

For more information, see “Viewing Bills of Distribution” in the Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide.

Viewing Assignment Set
Once you have defined your sourcing rules and BODs, you must assign them to particular items and/or organizations. These assignments are grouped together in assignment sets. This is where your various sourcing strategies define a particular supply chain network.

You can view your assignment sets to review particular sourcing schemes, locate particular assignments of sourcing rules or BODs, or view the supply chain bill for a particular assignment set.

For more information, see “Viewing Sourcing Rules” and “Viewing Bills of Distribution” in the Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide.

Viewing Sourcing Assignment Hierarchy
You can display all the assignment levels and identify the active assignment level for an item.

For more information, see “Viewing Assignment Hierarchy” in the Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide.

Performing Tasks on the Planning Server
You can perform the following tasks only on the Planning Server:

- Create instances
Define plan names and its options
Create priority rules

You can perform the following tasks on the source or Planning Server:
Add new sourcing rules
Add new assignment sets
Add new bill of distribution
Change the order priority for any independent demand
Add/change supplier capacity and flex fences
Change plan parameters

Audit Statements Report

The ASCP process involves collecting and using source data to drive planning. Data from source transaction instances need to be accurate and need to be set up properly in order for ASCP to render reliable planning output. Data from the source can be corrupt due to many reasons, including: bad transactions, missing transactions, human error, improper formats, conflicting and/or missing setups and profile options.

Oracle ASCP provides a tool to validate the data it uses in the planning process. The Audit Statements Report is a self-explanatory report that evaluates data setups for profile options that are incorrectly set, invalid package bodies and objects, invalid triggers, etc. It suggests remedies for the problems that are found.

To run the Audit Statements Report:
1. Sign in using the Advanced Supply Chain Planner responsibility.
2. Select Other > Request.
   The Find Requests window appears.
3. Select Submit a New Request.
   The Submit a New Request window appears.
4. Select Single Request, then click OK.
   The Submit Request window appears.
5. From the List of Values for the Name field, select Audit Statements Report.
The Parameters window appears.

**Figure 6-42 Parameters window**

6. Fill out the parameters window as described in Steps 7 through Step 13 below.

7. Choose Advanced Supply Chain Planner from the following applications listed in the table below.

<table>
<thead>
<tr>
<th>Application</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global Order Promising</td>
<td>for order promising related audit statements</td>
</tr>
<tr>
<td>Inventory Optimization</td>
<td>for inventory optimization related audit statements</td>
</tr>
<tr>
<td>Advanced Supply Chain Planner</td>
<td>for supply chain planning related audit statements</td>
</tr>
<tr>
<td>Demand Planning</td>
<td>for demand planning related audit statements</td>
</tr>
</tbody>
</table>

8. Choose one of the following reports listed in the table below:

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audit Collections Setup</td>
<td>Select this to audit data setups related to collections</td>
</tr>
<tr>
<td>Audit Planning Data</td>
<td>Select this to audit data setups related to the planning engine</td>
</tr>
<tr>
<td>Audit UI Data</td>
<td>Select this to audit data setups related to the user interface; for example, to check the validity of materialized views and profile options that control the display of plan data</td>
</tr>
</tbody>
</table>

9. Choose the plan for which you want to validate setup data.
10. Choose the source instance for which you want to validate setup data.

11. Choose one of the following output types listed in the table below:

<table>
<thead>
<tr>
<th>Output Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary Report</td>
<td>Select this if you do not want to look at details of the errors and warnings.</td>
</tr>
<tr>
<td>Detail report – Errors Only</td>
<td>Select this if you want audit details of the errors only.</td>
</tr>
<tr>
<td>Detail Report – Errors and Warnings</td>
<td>Select this if you want audit details of both the errors and warnings. Warnings are not fatal to the planning process, but could cause erroneous output.</td>
</tr>
<tr>
<td>Detail Report - Complete</td>
<td>Select this if you want the summary as well as errors and warnings in your audit report.</td>
</tr>
</tbody>
</table>

12. Select OK.
   The Parameters window disappears.

13. Select Submit in the Submit Request window.

**To view the output of the Audit Statements Report:**

1. From the Navigator, select Other > Request.
   The Find Requests window appears.

2. Select Find.
   The Requests window appears.

3. Select the completed request for Audit Statements Report.

4. Select View Output to view the report.
   The figure below is a sample Audit report.
Audit Report - Audit Collections Setup For Instance dmt

Checking for Instance Setup Information ...
No errors.

Checking for User Information on Destination.
No errors.

Checking for Responsibility Information on Destination.
No errors.

Checking if MRP_AP_APPS_INSTANCES Table has the Correct Instance Information ...
No errors.

Checking to see if Instance Information matches in MRP_AP_APPS_INSTANCES On SOURCE and MNG_APPS_INSTANCES in DESTINATION ...
No errors.

Checking Source instance to see if the User exists on the source instance.
Please note that all the users planning to run Collections should run this report ...
No errors.

Checking Source instance to see if the Responsibility exists on the source instance, ...
No errors.

Checking for Planning flexfields in the source instance....
No errors.

Checking for Profile Option Values Corresponding to the Planning flexfields in the source instance....
No errors.

Checking for Views in the source instance....
No errors.
Topics covered in this section include the following:

- Overview of Simulations on page 7-2
- Simulation Scenarios on page 7-2
- Simulation Modes on page 7-3
- Running Net Change Replan Simulations on page 7-5
- Using Undo to Reverse Actions or Make Changes on page 7-9
- Comparing Scenarios Quantitatively on page 7-12

A Day in the Life of a Planner
Overview of Simulations

Oracle ASCP provides online interactive simulation planning so you can simulate changes and respond to changing conditions. Simulations can be run by changing plan inputs and parameters and rerunning the new, simulated plan. The new simulated plan can be saved as a new plan and compared to the original (baseline) plan. You can copy and version your plan, save and compare exceptions, and visually highlight changes.

Simulation Scenarios

You can simulate changes to material and resource capacity simultaneously. You can also simulate changes to the objectives and weights used for optimization or simulate changes to demand priorities. In addition, you can simulate the effects of changing planned orders.

Supplier Capacity

To simulate item supply changes, you can add new supplier capacity and adjust a supplier’s capacity (for example, change daily capacity from 100 units to 200 units) over a specified time frame.

Resource Availability

You can add new resource availability and modify how many resources are available over user defined time frame. Resource constraints includes available machine hours, available worker hours, and adding or removing shifts.

Supplies

To simulate supply changes, you can:
- Add new planned orders
- Firm planned orders, discrete jobs, and purchase orders
- Modify quantities, dates, sources, and alternates

Demands

You can alter the demand priority of any demand. Oracle ASCP then modifies the existing schedule to accommodate changes to demand priority. To simulate demand
changes, you can modify quantities and due dates for independent demand (MDS entries). You can also add new Manual MDS.

**Optimization Objectives**

You can decide the relative importance of the many objectives Oracle ASCP tracks according to your business or industry sector. These will provide the basis for Oracle ASCP in optimizing the plan. For example, for some industries, inventory turns are a much more important performance indicator than cycle time. The following objectives are supported by Oracle ASCP:

- maximize inventory turns
- maximize plan profit
- maximize ontime delivery

You can also modify the weights that you have assigned for each objective and have the system generate an optimal plan based on the new objectives.

**Simulation Modes**

You can use the Planner Workbench to simulate and evaluate changes to specific orders, supplier capacity, and resource capacity. Additions to demand and supplies can also be simulated. Net change replan simulation is a powerful What If analysis feature that lets you update a material plan by planning only the items you have changed in the Planner Workbench. Replanning is based on the snapshot data gathered during the original planning run and the changes you have made with the Planner Workbench. No other transactions, such as receipts in Oracle Inventory, are considered in the replanning process. You can also implement the changes recommended by net change replan.

**Net Change Replan**

Net change replan generates only those plan outputs that have changed compared to a baseline plan. It allows evaluation of plans within seconds when minor changes are made in the plan. When running net change replan you can run either batch mode replan or online planner.

**Batch Mode Planner**

Batch mode lets you communicate directly with the database while making and replanning your changes. While frequent replanning can place an excessive load on
system resources, batch mode gives other users access to the plan while you are performing simulations.

Batch mode is particularly useful when you want to complete a single replanning cycle.

**Online Planner**

The online planner lets you simulate and replan manual changes to supply and demand records without increasing database traffic. Starting an online session loads all planning data into memory. Afterwards, you can make changes to that data, then replan the changes to see their effect on the rest of the plan. You can implement and release your changes from within the session, or you can make changes and replan as many times as necessary before the release.

As a simulation tool, the online planner lets you see the effect of the changes you make in the Planner Workbench. As an implementation tool, it reduces unnecessary database transactions and offers rapid plan revision and execution. As a monitoring tool, it generates the full set of exception messages following a replan. It also lets you save the exceptions generated by previous sessions, offering you feedback on successive planning decisions.

The online planner is particularly useful when performing frequent simulation on a single plan. In online mode, you can do this without suffering a significant loss in performance.

The following are some of the rules of operation for the Online Planner:

- You can view any plan even if another user is running online simulation.
- You are not allowed to start another Online Planner session nor are you allowed to make changes to the plan when Online Replan is progressing.
- You are allowed to enter changes before and after, but not during Online Replan session.
- The changes you have made prior to Online Replan are incorporated into the replan.
- You can view all of the changes that have been made since the last batch rerun of the plan.
- You can see the user and timestamp of all changes.
- The changes you made during an online session can be undone.
Running Net Change Replan Simulations

You have two options for running net change replan simulations:

- Batch replan
- Online replan

Running Batch Replan

Note: Save and make a copy of your baseline plan before running batch replan (make modifications only to the copy). Otherwise, you will lose visibility to your baseline plan. See Using Undo to Reverse Actions or Changes on page 7-9.

To run a batch replan:

1. Select a plan in the Planner Workbench.
2. Make the desired changes to the plan.
3. Run your plan again by choosing Plan > Batch Replan.
4. Make a note of the concurrent request ID and choose OK.
5. Verify that the replanning process is complete.
6. Re-query the plan to review your changes.
7. If you are not satisfied with the replan results, repeat steps 2 through 6 as needed.

Running Online Replan

Note: Save and make a copy of your baseline plan before running online replan (make modifications only to the copy). Otherwise, you will lose visibility to your baseline plan.

To run online replan:

1. Select a plan in the Planner Workbench window.
2. Choose Plan > Start Online Planner.
3. Make a note of the concurrent request ID and choose OK.
While the online planner loads the data into memory, you will see the Online Planner Status window. This window displays the progress of the loading and signals you when the session is ready for planning.

4. When the status window informs you that the session is ready for planning, close the window to return to the Planner Workbench. Your online planner session is now active.

5. Make the desired changes to your plan.

6. Save the plan.

7. Choose Plan > Online Replan.

To check the status of an online planner session:
Choose Plan > Online Planner Status.
The Online Planner Status window appears.

Figure 7–1 The Online Planner Status window
Running Net Change Replan Simulations

To stop an online planner session:
1. Choose Plan > Stop Online Planner.
2. Click OK to confirm your choice.

***Note:*** Do not stop the online planner until all simulations are complete.

To save your actions:
1. Choose Plan > Save actions.
   
   A pop-up window indicates the version number of your saved actions. Note this version number if you wish to view your actions later.

To view your actions:
1. Select the Actions tab (left pane) then scroll down to the desired version.

***Note:*** Though you can view a plan while another user is running an online simulation for that plan, you can neither make changes to the plan nor start another simulation until the current run completes. An icon denoting that online planning is running accompanies the plan in the left pane tree.

***Note:*** It is recommended that the online planner be stopped as soon as a series of simulations is complete. Multiple active online planners could consume a lot of system resource (CPU/memory) in a production environment.

***Note:*** Do not stop the online planner until all simulations are complete.
Figure 7-2  Actions tab

![Actions tab](image-url)

<table>
<thead>
<tr>
<th>Action Type</th>
<th>Version</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Late Sales Orders and Forecasts</td>
<td>1</td>
<td>48</td>
</tr>
<tr>
<td>Material and Resource Capacity</td>
<td>1</td>
<td>17</td>
</tr>
<tr>
<td>Substitutes and Alternates Used</td>
<td>1</td>
<td>10</td>
</tr>
<tr>
<td>Item Exceptions</td>
<td>1</td>
<td>4</td>
</tr>
<tr>
<td>Late Sales Orders and Forecasts</td>
<td>current</td>
<td>48</td>
</tr>
<tr>
<td>Material and Resource Capacity</td>
<td>current</td>
<td>10</td>
</tr>
<tr>
<td>Substitutes and Alternates Used</td>
<td>current</td>
<td>10</td>
</tr>
<tr>
<td>Item Exceptions</td>
<td>current</td>
<td>4</td>
</tr>
</tbody>
</table>
Using Undo to Reverse Actions or Make Changes

The Undo feature enables you to reverse changes for online planning. The following list details how this feature functions:

- You can undo your changes in any order, as long as the record you are undoing has not had subsequent changes made to it.
- You can undo changes until the plan is rerun in batch mode.
- You can view online planning changes using Undo Summary.
- You can view all of the changes that have been made since the last batch rerun of the plan. You can see the user and timestamp of all changes.
- You can tell immediately upon entering the Planner Workbench that the online planner is running or that it has been run.
- You can create a savepoint/bookmark and undo all of your changes to that savepoint. Bookmark names are not required to be unique.
- You cannot undo a release.
- You cannot undo changes made to the implement properties.

To view the Undo Summary for a plan:

1. Select Plan > Undo Summary.

The Undo Summary window appears. This window lists the user and timestamp for every action/change made to the plan since the last batch replan. It includes online planning changes, sorted by user.
To view details on an action:

1. Select an action in the Undo Summary window.

2. Click Detail.

   The Undo Detail window appears.
Using Undo to Reverse Actions or Make Changes

To undo your actions:
You can undo actions you make in the online planner in any order so long as no one else has made subsequent changes to the record you are undoing.

Note: You can only undo changes made between batch replan runs.

1. Select Plan > Undo Summary.
   The Undo Summary window appears (See Figure 7–3).
2. Select a change you initiated in the online planner.
3. Click Undo.
Comparing Scenarios Quantitatively

To create a bookmark:
You can create save points for undoing online planner actions. Subsequently, you can undo only those online planner actions made after the bookmark.
1. Select Plan > Add Undo Bookmark.
2. In the pop-up window, enter a name for the bookmark.

Note: You cannot undo another user’s changes. If you attempt to do so, you will receive an error message.

Comparing Scenarios Quantitatively
Simulation lets you compare Key Performance Indicators (KPIs) of multiple plans and make necessary changes to reach your goals. Standard KPIs available in Oracle ASCP are:
- Inventory Turns
- On time Delivery
- Planned Utilization
- Margin Percentage
- Margin
- Cost Breakdown

You can quantify the results of simulation scenarios and graphically compare the results of multiple scenarios to help you choose the plan that best meets your performance objectives.

To compare scenarios quantitatively:
1. Navigate to the Planner Workbench.
2. Select the baseline plan.
3. While holding the shift key, select the simulated plan.
   KPIs for both plans show side by side.
Figure 7–5  The Multiple Plans Comparison
Topics covered in this section include the following:

- Overview of Optimization on page 8-2
- Optimization Objectives on page 8-2
- Setting Penalty Factors on page 8-4
- Comparing Different Optimization Runs on page 8-19
Overview of Optimization

In optimized supply chain plans, Oracle ASCP uses a combination of traditional linear programming and constraint programming techniques.

You can choose to optimize your plans to meet one or more of the following objectives:

- maximize inventory turns
- maximize plan profit
- maximize ontime delivery

The plan objective is derived by combining and weighting chosen objectives. Optimization determines the best possible sources of supply, considering all your material, resource, and transportation constraints.

Optimized plans differ from unconstrained plans and constrained plans without optimization in that optimized plans make more choices automatically. Specifically, optimized plans automatically choose (on the basis of minimizing plan objective cost) the following:

- alternative bills of material
- alternative routings
- alternative resources

Optimized plans will override the rankings and sourcing percentages provided in sourcing rules and bills of distribution as necessary in order to minimize the plan objective cost.

Optimization Objectives

Multiple optimization objectives can be met by assigning weights to each. This is done using the Optimization tab.

For more information on the Optimization tab, see Chapter 5, “Defining Plans.”
Following are descriptions of the various optimization objectives:

**Maximize Inventory Turns**  This objective is achieved by minimizing the total inventory for the plan duration.

**Maximize Plan Profit**  The following are considered:

- Item cost
- Resource cost
- Inventory carrying cost
- Transportation cost

Other penalty costs are considered, such as demand lateness, resource over utilization, etc.
Maximize Ontime Delivery

This maximizes ontime delivery by trying to ensure that all demand is met ontime. Penalty factors specify the relative importance of demands when maximizing ontime delivery.

Setting Penalty Factors

Oracle ASCP depends a great deal on data related to costs, penalties, and priorities above and beyond what is available from the ERP system. You can set penalty factors at different levels using flexfields, plan options, or profile options. Flexfields let you set penalty factors at the most discrete level. For example, you can set the Penalty Factor for Late Demand at the Demand, Item, or Org level using flexfields. Plan options and profile options let you set the same penalty factor at the Plan level and Site level, respectively.

CAUTION: Penalty costs are different from penalty factors. Penalty costs are the product of the penalty factor and some other parameter such as list price, item cost, resource cost, or transportation cost.

For all of the steps related to setting penalty factors, please log in as Manufacturing and Distribution Manager, unless otherwise noted. You must run the Create Planning Flexfields program beforehand for the flexfields used for setting penalty factors to be operational. Please see Appendix B, Oracle ASCP Flexfields for additional details. Finally, please refer to Chapter 5, "Choosing an Objective Function" for help with setting actual penalty costs.

For more information on setting penalty factors, see Appendix A, "Profile Options" and Appendix B, "Oracle ASCP Flexfields."

Setting Late Demand Penalty Costs

The following figure shows the hierarchy for Setting Penalty Factor for Late Demand.
Setting Penalty Factors

Hierarchy for Setting Penalty Factor for Late Demand

To set late demand penalty cost at the demand level:
1. From the Navigator, choose Supply Chain Planning > Forecast > Entries.

The Item Forecast Entries window appears.
2. Select a forecast.

3. Select the flexfield.

   The MRP Forecast Dates window appears.

4. Enter the Late Forecasts Penalty factor.
To set late demand penalty cost at the item level:
For more information on these steps, please refer to the Oracle Inventory User’s Guide.

1. From the Navigator, choose Inventory > Items > Master Items.
   The Master Item window appears.
2. Click the Item field.
3. Select View menu > Find.
   The Find Master Items window appears.
4. Enter a search string for the item in the Item field and click the Find button.
   The Master Item window appears.
5. Select the flexfield.
   The Items window appears.
6. Enter the Late Demands Penalty factor.

To set late demand penalty cost at the organization level:

1. From the Navigator, choose Inventory > Setup > Organizations > Parameters.
   The Organization Parameters window appears.
2. Select the flexfield.
   A second Organization parameters window appears.
3. Enter the Late Demands Penalty factor.

To set late demand penalty cost at the plan level:

1. Select the Advanced Supply Chain Planner responsibility.
2. From the Navigator, choose Supply Chain Plan > Options.
3. Select a plan.
   The Plan Options window appears.
4. Select the Optimization tab.
5. Enter the penalty factor in the Demand Lateness field.

To set late demand penalty cost through a profile option:
1. Log in as the System Administrator.
2. From the Navigator, choose Profile > System.
   The Find System Profile Values window appears.
3. Enter the profile name MSO: Penalty Cost Factor for Late Demands in the Profile field and click Find.
   The System Profile Values window appears.
4. Enter the penalty factor in the Site column.

**Setting Penalty Factors for Exceeding Material Capacity**

The following figure shows the hierarchy for Setting Penalty Factor for Exceeding Material Capacity.
Setting Penalty Factors

Hierarchy for Setting Penalty Factor for Exceeding Material Capacity

If the data is not available at a given level, Oracle ASCP will check for available data at the next level in the hierarchy.

To set penalty factors for exceeding material capacity at the item/supplier level:
For more information on these steps, please refer to the Oracle Purchasing User Guide.

1. From the Navigator, choose Purchasing > Supply Base > Approved Supplier List.
2. Click Attributes.
   The Supplier-Item Attributes window appears.

3. Select the flexfield.
   The Attributes window appears.

4. Enter the Material Over-Capacity Penalty factor.

To set penalty factors for exceeding material capacity at the item level:
For more information on these steps, please refer to the Oracle Inventory User’s Guide.

1. From the Navigator, choose Inventory > Items > Master Items.
   The Master Item window appears.

2. Click the Item field.

3. Select View menu > Find.
   The Find Master Items window appears.

4. Enter a search string for the item in the Item field and click Find.
   The Master Item window appears.

5. Select the flexfield.
   The Items window appears.

6. Enter the Material Over-Capacity Penalty factor.

To set penalty factors for exceeding material capacity at the organization level:

1. From the Navigator, choose Inventory > Setup > Organizations > Parameters.
   The Organization Parameters window appears.

2. Select the flexfield.
   A second Organization Parameters window appears.

3. Enter the Material Over-Capacity Penalty factor.

To set penalty factors for exceeding material capacity at the plan level:

1. Select the Advanced Supply Chain Planner responsibility.
2. From the Navigator, choose Supply Chain Plan > Options.

3. Select a plan.

   The Plan Options window appears.

4. Select the Optimization tab.

**Figure 8–6 Plan Options, Optimization tab**

5. Enter the penalty factor in the Exceeding material capacity field.

   - **To set penalty factors for exceeding material capacity through a profile option:**

     1. Log in as the System Administrator.

     2. From the Navigator, choose Profile > System.

        The Find System Profile Values window appears.
3. Enter the profile name MSO: Penalty Cost Factor for Exceeding Material Capacity in the Profile field and click Find.
   The System Profile Values window appears.

Figure 8–7  System Profile Values

4. Enter the penalty factor in the Site column.

Setting Penalty Factors for Exceeding Resource Capacity

The following figure shows the hierarchy for Setting Penalty Factor for Exceeding Resource Capacity.
### Hierarchy for Setting Penalty Factor for Exceeding Resource Capacity

1. **Is the penalty cost defined at the resource level?**
   - Yes → Use this value
   - No → Next level

2. **Is the penalty cost defined at the org level?**
   - Yes → Use this value
   - No → Next level

3. **Is the penalty cost defined at the plan level?**
   - Yes → Use this value
   - No → Next level

4. **Is the penalty cost defined through a profile option?**
   - Yes → Use this value
   - No → Use the internal default value

---

If the data is not available at a given level, Oracle ASCP will check for available data at the next level in the hierarchy.

**To set penalty factors for exceeding resource capacity at the resource level:**

1. From the Navigator, choose Bills of Material > Routings > Departments.
   
   The Departments window appears.

2. Find a department.

3. Click Resources.
   
   The Resources window appears.

4. Select the flexfield
   
   The Department Resource Information window appears.
5. Enter the Resource Over-Capacity Penalty factor.

To set penalty factors for exceeding resource capacity at the organization level:
1. From the Navigator, choose Inventory > Setup > Organizations > Parameters. The Organization Parameters window appears.
2. Select the flexfield. The Organization Parameters window appears.
3. Enter the Resource Over-Capacity Penalty factor.

To set penalty factors for exceeding resource capacity at the plan level:
1. Select the Advanced Supply Chain Planner responsibility.
2. From the Navigator, choose Supply Chain Plan > Options.
3. Select a plan. The Plan Options window appears.
4. Select the Optimization tab.
5. Enter the penalty factor in the Exceeding resource capacity field.

To set penalty factors for exceeding resource capacity through a profile option:

1. Log in as the System Administrator.

2. From the Navigator, choose Profile > System.
   The Find System Profile Values window appears.

3. Enter the profile name MSO: Penalty Cost Factor for Exceeding Resource Capacity in the Profile field and click Find.
   The System Profile Values window appears.
4. Enter the penalty factor in the Site column.

**Setting Penalty Factors Using Plan Options**

There are four penalty factors that can be set in the Optimization tab. For more information on the Optimization tab, see Chapter 5, “Defining Plans.”

- Penalty Factor for Late Demand
- Penalty Factor for Exceeding Material Capacity
- Penalty Factor for Exceeding Transportation Capacity
- Penalty Factor for Exceeding Resource Capacity

**Penalty Cost for Late Demand**

The penalty cost for late demand (forecasts and sales orders) is equal to:

\[(\text{penalty factor}) \times (\text{list price})\]

**Penalty Cost for Exceeding Material Capacity**

The penalty cost for exceeding material capacity is equal to:

\[(\text{penalty factor for exceeding material capacity}) \times (\text{item cost})\]
Setting Penalty Factors

Penalty Cost for Exceeding Transportation Capacity
The penalty cost for exceeding transportation capacity is equal to:

\[(\text{penalty factor for exceeding transportation capacity}) \times (\text{transportation cost})\]

Penalty Cost for Exceeding Resource Capacity
The penalty cost for exceeding resource capacity is equal to:

\[(\text{penalty factor for exceeding resource capacity}) \times (\text{resource cost})\]

Note: Unit costs (list price, item cost, and so on) play an important role in determining penalty costs.

Setting Penalty Factors Using Optimization Profile Options
These profile options can be used to specify default values necessary for optimization.

Note: For detailed information on setting these and other profile options, see Appendix A, "Profile Options."

Penalty Factor for Late Demand
Use this profile option to define a penalty factor common to all demands. The demands include sales orders and forecasts.

Penalty Factor for Exceeding Material Capacity
Use this profile option to define a global penalty factor for exceeding material capacity. This value will be common to all items in the plan.

Penalty Factor for Exceeding Resource Capacity
Use this profile option to define a global penalty factor for exceeding resource capacity. This value will be common to all manufacturing and transportation resources in the plan.

Inventory Carrying Costs Percentage
Use this profile option to specify the inventory carrying costs percentage for all items in the plan. The value is specified as a number between 0 and 1.
Comparing Different Optimization Runs

**Maximum Allowable Days Late**
Use this profile option to limit the number of days by which a demand or unfirmed scheduled receipt can be moved out. This value is used to improve performance during optimization. The value is specified as an integer greater than 0.

**Comparing Different Optimization Runs**
You can generate an optimized and executable plan based on your plan objectives as well as material, resource, and transportation constraints. Oracle ASCP provides online interactive simulation planning so you can rapidly simulate changes and respond to changing conditions. For example, you could compare two optimized plans with different objective weights and compare the results based on performance indicators.

Results of optimized plans are stored for use by future planning runs.

For more information on simulations see Chapter 7, “Simulations.” For more information on evaluating plan performance and comparing multiple plans, see Chapter 9, “Performance Management.”
Performance Management

Topics covered in this section include the following:

- Overview of Performance Management on page 9-2
- Key Performance Indicators (KPIs) on page 9-2
- KPI Setup on page 9-8
- Tracking Plan Performance Using KPIs on page 9-10
- Exception Messages on page 9-12
- Making Decisions Based on Exceptions on page 9-20
- Recommendations on page 9-20
- Identifying Differences Between Plans on page 9-60

A Day in the Life of a Planner
Overview of Performance Management

Oracle ASCP is integrated with the Oracle Business Intelligence System (BIS) performance management system. BIS lets you set the organizational objectives:

**Note:** These objectives, known as Performance Measures in BIS, are referred to as Key Performance Indicators (KPIs) in Oracle ASCP

KPIs are used to drive continuous improvement in your enterprise. You can set performance targets and exception tolerances by business units or by period and automatically notify the appropriate people when exceptions arise. For information on setting targets, refer to the Oracle Business Intelligence System Implementation Guide.

You can also compare the KPIs for multiple plan simulations using the Planner Workbench.

Key Performance Indicators (KPIs)

Oracle APS (Advanced Planning and Scheduling) provides eight KPIs against which a plan’s performance can be compared. The following table shows the KPIs that are available in the Oracle ASCP and Oracle Inventory Optimization modules.

<table>
<thead>
<tr>
<th>KPIs</th>
<th>ASCP</th>
<th>IO</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inventory Turns</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Margin Percentage</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Planned Utilization</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>On time Delivery</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Margin</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Cost Breakdown</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Service Level</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Inventory Value</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Figure 9-1  Oracle ASCP Key Performance Indicators
Following are descriptions of various KPIs.

**Inventory Turns**

Inventory turns for a given plan between time periods \( t_1 \) and \( t_2 \) are calculated as follows:

\[
\text{(annual) inventory turns} = \frac{\text{dollar value of MDS demand in period } [t_1, t_2]}{\text{dollar value of average inventory in period } [t_1, t_2]} \times \frac{365}{(t_2 - t_1)}
\]

\[
\text{dollar value of average inventory in period } [t_1, t_2] = \frac{\text{inventory at } t_1 + \text{inventory at } t_2}{2}
\]

where \( t_1 \) and \( t_2 \) are expressed in units of days

inventory at time \( t_2 = \text{inventory at time } t_1 + \text{purchase orders during period } [t_1, t_2] + \text{purchase requisitions during period } [t_1, t_2] + \text{planned orders during period } [t_1, t_2] \]
Key Performance Indicators (KPIs)

Margin Percentage

Margin Percentage is the net difference between planned revenues and planned production costs.

\[
\text{Margin Percentage} = \frac{[(\text{total shipment units}) \times (\text{standard price}) \times (\text{standard discount})] - [(\text{total shipment units}) \times (\text{standard cost})]}{[(\text{total shipment units}) \times (\text{standard price}) \times (\text{standard discount})]}\]

where total shipment units include sales orders and forecasts.

Note: These calculations use standard costs of items. Standard cost systems use a single value to cost all material and resource transactions in inventory and work in process systems.

Planned Utilization

Planned Utilization for a resource or supplier for a planning time bucket is calculated as follows:

\[
\text{Planned Utilization} = \frac{\text{(Hours of capacity actually used)}}{\text{Available hours of capacity}} \times 100
\]

Note: For production lines and supplier capacities, substitute units for hours.

Aggregate level utilizations for all hierarchy levels are based on average utilization. For example, Planned Utilization for a resource is calculated as follows:

\[
\text{Resource Planned Utilization} = \frac{\text{Sum of [Planned Utilization for all Planning time buckets]}}{\text{Number of Planning time buckets}}
\]

Plan level Planned Utilization does not include supplier utilization.
Ontime Delivery

Customer service level or delivery performance are calculated as follows:

\[
\text{On-time delivery} = \frac{(\text{Total number of orders} - \text{number of late orders}) \times 100}{\text{Total number of orders}}
\]

Margin

Margin is calculated as follows:

\[
\text{Top Assembly Margin} = (\text{total shipment units}) \times (\text{standard price}) \times (\text{standard discount}) - (\text{total shipment units})(\text{standard cost})
\]

\[
\text{Aggregate Level Margin} = \text{Sum of margin of top assemblies}
\]

You can drill down to Plan/Org level KPI (Revenue vs. Cost vs. Profit) or to KPI Trend. No target is available for Margin KPI.

Cost Breakdown

Cost Breakdown KPI is composed of four separate costs:

- Production Cost
- Inventory Carrying Cost
- Penalty Cost
- Purchasing Cost

Production cost is calculated based on the required resource time and its corresponding cost. Product cost is calculated as follows:

\[
\text{Production Cost} = \text{Sum of (Resource time needed} \times \text{Resource Cost for all resources in the organization.}
\]

Inventory carrying cost is calculated based on average inventory level in each time bucket. Inventory carrying is calculated as follows:

\[
\text{Inventory Carrying Cost (period } i) = \text{Average inventory of period } i \times \text{carrying cost percent}
\]

Penalty cost is calculated as follows:

\[
\text{Penalty Cost} = \text{demand lateness cost} \times (\text{demand satisfied date} - \text{requirement date}) \times \text{demand quantity} \times \text{item list price}
\]
Standard item cost is used in the above equation in the absence of item list price.
Purchasing cost is calculated based on the standard item cost and the supply quantity.

\[ \text{Purchasing Cost} = \text{Sum of } [\text{Standard Cost} \times \text{Supply quantity}] \text{ for all items} \]

You can drill down to Plan/Org KPI or to KPI Trend. No target is available for Cost Breakdown KPI.

**Service Level**

Service Level is calculated as follows:

\[
\text{Planned Item Service Level} = \frac{\text{Total demand quantity of item satisfied by due date}}{\text{Total demand quantity of item}}
\]

\[
\text{Planned Aggregate Service Level} = \frac{\text{Total demand quantity satisfied by due date}}{\text{Total demand quantity}}
\]

You can display Planned Service Level vs. Target Service Level at plan, organization, and item levels. You can also drill down to a graph showing service level trend.

**Inventory Value**

A graphical representation of the least risk inventory values at the intersection of the levels in the hierarchies that you have selected for inventory planning (e.g., item or product family and organization by month) are displayed in a time-phased view.

---

**Note:** For more information on using KPIs, refer to Chapter 10, Planner Workbench/User Interface.
KPI Setup

Currently, setting up targets for the following KPIs or performance measures are set up within the BIS application. You can access the BIS application to set the following KPIs (now known as Performance Measures) at the following dimensions:

- MRP Gross Margin% at the Total Organizations and Total Time dimensions
- MRP Inventory Turns at the Total Organizations and Total Time dimensions
- MRP On-time Delivery% at the Total Organizations and Total Time dimensions
- MRP Planned Utilization% at the Total Organizations and Total Time dimensions

Figure 9–3  Setting KPI Target Levels in Oracle BIS
To set targets for KPIs or Performance Measures:

1. From the BIS Personal Home Page, click Performance Management Framework (Full Access).
2. Click Performance Measures.
3. In the Performance Measure drop down box, select the correct performance measure (e.g.; MRP Gross Margin%).
4. Click the View Target Levels button.
5. Click BIS_EDIT_VIEW in the row that shows the correct dimensions (e.g.; Total Organizations, Total Time).
6. Scroll down to the access section. Make sure the Selected Responsibilities include Performance Management Framework (Full Access) and Performance Management Framework (Targets Access).
7. Click the Save and View Targets button.
8. In the Organization drop down box, select Total Organizations.
9. Click the Find Targets button.
10. Click the Retrieve button.
11. In the Business Plan drop down box, select Standard.
12. Click the Refresh button.
13. If there is no target set and you wish to set a target, click the New Target button.
14. If there is an existing target you wish to edit, click BIS_EDIT_VIEW for the target you wish to edit.
15. Enter the target.
16. Click the Save button.
17. Use the home button in the Performance Target Details bar and start over with the next target.

Note: If you are using the 10.7 version of Oracle Applications, there is no user interface available for setting up these targets. A custom program is needed to input these targets.
Tracking Plan Performance Using KPIs

Oracle ASCP lets you track plan performance against KPIs. For more information, see Chapter 10, Planner Workbench/User Interface.

Making Improvements Based on KPIs

Increasing Inventory Turns

- Decrease the penalty factor for safety stock violation.
- Increase weight given to the maximize inventory turns objective, decrease weight given to other objectives by choosing Plan Options > Optimization tab.
- Change sourcing rules used by the plan to reflect material sources (for example, inventory stocks) that are controlled by the planner or the organization being planned. For example, if a plan is run with many inventory sources specified in the sourcing rules, inventory turns will be lower than if only a few inventory sources are used.

Increasing Planned Utilization

- Decrease penalty factor for exceeding resource capacity.
- Increase weight given to the maximize resource utilization objective, decrease weight given to other objectives.
- Increase the demand that is being planned. Note that increasing demand can have adverse impact to other KPIs (for example, OnTime Delivery) if material capacity is not sufficient to support the demand.

Increasing Margin Percentage

- Decrease penalty factors considered in the margin percentage calculation.
- Increase weight given to the maximize margin percentage objective, decrease weight given to other objectives.
- If material and/or resource capacity is constrained, demand will not be fulfilled by the request date and sales will either be lost of penalty costs will be incurred for late demand. See actions described in Increasing OnTime Delivery.
Increasing Ontime Delivery

- Ontime Delivery will suffer if material capacity and/or resource capacity are not sufficient to meet requested delivery dates. By looking at the exceptions that occur after a plan is run, you can determine whether material or resource capacity is the gating factor.

- To determine material and resource capacities required to meet all requested delivery dates for demand, run the plan unconstrained by material and capacity to determine total resource and material capacity requirements. (Choose Plan Options > Constraints tab to specify material and resource constraints.)

**Example 1 If material capacity is insufficient:**

- Add capacity at the bottleneck supplier(s)
- Specify alternate components that can be used if the primary (constrained) component is not available
- Add capacity at feeder plants supplying sub assemblies

**Example 2 If resource capacity is insufficient:**

- Add capacity at the bottleneck resource. For example, add shifts, add outsourcing providers, add labor
- Specify alternate resources that can be used

**Example 3 If material and resource capacities are not constrained:**

- Increase penalty factor for unmet demand and late demand
- Increase weight given to the maximize on-time delivery objective, decrease weight given to other objectives
Exception Messages

Oracle APS provides highly advanced exception handling. First, planners can use plan options to make their plans consistent with the business drivers of their company. They can decide to run a plan for a single plant or for an entire supply chain. They can also choose to run plans that have no material and resource constraints, some material and resource constraints, or with optimization objectives like profit, inventory turns, in combination with penalties for late deliveries, working overtime, and so on.

For each of the plans, they can search for specific exceptions (for example, find exceptions that relate to a specific buyer or item), view the exceptions grouped together in order of priority, drill down to related exceptions and detailed supply and demand information, and run simulations to improve plans. Last, they can use the powerful capabilities of the embedded workflow engine to highlight specific exceptions within their company or to their trading partners, and even model how they should be resolved automatically under specific situations.

This section explains:

- What exceptions are generated for which type of plans
- How exceptions can be viewed and analyzed
- How exception situations potentially can be resolved

Exception Summary Window

Exception messages are viewed using the Actions tab in the Planner Workbench (right panel). Please refer to Chapter 10 for more information on Exception-related windows. Planners can access the exceptions using the Exception Summary window. The Exception Summary window displays information about all exception messages generated by the current planning run, along with all messages saved from previous simulation runs. The window has three default columns: Action Type (exception group), Version, and Count (the Count column shows the subtotal of the exception message count by exception group). In this window, exceptions are grouped together in preseeded order of importance: for example, late orders are more important than recommendations. Planners have the option to prioritize and sort exceptions based on their preferences using the Find Window action. Furthermore, they can drill down to the Exception Details window to view an individual exception by double clicking on any exception group.
Exception Groups for Different Plans

As mentioned earlier, plan options determine which exceptions are generated by the planning system. For example, some exceptions are only generated for constrained plans and some are only generated for unconstrained plans. Optimized plans generate additional exceptions.

The next nine tables list all of the exceptions by exception groups for the respective plan options. Exceptions are displayed in the order of most critical to least critical within the exception group. Exception groups and exceptions are only displayed if the exceptions exist.

<table>
<thead>
<tr>
<th>Exception Group/Exception</th>
<th>Base ASCP (unconstrained)</th>
<th>ASCP with CBO** (constrained)</th>
<th>ASCP with CBO* (optimized)</th>
<th>Inventory Optimization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order at risk due to material shortage</td>
<td>yes</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>Order at risk due to resource shortage</td>
<td>yes</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>Late supply pegged to sales order</td>
<td>yes</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>Late supply pegged to forecast</td>
<td>yes</td>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>Past due sales orders</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Past due forecast</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Late replenishment for sales order</td>
<td>n/a</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
<tr>
<td>Late replenishment for forecast</td>
<td>n/a</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
<tr>
<td>Early replenishment for sales order</td>
<td>n/a</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
<tr>
<td>Early replenishment for forecast</td>
<td>n/a</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
</tbody>
</table>
## Exception Messages

<table>
<thead>
<tr>
<th>Exception Group/Exception</th>
<th>Base ASCP (unconstrained)</th>
<th>ASCP with CBO** (constrained)</th>
<th>ASCP with CBO** (optimized)</th>
<th>Inventory Optimization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material constraint</td>
<td>n/a</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Resource constraint</td>
<td>n/a</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Resource overloaded (*)</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Supplier capacity overloaded (*)</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Resource underloaded</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Exception Group/Exception</th>
<th>Base ASCP (unconstrained)</th>
<th>ASCP with CBO** (constrained)</th>
<th>ASCP with CBO** (optimized)</th>
<th>Inventory Optimization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transportation resource constraint</td>
<td>n/a</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
<tr>
<td>Transportation resource overloaded (*)</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Transportation resource underloaded</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Exception Group/Exception</th>
<th>Base ASCP (unconstrained)</th>
<th>ASCP with CBO** (constrained)</th>
<th>ASCP with CBO** (optimized)</th>
<th>Inventory Optimization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items with a shortage</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Items below safety stock</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
<tr>
<td>Items with excess inventory</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Exception Group/Exception</th>
<th>Base ASCP (unconstrained)</th>
<th>ASCP with CBO** (constrained)</th>
<th>ASCP with CBO** (optimized)</th>
<th>Inventory Optimization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Past due orders</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
<tr>
<td>Orders to be rescheduled out</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
</tbody>
</table>
### Exception Messages

<table>
<thead>
<tr>
<th>Exception Group/Exception</th>
<th>Base ASCP (unconstrained)</th>
<th>ASCP with CBO** (constrained)</th>
<th>ASCP with CBO** (optimized)</th>
<th>Inventory Optimization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orders to be cancelled</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
<tr>
<td>Orders to be rescheduled in</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
<tr>
<td>Orders with compression days (*)</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Exception Group/Exception</th>
<th>Base ASCP (unconstrained)</th>
<th>ASCP with CBO** (constrained)</th>
<th>ASCP with CBO** (optimized)</th>
<th>Inventory Optimization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned order uses alternate BOM</td>
<td>yes (1)</td>
<td>yes (1)</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Planned order uses alternate routing</td>
<td>yes (1)</td>
<td>yes (1)</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Planned order uses substitute components</td>
<td>n/a</td>
<td>n/a</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Planned order uses alternate resources</td>
<td>n/a</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Order sourced from alternate facility</td>
<td>n/a</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Order sourced from alternate supplier</td>
<td>n/a</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Demand satisfied using end item substitution</td>
<td>n/a</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
</tbody>
</table>

Please see the following note for information on what the number 1 means.

<table>
<thead>
<tr>
<th>Exception Group/Exception</th>
<th>Base ASCP (unconstrained)</th>
<th>ASCP with CBO** (constrained)</th>
<th>ASCP with CBO** (optimized)</th>
<th>Inventory Optimization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items with a shortage in a project/task</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
<tr>
<td>Items allocated across projects/tasks</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
</tbody>
</table>
## Exception Messages

<table>
<thead>
<tr>
<th>Exception Group/Exception</th>
<th>Base ASCP (unconstrained)</th>
<th>ASCP with CBO** (constrained)</th>
<th>ASCP with CBO** (optimized)</th>
<th>Inventory Optimization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items with excess inventory in a project/task</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Exception Group/Exception</th>
<th>Base ASCP (unconstrained)</th>
<th>ASCP with CBO** (constrained)</th>
<th>ASCP with CBO** (optimized)</th>
<th>Inventory Optimization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items that are over-committed</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
<tr>
<td>Items with negative starting on hand</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Items with expired lot</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
<tr>
<td>Items with repetitive variance</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
<tr>
<td>Items with no activity</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>

### Recommendations

<table>
<thead>
<tr>
<th>Recommendations</th>
<th>Base ASCP (unconstrained)</th>
<th>SCP with CBO** (constrained)</th>
<th>ASCP with CBO** (optimized)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discrete Jobs</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Purchase Requisitions</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>

**Note:** (1) These exceptions are not a result of decisions made by the planning engine. They are only visible in an unconstrained plan, if a planner has manually chosen this alternative (for example, a planner can firm a planned order and choose an alternate routing in the Supply/Demand window).
**Note:** *Orders with compression days and overloaded exceptions (resource overloaded, supplier capacity overloaded, and transportation resource overloaded) are generated for constrained/optimized plans only when there are firm supplies in the plans or when the Enforce Demand Due Dates option is selected.

**CBO denotes Constraint-Based Optimization.**

You can view the following exception messages listed in the table in the Planner Workbench Actions tab.

**Figure 9-4  Planner Workbench Actions tab**
Planning Exception Sets

Generation of over-loaded and under-loaded exceptions is controlled by user-defined planning exception sets (in the source instance) that specify the sensitivity controls and exception time periods for each exception message.

Since different sensitivity controls and exception time periods are appropriate for different types of items, a planner can define as many planning exception sets as needed. The appropriate exception set can be assigned to each item using the Define Item form.

Sensitivity controls that define the quantity excess and repetitive variance exceptions are:
- Excess quantity
- Repetitive variance percentage
- Resource under-loaded
- Resource over-loaded
- User-defined time fence (in days)

Exception time period types that define the time period for over-committed, shortage, excess, and repetitive variance exceptions are:
- Cumulative manufacturing lead time
- Cumulative total lead time
- Planning time fence
- Total lead time
- User-defined time fence

**Note:** When choosing a user-defined time fence, the number of days that this time fence corresponds to must be defined.

Prioritization and Navigation

The Planner Workbench supports various ways to assist planners in managing plan exceptions. They can manage exceptions and drill-down to details using:
- Exceptions prioritization and sorting
- Default exceptions folders
Exception Messages

- Relevant information buttons
- Right mouse options
- Drill down from Late Orders Exceptions to Constraint Exceptions (and vice versa)

For more information on viewing exceptions, see Chapter 10, Planner Workbench/User Interface.
Making Decisions Based on Exceptions

Oracle ASCP provides a range of exception messages for all plans. You can easily manage your plan by displaying only those items and orders that require your attention, and you can further narrow your search using other criteria such as by buyer or by line.

By saving the exception messages each time you perform simulations, you can compare different versions of the same plan or analyze the strengths and weaknesses of a single plan. Some of the guidelines to respond to the exceptions are detailed in the following sections.

Oracle enables Internet-based collaboration by automatically forwarding planning exceptions to trading partners using workflow. Trading partners can research and respond to exceptions by selecting links to self-service web applications including forecast maintenance, supplier capacity update, ATP, and even a secured version of the Planner Workbench. Trading partner responses can in turn trigger other workflow activities such as an internal notification, or even an automatic reschedule of a purchase order or sales order.

Using Online Planning

In general, Online Planning is a very efficient and effective way to try out different ways (simulation) to resolve the exception before you commit to making the final/permanent changes. However, you can eliminate one exception only to create another under certain circumstances. For example, if you decide to off-load some operations to a different resource, you could create an overload situation for another resource. Please refer to Chapter 7, Simulations for more information on Online Planning.

During on-line planning, a planner can modify the following information:

Supplier Capacity:
- Add new supplier capacity
- Modify dates and quantities

Resource Availability:
- Add new resource availability
- Modify dates and quantities
- Add new shifts

Supplies:
- Add new planned orders
- Firm planned orders, discrete jobs, and purchase order
- Modify quantities, dates, sources, and alternates.

Demands:
- Add new Manual MDS
- Modify order priority

Plan Options:
- Modify objectives

Source versus Destination Instance

Based on the results from on-line planning session, planners can decide what changes to implement in the execution system. Most of the improvement adjustments or changes will need to be made in the source instance except for supplier capacity, supplier flex-fences, and sourcing rules.

Companies that operate an Oracle Applications Release 11i source instance, will make changes in the source instance. Companies that operate Oracle Applications Release 10.7 or 11.0 will make changes in the Collections Workbench of the destination instance (also referred to as Planning Server), because capacity can only be defined in the destination instance.

For cross-instance planning sourcing rules, changes need to be made in the destination instance. For sourcing rules, defined in the source, changes will need to be made in the source instance.

Constraint/Bottleneck Management

In general, it is more effective to resolve the most constrained resource (bottleneck) before the least constrained resource. Resource refers to manufacturing resources, transportation resources, and suppliers. Similarly, it is more logical to work on the high priority demands before working on low priority ones.

The next section explains each exception message in detail. For each exception message, the default exception detail (key fields/columns) is documented. It also provides some guidelines on how to resolve exceptions.
Late Sales Orders and Forecasts

Order at risk due to material shortage
This exception message is only generated for unconstrained plans. This exception shows an item that will potentially cause a late order because of material shortage.

Generation: The system looks at each supply node and calculates how much supply is pegged to an independent demand. If the total independent demand quantity is greater than the supply availability for that time bucket, the exception message is generated.

The following table illustrates a condition that would cause an exception to be generated due to the shortage on D1.

<table>
<thead>
<tr>
<th>Day</th>
<th>D1</th>
<th>D2</th>
<th>D3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand</td>
<td>5</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>Supply</td>
<td>0</td>
<td>15</td>
<td>0</td>
</tr>
</tbody>
</table>

The demand will not be rescheduled since it’s an unconstrained plan and the supplier capacity will be violated.

The following is a list of the names of the exception details default columns and the information supplied in each column.

- Exception: Exception Message Name
- Org: Organization where exception occurs
- Item: Item of the order
- Date: Demand Date
- End Order Number: Sales Order Number, MDS
- Supplier: Supplier Name
- Supplier Site: Supplier Location

Action/Resolution: The exception serves as a warning for you since your plan is an unconstrained plan. There are several potential ways to resolve this:

- Adjust your sales order schedule date if possible;
Adjust your supplier capacity. Do this by performing a right-mouse click on the supplier in the left pane of the Planner’s Workbench. Then, select Supplier Capacity from the menu that appears.

- To find out which supplier(s) is/are overloaded, please see your Supplier capacity overloaded exception
- Contact your supplier to see if you can arrange for more supply (supplier capacity) and then adjust supplier capacity in the system
- Please make sure to rerun the plan to see if it’s feasible after the increased capacity

Figure 9-5 Supplier Capacity Adjustment Screen

Consider using an alternate supplier - you need to manually change your supplier in your sourcing rule since you’re not running a constrained plan

Consider substitute item - you need to manually change your setup for BOM since you’re not running a constrained plan
Making Decisions Based on Exceptions

- Increase Supplier Flexfences - you can define capacity tolerance percentages that vary over time for each source. This allows you to represent the ability of your supplier to flex capacity upwards based on the amount of advanced notice you provide.
- Change quantity or modify the Sourcing Rule (for example, sourcing percentage)
- Make vs. Buy decisions
- Combination of the above

Order at risk due to resource shortage
This exception message is only generated for unconstrained plans. It shows an item that can cause a late order because a resource, required to manufacture the item, is overloaded.

**Generation:** The system goes through the pegging tree to find the resource requirements that originate from independent demands. If the total resource requirements are greater than the accumulative resource availability up to that date, the exception message is generated.

The demand will not be rescheduled since it’s an unconstrained plan, and the resource capacity will be violated.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Resource</td>
<td>Resource with the shortage</td>
</tr>
<tr>
<td>Dept/Line</td>
<td>Department that owns the resource</td>
</tr>
<tr>
<td>From Date</td>
<td>Shortage start date</td>
</tr>
<tr>
<td>To Date</td>
<td>Shortage end date</td>
</tr>
<tr>
<td>End Order Number</td>
<td>Sales Order Number, MDS</td>
</tr>
</tbody>
</table>

**Action/Resolution:** The exception serves as a warning for you since your plan is an unconstrained plan. There are several potential ways to resolve this:

- Adjust your sales order date if it’s possible
- Increase your resource availability (can be adjusted in three different ways):

---

9-24 Oracle Advanced Planning and Scheduling Implementation and User’s Guide
Making Decisions Based on Exceptions

- Increase hours available per unit (for example, working overtime) for the constrained resource
- Increase the resource assigned units to the operation (this needs to be changed in Source Instance/Bill of Materials/Routings/Routings)

**Note:** A 24-hour resource can only have one assigned unit at a time.

- Increase work days (for example, shift from 5 work days per week to 6 work days per week)

**Figure 9–6 Adjusting Resource Availability from the Planner Workbench**
Consider using an alternate resource or alternate routing for this item (you need to manually change your resource in your routing since you’re not running a constrained plan)

- Modify the sourcing rules
- Consider subcontracting
- Consider substitute items (you need to manually change your setup for bill of material since you’re not running a constrained plan)
- Change shift pattern or add capacity (for example, additional workday)
- Resource leveling; level underloaded and overloaded areas
- Combination of the above

Note: You can view and update resource availability using Resource Availability window using Right Mouse Options. Resource Requirements can be accessed using Right Mouse Options as well.

Late supply pegged to sales order
This exception message is only generated for unconstrained plans. This exception shows items with shortages that prevent sales order demand from being met, caused by component shortages.

Generation: If the late supply occurs in a lower level of the bill of material (BOM), the logic will search the BOM to determine the affected sales order.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Item with late supply</td>
</tr>
<tr>
<td>Order Number</td>
<td>Order number</td>
</tr>
<tr>
<td>Old Date</td>
<td>Blank</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Demand due date entered in MDS</td>
</tr>
<tr>
<td>Quantity</td>
<td>Quantity</td>
</tr>
</tbody>
</table>
Action/Resolution: You should consider expediting the late supply if sales order schedule date can’t be adjusted. To find out which sales order is affected by this late supply, you can click on Supply/Demand to display the Supply Pegging tree which takes you up to the Sales Order MDS.

Late supply pegged to forecast
This exception message is only generated for unconstrained plans. This exception shows items with shortages that prevent forecast demand from being met, caused by component shortages.

Generation: If the late supply occurs in a lower level of the bill of Material (BOM), the logic will search the BOM to determine the affected forecast.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Item with late supply</td>
</tr>
<tr>
<td>Order Number</td>
<td>Order number</td>
</tr>
<tr>
<td>Old Date</td>
<td>Blank</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Demand due date entered in MDS</td>
</tr>
<tr>
<td>Quantity</td>
<td>Quantity</td>
</tr>
</tbody>
</table>

Action/Resolution: You should consider expediting the late supply if the forecast date can’t be adjusted. To find out which forecast is affected by this late supply, you can click on Supply/Demand to display the Supply Pegging tree which allows you to peg up to the MDS entry.

Past due sales orders
This exception message is generated when an item has a sales order due date that is earlier than the plan start date (beginning of your planning horizon).
Making Decisions Based on Exceptions

Figure 9–7  Exception Details for Past Due Sales Orders

**Generation:**  The system searches through all sales orders to see if there is any sales order due date that falls prior to the beginning of the planning horizon.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Sales Order item</td>
</tr>
<tr>
<td>Order Number</td>
<td>Sales Order number</td>
</tr>
<tr>
<td>Old Date</td>
<td>Old due date</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Demand date</td>
</tr>
<tr>
<td>Quantity</td>
<td>Sales Order quantity</td>
</tr>
</tbody>
</table>

9-28  Oracle Advanced Planning and Scheduling Implementation and User's Guide
**Making Decisions Based on Exceptions**

**Action/Resolution:** This exception serves as a warning since it’s already late! You should consider revising the sales order schedule date.

**Past due forecast**
This exception message is generated when items have a forecast demand due date that is earlier than the plan start date (beginning of your planning horizon).

**Generation:** The system searches through all forecast demand to see if there is any due date falls prior to the beginning of the planning horizon.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception Name</th>
<th>Exception Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Forecast item</td>
</tr>
<tr>
<td>Order Number</td>
<td>Forecast entry</td>
</tr>
<tr>
<td>Old Date</td>
<td>Old due date</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Demand date</td>
</tr>
<tr>
<td>Quantity</td>
<td>forecast item quantity</td>
</tr>
</tbody>
</table>

**Action/Resolution:** This exception serves as a warning since it’s already late! You should consider either no longer planning for the forecast entry or revising the forecast entry due date.

**Late replenishment for sales order**
This exception message is only generated for constrained/optimized plans and when the Enforce Capacity Constraints option is selected. This exception message shows the potential late orders if the problem is not resolved.

**Generation:** This exception exists when the planned order’s Suggested Due Date is greater than the Need by Date. Please refer to ASCP Glossary for a clarification of these terms.

If Enforce Capacity Constraint option is specified and there is capacity shortage, Demand Satisfied Date gets moved further into the future which results in late replenishment exceptions to be generated.

The following is a list of the names of the exception details default columns and the information supplied in each column.
Making Decisions Based on Exceptions

Action/Resolution: This is one of the most critical exception messages because frequent late orders could lead to loss of business. In Exception Details window, Days Late column shows number of calendar days late between the original due date and the demand satisfied date. You could sort the orders by Days Late to get the most urgent order that you need to address first. You could also use demand priority as your priority list.

There are several ways you could resolve the exception:

- Reevaluate and revise demand priority if necessary; you may want to use different priority rules to break the tie or simply use a different priority
- Expedite the supply
- Revising the sales order schedule date

To figure out the root cause of the late replenishment:

1. Select the order with the highest priority that is late.
2. Right mouse click to reveal more options (Right Mouse Options).
3. Click on Related Exceptions to show the cause of late replenishment.
   The new window shows Material constraint, Resource constraint, Transportation constraint, or a combination of the above three constraints.
4. Go to the respective exception message section for resolution.
5. Move to the next late order and so on.
Late replenishment for forecast
This exception message is only generated for constrained/optimized plans and when the Enforce Capacity Constraints option is selected.

Generation: This exception exists when the planned order’s Suggested Due Date is greater than the Need by Date. Please refer to ASCP Glossary for a clarification of these terms.

If Enforce Capacity Constraint option is specified and there is capacity shortage, Demand Satisfied Date will get moved further into the future which will result in late replenishment exceptions to be generated.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>End Item</td>
<td>Forecast item (independent) entered in MDS</td>
</tr>
<tr>
<td>Quantity</td>
<td>Forecast item quantity entered in MDS</td>
</tr>
<tr>
<td>Order Number</td>
<td>MDS name</td>
</tr>
<tr>
<td>Priority</td>
<td>Demand priority</td>
</tr>
<tr>
<td>Customer</td>
<td>Customer name</td>
</tr>
<tr>
<td>Customer Site</td>
<td>Customer location</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Demand due date entered in MDS</td>
</tr>
<tr>
<td>Demand Satisfied Date</td>
<td>Demand satisfied date based on plan result</td>
</tr>
<tr>
<td>Days Late</td>
<td>Number of calendar days late between the original due date and the demand satisfied date</td>
</tr>
</tbody>
</table>

Action/Resolution: In Exception Details window, Days Late column shows number of calendar days late between the original due date and the demand satisfied date. You could sort the forecast entries by Days Late to get the most urgent forecast entry that you need to address first. You could also use demand priority as your priority list.

There are several ways you could resolve the exception:

- Reevaluate and revise demand priority if necessary: you may want to use different priority rules to break the tie or simply use a different priority
- Expedite the supply
Making Decisions Based on Exceptions

- Revise the forecast date

**To figure out the root cause of the late replenishment:**
1. Select the forecast entry with the highest priority that is late.
2. Right mouse click to reveal more options (Right Mouse Options).
3. Click on Related Exceptions to show the cause of late replenishment.
   The new window shows Material constraint, Resource constraint, Transportation constraint, or a combination of the above three constraints.
4. Go to the respective exception message section for resolution.
5. Move to the next late forecast entry and so on.

**Early replenishment for sales order**
This exception message is only generated for constrained/optimized plans. This exception message shows the potential early orders.

**Generation:** This exception exists when the Planned Order’s Suggested Due Date is less than the Need by Date. Please refer to ASCP Glossary for a clarification of these terms.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Org</th>
<th>End Item</th>
<th>Quantity</th>
<th>Order Number</th>
<th>Priority</th>
<th>Customer</th>
<th>Customer Site</th>
<th>Demand Date</th>
<th>Demand Satisfied Date</th>
<th>Item Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exception name</td>
<td>organization where exception occurs</td>
<td>Sales Order item (independent) entered in MDS</td>
<td>Sales Order quantity entered in MDS</td>
<td>MDS name</td>
<td>Demand priority</td>
<td>Customer name</td>
<td>Customer location</td>
<td>Demand due date entered in MDS</td>
<td>Demand satisfied date based on plan result</td>
<td>Item Description</td>
</tr>
</tbody>
</table>
**Action/Resolution:** This exception message is for information purposes only. However, if you are implementing Just-In-Time (JIT) scheduling, this exception will help you minimize your inventory carrying cost.

Possible reasons that cause early replenishment(s) are:

- Supplier delivery calendar restriction: for example, your supplier only delivers on Monday (once a week). You may end up receiving supplies early most of the time.
- Some jobs are started and completed early due to a resource availability issue at a later time.
- Firmed supplies can also create the same effect.

**Early replenishment for forecast**

This exception message is only generated for constrained/optimized plans.

**Generation:** This exception is calculated in the same matter as the Early replenishment for sales order except it applies to forecast entries instead of sales orders.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>End Item</td>
<td>Forecast item (independent) entered in MDS</td>
</tr>
<tr>
<td>Quantity</td>
<td>Forecast item quantity entered in MDS</td>
</tr>
<tr>
<td>Order Number</td>
<td>MDS</td>
</tr>
<tr>
<td>Priority</td>
<td>Demand priority</td>
</tr>
<tr>
<td>Customer</td>
<td>Customer name</td>
</tr>
<tr>
<td>Customer Site</td>
<td>customer location</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Demand due date entered in MDS</td>
</tr>
<tr>
<td>Demand Satisfied Date</td>
<td>Demand satisfied date based on plan result</td>
</tr>
<tr>
<td>Item Description</td>
<td>Item description</td>
</tr>
</tbody>
</table>

**Action/Resolution:** See Action/Resolution for Early replenishment for sales order.
Material and Resource Capacity

Material constraint
This exception is generated for constrained/optimized plans only.

Generation: This exception is generated when there is a lead time violation (that is, time available is not sufficient to provide required supply) or when there is a supplier capacity violation, as defined by the following conditions:

- For purchase items with supplier capacity: the scheduling engine takes the required supply and performs backward scheduling using supplier capacity. When the accumulated supply is less than the demand within the available time, the supplier capacity is violated. Hence, the exception message is generated. For example, if there is a demand on D5 and the supplier capacity is shown in the following table:

<table>
<thead>
<tr>
<th>Day</th>
<th>D1</th>
<th>D2</th>
<th>D3</th>
<th>D4</th>
<th>D5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>20</td>
</tr>
<tr>
<td>Supplier Capacity</td>
<td>0</td>
<td>5</td>
<td>0</td>
<td>5</td>
<td>5</td>
</tr>
</tbody>
</table>

Since there is not enough supplier capacity for 20, an exception message is generated on D1. D1 will be the Constraint Date.

- For purchase items with lead times (preprocessing, processing, post processing) defined in Item Attributes in Source instance: the scheduling engine uses the lead time offsets to see if there is sufficient time. If not, the lead time is violated. Hence, the exception message is generated. For example, if there is a demand of 5 on December 20 and the total lead time is 10 (preprocessing=1, processing=7, post processing=2), while the order must be started by December 10, today is already December 12.

- For make items without a routing: this is calculated in the same manner as the above example using lead time offsets. If the lead time is violated, the exception message is also generated for make items.

The following is a list of the names of the exception details default columns and the information supplied in each column.
Making Decisions Based on Exceptions

Action/Resolution: If this is a lead time violation of material constraint, it is possible that the root cause might be upstream in the supply chain. For example, the resource capacity issue may have forced the job to be processed earlier than it should be which results in the material constraint issue.

It is also very important to understand the potential consequence of these exceptions. In other words, will these exceptions cause any Late replenishment for sales order/forecast? If yes, how many days late? Since On Time Delivery and Customer Satisfaction have a direct relationship, these material constraint issues are the ones that you want to resolve first. Number of days late is one way to prioritize these material constraint issues. Demand priority is another way for issue prioritization.

To look for potential Late replenishment for sales order/forecast, use the Right Mouse Options to go to Related Exceptions to see if it returns any late exceptions. Once you prioritize your Material constraint exceptions, you can now focus on resolving the lead time violation for each exception.

There are several ways to resolve this:

- Adjust your sales order schedule date if possible
- Adjust your supplier capacity by doing the following:
  - To find out which supplier(s) is/are overloaded, please see your Supplier capacity overloaded exception
  - Contact your supplier to see if you can arrange for more supply (supplier capacity) and then adjust supplier capacity in the system
  - Please make sure to rerun the plan to see if it’s feasible after the increased capacity
- Consider using an alternate supplier
- Consider substitute item (if not running an optimized plan, manual substitution will be required; optimized plan will automatically take this into consideration)
- Increase Supplier Flexfences
- Change quantity or modify the Sourcing Rule (for example, sourcing percentage)
- Reevaluate lead time
- Combination of the above

**Figure 9-8   Planner Workbench Sourcing Rule Screen**

**Resource constraint**
This exception is generated for constrained/optimized plans only.

**Generation:** This exception is generated when the time available is not sufficient to manufacture required supply using specified resource as defined by the following condition:
For make items with a routing: the scheduling engine takes the total resource requirements and performs backward scheduling to derive an operation start date. If the total resource requirements are greater than the resource availability up to the plan run start date (for example, the operation start date turns out to be in the past), then the exception message is generated.

Daily resource availability is calculated by number of hours available multiplying the number of assigned units.

Start Constraint Date and End Constraint Date show the duration of the resource issue.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource</td>
<td>Constrained resource</td>
</tr>
<tr>
<td>Dept/Line</td>
<td>Department that owns the resource</td>
</tr>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Start Constraint Date</td>
<td>Constraint start date</td>
</tr>
<tr>
<td>End Constraint Date</td>
<td>Constraint end date</td>
</tr>
<tr>
<td>Overload</td>
<td>Total hours over the availability</td>
</tr>
</tbody>
</table>

**Action/Resolution:** There are several potential ways to resolve this:

- Adjust your sales order date if possible
- Increase your resource availability (can be adjusted in three different ways):
  - Increase hours available per unit (for example, working overtime) for the constrained resource

**Note:** Overload column shows the additional hours you need to increase to resolve the exception.

- Increase the resource assigned units to the operation (this needs to be changed in Source Instance/Bill of Materials/Routings/Routings)

**Note:** A 24-hour resource can only have 1 assigned unit at a time.
Increase work days (for example, shift from 5 work days per week to 6 work days per week)

- Consider using an alternate resource or alternate routing for this item
- Modify the sourcing rules
- Consider subcontracting
- Consider substitute items using different resource(s)
- Change shift pattern or add capacity (for example, additional workday)
- Combination of the above

**Note:** You can view and update resource availability using Resource Availability window using Right Mouse Options. Resource Requirements can be accessed using Right Mouse Options as well.

### Resource overloaded

The exception is mostly generated for unconstrained plans and constrained/optimized plans with Enforce Demand Due Dates option selected, or with firm supplies (firm planned orders, firm discrete jobs, repetitive schedules, and so on) or firm operations (firm start date, firm end date, or both). The resource is overloaded because the supplies are firm, which leads to resource capacity violation.

**Generation:** This exception is generated when a resource is over-utilized, as defined by the over-utilization percentage entered in the exception set. For at least one time bucket, the resource requirement is greater than the resource availability. This exception is based on the load ratio calculated for the resource.

If Enforce Capacity Constraint option (constrained plan) is specified, the scheduling system resolves the overload exceptions unless there are firm supplies or firm operations in the plan. If there is capacity shortage, Demand Satisfied Date gets moved further into the future, which results in late replenishment exception and the resource constraint exception to be generated.

If Enforce Demand Due Date option is specified, the scheduling system resolves some of the overload exceptions. However, this option overloads the resource before pushing the Demand Satisfied Date into the future. So, these overload messages generated by the scheduling system are critical to the plan.
The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Resource</td>
<td>Overloaded resource</td>
</tr>
<tr>
<td>Dept/Line</td>
<td>Department that owns the resource</td>
</tr>
<tr>
<td>Start Constraint</td>
<td>Overload start date</td>
</tr>
<tr>
<td>End Constraint</td>
<td>Overload end date</td>
</tr>
<tr>
<td>Load Ratio</td>
<td>Resource requirement/resource availability</td>
</tr>
</tbody>
</table>

**Action/Resolution:** See Action/Resolution for Resource constraint. You should also consider adjusting the percentage entered in the exception set if it does not reflect the reality.

**Supplier capacity overloaded**

The exception is mostly generated for unconstrained plans and constrained/optimized plans with Enforce Demand Due Dates option selected, or with firm supplies (planned orders, firm purchase orders, and so on). The resource is overloaded because the supplies are firm, which leads to supplier capacity violation.

**Generation:** This exception is generated when a supplier is over-utilized, as defined by the over-utilization percentage entered in the exception set. The exception is generated when the required capacity of the supplier is more than the cumulative available capacity.

If Enforce Capacity Constraint option (constrained plan) is specified, the scheduling system resolves the overload exceptions unless there are firm supplies in the plan. If there is supplier capacity shortage, Demand Satisfied Date gets moved further into the future, which results in late replenishment exception and a material constraint exception to be generated.

If Enforce Demand Due Date option is specified, the scheduling system resolves some of the overload exceptions. However, this option overloads the supplier capacity before pushing the Demand Satisfied Date into the future. So, these overload messages generated by the scheduling system are critical to the plan.

The following is a list of the names of the exception details default columns and the information supplied in each column.
### Making Decisions Based on Exceptions

**Action/Resolution:** See Action/Resolution for Material constraint. You should also consider adjusting the percentage entered in the exception set if it does not reflect the reality.

**Resource underloaded**

This exception is generated for all plan options.

**Generation:** This exception is generated when a resource is under-utilized, as defined in under-utilization percentage entered in the exception set.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Purchase item</td>
</tr>
<tr>
<td>From Date</td>
<td>Overload start date</td>
</tr>
<tr>
<td>To Date</td>
<td>Overload end date</td>
</tr>
<tr>
<td>Supplier</td>
<td>Supplier name</td>
</tr>
<tr>
<td>Supplier Site</td>
<td>Supplier location</td>
</tr>
<tr>
<td>Load Ratio</td>
<td>Supply requirement/supplier capacity</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Exception</th>
<th>Underloaded resource</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Dept/Line</td>
<td>Department that owns the resource</td>
</tr>
<tr>
<td>Start Constraint</td>
<td>Underload start date</td>
</tr>
<tr>
<td>End Constraint</td>
<td>Underload end date</td>
</tr>
<tr>
<td>Load Ratio</td>
<td>Resource requirement/resource availability</td>
</tr>
</tbody>
</table>

**Action/Resolution:** You should consider increasing the workload, decreasing available capacity, shifting resources to other work centers, processing rework, or executing special projects. In addition, you should probably consider balancing the loads. You should also consider adjusting the percentage entered in the exception set if it does not reflect the reality.
Transportation and Distribution

Transportation resource constraint
This exception is generated for constrained/optimized plans only. This exception is generated when there is a transportation capacity violation (that is, time available is not sufficient to ship required supply using a specified transportation resource).

Generation: At the item level, users specify volume and weight in item attributes. Capacity for transportation resources is also defined in volume and weight. For scheduling, transportation resources are handled very similarly to manufacturing resources. The scheduling engine takes the total transportation resource requirement and performs backward scheduling to derive a start date. If the total resource requirements are greater than the accumulative resource availability up to the plan run start date (for example, the operation start date turns out to be in the past), then the exception message is generated.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To Organization</td>
<td>Destination organization</td>
</tr>
<tr>
<td>From Organization</td>
<td>Source organization</td>
</tr>
<tr>
<td>Ship Method</td>
<td>Shipping method</td>
</tr>
<tr>
<td>Constraint Date</td>
<td>Constraint date</td>
</tr>
<tr>
<td>End Order Number</td>
<td>Sales Order Number</td>
</tr>
<tr>
<td>End Item</td>
<td>Sales Order item</td>
</tr>
<tr>
<td>Customer</td>
<td>Customer name</td>
</tr>
<tr>
<td>Customer Site</td>
<td>Customer location</td>
</tr>
<tr>
<td>Priority</td>
<td>Demand priority</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Demand due date</td>
</tr>
<tr>
<td>Demand Satisfied Date</td>
<td>Demand satisfied date</td>
</tr>
<tr>
<td>Demand Quantity</td>
<td>Demand quantity</td>
</tr>
</tbody>
</table>

Action/Resolution: You could consider adjusting your transportation resource capacity (for example, increase volume/weight). You could also consider using a different ship method or a different shipping calendar.
**Transportation resource overloaded**

The exception is mostly generated for unconstrained plans and constrained/optimized plans with Enforce Demand Due Dates option selected, or with firm supplies. The resource is overloaded because the supplies are firm which leads to transportation resource capacity violation.

**Generation:** This exception is generated when a transportation resource is overloaded, as defined in overloaded percentage entered in the exception set.

If Enforce Capacity Constraint option (constrained plan) is specified, the scheduling system resolves the overload exceptions unless there are firm supplies in the plan. If there is capacity shortage, Demand Satisfied Date gets moved further into the future, which results in late replenishment exception and a transportation resource constraint exception to be generated.

If Enforce Demand Due Date option is specified, the scheduling system resolves some of the overload exceptions. However, this option overloads the transportation resource before pushing the Demand Satisfied Date into the future. So, these overload messages generated by the scheduling system are critical to the plan.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To Organization</td>
<td>Destination organization</td>
</tr>
<tr>
<td>From Organization</td>
<td>Source organization</td>
</tr>
<tr>
<td>Ship Method</td>
<td>Shipping method</td>
</tr>
<tr>
<td>From Date</td>
<td>Overload start date</td>
</tr>
<tr>
<td>To Date</td>
<td>Overload end date</td>
</tr>
<tr>
<td>Load Ratio</td>
<td>Requirement/availability</td>
</tr>
</tbody>
</table>

**Action/Resolution:** See also Transportation resource for suggestions. Consider adjusting the percentage entered in the exception set if it does not reflect the reality.

**Transportation resource underloaded**

This exception is generated for all plans.

**Generation:** This exception is generated when a transportation resource is under-utilized, as defined in under-utilization percentage entered in the exception set.
The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>To Organization</td>
<td>Destination organization</td>
</tr>
<tr>
<td>From Organization</td>
<td>Source organization</td>
</tr>
<tr>
<td>Ship Method</td>
<td>Shipping method</td>
</tr>
<tr>
<td>From Date</td>
<td>Underload start date</td>
</tr>
<tr>
<td>To Date</td>
<td>Underload end date</td>
</tr>
<tr>
<td>Load Ratio</td>
<td>Requirement/availability</td>
</tr>
</tbody>
</table>

**Action/Resolution:** You should consider using the opportunity to balance your transportation loads. Also consider adjusting the percentage entered in the exception set if it does not reflect the reality.

### Shortages and Excess

#### Items with a shortage

This exception shows an item whose quantity on hand is less than the sum of the requirements plus safety stock, within the exception time fence defined by the item’s planning exception set.

**Generation:** On some days, the item may have more demand than it has supply; therefore, you cannot satisfy all the demand on those days. To determine if this exception exists, the planning process performs the gross-to-net explosion. The planning process does not issue this exception if it has solved the shortage by recommending creating new orders.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Item with the shortage</td>
</tr>
<tr>
<td>Quantity</td>
<td>shortage quantity</td>
</tr>
<tr>
<td>From Date</td>
<td>Shortage start date</td>
</tr>
</tbody>
</table>
Making Decisions Based on Exceptions

Action/Resolution: Usually, this exception occurs within a planning time fence (and lead time in a constrained plan); you should consider reviewing and correcting supply/demand imbalances inside the planning time fence.

Items below safety stock
This exception shows an item for which demand, less supply, brings the projected quantity on hand to a negative level or below safety stock. This exception is different from the Items with a shortage exception because the Planning Exception Set is not involved in the generation of this exception.

Generation: On some days, the item has less inventory than the specified safety stock level. If the quantity remains constant for a period of days, then there will be a date range provided for this exception message.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Item below safety stock</td>
</tr>
<tr>
<td>Quantity</td>
<td>item quantity</td>
</tr>
<tr>
<td>From Date</td>
<td>Start date</td>
</tr>
<tr>
<td>To Date</td>
<td>End date</td>
</tr>
<tr>
<td>Item Description</td>
<td>Item description</td>
</tr>
</tbody>
</table>

Action/Resolution: You should consider expediting scheduled receipts.

Items with excess inventory
This exception shows an item whose quantity on hand exceeds (as defined in excess quantity item’s planning exception set) the total requirements against the item, within the exception time fence defined by the item’s planning exception set.

Generation: On some days, the item has more inventory than it needs to satisfy demand. If the quantity remains constant for a period of days then there will be a date range provided for this exception message.
The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Item with excess inventory</td>
</tr>
<tr>
<td>Quantity</td>
<td>Excess quantity</td>
</tr>
<tr>
<td>From Date</td>
<td>Start date</td>
</tr>
<tr>
<td>To Date</td>
<td>End date</td>
</tr>
<tr>
<td>Item Description</td>
<td>Item description</td>
</tr>
</tbody>
</table>

**Action/Resolution:** You should consider canceling unneeded scheduled receipts or transferring the material to another facility.

### Reschedules

**Past due orders**

This exception shows an item with planned orders, discrete jobs, and purchase orders that are past due.

**Generation:** For discrete material only, the planning process has found at least one planned order for an item in which both the needed start date and the needed due date are in the past. The planning process recommends the planned order to start and be due on the date that the planning process is executed (planning start date).

**Note:** If Lot for Lot is not selected in the plan options, all past due order are lumped together when the Optimization Plan Option is selected.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Past due item</td>
</tr>
</tbody>
</table>
Making Decisions Based on Exceptions

Order Number  Order number
Old Date      Old due date (past due)
Date          New due date based on plan result
Quantity      Item quantity

**Action/Resolution:** For discrete material planning only, you should consider checking the demand that resulted in this planned order and either arrange to change the demand and supply due dates or prepare to expedite the scheduled receipt that you create from this planned order.

**Orders to be rescheduled out**
This exception shows an item with orders that is recommended to be rescheduled to a later date by the planning process.

**Generation:** For discrete material only, the planning process found a scheduled receipt for an item for which the suggested due date is greater than the due date of the order.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Rescheduled item name</td>
</tr>
<tr>
<td>Order Number</td>
<td>Order number</td>
</tr>
<tr>
<td>From Date</td>
<td>Original date</td>
</tr>
<tr>
<td>To Date</td>
<td>Rescheduled date</td>
</tr>
<tr>
<td>Quantity</td>
<td>Order quantity</td>
</tr>
</tbody>
</table>

**Action/Resolution:** For discrete material planning only, you should consider reviewing the recommendations for this item. The Planning system assumes that the recommendation/action will be taken.

**Orders to be cancelled**
This exception shows an item with orders that is recommended to be cancelled by the planning process.
**Making Decisions Based on Exceptions**

**Generation:** For discrete material only, the planning process found a scheduled receipt for an item for which it does not have demands.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Cancelled Item name</td>
</tr>
<tr>
<td>Order Number</td>
<td>Order number</td>
</tr>
<tr>
<td>Old Date</td>
<td>Old due date</td>
</tr>
<tr>
<td>Date</td>
<td>New due date (Plan start date)</td>
</tr>
<tr>
<td>Quantity</td>
<td>Order quantity</td>
</tr>
</tbody>
</table>

**Action/Resolution:** For discrete material planning only, you should consider reviewing the recommendations for this item. The Planning system assumes that the recommendation/action will be taken.

**Orders to be rescheduled in**

This exception shows an item with orders that is recommended to be rescheduled to an earlier date by the planning process.

**Generation:** For discrete material only, the planning process found a scheduled receipt for an item for which the suggested due date is prior to the due date of the order.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Rescheduled item name</td>
</tr>
<tr>
<td>Order Number</td>
<td>Order number</td>
</tr>
<tr>
<td>From Date</td>
<td>Original date</td>
</tr>
<tr>
<td>To Date</td>
<td>Rescheduled date</td>
</tr>
<tr>
<td>Quantity</td>
<td>Order quantity</td>
</tr>
</tbody>
</table>
Action/Resolution: For discrete material planning only, you should consider reviewing the recommendations for this item. The Planning system assumes that the recommendation/action will be taken.

Orders with compression days
This exception shows an item with planned orders, discrete jobs, and purchase orders that have compression days and need to be expedited.

Generation: For discrete material, the planning process found a planned order/supply for an item for which the suggested order date is in the past. That is, item's lead time is being violated. The planning process recommends the planned order/supply to start (order date) on the date that the planning process is executed (SYSDATE). It assigns one compression day for each work day between the suggested order date and the date that the planning process is executed and then issues this exception.

For example, if a planned order due date is Friday, the lead time offset for this item is three days (Thursday, Wednesday, and Tuesday), and the planning process executes on Wednesday, the planning process suggests that the order date should be on Wednesday with one compression day.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Sales order item</td>
</tr>
<tr>
<td>Order Number</td>
<td>Sales order number</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Demand due date</td>
</tr>
<tr>
<td>Quantity</td>
<td>Demand quantity</td>
</tr>
<tr>
<td>Compression Days</td>
<td>Number of compression days</td>
</tr>
</tbody>
</table>

Action/Resolution: For discrete material planning only, you should consider reviewing the recommendations for this item and possibly moving out the demand to eliminate or alleviate the compression days. The Planning system assumes that the recommendation/action will be taken.
Substitutes and Alternates Used

Planned order uses alternate BOM

This exception message is generated for optimized plans only.

**Generation:** This exception message appears when the planning result does not use the primary BOM set by the user.

**Note:** APS requires that an alternate routing be associated with an alternate bill of material in order to be selected. Therefore, the exception message Planned Order uses alternate routing is always seen with the exception message Planned Order uses alternate BOM.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where alternate is used</td>
</tr>
<tr>
<td>Item</td>
<td>Item name</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Demand due date</td>
</tr>
<tr>
<td>Quantity</td>
<td>Demand quantity</td>
</tr>
<tr>
<td>Alternate BOM</td>
<td>Alt. Bill of Material</td>
</tr>
<tr>
<td>Alternate Routing</td>
<td>Alt. Routing</td>
</tr>
</tbody>
</table>

**Action/Resolution:** For information and validation purposes only. Generally, alternatives are relatively more expensive or more difficult to obtain. If you are seeing a lot of these exceptions, you may want to investigate this.

Planned order uses alternate routing

This exception message is generated for optimized plans only.

**Generation:** This exception message appears when the planning result does not use the primary routings set by the user.
The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exception</td>
<td>Exception name</td>
</tr>
<tr>
<td>Org</td>
<td>Organization where alternate is used</td>
</tr>
<tr>
<td>Item</td>
<td>Item name</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Demand due date</td>
</tr>
<tr>
<td>Quantity</td>
<td>Demand quantity</td>
</tr>
<tr>
<td>Alternate BOM</td>
<td>Alt. Bill of Material</td>
</tr>
<tr>
<td>Alternate Routing</td>
<td>Alt. Routing</td>
</tr>
</tbody>
</table>

**Action/Resolution:**  For information and validation purposes only.

**Planned order uses substitute components**
This exception message is generated for optimized plans only.

**Generation:**  This exception message appears when the planning result does not use the primary components set by the user.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exception</td>
<td>Exception name</td>
</tr>
<tr>
<td>Org</td>
<td>Organization where substitute is used</td>
</tr>
<tr>
<td>Item</td>
<td>Item name</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Demand due date</td>
</tr>
<tr>
<td>Quantity</td>
<td>Demand quantity</td>
</tr>
<tr>
<td>Order Number</td>
<td>Planned order number</td>
</tr>
</tbody>
</table>
Making Decisions Based on Exceptions

**Action/Resolution:** For information and validation purposes only. Generally, substitutes are relatively more expensive or more difficult to obtain. If you are seeing a lot of these exceptions, you may want to investigate this.

**Planned order uses alternate resources**
This exception message is generated for constrained and/or optimized plans only.

**Generation:** This exception message appears when the planning result does not use the primary resource set by the user due to the non-availability of the primary resource.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where alternate is used</td>
</tr>
<tr>
<td>Dept/Line</td>
<td>Department that owns the resource</td>
</tr>
<tr>
<td>Resource</td>
<td>Alt. Resource</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Demand due date</td>
</tr>
<tr>
<td>Quantity</td>
<td>Demand quantity</td>
</tr>
<tr>
<td>Order Number</td>
<td>Planned order number</td>
</tr>
</tbody>
</table>

**Action/Resolution:** For information and validation purposes only. Generally, alternative resource are relatively more expensive or difficult to operate or less convenient to use. If you are seeing a lot of these exceptions, you may want to investigate this.

**Order sourced from alternate facility**
This exception message is generated for optimized plans only.

---

**Note:** If you change and firm the source of a planned order to an alternate facility manually, and then rerun your plan, this exception message is generated regardless of plan options.

---

**Generation:** This exception message appears whenever the system selects an alternate facility instead of the primary facility. Alternate facility is defined in the
sourcing rule within the Assignment Set associated to the plan that has a rank greater than 1 and primary facility has a rank of 1.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where alternate is used</td>
</tr>
<tr>
<td>Item</td>
<td>Item name</td>
</tr>
<tr>
<td>Date</td>
<td>Date</td>
</tr>
<tr>
<td>Quantity</td>
<td>Quantity</td>
</tr>
<tr>
<td>Source Org</td>
<td>Source organization</td>
</tr>
<tr>
<td>Supplier</td>
<td>Supplier name</td>
</tr>
<tr>
<td>Supplier Site</td>
<td>supplier location</td>
</tr>
</tbody>
</table>

**Action/Resolution:** For information and validation purposes only. Generally, alternate facilities are relatively more expensive or not as convenient to use. If you are seeing a lot of these exceptions, you may want to investigate this.

**Order sourced from alternate supplier**

This exception message is generated for all plans (unconstrained, constrained, and optimized).

**Generation:** This exception message appears whenever the system selects an alternate supplier instead of the primary supplier. Alternate supplier is defined in the Sourcing Rule within the Assignment Set associated to the plan that has a rank greater than 1 and primary supplier has a rank of 1.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where alternate is used</td>
</tr>
<tr>
<td>Item</td>
<td>Item name</td>
</tr>
<tr>
<td>Date</td>
<td>Date</td>
</tr>
<tr>
<td>Quantity</td>
<td>Quantity</td>
</tr>
<tr>
<td>Source Org</td>
<td>Source organization</td>
</tr>
</tbody>
</table>
Making Decisions Based on Exceptions

Action/Resolution: For information and validation purposes only. Generally, alternate suppliers are relatively more expensive or less convenient to use. If you are seeing a lot of these exceptions, you may want to investigate this.

Demand Satisfied Using End Item Substitution
This exception message is generated for constrained and optimized plans.

Generation: This exception message is generated when the system performs an end-item substitution. Once the planning engine runs, you may find several instances where the engine has recommended substitutions. Oracle APS converts the demand from the original item to substitute item/s if substitute supply is found.

When this happens, an exception message is generated. Typical flow may consist of analyzing exceptions generated by the plan, drilling into the details of exceptions, analyzing supply demand records using Supply/Demand window, vertical plan and pegging.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Supplier</th>
<th>Supplier name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supplier Site</td>
<td>Supplier location</td>
</tr>
</tbody>
</table>

Action/Resolution: For information purposes only.

<table>
<thead>
<tr>
<th>From item</th>
<th>The item for which you received the demand; the exception is for this item.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order number</td>
<td>Sales Order Number or MDS/Forecast name for the From item</td>
</tr>
<tr>
<td>Original Quantity</td>
<td>The quantity on the original order</td>
</tr>
<tr>
<td>Substitute item</td>
<td>Substitute item; this is the item to which the demand was transferred.</td>
</tr>
<tr>
<td>Organization</td>
<td>Organization at which the exceptions happened</td>
</tr>
<tr>
<td>Substituted Quantity</td>
<td>The demand transferred quantity</td>
</tr>
<tr>
<td>Substitute supply Organization</td>
<td>The organization at which you found the supply.</td>
</tr>
</tbody>
</table>

Action/Resolution: For information purposes only.
Projects/Tasks

**Items with a shortage in a project/task**
This exception shows an item whose demand exceeds supply with a project/task for an item.

**Generation:** The planning engine generates projects/tasks related exception messages only when the planning options are set according.

**Note:** If there is both a Project and a Task Manager, the exception message is sent to the Task Manager, as modeled within the exception workflow.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exception</td>
<td>Exception name</td>
</tr>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Item name</td>
</tr>
<tr>
<td>Date</td>
<td>Shortage date</td>
</tr>
<tr>
<td>Quantity</td>
<td>Quantity</td>
</tr>
<tr>
<td>Planning Group</td>
<td>Planning group</td>
</tr>
<tr>
<td>Project</td>
<td>Project name</td>
</tr>
<tr>
<td>Task</td>
<td>Task name</td>
</tr>
<tr>
<td>To Project</td>
<td>To project</td>
</tr>
<tr>
<td>To Task</td>
<td>To task</td>
</tr>
</tbody>
</table>

**Action/Resolution:** You should consider reviewing and correcting supply/demand imbalances with the Project and/or Task Manager.

**Items allocated across projects/tasks**
This exception shows an item whose supply for one project has been allocated to the demand of a different project.

**Generation:** This can be achieved by assigning the same planning group to the allocated-from and allocated-to project.
Making Decisions Based on Exceptions

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Item name</td>
</tr>
<tr>
<td>Date</td>
<td>Date</td>
</tr>
<tr>
<td>Quantity</td>
<td>Quantity</td>
</tr>
<tr>
<td>Planning Group</td>
<td>Planning Group</td>
</tr>
<tr>
<td>Project</td>
<td>Project name</td>
</tr>
<tr>
<td>Task</td>
<td>Task name</td>
</tr>
<tr>
<td>To Project</td>
<td>To project</td>
</tr>
<tr>
<td>To Task</td>
<td>To task</td>
</tr>
</tbody>
</table>

**Note:** If both a Project and a Task Manager are present, then the exception message is sent to the Task Manager, as modeled in the exception workflow.

**Action/Resolution:** For information and validation purposes only.

**Items with excess inventory in a project/task**
This exception shows an item whose supply exceeds demand within a project/task.

**Generation:** This exception shows an item whose quantity on hand exceeds the total requirements within a project/task, as modeled in the exception workflow.

**Note:** If both a Project and a Task Manager are present, the exception message is sent to the Task Manager, as modeled in the exception workflow.

The following is a list of the names of the exception details default columns and the information supplied in each column.
Making Decisions Based on Exceptions

**Action/Resolution:** You should consider canceling unneeded scheduled receipts for this project or transferring the material to another project.

**Item Exceptions**

**Items that are over-committed**
This exception shows an item for which available to promise (ATP) is negative or below safety stock.

**Generation:** This exception is generated when ATP is less than zero where:

\[
\text{ATP} = \text{Planned Production} - \text{Committed Demand}
\]

Planned Production = Planned Orders, Scheduled receipts (Purchase Orders, Purchase Requisitions, and Discrete Jobs), suggested repetitive schedules, nettable quantity on hand

Committed Demand = Sales orders, component demand (from planned orders, discrete jobs, and suggested repetitive schedules); excludes forecast demand or manual planned.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Item name</td>
</tr>
<tr>
<td>Date</td>
<td>Excess inventory date</td>
</tr>
<tr>
<td>Quantity</td>
<td>Quantity</td>
</tr>
<tr>
<td>Planning Group</td>
<td>Planning group</td>
</tr>
<tr>
<td>Project</td>
<td>Project name</td>
</tr>
<tr>
<td>Task</td>
<td>Task name</td>
</tr>
<tr>
<td>To Project</td>
<td>To project</td>
</tr>
<tr>
<td>To Task</td>
<td>To task</td>
</tr>
</tbody>
</table>
Making Decisions Based on Exceptions

**Performance Management**

9-57

**Action/Resolution:** You should consider creating more planned orders or move some planned orders around.

**Items with negative starting on hand**

This exception shows an item with a negative onhand beginning balance.

**Generation:** This exception is generated when the onhand beginning balance is below zero.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exception</td>
<td>Exception name</td>
</tr>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Item name</td>
</tr>
<tr>
<td>Quantity</td>
<td>Negative quantity</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Blank</td>
</tr>
<tr>
<td>Item Description</td>
<td>Item description</td>
</tr>
<tr>
<td>Lot Number</td>
<td>Blank</td>
</tr>
</tbody>
</table>

**Action/Resolution:** You should consider creating more planned orders.

**Items with expired lot**

This exception shows an item that has inventory lots that expire within the planning horizon.

**Generation:** This exception is generated when there is an expired lot in the planning horizon.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
</table>
Making Decisions Based on Exceptions

Exception name
Organization where exception occurs
Item name
Item quantity
Demand due date
Item description
Lot number

Action/Resolution: This exception serves as a warning. You should ensure that the item/component will be used prior to its expiration date.

Items with repetitive variance
This exception shows an item with suggested aggregate schedules that differ from current aggregate schedules by more than a user-defined repetitive variance percentage, up to the exception date defined by the item’s planning exception set.

Generation: This exception is generated based on Exception Set defined by users.
The following is a list of the names of the exception details default columns and the information supplied in each column.

Exception name
Organization where exception occurs
Item name
Item quantity
Demand due date
Item description
Lot number

Action/Resolution: You should review both schedules to understand the difference.

Items with no activity
This exception shows an item with no demand or supply in the current plan.
Recommendations

**Generation:** To determine if this exception exists, the planning process performs the gross-to-net explosion.

The following is a list of the names of the exception details default columns and the information supplied in each column.

<table>
<thead>
<tr>
<th>Exception</th>
<th>Exception name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org</td>
<td>Organization where exception occurs</td>
</tr>
<tr>
<td>Item</td>
<td>Item name</td>
</tr>
<tr>
<td>Quantity</td>
<td>Blank</td>
</tr>
<tr>
<td>Demand Date</td>
<td>Blank</td>
</tr>
<tr>
<td>Item Description</td>
<td>Item description</td>
</tr>
<tr>
<td>Lot Number</td>
<td>Blank</td>
</tr>
</tbody>
</table>

**Action/Resolution:** You can consider changing the item attribute Planning Method to Not planned.

### Recommendations

**Discrete Jobs and Purchase Requisitions**

Based on the planning results, the plan suggests that the planner take actions or implement the recommendations through the generation of recommendations. By double clicking on the discrete job, it takes you to the Supply/Demand window where you can release the discrete jobs and purchase requisitions.

The following is a list of the names of the columns in the Order tab in the Supply/Demand window and the information supplied in each column.

<table>
<thead>
<tr>
<th>Org</th>
<th>Organization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
<td>Item name</td>
</tr>
<tr>
<td>For Release</td>
<td>Check box for release</td>
</tr>
<tr>
<td>Firm</td>
<td>Check box for firm</td>
</tr>
<tr>
<td>Order Type</td>
<td>Manual MDS, Sales Order, Planned Order, so on</td>
</tr>
<tr>
<td>Sugg Due Date</td>
<td>Planning suggested due date</td>
</tr>
<tr>
<td>Orig. Qty</td>
<td>Original demand quantity</td>
</tr>
<tr>
<td>Order Number</td>
<td>MDS name, Planned order number, and so on</td>
</tr>
</tbody>
</table>
Identifying Differences Between Plans

<table>
<thead>
<tr>
<th>Action</th>
<th>Recommendation: None or Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Date</td>
<td>If you firm the order, you could change to a new firm date</td>
</tr>
<tr>
<td>New Qty</td>
<td>If you firm the order, you could change to a new firm quantity</td>
</tr>
</tbody>
</table>

There are additional columns you could display using Right Mouse Options that provide some key information pertaining to the orders such as Suggested Due Date, Suggested Dock Date, Suggested Start Date, and Suggested Order Date. The calculations for these key terms are as follows:

Suggested Due date = Date Material Is Required
Suggested Dock Date = Due date – Postprocessing Lead Time
Suggested Start date = Dock date – Processing Lead Time
Suggested Order date = Start date – Preprocessing Lead time

The earliest Suggested Order Date allowed is today and no compression days are allowed.

Identifying Differences Between Plans

This feature gives planners the ability to compare two plans, quickly understand how the performance of one plan compares with that of the other, and find out why the two plans differ. This is useful for determining whether actions taken by a planner to solve a specific problem have the desired overall effect.

For example, a planner may choose to address a late sales order by increasing the priority of the sales order, and then replanning (generating a new plan in the process). By comparing the new plan to the original plan, the planner can see whether the problem sales order is now on time, and whether any other sales orders may have been pushed out as a result of pulling in the problem sales order.

Also, a planner may wish to know what plan setup changes led to changes in key indicator performance. To facilitate this diagnosis, ASCP displays the plan option settings for two plans side by side. Results of comparisons between plans are shown in both graphical and tabular format.

This is done by giving planners access to an intuitive interface that allows them to select or specify two plan names that they would like to compare. They can also specify various criteria (exceptions, plan options, etc.) on which they would like to base the comparison. Planners can drill down from exception group comparison to exception type comparison to exception details.
To access the **Plan Comparison** screen from Planner Workbench:

1. From Planner Workbench, select a plan name from the left tree pane.
2. Select the Plan menu on top.
3. Select the option Compare Plans as shown in the figure below.

**Figure 9–9 Compare Plans (from Planner Workbench)**

![Plan Comparison Screen](image)

The Plan Comparison screen appears.

To access the **Plan Comparison** screen from the Navigator:

1. From the Navigator, choose Reports > Plan Comparison Report > Plan Comparison.

   The Plan Comparison screen appears.
To compare two plans:

1. Access the Plan Comparison screen either from the Planner Workbench or the Navigator (as documented previously).

2. Enter the plan names in the two fields Plan A and Plan B or select from the LOV on the Exceptions tab.

3. Specify the preference set to use for comparison in the Preference Set field or select the Create/Edit Preferences button.

4. Select the Go button.

The results of the comparison appear in the lower part of the screen, as shown in the figure below.
Identifying Differences Between Plans

Figure 9–11 Exception Group Summary screen

This screen shows the exception count for different exception groups for the two plans. This display is determined by the exception groups that you specify on the Preference Set Search screen.

Note: All of the values in the table are linked to tables that provide additional details.

To specify a preference set:
1. From the Plan Comparison screen, select either the Comparison Setting tab or choose the Create/Edit Preferences button.
The Preference Set Search screen appears. You can select whether or not to display plan options comparison for the two plans. You can also delete this preference set, save it as a default or some other name, and make it private or public to indicate the level of sharing allowed.

**Figure 9–12  Preference Set Search screen (top part of screen)**
2. To return to the Plan Comparison screen, select the Cancel button.

3. To save the preferences you have chosen to the database, select the Save button.

4. To change the preference set, select the preference set name from the drop-down menu and select the Go button.

   The preference set results change.

5. To display a plan comparison report for those preference criteria, select the Display Report button.

   The Exception Group Summary screen reappears.

6. You can select any exception group link to view exception type plan comparison for that particular exception group. You can drill down further to view exception details. Some of these procedures are explained in the following steps.

**To drill down from the Exception Group Summary screen:**

1. From the Exception Group Summary screen, select one of the links in the Exception Group column.

   The Exception Types Summary screen appears.
This screen shows the exception count split over all the exception types in that exception group.

2. To view Exception Details, from the Exception Types Summary screen, select one of the links in the Exception Type column.

An exception details graph appears.
3. To view corresponding tabular data, select the Exception Details button. The Exception Details screen appears.
To view Plan Options

1. Select the Plan Options subtab under Plan Comparison.

The Plan Options table appears.
To view plan options information about the two plans, click on any of the links below the Plan Options tab (Main, Aggregation, Organization, Constraints, Optimization, Decision Rules).

**Filtering Criteria**

You can select the filtering level for the attributes to be compared. For example, you could compare lateness at the item level, while early replenishment could be compared at the product family level.

Your available exceptions for comparison are therefore determined by your choice of filtering level as well as the Preferences chosen. Filtering hierarchies and combinations of filtering hierarchies are also supported. Within each hierarchy, filtering can be used to narrow the selection. Combinations of different filtering hierarchies can be used to include more selections. The supported hierarchies are Item and Resource.

Filtering functionality behaves similarly to the Find functionality in the Planner Workbench.

**To select Filter Criteria**

1. Select the Comparison Settings tab.
2. Select the Filter Criteria sub tab.

   The Filter Criteria screen appears.

   **Figure 9–18  Filter Criteria screen**

3. Select a field name from the drop down menu.
4. Select a condition from the drop down menu.
5. Select the From and To values from the LOV or enter their values manually.
6. To use these filter criteria for comparison, select the Display Report button.
7. To go the previous screen, select Cancel.
8. To delete all the data entered, select Clear.
9. To specify additional filter criteria, select the button Add Another Row.
Topics covered in this section include the following:

- Overview of Planner Workbench/User Interface on page 10-2
- General Navigation on page 10-2
- Tailoring the User Interface on page 10-11
- Using the Left Pane and the Navigation Tree on page 10-15
- Using the Right Pane and the Navigation Tree on page 10-19
- Viewing Pegging Supply and Demand Information on page 10-44
- Viewing the Supply Chain on page 10-45
- Implementing Planning Recommendations on page 10-48
- Reviewing a BOM or Supply Chain Bill on page 10-50
- Interactive Scheduling Using the Gantt Chart on page 10-52
- Planning Detail Report on page 10-71
Overview of Planner Workbench/User Interface

The Planner Workbench is a powerful graphical tool that lets you perform advanced simulation, review plan performance, and take actions based on system recommendations.

General Navigation

*Figure 10–1  The Planner Workbench*

The tree controls the context that is displayed in the right pane. The information shown in the right pane is aggregated to the level of the node selected in the left pane. For instance, if Organization is selected in the left pane then every tab in the right pane shows information aggregated for the organization. If the aggregated information cannot be displayed then the tab is disabled.

If you select more than one node in the left pane, the right pane displays information for both nodes selected. For instance, if you select two items in the left pane then the Horizontal Plan shows details for both items listed consecutively.
You can select multiple items using Control-Click.

**Drill Down**

In any window with summary information like actions summary or horizontal plan, you can drill down to more detailed information by double-clicking on an element. This feature lets you do the following:

- Drill down on action messages to view details of a particular action.
- Drill down to different levels the Items, Organizations, and Resources tabs to view details.
- Drill either down or up from a supply or demand order in the Pegging tree.
- When working in the Items or Organizations tab, drill down from the Horizontal Plan to view supply/demand details. When working in the Resources tab, drill down from the Horizontal Plan to view resource availability.
- When working in the Items or Organizations tab, drill down from the Vertical Plan to view supply/demand details.

**Navigating Through a Find Window**

The Find windows enables you to control the volume of data displayed. You can set find criteria for all trees and detail windows.
The Find window enables you to display basic information for the items in the current plan, plus pegging and supply/demand information.

**To display the Find window:**

1. Select a plan in the Planner Workbench.
2. Choose Tools > [Exception Details, Supply/Demand, Supply, Demand, On Hand, Items, or Resources].

The Find window appears. You can search for the following item details:

- ABC Class
- BOM Item Type
- Buyer
- Category
- Effectivity Control
- Exception Set
Overview of Planner Workbench/User Interface

- Forecast Control
- Item
- MRP Planning Method
- Make or Buy
- Nettable Quantity
- Non Nettable quantity
- Organization
- Planner
- Primary Supplier
- Repetitive
- Standard Cost
- WIP Supply Type

3. To retrieve all records, leave all fields blank and choose Find.

4. To retrieve a subset of records, enter a search string. You can use just one string in your search (containing a criterion, an operator, and a value), or you can enter several strings to refine your search.

5. Once you have entered at least one string containing a field name, a condition, and (optionally) a value, choose Find to start your search.

6. Optionally, choose a folder to import a previously defined search strings and start the search.

Pull-Down Menus

Pull-down menus take context from the Planner Workbench tree.

For example, if an item node is selected, the pull-down menus will be related to that item. If a resource is selected, the pull-down menu will be related to that resource.
Right-Click Menu Options

From any window in the Planner Workbench, you can access menu options via the [right-click] button. [Right-click] menu options are context sensitive, and different depending on the window or selected screen element.
Figure 10-4  Right-Click Menu Options Available in the Supply/Demand window

Properties Window
You can view properties for any node in a left pane tree or pegging tree by selecting the node, then choosing [right-click] > Properties.
Expand Partial

Use Expand Partial to search for item(s) in the tree in the Planner Workbench and Collection Workbench. You can enter either the complete item name or a partial name with a wildcard.

To use Expand Partial
1. From Planner Workbench, select a plan name from the left pane.
2. Select a category node, such as Organizations or Items (please note that this has not been implemented for View By: Suppliers).
3. Right-click on an item in the left pane.
   A menu appears.
Figure 10–6  Right-Click menu

4. Select Expand Partial.
   The Enter Reduction Criteria for Long List form appears.
Figure 10–7  Enter Reduction Criteria

5. Enter either a complete item name or a partial item name with a wildcard and select OK. This search is not case sensitive.

Matching results (up to 500 in number at a time) are displayed in the left pane. If there are no matching items, a message appears in the status bar.

4. Select Cancel to close the window.
Tailoring the User Interface

The following table shows the menu options for the Planner Workbench and what happens when a particular menu option is selected.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>Duplicate</td>
<td>Duplicate a record.</td>
</tr>
<tr>
<td>Edit</td>
<td>Clear</td>
<td>Edit the current field.</td>
</tr>
<tr>
<td>Edit</td>
<td>Delete</td>
<td>Delete the current field.</td>
</tr>
<tr>
<td>Edit</td>
<td>Preferences</td>
<td>Set a user profile.</td>
</tr>
<tr>
<td>View</td>
<td>Show Navigator</td>
<td>Display Navigator window.</td>
</tr>
<tr>
<td>View</td>
<td>Find</td>
<td>Find a record.</td>
</tr>
<tr>
<td>View</td>
<td>Find All</td>
<td>Find all records.</td>
</tr>
<tr>
<td>View</td>
<td>Query by Example</td>
<td>Run queries for certain information.</td>
</tr>
<tr>
<td>View</td>
<td>Record</td>
<td>View a record.</td>
</tr>
<tr>
<td>View</td>
<td>Requests</td>
<td>Review requests.</td>
</tr>
<tr>
<td>Tools</td>
<td>Exception Details</td>
<td>View exception details for your plan.</td>
</tr>
<tr>
<td>Tools</td>
<td>Supply/Demand</td>
<td>View supply and demand information.</td>
</tr>
<tr>
<td>Tools</td>
<td>Supply</td>
<td>View supply information.</td>
</tr>
<tr>
<td>Tools</td>
<td>Demand</td>
<td>View demand information.</td>
</tr>
<tr>
<td>Tools</td>
<td>On-Hand</td>
<td>View on-hand quantities.</td>
</tr>
<tr>
<td>Tools</td>
<td>Items</td>
<td>View items information.</td>
</tr>
<tr>
<td>Tools</td>
<td>Resources</td>
<td>View resources information.</td>
</tr>
<tr>
<td>Tools</td>
<td>Notifications</td>
<td>View notifications.</td>
</tr>
<tr>
<td>Tools</td>
<td>Launch Notifications</td>
<td>Launch notifications.</td>
</tr>
<tr>
<td>Tools</td>
<td>Work Dates</td>
<td>Set up work dates for your plan.</td>
</tr>
<tr>
<td>Tools</td>
<td>Preferences</td>
<td>Set preferences.</td>
</tr>
<tr>
<td>Plan</td>
<td>Start Online Planner</td>
<td>Start online planner</td>
</tr>
</tbody>
</table>
You can tailor the user interface in the following ways:

### Resize Windows

You can resize windows as with any windows-based application. In the Planner Workbench you can adjust slide bars to change the relative widths of the left and right panes. You can also maximize the right pane independent of the left pane.
Customize Columns
You can add, hide columns, resize, and move columns on the horizontal plan and folder windows.

Defining Display Preferences
Display preferences control what horizontal material planning data, horizontal capacity planning data, supplier planning information, transportation planning information, and supply/demand detail are displayed for each item.

To define your display preferences:
1. Navigate to the Planner Workbench.
2. Choose Tools > Preferences.
   The Material Plan tab appears as the default tab.
3. Enter Display Buckets, Independent Demand Type, Display Factor, Decimal Places, Show Graph and check each type of plan information you want to display in your material plan.

4. Choose the Capacity Plan tab.

5. Check each type of plan information you want displayed in your capacity plan.

6. Choose the Supplier Plan tab.

7. Check each type of plan information you want displayed in your capacity plan.

8. Choose the Transportation tab.

9. Check each type of plan information you want displayed in your capacity plan.

10. Choose the Other tab.
    Supply/Demand details display.

11. Enter a Cutoff Date and Job Status.
    When the Planner Workbench creates discrete jobs from implemented planned orders, it assigns the job status you enter in the Preferences window.
12. Select a Job Class.
   When the Planner Workbench creates discrete jobs from implemented planned orders, it assigns the job class you enter in the Preferences window.

13. Select a Req Group By default.
   When the Planner Workbench creates purchase requisitions from implemented planned orders, it assigns the requisition load group you enter in the Preferences window.

14. Select the Default Left Tab and Default Right Tab under General.

15. Choose Apply to use your preference selections for the current session only.

16. Choose Reset to use your previously saved selections.

Using the Left Pane and the Navigation Tree

The left pane contains a hierarchical tree viewable by the following categories:

- Actions
- Items
- Organizations
- Projects
- Resources
- Suppliers

Choose a tree category from the list of values (View by) at the top of the left pane. The following figures show the layout for each category.

Figure 10–10  Planner Workbench left pane tree layout for Actions

Planner Workbench left pane tree layout for Actions

+ Plans
  + Versions
    + Exception Groups
      + Items Exceptions
        + Exceptions
          + Organizations
            + Items
+ Shortages and Excess
  + Exceptions
    + Organizations
    + Items
+ Reschedules
  + Exceptions
    + Organizations
    + Items
+ Late Sales Orders and Forecasts
  + Exceptions
    + Organizations
    + Items
+ Projects/Tasks
  + Exceptions
    + Organizations
    + Items
+ Material and Resource Capacity Exceptions
  + Exceptions
    + Organizations
    + Items
+ Substitutes and Alternates Used
  + Exceptions
    + Organizations
    + Items
+ Recommendations
  + Discrete Jobs
    + Organizations
    + Items
  + Purchase Requisitions
    + Organizations
    + Items
  + Flow Schedules
    + Organizations
    + Items
  + Repetitive Schedules
    + Organizations
    + Items
Figure 10–11  Planner Workbench left pane tree layout for the Items tree

Planner Workbench left pane tree layout for the Items tree

+ Plans
  + Product Families/Models/Option Classes
    + Items
      + Organizations
        + Components
        + Departments
        + Lines
        + Transportation Resources
        + Approved Suppliers
    + Categories
      + Items
        + Organizations
          + Components
          + Departments
          + Lines
          + Transportation Resources
          + Approved Suppliers

Figure 10–12  Planner Workbench left pane tree layout for Organizations

Planner Workbench left pane tree layout for Organizations

+ Plans
  + Organizations
    + Product Families/Models/Option Classes
      + Items
        + Components
        + Approved Suppliers
    + Categories
      + Items
        + Components
        + Approved Suppliers
      + Departments
        + Resources (owned resources only)
          + Items
            + Components
            + Approved Suppliers
  + Lines
Using the Left Pane and the Navigation Tree

+ Items
  + Transportation Resources

*Figure 10–13  Planner Workbench left pane tree layout for Projects*

*Planner Workbench left pane tree layout for Projects*

+ Plans
  + Organizations
    + Planning Groups
      + Common
        + Items
    + Items
  + Planning Groups
    + Common

*Figure 10–14  Planner Workbench left pane tree layout for Resources*

*Planner Workbench left pane tree layout for Resources*

+ Plans
  + Organizations
    + Department Classes
      + Departments
        + Resources
          + Items
    + Resource Groups
      + Departments
        + Resources
          + Items
  + Lines
    + Departments
      + Resources
        + Items
  + Transportation Resources
    + Departments
      + Resources
        + Items
Using the Right Pane and the Navigation Tree

The right pane contains summary information in tables and graphs, including:

- Key Indicators
- Horizontal Plan
- Vertical Plan
- Actions
- Supply Chain

You control the context of the right pane by highlighting one or more nodes on the tree. You can also use the Find window on either the left or right panes to further limit the context. From the right pane, you can drill down to more detailed information.

The Key Performance Indicators (KPIs) Tab

The initial window of the Planner Workbench, the summary chart, provides a graphical display of the plan’s Key Performance Indicators (KPIs). At a glance, you can see how the plan performs relative to the following measures:

- Inventory Turns
- Ontime Delivery
- Margin Percentage
- Planned Utilization
- Margin
- Cost Breakdown
- Service Level
Inventory value

Utilization by Weight/Volume

You can choose to see any four of these measures together. The availability of the KPIs depends on the type of plan chosen. For information on how these measures are calculated, please refer to Chapter 9, Performance Management.

Figure 10–16 The KPIs Summary Chart in the Planner Workbench

To view KPIs:

1. Select a Plan, an Item, an Org, or a Product Family from the tree in the left pane.

2. Select Key Indicators in the right pane.

   The right pane displays KPIs for the selected Plan, Item, Org, or Product Family.
To view an enlarged version of a KPI graph:
Double-click on a sub-window to see an enlarged version of a KPI graph.
Double-click again to return to the normal view.

Figure 10–17  An Enlarged View of the On-time Delivery KPI Bar Chart

Additional display options for each sub-window in the summary chart are available via the [right-click] menu. For instance, you can display KPI information in a trend chart.
Inventory Turns

This graph compares the actual inventory turn values to the target values collected from the source. You can view overall inventory turns for a plan or select a node on the tree to see the node’s inventory turns. You can view the inventory turns value over time to evaluate the plan throughout the planning period.

The Inventory Turns graph is displayed at the following nodes:

- plans
- organizations
- product families
- categories
- individual items
- components
- planning groups
projects

tasks

**Ontime Delivery**
The Ontime Delivery Percentage graph is displayed at the following nodes:
- plans
- organizations
- product families
- categories
- individual items
- components
- planning groups
- projects
- tasks

**Planned Utilization**
The Planned Utilization percentage is available at the following nodes:
- plans
- organizations
- departments
- resource groups
- resources
- production lines
- transportation resources
- approved suppliers

**Margin Percentage**
This graph compares the actual margin to the target values collected from the source. You can evaluate alternate plans based on the net difference between plan
revenues and costs. Plan revenues are derived from forecasts and booked sales orders while costs account for planned production schedule expenses.

Margin percentage is available at the following nodes:

- plan
- organization
- product family

Reviewing Item Planning Information

In the View by drop-down menu, select either Item or Organization, then drill down to an Item to view KPIs at the Item level.

**Figure 10–19 Viewing KPIs at the Item Level**

Comparing KPIs for Multiple Plans

KPIs of multiple plans can be compared in the summary chart by selecting two or more plans in the left pane.
The Horizontal Plan and Vertical Plan Tabs

You can display your plan information vertically or horizontally.
The Vertical Plan view is only enabled for an Item-Org context and it displays the activity by item over time in a vertical format (non-bucketized).

To display your plan vertically:
1. Select one or more items from the tree in the left pane.
2. In the right pane, choose the Vertical Plan tab.
The horizontal plan information is displayed in a pivot table enabling you to drill down from years, to periods, to weeks, to days. The following table shows the default display for the horizontal plan for each plan type:

<table>
<thead>
<tr>
<th>Plan Type</th>
<th>Default Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material Plan</td>
<td>Projected Available Balance</td>
</tr>
<tr>
<td>Capacity Plan</td>
<td>Required Hours vs. Hours Available</td>
</tr>
<tr>
<td>Supplier Plan</td>
<td>Required Capacity vs. Available Capacity</td>
</tr>
<tr>
<td>Transportation Plan</td>
<td>Weight Capacity Available vs. Weight Capacity Required</td>
</tr>
</tbody>
</table>

**To display your plan horizontally:**

1. Select one or more items, resources, lines, transportation resources, or suppliers from the tree in the left pane.
2. In the right pane, choose the Horizontal Plan tab.
Viewing Item Demand/Supply Across All Organizations

The horizontal plan in the Planner’s workbench supports an aggregate view of supply-demand for items across all organizations in the supply chain plan.

To view an item’s horizontal plan across all organizations:

1. From the Navigator, choose Supply Chain Plan > Workbench.
   The Supply Chain Planner Workbench appears.

2. In the View By field in the left pane, select Items.

3. Drill down to the item you want in the left pane. You can select one or more items.

4. Select the Horizontal Plan tab in the right pane.
   The horizontal plan information is displayed in a pivot table that enables you to drill down from aggregate to periods to weeks to days.
Dynamically Define Graphs

Define graphs by selecting which pieces of information to graph.
To define information to be graphed:

1. In the right pane, choose the Horizontal Plan tab.
   
   Plan data appears in a horizontal plan.

2. Select the plan parameters you wish to graph.
   
   To graph two or more parameters together, hold the shift key as you select additional parameters. For example, you can graph either planned orders, gross requirements, or both. You can also choose to graph multiple items.

3. [Right-click] to show and hide graph or save preference in the Tools > Preferences menu.

4. [Right-click] on the Items or Organization area to display more options. Left click on Hide/Show Graph to hide the graph.

5. To change the number of periods being displayed in the horizontal graph, [right-click] anywhere in the graph and select Viewable Groups. Your choices are 5, 7, or 10. Five is the default.
Dynamically Choose Types of Graphs
After you have graphed parameters or items (see above) you can change the chart type using the [right-click] menu. For instance, if you have displayed a bar chart and you wish to display a line graph, select [right-click] > Line Chart.

Figure 10–25 Dynamically Choose Types of Graphs

To change the number of periods being displayed in the graph:
1. Right-click on the graph and select Viewable Groups. The choices are 5, 7, and 10, with 5 as the default.
View Available Capacity

**Horizontal Capacity Plan**  The Horizontal Plan tab displays the Horizontal Capacity Plan for resources and resource type nodes.

**To view Resources:**
1. [Right-click] on an item in the navigation tree then choose the Resources option. The Resources window displays.
2. To view Resource Requirements, choose Requirements.
   The Resource Requirements window appears.
To view Resource Availability:

1. From the Resources window choose Availability.

   The Resource Availability Summary window appears.
Identifying Capacity Problems: Use exception messages or the horizontal capacity plan to view overloaded resources.

Actions/Exceptions Tab

The Actions tab and tree segregates all of the actions that require immediate attention. The Actions tree contains all of the recommended new orders due to be executed within a user-defined time window, as well as all exception messages requiring attention.

To view exceptions:

1. Choose a plan for which to view exception messages. You can view exception messages at the item level by selecting an item in the Items or Organization tree.

2. In the right pane, choose the Actions tab.
The Exception Summary window lists exception groups and exception messages for the selected plan in order of their usefulness in troubleshooting. For instance, exceptions due to late sales orders appear before exceptions due to resource constraints.

Using the Find window, you can sort, group, or sub-total exceptions according to various criteria including item, supplier, or buyer, for example.

**To sort exceptions:**

1. From the Exception Summary window, select View > Find.
   The Find Actions window displays.
2. Select criteria by which to sort exceptions.
3. Check Display Message Count check box.
4. Select Find button.
Exception messages appear in the Exception Summary window sorted accordingly.

- **To view exception details, drill down on an exception message:**
  The Exception Details window appears.

![Exception Details window](image)

Exception details display preseeded default folders (combination of various key columns) based on exception type. For example, Late Replenishment for Forecast exception detail has a different exception default folder than Material Constraint exception. If you select several different exceptions, the generic default folder appears.

---

**Note:** You can customize exception folders based on your preferences and save it as the default. This is explained in the next section.
Please note that the Days Late column is available and filled in for the following exceptions: Late Replenishment for Forecast and Late Replenishment for Sales Order.

The column named Quantity Satisfied By Due Date in the Exception Details form is used to present the portion of a demand that can be satisfied by the due date.

Folder Management
You can create and save new folders, or open and delete existing folders. When opening a new folder, the layout for the new folder replaces the layout for the current folder.

To create a new folder:
1. Choose Folder > New.
   The Create New Folder window appears.
2. Enter the new folder name. The name must be unique for the user’s sign-on and for the entity that the folder represents.
3. Set the auto-query option:
   - Always - automatically queries for a subset of records each the time folder is opened.
   - Never - does not execute the query when opening this folder
   - Ask each time - opens a decision box that requests you to execute the query when opening the folder
4. Check Open as Default if the new folder definition should open as the default folder (each time you navigate to this folder for the first time).
5. Check Public if other Oracle Applications users (for example, other planners or buyers) are allowed to have access to this new folder.

---

**Note:** They can use it as their default folder, but only the original owner can modify the definition.

---

6. Choose OK when done.

Whenever this new folder is opened, the name that is assigned to this folder appears in the upper left corner of the folder block, next to the Open Folder button.
The original default folder definition, provided with the product, does not have a folder title unless it is saved with a new name.

**To recover the original default folder definition:**
A user can recover the default folder that was shipped with the APS product, after creating a custom one, through the following steps:

1. Select Folder > Save As when you are in the custom default folder.
2. Uncheck Open as Default in the Save As window that appears.
3. Choose OK.
4. Close and reopen the form to display the original default folder.

We recommend that you save the original default folder by giving it another name before creating a new default folder. This way, the original default folder can be reinstated from a list of predefined folders.

**To open another folder:**

1. Select Folder > Open to load a predefined folder. You can also press the Open Folder button located in the upper left corner of the folder.
2. Select a private or public folder from the list window that appears and choose OK to replace the current folder with the new folder.

**To save changes to a folder:**

1. Select Folder > Save to save any layout or query changes made to the current folder, or select Folder > Save As to save the current folder under a new name. If there are any pending changes to the data in the form, you will be prompted to save the changes or cancel the save.
2. If you choose Save As, complete the information requested in the Save Folder window that appears and choose OK.

This window prompts you for the same information as the Create New Folder window.

---

**Note:** If you save a folder to Open as Default, then open another folder and save that second folder also as Open as Default, the second folder becomes the new default.
To delete an existing folder:

1. Select Folder > Delete.
2. Select a folder from the list that appears and choose OK to delete the folder. You can only delete folders that you have created. If there are any pending changes to the information in the folder, you will be prompted to save the changes or cancel the delete action.

If other users are referencing that folder definition as their Open as Default folder, that reference will be deleted as well.

To create a custom folder for viewing exception details:

1. Choose Folder > [layout option].
2. Change the display as desired.

Drill Down to Related Exceptions

If you are working in a constrained or optimized plan, you can drill down from an exception to Related Exceptions (Right Mouse Options) to analyze questions like:

- Why is the order late? Is it because of a resource, material, or transportation resource constraint?
- A material/resource/transportation resource issue is detected. Will it cause any late orders?

The objective is to explain the cause and effect of the problems. The related exceptions that each exception drills down to are indicated by an arrow.

On the other hand, from the constraint exception (resource, material, or transportation resource), you can also drill down to Late replenishment for sales order/forecast if the constraint causes the late replenishment.

This feature only applies to the following:

- Late replenishment for sales orders
- Late replenishment for forecast

Note: Saving a public folder after any modification, will make the folder private. However, a public folder is opened and saved to ‘Open as Default’ with no other changes; you merely save a reference of that folder as a private default.
- Material constraint
- Resource constraint
- Transportation resource constraints

To view related exceptions for the Late Replenishment for Sales Order:
1. Select a row in the Late Replenishment for Sales Order Exception Details window.
2. Choose [right-click] > Related Exceptions.
   Related exceptions appear in the Exception Details window.

To graphically compare exceptions for multiple plan scenarios:
1. Select the plans you wish to compare in the tree navigator in the left pane.
2. In the right pane, choose the Actions tab.
3. View comparison of the exception messages.
4. View details of action.

**Relevant Information Buttons**

On the Exception Details window, additional information about the exception can be obtained through clicking the buttons on the bottom of the window. The type of exception will determine what buttons are available.

**Right Mouse Options**

From the Exception Details window, planners can obtain more information through a right mouse click on the exception. The type of right mouse options users have is determined by the exception that is selected. Options included are:

- Supply
- Demand
- Resource Availability
Using the Right Pane and the Navigation Tree

- Resource Requirements
- Sources
- Destinations
- Related Exceptions
- Gantt Chart
- Horizontal Plan
- Vertical Plan
Viewing Pegging Supply and Demand Information

The Pegging tree lets you trace supply information for an item to its corresponding end demand details. You can drill up or down from any item or component level.

To display the Pegging tree:
1. Select the desired item in the left pane.
3. In the Supply/Demand window, the Pegging tree appears in the bottom half of the window.
   Pegging information for the item displays in the Pegging tree.
4. To expand the Pegging tree, highlight the pegging node, then press [right-click] > Expand All.
5. To show the Properties of a node, press [right-click] > Properties.

Figure 10–33 The Pegging tree in the Supply/Demand window
The Pegging tree links the item’s demand to all corresponding supply at the same time. The default display is: if you peg from demand to supply, supply order details and end item demand order information; if you peg from supply to demand, supply order details, immediate parent demand information, and end item demand information.

You can explode each node to higher level or lower level nodes. You can also jump to other detail windows using the [right-click] menu.

---

**Note:** If you are running a constrained plan, Oracle ASCP will compute pegging for all items irrespective of their pegging attributes.

---

**Viewing the Supply Chain**

You can view contextual supply chain and where used information for an item graphically.

- **To view Supply Chain or Where Used information:**
  1. Drill down to an end item in the left pane.
  2. Select the Supply Chain tab in the right pane.

    A graphical representation of the item’s supply chain bill appears.
Use the drop down list to view where used information for a component of this end item.
Figure 10–35 Where Used Information for an End Item
Implementing Planning Recommendations

The Actions Summary view displays both recommendations and exceptions. The recommendations are divided into orders that must be released and future orders. In the Preferences window (Tools > Preferences), you can specify the time frame in days for which to show recommendations.

To implement planning recommendations, choose Tools > Preferences.

Creating and Implementing Firm Planned Orders

Accessing and Executing Planned Orders Directly  You can access a subset of planned orders for a specified time period or other user defined sort criteria using the Supply/Demand window. You can release all planned orders using a Release All feature or you can individually select planned orders for release.

To access and execute planned orders:
1. Select Actions tab > Recommendations.
2. Drill down to Purchase Requisitions or Discrete Jobs.
3. To firm a planned order, drill down to detail, then select the firm check box.

Releasing Recommendations

To release recommendations:
1. In the right pane, choose Actions tab > Recommendations.
2. Drill down to Purchase Requisitions or Discrete Jobs.
3. Press [right-click] > Release to select the record(s) to release.
To modify release properties (optional):

1. Drill down to Supply/Demand.
Figure 10–37  Modifying Release Properties

Releasing All Recommendations

To release all recommendations:
1. In the right pane, choose Actions tab > Recommendations.
2. Drill down to Purchase Requisitions or Discrete Jobs.
3. Press [right-click] >Select All for Release to release all.
4. Make necessary changes and save.

Reviewing a BOM or Supply Chain Bill

The tree structure makes it easy to go down levels on a bill of material. When viewing by Organization, you can left click to go down a level from a department, resource, or item level to the next level down.
The supply chain map also offers the Item/Location View. This view is available only at the item nodes and is the default for these nodes. This view displays a diagrammed flow view of all the sourcing rules and bills of distribution associated with the selected item. This view also serves as the indented bill of materials.

You can use the Where Used functionality in the Items window to find out where the item is used.

To review a BOM:
1. In the left pane of the Navigator, choose Items from the drop-down menu.
2. Choose the item for which to view a bill of materials.
Interactive Scheduling Using the Gantt Chart

Interactive scheduling provides a time-phased graphical interface to your plan’s scheduled activities and resources to help resolve inevitable shop floor problems. It lets you troubleshoot exceptions arising from resource or material constraints; overloaded or underloaded resources; absenteeism, or machine downtime. Use interactive scheduling to pinpoint affected jobs and operations and simulate changes towards effective, timely resolution.

➢ **To access the Gantt Chart:**
Follow the appropriate navigation path as shown in the table below:

<table>
<thead>
<tr>
<th>Current Window</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exception Details window</td>
<td>[Select any field] &gt; [right-click] &gt; Gantt Chart</td>
</tr>
<tr>
<td>Supply window</td>
<td>[Select any field] &gt; [right-click] &gt; Gantt Chart</td>
</tr>
<tr>
<td>Item window</td>
<td>[Select any field] &gt; [right-click] &gt; Gantt Chart</td>
</tr>
<tr>
<td>Resources window</td>
<td>Click the Gantt button</td>
</tr>
<tr>
<td>Left pane, Planner’s workbench</td>
<td>Select a resource&gt; [right-click]&gt; Gantt Chart</td>
</tr>
</tbody>
</table>
You can specify either a resource-centric view or an order-centric view using the drop down menu in this window’s left pane. The upper panel shows the respective views. The lower panel shows resources bucketed by units, hours, or days. The default display is bucketed by units.

**Note:** The Gantt Chart shows only the resource requirements that occur in the first horizon (days bucket). For example, if a plan’s buckets are 30 days, 10 weeks, and 3 periods, the Gantt Chart shows resource requirements for the first 30 days. You cannot move a job beyond the first planning horizon.

### The Order-Centric View

The order-centric view displays the selected supplies. This view can be invoked from the Supply or Supply/Demand block of the Planner Workbench. For the selected supply (or supplies), this Gantt Chart displays all the end assemblies first. The end assembly as well as the subassembly and operations are shown as a
rolled-up bar to represent collection of activities. This is provided as a tool to view the impact on an entire work order of a planner’s scheduling changes.

From the end assembly, the Gantt chart first displays the operations and the requirements on the resources selected to perform the operations. Because material availability is just as important as resource availability, it is shown within the Gantt to make rescheduling more accurate. The dates when materials become available are displayed as milestones.

When accessed from the Resource Centric View, the Order-Centric view shows the orders that were originally in the Resource Centric View.

*Figure 10–39  Order-Centric View*

As displayed in the above screen shot, order no. 75196459 shows pegging to order 75196868 for JOB-BBD. Sub assy 75196527 for JOB-BBX is also shown pegged to the end assy 75196459.

The node for Sub assy 75196527 was selected and was drilled down to reveal sub assy 75196603 and subsequently 4335, 4338, etc. at different levels.
Sub assy 4335 is further detailed in operations 10, 20 and 30, where each of the operations also show the activities and related resources. Material is shown at the beginning of an operation where it is needed.

**The Resource-Centric View**

This view displays all the activities that are being worked on by the selected resource(s). This view can be accessed from the resource block of the Planner Workbench or by right clicking on selected resource(s) in the left pane of Planner Workbench.

**Note:** In both the order-centric and the resource-centric views, an activity that appears on the right pane and is not seen on the left pane can be brought in to the right pane by right clicking on that activity in the left pane. This makes it easy to navigate to an activity.

**Color Codes**

Operations in the Gantt Chart are color-coded according to the following scheme:

<table>
<thead>
<tr>
<th>Colors</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dark Blue</td>
<td>Required</td>
</tr>
<tr>
<td>Cyan</td>
<td>Available</td>
</tr>
<tr>
<td>Magenta</td>
<td>Overload</td>
</tr>
<tr>
<td>Pink</td>
<td>Updated</td>
</tr>
<tr>
<td>Green</td>
<td>Firmed</td>
</tr>
<tr>
<td>Pink with Green Border</td>
<td>Updated/Firmed</td>
</tr>
<tr>
<td>Blue with Green Border</td>
<td>Required/Firmed</td>
</tr>
</tbody>
</table>

**Find Window**

The Find window can be used to view subsets of data by selected criteria, such as by time or by parts within the Gantt chart.
To display the Find window, select File>Find.

*Figure 10–40  Find Window*

Right-Click Menu Options

The Gantt Chart provides easy access to important information and tasks related to operations. The following options are available if you right-click with your cursor over an operation:

<table>
<thead>
<tr>
<th>[Right-Click] Menu Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Alternate/Primary Resource</td>
<td>View Alternate/Primary Resource for this operation</td>
</tr>
<tr>
<td>Load Alternate/Primary Resource</td>
<td>Load Alternate/Primary Resource for this operation</td>
</tr>
<tr>
<td>View Simultaneous Resources</td>
<td>View Simultaneous Resources for this operation</td>
</tr>
<tr>
<td>Firm/Unfirm Operation</td>
<td>Firm/Unfirm Operation for this operation</td>
</tr>
<tr>
<td>Reschedule</td>
<td>Reschedule</td>
</tr>
</tbody>
</table>
**[Right-Click] Menu Options**

<table>
<thead>
<tr>
<th>Menu Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supply/Demand</td>
<td>Open the Supply/Demand window</td>
</tr>
<tr>
<td>Exception Details</td>
<td>Open the Exception Details window</td>
</tr>
<tr>
<td>Items</td>
<td>Open the Items window</td>
</tr>
<tr>
<td>Resource Availability</td>
<td>Open the Resource Availability window</td>
</tr>
<tr>
<td>Resource Requirements</td>
<td>Open the Resource Requirements window</td>
</tr>
<tr>
<td>Resources</td>
<td>Open the Resources window</td>
</tr>
</tbody>
</table>

**Figure 10–41  Right Click**

**Viewing Information on an Operation**

You can view information on an operation via the Property window or resource Tool Tips.
To display the Property window:
1. Select an operation in the right pane.
2. Double-click on an operation.

The Property window appears.

*Figure 10–42 The Property window*

The Property window displays a host of information about the selected operation. Choose tabs to access different types of information.

When you double click on the Gantt chart bar on the right panel (or the labels on the left panel), a Property window appears with three tabs: resource, supply order, and end demand.

The properties for the Resource tab (only for the activity node) are: department/line, resource name, org/instance, operation sequence, resource sequence, alternate number, firm type, start time, end time, assigned units, and total hours required.
The properties for the supply order tab (only for the supply node) are: job number, job type, item, quantity, firm flag, suggest due date, ship date, need by date, unit number, project, task, alternate BOM, alternate routing, and time fence.

The properties for the end demand tab (only for the supply node) are: demand date, demand satisfied date, pegged quantity, demand name, demand qty, demand type, demand priority, customer, customer site, and item.

To access the resource Tool Tip for an operation, rest your cursor over the operation in the right panel.

Figure 10-43 The Resource Tool Tip

The resource Tool Tip is a subset of the Properties window showing resource name, number of units, and resource type.
Specify Resources to Plot in the Lower Pane

- **To select resources to plot:**
  1. Click Select Resource(s) in the lower pane.

![The Select Resource(s) window](image)

2. Move resources between the Available Resources and Selected Resources panes as desired.

3. Click OK.
   The selected resources appear in the lower pane.

Specifying Time Buckets

You can specify a new time bucket for the right and lower panes.

- **To specify a new time bucket for the right pane:**
  1. Right-click on the date in the upper right corner of the right pane.
  2. Choose from the following intervals:
• Quarters
• Months
• Weeks
• Days
• Hours
• Thirty Minutes
• Fifteen Minutes

These time intervals can be further broken down into smaller units of time in the lower pane.

**Figure 10–45  Time Buckets**

- To specify a new time bucket for the lower pane:
  1. Choose a time bucket from the drop down menu in the lower pane.
  2. Choose from the following intervals:
Interactive Scheduling Using the Gantt Chart

- No bucketing
- Bucketing by hours
- Bucketing by days

Rescheduling Operations

You can reschedule a job either by using the Reschedule window or by dragging and dropping the bar in the right pane.

- To reschedule an operation using the Reschedule window:
  1. In the left pane of the Gantt chart, right click on one of the nodes.
     The related activity appears in the right pane.
  2. [Right-click] on the bar in the right pane.
     A list of tasks or options appears.
  3. Select Reschedule.
4. Select a new start or end date for the activity.
5. Click OK.

The activity’s new start or end date is reflected in the Gantt Chart. After moving an activity, you can firm it by the new start or end date, or by resource.

➢ To change the duration of an activity:
   1. Specify a new start or end date using the instructions above.
   2. Select the Resize check box.
   3. Click OK.

   The activity’s new duration is reflected in the Gantt Chart. After changing an activity’s duration, you can firm it by the new start or end date, or by resource.

➢ To reschedule an activity graphically:
   1. Select the activity you wish to reschedule.
   2. Drag the activity to a new date or time.
As you move the activity, a pop-up window shows the changing start and end date dynamically. The activity’s new start or end date is reflected in the Gantt Chart.

After moving an activity, you can firm it by the new start or end date, or by resource.

To resize an activity graphically:
1. Select the activity.
2. Drag the right end of the activity bar to a desired end date. After resizing, the activity can be firmed.

Firming an Operation

To firm an operation:
1. Place your cursor over the operation you wish to firm.
Resolving Overload of an Operation

There are three ways to resolve overload of an operation. You can:

- Reschedule the operation to a time when sufficient resources are available.
- Select alternate resources for the operation.
- Add extra capacity to complete the operation with your current resources.

To reschedule an operation:

- Use the Reschedule window
- Drag and drop the operation in the Gantt Chart

Note: When you move an operation, it is automatically firmed by start date. When you offload an operation, it is automatically firmed by resource.
To load an alternate resources:
1. Place your cursor over the operation you wish to offload.
2. Choose [right-click] > Offload to Alternate Resource.
3. Choose an Alternate resource.
   A new resource is listed for the operation in the left pane. In the right pane, the operation’s shading changes to reflect that it is updated and firmed.

To add capacity:

Note: This functionality is available only in the resource-centric view.

1. Place your cursor over an operation on the resource for which you wish add capacity.
   The Resource Availability Summary window appears.

Figure 10–48 The Resource Availability Summary window

3. Select a date for which you’d like to add capacity.
4. Click Details.

The Resource Availability window appears.

Figure 10–49  The Resource Availability window

5. Add capacity for a set duration for a particular shift.

6. Click Apply.

You can then run the online planner to see the results of adding capacity for this date. Your changes are also dynamically reflected in the Gantt Chart. Increased capacity is shown in the lower panel of this window.

When any changes are made in the Gantt chart, including offloading, adding capacity, rescheduling, or increasing time duration for an activity, these changes do not take effect until the Online Planner is run. Until then, the changes appear either in pink or pink with a green border in the Gantt chart window.
Gantt Chart Menu Options

The following table shows the menu options for the Gantt chart and what happens when a particular menu option is selected.

<table>
<thead>
<tr>
<th>Main Menu</th>
<th>Submenu</th>
<th>What happens when selected</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Save</td>
<td>Change is saved to the database.</td>
</tr>
<tr>
<td>File</td>
<td>Refresh</td>
<td>The change is rolled back and the Gantt Chart view is refreshed.</td>
</tr>
<tr>
<td>File</td>
<td>Find</td>
<td>A find window appears that you can use to fetch data.</td>
</tr>
<tr>
<td>File</td>
<td>Exit</td>
<td>Exits the Gantt Chart view. If you try to exit this Gantt Chart view or close this Gantt Chart window without saving the changes, a warning message appears asking you to choose one of the following: commit the changes, ignore the changes, or cancel the exit.</td>
</tr>
</tbody>
</table>

Gantt Chart Pegging

For supplies that you specify, the Gantt chart pegging view links related end assembly orders, subassembly orders and purchased material orders together in a hierarchical display. For the entire hierarchy, the timing of all production operations and purchased material arrivals are displayed. Material arrivals are shown as milestones. The hierarchy may be flexibly collapsed (with collapsed operations and material arrivals appearing as rolled up bars, as is commonly seen in project plans) and expanded. This view provides a consolidated view of all operation and material arrival dependencies for a particular end assembly order. You can drill down to any desired level and view further details.

To display Gantt Chart pegging:
1. From the Planner’s Workbench, select a plan.
2. Right click on the plan and select Supply/Demand from the drop down menu.
   The Find Supply/Demand window appears.
3. Select Find.
4. Select an item (or items) in the Item column.
5. Right click and select Gantt Chart.
   The Gantt chart appears with the pegging information in the left pane.
Gantt Chart Split Views

Gantt Chart Split Views splits the Gantt Chart into two or four views for the purpose of consolidating information which would otherwise require extensive horizontal or vertical scrolling to compare.

Vertical Split/Merge

Vertical Split/Merge displays two Gantt Chart views vertically. It is useful for comparing Gantt Chart information that is separated widely on the time scale. Each of the two vertical views has its own independent horizontal scroll bar, and the time scales in each view can be set independently.
To display a vertical split/merge:
1. Navigate to the Gantt chart.
   The Resource-Centric view appears.
2. Select View in the Menu bar.
   A drop-down menu appears.
3. Select Vertical Split/Merge.
   The information on the right pane is divided vertically.

**Figure 10–51 Vertical Split/Merge**

**Horizontal Split/Merge**
Horizontal Split/Merge displays two Gantt Chart views horizontally. It is useful for comparing resources or operations which would otherwise be separated by a large distance on the Gantt chart vertical axis. Each of the horizontal views has an independent vertical scroll bar.

To display a horizontal split/merge:
1. Navigate to the Gantt chart.
The Resource-Centric view appears.

2. Select View in the Menu bar.
   A drop-down menu appears.
3. Select Horizontal Split/Merge.
   The information on the right pane is divided horizontally.

**Figure 10–52 Horizontal Split/Merge**

Savings Changes

After making changes to a plan in the Gantt Chart you can either save your changes or refresh. Saving changes commits them. Refreshing changes clears them.

Planning Detail Report

The Planning Detail Report provides a simple and consolidated report that shows the output of the advanced supply chain planning process. The report gives detailed information to help you understand and analyze the supply chain planning results by presenting the data selectively and coherently. For a given Supply Chain Plan, the report includes the relevant details about items, resources, gross
requirements, scheduled receipts, planned orders, plan constraints, and exceptions in separate worksheets.

**Capability**

The basic framework of the previous Supply Chain Planning Detail Report has been retained. The report has been implemented in Discoverer 4i, facilitating the manipulation of format. You can invoke the report from a menu and print the worksheets selectively. No additional change or set up in the application is required in order to generate the report. You can select the plan, organizations, items, resources, projects, and many other parameters to filter the information to display in the report and you can change these parameters at any time.

The Planning Detail Report contains six worksheets:

- **Plan Details** - shows the details of the selected plan from the ASCP plan options screen
- **Item Details** - shows the details of the selected items
- **Resource Details** - shows the details of the selected resources
- **Vertical Plan** - shows the cumulative supply/demand picture (No buckets)
- **Late Order Exceptions** - shows the details of late orders. Only the following exceptions are included in the Late Orders Exception Worksheet:
  - Past Due Sales Order and Forecast
  - Late supply pegged to sales order or forecast
  - Late replenishments for sales order or forecast
  - Replenishment after need date
  - Past Due orders
- **Other Exceptions** - shows the material and resource related exceptions that span the following exception groups:
  - Material and resource capacity constraints
  - Shortages and Excess

You can specify the details you need to see in the report. For example, you can choose not to see a particular worksheet, and you can control the display by selecting the sorting rule. For example, if a report shows material and capacity constraints, you can sort the data on the basis of items or exceptions. A column can be removed from a worksheet, but if the new format (with the deleted column) is
There are many other standard Discoverer features which will enable you to flexibly manipulate the reports. For more details on using Discoverer, see the Oracle Discoverer User’s Guide.

**To use the Planning Detail Report:**

1. Choose the Advanced Supply Chain Planner or the Inventory Planner responsibility.
   The Navigator screen appears.

2. Select Reports > Planning Detail Report.
   The Planning Detail Window appears.

*Figure 10–53  Planning Detail Report*
The following table describes each condition and defines the number of values that can be selected in the From and To fields for each condition.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Definition</th>
<th>From</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>all the values for the parameter are selected</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>Equals</td>
<td>only one value is selected</td>
<td>single value</td>
<td>n/a</td>
</tr>
<tr>
<td>Between</td>
<td>a range of values is selected</td>
<td>single value</td>
<td>single value</td>
</tr>
<tr>
<td>Among</td>
<td>multiple values are selected</td>
<td>multiple values</td>
<td>n/a</td>
</tr>
<tr>
<td>Is Not</td>
<td>a value that is not required to be included in the report is selected</td>
<td>single value</td>
<td>n/a</td>
</tr>
<tr>
<td>Outside</td>
<td>a range of values is selected that are not required to be included in the report</td>
<td>single value</td>
<td>single value</td>
</tr>
</tbody>
</table>

The information is filtered and displayed in the report on the basis of the values selected for the parameters. The following table is an example of the values that can be selected for the different parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plan Name</td>
<td>Select a plan.</td>
</tr>
<tr>
<td>Org</td>
<td>Select multiple organizations for a multi-org plan and for the owning organization. For single-org plan or when not working in the owning organization, only the current organization can be selected.</td>
</tr>
<tr>
<td>Category Set</td>
<td>The default is the category set used for the plan. You can select another category set. At least one category set should be selected.</td>
</tr>
<tr>
<td>ABC Class</td>
<td>Select a range of item ABC class</td>
</tr>
<tr>
<td>Item</td>
<td>Select a range of Items.</td>
</tr>
<tr>
<td>Planner</td>
<td>Select the name of a planner</td>
</tr>
<tr>
<td>Buyer</td>
<td>Select the name of a buyer</td>
</tr>
<tr>
<td>Supplier</td>
<td>Select one or more suppliers</td>
</tr>
<tr>
<td>Planning Group</td>
<td>Select the planning groups</td>
</tr>
</tbody>
</table>
3. Select the Go button.

The Planning Detail Report is launched in Discoverer 4i. The six worksheets, namely Plan Details, Item Details, Resource Details, Late Order Exceptions, and Other Exceptions can be accessed by selecting the respective tabs at the bottom of the report.

4. Select the Item Details tab to open the Item Details worksheet.
5. To sort the data by Organization in Vertical Plan worksheet, select the Vertical Plan tab, then select Tools > Sort.

The Sort Table appears. Use this table to change or add the sort parameter and condition.
6. To sort the data based on Organizations, select Add and select Organization in the Sort Table.

7. To view the sorted Vertical Plan worksheet, select OK on the Sort Table Window. The sorted Vertical Plan worksheet appears.
### Figure 10–56  Vertical Plan worksheet, sorted

<table>
<thead>
<tr>
<th>Organization</th>
<th>Product Category</th>
<th>Item</th>
<th>Order Type</th>
<th>Order Number</th>
<th>Date</th>
<th>Planner Action</th>
<th>Suggested Quantity</th>
<th>Old Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>MISC</td>
<td>1</td>
<td>Manual</td>
<td>10302</td>
<td>01-Jan-02</td>
<td>Release</td>
<td>10.00</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>MISC</td>
<td>2</td>
<td>Manual</td>
<td>10302</td>
<td>01-Jan-02</td>
<td>Release</td>
<td>10.00</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>MISC</td>
<td>3</td>
<td>Planned</td>
<td>10302</td>
<td>01-Jan-02</td>
<td>Release</td>
<td>10.00</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>MISC</td>
<td>4</td>
<td>Planned</td>
<td>10302</td>
<td>01-Jan-02</td>
<td>Release</td>
<td>10.00</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>MISC</td>
<td>5</td>
<td>Planned</td>
<td>10302</td>
<td>01-Jan-02</td>
<td>Release</td>
<td>10.00</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>MISC</td>
<td>6</td>
<td>Planned</td>
<td>10302</td>
<td>01-Jan-02</td>
<td>Release</td>
<td>10.00</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>MISC</td>
<td>7</td>
<td>Planned</td>
<td>10302</td>
<td>01-Jan-02</td>
<td>Release</td>
<td>10.00</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>MISC</td>
<td>8</td>
<td>Planned</td>
<td>10302</td>
<td>01-Jan-02</td>
<td>Release</td>
<td>10.00</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>MISC</td>
<td>9</td>
<td>Planned</td>
<td>10302</td>
<td>01-Jan-02</td>
<td>Release</td>
<td>10.00</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>MISC</td>
<td>10</td>
<td>Planned</td>
<td>10302</td>
<td>01-Jan-02</td>
<td>Release</td>
<td>10.00</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>MISC</td>
<td>11</td>
<td>Planned</td>
<td>10302</td>
<td>01-Jan-02</td>
<td>Release</td>
<td>10.00</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>MISC</td>
<td>12</td>
<td>Planned</td>
<td>10302</td>
<td>01-Jan-02</td>
<td>Release</td>
<td>10.00</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>MISC</td>
<td>13</td>
<td>Planned</td>
<td>10302</td>
<td>01-Jan-02</td>
<td>Release</td>
<td>10.00</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>MISC</td>
<td>14</td>
<td>Planned</td>
<td>10302</td>
<td>01-Jan-02</td>
<td>Release</td>
<td>10.00</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>MISC</td>
<td>15</td>
<td>Planned</td>
<td>10302</td>
<td>01-Jan-02</td>
<td>Release</td>
<td>10.00</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>MISC</td>
<td>16</td>
<td>Planned</td>
<td>10302</td>
<td>01-Jan-02</td>
<td>Release</td>
<td>10.00</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>MISC</td>
<td>17</td>
<td>Planned</td>
<td>10302</td>
<td>01-Jan-02</td>
<td>Release</td>
<td>10.00</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>MISC</td>
<td>18</td>
<td>Planned</td>
<td>10302</td>
<td>01-Jan-02</td>
<td>Release</td>
<td>10.00</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>MISC</td>
<td>19</td>
<td>Planned</td>
<td>10302</td>
<td>01-Jan-02</td>
<td>Release</td>
<td>10.00</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>MISC</td>
<td>20</td>
<td>Planned</td>
<td>10302</td>
<td>01-Jan-02</td>
<td>Release</td>
<td>10.00</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>MISC</td>
<td>21</td>
<td>Planned</td>
<td>10302</td>
<td>01-Jan-02</td>
<td>Release</td>
<td>10.00</td>
<td></td>
</tr>
</tbody>
</table>

---

10-78  Oracle Advanced Planning and Scheduling Implementation and User's Guide
Topics covered in this section include the following:

- Overview of Constraint-Based Planning on page 11-2
- Constraint Types on page 11-2
- Enabling and Disabling Constraints on page 11-10
- Setting Constraints for Different Plan Types on page 11-13
- Rules Used in Constrained Plans on page 11-15
Overview of Constraint-Based Planning

Constraint-based planning and scheduling is an approach for balancing material and plant resources while meeting customer demand. It takes into account constraints at the enterprise and plant levels. Material and capacity constraints are considered simultaneously. Capacity constraints include factory, distribution, and transportation resources and their respective availabilities. This complete picture of the problem provides instant and global visibility to the effects of planning and scheduling decisions throughout the supply chain.

Oracle ASCP supports two types of constraint-based planning: constraint-based planning without optimization and constraint-based planning with optimization. This section first describes constraint types that are applicable to both types, and then describes constraint-based planning without optimization. Constraint-based planning with optimization is described in Chapter 8, Optimization.

Constraint Types

You can define constraints for materials and resources in your plan. You will also be able to specify the level of importance of these constraints depending on your business needs and the planning horizon. You can generate plans using the following scenarios for each planning bucket type (days, weeks, periods):

- Plan considering material constraints only
- Plan considering resource constraints only
- Plan with respect to both material and resource constraints

See Chapter 5, "Defining Plans" for information on defining the relative importance of constraints.

The following table gives you the information you need to run a constraint-based plan:

<table>
<thead>
<tr>
<th>Constraint Type</th>
<th>Includes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items</td>
<td>BOM effectivities (process effectivity), ECOs, alternate BOMs, substitute components, by-products, safety stocks, order modifiers, supplier-specific order modifiers, supplier-specific lead times, pegging restrictions</td>
</tr>
<tr>
<td>Manufacturing Resources</td>
<td>routing effectivities, alternate routings, alternate resources, resource capacities, line rates, workday calendar</td>
</tr>
<tr>
<td>Transportation Resources</td>
<td>carrier capacities, shipment and delivery calendars</td>
</tr>
</tbody>
</table>
Items

Bills of Material
You can set effective dates for BOMs. Similarly, you can set effective dates for process effectivity (this is for Oracle OPM only). You will also be able to specify effectivities in the form of effective dates, use ups, model/unit numbers. For more information, see “Effective Date Fields” in the Oracle Bills of Materials User’s Guide.

For more information, see “Primary and Alternate Bills of Material” in the Oracle Bills of Materials User’s Guide.

---

**Note:** Effectivity can be set not only at the date level, but also at the unit number level.

---

Engineering Changes (ECOs)
Oracle ASCP evaluates the engineering change orders as of their scheduled effective date. You can order material and plan resources that you need for new revisions ahead of time.

---

**Note:** The planning process only suggests implementing engineering change orders when the unconstrained start date of the planned order is later than the effective date. Oracle ASCP does not suggest a planned order using an ECO if the planned order needs to start before the effective date of the ECO.

---

For a pending ECO, you can specify whether to include the engineering changes during the planning process. Set the MRP Active Flag to Yes in the Engineering Change Order window if you want the planning process to consider the engineering changes on the ECO.

---

<table>
<thead>
<tr>
<th>Constraint Type</th>
<th>Includes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sourcing Constraints</td>
<td>sourcing effectivities, sourcing ranks, allocation percentages, supplier capacity</td>
</tr>
<tr>
<td>Suppliers</td>
<td>supplier capacity, supplier rank, supplier calendar, flex fences, supplier order modifier</td>
</tr>
<tr>
<td>Demands</td>
<td>sales orders/forecasts, demand priority, demand priority rules</td>
</tr>
</tbody>
</table>
Oracle ASCP considers engineering changes when generating component requirements for planned orders and suggested repetitive schedules. The quantity specified by an engineering change order is considered if the scheduled effective date of the ECO is before the suggested start date of the order. For additional information, see Engineering Change Orders Use-Up Effectivity on page 11-26.

**Substitute Components**
Substitute components are modeled similarly to alternate resources. Each primary BOM component is assumed to have a set of possible substitutes. The primary item will be used instead of the substitute when it is available.

For more information, see “Assigning Substitute Components.” in the *Oracle Bills of Material User’s Guide*.

**By-products**
You can define negative usages for component items on a bill of material in Oracle Bills of Material. You can add by-products to discrete jobs using Oracle Work in Process.

Oracle ASCP includes by-products on standard and non-standard discrete jobs and components with a negative usage on a bill of material when netting supply and demand. Oracle ASCP considers this type of component requirement as supply available on the job completion date.

**Note:** You can manually add a negative requirement to a non-standard job in Oracle Work in Process to manage components that result in disassembly. You could use this option for repairing assembly units. It lets you track the item that is issued to the job as available supply on completion of the repair job.

**Product Families**
Product families improve plan performance, letting you plan further down the plan horizon. You can do the following at the product family level:

- specify demands
- run planning and scheduling
- create supplies

For more information, see *Oracle Master Scheduling MRP and Oracle Supply Chain Planning User’s Guide*. 
Safety Stock
Safety stock is a quantity of stock you plan to remain in inventory to protect against fluctuations in demand or supply. Safety stock is sometimes referred to as overplanning, forecast, or a market hedge. In the context of master scheduling, safety stock refers to additional inventory planned as protection against forecast errors or short term changes in the backlog. You can specify safety stock days together with safety stock percent as item attributes in Oracle Inventory.

You can establish the default use of safety stock calculation when you define your planning parameters. You can override this option for individual material plans when you generate an MRP or MPS using the Launch window.

When launching the planning process, you can choose whether to calculate safety stock when generating suggested planned orders and repetitive schedules in the Plan Options window. If you choose to run the planning process with the safety stock option, Oracle ASCP looks at each item to determine the method of safety stock calculation. You can define safety stock methods for each item using Oracle Inventory.

For additional information, please see "Setting Plan Options" on page 5-21.

MRP Planned Percent If you choose a safety stock method of MRP planned percent for an item, safety stock is dynamically calculated during the planning process. For discretely manufactured items, the safety stock quantity is dynamically calculated by multiplying the safety stock percentage you define by the average of gross requirements for a period of time defined by the safety stock days. For repetitively manufactured items, the planning process multiplies the percentage you define by the average daily demand for a given repetitive planning period.

The planning process recalculates the safety stock quantity for each repetitive period in the planning horizon.

Inventory Methods Oracle Inventory provides several different methods for calculating safety stock.

The following methods are available within Oracle Inventory for calculating safety stock and are used during the planning process if your safety stock method is Non-MRP planned:

- Mean absolute deviation (MAD)

  Calculate safety stock using the mean absolute deviation (MAD). The formula is safety stock = Z * 1.25 * MAD, where Z is a function of the desired service level, which is a user input.
Constraint Types

- User-defined percentage
  Calculate safety stock using the percentage you define times the average monthly demand.

- User-defined quantity
  Use a fixed safety stock quantity you define.

Safety stock quantities generated in Oracle Inventory according to effectivity dates are included in planning. Instead of manually changing the user-defined safety stock quantity each time a change is needed, you can now set effectivity dates for when a change in quantity takes place.

Order Modifiers
Order sizing is a set of item attributes that allow you to control the recommended order quantities for planned orders. The planning process creates planned orders using basic lot-for-lot sizing logic.

---

**Note:** The planning process ignores order modifiers for items that have a phantom supply type.

---

**Note:** Order modifiers for supplied items may be defined by their suppliers.

For additional information, please refer to Items, General Planning Attribute Group and MPS/MRP Planning Attribute Group in the Oracle Inventory User’s Guide.

**Fixed Order Quantity** The planning process places one or more orders for the user-defined quantity or repetitive rate.

- For discretely planned items, when the requirement for a given date exceeds the fixed order quantity, place multiple orders.

- For repetitively planned items, either recommend a rate equal to the fixed order quantity or a rate of zero.

**Fixed Lot Multiple** The planning process places single orders in quantities that are multiples of the user-defined quantity or rate.

For example, when the fixed lot multiple quantity is 100 and the requirement equals 110 units, place a single order for 200 units.
Minimum and Maximum Order Quantity  The planning process places one or more orders for at least the minimum quantity, but no greater than the maximum quantity. For discretely planned items, when the requirement for a given date exceeds the maximum order quantity, the planning process places multiple orders.

Fixed Days Supply  The planning process places single orders for the quantity that covers the requirements for the user-defined number of days. When suggesting planned orders, the planning process looks forward this many days and accumulates all of the demand in that time period. It then suggests a planned order to satisfy the total quantity required for that time period.

Rounding Order Quantities  You can define, for each inventory item, whether the planning process should round order quantities when the actual order quantity is calculated as a fraction. If you choose to round, order quantities are rounded to the next highest whole number.

---

Note:  By rounding up, the planning process may suggest a planned order for more than what is actually needed. This extra quantity is carried over into the next period as supply.

Manufacturing Resources

Routings
You can set effective dates for routings. If components and resources are not available to build from the primary routing, alternate routings or alternate resources may be used. You can define different routings with varying priorities. You can associate a BOM with routings. You can also define the cost of using a routing.

For more information, see “Routings” in the Oracle Bills of Material User’s Guide.

Resources
You can define alternate resources for an operation, but not for a routing. A resource for an operation can have different alternates, each with its own priority. You can specify if two resources must be used simultaneously.

For more information, see “Defining a Resource” in the Oracle Bill of Materials User’s Guide.
Workday Calendar
You define a workday calendar for one or more organizations, and assign an exception set to each calendar. For each workday calendar and exception set, you assign a list of holidays or workday exceptions. You then define shifts for your workday calendar, and assign any shift workday exceptions.

For more information, see “Defining a Workday Calendar.” in the Oracle Bill of Materials User’s Guide.

Transportation Resources
Oracle APS considers Transportation and Storage Capacity constraints to plan accurately while providing a strong Available/Capable to Deliver (ATD/CTD).

You will be able to define transportation capacity for a lane of a ship method. In addition, you will be able to define aggregate capacity for an intransit/destination warehouse or a storage location.

Sourcing Constraints/Suppliers
You can specify the time-phased capacity of individual suppliers to specific items in Oracle Purchasing. You can allocate planned orders using the constraints of the suppliers--planned orders are assigned supplier sources in respect to their capacity.
Planning uses the ranking information you specify and first attempts to source the planned orders with the primary sources. If the capacity to fulfill the demand is not available, alternative sources are used.

<table>
<thead>
<tr>
<th>Source</th>
<th>Rank</th>
<th>Percentage</th>
<th>Effective From</th>
<th>Effective To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supplier 1</td>
<td>1</td>
<td>40</td>
<td>05/15</td>
<td>12/31</td>
</tr>
<tr>
<td>Supplier 2</td>
<td>1</td>
<td>60</td>
<td>05/15</td>
<td>12/31</td>
</tr>
<tr>
<td>Supplier 3</td>
<td>2</td>
<td>100</td>
<td>05/15</td>
<td>12/31</td>
</tr>
</tbody>
</table>

Supplier capacity is specified in units per day over a designated time period. Supplier capacity accumulates if not used on a particular day. For example, if a supplier’s capacity is 100 units per day from 1/1/99 to 1/10/99 and no units are ordered from the supplier from 1/1/99 to 1/3/99, then planning considers a total of 1000 units to be available from 1/4/99 to 1/10/99. No capacity is assumed available on nonworking days based on the owning organization calendar.
Supplier capacity can vary by time period. You can specify one daily capacity for Period 1 and a different capacity for Period 2. Time periods are specified from a start date to an end date.

See Chapter 6, "Supply Chain Modeling" for more information about setting supplier capacity constraints.

**Tolerance Fences**
You can define capacity tolerance percentages that can vary for each of your items. The tolerance fence data in Oracle Purchasing is used to adjust production according to capacity changes for item/supplier combinations when the order is placed. Tolerance fence values can be specified for the capacity fluctuation allowed for available to promise; and used to determine demand based on the amount of advanced notice given to the supplier.

See "Supply Chain Modeling" for more information about setting tolerance fences.

**Demands**
You can specify priority rules by ordering demands. Scheduling is performed on a demand by demand basis.
Enabling and Disabling Constraints

To enable and disable constraints:
1. From the Navigator, select Supply Chain Plan > Options. The Plan Options window appears.
2. Select the Constraints tab.

Figure 11–1 The Constraints Tab in the Plan Options window

3. Using the drop-down menus, set Resource or Material Constraints to Yes or No based on your business requirements.

Note: To generate exception messages related to material resource capacity, you must select the Constrained Plan checkbox.
Enabling and Disabling Constraints

For more information on setting constraints prior to launching plans, see "Defining Plans."

---

**Note:** You cannot update the Start Date and End Date. The End Date is calculated based on your time bucket settings.

---

### Setting Hard and Soft Constraints

Oracle ASCP lets you prioritize how you enforce Capacity Constraints or Demand Due Dates. Whichever constraint takes precedence over the other is the hard constraint; the other is the soft constraint. If you choose to enforce Demand Due Dates (setting Demand Due Dates as a hard constraint), then resources are used and possibly overloaded to satisfy demand due dates. In this case, Oracle ASCP returns overloaded exception messages.

If you choose to enforce Capacity Constraints (setting Capacity Constraints as a hard constraint), then resources are loaded to their limit to satisfy demand (if required). Unsatisfied demand are pushed to future. In this case, Oracle ASCP returns late replenishment exception messages.

---

**Note:** You must choose one and only one type of constraint.

---

**To set hard and soft constraints:**

1. From the Navigator, select Supply Chain Plan > Options.
   The Plan options window appears.
2. Select the Constraints tab.
3. Check either the Enforce Demand Due Dates or the Enforce Capacity Constraints check box. The selected check box represents a hard constraint while the unselected check box represents a soft constraint.
## Setting Constraints for Different Plan Types

The following table describes the requirements for setting constraints for various types of plans:

<table>
<thead>
<tr>
<th>Plan Type</th>
<th>Constraints Tab</th>
<th>Optimization Tab</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unconstrained</td>
<td>Constrained Plan checkbox is unchecked.</td>
<td>Optimize checkbox is unchecked.</td>
</tr>
<tr>
<td></td>
<td>Enforce Demand Due Dates checkbox is checked.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Resource Constraint and Material Constraint fields are set to No.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Calculate Resource Requirements can be checked to calculate capacity even for unconstrained plans.</td>
<td></td>
</tr>
<tr>
<td>Material Constrained</td>
<td>Constrained Plan checkbox is checked. Constrained Plan checkbox is checked.</td>
<td>Optimize checkbox is unchecked.</td>
</tr>
<tr>
<td></td>
<td>Check either Enforce Demand Due Dates or Enforce Capacity Constraints checkbox.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can check only one checkbox.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Resource Constraint fields are set to No; Material Constraint fields are set to Yes.</td>
<td></td>
</tr>
<tr>
<td>Resource Constrained</td>
<td>Constrained Plan checkbox is checked. Constrained Plan checkbox is checked.</td>
<td>Optimize checkbox is unchecked.</td>
</tr>
<tr>
<td></td>
<td>Check either Enforce Demand Due Dates or Enforce Capacity Constraints checkbox.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can check only one checkbox.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Resource Constraint field set to Yes; Material Constraint fields are set to No.</td>
<td></td>
</tr>
<tr>
<td>Material and Resource</td>
<td>Constrained Plan checkbox is checked. Constrained Plan checkbox is checked.</td>
<td>Optimize checkbox is unchecked.</td>
</tr>
<tr>
<td>Constrained</td>
<td>Check either Enforce Demand Due Dates or Enforce Capacity Constraints checkbox.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can check only one checkbox.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Resource Constraint and Material Constraint fields are set to Yes.</td>
<td></td>
</tr>
</tbody>
</table>
### Setting Constraints for Different Plan Types

<table>
<thead>
<tr>
<th>Plan Type</th>
<th>Constraints Tab</th>
<th>Optimization Tab</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optimized</td>
<td>Constrained Plan check box is checked. Depending on your hard and soft constraint requirements, check either Enforce Demand Due Dates or Enforce Capacity Constraints check box. <strong>Note:</strong> You can check only one check box. Either or both Resource Constraint Material Constraint fields are set to Yes.</td>
<td>Optimize check box is checked.</td>
</tr>
</tbody>
</table>

For additional information on setting constraints, please refer to Chapter 5, “Defining Plans” and Chapter 6, “Supply Chain Modeling.”
Rules Used in Constrained Plans

There are two types of constrained plans; one that uses the User Defined Decision Rules and one that does not. This is determined by the setting for the profile option MSO: Enable Decision Rules. If it is set to No (the default), then when running a constrained but not optimized plan, the following rules are used:

- Demand Priorities are respected

**Note:** When Demand Priorities are not specified, the default priorities of the various demand types are (in order): sales order, forecast, and safety stock.

- Alternate BOMs will not be considered
- Alternate routings will not be considered
- Substitute items will not be considered

If MSO: Enable Decision Rules is set to Yes, then when running a constrained but not optimized plan, the following rules are used:

- Demand Priorities are respected

**Note:** When Demand Priorities are not specified, the default priorities of the various demand types are (in order): sales order, forecast, and safety stock.

- Alternate BOMs are considered
- Alternate routings are considered
- Substitute items are considered

For additional information, please refer to User-Defined Alternate Decision Rules on page 18-69.

Look-Ahead Heuristic

This product contains a new heuristic for scheduling in ASCP. You can now choose between using the existing or the new heuristic using the profile option [lookup]. The existing heuristic schedules are based on demand priority. Scheduling supplies based on the demand priority the supply is pegged to, can sometimes lead to work
being scheduled in an undesirable way. You may find that lower priority demands are scheduled ahead of higher priority demand depending on the resource availability profile and the demand due dates.

With the new heuristic, you can schedule the supplies in a way that avoids working on lower priority demands ahead of higher priority demands. The way the schedules are generated depends on the number of demands being considered for scheduling at a time. You can specify the number of demands considered for scheduling at a time via a system level profile option: MSO:maximum demands per group.

The new look-ahead heuristic tries to predict some of the demands earlier than their actual due dates in order to accommodate the higher priority demands that are due later. By scheduling the demands with a higher priority earlier, the problem of having resources assigned to low priority demands before high priority demands come due is avoided.

You can evaluate the number of demands specified in the profile option. You can schedule the lowest priority demand on time and adjust the rest of the demands behind the lowest priority demand. This happens provided you have enough resources to schedule all the demands based on backward scheduling. If you do not have enough resources to handle all the demands in the backward scheduling phase, you can forward schedule the demands starting with the highest priority demand.

**Flexible Shift Times**

This feature enables planners to plan resource shift start and end times at any minute within the hour. This feature enables ASCP to handle aggregate planning and detailed scheduling concurrently and to accurately schedule resources down to the minute time level.

For the portion of the planning horizon that is planned at greater than minute-level granularity (the portion that is planned at the hour, day, week or period levels), ASCP factors in break periods by extending operation times to reflect the proportion of breaks within each planning time bucket. For example, a 2-hour operation that occurs during a day-level planning bucket that has breaks at 4:00-5:00, 12:00-13:00 and 20:00-21:00 would be stretched into a \( \frac{2}{21/24} = 2.29 \) -hour operation. The exact timing of breaks within this day-level planning bucket is ignored. This solution maintains as much scheduling accuracy as possible when more aggregate (time-bucketed) planning is being done.
Example 1: Planning Time Bucket Size = 1 Hour
Consider a one-hour portion of the planning horizon (1:00 - 2:00). Within this period there is a resource break of 15 minutes (1:30-1:45). The size of the planning time bucket is 1 hour.

ASCP calculates an elongation factor for this period that is equal to the ratio of working time within the period to the total duration of the period.

Elongation factor = \( \frac{60 - 15}{60} = 0.75 \)

If there is a resource requirement of 18 minutes, due at 2:00, by using the elongation factor, the requirement duration is calculated to be:

Requirement duration = \( \frac{18}{0.75} = 24 \) minutes

The requirement start time is therefore set to requirement end time (2:00) minus 24 minutes:

Requirement start time = 1:36

The following figure is an example of how a resource break is scheduled for when the planning time bucket size is one hour:

**Figure 11–3  One Hour Planning Time Bucket Size**

Note that the requirement is scheduled to start in the middle of the resource break; the exact timing of the resource break is ignored. This is an approximation that ASCP makes in any time bucket of size 1 hour or more. It allows for as much scheduling accuracy as possible while planning at more aggregate time levels.

Example 2: Planning Time Bucket Size = 1 Minute
Consider the same one-hour portion of the planning horizon (1:00 - 2:00), with the same resource break of 15 minutes (1:30-1:45). In this example, the size of the planning time bucket is 1 minute (the smallest permitted by ASCP).
Once again there is a resource requirement of 18 minutes, due at 2:00.

Since this is the minute-by-minute detailed scheduling portion of the plan horizon, break start and end times are accounted for down to the nearest minute. An elongation factor is not used.

The requirement start time is calculated to be:

\[ \text{Requirement start time} = 1:27 \]

The following figure is an example of how a resource break is scheduled for when the planning time bucket size is one minute:

**Figure 11-4  One Minute Planning Time Bucket Size**

![Diagram showing one minute planning time bucket size]

This allows for 3 of the 18 minutes of work to be done before the break (1:27 to 1:30), then the remaining 15 minutes of work to be done after the break (1:45 to 2:00). No work is scheduled during the break.

The above two examples demonstrate the contrast in the level of detail of scheduling that occurs in aggregate (greater than one minute duration) time buckets versus detailed (one minute duration) time buckets.

**Partial Demand Satisfaction**

When multiple planned order supplies are required to satisfy a demand, ASCP schedules all supplies that can be completed by the due date for the due date, and the remaining supplies for the demand satisfied date.

This allows the supplies that can be completed on time to be released, executed, and shipped as a partial order shipment to the customer.

The Partial Demand Satisfaction capability applies only to the end demand (independent demand). For the dependent demand, it is not cost effective and beneficial to complete part of the order quantity and then carry this inventory up to the time when it is needed.
To establish Partial Demand Satisfaction functionality:
1. Set Partial Demand Completion Profile Option.
   a. Sign in as System Administrator.
   b. From the Navigator, choose Profile > System.
      The Find System Profile Values screen appears.
   c. Enter your search criteria and select the Find button.
      The System Profile Values screen appears.

Figure 11–5 System Profile Values

Set the MSO: Allow Partial Demand Completion profile option to any of the following values:

- All End Demands
- Sales Orders Only
- None

The default value for this profile option is All End Demands.
Example
In this example, there is a sales order SO1 for 150 with a due date on day 10. There are two planned orders P1 and P2 satisfying this sales order demand. This is shown in the following diagram:

*Figure 11–6  Partial Demand Satisfaction*

The planned order P2 can be completed on time; however, the planned order S1 can be completed only by day 12.

Without the Partial Demand Satisfaction enhancement, ASCP would have scheduled both P and P2 to complete on day 12.

Using the Partial Demand Satisfaction feature, P2 is scheduled to complete on time (on day 10), while P1 remains scheduled for day 12. This permits P2 to be released, executed and shipped in time to partially satisfy customer demand on time.

In the Exception Details form (Supply Chain Plan > Workbench > Actions tab > drill down on an Action Type), the column named Quantity Satisfied By Due Date is used to present the portion of a demand that can be satisfied by the due date.
Phantom Routings

In order to run constrained plans in ASCP, you must set the BOM parameter Use Phantom Routings to No.

**To set the BOM parameter Use Phantom Routings to No:**

1. Sign in using the Manufacturing and Distribution Manager responsibility.
2. Select Bills of Materials > Setup > Parameters.
   The Parameters screen opens.
3. Uncheck the Use Phantom Routings checkbox.

Planning Time Fence

This feature reduces short-term fluctuations in the plan output. The planning time fence (PTF) helps Oracle ASCP generate a stable supply chain plan for manufacturing shops and helps companies to honor contractual commitments with external suppliers. PTF is a time parameter associated with an organization-item. The functionality associated with PTF can be summarized as follows:
Oracle ASCP does not create any new planned orders with start dates within PTF.

Oracle ASCP does not Reschedule In any orders into the PTF.

Orders within PTF are Rescheduled Out based on a profile option setting.

Oracle ASCP does not suggest any changes for firm orders and orders pegged to firm orders.

Excess and Shortage exceptions are generated within the time fence.

If you select the Enforce Demand Due Dates option, Oracle ASCP can violate the PTF.

When determining whether a supply is inside the PTF, ASCP uses the criteria in the following table:

<table>
<thead>
<tr>
<th>For this type of order</th>
<th>a supply is inside the PTF if...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make planned orders</td>
<td>the start date of the first resource sequence within the first operation sequence is less than or equal to the PTF</td>
</tr>
<tr>
<td>Buy planned orders</td>
<td>the dock date is less than or equal to the PTF</td>
</tr>
<tr>
<td>Transfer planned orders</td>
<td>the dock date is less than or equal to the PTF</td>
</tr>
<tr>
<td>Purchase planned orders</td>
<td>the dock date is less than or equal to the PTF</td>
</tr>
<tr>
<td>External requisitions</td>
<td>the dock date is less than or equal to the PTF</td>
</tr>
<tr>
<td>Internal requisitions</td>
<td>the start date is less than or equal to the PTF</td>
</tr>
<tr>
<td>Flow schedules</td>
<td>the start date less than or equal to the PTF</td>
</tr>
</tbody>
</table>

For discrete and lot-based jobs, supply is considered at the operation level. Any operation sequence with a start date less than or equal to the PTF is considered to be inside the PTF; any operations sequence with a start date greater than the PTF is considered to be outside the PTF.

**To enable PTF functionality:**

1. Sign in using the System Administrator responsibility.
2. From the Navigator, select Profile > System.
   
   The Find System Profile Values window appears.
3. Enter the name of the profile you want to find and select the Find button.
The System Profile Values window appears with the profile selected.

**Figure 11–8  System Profile Values**

4. Use the following table to establish settings for the following profile options in the System Profile Values form:

<table>
<thead>
<tr>
<th>Profile</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>MRP: Create Time Fence</td>
<td>Set this option to Yes if you need firm purchase orders or work orders to create a natural time fence. If you set this option to No, the planning engine will not create a time fence at a firm purchase order or work order. The default value for this profile option is Yes.</td>
</tr>
<tr>
<td>MRP: Firm Planned Order Time Fence</td>
<td>Set this option to Yes if you need firm planned orders to create a natural time fence. If you set this option to No, the planning engine will not create a time fence at a firm planned order. The default value for this profile option is Yes.</td>
</tr>
<tr>
<td>MRP: Firm Requisitions Within Time Fence</td>
<td>Set this option to Yes if you do not want the requisitions to be rescheduled. The default value for this profile option is No.</td>
</tr>
<tr>
<td>MSO: Firm Operations/Orders Within Time Fence</td>
<td>If you set this option to Yes, all operations of an order with start dates within the PTF will be treated as firm. Any operation with a start date outside of the PTF will not be considered as firm and can be moved. If you set this option to No, operations with start dates within the PTF can be rescheduled out (not rescheduled in). The default value for this profile option is No.</td>
</tr>
</tbody>
</table>

5. Switch responsibility to Manufacturing and Distribution Manager.
6. From the Navigator, select Inventory > Items > Master Items.
   The Master Item window appears.
7. Select the MPS/MRP Planning tab. Select the Planning Time Fence.

*Figure 11–9  The Master Item window*

8. Set the PTF item attribute.
   You can specify any number of days as the PTF. You can also select
   manufacturing lead time or total lead time as the PTF.
9. Switch responsibility to Advanced Supply Chain Planner.
10. From the Navigator, select Supply Chain Plan > Options.
11. Select your plan.
    The Plan Options window appears.
12. Select the Planning Time Fence Control checkbox to enable the PTF functionality with respect to the item-specified time fence at the plan level (see scenarios at the end of this section).

The following scenarios show how firmed supplies create a natural time fence:

**Scenario 1:**
MRP: Create Time Fence set to Yes
Planning Time Fence Control is unchecked
Firmed purchase orders and work orders create a natural time fence. The item time fence is ignored.

**Scenario 2:**
MRP: Create Time Fence set to Yes
Planning Time Fence Control is checked
Firmed purchase orders and work orders create a natural time fence. The time fence is set to the maximum of natural time fence and item time fence.

**Scenario 3:**
MRP: Create Time Fence set to No
Planning Time Fence Control is checked
Firmed purchase orders and work orders do not create a natural time fence. The time fence is set to the specified item time fence.

**Scenario 4:**
MRP: Firm Planned Order Time Fence set to Yes
Planning Time Fence Control is unchecked
Firmed planned orders create a natural time fence. The item time fence is ignored.

**Scenario 5:**
MRP: Firm Planned Order Time Fence set to Yes
Planning Time Fence Control is checked
Firmed planned orders create a natural time fence. The time fence is set to the maximum of natural time fence and item time fence.

**Scenario 6:**
MRP: Firm Planned Order Time Fence set to No
Planning Time Fence Control is checked
Firmed planned orders do not create a natural time fence. The time fence is set to the specified item time fence.

**Engineering Change Orders Use-Up Effectivity**

Engineering changes to an item or modifications to bills of material are implemented through Engineering Change Orders (ECO). These planned changes affect the dependent demand calculations and the orders rescheduled or created by the planning process. The use-up date is the date when the on-hand quantity for an item will be exhausted based on projected gross requirements and receipts. You can
plan to use up your current item before introducing engineering changes by accepting the use-up effectivity date recommended by ASCP.

When you define a revised item using an ECO, you can specify whether the planning process should recommend a suggested effective date for the revised item. If you do so, Oracle ASCP recommends a use-up date for the current item. The use-up date is calculated by applying on-hand quantity in inventory (supply) against gross requirements (demand). It is the date on which all supplies for the current item will be used up (on hand will be zero).

The ECO use-up effectivity date is calculated by adding one working day to this, as shown in the following figure.

Oracle ASCP considers scheduled receipts in the use-up date calculation if the following profile option: Include Schd Rcpts in Use-up, is set to Yes.

**To use the ECO Use–up effectivity date recommended by ASCP:**

1. Define your Engineering Change Orders. For information on how to do this, please refer to *Oracle Engineering User’s Guide*.

   When you create an ECO, by default the MRP Active Flag is already checked. If you do not want this ECO to be subject to a use-up date calculation, you can uncheck this flag.

2. Bring the ECO to your planning system by running Collections.

3. Run an ASCP plan for the items to which ECOs apply.
4. After running your plan, you can verify that the ECO has been accounted for in the planning process by selecting the item in the left pane of the Planner Workbench, then right-clicking with the mouse and selecting Items from the menu that drops down.

The Items window appears.

5. Select the Components button.

The Components window appears.

**Figure 11-11** Components window

Effectivity dates for the components appear in this window.

6. Push the plan output to the source system by running the Push Plan Information concurrent program. (Navigation: Setup > Run Requests > Single Request. Select Push Plan Information from the list of values.)

7. You can find the system recommended use-up date for the item and components by navigating to Oracle Engineering and querying up the ECO. You can see the ECO details by selecting the Revised Items button in the Engineering Change Orders window.

The Revised Items window appears.
8. You can override the recommended use-up date by manually changing the Effective Date field. You can also see use-up dates for all components, if the item is part of an assembly, and choose the use-up date of any component to be use-up date for the whole assembly.

The following table illustrates how the use-up effectivity date is established.

<table>
<thead>
<tr>
<th>Day</th>
<th>Day 1</th>
<th>Day 2</th>
<th>Day 3</th>
<th>Day 4</th>
<th>Day 5</th>
<th>Day 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gross Requirements</td>
<td>0</td>
<td>200</td>
<td>200</td>
<td>300</td>
<td>300</td>
<td>0</td>
</tr>
<tr>
<td>Projected On-Hand</td>
<td>700</td>
<td>500</td>
<td>300</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Oracle Advanced Supply Chain Planning calculates the use up date based on projected gross requirements for the item. In this example, the current on-hand quantity is exhausted on Day 4. Therefore, the planning process sets the use–up effectivity date for this item to be Day 5.
Planning in Mixed Mode Environments

Topics covered in this section include the following:

- Overview of Mixed Mode Manufacturing on page 12-2
- Common Features in Hybrid Manufacturing Environments on page 12-2
- Oracle Project Manufacturing on page 12-11
- Oracle Flow Manufacturing on page 12-22
- Oracle Process Manufacturing on page 12-26
- Oracle Shop Floor Management on page 12-36
Overview of Mixed Mode Manufacturing

Oracle ASCP supports mixed mode manufacturing which lets you plan distribution and manufacturing operations for hybrid environments. You can plan for the full range of discrete, repetitive, process, project, and flow manufacturing environments. You can also plan to make to stock, make to order, assemble to order, and configure to order products simultaneously, using a single plan across all methods. This features enables you to use the most efficient process to build each product.

Mixed mode manufacturing is supported by the following combination of Oracle Applications: Oracle BOM (for discrete manufacturing), Oracle Flow Manufacturing, Oracle Project Manufacturing, and Oracle Process Manufacturing. These serve primarily to provide process plan (routing) data to the Oracle ASCP engine. They also provide the user interfaces with which users of the different manufacturing modes view the output of the planning process.

**Note:** Repetitive manufacturing environments are supported in unconstrained planning, but not in constrained or optimized planning. For repetitive manufacturing environments that require constrained or optimized planning, it is recommended that you use flow schedules in Oracle Flow Manufacturing.

Common Features in Hybrid Manufacturing Environments

Oracle ASCP includes full support for by-products, co-products, lot expirations, and formula effectivities. For repetitive manufacturing, all features in Oracle Applications Release 10.7 and Release 11 are supported.

Phantom Routings

Phantoms are non-stocked assemblies that let you group together material needed to produce a subassembly. Oracle ASCP explodes requirements through a phantom subassembly to the components as if the components were directly tied to the parent assembly. No planned orders are generated for phantom assemblies. Routings for phantom items are used to generate resource requirements.

Phantom Routings are included for all phantom items in an organization based on the settings of the Organization level parameter use phantom routings in Oracle Bills of Material. An additional parameter inherit phantom operation sequence set at the inventory organization level in Oracle Bills of Material determines whether
components of phantom items will retain their operation sequence or inherit them from the parent.

**Note:** The combination of use phantom routings = Y and inherit phantom operation sequence = N is not supported.

The following figure and table summarize the different behavior of a phantom item and its components associated with settings of the two parameters, according to the example that follows.
Figure 12-1  Bill of Material Structure for Assembly A

![Bill of Material Structure for Assembly A]

Table 12-1

<table>
<thead>
<tr>
<th>Release</th>
<th>Use Phantom Routing</th>
<th>Inherit Phantom Op Seq</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.7</td>
<td>Yes</td>
<td>Yes</td>
<td>Not supported</td>
</tr>
<tr>
<td>10.7</td>
<td>Yes</td>
<td>No</td>
<td>Not supported</td>
</tr>
</tbody>
</table>

12-4  Oracle Advanced Planning and Scheduling Implementation and User’s Guide
### Table 12-1

<table>
<thead>
<tr>
<th>Release</th>
<th>Use Phantom Routing</th>
<th>Inherit Phantom Op Seq</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.7</td>
<td>No</td>
<td>Yes</td>
<td>Resource requirements generated for R1 and R2, but not R3 and R4. Due dates of Items E and F are calculated based on offset percentage of Op Seq 10.</td>
</tr>
<tr>
<td>10.7</td>
<td>No</td>
<td>No</td>
<td>Resource requirements generated for R1 and R2, but not R3 and R4. Due dates of Items E and F are calculated based on offset percentages of Op Seq 30 and 40, respectively.</td>
</tr>
<tr>
<td>11.0</td>
<td>Yes</td>
<td>Yes</td>
<td>Not supported</td>
</tr>
<tr>
<td>11.0</td>
<td>Yes</td>
<td>No</td>
<td>Not supported</td>
</tr>
<tr>
<td>11.0</td>
<td>No</td>
<td>Yes</td>
<td>Resource requirements generated for R1 and R2, but not R3 and R4. Due dates of Items E and F are calculated based on offset percentage of Op Seq 10.</td>
</tr>
<tr>
<td>11.0</td>
<td>No</td>
<td>No</td>
<td>Resource requirements generated for R1 and R2, but not R3 and R4. Due dates of Items E and F are calculated based on offset percentages of Op Seq 30 and 40, respectively.</td>
</tr>
<tr>
<td>11i</td>
<td>Yes</td>
<td>Yes</td>
<td>Resource requirements generated for R1, R2, R3 and R4. Due dates of Items E and F are calculated based on offset percentage of Op Seq 10.</td>
</tr>
<tr>
<td>11i</td>
<td>Yes</td>
<td>No</td>
<td>Not supported</td>
</tr>
<tr>
<td>11i</td>
<td>No</td>
<td>Yes</td>
<td>Resource requirements generated for R1 and R2, but not R3 and R4. Due dates of Items E and F are calculated based on offset percentage of Op Seq 10.</td>
</tr>
<tr>
<td>11i</td>
<td>No</td>
<td>No</td>
<td>Resource requirements generated for R1 and R2, but not R3 and R4. Due dates of Items E and F are calculated based on offset percentages of Op Seq 30 and 40, respectively.</td>
</tr>
</tbody>
</table>
Utilization Efficiency

Utilization and efficiency are incorporated into Capacity Planning with Oracle ASCP. Routings are used to generate capacity requirements for planned orders and suggested repetitive schedules by the memory-based planner. You can define utilization and efficiency on a department resource within Bills of Materials. For Flow Routings, the utilization and efficiency of individual resources used on a line in the Mixed Model Map definition are considered for determining the line rate. For repetitive schedules, it is assumed that the efficiency and utilization are factored into the user definition of line rate.

The range of values for utilization is 0.0 to 1.0. The range of values for efficiency is zero to infinity. The availability of department resources takes into account the utilization and efficiency of the resource. The net availability is calculated as follows:

Net availability = the number of hours the resource is available * utilization * efficiency.

(You can view utilization and efficiency in the Resources window in the Planner Workbench).

See also: Assigning Resources to a Department, Bills of Materials User’s Guide

Routing Effectivity

Routing Effectivity is incorporated into Capacity Planning with Oracle Planning Products.

Routings are used to generate capacity requirements for Planned Orders and Suggested Repetitive schedules by the planning engine. With the new functionality, resource requirements are generated using routings which are effective on the start date of the planned order or suggested repetitive schedule.

Each routing has an effective date and a disable date which indicates the date range for which the routing is effective. This is defined in Oracle Bills of Material. Routings are used to list the different resources which are required at each operation for an item.

See also: Creating a Routing, Oracle Bill of Material User’s Guide
Simultaneous, Aggregate, and Alternate Resources

The following new flexfields have been added in Oracle Applications to enter data for planning and scheduling. A sample implementation follows the flexfield definitions.

**Aggregate Resource for a Resource**  This is defined in the Department Resources form. It is based on the existing flexfield Aggregate Resource Id.

**Simultaneous Resource Sequence**  This is defined via a flexfield in the Operation Resources form.

**Alternate Resource for an operation**  This is defined via a flexfield in the Operation Resources form.

**Priority of Alternate Resources for an operation**  This is defined via a flexfield in the Operation Resources form.

**Priority for Substitute Items**  This is defined in the Substitute Components form.

**Cost of using Alternate BOM / Routing**  This is defined via a flexfield in the Bills of Material form.

---

**Note:** If your source is later than 11.5.3, the first four flexfields have been converted to regular fields and the names given are different. Please refer to Oracle Bill of Materials User’s Guide and Chapter 6, Supply Chain Modeling.

---

**Example**

---

**Note:** The following example assumes that you are either using 10.7 or 11.0 Oracle Applications.

- Assumption: Primary resource has a priority of 0
- Principal Flag: 1 - Yes (primary resource); 2 - No (alternate resource)
In the following table, Resources R1 and R2 are primary resources, and Resource R3 is an alternate for R1.

**Table 12–2 Scenario 1:**

<table>
<thead>
<tr>
<th>Operation Sequence</th>
<th>Resource Sequence</th>
<th>Resource</th>
<th>Flexfield</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>10</td>
<td>R1</td>
<td>Resource step number</td>
<td>10</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>R1</td>
<td>Priority/Group</td>
<td>0</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>R1</td>
<td>Principal Flag</td>
<td>1 (Yes)</td>
</tr>
<tr>
<td>10</td>
<td>20</td>
<td>R2</td>
<td>Resource step number</td>
<td>20</td>
</tr>
<tr>
<td>10</td>
<td>20</td>
<td>R2</td>
<td>Priority/Group</td>
<td>0</td>
</tr>
<tr>
<td>10</td>
<td>20</td>
<td>R2</td>
<td>Principal Flag</td>
<td>1 (Yes)</td>
</tr>
<tr>
<td>10</td>
<td>30</td>
<td>R3</td>
<td>Resource step number</td>
<td>10</td>
</tr>
<tr>
<td>10</td>
<td>30</td>
<td>R3</td>
<td>Priority/Group</td>
<td>1 (Yes)</td>
</tr>
<tr>
<td>10</td>
<td>30</td>
<td>R3</td>
<td>Principal Flag</td>
<td>1 (Yes)</td>
</tr>
</tbody>
</table>

In the following table, R1 and R2 are simultaneous, R3 and R4 are simultaneous, and (R3, R4) is an alternate for (R1, R2).

**Table 12–3 Scenario 2:**

<table>
<thead>
<tr>
<th>Operation Sequence</th>
<th>Resource Sequence</th>
<th>Resource</th>
<th>Flexfield</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>10</td>
<td>R1</td>
<td>Resource step number</td>
<td>10</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>R1</td>
<td>Priority/Group</td>
<td>0</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>R1</td>
<td>Principal Flag</td>
<td>1 (Yes)</td>
</tr>
<tr>
<td>10</td>
<td>20</td>
<td>R2</td>
<td>Resource step number</td>
<td>10</td>
</tr>
<tr>
<td>10</td>
<td>20</td>
<td>R2</td>
<td>Priority/Group</td>
<td>0</td>
</tr>
<tr>
<td>10</td>
<td>20</td>
<td>R2</td>
<td>Principal Flag</td>
<td>2 (No)</td>
</tr>
</tbody>
</table>
In the following table, R1 and R2 are simultaneous, R3 is sequential, and R4 is an alternate for R2.

**Table 12–3 Scenario 2:**

<table>
<thead>
<tr>
<th>Operation Sequence</th>
<th>Resource Sequence</th>
<th>Resource</th>
<th>Flexfield</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>30</td>
<td>R3</td>
<td>Resource step number</td>
<td>10</td>
</tr>
<tr>
<td>10</td>
<td>30</td>
<td>R3</td>
<td>Priority/Group</td>
<td>1 (Yes)</td>
</tr>
<tr>
<td>10</td>
<td>30</td>
<td>R3</td>
<td>Principal Flag</td>
<td>1 (Yes)</td>
</tr>
<tr>
<td>10</td>
<td>40</td>
<td>R4</td>
<td>Resource step number</td>
<td>10</td>
</tr>
<tr>
<td>10</td>
<td>40</td>
<td>R4</td>
<td>Priority/Group</td>
<td>1 (Yes)</td>
</tr>
<tr>
<td>10</td>
<td>40</td>
<td>R4</td>
<td>Principal Flag</td>
<td>2 (No)</td>
</tr>
</tbody>
</table>

**Table 12–4 Scenario 3**

<table>
<thead>
<tr>
<th>Operation Sequence</th>
<th>Resource Sequence</th>
<th>Resource</th>
<th>Flexfield</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>10</td>
<td>R1</td>
<td>Resource step number</td>
<td>10</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>R1</td>
<td>Priority/Group</td>
<td>0</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>R1</td>
<td>Principal Flag</td>
<td>1 (Yes)</td>
</tr>
<tr>
<td>10</td>
<td>20</td>
<td>R2</td>
<td>Resource step number</td>
<td>10</td>
</tr>
<tr>
<td>10</td>
<td>20</td>
<td>R2</td>
<td>Priority/Group</td>
<td>0</td>
</tr>
<tr>
<td>10</td>
<td>20</td>
<td>R2</td>
<td>Principal Flag</td>
<td>2 (No)</td>
</tr>
<tr>
<td>10</td>
<td>30</td>
<td>R3</td>
<td>Resource step number</td>
<td>30</td>
</tr>
<tr>
<td>10</td>
<td>30</td>
<td>R3</td>
<td>Priority/Group</td>
<td>0</td>
</tr>
<tr>
<td>10</td>
<td>30</td>
<td>R3</td>
<td>Principal Flag</td>
<td>2 (No)</td>
</tr>
<tr>
<td>10</td>
<td>40</td>
<td>R1</td>
<td>Resource step number</td>
<td>10</td>
</tr>
<tr>
<td>10</td>
<td>40</td>
<td>R1</td>
<td>Priority/Group</td>
<td>1 (Yes)</td>
</tr>
<tr>
<td>10</td>
<td>40</td>
<td>R1</td>
<td>Principal Flag</td>
<td>1 (Yes)</td>
</tr>
<tr>
<td>10</td>
<td>50</td>
<td>R4</td>
<td>Resource step number</td>
<td>10</td>
</tr>
<tr>
<td>10</td>
<td>50</td>
<td>R4</td>
<td>Priority/Group</td>
<td>1 (Yes)</td>
</tr>
<tr>
<td>10</td>
<td>50</td>
<td>R4</td>
<td>Principal Flag</td>
<td>2 (No)</td>
</tr>
</tbody>
</table>
If Resource step number is NULL, the value defaults to Resource sequence. If priority is NULL, the value defaults to the primary priority.

If your source is 11i, the following tables show you the set up required to model alternate and simultaneous resources.

In the following table, Resources R1 and R2 are primary resources, and Resource R3 is an alternate for R1.

<table>
<thead>
<tr>
<th>Table 12–5  Scenario 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
</tr>
<tr>
<td>10</td>
</tr>
</tbody>
</table>

In the following table, Resources R1 and R2 are simultaneous, R3 and R4 are simultaneous, and (R3,R4) is an alternate for (R1,R2).

<table>
<thead>
<tr>
<th>Table 12–6  Scenario 5:</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
</tr>
<tr>
<td>10</td>
</tr>
<tr>
<td>10</td>
</tr>
</tbody>
</table>

In the following table, Resources R1 and R2 are simultaneous, R3 is sequential, and R4 is an alternate for R2.

<table>
<thead>
<tr>
<th>Table 12–7  Scenario 6:</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
</tr>
<tr>
<td>10</td>
</tr>
<tr>
<td>10</td>
</tr>
</tbody>
</table>
Oracle Project Manufacturing

Oracle Project Manufacturing is designed to support companies that manufacture products for projects or contracts. It provides robust project tracking, billing, and budgeting. You can plan in a project or contract environment by segmenting all sources of supply and demand by project. This allows the planning process to identify components as shared or project specific, track existing inventories by project, and provide visibility to all supply and demand associated with the project.

Oracle Project Manufacturing also supports Seiban production. Seiban is a Japanese management practice. The word sei means production, and the word ban means number, thus implying a production number. A manufacturing plan is therefore managed by a Seiban number. All demand and supply for the manufacturing plan is associated with the Seiban number (via its project number).

Oracle Project Manufacturing is also designed for engineer-to-order (ETO) environment and an assemble-to-order environment. This enables a manufacturer to track supply and demand with a particular product, project, or customer.

Oracle ASCP supports Oracle Project Manufacturing through Project Planning. With Project Planning you can:

- Include project or project-task or Seiban numbers in forecast, MPS, and MDS entries.
- Load, copy or merge forecast, MPS, and MDS entries with project or project-task or Seiban numbers.
- Recognize and allocate supply according to project or project-task or Seiban numbers.
- Combine project or project-task and Seiban related supply and demand with common supply and demand in the same plan or schedule.
- Perform netting by planning groups, project or Seiban, and tasks
- Generate planned orders with project or Seiban, and task references
- Execute a plan in the Planner Workbench by planning group, project or project-task, and Seiban.
- Perform net change simulation in a project environment.
- Generate planned orders with project or project-task or Seiban.
- Implement planning suggestions by planning group, project or project-tasks, or Seiban numbers.
Oracle Project Manufacturing is integrated with Oracle ASCP. Oracle ASCP supports constraint-based supply chain planning and optimization with online simulations for Engineer-to-Order (ETO) manufacturing typical in the Aerospace and Defense Industry. It features the following:

**Hard and Soft Pegging**

The hard and soft pegging feature is fully supported by Oracle ASCP. An item’s attribute can be set to any of the following pegging levels which are elaborated below:

**Soft Pegging**

The planning process allocates supply at the project or project-task level (or Seiban) to demand at the project or project-task level (or Seiban) according to the reservation level set in the plan level options.

All reservations of supply to demand records is for a single item. Common, nonproject supply is used to satisfy project demand. For a soft pegged demand, excess project supply (or common supply) is always available for another project’s demand.

No project references are made to planned orders issued to soft pegged items.

(Choose the End Assembly/Soft Pegging option for both soft pegging and end assembly pegging. End assembly pegging traces the end assembly to which the item is pegged at the top of the bill of material.)

**Hard Pegging**

In this option, the planning process allocates supply at the project or project task level (or Seiban) to demand at the project or project task level (or Seiban), according to the reservation level set in the plan level options. Excess common supply from one project can only be shared among projects in the same planning group, if reservation level is set at planning group.

Project references are attached to planned orders for hard pegged items.

(Choose the End Assembly/Hard Pegging option for both hard pegging and end assembly pegging.)
Common Supply Netting

The new netting logic for Project Planning also takes into account excess common supply for project demand for hard pegged items. This netting logic is available only if the reservation level option for the plan is set to Planning Group.

For the above, you can generate a graphical pegging display. If none is used for pegging, project material allocation, end assembly pegging, and graphics are disabled.

Supply Chain Project Planning with Hard Pegging

In situations where projects are executed across multiple organizations, Oracle ASCP provides you with the same useful features for managing demand and supply across multiple organizations in the supply chain.

It uses similar logic as Project Manufacturing planning to plan projects in multiple organizations and ensures that the project information is permeated to all organizations in the Supply Chain. Supply for a project belonging to multiple organizations can be netted against the demand for the same project in a single planning run.

Project Supply Chain Planning provides you with a visibility across the entire supply chain. You can use the same features to obtain project specific information from the Planner Workbench.

---

**Note:** The project control level for all project manufacturing organizations must be the same for all organizations in the supply chain project planning scenario.

---

Group Netting

The netting logic can include a group of projects. Excess supply in one project can be reserved against demand for another project belonging to the same planning group. For this, set the reservation level to planning group. If reservation level is set to project then it is not group netting.

Borrow Payback

Two order types have been created in Project Planning to distinguish demand and supply resulting from a borrow/payback transaction in Project Manufacturing:

- Payback Demand
Payback Supply

You can search for borrow/payback demand/supply using these order types. You can also see these order types on the Planner Workbench.

Planner Workbench

You can view payback demand created in the borrowing project and payback supply created in the lending project for an Item in the horizontal material plan and the Supply/Demand window in the Planner Workbench.

A scheduled payback transaction is considered as a new type of supply called payback supply for the lending project and a new type of demand called payback demand for the borrowing project. The scheduled payback date is used as the supply and demand date.

In the Preferences window, you can choose to display the payback demand and payback supply for the horizontal material plan.
The supply/demand picture can be viewed. No changes are allowed here, for example rescheduling or changing the quantity.

In the enterprise view, the payback supply is in a separate column. Payback demand is included in the other independent demand column. Payback supply is included in total supply. Payback demand is included in gross requirements. In addition, payback supply is included in current schedule receipts.

**Pegging**

You can view the borrow and payback relationships in the pegging window.

Please see the *Oracle Project Manufacturing Implementation Manual* for more information on Borrow/Payback in Project MRP.
Model/Unit Effectivity (Serial Effectivity)

Oracle ASCP supports Model/Unit Effectivity.

Items
Items can be set for effectivity control method. The full pegging attribute for the item must not be set to no pegging if the item is under model effectivity control. It must be set to soft pegging or hard pegging.

Define MDS/MPS Entries by Unit Numbers
You can enter schedule entries by Model Unit Number. The unit number that you enter is validated against the master list of unit numbers that are eligible for that end item. If the item on the entry is a orderable subassembly, used in the bills of other end items, the entry can be associated with the unit numbers of its end item.

Unit Numbers in Sales Orders
You can load sales orders into a MDS, and have the unit number specified against the sales order.

Effectivity in the BOM
You can snapshot bills for items under unit effectivity in addition to those under date effectivity. The Engineering Changes Information snapshot as a part of the BOM can have the component effectivity specific to an end item unit number or a range of item unit numbers.

The snapshot tasks include end item unit number for different supply and demand entities used in the planner.

Generating Planned Orders
You can net all supply for a End Item Unit number to the demand for the end item. Oracle ASCP generates planned orders with Unit Number specified on them. Demand for components can be created with model/unit number effectivity in addition to components with date effectivity. Oracle ASCP does not generate suggested repetitive schedules with Unit Number specified on them.

Planner Workbench
You can view the unit numbers of all items under unit number effectivity in the demand, supply, items, end assemblies. In the Find window you can specify the unit numbers while viewing items, supply/demand or exceptions. You can enter
unit number information for new planned orders and MDS entries in the Planner Workbench. However, you cannot modify existing unit numbers tied to planned orders/MDS records from the Planner Workbench.

Figure 12–3 Supply/Demand for Unit Effective Items
Pegging
You can view the unit number information in the pegging views.

WIP Mass Load/ PO Requisitions Interface
When you implement Planned Orders in the Planner Workbench, you can pass on the unit number information to WIP and PO.

Flow Line Scheduling
You can view the unit numbers of all unscheduled orders under unit number effectivity in the Line Scheduling Workbench Unscheduled Orders window (Oracle Flow Manufacturing Workbench). When you create new schedules based on an unscheduled order unit number effectivity, the resulting flow schedule contains the unit number reference.

You can create new flow schedules under unit number effectivity and view the numbers for existing schedules in the Line Scheduling Workbench Detail window. You can create and update flow schedules under unit number effectivity using the API.

Workflow Based Project Exception Messages
Along with the other Exception Messages, Project Planning provides the following project related exception messages that can help monitor project material plans. Like other exception messages, these exception messages are also workflow enabled for better supply chain coordination. The Project Manager or Task Manager (if defined) are also be notified of these plan exceptions.

- Items with Excess inventory in a project-task: This exception message enlists all items with excess inventory in a project or project-task. This exception occurs when the projected on-hand quantity of the item in a project or project-task exceeds zero or safety stock by more than the value you entered in Excess Quantity in the exception set for the item.

- Items with Shortage in a project-task: This exception message highlights the items whose demand exceeds supply for that project or project-task. For items with a shortage in a project-task, an exception message is generated when the projected on hand quantity for an item in a project is negative or below the safety stock.

- Items allocated across project-task: This exception message indicates items where supply for one project or project-task is used to satisfy demand for another project or project-task.
Reschedule In
Reschedule Out
Cancellation

Project Planning Implementation Steps
The steps to set up, run and view a plan in a project environment are as follows.

Oracle Project Manufacturing Setup
1. Define projects and tasks directly in Oracle Project Manufacturing, manually using Entry Project, or using the Project Manufacturing Seiban Number Wizard, or define Seiban numbers in Project Manufacturing using the Seiban Number Wizard.
2. Define planning group Quick Code.
3. Associate a project/Seiban to a planning group (in the project parameters form)
Refer to the Oracle Project Manufacturing User's Guide for detailed setup instructions.

Oracle Inventory Setup
Define item pegging attributes. The following item pegging attributes can be used:

- Soft pegging, or End Assembly/Soft Pegging: In this case excess project or common supply is available to satisfy project demand of any project irrespective of plan options chosen. Planned orders do not carry project and task references.
- Hard Pegging, or End Assembly/Hard Pegging: In this case excess supply in one project can be used for demand of a different project in the same planning group if reservation is set to planning group. Excess common supply is also available for project demand only if the reservation level is planning group. Planned orders carry project and task references as defined by the hard pegging level plan option.
- None: Disables project material allocation. Also, planned orders do not carry any project or task reference irrespective of the hard pegging level plan option.

Refer to Oracle Inventory User’s Guide for detailed setup instructions.
Oracle ASCP Setup

1. Define Plan Options by choosing Tools > Pegging.
2. Complete the following options in the Pegging window.

Table 12–8

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reservation Level</td>
<td>This option determines the method of pre-allocation of project supply to project demand. You can choose to reserve based on:</td>
</tr>
<tr>
<td></td>
<td>Planning Group</td>
</tr>
<tr>
<td></td>
<td>In this case the plan reserves project-specific supply at the planning group level. Excess supply in one project can be reserved against demand for another project belonging to the same planning group. Excess common supply is also allocated to project demand.</td>
</tr>
<tr>
<td></td>
<td>Project</td>
</tr>
<tr>
<td></td>
<td>In this case, project specific supply is used for demand specific to that project only. This allows cross-allocation across tasks within the same project.</td>
</tr>
<tr>
<td></td>
<td>Task</td>
</tr>
<tr>
<td></td>
<td>This reserves supply for a project-task against demand for the same project-task only. No cross-allocation of material belonging to the same project but different tasks is allowed.</td>
</tr>
<tr>
<td></td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>This is a nonproject plan.</td>
</tr>
<tr>
<td>Hard pegging level</td>
<td>This option determines if the project or project-task references will be added to planned orders. This is applicable to hard pegged items only for which the pegging attribute must be hard pegging or End Assembly/ Hard Pegging. For soft pegged items, no project references are associated. These work independent of the reservation level options.</td>
</tr>
</tbody>
</table>
3. Launch a plan.
Refer to Defining Plans (see Chapter 5) for more information on defining plan options and launching plans.

**Project Planning Logic**

Refer to the *Oracle Project Manufacturing Implementation Manual* for Project planning logic. Netting Logic with examples of hard pegging with common supply netting and the pegging logic is explained here.

---

**Note:** Order modifiers are applied before project netting calculations.
Viewing the Plan

The plan can be viewed from the Planner Workbench. You can view planning information by project and implement manufacturing plans in the workbench by project.

Use the Supply, Demand or Supply/Demand window of the Planner Workbench to view information about the plan’s supply and demand. Planning Group, Project Number and/or Task Number may be used as the search criteria.

You could also use customizable folders in the Supply, Demand or Supply/Demand screens to query planning information for a particular project or project-task.

The Horizontal Plan and Enterprise View windows enable you to view supply and demand information by Planning Group, Project, and Project-Task. You can also choose to see the planning status of all the material or only common material in these forms.

The Planner Workbench also generates Reschedule In, Reschedule Out and Cancel action messages for project supply. It follows the current Planning Time Fence and Acceptable Days Early logic to generate these messages.

Oracle Flow Manufacturing

Oracle Flow Manufacturing is a demand driven production system with balanced production lines and processes designed to produce a constantly changing mix of products at a steady rate. Flow manufacturing uses schedules for mixed model production instead of work orders to drive production. The mixed model schedules are sequenced based on scheduling rules and material is replenished, or pulled through the sequence, using kanbans.

This is in contrast to a traditional discrete environment where the Master Production Schedule and MRP are used to explode requirements and create planned orders that are converted into purchase orders and work orders. There are some cases in which Oracle ASCP may be used effectively. For example - you have a seasonal business, and you use Oracle ASCP to create planned orders during your slow period to build up inventory to satisfy your peaks in demand. In these cases, planned orders may be converted into flow schedules.

When there is a hybrid of manufacturing methods, for example if a flow manufacturing system feeds to a discrete manufacturing plant, Oracle ASCP may be used effectively, because Oracle ASCP can consider a flow schedule as a supply.
Oracle ASCP continues to support features in Oracle Flow Applications Release 11.0.

Supply Chain Synchronization
Oracle ASCP can improve supply-chain throughput and reduce inventories by improving synchronization of operations between facilities. In turn, Oracle Flow Manufacturing increases manufacturing plant throughput by dramatically decreasing manufacturing times and removing in-process and finished goods inventory.

Support for Flow Schedules
If you specify line capacity, Oracle ASCP can constrain by that capacity to create plans. If demand is more than what can be manufactured, then Oracle ASCP creates a plan considering the constraints. These planned orders may be converted into flow schedules.

---

**Note:** You need to run the Push Plan Information concurrent program to see planned orders as valid inputs for flow schedules.

---

Oracle ASCP includes flow schedules to be considered as supplies.

The processes to define, implement, and maintain Oracle Flow Manufacturing are:

- Demand Management
- Line Design & Balancing
- Line Scheduling & Sequencing
- Production Execution
- Kanban Planning and Execution

Planning plays an important part in the design phase of an Oracle Flow Manufacturing implementation. The forecast, MDS, and/or MPS that are established are only used for planning purposes for line design and kanban sizing as described below. External to the enterprise, the forecasts are communicated with suppliers so that they may, in turn, plan their operations.
Demand Management

Oracle Flow Manufacturing forecast tools, Master Demand Schedules, and Master Production Schedules with Oracle ASCP are used for managing demand. Similar products are grouped into families to allow for planning at an aggregate level. The creation of forecasts, MDS/MPS are used for line design and kanban planning. If you are not building directly to customer demand, Oracle Flow Manufacturing can create schedules from the planned orders generated by the above tools.

The following planning capabilities need to be set up: Forecasting & Master Demand Schedules. Oracle Flow Manufacturing uses the Demand Management tools provided in Oracle MPS/MRP or Oracle ASCP to plan production volumes.

See also: Demand Management, Oracle Flow Manufacturing Implementation Manual

Line Design and Balancing

Line Design includes grouping products into product families, defining the processes, and events required to produce each product, and re-grouping events into line operations to approximate TAKT time (German for target cycle time). The statement of demand established in Demand Management, whether it is from a forecast, MDS, or MPS, is critical to the line design function. The demand sets the upper limit of production capacity and becomes the basis for balancing procedures.


Kanban Planning and Execution

Generally the same forecast, MDS, or MPS that is used to design a mixed model production line is also used for kanban planning. The derived demand of components is used to establish size requirements. Oracle ASCP uses the snapshot of inventory for on-hand quantity and safety stock.

Product Families

Flow uses product families to plan at an aggregate level. Oracle ASCP supports product family items. You can define different planning horizons for product families or item level. Resources can be planned at the product family level.

Oracle Process Manufacturing

The Oracle Process Manufacturing (OPM) user is fully integrated with Oracle ASCP and can plan based on plan objectives and use the materials and resources optimally. There is no need to execute OPM P/MRP.

Oracle ASCP provides an integrated plan for multiple modes of process manufacturing including batch, continuous, and packaging operations. It incorporates a formula-based, process unique requirements including co-products, and scaling.

The data used to plan materials and capacity exists in the OPM schema. This data is used by the Oracle ASCP Planning Server. Oracle ASCP uses Inventory, Production, Formula, Planning, and Sales data from OPM and purchasing data from Oracle Applications. The user can run multiple plans and manage materials and resources. Once satisfied with the plan, it can be executed in the Production Module.

The following changes have been made to the existing methodology:

- No need to execute OPM P/MRP
- Outside vendor for finite scheduling no longer needed
- All Planning Activities can be on a Separate Server
- Plans are no longer restricted to material planning
- OPM structure mimics Apps Organization Structure

OPM Data for Oracle ASCP

Merged Organization Structure

The OPM structure merges with the Oracle Applications structure, as shown.
Oracle Process Manufacturing

Figure 12-5  OPM and Oracle Applications Structures

OPM production batches and planning functions occur at the plant level. These are merged to production and planning data at the inventory organization level.

OPM demand is placed at the warehouse level and planning can occur at this level as well. These are merged to the inventory organization level.

OPM on-hand balances are stored at the warehouse or location level. Stock allocation and nettability takes place at the warehouse level. These are merged to the sub-inventory level of Oracle Applications.

The above data and transactions can also occur at the location level in OPM. The corresponding level in Oracle Applications is the locator level, but Oracle ASCP plans at the subinventory level. All OPM location data therefore must be merged into the warehouse and mapped at the sub-inventory level.
Differences Between Production in OPM and Oracle Applications

In Oracle Applications, at the Inventory Organization level, site locations are used for vendors and customers, and departments are used to control resources. In OPM, the resources are defined at the plant level.

A work order (a WIP job, in Oracle Applications) is roughly equal to a production batch in OPM. Both work orders and production batches consume resources. In Oracle Applications, a work order (created at the inventory organization level) can only draw from resources available in the inventory organization for which the work order was created. In OPM, a batch may only access resources for the plant.

Plant warehouse effectivities in OPM allow a production batch to draw from materials available outside the plant (WIP Warehouse) in which the production batch was created. OPM also lets you specify the warehouses from which to pull inventory to complete a production batch. You can define multiple allocation parameters for an item. This allows you to allocate inventory from multiple warehouses.

In Oracle ASCP, the ingredients for a batch must come from a single warehouse. OPM works around this issue by using the work-in-process warehouse or the resource warehouse, if available, as the single source of ingredient inventory when the batch has multiple sources or destinations. The work-in-process warehouse or the resource warehouse shows Oracle ASCP from where to allocate inventory.

Recommended OPM Organization Structure for Oracle ASCP

The following OPM organization structure is recommended in order for OPM data to smoothly merge with Oracle ASCP. Navigation paths are included:

- Each OPM production plant has only one associated warehouse called the Resource Warehouse. Production is assumed to take place in that warehouse. (For additional details, see Organizations Field Reference in the OPM System Administration User’s Guide. The navigation path to the screen in the OPM application is OPM > System Administration > Organizations > Resource Warehouse Field)

- There can be only one warehouse per plant. (For additional details, see Organizations Field Reference in the OPM System Administration User’s Guide. The navigation path to the screen in the OPM application is OPM > System Administration > Organizations > Resource Warehouse Field)

- Multiple production plants can draw raw material inventory from common warehouses to meet their production demand. (For additional details see Setting Up Plant Warehouse Relationships in the Oracle Process Manufacturing...
Multiple production plants can supply common warehouses (distribution center). (For additional details see Setting Up Plant Warehouse Relationships in the Oracle Process Manufacturing MPS/MRP and Forecasting User’s Guide. The navigation path to the screen in the OPM application is OPM > Planning > MPS > Setup > Plant Warehouse)

- Each OPM warehouse must have a corresponding inventory organization in Oracle Applications. (For additional details, see Organizations Field Reference in the OPM System Administration User’s Guide. The navigation path to the screen in the OPM application is OPM > System Administration > HR Organizations)

- If multiple production plants use the same warehouse as their raw material inventory source, then the production for these plants should be planned together.

**Merging Effectivities, Formulas, and Routings**

Oracle ASCP expects organization-specific formulas and routings.

Oracle ASCP includes the following OPM functionality:

- Effectivities
- Scaling
- One-level circular references

One-level circular references allow the definition of formulas that have a product or by-product listed as an ingredient in the same formula. For example, when making sourdough bread, you save a small portion of the dough to use as a starter for the next batch. Therefore, when defining a sourdough bread formula, the dough is a product, but it is also an ingredient.

**Creating a Resource Warehouse**

In Oracle ASCP, capacity planning occurs at the inventory organization, department, or resource level. OPM needs to perform capacity planning at the plant level. To bridge this gap between OPM and Oracle ASCP, one warehouse is defined for each production plant that requires capacity planning. These warehouses are called Resource Warehouses. Oracle ASCP recognizes Resource Warehouses as production facilities that require capacity planning.
To create a resource warehouse:
Use the following navigation path in the OPM application:

1. OPM > Planning > MPS > Setup > Plant Warehouse. For additional details, please refer to Setting Up Plant Warehouse Relationships in the Oracle Process Manufacturing MPS/MRP and Forecasting User’s Guide.

2. OPM > System Administration > Organizations. For additional details, please refer to Organizations in the OPM System Administration User’s Guide.

Unit of Measure
You can define item units of measure in OPM that are four characters long, but the value will be truncated to three characters once the unit of measure is copied into Oracle Applications. You can automatically convert UOMs from OPM to Applications.

This also applies for OPM organizations where OPM allows four characters and Applications allows three characters.

(For additional information, please refer to Editing Units of Measure in OPM System Administration User’s Guide. The navigation path to the screen in the OPM application is OPM > System Administration > Units of Measure).

Setting Up and Using OPM Data
The OPM data that must be set up are:

- OPM organizations & warehouses
- OPM items, Unit of Measure, and conversions
- Effectivities, formulas and routings
- Resources
- MPS Schedules for Oracle ASCP
- Plant warehouse effectivities
- Batches, FPOs, sales orders, forecasts, and on-hand inventory

For detailed instructions on setting up OPM data refer to the Oracle Process Manufacturing User’s Guide.

Besides the points stated in the previous section, some of the other areas which link to Oracle ASCP are described below.
**OPM Organizations**

If you plan to use the capacity planning function in Oracle ASCP, each OPM production plant must own one resource warehouse.

**Effectivity, Formulas and Routings**

**Effectivity**  OPM uses global effectivities by organization, as opposed to effectivities for a specific plant or resource warehouse. An organization’s effectivities then apply to all plants and warehouses associated with that organization.

The following effectivity functions can be used with Oracle ASCP: min and max quantities, start and end effective dates, formula and routing assignments, and preferences.

(For additional information, please refer to Editing Recipe Validity Rules in the *Oracle Process Manufacturing New Product Development User's Guide*. The navigation path to the screen in the OPM application is OPM > Development > Formula Management > Effectivities.)

**Formula**  Oracle ASCP can accept one product per formula. If an OPM formula has multiple effectivities for a product or for co-products, a different formula is effectively viewed by Oracle ASCP. Oracle ASCP expects one product per bill of material (in our case, a formula) and this causes the co-products and byproducts to be reported as components with negative quantities. Also, linear and fixed scaling is implementable.

(For additional information, please refer to Entering Formula Details in the *Oracle Process Manufacturing New Product Development User's Guide*. The navigation path to the screen in the OPM application is OPM > Development > Formula Management > Formulas.)

**Routings**  The routing/formula combination must be unique. The routing quantity uses the base UOM of the effectivities product. An OPM step is equivalent to an Operation. An OPM activity is equivalent to an Operation Resource Sequence. A routing resource is equivalent to an Operation Resource.

With OPM CRP, you have the option of using alternate resources. Resources are assigned a Plan Type indicating primary (1), auxiliary (2), or secondary (0) on the Operations form. In Oracle ASCP, only the primary and auxiliary resources are used. Secondary resources are ignored.

Oracle ASCP uses resource count and usage quantity information. You record resource count and usage quantity information in the Operations form. For
example, if two identical blenders are used for mixing, enter 2 in the Count field. If the resource can mix 200 gallons per hour, enter 200 in the Process Quantity field and 1 in the Usage Quantity field.

Oracle ASCP enables you to use more than one resource at the same time during an operation, but you can not complete more than one operation in a routing at the same time. Oracle ASCP enables you to overlap an operation with another operation, but this restricts OPM’s functionality of allowing concurrent operations and multiple dependent operations. Concurrent operations are not allowed with Oracle ASCP.

(For additional information, please refer to Understanding Routings in the Oracle Process Manufacturing New Product Development User’s Guide. The navigation path to the screen in the OPM application is OPM > Development > Formula Management > Routings.)

**Resources**

When you complete the Resource Information form, you define a relationship between a plant and the resource. Because Oracle ASCP acknowledges the plant via the resource warehouse associated with the plant, Oracle ASCP views the resource as having a relationship with a resource warehouse instead of with a plant. Because a resource warehouse is mapped to a department in an inventory organization in Oracle Applications, the resource is essentially mapped to a department in an inventory organization via the plant resource form.

You can use Oracle ASCP to develop capacity plans for your resources. The resource warehouse for the plant indicates to Oracle ASCP the need to perform capacity planning. The Oracle ASCP capacity planning function assumes that all resource capacity is measured in hours. The Assigned Quantity field (the navigation path to this screen in the OPM application is OPM > Planning > Capacity Planning > Setup > Plant Resources) indicates the number/quantity of the resource used in the specified plant for which you are defining production costs and usage availability. The number you enter depends on how broad a resource categorization you are defining. For example, if you defined the resource as Blender 1 (a specific machine) you would enter 1. If you use three blenders in the production line, and you defined the resource as Blenders (rather than defining each individual machine) enter 3.

The cost of using a resource for one unit of measure (for example, the cost of running a mixer for one hour) that you define in OPM Cost Management is also used by Oracle ASCP, but this cost must be recorded in the nominal cost value for the resource. Oracle ASCP assumes the unit of measure for all resources is an hour.
To set capacity planning, from the Navigator, choose Capacity Planning > Setup > Resources.

Plant/Warehouse Relationships

Plant warehouse effectivities are also known as plant/warehouse relationships. Plant warehouse effectivities specify the warehouses from which a plant consumes each item when it is used as an ingredient in a batch. They also specify the warehouses that a plant replenishes with each item when the item is a product of a batch.

On the Plant Warehouses form (the navigation path to this screen in the OPM application is OPM > Planning > Capacity Planning > Setup > Plant Resources), if the Warehouse Item field is left blank for a particular warehouse, then any item can be consumed from or replenished to that warehouse. This is called a global rule.

The plant warehouse effectivity item consumption and replenishment rules are enforced by Oracle ASCP for both global and warehouse items. Setting global rules increases the amount of data transferred because all warehouse item data is transferred, regardless of whether or not the warehouse items are actually consumed or replenished from the warehouse.

You can transfer items between warehouses as long as the item is defined in plant warehouse effectivities as a global or a specific rule. The consumption and replenishment indicators for the item/warehouse combination can be turned off and the item/warehouse combination can still be considered for transfers.

MPS Schedule

Integrating MPS Schedule Parameters With Oracle ASCP When you define your master production schedule (MPS) parameters, you indicate which plants are included in a schedule and select the criteria for including different sources of inventory supply and demand. The MPS schedule parameters serve the same purpose in Oracle ASCP and are used to create the Oracle ASCP master demand schedule. The Oracle ASCP master demand schedule includes all plants linked to the MPS schedule in the MPS Schedule Parameters form detail (the navigation path to this screen in the OPM application is OPM > Planning > MPS > Setup > Scheduler).

For additional details, please refer to Defining an MPS Schedule in the Oracle Process Manufacturing MPS/MRP and Forecasting User’s Guide.

The MPS schedule must have a unique, five character name. The Oracle ASCP master demand schedule name consists of the MPS schedule name and the warehouse name. For example, a MPS schedule named SCHD1 for resource
warehouse RSW1 would result in a master demand schedule named SCHD1/RSW1.

The Make to Stock field on the MPS Schedule Parameters form enables you to choose whether or not to include forecasts as a source of demand. The Make to Order field allows you to choose whether or not to include sales orders as a source of demand. The Plant Warehouses form defines the items and warehouses from which to pull the demand for each plant linked to the MPS schedule.

**Integrating Forecasts With Oracle ASCP** The setup steps necessary to use forecast consumption for Oracle ASCP are the same setup steps you must complete when using forecast consumption in OPM.

#### To use forecast consumption:

1. Create Forecast by using the following navigation path in the OPM application: OPM > Planning > Forecasting > Forecast. For additional details, please refer to Forecasting in the *Oracle Process Manufacturing MPS/MRP and Forecasting User’s Guide*.

2. Associate forecast with Schedule by using the following navigation path in the OPM application: OPM > Planning > Forecast > Schedule Association. For additional details, please refer to Forecast Schedule Association Field References in the *Oracle Process Manufacturing MPS/MRP and Forecasting User’s Guide*.

Forecast information created and linked to an MPS schedule in OPM is used by Oracle ASCP to create the master demand schedule. The forecasts used by the MPS schedule are specified on the Forecast Schedule Association form. A forecast can contain any number of items in various warehouses, but the schedule only uses those items that are valid to consume for a warehouse according to the Plant Warehouses form.

---

**Note:** Because one forecast can be used in multiple MPS schedules, be careful not to duplicate the demand for an item in a warehouse.

---

**Integrating Production Orders With Oracle ASCP** Oracle ASCP views pending OPM production orders as a source of supply and demand. Oracle ASCP can only view pending OPM production orders (firm planned orders, pending batches, and work-in-process batches) for those items that have a item/warehouse/plant relationship defined on the Plant Warehouses form.
You must turn on Production Operations Control (POC) for a plant and you must define a resource warehouse for a plant if you want to create capacity plans for the plant. Do this for the desired Organization on the OPM Organizations form. (For additional details, see Organizations in the OPM System Administration User’s Guide. The navigation path to the screen in the OPM application is OPM > System Administration > Organizations).

If POC is turned on, Oracle ASCP collects the plant’s routing and resource requirements once a batch is created and the batch information is transferred to Oracle ASCP. If a plant does not have a resource warehouse, routing and resource data is not transferred to Oracle ASCP.

The ingredients for a batch must come from a single warehouse. OPM works around this issue by using the work-in-process warehouse or the resource warehouse, if available, as the single source of ingredient inventory when the batch has multiple sources or destinations. The work-in-process warehouse or the resource warehouse shows Oracle ASCP from where to allocate inventory.

The quantity of a batch product is reported in the converted primary unit of measure of the item.

Firm planned orders are viewed by Oracle ASCP the same as batches, except the firm planned order routing and resource requirements are not considered. Routing and resource requirements are considered once a firm planned order is converted into a batch.

Production rules (defined in OPM Inventory) are not required, but they do ensure that batches created meet fixed and variable leadtime requirements.

The process of creating production batches or firm planned orders from planning suggestions remains the same, regardless of whether or not the planning suggestions was created in Oracle ASCP or OPM. Any user can create production batches or firm planned orders from Oracle ASCP planning suggestions as long as the plant is listed in their security schema.

**Integrating Onhand Inventory With Oracle ASCP** Oracle ASCP sees the on-hand inventory of item/warehouse combinations defined for the plant that is attached to the MPS schedule. If a lot has expired, Oracle ASCP does not consider the lot as available inventory. It also does not suggest that you use the available lot that is closer than the other lots to expiring. Oracle ASCP observes lot statuses and does not consider a lot for consumption unless the lot status identifies the lot as nettable.
Oracle Shop Floor Management

Oracle Shop Floor Management is a module which bridges planning and execution systems. It provides the following capabilities:

Manage Complex shop floor lot transactions
- Lot split and merge
- Update of lot name, product, routing, quantity
- Bonus lots creation

Enable dynamic routings
- Routing determined on the fly
- Routing movements enforced based on legal next operations
- Jumps allowed to any operation

Provide end-to-end genealogy of your products
- Product tracking all the way back to raw material
- Forward and backward genealogy surfing

Model and track operation yield based cost for your products.
- Operation level yields
  - Yielded cost of product
  - Cost variance at operations

Enable integration of ERP with third-party MES systems.
- Seamless integration with Oracle Applications

Co-Product modeling
- Modeling of co-products

Oracle ASCP integrates seamlessly with OSFM to provide the following capabilities:

Lot-Based Jobs

Lot-Based Jobs is an execution entity in Oracle OSFM designed to handle Lot-Based production. You can implement planned orders for items with Network Routings as Lot-Based Jobs. Follow the instructions specified in Implementing Planning
Recommendations on page 10-48 to select and release planned orders from Planner’s Work Bench. You can implement Reschedule In, Reschedule out, and Cancellation recommendations in addition to releasing the planned orders. Implementing recommendations uses a concurrent program called Import Lot Based Jobs at the source.

You can pass job name, job start and completion dates, start quantity, BOM and Routing designators, demand class, and WIP class, etc. Oracle ASCP treats Lot-Based Jobs as valid supplies in the planning engine. You can pass the demand for the components of the assembly from Lot-Based Jobs, and calculate resource requirements. You can see the results of the transactions on a Lot-Based Job; for example, Issues, Moves, Completions, etc. Oracle ASCP schedules the Lot-Based Jobs based on the availability of resources considering the current load of the shop floor. If you progress the job through move transactions at the source, the next time plan runs, Oracle ASCP schedule the rest of the operations in the network.

---

**Note:** Lot-based Jobs are referred to as Discrete Jobs in the Planner’s Work Bench

---

**Coproducts**

This feature is available with the integration of APS and Oracle Shop Floor Management (OSFM).

In some production environments, an item may turn into one or more parent items depending on the process control, test results, raw material quality, etc. Such a relationship is defined by defining coproducts. OSFM allows you to specify multiple possibilities of assemblies (parents) that may be derived from a single part.

You can set up coproducts using Oracle OSFM. To explain this with an example, consider the diagram below. A, B, and C are coproducts produced from raw material X. The figures in % are the expected mix of production of coproducts.
Coproducts Support in Planning

With APS and OSFM integration, you can calculate supply for multiple assemblies based on the demand for any one of the possible coproduct assemblies. You can generate and release planned orders for the assembly for which you realized demand. You can view coproduct supplies being generated for the rest of the items in coproduct relationship. This enables you to track the production for all the coproducts. The same applies if the planned order is converted into a lot-based job.

Oracle ASCP collection program collects the coproducts information into the planning server which is then used by the planning engine.

Referring to figure above, if you intend to produce 10 units of assembly A, you work with a supply of 20 units of X (i.e., 10/0.5) to come up with 10 units of supply for A, 6 units of supply (20 * 0.3) for assembly B, and 4 units of supply (20 * 0.2) for assembly C. The demand for item X is 20. You can consider any component level yield while passing the demand to item X. Please note that the supplies to be generated for B and C are of the type Planned order coproduct/byproduct and the supply generated for A is a planned order. In other words, you will see planned order for the item against which you realized the demand and Planned order coproduct/byproduct for other items in the coproduct list as defined in coproduct definition. Planned order coproduct/byproduct is treated as a valid supply and open for allocation for any demand for the respective items.

Note: Due to the nature of level by level and item by item planning, in some circumstances you may not be able to fully utilize the Planned order coproduct/byproduct supply.
The table below shows the supply/demand picture as a result of demand for A for 10 units as described above.

<table>
<thead>
<tr>
<th>Demand or Supply</th>
<th>Day 10</th>
<th>Day 25</th>
<th>Day 35</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand(A)</td>
<td>0</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>Supply(A)</td>
<td>0</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>Demand(B)</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Supply(B)</td>
<td>0</td>
<td>6</td>
<td>0</td>
</tr>
<tr>
<td>Demand(C)</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Supply(C)</td>
<td>0</td>
<td>4</td>
<td>0</td>
</tr>
</tbody>
</table>

The next table shows the supply/demand picture after you get independent demand of 2 units for assembly B, on Day 35.

<table>
<thead>
<tr>
<th>Demand or Supply</th>
<th>Day 10</th>
<th>Day 25</th>
<th>Day 35</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand(A)</td>
<td>0</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>Supply(A)</td>
<td>0</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>Demand(B)</td>
<td>0</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>Supply(B)</td>
<td>0</td>
<td>6</td>
<td>0</td>
</tr>
<tr>
<td>Demand(C)</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Supply(C)</td>
<td>0</td>
<td>4</td>
<td>0</td>
</tr>
</tbody>
</table>

The next table shows the supply/demand picture after you get independent demand of 10 units for assembly C on Day 10. Please note that Planned order Coproduct/Byproduct supply is not moved in or out to support demands, and Planned order Coproduct/Byproduct supply is treated as firm.

<table>
<thead>
<tr>
<th>Demand or Supply</th>
<th>Day 10</th>
<th>Day 25</th>
<th>Day 35</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand(A)</td>
<td>0</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>Supply(A)</td>
<td>25</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>Demand(B)</td>
<td>0</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>Supply(B)</td>
<td>15</td>
<td>6</td>
<td>0</td>
</tr>
</tbody>
</table>
Planned Order Released Qty. for Coproducts: Referring to the first table, if you release the planned order for assembly A, the system creates a Lot-Based Job with a quantity of 20 to account for the production of A, B, and C with material requirements of X for 20. The actual supply open for assembly A within the planning engine is 10. The next time you run the plan, Oracle ASCP snapshots a supply of 10 units for assembly A and maintains Discrete Job coproduct/byproduct supply for B and C for 6 and 4 respectively. If for some reason you do not wish to create and maintain Discrete Job coproduct/byproduct supplies, you have control over this at the Job level. The Coproducts supply flag at the Job determines if you need to create the Discrete Job coproduct/byproduct supply.

Coproducts Support in Order Promising
You can consider coproduct supplies as valid supplies for order promising as long as the demand is later than the coproduct supply date. In the example above, if you get an order for B on day 35, the coproduct supply of 6 units on day 25 should be considered as a valid supply. At the same time, if you get any orders for B or C prior to day 25, you cannot use the coproduct supplies on day 25 as valid supplies.

If you get an order for A for 15 on day 25, there are only 10 of A available. If you perform capable-to-promise, Order Promising checks the availability of X for quantity of 10 in order to come up with 5 units of supply for A. If there is enough X available, Order Promising creates 5 units of supply for A, 3 units for B, and 2 units for C.

Operation Yield
If you can attribute significant amount of materials loss to a specific production process, then identifying the process and managing the yield at an operation level is essential. Yields specified at operation sequence is often needed to calculate the amount of raw materials or sub assemblies and measure performance.

Consider a production process as described in the diagram below.

<table>
<thead>
<tr>
<th>Demand or Supply</th>
<th>Day 10</th>
<th>Day 25</th>
<th>Day 35</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand(C)</td>
<td>10</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Supply(C)</td>
<td>10</td>
<td>4</td>
<td>0</td>
</tr>
</tbody>
</table>
In order to calculate raw materials needed at the start of each operation, cumulative yields, reverse cumulative yields, and net planning percentages need to be calculated. The diagram above shows you the calculations. Cumulative Yields are shown as CY, Reverse Cumulative Yields are shown as RCY, and Net Planning Percent is shown as NPP on the diagram. Net Planning Percent is the expected percentage of the flow of materials at a given node. Cumulative yield is the multiplication of yields in the forward direction. Reverse Cumulative Yield is the multiplication of yields in the reverse direction. Please refer to the diagram above for detailed calculations.

You can specify the yields at operation sequence level in the Network Routings using Oracle OSFM. The system can automatically calculate Cumulative Yields, Reverse Cumulative Yields, and Net Planning Percentages by using Calculate Cumulative Yield from the Tools menu on Network Routing form.
**Operation Yield Support in Planning**

If you need to calculate materials needed at operation sequence 10, you need to divide the order quantity by Reverse Cumulative Yield and multiply it by Net Planning Percent at Operation sequence 10.

If you need item A at operation sequence 10, and you have an order quantity of 100, the component demand for A should be $\frac{100}{0.88\times100\%}$, which is 113.63. Oracle ASCP consumes resources at various operation sequences based on the inflated order quantity which accounts for the operation yield. In our example, resources at operation sequence 10 are scheduled for a quantity of 113.63.

If you decide to scrap or reject some of the items on a Lot-Based Job, you can apply yields for the rest of the pending operations. If you reject 20 units out of a total order of 100 at Operation sequence 20 and assume that there were no losses at operation sequence 10, you can determine the component requirements based on a quantity of 80 and the reverse cumulative yield at operation sequence 20.

If you have network routings where you have multiple nodes joining a single node, the cumulative yield calculation is based on the weighted average of the yields from the nodes that join to form a single node.

**Operation Yield Support in Order Promising**

Oracle Global Order Promising considers operation yield when calculating component and resource requirements during capable-to-promise. The calculation is the same as in ASCP.

**Network Routings**

Alternate ways of producing an item often demands flexible definition of Routings. Network Routings give you the flexibility of defining multiple manufacturing paths. Network Routings are defined using Oracle OSFM at the source. When you set up Network Routings, you can specify the estimated percentage of the orders that need to be processed on a specific path. This is called the planning percent.

**Network Routing Support in Planning**

You can collect the Network Routings into the planning server using the APS Collection program. You can snapshot the Network Routings and use them to calculate and schedule resource requirements for existing Lot-Based Jobs and planned orders when you run a plan. You can choose to schedule orders using Network Routings in three ways:

- Primary Path
- **Planned Percent**
- **Optimize**

To make your selection, navigate to Setup and use Parameters form at ASCP. You can choose the scheduling method at the organization level by setting OSFM Network Scheduling Method parameter for your organization. The following diagram shows Network Routings.

**Primary Path** As the name suggests, you can schedule orders on primary path. In this case, Oracle ASCP calculates the Reverse cumulative yields and Net Planning Percent based on the Primary path.

**Planned Percent** This method takes advantage of accumulated percentages derived from user-specified planning percentage on the Network Routing. Referring to the figure, the resource requirements at operation sequence 20 is calculated for 100* Net Planning Percent at operation sequence 20. Considering an order of 100 units, the resource requirements at operation sequence 40 is calculated for 8 units, and so on.

**Optimize** With this method, you can analyze the current conditions on the shop floor, intelligently choose alternate paths, and determine the quantity that needs to be processed on various paths. Given a specific order, you should be able schedule the order on the primary path. If you run into capacity constraints on the primary path, you should be able to schedule as much of the order as possible using the primary path and schedule the rest of the order on alternate paths. If you happen to go to an alternate path, the objective still is to get back to the primary path as soon as possible. For example, if you schedule resources at 40, you should seek the path 50, 60, 80 instead of 70, 80 or 50, 70, 80.
You can influence the decision of using alternate paths as opposed to primary path or vice versa using system level profile options. Oracle ASCP provides profile options to influence scheduling decision. Oracle ASCP schedules the orders based on the availability of resources in a window defined by the following profile options:

**MSO: Network Routing Cycle Time coefficient**, is a multiple of the longest path of the network; the longest path is based on theoretical durations.

**MSO: Network Routing fixed time window**, is a fixed amount of time in days that you would like to add to your window.

If the duration using longest path on the network is 5 days, and you entered 2 for **MSO: Network Routing Cycle Time coefficient** and 3 for **MSO: Network Routing fixed time window**, the total window size will be: fixed time window + cycle time coefficient * longest path on the network, or 3 + 2(5) = 13 days.

You can further influence the scheduling decision using the following two profile options:

**MSO: NFL BACKWARD COMPRESSION PCT**, specifies the percentage of resources available for scheduling within the window described earlier during backward scheduling. If you set this profile option to 60%, the system only considers 60% of the available capacity in the window specified above while backward scheduling.

**MSO: NFL FORWARD COMPRESSION PCT**, specifies the percentage of resources available for scheduling within the window described earlier during forward scheduling. If you set this profile option to 20%, the system only considers 20% of the available capacity in the window specified above while forward scheduling.

These last two profile options give you the flexibility in controlling the on time delivery of orders.

**Network Routing Support in Order Promising**

Global Order Promising considers net planning percent (NPP) when it calculates resource and material requirements during capable-to-promise. In the diagram above, the resource and material requirement needed at node 30 is: Order Qty * RCY * 0.8 (NPP) * Qty Per Assembly.
Topics covered in this section include the following:

- Overview of Collaborative Planning on page 13-2
- Collaborating with Suppliers on page 13-4
- Using Workflow in Oracle ASCP on page 13-5
Overview of Collaborative Planning

Oracle ASCP extends the collaborative features of Oracle Applications. It is built on Oracle’s Internet computing architecture which allows all of the applications to be deployed over the Internet or your corporate Intranet. It is also completely integrated with Oracle’s Self Service Web Applications.

Collaborating with Customers

Collaboration is practical only in environments where all can gain by sharing information. When collaborative arrangements are carefully established throughout a supply chain, many competitive advantages accrue to the group.

Sharing Forecasts/Demand Plans

Oracle ASCP supports powerful Internet-based collaboration, which enables you to communicate with your customers.

Providing Viewing and Updating Access

Because Oracle ASCP is a complete Internet-based planning solution, it allows your customers to review and enter forecasts. Please refer to Oracle Demand Planning User Guide for information on how to review and enter forecasts.

Viewing Customer-Specific Forecasts

By allowing customers to enter their own forecasts, you have the freedom to view customer specific forecasts which in turn will help you better plan your own forecasts and demand plans.

Forecast Consumption Status

You should be able to perform regenerative forecast consumption during planning to improve the performance of your transaction system.

Within ASCP, collaboration is accomplished using Oracle Workflow and the BIS application.
Customer Submissions

Consolidating Customer Forecasts

Consolidated forecasts are complete forecasts for the entire business. They are built by consolidating all the forecasts into a single forecast. The forecast is then rolled up to the highest level of aggregation, and spread down to the lowest level of detail.

**Oracle Demand Planning** Demand forecasting is a crucial function for managing the manufacturing process. It provides the information necessary to improve the operational plans, and improve the companies ability to manage its profitability and customer expectations.

Oracle Demand Planning improves the planning process by providing the information necessary to make the product-mix decisions in a manner consistent with the goals of the company

Oracle Demand Planning is a system that will enable manufacturers to systematically create the best forecasts with all the information available.

You can collect the data you need from multiple disparate sources and use Oracle Workflow to route information, manage processes, and monitor performance. You can provide secure access to portions of the plan and manage multiple scenarios to develop a collaborative consensus demand plan. The integration between Oracle ASCP and Oracle Demand Planning also allows you to maintain both constrained and unconstrained versions of the demand plan to manage the balance between market needs and production capabilities.

**Incorporating Customer Forecasts Into the Demand Plan** Oracle Demand Planning support Internet collaboration, incorporating information from sales, marketing, operations, and customers. Oracle Demand Planning provides a robust Internet-based framework for developing collaborative demand plans and forecasts.
Collaborating with Suppliers

From ASCP, a notification can be sent to a supplier for supplier capacity issues. This is done using notifications in the Plan menu of the Planner’s Workbench.

From the Oracle Self-Service Web Application, the supplier can review this notification and within the notification he or she can update the capacity information.

Performance Management and Supply Chain Partners

The planning system is integrated with the performance management system provided by Oracle Business Intelligence System (BIS). BIS is an Internet ready performance management system for Oracle Applications. By transforming transactional data into meaningful information, BIS lets you define, monitor, and analyze corporate performance in order to make strategic and timely decisions. BIS is a user-friendly, pre-packaged decision support solution integrated with Oracle Applications. You log onto BIS through a customizable web page for easy access to vital information. You receive notifications when enterprise performance does not meet predefined targets. These notifications include web links to related reports. BIS reporting is easy to understand, crosses functional areas, and provides different levels of analysis depending on your needs. Managers can respond immediately to BIS notifications in order to share information or take corrective actions. By enabling managers to proactively track, measure, and analyze enterprise performance, BIS provides a powerful corporate management tool, enabling strategic and timely decision-making.

Measuring Supply Chain Partner Performance

Oracle ASCP optimizes your plans to help you achieve your targets, and plans can be evaluated based on their impact on your key performance measure.

Providing View Access to Performance Metrics

From Planner Workbench, select your plan from navigation tree and go to the Key Indicators tab, you will be able to view KPIs for performance of your plan against target.

Viewing Partner Performance

Partner performance could also be view the same way. To view exceptions for a partner, select a plan and go to Action tab. You will be able to view your partner’s action and details of action.
Using Workflow in Oracle ASCP

Business processes today involve getting many types of information to multiple people according to rules that are constantly changing.

Oracle ASCP enables collaboration by automatically forwarding planning exceptions to internal personnel and trading partners using Oracle Workflow. Trading partner responses can trigger other workflow activities such as an internal notification, or even an automatic reschedule of a purchase order.

Workflow Enabled Exceptions

The following is a list of exceptions that are workflow enabled:

- Item is over committed
- Item has a shortage
- Item has excess inventory
- Items with expired lots
- Past due forecast
- Late supply pegged to forecast
- Items below safety stock
- Item has orders to be rescheduled in
- Item has orders to be rescheduled out
- Item has orders to be cancelled
- Item has orders with compression days
- Item has past due orders
- Past due sales orders
- Late supply pegged to sales order
- Items with shortage in a project
- Items with excess in a project
- Items allocated across projects
Workflow Process Summary

The following table summarizes the workflow process information for these exceptions:

<table>
<thead>
<tr>
<th>Exception Types</th>
<th>Notification Recipients</th>
<th>Item Attributes Passed in Message</th>
<th>Response Handling</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item is over committed take numbers out</td>
<td>Planner</td>
<td>Plan name, org, item, quantity, date</td>
<td>None</td>
</tr>
<tr>
<td>Item has a shortage</td>
<td>Planner</td>
<td>Plan name, org, item, quantity, shortage from date, shortage to date</td>
<td>None</td>
</tr>
<tr>
<td>Item has excess inventory</td>
<td>Planner</td>
<td>Plan name, org, item, quantity, excess from date, excess to date</td>
<td>None</td>
</tr>
<tr>
<td>Items with expired lots</td>
<td>Planner</td>
<td>Plan name, org, item, lot expiration date, quantity, lot number</td>
<td>None</td>
</tr>
<tr>
<td>Past due forecast</td>
<td>Planner</td>
<td>Plan name, org, item, demand due date, quantity</td>
<td>None</td>
</tr>
<tr>
<td>Late supply pegged to forecast</td>
<td>Planner</td>
<td>Plan name, org, item, order date, supply type, quantity, end item</td>
<td>None</td>
</tr>
<tr>
<td>Items below safety stock</td>
<td>Planner</td>
<td>Plan name, org, item, quantity, from date, to date</td>
<td>None</td>
</tr>
<tr>
<td>Item has orders to be rescheduled in</td>
<td>Work order - Planner, Requisition - Planner/Buyer, PO - Planner/Buyer/Supplier Contact</td>
<td>Plan name, org, item, order number, supply type, quantity, old schedule date, new schedule date</td>
<td>Work Order: Planner optionally reschedules, Requisition: Planner &gt; Buyer optionally reschedules, PO: Planner &gt; Buyer &gt; Supplier Contact optionally reschedules</td>
</tr>
<tr>
<td>Item has orders to be rescheduled out</td>
<td>Work order - Planner, Requisition - Planner/Buyer, PO - Planner/Buyer/Supplier Contact</td>
<td>Plan name, org, item, order number, supply type, quantity, old schedule date, new schedule date</td>
<td>Work Order: Planner optionally reschedules, Requisition: Planner &gt; Buyer optionally reschedules, PO: Planner &gt; Buyer &gt; Supplier Contact optionally reschedules</td>
</tr>
</tbody>
</table>
### Using Workflow in Oracle ASCP

#### Collaborative Planning

<table>
<thead>
<tr>
<th>Exception Types</th>
<th>Notification Recipients</th>
<th>Item Attributes Passed in Message</th>
<th>Response Handling</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item has orders to be canceled</td>
<td>Work order - Planner</td>
<td>Plan name, org, item, order date, order number, supply type, quantity</td>
<td>Work Order: Planner optionally reschedules</td>
</tr>
<tr>
<td></td>
<td>Requisition - Planner/Buyer</td>
<td>Requisition - Supplier</td>
<td>Requisition: Planner &gt; Buyer optionally reschedules</td>
</tr>
<tr>
<td></td>
<td>PO - Planner/Buyer/Supplier Contact</td>
<td>PO - Supplier, Supplier Site</td>
<td>PO: Planner &gt; Buyer &gt; Supplier Contact optionally reschedules</td>
</tr>
<tr>
<td>Item has orders with compression days</td>
<td>Work order - Planner</td>
<td>Plan name, org, item, order number, supply type, quantity, compression days</td>
<td>Work Order: Planner optionally reschedules</td>
</tr>
<tr>
<td></td>
<td>Requisition - Planner/Buyer</td>
<td>Requisition - Supplier</td>
<td>Requisition: Planner &gt; Buyer optionally reschedules</td>
</tr>
<tr>
<td></td>
<td>PO - Planner/Buyer/Supplier Contact</td>
<td>PO - Supplier, Supplier Site</td>
<td>PO: Planner &gt; Buyer &gt; Supplier Contact optionally reschedules</td>
</tr>
<tr>
<td>Item has past due orders</td>
<td>Work order - Planner</td>
<td>Plan name, org, item, order date, order number, supply type, quantity</td>
<td>Work Order: Planner optionally reschedules</td>
</tr>
<tr>
<td></td>
<td>Requisition - Planner/Buyer</td>
<td>Requisition - Supplier</td>
<td>Requisition: Planner &gt; Buyer optionally reschedules</td>
</tr>
<tr>
<td></td>
<td>PO - Planner/Buyer/Supplier Contact</td>
<td>PO - Supplier, Supplier Site</td>
<td>PO: Planner &gt; Buyer &gt; Supplier Contact optionally reschedules</td>
</tr>
<tr>
<td>Past due sales orders</td>
<td>Planner/Sales Rep</td>
<td>Plan name, org, item, demand due date, order number, quantity</td>
<td>None</td>
</tr>
<tr>
<td>Late supply pegged to sales order</td>
<td>Planner/Sales Rep</td>
<td>Plan name, org, item, order date, supply type, quantity, end item, end order number</td>
<td>None</td>
</tr>
<tr>
<td>Items with shortage in a project</td>
<td>Planner/Task (Project) Manager</td>
<td>Plan name, org, item, quantity, shortage from date, shortage to date, planning group, project, task</td>
<td>None</td>
</tr>
<tr>
<td>Items with excess in a project</td>
<td>Planner/Task (Project) Manager</td>
<td>Plan name, org, item, quantity, shortage from date, shortage to date, planning group, project, task</td>
<td>None</td>
</tr>
</tbody>
</table>
Workflow Process Details

This section shows four different workflows and their corresponding exceptions.

Workflow 1

This workflow is valid for the following exceptions:

- Item is over committed
- Item has a shortage
- Item has excess inventory
- Items with expired lots
- Past due forecast
- Late supply pegged to forecast
- Items below safety stock

The following text and figure describes the steps in the workflow.

Start

This is a Standard function that marks the start of the process.

Workflow Process Forward

This function determines if the workflow process should proceed. If the Plan option Production is checked, this procedure returns a value of Y and the process continues. If not, it returns N and the process is terminated.

Select Planner

Based on plan, organization, and item, this function determines which planner will get the notification. This function also selects the appropriate message to be sent based on exception type. If the planner is found, this procedure returns a value of

---

<table>
<thead>
<tr>
<th>Exception Types</th>
<th>Notification Recipients</th>
<th>Item Attributes Passed in Message</th>
<th>Response Handling</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items allocated across projects</td>
<td>Planner/From Task (Project) Manager/To Task (Project) Manager</td>
<td>Plan Name, org, item, order date, supply type, quantity, end item, from project, from task, to project, to task</td>
<td>None</td>
</tr>
</tbody>
</table>
FOUND. Otherwise, it returns a value of NOT_FOUND and the process is terminated.

**Notify Exception**
This function calls a standard function WF_STANDARD.NOTIFY that allows dynamic selection of messages under one notification activity. The required activity attribute MESSAGE is set to item attribute MESSAGE_NAME that was previously selected in Select Planner node.

**End**
This is a standard function that marks the end of the process.

---

**Workflow 2**
This workflow is valid for the following exceptions:

- Item has orders to be rescheduled in
- Item has orders to be rescheduled out
- Item has orders to be cancelled
- Item has orders with compression days
- Item has past due orders

The following text and figure describes the steps in the workflow.

**Start**
This is a standard function that marks the start of the process.
Workflow Process Forward
This function determines if the workflow process should proceed. If the Plan option Production is checked, this procedure returns a value of Y and the process continues. If not, it returns N and the process is terminated.

Determine Order Type
This function determines the order type defined in current exception, and serves as a branching point. The order types are grouped into four categories: Work Order, Purchase Requisition, Purchase Order, and Other Order Types.

Select Planner
Based on plan, organization and item, this function determines which planner will get the notification. This function also selects the appropriate message to be sent based on exception type. If the planner is found, this procedure returns a value of FOUND. Otherwise, it returns a value of NOT_FOUND.

Select Buyer
Based on plan, organization and item, this function determines which buyer will get the notification. This function also selects the appropriate message to be sent based on exception type, thus overriding the message selected in Select Planner function. If the buyer is found, this procedure returns a value of FOUND. Otherwise, it returns a value of NOT_FOUND.

Select Supplier Contact
This function determines which supplier contact will get the notification. This activity also selects the appropriate message to be sent based on exception type, thus overriding the message selected in Select Buyer function. If the supplier contact is found, this procedure returns a value of FOUND. Otherwise, it returns a value of NOT_FOUND.

Notify Exception (Purchase Requisition)
This function calls a standard function WF_STANDARD.NOTIFY that allows dynamic selection of messages under one notification activity. The required activity attribute MESSAGE is set to item attribute MESSAGE_NAME that was previously selected in Select Planner node. Only the messages that contain information related to Purchase Requisition order type are selected from this activity. When the notification is reviewed, the recipient responds to it by selecting either PROCEED or STOP. If PROCEED is chosen, the process continues to next node. If STOP is chosen, the process is terminated.
Notify Exception (Purchase Order)
This function calls a standard function WF_STANDARD.NOTIFY that allows dynamic selection of messages under one notification activity. The required activity attribute MESSAGE is set to item attribute MESSAGE_NAME that was previously selected in Select Planner node. Only the messages that contain information related to Purchase Order order type are selected from this activity. When the notification is reviewed, the recipient responds to it by selecting either PROCEED or STOP. If PROCEED is chosen, the process continues to next node. If STOP is chosen, the process is terminated.

Notify Exception/Rescheduling (Work Order)
This function calls a standard function WF_STANDARD.NOTIFY that allows dynamic selection of messages under one notification activity. The required activity attribute MESSAGE is set to item attribute MESSAGE_NAME that was previously selected in Select Planner node. Only the messages that contain information related to Work Order order type are selected from this activity. When the notification is reviewed, the recipient responds to it by selecting either RESCHEDULE or DO NOT RESCHEDULE. If RESCHEDULE is chosen, the process continues to next node. If DO NOT RESCHEDULE is chosen, the process is terminated.

Notify Exception/Rescheduling (Purchase Requisition)
This function calls a standard function WF_STANDARD.NOTIFY that allows dynamic selection of messages under one notification activity. The required activity attribute MESSAGE is set to item attribute MESSAGE_NAME that was previously selected in Select Planner node. Only the messages that contain information related to Purchase Requisition order type are selected from this activity. When the notification is reviewed, the recipient responds to it by selecting either RESCHEDULE or DO NOT RESCHEDULE. If RESCHEDULE is chosen, the process continues to next node. If DO NOT RESCHEDULE is chosen, the process is terminated.

Notify Exception/Rescheduling (Purchase Order)
This function calls a standard function WF_STANDARD.NOTIFY that allows dynamic selection of messages under one notification activity. The required activity attribute MESSAGE is set to item attribute MESSAGE_NAME that was previously selected in Select Planner node. Only the messages that contain information related to Purchase Order order type are selected from this activity. When the notification is reviewed, the recipient responds to it by selecting either RESCHEDULE or DO NOT RESCHEDULE. If RESCHEDULE is chosen, the process continues to next node. If DO NOT RESCHEDULE is chosen, the process is terminated.
**Rescheduling Process**

This function calls a function WF_STANDARD.NOTIFY that allows rescheduling. The prerequisite activity is to select a buyer.

**End**

This is a standard function that marks the end of the process.

**Workflow 3**

This workflow is valid for the following exceptions:

- Past due sales orders
- Late supply pegged to sales order

The following text and figure describes the steps in the workflow.

**Start**

This is a standard function that marks the start of the process.
**Workflow Process Forward**
This function determines if the workflow process should proceed. If the Plan option Production is checked, this procedure returns a value of Y and the process continues. If not, it returns N and the process is terminated.

**Select Planner**
Based on plan, organization and item, this function determines which planner will receive the notification. This activity also selects the appropriate message to be sent based on exception type. If the planner is found, this procedure returns a value of FOUND. Otherwise, it returns a value of NOT_FOUND.

**Select Sales Rep**
This function determines the sales representative who will receive the notification. If the sales rep is found, this procedure returns a value of FOUND. Otherwise, it returns a value of NOT_FOUND.

**Select Customer Contact**
This function determines the customer contact that will receive the notification. If the customer contact is found, this procedure returns a value of FOUND. Otherwise, it returns a value of NOT_FOUND.

**Notify Exception**
This function calls a standard function WF_STANDARD.NOTIFY that allows dynamic selection of messages under one notification activity. The required activity attribute MESSAGE is set to item attribute MESSAGE_NAME that was previously selected in Select Planner node.

**End**
This is a standard function that marks the end of the process.
Workflow 4

This workflow is valid for the following exceptions:
- Items with shortage in a project
- Items with excess in a project
- Items allocated across projects

The following text and figure describes the steps in the workflow.

Start
This is a standard function that marks the start of the process.

Workflow Process Forward
This function determines if the workflow process should proceed. If the Plan option Production is checked, this procedure returns a value of Y and the process continues. If not, it returns N and the process is terminated.

Select Planner
Based on plan, organization and item, this function determines which planner will get the notification. This activity also selects the appropriate message to be sent based on exception type. If the planner is found, this procedure returns a value of FOUND. Otherwise, it returns a value of NOT_FOUND.

Notify Exception
This function calls a standard function WF_STANDARD.NOTIFY that allows dynamic selection of messages under one notification activity. The required activity attribute MESSAGE is set to item attribute MESSAGE_NAME that was previously selected in Select Planner node.

Select Task/Project Manager
This function determines which task manager or project manager will receive the notification, based on TASK_NUMBER and PROJECT_NUMBER (also TO_TASK_NUMBER and TO_PROJECT_NUMBER for exception Items Allocated Across Projects) associated with the exception. If both TASK_NUMBER and PROJECT_NUMBER are known, this procedure selects the task manager. If TASK_NUMBER is missing or appropriate task manager is not found, project manager is selected instead.
Across Projects
This function checks the current exception type to determine if more than one task/project manager should be selected to receive notification (for exception type Items Allocated Across Projects). If exception type is Items Allocated Across Projects, this procedure returns a value of Y. Otherwise, a value of N is returned.

End
This is a standard function that marks the end of the process.

To view workflow notifications:
1. From the Navigator, select the menu Workflow Notifications
   The Worklist window appears.

Figure 13–1 Worklist window

2. To bring up details about an exception, select a link (please see the table in the Workflow Process Summary section for content details for each exception).
The Notification Details window appears.

**Figure 13–2  Notification Details**

The notification buttons at the bottom of the window indicate the actions that you can take on a particular notification. These buttons differ from exception to exception.

In this example, a Reassign button has appeared. This is used to transfer ownership of a notification or delegate the responsibility of responding to the notification.

3. Select the Reassign button.

A window appears with details about reassigning.
4. Use the fields in the bottom half of the window to either transfer ownership or delegate authority for this notification.

**Setups Associated with Oracle ASCP Exception Workflows**

In order to use Workflow, the following setup steps may need to be performed. Not every setup step is mandatory, but you should review all of them and decide if your Workflow requires a particular setup step.

For example, if your Workflow uses a particular employee, user, and supplier, these entities must be entered into the database.

**To set up employees**

1. Sign in using the HR Manager responsibility.
2. Select People > Enter and Maintain.
   
   The Find Person window appears.
3. Select the Find button.
   The People window appears.

*Figure 13–4  The People window*

4. Fill out this window with the employee’s information. Select Employee as Type.
5. Save your work.

For additional information about this window, please refer to *Managing Your Workforce Using Oracle HRMS.*

**To set up users:**
1. Sign in using the System Administration responsibility
   The Users window appears.
3. Enter the User Name and a Password. You will have to reenter the Password.

4. Save your work.

To set up customer contact as a user
1. In the Users window, enter a name in User Name field
2. Select a customer contact name from the Customer LOV
3. Save your work.

To set up supplier contact as a user
1. In the User’s window, enter a name in User Name field
2. Select a supplier contact name from the Supplier LOV
3. Save your work.

To set up planners:
1. Sign in using the Manufacturing and Distribution Manager responsibility
2. Select Inventory > Setup > Planners.
   The Planners window appears.

*Figure 13–6 The Planners window*

3. Fill out the fields in this window and save your work.

**To set up buyers:**

1. Sign in using the Manufacturing and Distribution Manager responsibility
2. Select Purchasing > Setup > Personnel > Buyers.
   The Buyers window appears.
3. Add the buyer, fill out the fields in this screen and save your work.

To set up customer contact
Customer contacts are associated with customer/customer sites.

1. Sign in using the Manufacturing and Distribution Manager responsibility
2. Select Order Entry > Customers > Standard.
   The Find/Enter Customers window appears.
3. Select the Find button.
   The Customer Selection window appears.
4. Select the customer.
   The Customers - Standard window appears.
5. Select an address and then select the Open button. The Customer Addresses window appears.
6. In the Under Usage column on the Business Purposes tab, select Ship to and then select the Open button.

The Business Purpose window appears.
7. In the Contact field, select name of the customer contact.
8. Save your work.

**To enter a customer contact for a customer**
1. Sign in using the Manufacturing and Distribution Manager responsibility.
2. Select Order Entry > Customers > Standard.
   The Find/Enter Customers window appears.
3. Select the Find button.
   The Customer Selection window appears.
4. Select the customer.
   The Customers - Standard window appears.
5. Select an address and then select the Open button.

The Customer Addresses window appears.

6. Select the Contacts: Telephones tab and enter customer information.
7. Save your work.

**To set up supplier contact**
Supplier Contacts are associated with supplier/supplier sites. They are employees of supplier companies.

1. Sign in using the Manufacturing and Distribution Manager responsibility.
2. Select Purchasing > Supply Base > Suppliers.
   
   The Suppliers window appears.
3. In the Site Name field, enter a percent sign and press the Enter key.
   The Sites button is enabled.
4. Select the Sites button at the bottom of the screen.
   The Supplier Sites window appears.
5. Select the Contact tab and enter the Contact information.
6. Save your work.

To define a sales rep
For additional information about defining salespersons, please refer to the Salespersons section of the Oracle Receivables User Guide.

1. Sign in using the Manufacturing and Distribution Manager responsibility.
2. Select Order Entry > Setup > Sales > Salespersons.
   The Find Resources window appears.
3. Select the New button.

The Resource window appears.
4. Fill out the fields with information regarding the salesperson.
5. Save your work.

**To associate a salesperson with a customer**

1. Sign in using the Manufacturing and Distribution Manager responsibility.
2. Select Order Entry > Customers > Standard.
   The Find/Enter Customers window appears.
3. Select the Find button.
   The Customer Selection window appears.
4. Select the customer.
   The Customers - Standard window appears.
5. Select an address and then select the Open button.

The Customer Addresses window appears.
6. In the Under Usage column on the Business Purposes tab, select Ship to and then select the Open button.

The Business Purpose window appears.
7. In the Salesperson field, select name of the customer contact.

To define an item
1. Sign in using the Manufacturing and Distribution Manager responsibility
2. Select Inventory > Items > Master Items.
   The Master Item window appears.
3. Enter the Item name and Description and save your work.

To associate an item with planner
1. Navigate to the Master Item window (see To define an item).
2. Select the General Planning tab.
3. Enter the planner name in the Planner field.

4. Save your work.

**To associate an item with buyer:**

1. Navigate to the Master Item window (see To define an item).
2. Select the Purchasing tab.
3. Enter the buyer name in the Default Buyer field.
4. Save your work.
Topics covered in this section include the following:

- CTO Enhancements on page 14-2
- Multilevel ATO with Example on page 14-2
- Set Up Required to Use Multilevel ATO on page 14-10
CTO Enhancements

Oracle’s Configure to Order solution has been enhanced to support Multilevel Configurations where you can have configurations under configurations. You can source the configurations from anywhere in the supply chain. The Configure to Order Solution contains the following features:

- **Forecast Explosion and Consumption**
  You can explode the forecast from models to sub-models, option classes, optional items, and mandatory items with forecast control set to Consume and Derive in the source organization. You can maintain and consume forecasts for ATO model in the source Organization.

- **Planning**
  Once you configure your orders, you can place the demand on to the correct source organization, consume forecasts, and plan component requirements. You can explode through multilevel and multiorg ATO bills for Forecasts and other independent demands. You can accurately reconcile the forecast and sales order numbers as demands prior to creating Configured item and after you create Configured item.

- **Order Promising**
  You can perform order promising inquiries for your selected configurations with multiple levels of ATO models based on a plan output. Oracle APS automatically places sales order demands for your configuration in question, evaluates the best possible promise dates, and schedules supplies if needed.

**Multilevel ATO with Example**

To illustrate this by an example, consider the supply chain bill shown in the following figure.
Please refer to the legends on the figure for an explanation of item types. Sourcing relationships are shown in dotted lines and the BOM relationship are shown in continuous lines. The BOM and the sourcing is defined using Oracle Bills of Material and Oracle Supply Chain Planning or Oracle APS. You can find the item names within each of the nodes. The item name is followed by a two-letter code to identify the organizations.

CMP mainframe has four configurable assemblies (ATO models): PCI module, Dual Pod Enclosure, Sub Prod 32, and Sub Prod 64. The company sells CMP mainframes from its shipping organizations at Boston and Singapore, and it has three manufacturing sites; Hong Kong, Mexico, and Boston. CMP mainframes are assembled in Boston and Hong Kong. The PCI module is manufactured and sourced at the Mexico facility. Dual Pod Enclosures are manufactured and sourced at Hong Kong along with the components Sub prod32 and Sub prod64. Optional items CD ROMs, DAT Drives, and Tape Drives can be sold as spares from either Boston or Hong Kong.

**Forecast Explosion**

You can maintain forecasts for any item at any level in the bill you need. Forecasts maintained for CMP mainframe at the Hong Kong organization can be exploded down to its models, sub-models, option classes, options and mandatory components within the Hong Kong organization. Console, Pdevices, PCI Module, Dual Pod Enclosure, Sub Prod OC, Sub Prod 32, Sub Prod 64, PTN32-1MB, etc. have exploded forecasts. Independent forecasts maintained for CD-ROM, DAT Drv, Tape Drv can be consolidated with the exploded forecasts from its parents.

Similarly, any independent forecasts maintained for Sub Prod 32 or Sub Prod 64 can be consolidated with the exploded forecasts from its parents and exploded to its component forecasts. If you have multiple levels of ATO models, the forecast explosion process explodes through multiple levels of models in the BOM. The forecast explosion process stops at Standard items. Another important behavior to note is that the forecast explosion process explodes down to its forecasts only if you set the forecast control attribute of the components to Consume and Derive.

**Planning Process**

You can explode the forecast entries of ATO models into its component requirements during the planning process. If the forecast control is set to None and Consume, the explosion can occur in the planning process. The explosion process depends on planning percentage on the Bills of Material. If the forecast control is set
to Consume and Derive, the planning engine does not explode the requirements
down because it has been exploded once during forecast explosion process.

You can configure your orders using Oracle configurator and establish orders using
Oracle Order Management. Irrespective of the organization from which you want to
ship the orders, you can source the configuration at your source organization. You
can collect the configured and scheduled orders and their associated forecasts into
the planning server using the collection program. You can consume the forecast
specified at the sourced organization using the sales orders you entered using
Oracle Order Management prior to the planning process at the planning server.

**Note:** You need to use the assignment set specified in profile
option MRP: Default Sourcing Assignment as the assignment set
used in plan options. This is because if the models are sourced,
Order Management selects sources for configurations for ATP
purposes and it uses the assignment set from this profile option. If
the plan uses an assignment set that is different than the one
mentioned in this profile option, you run the risk of inconsistent
sources.

Oracle ASCP places the sales order demands for Models, Sub Models, option
classes, optional items, and mandatory components specific to your order
configuration. The planning process further explodes the demand down from
Standard Items and plans for components below if there are any.

For example, if you accept an order at the Singapore organization and select the
following options for your configuration:

- CMP Main Frame,
- CD-ROM,
- PTN32-2MB,
- 32TLC Add On,
- 5V Card;

after you collect your configured and scheduled order into the APS server and run a
plan, you will get the demand picture shown in the following table in your APS
plan:
You can create a Configuration Item based on your selection at Oracle Order Management. After the Configuration Item is created, you can rerun collections and the plan. As a result, you will see a sales order line for the Configuration Item at the shipping Organization in the plan. Referring to our previous example, you will see a sales order line for Configuration Item at the Singapore Organization. You will also see Configuration Items for each of the ATO models in your selection, i.e., CMP Main Frame, PCI Module, Dual Pod Enclosure, Sub Prod 32 at Hong Kong. In addition, you will see Configuration Item for PCI Module at Mexico. You will also see Bills of Material for each of the Configuration Items based on your selection. This will be used to pass the demand down to components and execute the orders.
Forecast consumption will now reflect the Configuration Item instead of the ATO item.

The following table represents the demand picture in planning after creating the Configuration Item:

<table>
<thead>
<tr>
<th>Item</th>
<th>Org</th>
<th>Type of Demand</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMP Main Frame*1</td>
<td>SG</td>
<td>Sales Order</td>
</tr>
<tr>
<td>CMP Main Frame*1</td>
<td>HK</td>
<td>Planned Order</td>
</tr>
<tr>
<td>Console</td>
<td>HK</td>
<td>Planned Order</td>
</tr>
<tr>
<td>CD-ROM</td>
<td>HK</td>
<td>Planned Order</td>
</tr>
<tr>
<td>PCI Module*1</td>
<td>HK</td>
<td>Planned Order</td>
</tr>
<tr>
<td>PCI Module*1</td>
<td>MEX</td>
<td>Planned Order</td>
</tr>
<tr>
<td>Cables</td>
<td>MEX</td>
<td>Planned Order</td>
</tr>
<tr>
<td>5V card</td>
<td>MEX</td>
<td>Planned Order</td>
</tr>
<tr>
<td>Compatibility Bridge</td>
<td>MEX</td>
<td>Planned Order</td>
</tr>
<tr>
<td>Dual Pod Enclosure*1</td>
<td>HK</td>
<td>Planned Order</td>
</tr>
<tr>
<td>Power Supply</td>
<td>HK</td>
<td>Planned Order</td>
</tr>
<tr>
<td>Sub Prod 32*1</td>
<td>HK</td>
<td>Planned Order</td>
</tr>
<tr>
<td>PTN-32 OC</td>
<td>HK</td>
<td>Planned Order</td>
</tr>
<tr>
<td>PTN32-2MB</td>
<td>HK</td>
<td>Planned Order</td>
</tr>
<tr>
<td>TLC1032</td>
<td>HK</td>
<td>Planned Order</td>
</tr>
<tr>
<td>32TLC Add On</td>
<td>HK</td>
<td>Planned Order</td>
</tr>
</tbody>
</table>

Notice that the Configuration Item is created for each ATO model shown as *1 appended to the item in the above table.

The ASCP engine creates appropriate planned supplies that you can convert to actual supplies and follow standard replenishment cycle to ship the sales orders between internal Organizations and finally to the customer.

**Order Promising**

You can use plans developed by Oracle ASCP to quote the promise dates for your customers. You need to ensure that you have the profile option Profile INV:
Capable to Promise set to ATP/CTP Based on Planning Output and perform your inquiries from Oracle Order Management.

You can perform order promising queries based on the supply/demand data developed by the planning engine. As you receive additional orders for your configurations, the Order Promising engine inserts sales order demand at the shipping organization and sources the orders using the sourcing information for your ATO models. If the supply found in the plan is not sufficient, the Order Promising engine generates more supply based on resource and material availability defined in the plan. Derived demand and supply (if needed) is inserted in the plan as well.

If you use a Master Demand Schedule (MDS) to drive the plan, you need to load the MDS with all the scheduled sales orders, collect the data, and rerun the plan in order to insert the scheduled sales orders into the plan. If you use sales orders and forecasts directly as input to the plan, the new scheduled sales orders will automatically become part of the plan as soon as you rerun the plan.

The order promising query will walk you through the bill and sourcing structure and determine the best possible promise dates and ship dates.

You can visualize the order promising results via a very detailed pegging tree that shows you the replenishment paths traced by the order promising query.

Please refer to the following Demand flow diagram for details on the demand flow in a multilevel, multisource ATO scenario.
Demand flow in a Mult-Level, Multi-org ATO scenario

Set up the following:
- MRP: Default Sourcing Assignment Set: Specify assignment set which has sourcing for models
- Plan: Specify the same assignment set (as in Profile option MRP: Default Sourcing Assignment Set). Plan should be set up to check ATP
- INV: Capable To Promise: Based FUSOL ATP with Planning Output

Enter and Schedule Sales Order for an ATO Model

- No changes in the plan
- Yes: Are items ATP Enabled?
  - Yes: Oracle Global Order Promising will insert Sales Order line for parent model in the plan within the Shipping Org. For all other components (component models included), Oracle Global Order Promising will insert derived demand.
  - No: Plan net change collections and rerun the plan.

Sales Order lines are placed for models, option classes, options, and mandatory components in the plan.

If the model is sourced, Sales Order lines for models are created in source org. Forecast consumption happens in sourced org. (not in the shipping org.)

Create Configuration Item

Plan net change Complete refresh collections and rerun the plan.

Configuration item is created for each ATO Model. Sales Order demand placed for top level assembly in Shipping Org. All other items in the selected configuration will get planned order demands.
Set Up Required to Use Multilevel ATO

The profile INV: Capable to promise must be set to ATP/CTP Based on Planning Output in order to perform multilevel order promising.

The profile MRP: Default Sourcing Assignment Set should be set to the assignment set that defines the sourcing rules for your model. The same assignment set should be used in your plan.

If a model in an organization can be sourced from another organization, the sourcing rule needs to be set up. Sourcing rule at the model level means that all configurations derived from that model will be manufactured in the sourcing organization and finally be shipped in the shipping organization. Only one sourcing organization is supported at this time.

Order Promising Related Attributes

For the models and option classes, the Check ATP flag in all organizations should be set to None. The ATP components flag can be set to any value. If no order promising check is required for configuration, the ATP flag at the BOM level should be unchecked. If a model is sourced, the ASCP engine will honor the attribute settings for the model in the source organization.

Forecast Control attribute for a sourced model should be set to Consume or Consume and Derive in the source organization in order for the forecast to be consumed in the Source organization. The Forecast Control set up in the shipping organization does not matter since forecast is not consumed in the shipping organization.

You need to ensure that end assemblies are in a forecast which is used by the plan at the shipping organization. This ensures that the item gets picked up in the plan prior to creation of Sales Orders.

To use Multilevel ATO features:

1. Enter or create forecasts and explode the forecasts to component forecasts at the source. You can use either Oracle Master Scheduling/MRP or Oracle Supply Chain Planning.

2. Run Collection to collect all your data. If data is collected to the planning server for the first time, use Complete Refresh Collection. Use Collection program from Oracle APS.

3. Define and run ASCP plan in the planning server. Ensure that ATP flag is checked for the plan.
4. Enter Sales Orders for your configuration using Oracle Order Management and Oracle Configurator.

5. Check ATP for your configuration from Sales Order form (Optional).


7. Run net change collections as needed from Planning server.

8. Run a plan which will consume forecasts, explode sales orders and forecast requirements, and generate planned supplies.

9. Create Configuration item for the sales order using Oracle Order Management.

10. Run Net change/Complete Refresh collections.

11. Rerun your plan again.

12. Convert planned supplies to actual supplies by releasing planned orders form Planner’s Work Bench.

13. Follow the regular replenishment cycle and ship between internal Orgs. and to the customer as needed.
Cross-Instance Planning

Topics covered in this section include the following:

- Overview of Cross-Instance Planning on page 15-2
- Instances on page 15-2
- Collections on page 15-3
- Sourcing Rules on page 15-4
- Planning on page 15-6
- Global Order Promising on page 15-8
- Execution on page 15-8
- Known Limitations on page 15-8
Overview of Cross-Instance Planning

This section provides a brief explanation on how Oracle APS supports cross-instance planning and available-to-promise. Cross-instance planning is defined as defining, running, and executing a single plan across multiple source instances and is a key feature for companies that implement a hub-and-spoke planning model.

Instances

The Oracle Advanced Planning Suite can plan a single instance or multiple instances. An instance is a database and set of applications. In order to explain cross-instance planning, we will distinguish between source and destination instances. Source instances hold the source data, like items, bill of materials, actual orders, and so on. Source instances can be Oracle Applications instances (release 10.7, 11.0, and 11i) or legacy systems. The destination instance is generally referred to as the APS Planning Server. Using the Planning Server, planners collect source information from the source instances, run, analyze, and simulate plans, and implement planned orders. Collection against an Oracle Applications source instance works out-of-the-box, whereas for legacy systems, a customized collection must be developed as part of the implementation.

The picture below will be used to illustrate the concept of cross-instance planning as supported by Oracle APS.

The diagram represents four source instances (S11, ABC, TR1, and S07) and a planning server. To set up cross-instance planning, an administrator has to register the source instances in the planning server. This is a two-step process:

1. Establish a database link between the source instances and the APS planning server.
2. Log in as Advanced Supply Chain Planner.
3. From the Navigator window, choose Setup > Instances. The Applications Instances window appears.

*Figure 15–1 Application Instance window*

4. Use the Instances window to register the source instances. This window allows you to define Planning Database Links used to pull data from the source instances to the Planning Server, and Application Database Links used to release planning recommendations from the Planning Server back to the source instances.

**Collections**

Before running plans on the planning server, the source data (planning related data and transactional data) needs to be collected. In our example, a user would run collections to collect from the four source instances. These collections can run in parallel using Oracle Applications standard concurrent processing features.
Sourcing Rules

This architecture improves the collections process cycle time dramatically. For example, if the Discrete Job transactions are the only data that frequently change, you could collect only the changes in Work In Process transactions without recollecting data that was unchanged from the previous collection.

Sourcing Rules

Sourcing Rules (Bills of Distribution) enable sourcing across instances. A planner assigns sourcing rules to items to determine how items are being sourced.

The sourcing and the assignments for cross instance planning are done within the planning server. For example, the following diagram represents five instance-org combinations sharing materials. The rectangles in the diagram represent the instance-orgs. The first three letters in each of the rectangles represent the instance name; the two letters after the semicolon represent the organization name within that instance. For example, “ABC:S1” refers to instance ABC, organization S1.

The setup described in the following table is used to define sourcing rules as represented in the diagram above:

<table>
<thead>
<tr>
<th>Sourcing Rule/BOD</th>
<th>Receiving Org</th>
<th>Shipping Org</th>
<th>Allocation %</th>
<th>Intransit Lead Times</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOD100</td>
<td>S11:M1</td>
<td>TR1:M2</td>
<td>25%</td>
<td>3</td>
</tr>
<tr>
<td>BOD100</td>
<td>S11:M1</td>
<td>S07:M3</td>
<td>75%</td>
<td>10</td>
</tr>
</tbody>
</table>
Once the sourcing rules are assigned to the items, the system is ready to start running plans.

To set up Sourcing Rules:
1. From the Navigator, choose Sourcing > Sourcing Rules.

*Figure 15–2  The Sourcing Rule window*

<table>
<thead>
<tr>
<th>Sourcing Rule/ BOD</th>
<th>Receiving Org</th>
<th>Shipping Org</th>
<th>Allocation %</th>
<th>Intransit Lead Times</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOD100</td>
<td>ABC:S1</td>
<td>TR1:M2</td>
<td>60%</td>
<td>1</td>
</tr>
<tr>
<td>BOD100</td>
<td>ABC:S1</td>
<td>S07:M3</td>
<td>15%</td>
<td>5</td>
</tr>
<tr>
<td>BOD100</td>
<td>ABC:S1</td>
<td>S07:S1</td>
<td>25%</td>
<td>10</td>
</tr>
</tbody>
</table>

2. Define your sourcing rules. These are the rules that dictate a pattern of sourcing from suppliers and inventory organizations across multiple instances.

To assign Sourcing Rules:
1. From the Navigator, choose Sourcing > Assign Sourcing Rules.
The Sourcing Rule/Bill of Distribution Assignments window appears.

**Figure 15–3  Sourcing Rule/Bill of Distribution Assignments window**

2. Use this window to assign sourcing rules defined above to either an item in an organization, a category of items in an organization, an item, an organization, or an instance.

**Planning**

The next step in the process is to define a plan that spans multiple instances. This is achieved by entering all instance-orgs that need to be used in planning at the plan option level.

Referring back to the example: choose all the five instance-org combinations along with valid demand and supply schedules.

The assignment set, as mentioned previously, needs to be set as a plan option. Once the plan is run, the planned orders generated at S11:M1 and ABC:S1 will have sources per the sourcing rules/BOD that were defined. For example, TR1:M2, S07:M3, and S07:S1 will be shown as sources (depending on the type of plan you run). The combination of sourcing rules/BODs, bills of material, and routings create what, in Oracle terminology, we call a supply chain bill. In the example described above, the independent demand will be exploded throughout the entire multiple
instance supply chain and appropriate planned supply will be created for each component at each level of the supply chain bill.

To define a plan:

1. From the Navigator, choose Supply Chain Plan > Options.
2. Select a plan.

The Plan Options window appears with the Main tab selected.

Figure 15–4  Plan Options window

Please refer to Chapter 5, Defining Plans, for more information on how to define a plan.
Global Order Promising

When performing global order promising based on planning data with cross-instance sourcing, the available-to-promise calculation uses the supplies generated in the plan to evaluate availability. If there is a need for more supply, the capable to promise calculation uses cross-instance sourcing and goes through the supply chain bill to evaluate the capability to produce, and returns a valid availability date.

Execution

Although most of the execution happens at the source, the integration between the source instance and the planning server is initiated at the planning server. As a result of the plan run, you will see planned orders in the Planner Workbench with sources across instances as described in planning section. Considering the current and source organizations from the table below, the current organization is the organization at which the planned order is generated (the ship-to organization) and source organization is the organization from which you are going to source the planned order (the ship-from organization).

<table>
<thead>
<tr>
<th>Item</th>
<th>Current Org</th>
<th>Source Org</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>S11:M1</td>
<td>TR1:M2</td>
</tr>
<tr>
<td>B</td>
<td>s11:M1</td>
<td>S07:M3</td>
</tr>
<tr>
<td>C</td>
<td>ABC:S1</td>
<td>TR1:M2</td>
</tr>
<tr>
<td>D</td>
<td>ABC:S1</td>
<td>S07:M3</td>
</tr>
</tbody>
</table>

When the plan is executed, output from the planning process is communicated back to the source instances. Output includes recommendations in the form of new purchase requisitions and discrete jobs, as well as other recommendations such as reschedules to existing entities like purchase orders. If you release the planned orders for item A, B, C, or D, internal purchase requisitions are created at the respective source organizations. The creation of sales orders, shipments, in-transit shipments, receipts, and so on, across instances are defined manually.

Known Limitations

The following limitations for cross-instance planning are currently known:

- The Planner Workbench currently releases the requisition as an internal requisition, rather than an external requisition.
- When releasing the requisition, it is not always clear which supplier maps to the internal-org.
- Conversion of financial data to the base currency is not supported in the current release.
- There is a time difference you set up when you define the instances: the planning engine will currently not add or subtract the time difference to the snapshot data from the source.
- Currently, you cannot create and collect transactions across instances to the Planning Server.
Topics covered in this section include the following:

- Overview of Oracle Global Order Promising on page 16-2
- ATP Methods on page 16-6
- Data Collection on page 16-8
- Basic ATP on page 16-10
- Single-Level Supply Chain ATP on page 16-13
- Multilevel Supply Chain ATP on page 16-22
- Allocated ATP on page 16-39
- Demand Class ATP on page 16-57
- Other ATP Functions on page 16-61
- ATP Inquiry on page 16-74
- Using Global ATP Server from Non-Oracle Applications on page 16-79
Overview of Oracle Global Order Promising

Oracle APS includes Oracle Global Order Promising, a tool that enables sophisticated, fast, accurate, and flexible order promising.

Key Features

The following is a list of key features supported by Oracle Global Order Promising. Except where noted, all the features are available with any release of R11i.

Accurate Global Statement of Availability
Oracle Global Order Promising supports availability checks in a distributed environment. It can be deployed either as a component of a complete applications system, or by itself on a separate server. This flexibility allows you to support any combination of centralized and decentralized order promising. This also ensures high availability as well as enabling multiple Order Entry systems to access a global statement of availability. You can provide an extremely accurate statement of availability to all customers in your global supply chain.

ATP for Multiple Supply Locations
If you have multiple distribution centers in your enterprise, Global Order Promising can help you to determine the best location to fulfill a customer request. Alternatively, you can check ATP for any of the possible supply location, drill down to ATP detail, and select the desired location.

Multilevel Supply Chain ATP
Oracle Global Order Promising lets you perform a multilevel component and/or resource availability check across your supply-chain for the end items you specify. You can control the organizations and suppliers to be included in the availability inquiry, and you can control the number of levels in your supply chain bill to be considered in your check. At each level in the supply chain, you can specify the key components and bottleneck resources for which to check availability. Multilevel ATP also considers transportation lead time between the organizations and from the suppliers and to the customers to give you a delivery promise your customers can rely on.

Detailed Availability Information with Graphical Pegging Tree
The result of a multilevel ATP is represented in a detailed pegging tree that shows you the component and resource availability at all the levels across the supply
Overview of Oracle Global Order Promising

You can easily identify the material in shortage or the bottleneck resource. You can further look at the component or resource cumulative availability or supply/demand information for any time in the planning horizon.

**Allocation**

The Allocation feature allows you to allocate scarce material or resource among multiple sales channels. Based on your business strategy, you can establish an Allocation Rule which ranks the sales channels and rations the supply among them. You can base the allocations on forecast or constrained demand. You can time phase the allocation to reflect changes in your monthly or quarterly objectives. During order promising, Oracle Global Order Promising honors the allocation rule and calculates order due dates, considering material and capacity constraints at each level of the supply chain.

In addition, the allocations are managed on a continuous basis as orders are fulfilled. Workflow notification are sent when ATP fails on request date or supply is directed from lower ranking channel towards higher ranking channel. At any point, you can compare the demand to the allocation for a sales channel and be able to adjust the allocation to ensure maximum fulfillment and profitability.

Allocation provides you with significant control over the demand fulfillment process to achieve your customer service and profitability goals.

**Configuration ATP**

Oracle Global Order Promising supports Assemble to Order (ATO) environment. You can designate any optional items for ATP check at any level of the configuration. This provides an accurate availability date for the end configuration. Oracle Global Order Promising integrates with Oracle Configurator to provide you with real time availability check during product configuration.

**Flexible Configuration**

Oracle's Global Order Promising solution is flexible and configurable. You can control the complexity of the availability inquiry. You can specify the list of potential sources to be considered in the availability check. Sourcing rules can be used to specify the approved sources. These sourcing rules can be assigned to products, or to customers. Sourcing rules enable you to control what products can be quoted to a customer from specific locations. A flexible, hierarchical, approach is used to assign sources. The hierarchical assignment allows you to employ sophisticated sourcing strategies with minimal data entry. Rules can be applied at several levels. For example, you can apply rules globally, to entire organizations, to
categories of products, or to individual stock keeping units. More specific rules override more general rules, allowing you to apply default rules and maintain them on an exception basis. This drastically reduces the overhead necessary to maintain your global model.

Global Order Promising also provides you these additional flexibilities:

- Check availability for an item or a set of items across bills and across organizations
- Control single level or multilevel availability check
- Availability check at a product family level allowing more rapid response in mixed mode production environments
- Specify ship set or arrival set as constraints in the availability inquiry
- Specify infinite time fence to limit the time the availability is constrained
- Allow forward and backward consumption

Integration with Other Oracle Applications

The following Oracle Application products are integrated with Global Order Promising to provide availability check:

- Oracle Order Management
- Oracle Configurator
- Oracle i-Store
- Oracle Advanced Supply Chain Planning

Architecture

Oracle Global Order Promising supports the following configuration for installation and deployment.

- Centralized order promising
- Decentralized order promising

Centralized Order Promising

The following figure shows the centralized order promising configuration:
Overview of Oracle Global Order Promising

Supply and demand are pulled from the source instances to the Global Order Promising instance through database links. Order promising is based on the global availability statement.

**Decentralized Order Promising**

The following figure shows the decentralized order promising configuration.

Oracle Global Order Promising and its source data reside in the same database. No database link is required in this case. Two components can communicate through the planning object APIs and the interface tables defined in Oracle Applications.
ATP Methods

There are two methods to run ATP:

- ATP based on collected transactional data. This method is often referred to as ODS-based ATP.
- ATP based on planning data. This method is often referred to as PDS-based ATP.

ATP Based on Collected Data

You can run ATP based on collected data from source instances. This method is often referred to as ODS-based ATP. When you run ATP in this method, you can perform Basic ATP and Single-Level Supply Chain ATP. Supply and demand data as well as other information such as items, customers, MPS entries, and suppliers are collected from source instances and stored in the tables (Object Data Store) that are shared between Global Order Promising and Advanced Supply Chain Planning.

When running ATP in this method, ATP Rule is used to specify the time fence options and supply and demand sources to use during order promising inquiry. Forward and backward consumption, and accumulation are automatically carried out in this method.

You run ATP in this method by setting the INV:Capable to Promise profile to ATP Based on Collected Data.

For detailed information on how to set ATP Rules, see “ATP Rule Options” in the Oracle Inventory User’s Guide.

ATP Based on Planning Data

You can run ATP based on the planning output. This method is often referred to as PDS-based ATP. When you run ATP in this method, you can perform Basic ATP, Single-Level Supply Chain ATP, Multilevel Supply Chain ATP, and Allocated ATP. Supply and demand data as well as other information such as items, bills of material, routing, customers, MPS entries, and suppliers are collected and serves as the input to an Advanced Supply Chain plan. Planning output is used for ATP calculation. Whatever supply and demand is considered by planning will be considered by ATP. You specify supply and demand in plan options.

Forward and backward consumption, and accumulation are automatically carried out in this method.

ATP Rule is used to specify the infinite time fence.
You run ATP in this method by setting the INV:Capable to Promise profile to ATP/CTP Based on Planning Output.

For detailed information on how to set plan options, see Setting Plan Options in Chapter 5, Defining Plans.

**Order Promising for Unplanned Items**

When you run ATP based on planning data (by setting the profile option INV: Capable to Promise to ATP/CTP Based on Planning Output), Global Order Promising may not be able to find the item (for example, Item A) that is the subject of the availability inquiry in the supply chain plan that is designated to be the ATP plan. This may happen if the Planning Method attribute for Item A has been set to Not Planned, or if the Planned Items parameter in the plan options form of the ATP plan has been set to Demand Schedule Items Only and Item A does not appear in the demand schedule(s) of the ATP plan.

In this case, Global Order Promising automatically reverts to an ATP inquiry on the basis of collected data; that is, internally perform a second check as if the profile option INV: Capable to Promise had been set to ATP Based on Collected Data, and return that result.

**Example**

Consider a scenario where an ATP enabled, spare part Item A is not a planned item. The profile option INV: Capable to Promise has been set to ATP/CTP Based on Planning Output.

When the ATP inquiry for Item A is submitted, Global Order Promising checks to see if Item A exists in the ATP enabled plan and takes the following action:

- If the ATP enabled plan is running, it generates the error message “Plan not found”.
- If the ATP enabled plan is not running, it generates the message “Plan not found. ATP is calculated using ODS data”. The results of the ATP inquiry are generated using the collected data.

ATP inquiries for multi-org, multi-level ATO items can be supported only on the basis of planning data. Hence, the automatic use of collected data is not supported for a multi-org, multi-level ATO items.
Data Collection

Data Collection is a process that pulls data from source instances into an area called Operational Data Store (ODS) in Oracle ASCP/Global Order Promising. You can perform Basic ATP and Single-Level Supply Chain ATP based on ODS data.

If you also have the Oracle Advanced Supply Chain Planning product installed, ODS acts as the input for the planning process. As you will see later in this section, Global Order Promising takes advantage of the planning output to provide you with advanced ATP features such as Multilevel Supply Chain ATP/CTP/CTD and Allocated ATP.

Data should be collected from selected instances before running the ATP inquiry.

Running Collection for ATP Based on Collected Data

Data collection can be performed if you don't have Advanced Supply Chain Planning, however, you will not be able to collect data such as bill of material, routing, safety stock, forecast, or MDS. This data is needed for planning purposes.

To run data collection without Advanced Supply Chain Planning, sign on using the Order Management responsibility, and from the Navigator, select Scheduling > ATP Data Collection. ATP will use the collected data for an availability check.

Currently, the ATP Data Collection program contains only the following parameters:

- Instance: the source instance for data collection.
- Number of Workers: number of processes that simultaneously pull transaction data.
- Timeout (minutes): number of minutes before the collection errors out if it has not finished.
- Collection Type: Complete Refresh or Net Change Refresh.
- Sales Orders: Complete Refresh or Net Change Refresh.

The following table describes the data that ATP Data Collection collects. It also indicates which data entity is supported by Net Change Refresh (mode). When you create a new data entity or update an existing data entity that is not supported by Net Change Refresh, you need to run Complete Refresh in order to obtain the new information.
Running Collection For ATP Based on Planning Output

If you run ATP based on planning output (you must have Advanced Supply Chain Planning product installed), you need to sign on using the Advanced Supply Chain Planner responsibility, and then from the Navigator select Collections > Oracle Systems > Data Collection.

For more information on data collection, please refer to Overview of Running Collections for ASCP on page 4-2.

<table>
<thead>
<tr>
<th>Data Entity</th>
<th>Supported by Net Change Refresh</th>
</tr>
</thead>
<tbody>
<tr>
<td>ATP Rules</td>
<td>No</td>
</tr>
<tr>
<td>Calendars</td>
<td>No</td>
</tr>
<tr>
<td>Demand Class</td>
<td>No</td>
</tr>
<tr>
<td>Items</td>
<td>Yes</td>
</tr>
<tr>
<td>Master Production Schedule</td>
<td>Yes*</td>
</tr>
<tr>
<td>On Hand</td>
<td>Yes</td>
</tr>
<tr>
<td>Purchase Requisitions/Orders</td>
<td>Yes</td>
</tr>
<tr>
<td>Sales Orders</td>
<td>Yes</td>
</tr>
<tr>
<td>Sourcing Rules</td>
<td>No</td>
</tr>
<tr>
<td>Subinventories</td>
<td>No</td>
</tr>
<tr>
<td>Trading Partners (Customers)</td>
<td>No</td>
</tr>
<tr>
<td>Units of Measure</td>
<td>No</td>
</tr>
<tr>
<td>Work in Process</td>
<td>Yes</td>
</tr>
</tbody>
</table>

* only new entries to an existing MPS are collected in the Net Change Refresh collection method
Basic ATP

This section provides a detailed discussion on how to use Basic ATP.

Basic ATP allows you to perform an availability check based on statement of current and planned material supply against a given organization. You can perform ATP checks by specifying the item, need-by date, and warehouse. Results describing the need-by date quantity and the fulfillment date of their request are returned to you.

Basic ATP Business Application

Customers need fast and accurate availability information to meet their requirements. Businesses must do their best to keep their customer relations successful and to meet their customers needs. Basic ATP allows customers to perform availability checks and receive detailed information on whether their request can be met or on what date the order can be fulfilled. Based on statements of current and planned material supply, Basic ATP can determine the availability of items.

You perform a Basic ATP check when you only have one inventory location in your company or you simply want to check availability in one inventory location.

Basic ATP Setup Steps

Item Attributes

There are two item attributes: Check ATP flag and Component ATP flag.

The Check ATP flag can be set to either:

- Material only - Check material availability for this item at this level
- None - No need to check ATP at this level

The Material and Resource, and the Resource options are not currently supported.

For Basic ATP, the Component ATP flag should be set to None, which states that there is no need to check ATP for this item at the component level.

ATP Rule

ATP rules are used to define various ATP options. Each rule is a combination of ATP, time fence options, and supply and demand sources to use during the ATP inquiry. You can define multiple ATP rules to reflect the specific needs of your organization and then use different rules to calculate availability for different items.
or groups of items. You can update the item attribute ATP rule to specify a default ATP rule for each item.

Please see Other ATP Functions on page 16-61 for more information on how to use each of these options to best meet your needs.

Profile - INV: Capable to Promise
This profile determines whether to use ODS data or PDS data for ATP calculation. There are two values for this profile:

- ATP Based on Collected Data: You use this value if you want ATP calculation to be based on the collected data from the source instances and when you run MRP or SCP on the source instance and you do not have APS. The supply and demand come from the source instances from MRP or SCP plan output.

- ATP/CTP Based on Planning Output: You use this value if you want ATP calculation to be based on the APS planning output.

Profile - MRP: ATP Database Link
ATP uses this profile at the source instance to check if the planning server is on the same instance.

Basic ATP Data Collection
Data collection is used to collect transactional data into a common data store for order promising. You must run collection before performing ATP inquiries.

ATP Inquiry

Basic ATP From i-Store
An end user will specify the item and need-by date. i-Store uses the warehouse defined in the profile ASO:Default Ship From Org for ATP purpose. i-Store displays the need-by date quantity and the fulfillment date when the requested quantity will be available.

Basic ATP From Order Management
You can perform Basic ATP from the Sales Order Pad in Order Management. You specify the item, the request date and the warehouse. Basic ATP returns the request date quantity and fulfillment date when the requested quantity will be available.
Basic ATP

Basic ATP From Advanced Supply Chain Planning

You can perform Basic ATP from Advanced Supply Chain Planning using the ATP Inquiry window.

See ATP Inquiry section on page 16-74.

ATP Logic

ATP Logic in a Single Organization

1. If ATP item attribute is None, there is no need to do an ATP check.

   If ATP item attribute is materials, the system checks ATP for the item on the request date. If there is availability, you are done. Otherwise go to step 2.

2. ATP fails to satisfy this request. From the sysdate (usually today), try forward scheduling for this request. Find the earliest date that you can get the shortage available. The earliest date is the ATP date.
Single-Level Supply Chain ATP

This section provides a detailed discussion on how to use Single-Level Supply Chain ATP.

Single-Level Supply Chain ATP enables you to perform availability checks based on current and planned supply across multiple supplying organizations. You can rank the supply organizations so that the ATP will check for availability in the order you want. Single-Level Supply Chain ATP can automatically find the best supply organization for your request. You can also drill down to look at the availability at every supply organization.

Single-Level Supply Chain ATP Business Application

Any environment where multiple supply locations can be used to fulfill order demand can benefit from this feature. As you utilize available inventory from other locations, you successfully meet customers' requirements and thus increase your company's overall order fill rate by utilizing inventories that might become excess otherwise.

For example, a company has three stores in the United States. When a customer inquires about a particular product’s availability, the company wants to first check the preferred store (Org1). The product may not be available at the preferred store. The company then wants to check other stores (Org2 and Org3) to find out which store can meet the customer requirement (this is shown in the following diagram.) Single-Level Supply Chain ATP can help this company to achieve this goal.

![Diagram of Single-Level Supply Chain ATP]

Single-Level Supply Chain ATP Setup Steps

Item Attributes

There are two item attributes: Check ATP and Component ATP.
The Check ATP flag lets you control whether to perform and ATP check for that item. The Component ATP flag lets you control whether to check component availability and/or resource availability.

For the Check ATP attribute, the choices are:
- Material only - Check material availability for this item at this level
- None - No need to check ATP at this level

The Material and Resource, and the Resource only options are not currently supported.

For Single-Level Supply Chain ATP, the Check ATP attribute should be set to Material. The Component ATP flag should be set to None, which means that there is no need to check ATP for this item at the component level.

**ATP Rule**

Each rule is a combination of ATP time fence options and supply and demand sources to use during the ATP inquiry. You can define multiple ATP rules to reflect specific needs of your organization and then use different rules to calculate availability for different items or groups of items. You can update the item attribute ATP rule to specify a default ATP rule for each item.

ATP rules are used to define how ATP is run from the ODS.

Please see Other ATP Functions on page 16-61 for more information on how to use each of these options to best meet your needs.

**Sourcing Rule**

Sourcing rules determine the movement of materials between the shipping organizations and the receiving party. The receiving party can be a customer or an internal organization.

In Single-Level Supply Chain ATP scenario, you use a sourcing rule to designate the shipping organizations. Only global sourcing rules are permitted when assigning rules to customers.

For detailed setup instructions, see “Sourcing Rules and Bills of Distribution” in the Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide.
Assignment Set
Once you have defined your sourcing rules, you must assign them to particular items and/or organizations and customers. These assignments are grouped together in assignment sets.

In an assignment set, you can assign your sourcing rules at different levels, as follows:

- a single item in an organization
- category of items in an organization
- an item across all organizations
- category of items across all organizations
- all items in an organization
- all organizations (global)

You can create an assignment set at different levels based on your needs. If the receiving party is a customer, then assign the sourcing rule to this customer and its site. If you want a sourcing rule to be applicable to any customer or any items, then you assign the sourcing rule to Global.

For detailed setup instructions, see “Sourcing Rules and Bills of Distribution” in the Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide.

Inter-Location Transit Times
You can set up different shipping methods and transit lead times between the shipping location of your organization and an internal location associated with the customer’s ship-to location. You can designate a particular shipping method as the default method. ATP attempts to use the shipping method specified on the request to calculate the lead time. If a shipping method is not specified on the request, ATP will use the shipping method from the sourcing rule. If that is not found, ATP will use the default shipping method to obtain the transit lead time.

Before you set up transit times between the locations, you need to have the following set up:

- Shipping methods
- A location for your organization as the default shipping location designated in the Organization window
An internal location and its association with the customer’s ship-to address. You associate an internal location to a customer’s ship-to address in the Define Customer window.

For detailed setup instruction, see Shipping Methods, Inter-location Transit Times in Oracle Inventory User’s Guide.

**Profile - MRP: ATP Assignment Set**

When you perform Single-Level Supply Chain ATP from the source instance, this profile determines the assignment set ATP uses to figure out the shipping organization for the receiving organization or customer. This profile should point to the assignment set discussed above and should be set up at the source instance.

**Profile - INV: Capable to Promise**

This profile determines whether to use ODS data or PDS data for ATP calculation. There are two values for this profile:

- **ATP Based on Collected Data:** You use this value if you want the ATP calculation to be based on the collected data from the source instances and when you run MRP or SCP on the source instance and you do not have APS. The supply and demand come from the MRP or SCP plan output in the source instances. You will be able to perform Supply Chain ATP with this setting.

- **ATP/CTP Based on Planning Output:** You use this value if you want the ATP calculation to be based on the APS planning output. You will be able to perform Supply Chain ATP with this setting.

**Profile - MRP: ATP Database Link**

ATP uses this profile at the source instance to check if the planning server is on the same instance or not.

**Single-Level Supply Chain ATP With or Without APS**

You can perform Single-Level Supply Chain ATP from Order Management or i-Store. If you do not have Advanced Supply Chain Planning products, Single-Level Supply Chain ATP will be based on the collected data (ODS). With Advanced Supply Chain Planning products, you can base Single-Level Supply Chain ATP on the planning output. If you have a constrained and/or optimized plan, you can be sure that your ATP also respects your internal constraints as well as your optimization objectives.
Single-Level Supply Chain ATP Data Collection

Data Collection allows you to collect transactional data from multiple instances or different application systems into a common data store for global order promising and supply chain planning. It collects various data entities such as item, bills of material, customers, forecast, sourcing rule as well as transactional data such as purchase order, miscellaneous receipts, inventory transfers, etc.

In general, if you create new entities, you need to run full (complete refresh) data collection. If you modify an existing entity, such as changing an item attribute, or you have new transactional data, you can run net-change (incremental) collection to refresh the data.

ATP Inquiry

You can perform a Single-Level Supply Chain ATP inquiry inside Order Management or i-Store. Single-Level Supply Chain ATP can either automatically choose the supply organization for you or let you view all the supply organizations and you can pick the warehouse. The calling application can decide which method it wants to use.

Single-Level Supply Chain ATP From i-Store

Oracle i-Store will perform Single-Level Supply Chain ATP if there is no default shipping organization specified in the profile ASO:Default Ship From Org. An end user specifies the item and the need-by date and then i-Store displays the need-by date quantity and the fulfillment date when the quantity will be available.

Single-Level Supply Chain ATP From Order Management

You can perform Single-Level Supply Chain ATP Inquiry from the Sales Order Pad.

From the Sales Order Pad:

- You can perform a Single-Level Supply Chain ATP inquiry without specifying a warehouse on the order line. Single-Level Supply Chain ATP will automatically search for the warehouse that can meet the request based on the sourcing rule you define. The result is displayed in a popup ATP Result window.

- If you are not satisfied with the result, you can click Global ATP inside the ATP Result window. This triggers Single-Level Supply Chain ATP to show you all the supply organizations as defined in the sourcing rule. You may decide to source the demand from two different organizations.
Supply Chain ATP From Advanced Supply Chain Planning
You can perform Single-Level Supply Chain ATP Inquiry from Advanced Supply Chain Planning using the ATP Inquiry window.

From the ATP Inquiry window:

- If you select Pick Sources to No and you do not specify an organization, Single-Level Supply Chain ATP will automatically search for the organization that can meet the request based on the criteria you enter and the sourcing rule you define.
- If you select Pick Sources to Yes, you can view availability from multiple supply organizations.

Please see ATP Inquiry on page 16-74 for additional information.

ATP Logic for Single-Level Supply Chain ATP
An ATP request is processed by the system in the following order:

1. The organization with highest rank is chosen.
2. An availability check for the end item on the request date for that organization is performed. If there is enough supply on that request date, this date becomes the ATP date.
3. If there is not enough supply, a future ATP date in this organization is found by forward scheduling from sysdate (typically today) until sysdate + Latest Schedule Limit. (Latest Schedule Limit is defined for a customer.)
4. If there is still not enough supply, the organization with next highest rank is used, and step 2 is repeated.
5. If all the above fails, the organization with the highest ranking is used.

Note: When organizations are ranked the same, organizations with higher allocation percentage are checked first.

Single-Level Supply Chain ATP Example
The following example will walk you through some of the set up steps and show you the Single-Level Supply Chain ATP result.
You have two supply organizations: M1 and M2. M1 is the preferred warehouse. For end item A, it is make at M1, but it is buy from supplier S1 at M2. This sourcing strategy is applicable to all customers.

You can ship the product to customers using either the standard 3-day delivery or 1-day express.

For any demand, you want ATP to look at the two supply warehouses based on the current and planned supply.

You do not have Advanced Supply Chain Planning product installed.

**Item Attribute**

For end item A:

Check ATP Flag: Material

Component ATP Flag: None

**ATP Rule**

You need to have an ATP rule either assigned at the item level or organization level.

**Sourcing Rule**

You can set up a sourcing rule as shown in the following table. Please note that you must check the All Org field in the Define Sourcing Rule form. For this example, the sourcing rule name is SR-A.

<table>
<thead>
<tr>
<th>Type</th>
<th>Org/Supp</th>
<th>Percent</th>
<th>Rank</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transfer</td>
<td>M1</td>
<td>100%</td>
<td>1</td>
</tr>
<tr>
<td>Transfer</td>
<td>M2</td>
<td>100%</td>
<td>2</td>
</tr>
</tbody>
</table>

This is a global sourcing rule.

**Assignment Set**

In the assignment set, you make an Item level assignment by assigning sourcing rule SR-A to item A, as shown in the following table.

<table>
<thead>
<tr>
<th>Type</th>
<th>Item</th>
<th>SR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
<td>A</td>
<td>SR-A</td>
</tr>
</tbody>
</table>
Inter-Location Transit Times
You can set up different shipping methods and transit lead times between the shipping location of your organization and an internal location associated with the customer’s ship-to location. The following table, with customer ABC and receiving location ABC-RecLoc, shows the transit lead times between the shipping location and the customer’s ship-to location.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Shipping Method</th>
<th>Lead Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>M1-ShipLoc</td>
<td>ABC-RecLoc</td>
<td>Express</td>
<td>1 day</td>
</tr>
<tr>
<td>M1-ShipLoc</td>
<td>ABC-RecLoc</td>
<td>Standard</td>
<td>3 days</td>
</tr>
<tr>
<td>M2-ShipLoc</td>
<td>ABC-RecLoc</td>
<td>Express</td>
<td>1 day</td>
</tr>
<tr>
<td>M2-ShipLoc</td>
<td>ABC-RecLoc</td>
<td>Standard</td>
<td>3 days</td>
</tr>
</tbody>
</table>

Profile MRP: ATP Assignment Set
This should point to the assignment set defined above.

Profile: INV: Capable to Promise
Because you do not have Advanced Supply Chain Planning, you should set this profile to ATP Based on Collected Data.

Profile MSC: ATP Assignment Set
This profile indicates the name of the assignment set to be used for Single-Level Supply Chain ATP. When you perform Single-Level Supply Chain ATP from the server side, this profile determines the assignment set.

Instance Setup
If there are multiple source instances, you can associate an assignment set for each instance. The assignment set you choose for an instance will be typically the same as the assignment set you define for the MRP: ATP Assignment Set at the source instance. The profile MSC: ATP Assignment Set takes precedence over the assignment set for each instance.

Single-Level Supply Chain ATP Inquiry
Assume the cumulative ATP quantity for each of the warehouses is as shown in the following table:
The following list shows the ATP request information:

- Order quantity = 100
- Request arrival date = Day 11
- Customer = ABC
- Customer Site = ABC-Site1
- Shipping Method = Express
- Latest Schedule Limit = 2 day.

First, using this information, you perform the ATP Inquiry. During the inquiry, the system does the following:

1. Single-Level Supply Chain ATP first looks at M1. Because the shipping lead time is 1 day, the quantity must be available on Day 10. However, it is not available.

2. Because the latest schedule limit for this customer is 2 days, Single-Level Supply Chain ATP looks forward to Day 11 and Day 12. It is still not available.

3. Single-Level Supply Chain ATP now looks at M2. It is available on Date 12.

4. Single-Level Supply Chain ATP thus returns M2 as the warehouse for the request with the availability date of Day 12.

If you not only want to look at the current and planned supply for A, but also want to find out whether you can make it in M1 if there is not enough supply for A, you can do that by performing Multilevel Supply Chain ATP.

**Notes**

**ATO and PTO Models**

Currently, Global Order Promising does not recommend sourcing for ATO and PTO models. You need to enter the source warehouse when you perform an ATP inquiry.
Multilevel Supply Chain ATP

This section provides a detailed discussion on how to implement Multilevel Supply Chain ATP.

Multilevel Supply Chain ATP Feature Description

Oracle Global Order Promising lets you perform a multilevel component and resource availability check across your supply chain for the end items you specify. You can control the organizations and suppliers to be included in the availability inquiry, and you can control the number of levels in your supply chain bill to be considered in your check. At each level in the supply chain, you can check the availability of key components and bottleneck resources. Multilevel ATP also considers transit lead times between the organizations, from the suppliers, and to the customers to give you a reliable delivery promise your customers can rely on.

The following diagram depicts a simplified supply chain scenario where item A can be shipped from organization Org1 and Org2 to a customer. Both organization manufacture the item. Item A has a key component B and a bottleneck resource. Component B comes from different supplier for different organizations with different lead times.

Multilevel ATP can help you decide the following:

- Do I have supply for A at Org1? If not, can I make it at Org 1 with unutilized supplier capacity for B and my manufacturing resource R1?
Multilevel Supply Chain ATP Business Application

Multilevel ATP helps companies to increase order fill rate by promising orders using extra manufacturing and supplier capacity. Because of demand fluctuation, your planned production level can change and thus result in under-utilization of manufacturing resources or supplier capacity at times. However, if demand increases beyond forecast, you want to be able to book those orders using the extra capacity. A multilevel ATP check will ensure whether you have enough capacity to book the unanticipated demand.

As companies today outsource more and more of their assemblies or subassemblies, order promising can only become accurate if the supply chain is being considered. A factory must capable of not only making the product on time, but also delivering the product to the parent factory on time. Transit lead time between the facilities and from the suppliers become critical elements in the availability calculation. Only Multilevel ATP is capable of providing you with an accurate promise date based on the entire supply chain.

This feature is also critical in an Assemble-to-Order environment where end configuration availability depends on the availability of optional items at lower level configuration. The availability of an optional item at a lower level configuration will constrain the configuration at that level, which will in turn constrain the final configuration. Multilevel ATP ensures that you promise the end configuration accurately.

Multilevel Supply Chain ATP Setup Steps

Item Attributes

There are two item attributes: Check ATP and Component ATP.

The Check ATP flag lets you control whether to perform ATP check for that item. The Component ATP flag lets you control whether to check component availability and/or resource availability.

For Check ATP attribute, the choices are:

- Material only - Check material availability for this item at this level
- None - No need to check ATP at this level

For Component ATP attribute, the choices are:

- Material only - Check material availability for this item at this level
- None - No need to check ATP at this level
- Material only - Check availability of the components in the bill for this item.
- Resource only - Check availability of the resources required to assemble this item.
- Material and Resource - Check availability of both materials and resources required to assemble this item.
- None - No need to check ATP for this item at the component level.

For Multilevel ATP, Check ATP attribute can be set to either value. Typically you would set it to Material because you want the system to first check the item availability, and only check component availability if there is not enough available. The Component ATP flag should be set to any value other than None.

**ATP Rule**

For Multilevel ATP, planning output is used for ATP (see below for how to specify planning options).

ATP Rule is used to specify the infinite time fence. If items have different infinite time fences, you want to define different ATP Rules and assign them at the item level. Otherwise, you can simply have a default ATP Rule at the organization level.

**Plan Options**

You need to identify a particular plan (MPS, MRP, or DRP) for ATP by checking the Check ATP flag in the plan definition window in Advanced Supply Chain Planning. In a plan definition, the following options are used both for planning and ATP:

- Supply and demand
- Assignment set

For detailed setup instructions, see Setting Plan Options in Chapter 5, Defining Plans.

**Supply Chain**

You can model your supply chain through a sourcing rule (SR) or a bill of distribution (BOD) and assign SR/BOD to your items, organizations, suppliers, customers in assignment sets.

In the Single-Level Supply Chain ATP section, it was explained how you set up sourcing rule and assignment set for supplying from multiple locations (organizations). You can extend that model further to model your entire supply...
Multilevel Supply Chain ATP

chain from distribution centers to final assembly plants, from final assembly plants to subassembly plants, and from subassembly plants to component suppliers.

For detailed setup instructions, see “Sourcing Rules and Bills of Distribution.” in the Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide.

Manufacturing Capacity
Manufacturing capacity is determined by the following setup in each organization.

- Department Resource
- Work Shift

For detailed setup instruction, see Defining Resources, Defining a Workday Calendar in Oracle Bills of Material User’s Guide.

Supplier Capacity
You can define time-phased supplier capacity and capacity tolerance percentages for each item and supplier.

See Chapter 6, Supply Chain Modeling for more information about setting supplier capacity constraints.

Interlocation Transit Times
You can set up different shipping methods and transit lead times between the shipping location of your organization and an internal location associated with the customer’s ship-to location. You can designate a particular shipping method as the default method. ATP attempts to use the shipping method specified on the request to calculate the lead time. If a shipping method is not specified on the request, ATP will use the shipping method from sourcing rule. If that is not found, ATP will use the default shipping method to obtain the lead time.

Before you set up transit times between the locations, you need to have the following set up:

- Shipping methods
- A location designated for your organization as the default shipping location in the Organization window
- An internal location and its association with the customer’s ship-to address. You associate an internal location to a customer’s ship-to address in the Define Customer window.
For detailed setup instruction, see Shipping Methods, Inter-location Transit Times in Oracle Inventory User’s Guide.

**Profile - MRP: ATP Assignment Set**
This profile points to an assignment set that determines the sourcing strategy discussed in the Single-Level Supply Chain ATP section. This profile should be set up at the source instance.

This assignment set may or may not be the same as the assignment set you specify in a plan used for ATP. You can use a different assignment set to define the different part of a supply chain or you can use one assignment set.

**Profile - INV: Capable to Promise**
This profile determines whether to use ODS data or PDS data for ATP calculation. There are two values for this profile: ATP Based on Collected Data and ATP/CTP Based on Planning Output.

You must set this profile to ATP/CTP Based on Planning Output in order to perform Multilevel ATP.

**Profile - MSC: ATP Assignment Set**
This profile indicates the name of the assignment set to be used for Supply Chain ATP. When you perform Supply Chain ATP from the server side, this profile determines the assignment set used. The assignment set in this profile takes precedence over the assignment set you define in the instance window.

**Profile - MRP: ATP Database Link**
ATP uses this profile at the source instance to check if the planning server is on the same instance.

**Instance Setup**
If there are multiple source instances, you can associate an assignment set for each instance. The assignment set you choose for an instance will be typically the same as the assignment set you define for the MRP: ATP Assignment Set at the source instance.

**Data Collection and Running a Plan**
Data Collection allows you to collect transactional data from multiple instances or different application systems into a common data store for global planning. It
Multilevel Supply Chain ATP

collects various data entities such as item, bills of material, customers, forecast, sourcing rules as well as transactional data such as purchase order, miscellaneous receipts, inventory transfers, etc.

In general, if you create new entities, you need to run full (complete refresh) data collection. If you modify an existing entity, such as changing an item attribute, or you have new transactional data, you can run net-change (incremental) collection to refresh the data.

After you run collection, you can launch a plan. The planning result is the basis for Multilevel ATP.

**ATP Inquiry**

You can perform Multilevel ATP inquiry inside Order Management, i-Store or from Advanced Supply Chain Planning. Multilevel ATP can provide you with a summarized result and let you view all the detail including cumulative availability and pegging information. The calling application can decide the level of detail it wants to display.

Whether the system performs a Single-Level or Multilevel ATP check depends on the Component ATP flag. In both case, the result formats are the same. The difference is that Multilevel ATP gives you a better promise date because it is capable of utilizing any additional capacity to fulfill the demand on the request date.

**Multilevel ATP From i-Store**

An end user will get a simple availability result back when he performs an ATP inquiry inside a shopping cart. Behind the scene, ATP can perform a Multilevel ATP check based on the Check ATP and Component ATP flags.

**Multilevel ATP From Order Management**

You can perform Multilevel ATP inquiry from the Sales Order Pad.

From the Sales Order Pad:

- When you click Availability on an order line, you will see a pop up window telling you what quantity is available on the date you requested and what date the whole requested quantity is available if it’s not available on the date you want. From this pop up window, you can click Global Availability to view the multilevel supply chain availability picture, or the pegging tree.
Multilevel ATP From Advanced Supply Chain Planning

You can perform ATP inquiry using the ATP Inquiry window from the Advanced Supply Chain Planning product menu.

From the ATP Inquiry window:

- This window allows you to enter ATP criteria and view ATP result. You can see both the summarized ATP result as well as detailed pegging view.

Please see ATP Inquiry on page 16-74 for additional information.

ATP Logic for Multilevel Supply Chain ATP

Multilevel ATP is processed by the system as follows:

Multilevel ATP Logic in a Single Organization

1. If both the Check ATP flag and the Component ATP flag are set to None, no ATP check is performed.

   If the Check ATP flag is set to Materials, an ATP check for the item on the request date is performed. If there is enough supply on the request date, the ATP check is finished. If there is not enough supply, the system goes to step 2.

   If the Check ATP flag is set to None and Component ATP flag is not set to None, the shortage for the item is assumed to be the amount of the request quantity. The system goes to step 3.

2. If Component ATP flag is set to None, the request is not satisfied. The system goes to step 7.

3. If Component ATP flag is not set to None, a new supply to cover the shortage of this end item is simulated. The bill of material is exploded to get to the next level component and resource requirements to assemble the end item. The system goes to step 4.

4. If resource requirements exist, the availability of resources is checked. If resources are found, the system goes to step 5.

   If resources are not found, ATP fails for this request. The system goes to step 7.

5. If component requirements exist, the availability of material components is checked. If material components are found, the check is finished.

   If material components are not found, the system goes to step 6.
6. If Component ATP flag is not set to None, new supplies for the shortage are recursively simulated, the bill of material is exploded, and availability is checked at the next level. If there is still not enough supply and the system cannot go down to the next level for the shortage, the system goes to step 7.

7. ATP has failed to satisfy this request. From request date, forward scheduling for this request is performed. The system searches for the earliest date that it can get the remaining quantity. The earliest date is the ATP date.

**Multilevel ATP Logic Involving Supply Chain**

1. The source with the highest rank is chosen. If the source type is buy from, availability from sourcing is checked. If the source type is make at or transfer, the system goes to step 2.

2. Check ATP is run for the end item at that organization (refer to Single Org ATP for the ATP calculation) based on the Check ATP flag and Component ATP flag. The supply chain bill is exploded to get to the next level component requirements for the shortage of the end item based on end item Component ATP flag. Resource and materials requirements from the supply chain bill based on the flags are considered. If there is enough resource and material availability on a certain date, the ATP check is successful, and the date becomes the ATP date.

3. If not successful, the ATP date in this organization is found by forward scheduling from the request date. The system goes to the organization with next highest rank and repeats step 2. If the system does not find any more organizations, it goes to step 4.

4. The system returns the highest ranking organization as the source. The ATP date is the earliest availability date in that organization.

**Multilevel Supply Chain ATP Example**

**Example 1: Multilevel ATP in a Single Organization**
Assume assembly A has the following bill in Org1.
Lead time information for A and B is as shown in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Fixed Lead Time</th>
<th>Variable Lead Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>0</td>
<td>0.1</td>
</tr>
<tr>
<td>B</td>
<td>1</td>
<td>0.01</td>
</tr>
</tbody>
</table>

The routing information for Item A and Item B is as shown in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Op Seq</th>
<th>Resource</th>
<th>Usage</th>
<th>Lead time offset</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>1</td>
<td>R1</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>B</td>
<td>1</td>
<td>R2</td>
<td>2</td>
<td>20%</td>
</tr>
</tbody>
</table>

Planning information for Item A and Item B from an MRP run on Date1 is as shown in the following table:

<table>
<thead>
<tr>
<th>Supply/Demand Type</th>
<th>Item A</th>
<th>Item B</th>
<th>Item C</th>
<th>Item D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales Orders</td>
<td>10</td>
<td>5</td>
<td>50</td>
<td>40</td>
</tr>
<tr>
<td>Forecasts</td>
<td>100</td>
<td>10</td>
<td>75</td>
<td>60</td>
</tr>
<tr>
<td>Dependent Demand</td>
<td>0</td>
<td>145</td>
<td>270</td>
<td>135</td>
</tr>
<tr>
<td>Scheduled Receipts</td>
<td>5</td>
<td>25</td>
<td>50</td>
<td>50</td>
</tr>
<tr>
<td>Planned Order</td>
<td>105</td>
<td>135</td>
<td>345</td>
<td>185</td>
</tr>
<tr>
<td>ATP</td>
<td>100</td>
<td>10</td>
<td>75</td>
<td>60</td>
</tr>
</tbody>
</table>
Suppose we have the cumulative ATP quantities from the planning run as shown in the following two tables:

<table>
<thead>
<tr>
<th>Item</th>
<th>Date0</th>
<th>Date1</th>
<th>Date2</th>
<th>Date3</th>
<th>Date4</th>
<th>Date5</th>
<th>Date6</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>100</td>
<td>100</td>
<td>110</td>
<td>110</td>
<td>150</td>
<td>160</td>
<td>170</td>
</tr>
<tr>
<td>B</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>200</td>
<td>255</td>
<td>260</td>
<td>270</td>
</tr>
<tr>
<td>C</td>
<td>10</td>
<td>75</td>
<td>85</td>
<td>85</td>
<td>85</td>
<td>90</td>
<td>100</td>
</tr>
<tr>
<td>D</td>
<td>50</td>
<td>60</td>
<td>60</td>
<td>60</td>
<td>60</td>
<td>65</td>
<td>70</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Resource</th>
<th>Date0</th>
<th>Date1</th>
<th>Date2</th>
<th>Date3</th>
<th>Date4</th>
<th>Date5</th>
<th>Date6</th>
</tr>
</thead>
<tbody>
<tr>
<td>R1</td>
<td>16</td>
<td>16</td>
<td>16</td>
<td>16</td>
<td>20</td>
<td>22</td>
<td>24</td>
</tr>
<tr>
<td>R2</td>
<td>16</td>
<td>16</td>
<td>16</td>
<td>16</td>
<td>22</td>
<td>24</td>
<td>26</td>
</tr>
</tbody>
</table>

The values of the Check ATP flag and Component ATP flag of the request item determine the level of the ATP check, which may cause different results for the same request. Assume that the Check ATP flag at bill level is Yes for all items.

**Example 1: Request 100 of Item A on Date3 in Org1**

<table>
<thead>
<tr>
<th>Item</th>
<th>Check ATP flag</th>
<th>Component ATP flag</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Materials</td>
<td>None</td>
</tr>
</tbody>
</table>

We do have ATP quantity 100 on Date3. ATP date is Date3.

**Example 2: Request 120 of Item A on Date3 in Org1**

<table>
<thead>
<tr>
<th>Case 2.1</th>
<th>Item</th>
<th>Check ATP flag</th>
<th>Component ATP flag</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td></td>
<td>Materials</td>
<td>None</td>
</tr>
</tbody>
</table>

1. We do not have ATP quantity 120 on Date3.
2. Component ATP flag is None. We cannot go to next level. ATP fails for this request.
For Item A, we can have 110 on Date3 and 120 on Date4. ATP date is Date4.

**Case 2.2**

<table>
<thead>
<tr>
<th>Item</th>
<th>Check ATP flag</th>
<th>Component ATP flag</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Materials</td>
<td>Materials</td>
</tr>
<tr>
<td>B</td>
<td>Materials</td>
<td>None</td>
</tr>
</tbody>
</table>

1. We don’t have 120 of Item A on Date3.
2. The Component ATP flag is Materials. The shortage is 10 for Item A. The lead time to build 10 of Item A is one day. Therefore, we need 10 of Item B on Date2 to build this simulated supply of 10.
3. We do have 10 of Item B on Date2. So ATP date is Date3; use 110 of Item A on Date3 and 10 of Item B on Date2.

**Case 2.3**

<table>
<thead>
<tr>
<th>Item</th>
<th>Check ATP flag</th>
<th>Component ATP flag</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Materials</td>
<td>Materials and Resources</td>
</tr>
<tr>
<td>B</td>
<td>Materials</td>
<td>None</td>
</tr>
</tbody>
</table>

1. We don’t have 120 of Item A on Date3. The shortage is 10.
2. The Component ATP flag of Item A is Materials and Resources. Simulate a supply of Item A for quantity 10. Explode the bill to the next level. The lead time to build 10 of Item A is one day. We need 10 of Item B on Date2 and 10 R1 on Date2 to build 10 of Item A.

   We do have 10 R1 on Date2.

   We do have 10 of Item B on Date2. So ATP date is Date3; use 110 of Item A on Date3, 10 of Item B on Date2, and 10 of R1 on Date2.

**Example 3: Request 165 of Item A on Date4 in Org1**

<table>
<thead>
<tr>
<th>Item</th>
<th>Check ATP Flag</th>
<th>Component ATP Flag</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Materials</td>
<td>Materials and Resources</td>
</tr>
<tr>
<td>B</td>
<td>Materials</td>
<td>Materials and Resources</td>
</tr>
</tbody>
</table>
1. We don’t have 165 of Item A on Date4. The shortage is 15.

2. The Component ATP flag of Item A is Materials and Resources. Simulate a supply of Item A for quantity 15. Explode the bill to the next level. The lead time to build 15 of Item A is two days. We need 15 of Item B on Date2 and 15 R1 on Date2 to build 15 of Item A.

3. We do have 15 R1 on Date2.

4. However, we only have 10 of Item B on Date2, and the shortage is 5.

5. The Component ATP flag of Item B is Materials and Resources. Simulate a supply of Item B for quantity 5. Explode the bill to the next level. The lead time to build 5 of Item B is two days. We need 10 of Item C and 5 of Item D on Date0, and 10 R2 on Date1 (Date2-CEIL((1+0.01*5)*80%)).

6. We do have 10 R2 on Date1.

7. We do have 10 of Item C and 5 of Item D on Date0. So ATP date is Date4; use 150 of Item A on Date4, 10 of Item B on Date2, 15 of R1 on Date2, 10 of Item C on Date0, 5 of Item D on Date0, and 10 of R2 on Date1.

Case 4: Request 130 of Item A on Date2 in Org1

1. We don’t have 130 of Item A on Date2.

2. The Component ATP flag of Item A is Materials and Resources. Simulate a supply of Item A for quantity 20. Explode the bill to the next level. The lead time to build 20 of Item A is two days. We need 20 of Item B on Date0 and 20 R1 on Date0 to build 20 of Item A.

3. We don’t have enough R1 on Date0. ATP fails for this request on request date.

4. We can only make 16 of Item A since we only have 16 R1 available on Date0.
5. We can only make 10 of Item A since we only have 10 of Item B available on Date0 although we have 16 R1 available on Date0. The request date ATP quantity is 120.

6. Do forward scheduling from sysdate (Date0) for Item A with quantity 10.

7. The earliest date we can have another 10 R1 is Date4 (the supply picture of R1 has been changed since we have used 10 R1 in Date0 to build 10 of Item A).

8. The earliest date we can have 10 of Item B is Date3 (the supply picture of Item B has been changed since we have used 10 of Item B in Date0 to build 10 of Item A).

9. Considering lead time, the earliest date we can have 10 of Item A built is Date5 (= max(Date3 + 1, Date4 +1))

10. If we don’t build 10 of Item A, we can have 130 of Item A on Date4. Date4 < Date6. ATP date is Date4. We can provide 130 on Date4.

Example 2: Multilevel ATP for a Supply Chain BOM

The supply chain bill looks like the following figure:

![Supply Chain BOM Diagram]

For an item with no associated sourcing information, the item is assumed to make at the current organization.

Assume that Customer1 has the following sourcing rule, shown in the next table, with assembly A.
Org1
The bill and routing for item A in Org1 is the same as the information provided in the previous example. No sourcing information is defined for item A in Org1. It is assumed that item A in Org1 has an implicit supply chain bill which is shown in the following table:

<table>
<thead>
<tr>
<th>Source Type</th>
<th>Org</th>
<th>Rank</th>
<th>Shipping Lead Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>transfer from</td>
<td>Org1</td>
<td>1</td>
<td>1 day</td>
</tr>
<tr>
<td>transfer from</td>
<td>Org2</td>
<td>2</td>
<td>2 days</td>
</tr>
</tbody>
</table>

The cumulative ATP quantities in Org1 are shown in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Date0</th>
<th>Date1</th>
<th>Date2</th>
<th>Date3</th>
<th>Date4</th>
<th>Date5</th>
<th>Date6</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>100</td>
<td>100</td>
<td>110</td>
<td>110</td>
<td>150</td>
<td>160</td>
<td>170</td>
</tr>
<tr>
<td>B</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>200</td>
<td>255</td>
<td>260</td>
<td>270</td>
</tr>
<tr>
<td>R1</td>
<td>16</td>
<td>16</td>
<td>16</td>
<td>16</td>
<td>20</td>
<td>24</td>
<td>26</td>
</tr>
</tbody>
</table>

Org2
The supply chain bill for item A in Org2 is shown in the following table:

<table>
<thead>
<tr>
<th>Source Type</th>
<th>Org</th>
<th>Rank</th>
<th>Shipping Lead Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>transfer from</td>
<td>Org3</td>
<td>1</td>
<td>1 day</td>
</tr>
<tr>
<td>make at</td>
<td>Org2</td>
<td>2</td>
<td>0 days</td>
</tr>
</tbody>
</table>

Item A in Org2 uses the common bill from item A in Org1. The fixed lead time of Item A is 0 and the variable lead time is 0.1 day.

Item B is a buy item and it sources from Supplier1 with lead time of 0 days. Assume Supplier1 can provide 100 of Item B for Org2 from Date0 to Date10.

The cumulative ATP quantities in Org2 are shown in the following table:
Org3

The cumulative ATP quantities in Org2 are:

<table>
<thead>
<tr>
<th>Item/Res</th>
<th>Date1</th>
<th>Date2</th>
<th>Date3</th>
<th>Date4</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>100</td>
<td>120</td>
<td>120</td>
<td>150</td>
</tr>
<tr>
<td>B</td>
<td>10</td>
<td>40</td>
<td>50</td>
<td>60</td>
</tr>
<tr>
<td>R1</td>
<td>16</td>
<td>16</td>
<td>16</td>
<td>16</td>
</tr>
</tbody>
</table>

Note: Assume that the Check ATP flag at bill level for all items in every org is set to Yes.

Example 1: Customer1 requests 100 of item A with Date4 delivery date

<table>
<thead>
<tr>
<th>Item</th>
<th>Org</th>
<th>Check ATP flag</th>
<th>Component ATP flag</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Org1</td>
<td>M</td>
<td>None</td>
</tr>
<tr>
<td>A</td>
<td>Org2</td>
<td>M</td>
<td>None</td>
</tr>
</tbody>
</table>

1. The system checks the availability of 100 of Item A on Date3 at Org1. The item is available. Therefore, ATP date is Date3 from Org1 and Customer1 will receive it on Date4 because shipping lead time is 1 day. This request is satisfied by using 100 of Item A on Date3 in Org1.

Example 2: Customer1 requests 120 of item A with Date4 delivery date

<table>
<thead>
<tr>
<th>Item</th>
<th>Org</th>
<th>Check ATP Flag</th>
<th>Component ATP Flag</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Org1</td>
<td>M</td>
<td>None</td>
</tr>
<tr>
<td>A</td>
<td>Org2</td>
<td>M</td>
<td>M+R</td>
</tr>
</tbody>
</table>
1. The system checks the availability of 120 of Item A on Date3 at Org1. The request (refer to previous example) cannot be satisfied. Item A has availability of 120 on Date4. ATP date in Org1 is Date4 and Customer1 will receive it on Date5. The request is satisfied by using 110 of Item A in Org1 on Date3 and total of 120 of Item A in Org1 on Date4.

2. The system checks the availability of 120 of Item A on Date2 at Org2. The item is available. ATP date is Date2 from Org2 and Customer1 will receive it on Date4. The request is satisfied by using 120 of Item A in Org2 on Date2.

Example 3: Customer1 requests 145 of Item A with Date4 delivery date

1. The system checks the availability of 145 of Item A on Date3 at Org1. The request cannot be satisfied. Item A has availability of 145 on Date4. The ATP date in Org1 is Date4 and Customer1 will receive it on Date5. The request is satisfied by: 110 of Item A in Org1 on Date3 and total of 145 of Item A in Org1 on Date4.

2. The system checks the availability of 145 of Item A on Date2 at Org2. There is not enough of Item A and the shortage is 25.

3. The Component ATP flag is Material and Resources. Simulate a supply of Item A for quantity 25. Explode the supply chain bill to the next level and the org with the highest rank is Org3.

4. The system checks the availability at Org3 and tries to transfer 25 of Item A from Org3 on Date1 to cover the shortage. There is only 20, and so the shortage is 5.

5. The system checks the availability at Org2 and tries to make 5 of Item A to cover the shortage. Five of Item B and 5 R1 on Date1 is needed. There is 10 R1 on Date1. There is 10 of Item B on Date1. ATP date is Date2 from Org2 and customer will receive it on Date4. The request is satisfied by using 120 of Item A in Org2 on Date2, 20 of Item A in Org3 on Date1, 5 of R1 in Org2 on Date1, and 5 of Item B in Org2 on Date1.
Notes

**Product Dependency**
Oracle Global Order Promising and Oracle Advanced Supply Chain Planning product are required.

**Multilevel ATO Model**
For multilevel ATO models (ATO models within ATO model where sub-ATO models are nonphantom items), you can perform ATP inquiry for any optional items under any ATO models. You need Global Order Promising and Oracle Advanced Supply Chain Planning products installed.
Allocated ATP

This section provides a detailed discussion on how to use Allocated ATP.

Allocated ATP Feature Description

The Allocation feature allows you to allocate scarce material or resources among multiple sales channels. Based on your business strategy, you can establish an Allocation Rule which ranks the sales channels and rations the supply among them. You can time phase the allocation to reflect changes in your monthly or quarterly objectives. During order promising, Oracle Global Order Promising honors the allocation rule and calculates order due dates, considering material and capacity constraints at each level of the supply chain.

You can define two types of hierarchies to represent your various sales channels. You can use demand classes which are single-level and user-defined or, you can use customer classes which have 3 levels: customer class, customer, and site. Whichever hierarchy you choose, you can define allocation rules. With these rules, allocation percentages can be specified for each node in the hierarchy. In addition, you can define priorities against your allocation rules. These priorities can be used to steal supplies from lower priority nodes if supplies are not available. The allocation rules can be assigned to either Global, Item Category, Item, Resource Group or Department Resource level. Notifications are sent to you if scheduling fails, or if scheduling is only successful by stealing allocation from other nodes.

Allocation provides you with significant control over the demand fulfillment process to achieve your customer service and profitability goals.

Allocated ATP Business Applications

When supply is scarce, it is important for suppliers to control which customers and demands are satisfied. The supplier does not want to allow their most important customers to go to another supplier because their ATP request was not fulfilled. The supplier needs to guarantee that the important demands are met, and that each of their various sales channels are allocated a percentage of the total supply.

In addition, the supplier needs flexibility in controlling how their demands are grouped. In other words, the supplier may want to have a single-level grouping, and thus would use a demand-class hierarchy. Otherwise, the supplier may want to divide their customers by customer class, customer, and site, and thus use the three-level, customer-class hierarchy.
For example, a supplier could define a single-level hierarchy with demand classes based on their various sales channels by geographical locations, such as Africa, Australia, Europe, and Asia. This supplier might want to guarantee that each of these areas gets an equal percentage of the total supply. Thus, the supplier will allocate 25% of their total supply to each of the demand classes. However, the supplier might have higher priority customers in Europe that they don’t want to risk losing, while the customers in Australia are less critical. Thus, the supplier would assign Europe a priority of 1, and Australia a priority of 2. If demands in Europe exceed the available allocated supply, then the demands can still be satisfied by stealing the allocation from Australia. The customer’s order in Europe could be fulfilled while the supplier would receive a notification indicating that the European demand class stole supply from the Australian demand class.

Allocated ATP Setup Steps

To enable allocation, the following setup steps must be performed.

**Item Attributes**

There are two item attributes: Check ATP flag and Component ATP flag.

You can control what type of ATP check you want to perform at the level of each item or higher. The Check ATP flag can be set to either:

- Material only - Check material availability for this item at this level
- None - No need to check ATP at this level

You can also control what kind of ATP check you want to perform at the component level. The possible choices for the Component ATP flag are:

- Material only - Check availability of the components in the bill for this item.
- Resource only - Check availability of the resources required to assemble this item.
- Material and Resource - Check availability of both materials and resources required to assemble this item.
- None - No need to check ATP for this item at the component level.

Even if the Component ATP flag indicates that a component check is required, the Check ATP flag at the bill level can override the setting in the Component ATP flag.

**ATP Rule**

For Allocated ATP, planning output is used for ATP.
ATP Rule is used to specify the infinite time fence. If items have different infinite time fence, you want to define different ATP Rules and assign them at the item level. Otherwise you can simply have a default ATP Rule at the organization level.

**ATP Plan**
You need to identify a particular plan (MPS, MRP, or DRP) for ATP by checking the Check ATP flag in the plan definition window in Advanced Supply Chain Planning.

In a plan definition, the following options are used both for planning and ATP:

- Supply and demand
- Assignment set

**Define Demand Classes**
If you are using demand class hierarchy, set up demand classes to represent the various sales channels. For more information on setting up demand classes, please refer to Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide.

**Define Customer Class Hierarchy**
If using customer class hierarchy, set up customer classes, customers, and sites to represent the various sales channels. For more information on setting up customer classes, please refer to the Oracle Accounts Receivable User’s Guide.

**Define Allocation Rules**
Allocation rules must be defined on the Planning server. These rules determine how the supply will be allocated to the various sales channels.

Allocation rules have the following features: effective dates, percentages, and priorities.

- **Allocation Effective Dates**
  You can define time-phased allocation percentages. The ATP engine determines which allocation percentage to use based on the dates of the suppliers and demands. The allocation hierarchy needs to be the same across the entire planning horizon.

- **Allocation Percentages**
  You can define allocation percentages for each node in the hierarchy. Your supply will be allocated to those nodes based on the allocation percentages. If the total percentages do not add up to 100% on each level, the remaining
percentages are assigned to the category of Other. All nodes on each level that were not assigned a percentage in the allocation rule are included in Other.

---

**Note:** This applies to Customer Hierarchy only.

---

- Allocation Priorities

You can define priorities against your allocation rules to be used to steal supply from other nodes if supply is not available. Priorities are assigned to each node on each level, and you can only steal from those with lower priority.

德拉特

**To define the Allocation rules:**

1. From the Navigator window, choose Advanced Supply Chain Planning.
2. Choose ATP > Allocation > Define Allocation Rule.

The Allocation Rule window appears.

---

**Figure 16–1 Allocation Rule window**

---

---

---
3. Enter name, description, and the effective dates for the rule. For each demand class, assign an allocation percentage and priority.

**Assign Allocation Rules**
Once the rules have been defined, the allocation rules must be assigned so that the ATP engine knows which rule to use for each item, etc. Allocation rules can be defined at a variety of levels for supplier convenience.

For material planning, the levels are: (from general to specific)
- Global
- Item Category (those categories that are part of the planning category set)
- Item
- Organization
- Item/Organization

The levels for resources are: (from general to specific)
- Global
- Organization
- Resource Group
- Department Resource

A more specific level can override a more general level assignment. For example, if there is a rule for a particular item and a different rule for the category of that item, then the effective rule will be the item rule.

The refresh hierarchy process must be started for ATP to see the allocations. Please refer to the next section to see more information on where and how this process is enabled.

**To assign Allocation Rules:**
1. From the Navigator window, choose Advanced Supply Chain Planning.
2. Choose ATP > Allocation > Assign Allocation Rules.
   The Assign Allocation Rule screen appears.
3. Choose level in the Assign To column.
4. Choose the correct level. Depending on the level you have chosen, you must fill in the respective column.
5. To include a description, scroll to the Description column and enter a description.
6. In the Allocation Rule column, either enter the name of the Allocation Rule or select the rule from the full list.

**Profile - INV: Capable to Promise**
This profile determines whether to use ODS data or PDS data for ATP calculation. There are two values for this profile: ATP Based on Collected Data and ATP/CTP Based on Planning Output.

You must set this profile to ATP/CTP Based on Planning Output for Allocated ATP to work.

**Profile - MSC: Class Hierarchy**
This profile determines the type of hierarchy that will be used. There are two values for this profile:
- Demand Class: This hierarchy is a user-defined, single-level hierarchy.
- Customer Class: This hierarchy has 3 levels: customer class, customer, and site.
Profile - MSC: Enable Allocated ATP
To enable allocation, set the profile option: MSC: Enable Allocated ATP to yes.

Profile - MSC: Enable Allocated Workflow
To enable workflow notifications that are specifically for Allocated ATP, set the profile option: MSC: Enable Allocated Workflow to yes.
Workflow notifications are automatically triggered and sent to the item planner and sales representative/customer contact when the following happens:
- ATP fails on request date during scheduling, or
- ATP is successful only by stealing allocation from a lower priority demand class

Profile - MRP: ATP Database Link
ATP uses this profile at the source instance to check if the planning server is on the same instance.

Allocated ATP Data Collection
Data Collection allows you to collect transactional data from multiple instances or different application systems into a common data store for global order promising and supply chain planning. It collects various data entities such as items, bills of material, customers, forecasts, sourcing rules as well as transactional data such as purchase orders, miscellaneous receipts, inventory transfers, etc.

In general, if you create new entities, you need to run full (complete refresh) data collection. If you modify an existing entity, such as changing an item attribute, or you have new transactional data, you can run net-change (incremental) collection to refresh the data.

ATP Inquiry and Viewing Allocations
You can perform an ATP inquiry inside Order Management, i-Store, or from Advanced Supply Chain Planning. The inquiry results include the available quantity on the request date and the fulfillment date when the entire quantity is available. In addition, the detailed response includes a pegging view that shows the supply that satisfies the demand. The calling application can decide the level of detail it wants to display.

When Enable Allocated ATP is set to Yes, Global Order Promising processes each ATP request based on the allocated supply rather than total supply. It uses the
demand class or customer information from the ATP request and nets the demand against the allocated supply for that specific demand class or customer. Depending on the profile MSC:Class Hierarchy, Global Order Promising will either use demand class or customer class for allocated ATP.

**Allocated ATP From i-Store**
You can perform allocated ATP by customer class from i-Store. The results seen by the end user who is performing the ATP inquiry is in the same format as Basic ATP.

**Allocated ATP From Order Management**
You can perform Allocated ATP by demand class or customer class (depending on the profile setting) from the Sales Order Pad.

From the Sales Order Pad:
- You can perform allocated ATP in the same way you perform other ATP functions. The ATP engine uses the demand class or customer information from the sales order to determine the allocated availability. The result is displayed in a popup ATP Result window.

**Allocated ATP From Advanced Supply Chain Planning**
You can perform ATP inquiry using the ATP Inquiry window from the Advanced Supply Chain Planning product menu.

From the ATP Inquiry window:
- This window allows you to enter ATP criteria and view ATP results. You can see both the summarized ATP results as well as a detailed pegging view. The only difference between an inquiry without allocation and one with allocation is that if Allocated ATP is being used, then it matters from where the request originates. Thus, depending on the hierarchy that is being used, the inquiries should contain either the demand class, or the customer class, customer, and site.

For example, ATP inquiries that are identical, in terms of item, quantity, etc., but differ only by demand class will lead to different results. The available supply has been allocated by percentages to the various demand classes, and thus the ATP result for each demand class may be different.

If you are using demand-class hierarchy and an ATP inquiry is made without a demand class, then the default demand class is used. A default demand class can be assigned to your organization.
View Allocations Workbench
You can view the horizontal plan for your allocated ATP through a view allocations workbench. In this workbench, the left-hand side is the tree structure representing your hierarchy. You can choose a node (for instance, a particular site within a customer if using customer-class hierarchy or a demand class if using demand-class hierarchy) and view the horizontal plan. The horizontal plan gives a picture over time of the total demand, total supply, net ATP, and cumulative ATP for the total and for the particular node that you chose.

In addition, you can change the allocation percentages and priorities for any node directly from the workbench and immediately view the effects. You can do this by clicking on any of the nodes and filling in the Define Allocation Rules form.

➢ To view allocations:
  1. From the Navigator window, choose Advanced Supply Chain Planning.
  2. Choose ATP > Allocation > View Allocation.
3. Enter Organization. Then enter either the item or the department/resource.

4. To choose a demand class, click once on the appropriate class in the Demand Class table.

**Refreshing Allocations**

You can make modifications to both the percentages and priorities that are defined in your allocation rules. You can get to these forms to make the changes by either opening the define allocation rule form from the advanced supply chain planner menu or from the allocations workbench. Any changes along the hierarchy can be instantly viewed in the allocation workbench. However, for any of these effects to be used by ATP, the hierarchy must be refreshed. You can refresh the allocation hierarchy from the Tools menu, or from a button found on the form and this will start the process to allocate the supplies based on the current rules. Again, the refresh hierarchy process must be started for the allocations to occur in ATP.
Allocated ATP Example

Here are a few examples to illustrate how allocated ATP can be used. The first example is simple, and shows allocated ATP based on percentages. The second example also incorporates priorities, and thus shows the stealing functionality. The first two examples use the demand-class hierarchy. The final example shows how ATP works with a customer-class hierarchy.

Allocated ATP based on Percentages

In this case, the supplier is using two demand classes to represent various sales channels. Demand class DCb contains customers that are more important to this supplier, and thus he wants to guarantee that 60% of the total supply is allocated to this group of demands.

Allocation Rule

<table>
<thead>
<tr>
<th>Demand Class</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>DCa</td>
<td>40%</td>
</tr>
<tr>
<td>DCb</td>
<td>60%</td>
</tr>
</tbody>
</table>

The supply and demand picture for this example is shown in the table below. There is one sales order coming from demand class DCa for 20 and there are two sources of supply: a work order for 25 and a purchase order for 35.

Demands and Supplies

<table>
<thead>
<tr>
<th>Demands and Supplies</th>
<th>Demand Class</th>
<th>Quantities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand Sales Order</td>
<td>DCa</td>
<td>20</td>
</tr>
<tr>
<td>Supply Work Order</td>
<td>n/a</td>
<td>25</td>
</tr>
<tr>
<td>Supply Purchase Order</td>
<td>n/a</td>
<td>35</td>
</tr>
</tbody>
</table>

The overall availability picture is 25+35-20= 40. This is calculated by adding the total supplies and subtracting the already committed demand of 20. If there is no allocation, the availability for any ATP requests from any demand class is 40.

With the allocation rules in place, this supply is rationed to the demand classes based on the predefined percentages.
For Demand Class DCa:

<table>
<thead>
<tr>
<th>Demands and Supplies</th>
<th>Quantities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand S/O</td>
<td>20</td>
</tr>
<tr>
<td>Supply W/O</td>
<td>10 ( = 25 * 40%)</td>
</tr>
<tr>
<td>Supply P/O</td>
<td>14 ( = 35 * 40%)</td>
</tr>
</tbody>
</table>

Thus, the ATP quantity for this demand class is \(4 = 10 + 14 - 20\).

For Demand Class DCb:

<table>
<thead>
<tr>
<th>Demands and Supplies</th>
<th>Quantities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supply W/O</td>
<td>15 ( = 25 * 60%)</td>
</tr>
<tr>
<td>Supply P/O</td>
<td>21 ( = 35 * 60%)</td>
</tr>
</tbody>
</table>

Thus, the ATP quantity for this demand class is \(36 = 15 + 21 - 0\).

Therefore, with the allocation rules, demand class DCb is guaranteed to be allocated 60% of the supply which is 36. Without these rules in place, customers from demand class DCa could keep submitting orders, and when a demand came from DCb, no supply would be available.

Allocated ATP based on Percentages and Priorities

This example illustrates how allocated ATP works with both percentages and priorities. The supply is allocated to the demand classes based on the percentages that are defined within the allocation rules. Yet, if a higher priority demand class still needs more supply, they can steal the necessary supply from the lower priority demand classes.

Allocation Rule

<table>
<thead>
<tr>
<th>Demand Class</th>
<th>Priority</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>DCa</td>
<td>1</td>
<td>30%</td>
</tr>
<tr>
<td>DCb</td>
<td>2</td>
<td>20%</td>
</tr>
<tr>
<td>DCc</td>
<td>3</td>
<td>50%</td>
</tr>
</tbody>
</table>
In this example, the supplier has defined three demand classes. He has assigned certain percentages to these demand classes, but in addition he has ranked the priorities of these demands. In this scenario, demand class DCc has the largest number of customers and thus has been allocated the largest percentage of the available supply. However, demand class DCa has more important customers and thus they should be allowed to steal the supply from the other demand classes if they want to submit an order.

The supply and demand picture is as follows:

### Demands and Supplies

<table>
<thead>
<tr>
<th>Demands and Supplies</th>
<th>Demand Class</th>
<th>Quantities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand Sales Order</td>
<td>DCa</td>
<td>20</td>
</tr>
<tr>
<td>Demand Forecast</td>
<td>DCb</td>
<td>30</td>
</tr>
<tr>
<td>Demand Forecast</td>
<td>DCa</td>
<td>10</td>
</tr>
<tr>
<td>Supply Work Order</td>
<td>n/a</td>
<td>25</td>
</tr>
<tr>
<td>Supply Purchase Order</td>
<td>n/a</td>
<td>35</td>
</tr>
</tbody>
</table>

Based on the above tables, the available quantity is $25 + 35 - 20 = 40$. Note that the demand forecasts are not included in the availability calculation. The available supply is based purely on the total supply less the committed demand.

Using the percentages defined in the allocation rules, the tables below illustrate the availability picture in each of the demand classes.

**For Demand Class DCa:**

<table>
<thead>
<tr>
<th>Demands and Supplies</th>
<th>Quantities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand S/O</td>
<td>20</td>
</tr>
<tr>
<td>Demand F/C</td>
<td>10</td>
</tr>
<tr>
<td>Supply W/O</td>
<td>7.5 ($ = 25 * 30%$)</td>
</tr>
<tr>
<td>Supply P/O</td>
<td>10.5 ($ = 35 * 30%$)</td>
</tr>
</tbody>
</table>

Thus, the ATP quantity for this demand class is $-2 = 10.5 + 7.5 - 20$. 
For Demand Class DCb:

<table>
<thead>
<tr>
<th>Demands and Supplies</th>
<th>Quantities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand F/C</td>
<td>30</td>
</tr>
<tr>
<td>Supply W/O</td>
<td>5 ( = 25 * 20%)</td>
</tr>
<tr>
<td>Supply P/O</td>
<td>7 ( = 35 * 20%)</td>
</tr>
</tbody>
</table>

Thus, the ATP quantity for this demand class is 12 = 5 + 7 - 0.

For Demand Class DCc:

<table>
<thead>
<tr>
<th>Demands and Supplies</th>
<th>Quantities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supply W/O</td>
<td>12.5 ( = 25 * 50%)</td>
</tr>
<tr>
<td>Supply P/O</td>
<td>17.5 ( = 35 * 50%)</td>
</tr>
</tbody>
</table>

Thus, the ATP quantity for this demand class is 30 = 12.5 + 17.5 - 0.

The above figures only take into account the percentages. Notice that the ATP quantity for demand class DCa is negative. Since this demand class has the highest priority, these demands must be satisfied if possible, so this demand class steals from the lower priority demand classes.

The final availability picture for each of the demand classes is as follows:

- The availability for DCa is -2.
- The availability for DCb is 10. This is because DCa has a higher priority than DCb, so DCb needs to take care of the over commitment from DCa. Demand class consumption is used and 2 are stolen DCa. Thus, the availability for DCb is 12 + (-2) = 10.
- The availability for DCc is 30 because nothing from DCa and DCb needs to be taken care of here. Demand class consumption is used for DCa at DCb. Since DCb has already taken care of DCa, no further consumption is necessary.

Allocated ATP Using Customer-Class Hierarchy

This example illustrates how allocated ATP works with customer-class hierarchy. The supply is allocated to the customer classes, customers, and sites based on the percentages that were defined within the allocation rules.
The following diagram illustrates a customer-class hierarchy.

The following percentages and priorities have been defined in the allocation rule. The actual percentage is calculated by multiplying the entered percentage by the parent’s allocation percentage. For example, in the computer industry there are 3 customers, Dell, IBM, and other. The percentages for those 3 must add up to 100. The entered percentage for Dell is 40% and thus the actual percentage of the total that Dell will receive is 40% of what the Computer Industry is allocated, and thus 28%.

**Allocation Rule**
The following tables show the allocation rule:

**Customer Class Level**

<table>
<thead>
<tr>
<th>Customer Class</th>
<th>Priority</th>
<th>Percentage</th>
<th>Actual Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer Industry</td>
<td>1</td>
<td>70%</td>
<td>70%</td>
</tr>
<tr>
<td>Other</td>
<td>2</td>
<td>30%</td>
<td>30%</td>
</tr>
</tbody>
</table>

**Customer Level**

<table>
<thead>
<tr>
<th>Customer Class</th>
<th>Customer</th>
<th>Priority</th>
<th>Percentage</th>
<th>Actual Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer Industry</td>
<td>Dell</td>
<td>1</td>
<td>40%</td>
<td>28%</td>
</tr>
<tr>
<td>Computer Industry</td>
<td>IBM</td>
<td>2</td>
<td>40%</td>
<td>28%</td>
</tr>
</tbody>
</table>
Site Level

<table>
<thead>
<tr>
<th>Customer Class</th>
<th>Customer</th>
<th>Site</th>
<th>Priority</th>
<th>Percentage</th>
<th>Actual Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer Industry</td>
<td>Other</td>
<td>3</td>
<td>20%</td>
<td>14%</td>
<td></td>
</tr>
</tbody>
</table>

Demands and Supplies

<table>
<thead>
<tr>
<th>Demands and Supplies</th>
<th>Customer Class/ Customer/ Site</th>
<th>Quantities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand Sales Order</td>
<td>Computer Industry/ Dell/ Europe</td>
<td>20</td>
</tr>
<tr>
<td>Demand Sales Order</td>
<td>Computer Industry/ IBM/ Russia</td>
<td>10</td>
</tr>
<tr>
<td>Demand Sales Order</td>
<td>Computer Industry/ IBM/ China</td>
<td>5</td>
</tr>
<tr>
<td>Demand Sales Order</td>
<td>Computer Industry/ Dell/ Australia</td>
<td>10</td>
</tr>
<tr>
<td>Supply Purchase Order</td>
<td>n/a</td>
<td>100</td>
</tr>
</tbody>
</table>

Before allocation, the total supply is 100, and the total demand is 45. Thus, the available to promise would be 55.

Using the allocation rules, the picture looks as shown in the following table. The table displays the sites, actual allocation percentages, supply allocated to the specific sites, the demand, and what is ATP for each site. This table only shows the ATP calculated using percentages. The priorities and stealing effects are described below the table.
Because there are a few sites with a negative availability, the priorities must be examined to see if the negative quantities can be resolved with stealing.

Because Computer Industry/ Dell/ Europe has a higher priority than Computer Industry/ Dell/ Asia, the -6 ATP can be resolved by making the availability for Computer Industry/Dell/Asia to be 1.

Because Dell has a higher priority than IBM, then the -3 availability in Dell/Other can be resolved by stealing from IBM/Russia. Thus, the availability for IBM/Russia would now be 1.

Notice, that stealing can happen between sites within a customer and sites among different customers. First, if a negative quantity needs to be resolved, ATP looks at the sites within the same customer to see if the demand can be met. Otherwise, if the customers have different priority, then stealing can happen among customers if necessary.

Notes

Product Dependency
Oracle Global Order Promising, Oracle Advanced Supply Chain Planning, and Oracle Workflow are required.
Resource Allocation

Resource allocation is only considered during Multilevel ATP check when Global Order Promising performs a resource availability check.
Demand Class ATP

This section provides a detailed discussion on how to use Demand Class ATP.

Demand Class ATP Feature Description

Demand Class ATP enables you to perform availability checks by demand class. The availability calculation only considers the supply in a master schedule with the same demand class as that on the ATP request.

Demand Class ATP Business Application

This feature is useful when you want to use a known statement of supply of independent items for a specific sales channel for order promising. For example, your sales channels may be countries. You know how much supply you would give to each country. Aggregate demand from customers in a country can not exceed supply allocated to that country. You can use demand class to represent the country and state the supply for each country using a specific MPS. Global Order Promising honors the MPS and will only promise demand based on the demand class MPS.

Demand Class ATP Setup Steps

Item Attributes

There are two item attributes: Check ATP and Component ATP.

The Check ATP flag lets you control whether to perform ATP check for that item. Component ATP flag lets you control whether to check component availability and/or resource availability.

For Check ATP attribute, the choices are:

- Material only - Check material availability for this item at this level
- None - No need to check ATP at this level

Since Demand Class ATP usage is only meaningful when you want to use a specific statement of supply for independent items, Component ATP attribute should be set to None.

ATP Rule

You need to check the Demand Class field in the ATP rule. Assign the ATP rule to an item or an organization.
Demand Class ATP restricts the supply and demand to sources with a specified demand class. A demand class ATP rule cannot include on-hand quantity, purchase orders, supplier requisitions, internal requisitions, or intransit shipments as sources of supply.

Please see Other ATP on page 16-61 Functions for more information on how to use each of these options to best meet your needs.

**Demand Class MPS**

You need to define an MPS for each demand class for which you will perform Demand Class ATP. You need to create entries for each of the demand class MPS.

**Profiles**

In order to use Demand Class ATP, set the following profiles:

- INV: Capable to Promise: You can choose ATP Based on Collected Data, or ATP/CTP Based on Planning Output.
- MSC: Enable Allocated ATP: Set this to No.
- MSC: Enable Allocated Workflow: Set this to No.

**Demand Class ATP versus Allocated ATP**

Demand Class ATP capability exists in 10.7. It lets you promise orders by sales channels through the use of demand class. Users will use specific MPS for each demand class and populate the MPS's with a statement of supply for that demand class. Global Order Promising uses the demand class MPS to calculate the available supply against the demand with the same demand class. The mechanism is simple and may work well in an environment where demand does not fluctuate much and supply is relatively fixed.

Allocated ATP is a new feature in R11i. It provides the same capability as Demand Class ATP; that is, to ensure some level of supply for your designated sales channels. However the feature is much more powerful and the implementation is more flexible. It differs from Demand Class ATP in the following ways:

- Allocated ATP allows you to designate sales channel by demand class, or customer class/customer/ship-to site hierarchy. Demand Class ATP lets you designate sales channel by demand class only.
- Allocated ATP allows you to define time-phased allocated rules that designate a percentage of your total supply to each of the sales channel. The allocation rule is applied to your production MPS or MRP plan during order promising.
Demand Class ATP requires you to maintain a specific MPS for each demand class and uses that as statement of supply during order promising. You need to synchronize the demand class MPS’s and the production MPS.

- Allocated ATP performs a capable-to-promise check when demand exceeds allocation. Demand Class ATP cannot.
- Allocated ATP provides automatic stealing from lower ranked sales channels. Demand Class ATP requires you to resolve the shortage by manually adjusting the demand class MPS.

### Demand Class ATP Data Collection

Data Collection allows you to collect transactional data from multiple instances or different application systems into a common data store for global order promising and supply chain planning. It collects various data entities such as item, bills of material, customers, forecasts, and sourcing rules as well as transactional data such as purchase orders, miscellaneous receipts, inventory transfers, etc.

In general, if you create new entities, you need to run full (complete refresh) data collection. If you modify an existing entity, such as changing an item attribute, or you have new transactional data, you can run net-change (incremental) collection to refresh the data.

### ATP Inquiry

You can perform Demand Class ATP either from Order Management or Advanced Supply Chain Planning.

#### Demand Class ATP From Order Management

When you enter a customer on a sales order, by default, Order Management places the demand class that is associated with the customer or customer ship-to address on the sales order header or line. You can also manually enter the demand class. When you perform ATP inquiry, Order Management passes the customer, demand class and other information to ATP. ATP finds an MPS of the same demand class and check availability using that MPS.

#### Demand ATP From Advanced Supply Chain Planning

You can use the ATP Inquiry window to perform a Demand Class ATP. Along with other criteria you enter in the window, you must enter a demand class. ATP finds an MPS of the same demand class and checks availability using that MPS.
ATP Logic for Demand Class ATP

An ATP request is processed by the system as follows:

1. The ATP Rule (either item level or org level) is checked to see if Demand Class ATP needs to be done.

2. If Demand Class ATP is enabled on the ATP rule, the system checks for a plan having the same demand class as the demand class on the ATP request.

3. In case no demand-class specific plan is found, the generic plan with no demand class is used.

---

**Note:** If Allocated ATP is enabled, ATP uses the generic plan with no demand class.
Other ATP Functions

Time fence options, computation options, and supply/demand are general ATP concepts. However, depending on whether you use ODS or PDS, you set them up in different places and sometimes not to the same granularity.

Time Fence Options

The time fence options are specified inside an ATP rule. Not all options are applicable to PDS-based ATP.

Past-due demand days
ATP does not include any demand orders with a due date before this time fence. The ATP process considers all demand from the beginning of the past-due demand time fence to the current date as demand for the current date.

This is not used for PDS-based ATP. PDS-based ATP considers all past due demand.

Past-due supply days
ATP does not include any supply orders with a due date before this time fence. The ATP process considers all supply from the beginning of the past-due supply time fence date to the current date as supply for the current date.

This is not used for PDS-based ATP. PDS-based ATP considers all past due demand.

Infinite Supply Time Fence
This time fence is used to specify the end of your ATP horizon. ATP considers any demand that falls beyond this time fence as available. There are four options:

- Cumulative total lead time: The total lead time of an assembly plus the largest adjusted cumulative total lead time of its components.
- Cumulative manufacturing lead time: The manufacturing lead time of an assembly plus the largest adjusted cumulative manufacturing lead time of its components.
- Total lead time: The sum of the preprocessing, processing, and postprocessing lead times of the item.
- User-defined time fence: The lead time that you specify in the Days field.
This option is applicable to both ODS- and PDS-based ATP. In the case of PDS-based ATP, the plan end date is used as the infinite supply time fence if ATP does not find this specified.

**Computation Options**

All options are applicable to ODS- and PDS-based ATP.

**Forward Consumption of Shortage**

You can calculate ATP information by using a surplus quantity of an item from future ATP periods to cover an earlier-period shortage. If the period ATP is negative, you can go forward through the supply periods, one at a time, and subtract the shortage from the available quantity. You can keep going forward until the shortage disappears or until you run out of periods.

Note that forward consumption has not been enabled yet for Allocated ATP.

**Backward Consumption of Shortage**

You can calculate ATP information by using a surplus quantity of an item from prior ATP periods to cover a period shortage. If the period ATP is negative, you can go backward through the supply periods, one at a time, and subtract the shortage from the available quantity. You can keep going backward until the shortage disappears or until you run out of periods.

**Accumulate Available**

Global Order Promising assumes infinite accumulation.

**Supply and Demand**

When you use ATP based on the ODS, then supply and demand are specified in the ATP rules. When you use ATP based on the PDS, then supply and demand are specified within a plan.

**ODS: Supply**

You can control which sources are chosen for consideration for the availability requests.

The possible supply sources are: discrete MPS, repetitive MPS, discrete WIP, repetitive WIP, available QOH, non-standard WIP, internal requisitions, vendor requisitions, purchase orders, in-transit shipments, and user-defined supply.
You can use the on-hand available check box to choose whether to include the available on-hand quantity as a source of supply. Typical make-to-order and assemble-to-order manufacturing environments do not use the available on-hand quantity as a source of supply.

Oracle Inventory designates a supply period as beginning on a scheduled supply date and ending the day before the next scheduled supply date. A supply period can cover several days or be a minimum of one day in duration. If supply occurs on a nonworkday, the ATP calculation considers that supply as belonging to the next workday. If multiple supply events occur on the same day, the ATP process sums the supplies.

**ODS: Demand**

The possible demand sources are: sales orders, internal orders, discrete WIP demand, repetitive WIP demand, nonstandard WIP, flow schedules demand, and user-defined demand.

ATP demand is the sum of all demand quantities occurring within the supply period. If demand occurs on a nonworkday, the ATP calculation considers that demand as belonging to the next workday. If multiple demand events occur on the same day, the ATP process sums the demands.

If you select ATP by Demand Class, the ATP calculation looks only at the supply and demand for a particular demand class. The demand class feature enables you to forecast, plan, and promise based on subdivisions of your demand. For example, a demand class might represent a large customer or group of related customers.

When the ATP by Demand Class check box is selected, ATP only considers the following sources of supply: discrete MPS, repetitive MPS, discrete WIP, repetitive WIP, and nonstandard WIP.

**PDS: Supply & Demand**

When using ATP based on PDS, then the inquiries are based on the plan outputs. Thus, ATP rules are not used. For each of these plans, you can specify the supply and demand schedules to be included. Furthermore, for each organization that is included in each plan, you can specify whether to include the following options: net WIP, net reservations, net purchasing, plan safety stock, and sales orders.

The supply and demand are specified in the plan options of the plans that you are running.
Component Substitution

ATP supports the use of substitute components if the primary component is not available. If sufficient quantity of primary component is not available, the ATP searches for substitute components.

Many substitutes are possible for a primary item. In this case, the sequence of search for substitutes is determined by substitute priority, which is a flex field in the Bills of Material.

ATP splits demand among the primary and substitute components. For example,

- Demand for 10 comes for item A
- Item A has Item B as a component
- Item B has two substitutes: B1 and B2
- Item B has 2 available, B1 has 4 available, and B2 has 20 available

Then, the ATP results will return, 2 for Item B, 4 for B1, and 4 for B2. It will not just return 10 for B2.

Consider the BOM (shown below) where A is made up of component B. B can be substituted by B(1) whenever B does not exist.

```
    A
     |
     B   B(1)
     |
     C
```

Oracle Global Order Promising searches for substitute components before doing a multilevel search. If there is not sufficient quantity of A to meet the requirement at a given date, the quantity for B is checked. If that is also not enough, the substitute B(1) is considered. If that is also not sufficient, C which is the component of B is considered.

Oracle Global Order Promising does not search for the components of B(1), which is the substitute for B.
Even after the inclusion of B(1) and C, the demand is not satisfied. Then Oracle Global Order Promising searches forward in date to suggest the earliest date when the complete quantity will be available.

The substitute quantity available on the request date is considered in the forward case, but the schedule receipts are not considered.

**MRP: Include Substitute Components**

This site level profile must be enabled in order to consider substitute items in the ATP inquiry.

**Using Multiple Plans**

If you use planning output for ATP, then ATP supports the inclusion of multiple plans. To include multiple plans, check the Inventory ATP check box for all the plans that ATP needs to use in the plan options form.

As ATP moves in its search, it chooses a plan for each item. Each move in a search could be down one level in the BOM in a multilevel search or across the supply-chain as per the assignment set. The plan that is picked must be a successfully run plan, and should have a unique combination among item, organization, instance and demand class. If there are multiple occurrences of this set, the plan which has the lowest plan identification number is picked.

There may be situations where one plan is used as the source for another plan. For example, an MPS plan is the source for an MRP run. In this case, ATP searches for the real plan using the item attribute in-source plan.

**Support for Batch Resources**

Oracle Global Order Promising supports the ability to accurately consider the capacity of batch resources when performing CTP based on planning data. Batch resources are resources such as heat treat ovens that can process multiple units of the same item or multiple units of different items simultaneously.

Batch resource capacity is expressed along two dimensions: the time dimension (how long each load takes to process) as well as an additional size dimension that expresses the maximum size of each load (number of units in each load, maximum weight of each load, or maximum volume of each load).

Global Order Promising considers the capacity of batch resources by converting multiple dimensions into a single dimension (for example, unit-hours). Batching activity is constrained by the maximum capacity you have set for your resource.
Global Order Promising uses the cumulative available capacity for the CTP calculations. For example:

Batch Resource – Heat_Treat_1 is used for heat-treating pistons:

Capacity information:
- Volume of 100 cubic feet
- Availability 8 hours/day
- Capacity/day = 100 cubic feet * 8 hours = 800 cubic feet-hours

Capacity requirement:
- Piston1 requires 2 hours of processing and occupies 1 cubic foot
- CTP inquiry for a quantity of 100 Piston1 on Day 1–Capacity needed = 1 cu ft * 2 hours * 100 units = 200 cubic feet-hours

The following table shows the capacity picture of Heat_Treat_1 at the time of the CTP inquiry:

<table>
<thead>
<tr>
<th>Capacity</th>
<th>Day 1</th>
<th>Day 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Capacity</td>
<td>800 cubic ft-hours</td>
<td>800 cubic ft-hours</td>
</tr>
<tr>
<td>Consumed capacity</td>
<td>700 cubic ft-hours</td>
<td>600 cubic ft-hours</td>
</tr>
<tr>
<td>Available capacity</td>
<td>100 cubic ft-hours</td>
<td>200 cubic ft-hours</td>
</tr>
</tbody>
</table>

The next table shows the capacity picture of Heat_Treat_1 after the CTP inquiry and after the order is scheduled:

<table>
<thead>
<tr>
<th>Capacity</th>
<th>Day 1</th>
<th>Day 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Capacity</td>
<td>800 cubic ft-hours</td>
<td>800 cubic ft-hours</td>
</tr>
<tr>
<td>Consumed capacity</td>
<td>800 cubic ft-hours</td>
<td>700 cubic ft-hours</td>
</tr>
<tr>
<td>Available capacity</td>
<td>0 cubic ft-hours</td>
<td>100 cubic ft-hours</td>
</tr>
</tbody>
</table>

The CTP inquiry returns a result of Day 2.

If a single order requires capacity that is in excess of the maximum capacity for the resource, CTP will schedule such demands on the infinite supply time fence (if specified) or (by default) at the end of the planning horizon.
Resource batching is honored only for constrained MRP and DRP plans and when routings (not bills of resources) are used and when items are planned at the individual item as opposed to product family level.

Global Order Promising does not support the batching window functionality.

To invoke CTP for batch resources:
1. Set the profile option MSO: Global Batchable Flag to Yes.
2. Set up the resource as a batch resource. For information on this procedure, please refer to the section Setting Up Batch Resources on page 6-54 in the Supply Chain Modeling chapter.

Regional Level Sourcing Support

For companies that have multiple warehouses, each warehouse typically serves as a primary supply location for its surrounding geographical area. Oracle Global Order Promising supports availability checks in this business scenario by respecting sourcing rules that are assigned to geographic areas.

Specifically, Global Order Promising respects sourcing rules that are assigned to regions and zones. A region can represent any of the following types of geographic areas:

- range of postal codes
- city
- state
- country

A zone is a user-defined collection of regions.

Oracle Shipping Execution allows you associate customer sites to regions/zones, and to specify transit lead times between inventory locations and regions/zones, as well as inter-regional and inter-zonal transit lead times.

Global Order Promising recognizes which customer sites belong to which regions/ zones, and automatically uses the correct regional or zonal sourcing rule. If more than one sourcing rule applies, Global Order Promising chooses the sourcing rule that is assigned to the most specific (smallest) geographic area.

Global Order Promising selects the most specific assignment for sourcing based on the priority provided in table below.
In the same manner, Global Order Promising defaults shipping warehouse location to customer site transit lead times from more aggregate (for example, inventory location to zone) shipping network transit lead times. When more than one applicable transit lead time exists in the shipping network, the most specific lead time specification is used.

This capability allows you to easily maintain sourcing and transit lead time data required to support availability checks for large numbers of customer sites.

To enable Global Order Promising to use region level sourcing and in-transit lead time information:

1. Set up regions and zones in the source instance. For details, please refer to the Oracle Shipping Execution User’s Guide.

2. On the source instance, set up region level and zone level in-transit times in the shipping network. Please refer to the Oracle Inventory User’s Guide for details.


4. Switch to the Advanced Supply Chain Planner responsibility.

5. Run collections.

6. On the planning server, create an assignment set in which some sourcing rules are assigned at the region/zone level. (Navigation: Sourcing > Assign Sourcing Rules.)

   The Sourcing Rule/Bill of Distribution Assignment window appears.
7. Enter the assignment set name and description.

8. In the Assigned To drop-down menu, choose Item-Instance-Region or Category-Instance-Region or Instance-Region (to create a region-level sourcing rule assignment).

9. Select an item from the LOV in the Item/Category column.

10. Select either Sourcing Rule or Bill of Distribution from the LOV in the Type column (not shown in the screen shot above).

11. Select a sourcing rule or bill of distribution from the LOV in the Sourcing Rule / BoD column (not shown in the screen shot above).

12. Scrolling to the right, select a region or zone from the LOV in the Region / Zone column (not shown in the screen shot above). A search window appears to help you make this selection.
13. Save the assignment set.

14. On the planning server, set the profile option MSC: ATP Assignment Set to the assignment set that was saved in Step 13.

The sourcing rule assignments at the ASCP server gives you the ability to assign regional level sourcing rules. The regional level sourcing can only be defined at the assignment sets on the ASCP server.

Notes

- Region level sourcing assignments can only be defined on the planning server. They cannot be defined in the source in the Sourcing Rule/Bill of Distribution Assignments windows of Oracle MRP and Oracle Supply Chain Planning.

- The MRP:ATP assignment set defined at the source instance takes precedence over the MSC:ATP assignment set defined on the planning server. To define and enable order promising to use regional level sourcing, you have to set the MRP:ATP assignment set both at the source and at the destination to point to the same assignment set name. You can set the MRP:ATP assignment set in the source instance to NULL and force order promising to honor the ATP assignment set defined by the MSC:ATP assignment set in the planning server.

- Region level sourcing rules and transit lead times are respected by Global Order Promising only; not by Advanced Supply Chain Planning and not by Inventory Optimization.
Improved ATP Performance Based on Summarized Demand and Supply

Order promising response times can be improved by means of a summary approach that stores summary supply and demand information in a separate table. It allows each ATP request to quickly retrieve summarized availability information without computing availability from detailed supply and demand.

The summary approach is supported whether you promise orders based on collected data or planning output. The summary process is automatically run after each data collection or planning run.

This feature is supported for nondistributed environments only, in which the transaction data source and the Global Order Promising planning server are on the same database instance. Thus it is of most benefit to Order Management users who do not use Advanced Supply Chain Planning. ASCP users who have deployed ASCP on a separate planning server instance from their transaction data source instance will not be able to use this feature.

The summary approach is enabled by setting the profile option MSC: Enable ATP Summary Mode to Yes. It should only be set to No if you are not using ATP or if you do order promising on the basis of planning output generated in a planning server instance distinct from your transaction source instance. In those cases, the profile option value of No would allow you to avoid the extra processing added to the end of either plan runs or collections (for order promising based on planning output and transaction data respectively) to generate the summarized supply and demand information.

To enable ATP based on summary data:
1. Set the system profile option MSC: Enable ATP Summary Mode to Yes.
2. Set the user profile option MRP: Calculate Supply Demand Details to No.

Manually Generating the Global Order Promising Summary Tables

You can generate summary tables for:
- order promising based on collected data at the time of collections
- order promising based on planning data at the time of running a plan

While the summary tables required to support summary data-based order promising are automatically triggered by either the collections or the planning processes, you can also load the summary data by manually invoking concurrent programs. You may want to do this if you do not want to rerun collections or a plan before enabling summary data-based order promising.
You can manually generate the Global Order Promising summary tables from either the Advanced Supply Chain Planner responsibility or the Order Management Super User responsibility.

**To manually generate the Global Order Promising summary tables from the Advanced Supply Chain Planner responsibility:**

1. Log in using the Advanced Supply Chain Planner responsibility.
2. From the Navigator, select Other > Request.
3. Select the Submit a New Request button.
4. Select Single Request to submit a single concurrent request.
5. Select OK.
   The Submit Request window appears.
6. From the list of values in the Names field, select one of the following two concurrent requests:
   - Load ATP Summary Based on Collected Data (see Step 7)
   - Load ATP Summary Based on Planning Data (this program takes plan name as the program parameter)
7. If you select Load ATP Summary Based on Collected Data, you must select the following parameters:
   - Instance
   - Load Method: complete, net change, net change/incremental, targeted refresh
   - Refresh Sales Orders (yes, no)
   - Refresh Supplies/Demands (yes, no)
8. Select Submit.

**To manually generate the Global Order Promising summary tables from the Order Management Super User responsibility:**

1. Log in using the Order Management Super User responsibility.
2. From the Navigator, select Requests.
3. From the list of values in the Names field, select the following concurrent request: Load ATP Summary Based on Collected Data (see Step 7)
4. Select the following parameters:
   - Instance
   - Load Method: complete, net change, net change/incremental, targeted refresh
   - Refresh Sales Orders (yes, no)
   - Refresh Supplies/Demands (yes, no)
5. Select Submit.
ATP Inquiry

This section provides a detailed explanation on how to use the ATP Inquiry window.

You can view the available quantity for the date you requested. You can view the request date available to promise quantity, or the earliest date beyond the requested date that the request quantity is available. For PDS you can view the pegging tree and a time-phased view of material and resource availabilities.

ATP Criteria

ATP criteria lets you enter parameters for the desired ATP check.

To enter ATP criteria:
1. Choose ATP > ATP Inquiry.
   
   The ATP Criteria window displays.

Figure 16–6   ATP Criteria
2. Complete the following fields and options in this window. Not all of these fields are required.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pick Sources</td>
<td>Choose Yes to manually specify the sources for the order promising inquiry. Choose No to let Oracle Global Order Promising return the best sources based on your supply chain’s sourcing rules, bills of distribution, and assignment sets.</td>
</tr>
<tr>
<td>ATP Type</td>
<td>Choose from Ship Set or Arrival Set or [Blank]</td>
</tr>
<tr>
<td>Customer</td>
<td>Enter the customer name</td>
</tr>
<tr>
<td>Site</td>
<td>Enter the customer site</td>
</tr>
<tr>
<td>Request Date</td>
<td>Choose Ship Date or Arrival Date</td>
</tr>
<tr>
<td>Assignment Set</td>
<td>The assignment (view-only)</td>
</tr>
<tr>
<td>Demand Class</td>
<td>Choose the demand class from a list of values.</td>
</tr>
<tr>
<td>Org</td>
<td>Specify the organization(s) to consider in the order promising calculation.</td>
</tr>
<tr>
<td>Item</td>
<td>Specify the items to consider in the order promising calculation.</td>
</tr>
<tr>
<td>ATP Rule</td>
<td>If the order promising calculation is based on ODS, the ATP rule appears.</td>
</tr>
<tr>
<td>UOM</td>
<td>Enter the unit of measure</td>
</tr>
<tr>
<td>Qty</td>
<td>Enter the quantity.</td>
</tr>
<tr>
<td>Req Date</td>
<td>Enter the request date</td>
</tr>
</tbody>
</table>

3. Select ATP Results.

The ATP Workbench window displays ATP results and the pegging tree.

**Note:** This window displays the available to promise quantity for the specified date and the date by which the full quantity will be available.
The pegging tree shows how demand is being met. Red bullets on the window indicate demand; green bullets indicate supply.

4. Select a line of the pegging tree.

5. Click Details.

The ATP Detail window appears.
This window shows supply and demand for the selected line of the pegging tree.

6. Choose the Horizontal ATP tab.
This tab shows material availability details in a horizontal time scale. It shows total demand, total supply, net available to promise, and cumulative available to promise.
Using Global ATP Server from Non-Oracle Applications

The Global ATP server can be used from non-Oracle applications, yet the following points should be noted.

**API**
The ATP API is a public API that can be used to determine availability. The API will process an item or a group of items and determine material and resource availability across the supply chain. The API is a set of stored PL/SQL procedures and functions. The name of the API is Call_ATP and it can be found in the package MRP_ATP_PUB.

**ATP Inquiry**
ATP inquiry is performed from the third-party application.

**ATP Scheduling**
Third-party applications can also call ATP APIs to perform sales order scheduling.

**Collecting Data**
Customers can place their transactional data into the staging tables, and then Data Collection can pick up the data from those tables.

For more information on Data Collection, please refer to *Oracle Advanced Supply Chain Planning Technical Reference Manual*. 
The following topics are covered in this section:

- Overview of Oracle Inventory Optimization page 17-2
- Defining a Plan page 17-6
- Key Setups and Inputs page 17-10
- Viewing Output page 17-47
- Reviewing Exception Messages page 17-54
Overview of Oracle Inventory Optimization

Oracle Inventory Optimization enables you to optimize your strategic inventory investment decisions by helping you to identify optimal inventory stocking levels, order quantities, order frequency, and other operational policies given a set of requirements and objectives.

Oracle’s exclusive Stochastic optimization technology is a revolutionary breakthrough in optimization techniques that helps you manage the uncertainty inherent in your business decisions. Stochastic optimization techniques let you:

- Manage variability and risk
- Evaluate cost and risk tradeoffs
- Consider uncertainty in demand and supply
- See a graphic representation of your strategic inventory plan
- Plan telescoping time horizons
- Provide accurate inputs to tactical plans
- Manage to key performance indicators and drive continuous improvement
- Improve customer service while lowering inventory investment

Business Process

The following diagram describes the business process flow for Oracle Inventory Optimization:
Key Inventory Decisions

The following sections describe the key inventory decisions:

Service Level Decision Factors

The service level cost trade-off decision considers the expected costs of inventory stockouts and backorders associated with poor customer service. Those costs are weighted against the expected costs of maintaining high safety stock inventories, and expedited purchasing, production, and distribution costs associated with high customer service level.
Safety Stock Decision Factors
Since the purpose of safety stock is to buffer uncertainty, safety stock investment should be placed where there is uncertainty. In many cases, the degree of variability of supply and demand changes over time.

Inventory Location Decision Factors
This decision involves a trade-off between delivery time and flexibility. When safety stock is distributed to be closer to customers, delivery time is decreased. However, greater flexibility is provided when safety stock is stored in a single central location.

When safety stock is stored in the form of finished goods, the lead time for those finished goods is decreased. However, the components and materials used in making those finished goods are committed, and cannot be used to satisfy unexpected demand for other items. Greater flexibility is provided when safety stock is stored at the raw material or component level.

Input
Oracle Inventory Optimization takes the following information as input:

- Demand uncertainty scenarios and their associated probabilities.
- Customer service level requirement for each independent demand. If the customer service level is specified at a higher level of granularity (e.g. customer), the service level value will apply to all independent demands for that customer.
- Supplier lead time variation scenarios and their associated probabilities.
- Supply chain network in the form of sourcing rules and bill of distribution.
- List of items to be included.
- Bills of material, including effectivity and item substitution.
- Routings and key resources for items.
- Capacity constraints in the form of supplier capacity, transportation capacity, and resource availability or line rates.
- Cost elements, including production cost, item cost, carrying cost percentages, purchase cost, transportation cost, and resource cost.

You will be able to establish the following instances as eligible source instances for Oracle Inventory Optimization data:
Oracle Applications R10.7
Oracle Applications R11 (Discrete or Process Manufacturing)
Oracle Applications R11i (Discrete or Process Manufacturing)

Output

The output of Oracle Inventory Optimization is a time-phased strategic inventory plan and material budget. More specifically, output includes the following:

- Time-phased constrained and unconstrained safety stock levels and order quantities for each stockkeeping unit (SKU). The time-phased constrained safety stock quantities can be specified as input to Oracle ASCP in the form of demand plan(s).
- Recommended service level obtained for each SKU in each bucket.
- BIS key performance indicators.
- Exception messages and recommendations (for postponement, for example).
- Total cost of achieving the target customer service level and the individual cost elements that make up the total cost.

BIS Key Performance Indicators

Oracle Inventory Optimization is integrated with Oracle Business Intelligence’s performance management system. Oracle Business Intelligence lets you set the organizational objectives.

KPIs are used to drive continuous improvement in your enterprise. You can set performance targets and exception tolerances by business units (an organization, for example) or by period and automatically notify the appropriate people when exceptions arise.

Using the Planner Workbench, you can run multiple simulations, comparing them to your own performance metrics. As you firm a plan, you can directly update performance metrics in the execution system.

Note: These objectives, known as Performance Measures in the Oracle Business Intelligence System (BIS), are referred to as Key Performance Indicators (KPIs) in Oracle Inventory Optimization.
Defining a Plan

This section describes features that help you select a plan that best satisfies your business requirements. You can choose to run a global inventory plan or a subset plan to suit your supply chain environment or single organization environment, respectively. You can optimize your plan based on business objectives such as maximizing inventory turns, on time delivery, and plan profit. Finally, you can specify aggregation levels to view plans at varying levels of detail.

Global Inventory Planning and Subset Planning

Oracle Inventory Optimization enables you to create material and capacity plans for single organizations or multiple organizations. Global inventory planning refers to planning across multiple organizations while subset planning refers to single organization planning.

Choosing Between Global Inventory and Subset Plans

In general, resource and material capacity are most efficiently utilized in a global inventory planning environment where planning distributes production requirements across multiple organizations. However, the choice of global supply chain versus subset planning should depend on a number of factors including:

- **Physical proximity of the organizations being planned** – If planned organizations are geographically dispersed, it is generally more difficult to fulfill demand in one region from a plant or distribution center far away because of transportation costs and longer lead times. Note, however, that the costs associated with fulfilling demand from remote plants can be modeled in planning. Planning can then optimize production allocation across plants to meet the objectives that have been set.

- **Commonality of the items produced** – If you have multiple organizations that produce or distribute similar products, global inventory planning is beneficial because planning can consider factors like material and resource availability, material costs, and resource costs to create an optimal supply chain plan.

- **Commonality of the supply base** – Similar to producing common items, organizations sharing suppliers are good candidates for global inventory planning because supply can be optimally distributed across plants depending on each plan’s production requirements. Global inventory planning will ensure that supplier capacity is most effectively used to meet end customer demand and to minimize inventory.
Defining a Plan

- **Linkage among plants** – If production at one plant must be coordinated with production at other plants, global inventory planning should be used. For example, if Plant A provides subassemblies to Plant B (Plant A is a feeder plant), both plants should be planned together.

- **Corporate structure** – The internal organizational structure of a corporation is also a major determinant of the planning method used. If there are clear organizational boundaries between divisions, global inventory planning is difficult to implement.

The table below summarizes the factors to consider when deciding whether to run a global supply chain or subset plan.

<table>
<thead>
<tr>
<th>Factor</th>
<th>Global Inventory Planning</th>
<th>Subset Planning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Physical proximity</td>
<td>Close Physical Proximity</td>
<td>Distant Physical Proximity</td>
</tr>
<tr>
<td>Commonality of items produced</td>
<td>High Commonality</td>
<td>Low Commonality</td>
</tr>
<tr>
<td>Commonality of supply base</td>
<td>High Commonality</td>
<td>Low Commonality</td>
</tr>
<tr>
<td>Linkage among plants</td>
<td>Tight Linkage Among Plants</td>
<td>Loose Linkage Among Plants</td>
</tr>
<tr>
<td>Corporate structure</td>
<td>Centralized Corporate Structure</td>
<td>Decentralized Corporate Structure</td>
</tr>
</tbody>
</table>

**Running an Inventory Plan**
To run an inventory plan, the following prerequisites are required:

- Each planned organization must be set up on the source instance.
- Collection programs must be directed to collect data from the transactional instance of each planned organization.
- Items to be planned must be enabled in each organization that can produce (or distribute) the item. During item setup, items can be enabled in all organizations or only in specific organizations.
- Routings and/or Bills of Resource for each planned item must exist or be enabled in each organization that are planned centrally.
- Suppliers and sourcing rules must be enabled in all relevant organizations.

- **To create and launch an inventory plan:**
  1. Sign in using the Inventory Planner responsibility.
  2. Choose Inventory Plan > Names.
The Inventory Plan Names window appears.

**Figure 17–1  The Inventory Plan Names window**

3. Select Plan Options.
   
The Plan Options window appears.
4. Continue setting plan options and parameters.
   For more information, see Setting Plan Options, page 5-21 and the Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide.

   **Note:** Only selected organizations are planned, regardless of whether planned items, routings, and so on, have been enabled in other organizations.

5. Click Launch.
   The Launch Parameters window appears.

6. Verify launch parameters and click OK to launch the plan.
Setting Global Supply Chain vs. Subset Planning Parameters
You can choose the way you deploy Oracle Inventory Optimization to support either global supply chain or subset planning strategies. You can run one rapid single step supply chain plan that optimizes and plans your entire virtual enterprise. You can also choose to break the planning process into subsets. For example, you may choose to run an enterprise-wide high level plan, but plan manufacturing at the individual factory level. You can plan all, or any subset of your virtual enterprise in a single planning process. This reduces the number of plans and reduces the time and effort required to coordinate planning activities.

If you have a single instance of Oracle Applications, or if you prefer to pursue a strategy of subset planning, Oracle Inventory Optimization can be deployed as a module of an integrated Oracle Applications instance.

Key Setups and Inputs
This sections describes some of the key inputs you need to provide to Inventory Optimization before you run an Inventory Optimization plan.

Setting Target Service Levels
You can define service levels at each of the following hierarchies:

- Item/Demand class
- Item
- Category/Demand class
- Customer
- Organization
- Demand class
- Plan (global)

If the value is not specified at a certain level in the hierarchy, the system defaults to the value specified at the next higher level.

**Note:** For more information on allocating demand to suppliers, see “Sourcing Rules and Bills of Distribution.” in the Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide.
**Item/Demand Class**

A field in the Define Allocation Rules window lets you define the Demand Class service level. Define the Item Demand Class service level by assigning rules to specific items in the Assign Allocation Rules window.

- **To define the Demand Class service level:**
  1. From the Navigator, choose ATP > Allocation > Define Allocation Rule.

  *Figure 17–3 Allocation Rule window*

- **To set the Item Demand Class service level:**
  1. From the Navigator, choose Allocation > Assign Allocation Rule.

  2. Enter a service level for each Demand Class in the Service Level field.
2. Choose Item from the drop down list in the Assign To field.

3. Scroll right then choose an allocation rule from the list of values in the Allocation Rule field.

**Figure 17–4 Assign Allocation Rule window**

**Figure 17–5 Assign Allocation Rule, Allocation Rule field**

**Item**

A flexfield in the Oracle Inventory Master Item window in the source instance lets you define the Item service level.
To set the Item service level:
1. Choose Inventory > Items > Master Items > [New].
2. Click on the item flexfield entry box to the right of the Description field.
   The Items window appears.

   ![Figure 17-6 Items window]

3. Enter a value in the Service Level flexfield.

Category/Demand Class:
The Define Allocation Rules window lets you define the Demand Class level service
level. You can define the Category Demand Class level service level by assigning
rules to specific categories in the Assign Allocation Rules window.

To set the Category Demand Class service level:
1. From the Navigator, choose Allocation > Assign Allocation Rule.
2. Choose Item Category from the drop down list in the Assign To field.
3. Scroll right, then choose an allocation rule from the list of values in the Allocation Rule field.

**Figure 17–8** The Assign Allocation Rule window, Allocation Rule field

**Customer**

A flexfield in the Oracle Order Management Customers window in the source instance lets you define the Customer service level.

Service level by item overrides service level by customer.
To set the Customer service level:
   The Customers window appears.
2. Click on the customer information flexfield.
   The Customer Information window appears.

Figure 17–9 Customer Information window

3. Enter a value in the Service Level flexfield.

Organization
A flexfield in the Oracle Inventory Organization Parameters window in the source instance lets you define the Organization service level.

To set the Organization service level:
1. Choose Inventory > Setup > Organizations > Parameters.
2. Click on the organization parameters flexfield.
   The Organization parameters window appears.
3. Enter a value in the Service Level flexfield.

**Demand Class**

A field in the Define Allocation Rules window lets you define the Demand Class service level. The rule you assign to the Global Assignment Type in the Assign Allocation Rules window determines the Demand Class service level.

**To set the Demand Class service level:**
1. From the Navigator, choose Allocation > Assign Allocation Rule.
2. Choose Global from the drop down list in the Assign To field.

3. Scroll right, then choose an allocation rule from the list of values in the Allocation Rule field.

**Global (Plan Level)**

Use the Service Level field in the Optimization tab to define the Plan service level. For more information, refer to page 17-24, The Optimization Tab.
Figure 17–12  The Optimization Tab

Setting Plan Options

This section describes how to set plan options. The plan option types are as follows:

- Aggregation
- Organizations
- Constraints
- Optimization

You can specify the fields and options shown in the following table:
To access the Aggregation tab:

1. Navigate to the Planner Workbench.
2. Choose Plan Options > Aggregation tab.
The Aggregation tab appears.

**Figure 17–13  The Aggregation tab**

You can specify the fields and options shown in the following table:

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plan Start Date/Plan End Date</td>
<td>Based on the length of the planning horizon. This is a view only field. You cannot specify either of these dates.</td>
</tr>
<tr>
<td>Start Date</td>
<td>Start date for each bucket.</td>
</tr>
<tr>
<td>Buckets</td>
<td>Specify bucket size in days, weeks, and periods.</td>
</tr>
<tr>
<td>Items</td>
<td>Choose aggregation at item level or product family level.</td>
</tr>
<tr>
<td>Resources</td>
<td>Choose resource aggregation at individual level or aggregate level.</td>
</tr>
</tbody>
</table>
The Organizations Tab

To access the Organizations tab:
1. Navigate to the Planner Workbench.
2. Choose Plan Options > Organizations tab.

You can specify the fields and options shown in the following table:
The Constraints Tab

To access the Constraints tab:
1. Navigate to the Planner Workbench.
2. Choose Plan Options > Constraints tab.
Use the information in the following table to specify the fields and options:

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constrained Plan</td>
<td>If checked, Enforce Demand Due Date is checked as the default, all fields in the Constrained Plan region are updateable, all constraints are defaulted to Yes. This option is unchecked by default.</td>
</tr>
<tr>
<td>Enforce Service Level Constraints</td>
<td>Check this if you want the service level to be the hard constraint (that is, respected in lieu of material and resource capacity constraint if there is a conflict).</td>
</tr>
<tr>
<td>Enforce Demand Due Dates</td>
<td>Check this option if you want demand due dates to be your hard constraint (that is, respected in lieu of material and resource capacity constraints, if there is conflict). For more information, see Setting Hard and Soft Constraints. page 11-13 in Chapter 11, Constraint-Based Planning.</td>
</tr>
</tbody>
</table>
### The Optimization Tab

#### To access the Optimization tab:
1. Navigate to the Planner Workbench.
2. Choose Plan Options > Optimization tab.

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enforce Capacity Constraints</td>
<td>Check this option if you want material and resource capacity constraints to be respected in lieu of demand due date constraints. For more information, see Setting Hard and Soft Constraints. page 11-13 in Chapter 11, Constraint-Based Planning.</td>
</tr>
<tr>
<td>Start Date</td>
<td>This is a display only field that shows the start date for each bucket.</td>
</tr>
<tr>
<td>Buckets</td>
<td>This is a display only field that shows the bucket size in days, weeks, and periods.</td>
</tr>
<tr>
<td>Resource Constraints</td>
<td>Select Yes to consider resource constraints.</td>
</tr>
<tr>
<td>Material Constraints</td>
<td>Select Yes to consider material constraints.</td>
</tr>
<tr>
<td>Calculate Resource Requirements</td>
<td>If this is checked, the program will calculate resource capacity utilization.</td>
</tr>
<tr>
<td>Planned Resources</td>
<td>Choose all resources or bottleneck resources. If selecting bottleneck resources, you must first specify a Bottleneck Resource Group, which you can do in the next field.</td>
</tr>
<tr>
<td>Bottleneck Resource Group</td>
<td>If you have defined bottleneck resource groups in Oracle Bills of Material and you want to plan only those groups, designate them here.</td>
</tr>
</tbody>
</table>
Figure 17–16  The Optimization tab

You can specify the fields and options shown in the following table:

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned Items</td>
<td>Select the ABC classification to be used for this plan. Items belonging to the class you pick will be included in the plan.</td>
</tr>
<tr>
<td>Assignment Set</td>
<td>The assignment set that holds the sourcing rules and bills of distribution that define the rules for material flow within your supply chain.</td>
</tr>
<tr>
<td>Optimize</td>
<td>Select this check box if you are running an optimized plan.</td>
</tr>
</tbody>
</table>

**Note:** For this check box to be enabled, you must enable Plan Capacity and set at least one field in Material or Resource Constraints to Yes in the Aggregation tab.
Using an Existing Plan as a Supply Schedule for a New Plan

The plan for one organization can be used as a supply source (or supply schedule) for the plan of another organization.

To use an existing plan as a supply schedule for a new plan:

1. Choose Supply Chain Plan > Names to create a new inventory plan for the organization that will use an existing plan as a source.
2. Choose Plan Options > Organizations.

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enforce Sourcing Constraints</td>
<td>Check this option if you want to enforce the sourcing splits as defined in the item sourcing rules. When used with an optimized plan, the effect of this parameter is that, by default, ASCP's optimization engine may override sourcing percentage splits suggested in sourcing rules if a less costly planning solution can be obtained by doing so. For unconstrained and constrained plans, ASCP will adhere to sourcing percentages specified in sourcing rules, regardless of the setting of this parameter.</td>
</tr>
<tr>
<td>Objective: Maximize Inventory Turns</td>
<td>Specify a weighting percentage for this objective using the sliding bar or by entering a value between 0 and 1.</td>
</tr>
<tr>
<td>Objective: Maximize Plan Profit</td>
<td>Specify a weighting percentage for this objective using the sliding bar or by entering a value between 0 and 1.</td>
</tr>
<tr>
<td>Objective: Maximize Ontime Delivery</td>
<td>Specify a weighting percentage for this objective using the sliding bar or by entering a value between 0 and 1.</td>
</tr>
<tr>
<td>Plan Level Penalty Factors: Exceeding material capacity%</td>
<td>Enter a numerical value to quantify the impact of exceeding material capacity.</td>
</tr>
<tr>
<td>Plan Level Penalty Factors: Exceeding transportation capacity%</td>
<td>Enter a numerical value to quantify the impact of exceeding transportation capacity.</td>
</tr>
<tr>
<td>Plan Level Penalty Factors: Service level%</td>
<td>Specify the global service level percentage.</td>
</tr>
<tr>
<td>Plan Level Penalty Factors: Exceeding resource capacity%</td>
<td>Enter a numerical value to quantify the impact of exceeding resource capacity.</td>
</tr>
<tr>
<td>Plan Level Penalty Factors: Demand lateness%</td>
<td>Enter a numerical value to quantify the impact of late demand.</td>
</tr>
</tbody>
</table>
3. Specify the plan name to be used as a source for the new plan in the Supply Schedule portion of the form.

Using an Existing Plan as a Demand Schedule For a New Plan
The plan for one organization can be used as a demand source (or demand schedule) for the plan of another organization.

➢ To use an existing plan as a demand schedule for new plan:
1. Choose Supply Chain Plan > Names to create a new inventory plan for the organization that will use an existing plan as a source.
2. Choose Plan Options > Organizations.
3. Specify the plan name to be used as a source for the new plan in the Demand Schedule portion of the form.

Selecting Planned Items
Oracle Inventory Optimization calculates safety stock quantities only for those items whose safety stock planning method is set to MRP planned. Safety stock quantities are not calculated for items whose safety stock planning method is set to Non-MRP planned. However, time-phased planned order quantities are calculated for all items in the plan.

Controlling Aggregation
Oracle Inventory Optimization enables you to specify various types and levels of aggregation for time buckets, materials, resources, and routings in your inventory plan. Aggregation control lets you specify the level of detail desired for different time horizons within a plan. For example, you may want detailed planning of items and individual resources using routings in daily time increments for the short term portion of the plan. You may want aggregated scheduling at the product family level using aggregated resources and bills of resources in monthly time buckets for the long term portion of the plan.

Plan End Date
Forecast bucket and plan bucket granularity In the inventory plan, the forecast buckets and granularity (defined in the ERP system in the Forecast Entries window) and the planning granularity (defined in the Plan Options window) should be aligned correctly. This means that the start date and end date for each forecast entry should match the start date and end date for each planning bucket respectively.
The Plan End Date is calculated based on the length of the planning horizon defined by the specified bucket sizes in the Aggregation tab.

➢ To view the end date for your inventory plan:
  1. Navigate to the Planner Workbench.
  2. Choose Plan Options > Aggregation tab.

The Aggregation tab appears showing the end date for your inventory plan.

**Figure 17–17  The Aggregation Tab**

![The Aggregation Tab](image)

**Note:** The start date is hard coded as the sysdate.

**Specifying Material Aggregation Levels**
You can specify material aggregation levels for each of the three planning time horizons.
To set the material aggregation level for a time horizon:

1. Navigate to the Planner Workbench.
2. Choose Plan Options > Aggregation tab.

Figure 17–18  The Aggregation tab

3. Enter the time horizon in days, weeks, or periods.

You can specify different levels of aggregation in different time buckets so that detailed information is considered more frequently and less detailed information is considered less frequently.

You can plan the product at either the item level or the product family level. Ensure items are correctly assigned to a product family and that a planning percent is specified when setting up your BOMs.

Specifying Resource Aggregation Levels
You can specify resource aggregation levels for each of the three planning time horizons.
To set the resource aggregation levels for a time horizon:

1. Navigate to the Planner Workbench.
2. Choose Plan Options > Aggregation tab.
3. Enter the time horizon in days, weeks, or periods.

You can specify different levels of aggregation in different time buckets so that detailed information is considered more frequently and less detailed information is considered less frequently.

Resources can be planned either individually or in aggregate. Selecting Individual resource planning will generate plans down to the individual resource level and will consider the available capacity of each resource in the plan recommendations.

Selecting Aggregate resource scheduling will consider the overall capacity of all resources in a resource group required for an item. For example, the overall capacity of a department to which the individual resources are assigned are used.

For more information, see “Defining a Resource.” in the Oracle Bill of Materials User’s Guide.

Specifying Routing Aggregation Levels
You can specify routing aggregation levels for each of the three planning time horizons.

To set the routing aggregation level for a time horizon:

1. Navigate to the Planner Workbench.
2. Choose Plan Options > Aggregation tab.
3. Enter the time horizon in days, weeks, or periods.

You can specify different levels of aggregation in different time buckets so that detailed information is considered more frequently and less detailed information is considered less frequently.

Either routings or bills of resources can be selected for plans. For detailed scheduling in the minute, hour and daily buckets, routings are used. For long-range simulations in the weekly and monthly buckets, routings or bills of resources can be used. Note that routings and BOR’s cannot be used in the same plan.

Selecting routing level aggregation will result in schedules that consider the capacity of each resource as well as the sequencing of the resources during the production of an item. Selecting BOR level aggregation will only consider the
resource requirements needed to produce an item without considering the sequencing and interdependence among the resources required for an item.

The BOR aggregation level is for use with the weekly and period buckets for an approximate rough-cut capacity planning. When using BOR's, constraint-based planning is not recommended because the resource sequencing and interdependence is not considered. BOR aggregation is not compatible with routing aggregation in the same plan, and BOR aggregation is not available when scheduling in minutes and hours.

You can set aggregation levels for modeling items, resources, alternates and routings in your inventory plan. You can specify different levels of aggregation in different time buckets so that detailed information is considered more frequently and less detailed information is considered less frequently.

**Setting Constraints**

Constraint-based planning is an approach for balancing material and plant resources while meeting customer demand. It takes into account constraints at the enterprise and plant levels. Material and capacity issues are considered simultaneously, and factory, distribution, and transportation issues are integrated. This complete picture of the problem provides instant and global visibility to the effects of planning and scheduling decisions throughout the supply chain.

You can select one of the following three constraint options:

- **Enforce Demand Due Dates**
  
  Enforce a 100% service level on all demands in the plan. Material and resource capacity will be exceeded beyond their availability if necessary.

- **Enforce Service Level Constraints**
  
  This option enforces the service level specified at the most detailed level. In a simple example, if the plan level (global) service level is set to 95% and the service level for item AS12345 is set to 98%, the 98% service level is enforced for item AS12345 and the 95% service level is enforced for all other aspects of the inventory plan. Material and production resources are utilized beyond available capacity constraints if necessary to attain the desired service levels.

- **Enforce Capacity Constraints**
  
  This option enforces material and resource capacity constraints throughout the plan. Service Level Key Performance Indicator (KPI) reports the achievable service level.
For more information, see page 11-11, Setting Hard and Soft Constraints. in “Constraint Based Planning.”

➢ To set Oracle Inventory Optimization constraints choose one of the enforcement check boxes in the Options tab:

**Figure 17–19  The Options Tab**

---

**Specifying Plan Objectives**

Multiple optimization objectives can be met by assigning weights to each. This is done using the Optimization tab, assigning weights to each optimization objective.

For more information on the Optimization tab, see page 17-24, The Optimization Tab.
Following are descriptions of the various optimization objectives:

**Maximize Inventory Turns**  This objective is achieved by minimizing the total inventory for the plan duration.

**Maximize Plan Profit**  The following factors are considered:
- Revenue from independent demands
- Item cost
- Resource cost
- Inventory carrying cost
- Transportation cost

**Maximize On-time Delivery**  This objective maximizes on-time delivery by trying to ensure that all demand is met on-time. Penalty factors specify the relative importance of demands when maximizing on-time delivery.
You can specify demand variability as a discrete distribution. The Plan Options window has a new field that lets you specify probability for a given forecast set. Forecast sets are grouped together in scenario sets by using the scenario set field.

**Note:** Scenario sets are planned separately.

**To set demand variability:**
1. Choose Plan Options > Organizations tab.
2. In the Scenario Set field, enter the scenario set number.

3. In the Name field, enter the demand schedule name (forecast set or MDS).

4. In the Probability field, specify corresponding probabilities for forecast sets.

**Note:** One scenario set includes a list of one or more forecast sets. A forecast set includes a list of one or more forecasts. Use the Probability field to enter an estimate of probability that a particular forecast set within the scenario set will occur. For example, if a scenario set includes three forecast sets named; Optimistic, Most likely, and Pessimistic, one could estimate the probability of the forecasts occurring as 0.15, 0.65, and 0.20, respectively.

**Note:** Safety stock is not calculated if there is no demand and supply variability.
The sum of probabilities of forecast sets in a scenario set can be more than 1. They are normalized to 1 within the Inventory Optimization code. If a forecast set probability is not specified, a value of 1 is considered as default.

**Cumulative Demand Distribution**

You can specify demand uncertainty in terms of a cumulative probability distribution. This is in addition to the existing functionality of being able to specify demand uncertainty in terms of noncumulative probabilities. You can view the demand probability in the Supply/Demand window of the Planning Workbench.

**Profile option to indicate demand distribution format**

A new profile option MSR: Probability Distribution Type is used to indicate whether the demand variability is assumed to be in terms of forecast set probabilities or in terms of forecast set cumulative probabilities. The valid options are: Probabilities and Cumulative Probabilities. The default value is Probabilities.

This option applies uniformly to all scenario sets. That is, it is not possible to express demand variability in one scenario set in terms of probabilities and in another scenario set in terms of cumulative probabilities. This must be ensured by the user. No validation will be performed in the engine or UI.

**Specifying cumulative probabilities**

Cumulative probabilities are specified in the same place where the probabilities are currently specified. This is the Probability field in the Organizations tab on the Plan Options form (Demand Schedules section).

The maximum value of the cumulative probability, for a given scenario set, needs to be equal to 1.0. If this is not true, a warning message will be displayed when you attempt to save the plan options. If you run the plan at this point, the plan will error out.

The two tables below provide an example of correct user input.

<table>
<thead>
<tr>
<th>Scenario Set</th>
<th>Forecast Set</th>
<th>Qty</th>
<th>Prob</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FSET-A</td>
<td>50</td>
<td>0.4</td>
</tr>
<tr>
<td>1</td>
<td>FSET-B</td>
<td>75</td>
<td>0.2</td>
</tr>
<tr>
<td>1</td>
<td>FSET-C</td>
<td>100</td>
<td>0.4</td>
</tr>
</tbody>
</table>
The following two tables provide examples of incorrect user input:

**Table 17–2  User Input with Cumulative Probabilities**

<table>
<thead>
<tr>
<th>Scenario Set</th>
<th>Forecast Set</th>
<th>Qty</th>
<th>Cum. Prob</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FSET-A</td>
<td>50</td>
<td>0.4</td>
</tr>
<tr>
<td>1</td>
<td>FSET-B</td>
<td>75</td>
<td>0.6</td>
</tr>
<tr>
<td>1</td>
<td>FSET-C</td>
<td>100</td>
<td>1.0</td>
</tr>
</tbody>
</table>

The cumulative probability cannot go up when the demand quantity comes down. That is, if cumulative probability is 0.4 for a quantity of 75, the cumulative probability should be less than 0.4 for a quantity of 50. Oracle Inventory Optimization will log the following message during planning and exit if the forecast quantities in the demand distribution do not increase with the cumulative probabilities:

Error: Forecast quantity does not follow cumulative pattern for scenario set: `<scenario_set>`, forecast set id: `<forecast_set_id>`, item_id: `<item_id>`, org_id: `<org_id>`, instance_id: `<instance_id>`, date: `<date>`

**Table 17–3  Example 1: Invalid User Input with Cumulative Probabilities**

<table>
<thead>
<tr>
<th>Scenario Set</th>
<th>Forecast Set</th>
<th>Qty</th>
<th>Cum. Prob</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FSET-B</td>
<td>75</td>
<td>0.4</td>
</tr>
<tr>
<td>1</td>
<td>FSET-A</td>
<td>50</td>
<td>0.6</td>
</tr>
<tr>
<td>1</td>
<td>FSET-C</td>
<td>100</td>
<td>1.0</td>
</tr>
</tbody>
</table>

The maximum cumulative probability has to be equal to 1.0 (in the above example, it is only 0.9)

For Example 2, the plan options form will give a warning. If you run the plan at this point, the plan will error out.

**Table 17–4  Example 2: Invalid User Input with Cumulative Probabilities**

<table>
<thead>
<tr>
<th>Scenario Set</th>
<th>Forecast Set</th>
<th>Qty</th>
<th>Cum. Prob</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FSET-A</td>
<td>50</td>
<td>0.4</td>
</tr>
<tr>
<td>1</td>
<td>FSET-B</td>
<td>75</td>
<td>0.6</td>
</tr>
<tr>
<td>1</td>
<td>FSET-C</td>
<td>100</td>
<td>0.9</td>
</tr>
</tbody>
</table>
How Probability Data is Used by the System

The probability information is used in three ways:

- Probability acts like a weight in a normalization calculation.
- Normalized probabilities are used to calculate an expected value for forecast quantities.
- The distribution of the discrete probabilities is used to estimate variance, which is a factor in calculating safety stock quantity.

Safety stock is sized in proportion to the variance of forecast sets probability distributions.

The following table shows how the variance of forecast set probability distribution affects the size of the safety stock.

<table>
<thead>
<tr>
<th>Forecast Set</th>
<th>Prob. Dist A</th>
<th>Prob. Dist B</th>
</tr>
</thead>
<tbody>
<tr>
<td>FCSTA</td>
<td>0.182</td>
<td>0.100</td>
</tr>
<tr>
<td>FCSTB</td>
<td>0.364</td>
<td>0.800</td>
</tr>
<tr>
<td>FCSTC</td>
<td>0.454</td>
<td>0.100</td>
</tr>
</tbody>
</table>

All other relevant factors being equal, the safety stock quantity for a situation depicted by probability distribution B would be smaller than safety stock quantity for a situation depicted by probability distribution A, because the variance of probability distribution B is less than the variance of probability distribution A.

Weighted Average Calculation

The probabilities of forecast sets within one scenario set can be entered so that they total more than 1. When this occurs, the probabilities are normalized within Inventory Optimization code so that they do sum to 1. In the following table, probabilities of the forecast sets within scenario set 10 are 0.8, 0.4, and 1.0, respectively. Recall that blank values default to 1.0. The sum of the probabilities is 2.2. Dividing the entered probabilities by the sum results in normalized probabilities 0.364, 0.182, and 0.454, respectively. The normalized probabilities sum to one.

<table>
<thead>
<tr>
<th>Scenario Set</th>
<th>Forecast Set</th>
<th>Probability (entered)</th>
<th>Probability (used)</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>FCST1</td>
<td>0.4</td>
<td>0.4/2.2 = 0.182</td>
</tr>
<tr>
<td>10</td>
<td>FCST2</td>
<td>0.8</td>
<td>0.8/2.2 = 0.364</td>
</tr>
</tbody>
</table>
How to Assign Forecasts and Forecast Sets to Scenario Sets

The following tables present the relationships of forecasts, forecast sets, and scenario sets when specifying demand variability.

Forecasts and probability distributions for Item A are displayed in the following table:

<table>
<thead>
<tr>
<th>Time Period</th>
<th>Quantity</th>
<th>Probability</th>
</tr>
</thead>
<tbody>
<tr>
<td>D1</td>
<td>100</td>
<td>0.80</td>
</tr>
<tr>
<td>D1</td>
<td>90</td>
<td>0.07</td>
</tr>
<tr>
<td>D1</td>
<td>80</td>
<td>0.13</td>
</tr>
<tr>
<td>D2</td>
<td>200</td>
<td>0.80</td>
</tr>
<tr>
<td>D2</td>
<td>220</td>
<td>0.07</td>
</tr>
<tr>
<td>D2</td>
<td>210</td>
<td>0.13</td>
</tr>
<tr>
<td>D3</td>
<td>150</td>
<td>0.60</td>
</tr>
<tr>
<td>D3</td>
<td>120</td>
<td>0.30</td>
</tr>
<tr>
<td>D3</td>
<td>180</td>
<td>0.10</td>
</tr>
<tr>
<td>D4</td>
<td>180</td>
<td>0.60</td>
</tr>
<tr>
<td>D4</td>
<td>190</td>
<td>0.30</td>
</tr>
<tr>
<td>D4</td>
<td>120</td>
<td>0.10</td>
</tr>
</tbody>
</table>

Note that Item A has the same probability distribution for D1 and D2, and another distribution represents its demand for D3 and D4.

The scenario sets, forecast sets, and forecasts shown in the following tables should be defined to specify demand variability for item A:

<table>
<thead>
<tr>
<th>Scenario Set</th>
<th>Forecast Set</th>
<th>Probability (entered)</th>
<th>Probability (used)</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>FCST3</td>
<td>(blank)</td>
<td>1.0/2.2 = 0.454</td>
</tr>
</tbody>
</table>

Table 17–5  FCST1:Forecast Set 1/FC1: Forecast 1

<table>
<thead>
<tr>
<th>Item</th>
<th>Quantity</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>100</td>
<td>D1</td>
</tr>
</tbody>
</table>
### Table 17-5  FCST1: Forecast Set 1/FC1: Forecast 1

<table>
<thead>
<tr>
<th>Item</th>
<th>Quantity</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>200</td>
<td>D2</td>
</tr>
</tbody>
</table>

### Table 17-6  FCST2: Forecast Set 2/FC2: Forecast

<table>
<thead>
<tr>
<th>Item</th>
<th>Quantity</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>90</td>
<td>D1</td>
</tr>
<tr>
<td>A</td>
<td>220</td>
<td>D2</td>
</tr>
</tbody>
</table>

### Table 17-7  FCST3: Forecast Set 3/FC3: Forecast 3

<table>
<thead>
<tr>
<th>Item</th>
<th>Quantity</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>80</td>
<td>D1</td>
</tr>
<tr>
<td>A</td>
<td>210</td>
<td>D2</td>
</tr>
</tbody>
</table>

### Table 17-8  FCST4: Forecast Set 4/FC4: Forecast 4

<table>
<thead>
<tr>
<th>Item</th>
<th>Quantity</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>150</td>
<td>D3</td>
</tr>
<tr>
<td>A</td>
<td>180</td>
<td>D4</td>
</tr>
</tbody>
</table>

### Table 17-9  FCST5: Forecast Set 5/FC5: Forecast 5

<table>
<thead>
<tr>
<th>Item</th>
<th>Quantity</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>120</td>
<td>D3</td>
</tr>
<tr>
<td>A</td>
<td>190</td>
<td>D4</td>
</tr>
</tbody>
</table>

### Table 17-10  FCST6: Forecast Set 6/FC6: Forecast 6

<table>
<thead>
<tr>
<th>Item</th>
<th>Quantity</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>180</td>
<td>D3</td>
</tr>
<tr>
<td>A</td>
<td>120</td>
<td>D4</td>
</tr>
</tbody>
</table>
These forecast sets are tied to their corresponding probabilities and assigned to scenarios sets in the Organization Tab of the Plan Options form as shown in the following table:

<table>
<thead>
<tr>
<th>Scenario Set</th>
<th>Forecast Set</th>
<th>Probability</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>FCST1</td>
<td>0.80</td>
</tr>
<tr>
<td>10</td>
<td>FCST2</td>
<td>0.07</td>
</tr>
<tr>
<td>10</td>
<td>FCST3</td>
<td>0.13</td>
</tr>
<tr>
<td>20</td>
<td>FCST4</td>
<td>0.60</td>
</tr>
<tr>
<td>20</td>
<td>FCST5</td>
<td>0.30</td>
</tr>
<tr>
<td>20</td>
<td>FCST6</td>
<td>0.10</td>
</tr>
</tbody>
</table>

If item B has the same probability distribution as item A, you can include item B in the above forecasts and forecast sets. If item B does not follow the same probability distributions, then separate forecast sets and forecasts should be defined for item B. In this case, item A and B cannot share the same scenario sets either.

**Specifying Sources of Supply and Demand**

**Specify Supply Types**
You can specify existing supply types (On-Hand, PO, WO, and so on) to be included or excluded.

▷ **To specify supply type:**
1. Navigate to the Planner Workbench.
2. Choose Plan Options > Organizations tab.
3. Choose the appropriate checkbox for each source of supply.

**Demand Schedules**
You can specify a demand schedule or forecast set as input demand for an inventory plan.

▷ **To specify sources of demand:**
1. Navigate to the Planner Workbench.
2. Choose Plan Options > Organization tab.
3. Select the demand schedule (MDS or Forecast) from the list of values.

**Supply Schedules**

- **To specify sources of supply:**
  1. Navigate to the Planner Workbench.
  2. Choose Plan Options > Organization tab.

  ![The Organizations Tab](image)

  3. Select the supply schedule from the list of values.

**Set Supplier Lead Time Variability**

You can specify supplier lead time variability either at the item-supplier level or at the supplier level. If variability information is defined at the item-supplier level, it will be used by the optimization engine. Otherwise, the engine will use variability information defined at the supplier level.
Define supplier lead time variability in the Item Supplier Variability window.

**Note:** You can only input supplier lead time variability information in the planning server.

To set supplier lead time variability:
1. Navigate to the Planner Workbench.
2. Choose Supplier from the drop down menu in the left pane.
3. Drill down to and select an item underneath a supplier in the left plane.

*Figure 17–23  The Supplier Variability window*

5. Use the information in the following table to complete the fields in this window (all other fields are populated automatically).

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Days Late</td>
<td>The number of days in whole numbers the item is delivered late. Days Late can be measured in negative whole numbers, indicating early delivery.</td>
</tr>
</tbody>
</table>
Setting Penalty Costs

You can specify penalty costs instead of service levels for independent demands and have the system calculate safety stocks. The system trades off the cost of late demands with production costs, purchasing costs, and inventory costs in determining the best attainable service level.

The system uses the penalty costs, service level or both in calculating safety stock quantities as shown in the following table:

<table>
<thead>
<tr>
<th>Plan Level Defaults</th>
<th>Enforce Service Level</th>
<th>Enforce Capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Level</td>
<td>used</td>
<td>used only for target safety stock calculation</td>
</tr>
<tr>
<td>Resource Penalty Costs</td>
<td>used</td>
<td>used only for target safety stock calculation</td>
</tr>
<tr>
<td>Material Penalty Costs</td>
<td>used</td>
<td>used only for target safety stock calculation</td>
</tr>
<tr>
<td>Late Demand Penalty Costs</td>
<td>not used</td>
<td>used</td>
</tr>
</tbody>
</table>

When you specify Enforce Service Level Constraints, the system calculates safety stock quantities for the specified service levels while minimizing penalty costs for exceeding material capacity, exceeding resource capacity, and exceeding transportation capacity.

Penalty cost for late demand is used only when you specify Enforce Capacity Constraints.

**Note:** Specifying input penalty costs for late demand and specifying input service level are mutually exclusive.

---

**Probability**

The probability expressed as number between 0 and 1 corresponding to each estimation of days late for the item. The probabilities should sum to equal 1.0.

**Note:** Select your supplier in the left pane to assign supplier variability independent of a specific item. If an item does not have specific supplier variability, it defaults to the supplier level.
For information on setting penalty factors or costs, refer to page 8-4, “Setting Penalty Factors.”

**Setting Item Purchase Price by Supplier**

During the collections process, Oracle Inventory Optimization captures the item purchase price by supplier and supplier site by taking the unit price from the most recent purchase order for each item. Oracle Inventory Optimization uses the item purchase price to compute the purchasing cost for an item. You can view the item purchase price from the Supplier Capacity window in both the Collection Workbench and the Planning Workbench.

**To view item price by supplier:**

1. Navigate to the Collection Workbench (Collections > View Collected Data) or Planner Workbench (Inventory Plan > Workbench).
2. Choose Suppliers from the drop down menu in the left pane.
3. Drill down and select an item underneath a supplier in the left pane.
4. Right-mouse click on the item.
   
   A list appears.
5. Select Supplier Capacity.
   
   The Supplier Price is a column in the Supplier Capacity window.
Setting Performance Indicators

You can compare inventory plan output to the following performance indicators:

- Inventory Turns
- Service Level
- Planned Utilization
- Margin
- Margin Percentage
- Cost Breakdown
- Inventory Value

Refer to the Oracle Business Intelligence System Implementation Guide for information on setting performance indicator targets.

**Note:** You can set targets for all Performance Indicators except Margin and Cost Breakdown.
Viewing Output

Oracle Inventory Optimization lets you view the following types of output:

- Horizontal plan
- Vertical Plan
- Performance Indicators
- Time-phased Supply and Demand
- Constrained and Unconstrained Safety Stocks

Refer to Chapter 10, Planner Workbench/User Interface for more information on viewing horizontal and vertical plans.

Performance Indicators

The initial window of the Planner Workbench, the summary chart, provides a graphical display of the plan’s Key Performance Indicators (KPIs). At a glance, you can see how the plan performs relative to the following measures:

- Inventory Turns
- Service Level
- Planned Utilization
- Margin
- Margin Percentage
- Cost Breakdown
- Inventory Value
Refer to Chapter 10, Planner Workbench/User Interface for more information on viewing performance indicators.

**Time-Phased Supply and Demand**

You can view time-phased demand and supply for all items in your inventory plan.
To view time-phased supply and demand choose Tools > Supply/Demand.

Figure 17–26  The Supply/Demand window

The following information is available in the various tabs of the Supply/Demand window and by scrolling to the right:

Order Tab
- Org
- Item
- For Release
- Firm
- Order Type
- Suggested Due Date
- Probability
- Qty/Rate
- Order Number
- ABC Class
- Alternate BOM
- Alternate Routing
Safety Stocks and Target Safety Stocks

Target safety stocks, which are unconstrained safety stocks, are the safety stock quantities required to support a given service level. Safety stocks, which are constrained safety stock quantities, are the quantities achievable given the capacity limitations. The constrained safety stocks are always less than or equal to the unconstrained target safety stocks equivalents.

Oracle Inventory Optimization calculates and displays both constrained safety stocks and unconstrained target safety stocks.

Using capacity exceptions and the unconstrained and constrained safety stock quantities, users of Oracle Inventory Optimization can determine the following:

- what service level is achievable
- what they need to do in order to achieve the target service level

Time-phased safety stock quantities for all items is available in the Horizontal Plan, Vertical Plan, and Supply and Demand windows.
To view time-phased safety stocks, choose the Horizontal Plan tab:

Figure 17–27  The Horizontal Plan window

Resource Requirements

You can view time-phased resource requirements for all resources in your inventory plan.

To view time-phased resource requirements:
1. [Right-click] on an item in the navigation tree then choose the Resources option.
2. Choose Requirements.

The Resource Requirements window appears.

The following fields are displayed in the Resource Requirements window. Some of the fields appear when you scroll to the right:

- Dept/Line
- Resource
- Org
- Owning Dept.
- Dept. Class
- Resource Type
- Resource Group
- Start Date
- End Date
- Schedule Quantity
- Using Assembly
Material/Resource Availability

You can view time-phased material and resource availability for all items/resources in your inventory plan.

To view time-phased material and resource availability:

1. [Right-click] on an item in the navigation tree then choose the Resources option.
2. Choose Availability.

The Resource Availability Summary window appears.

Figure 17–29  Resource Availability Summary window
Reviewing Exception Messages

This section describes exception messages associated with Oracle Inventory Optimization.

Capacity Exceptions

Material and Resources constraints are generated for Inventory Plans only if you choose the option Enforce Capacity Constraints. In this option, the output contains both unconstrained safety stocks (i.e., safety stocks required to meet the target customer service level), and constrained safety stocks (i.e., the achievable safety stock given the capacity constraints).

The constraint exception messages provide users with a list of capacity bottlenecks that prevent them from achieving the target service levels.

The exception messages generated for this case are the same as those available in ASCP. Please refer to Chapter 9, Exception Messages for information on what exceptions are generated for which type of plans, how exceptions can be viewed and analyzed, and how exception situations potentially can be resolved.

The following is a list of exceptions for Inventory Optimization:

- Late Sales Orders and Forecasts
  - Past due transportation resource constraint
  - Past due forecast
- Material and Resource Capacity
  - Material constraint
  - Resource constraint
  - Resource overloaded
  - Supplier capacity overloaded
  - Resource underloaded
- Transportation and Distribution
  - Transportation resource overloaded
  - Transportation resource underloaded
- Shortage and Excess
  - Item with a shortage
- Item with excess inventory
- Substitutes and Alternates Used
  - Planned order uses alternate BOM
  - Planned order uses alternate routing
  - Planned order uses substitute components
  - Planned order uses alternate resources
  - Order sourced from alternate facility
  - Order sourced from alternate supplier
- Item Exceptions
  - Items with negative starting onhand
  - Items with no activity
Topics covered in this section include the following:

- End-Item-Level Substitution on page 18-2
- End Item Substitution and Oracle Global Order Promising on page 18-42
- User-Defined Alternate Decision Rules on page 18-69
- Organization Security on page 18-103
Overview of Business Topics

This section presents information on a variety of business topics that affect all aspects of the APS product. They include such issues as:

- end item-level substitution
- user-defined alternate decision rules
- organization security

End-Item-Level Substitution

Oracle ASCP supports two types of substitution: component substitution and end-item-level substitution. This section describes end-item-level substitution.

The term end-item refers to the finished good or saleable product. End-item-level substitution is an acceptable business practice in many industries. It is often possible to fulfill customer demand on time when the requested item is not available by substituting a more functionally rich product. Substitution is also done to use up existing inventory of older, functionally equivalent items.

End-item substitution provides the following capabilities:

- Enable substitution based on user-defined rules that can be effective either in one direction or in both directions; defining a chain of substitution relationships is simplified by inferring existing relationships
- Consider substitution rules in the order promising process and suggest substitution similar to planning; this is important because promising orders based on a logic which does not consider substitution may lead to inaccurate promise dates and over promising
- Consider the customer/customer site ordering the item; for example, some customers ordering a specific item might not accept substitutions; on the other hand other customers ordering the same item will accept substitutions
- Consider the effective dates of substitution rules prior to performing substitution
- Evaluate the effects of possible substitution rules by performing plan simulations
- Define whether orders may be fulfilled using a combination of requested and substitute items or only one item
User Procedures Overview

This section lists the general procedures that are used to define and use end-item substitution:

1. Define substitution relationship between items at Oracle Inventory, optionally establish substitution chain, directionality and effectivity for substitution, and optionally establish customer and customer site for each substitution relationship

2. Set item attributes to control the generation of supplies

3. Set Item attribute to establish a window for substitution

4. Collect data

5. Run plans and analyze substitution decisions

6. Follow work flow procedure to enable execution

7. Optionally initiate ATP queries to quote promise dates based on substitution logic

Define a Substitution Relationship

This section describes what you need to do to define a substitution rule or relationship at the item level. In general, you must define the following:

- a substitute From and a substitute To item
- the direction in which substitution is effective
- effective dates for substitution (optional)
- Partial Order Fulfillment flag for each substitution relationship (optional)
- Substitution Set to enable simulation of substitutions (optional)
- customer and customer site for a substitution relationship (optional)

Currently, substitution rules or relationships can be defined via item relationships in Oracle Inventory using the Item Relationship form. You can use the form to define all the characteristics mentioned above. You can infer chaining and highest-level item in a substitution chain.

If you define the end item-level substitution rule, it is applicable in all organizations in which the items are enabled.

These substitution rules are collected in Targeted collection mode and Complete refresh mode and not in Net change mode.
To define a substitution relationship:

1. From the Navigator, select Inventory > Items > Item Relationships.

   The Find Item Relationships window appears.

2. Either select a previously defined item or search for an item.

   The Item Relationships window appears.

**Figure 18–1 Item Relationships window**

You can use this window to create a substitute relationship between two items and to indicate if the relationship is reciprocal. Please note that you cannot enter multiple Effective Dates for a substitution relationship in this window. This is done in the Planning Details window.

3. To further define details about the substitute relationship, select an item row and select the Planning Details button.

   The Planning Details - Substitute window appears.
Use the information in the following table to fill out the fields in this screen.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Substitution Set</td>
<td>You can specify one or more substitution sets for a substitution relationship. You can use a set of substitution relationships to be effective for a given plan by selecting the substitution set as an option for the plan. This allows you to run simulations of possible substitutions and evaluate performance indicators given possible future substitutions. For additional information, please see Simulate Possible Substitutions on page 18-26.</td>
</tr>
<tr>
<td>Partial Fulfillment</td>
<td>If you select this check box, the entire order can be satisfied with supplies from both items. If you do not select this checkbox, Oracle APS must satisfy the entire order with supplies from one item or the other item, but not both.</td>
</tr>
</tbody>
</table>
Effective Dates: The substitution relationship can be made effective between a range of dates or multiple ranges of dates. If you specify range of dates in this window, the effective dates in the Item Relationship window will be ignored. Oracle APS will consider substitution relationship with different effective dates and will substitute only during the valid range of dates.

All Customers: When this box is checked, any substitution set or range of effective dates is made applicable to all customers. If you need to make it specific to a customer, then unselect this checkbox and navigate to the Customer field where you will have a chance to enter a customer or multiple customers.

Customer: You can set up customer site-specific substitution rules by defining customers and customer sites here. This allows you to maintain customer-specific substitutions as your customers accept or decline specific substitution relationships. Please note that you can associate multiple customers to the same substitute relationships.

You may have a need to enter both customer-specific and noncustomer-specific substitution relationships for the same set of items. You can do so by entering one record in the Item Relationship window, entering the effective dates for the first rule in the first row of the Planning Detail window and deselecting All Customers, and entering multiple customer-specific associations in the Customer Reference section. Then, you enter effective dates for the generic rule in the Planning Details window and leave All Customers selected. One of the records can be applicable to all customers and the other record will be a customer-specific record.

NOTE: Once you enter customer-specific substitution rule for any item, you will have to specify all the relationships applicable to that customer explicitly because no generic rules will be applied to that customer.

Address: Choose the address for the customer location.

Type: View only field that shows the type of location (currently, only shows Ship to).

From and To: You can specify effective dates for substitution at a customer level. If you specify effective dates at customer level for a substitution relationship, the effective dates you might have specified at the in the Planning Details window and the Item Relationship window will be ignored.
# Substitution Set-Up Examples

Use the following information to set up various substitution scenarios.

**To set up substitution across many dates/effectivities**

1. Fill out the Item Relationships window as shown in the following table:

<table>
<thead>
<tr>
<th>From Item</th>
<th>To Item</th>
<th>Relationship type</th>
<th>Reciprocal</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>B</td>
<td>Substitute</td>
<td>not selected</td>
</tr>
</tbody>
</table>

2. Fill out the Planning Details window as shown in the following table:

<table>
<thead>
<tr>
<th>Substitution Set</th>
<th>Partial Fulfillment</th>
<th>From Date</th>
<th>To Date</th>
<th>All Customers</th>
</tr>
</thead>
<tbody>
<tr>
<td>null</td>
<td>unselected</td>
<td>Day 1</td>
<td>Day 50</td>
<td>selected</td>
</tr>
<tr>
<td>null</td>
<td>unselected</td>
<td>Day 65</td>
<td>Day 80</td>
<td>selected</td>
</tr>
<tr>
<td>null</td>
<td>unselected</td>
<td>Day 101</td>
<td>null</td>
<td>selected</td>
</tr>
</tbody>
</table>

**To set up substitution relationships with multiple substitution sets**

1. Fill out the Item Relationships window as shown in the following table:

<table>
<thead>
<tr>
<th>From Item</th>
<th>To Item</th>
<th>Relationship type</th>
<th>Reciprocal</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>B</td>
<td>Substitute</td>
<td>not selected</td>
</tr>
</tbody>
</table>

2. For the item relationship A --> B, fill out the Planning Details window as shown in the following table:

<table>
<thead>
<tr>
<th>Substitution Set</th>
<th>Partial Fulfillment</th>
<th>From Date</th>
<th>To Date</th>
<th>All Customers</th>
</tr>
</thead>
<tbody>
<tr>
<td>NULL (Default)</td>
<td>not selected</td>
<td>null</td>
<td>null</td>
<td>selected</td>
</tr>
<tr>
<td>SSET1</td>
<td>not selected</td>
<td>null</td>
<td>null</td>
<td>selected</td>
</tr>
<tr>
<td>SSET2</td>
<td>not selected</td>
<td>null</td>
<td>null</td>
<td>selected</td>
</tr>
</tbody>
</table>
You may now run plans using any of the substitution sets defined in this window as a plan option.

To set up customer-specific and noncustomer-specific substitution rules
1. Fill out the Item Relationships window as shown in the following table:

<table>
<thead>
<tr>
<th>From Item</th>
<th>To Item</th>
<th>Relationship type</th>
<th>Reciprocal</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>B</td>
<td>Substitute</td>
<td>not selected</td>
</tr>
</tbody>
</table>

2. Fill out the Planning Details section of the Planning Details window as shown in the following table:

<table>
<thead>
<tr>
<th>Substitution Set</th>
<th>Partial Fulfillment</th>
<th>From Date</th>
<th>To Date</th>
<th>All Customers</th>
</tr>
</thead>
<tbody>
<tr>
<td>null</td>
<td>selected</td>
<td>null</td>
<td>null</td>
<td>not selected</td>
</tr>
<tr>
<td>null</td>
<td>selected</td>
<td>null</td>
<td>null</td>
<td>selected</td>
</tr>
</tbody>
</table>

3. Fill out the Customer References section of the Planning Details window for the first row as shown in the following table:

<table>
<thead>
<tr>
<th>Customer</th>
<th>Customer Site</th>
<th>From Date</th>
<th>To Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer 1</td>
<td>Site 1</td>
<td>null</td>
<td>null</td>
</tr>
<tr>
<td>Customer 2</td>
<td>Site 2</td>
<td>null</td>
<td>null</td>
</tr>
</tbody>
</table>

Please note that in order to enter a customer-specific rule, All Customers must be unselected.

To set up multiple substitution effective dates for a customer.
1. Fill out the Item Relationships window as shown in the following table:

<table>
<thead>
<tr>
<th>From Item</th>
<th>To Item</th>
<th>Relationship Type</th>
<th>Reciprocal</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>B</td>
<td>Substitute</td>
<td>not selected</td>
</tr>
</tbody>
</table>

2. Fill out the Planning Details section of the Planning Details window as shown in the following table:
3. Fill out the Customer References section of the Planning Details window as shown in the following table:

<table>
<thead>
<tr>
<th>Customer</th>
<th>Customer Site</th>
<th>From Date</th>
<th>To Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer 1</td>
<td>Site 1</td>
<td>Day 1</td>
<td>Day 50</td>
</tr>
<tr>
<td>Customer 1</td>
<td>Site 1</td>
<td>Day 100</td>
<td>null</td>
</tr>
</tbody>
</table>

**Viewing Substitution Display**

**To view substitution display:**

1. From the Navigator, select Supply Chain Plan > Workbench.
   The Supply Chain Planner Workbench appears.

2. In the Navigator, select View By Items.

3. Select the item you wish to view and right-click.

4. From the menu that appears, select Items.
   The Items window appears.
5. Select an item.

6. Select the Substitutes button. Please note that multiselects are not allowed. If you select several items, the Substitutes button will be greyed out.

The Substitution Chain window appears.
The following list provides an explanation of the features of this window:

- The item you selected in the Items window is highlighted.
- The color of the arrows between each item signify whether the relationship is predecessor, parallel, or successor.
- You can see the item and the substitution chain along with the direction, and the type of substitution relationship (i.e., one-way/two-way).
- Each node in the window refers to an item and has expansion capabilities.
- Double-clicking on an item will show any existing expanded relationships.
- If you can expand the chain upwards, the item in question can use higher level item as a substitute.
- If you can expand the chain lower the item in question can be substituted for the lower level item.
- If you can expand the tree sideways, the item in question and the parallel item can be substituted for each other.
- If you double click on a node which is a two-way substitute item, the tree will refresh itself and start from the node you double-clicked rather than showing multiple trees at the same time.

- The highest level item is the one to which all the arrows point.

- The highest-level item is usually the item with most capabilities and it is the item that is in active production in certain industries.

- If you select an item and right-click, two menu options appear: Properties and Horizontal Plan. If you select Properties, the Substitution Properties window appears. If you select Horizontal Plan, the Horizontal Plan appears.

**Figure 18–5  Substitution Properties window**

There are three tabs: Predecessor, Successor, and Parallel. Each tab shows you the properties of substitution relationship and other possible substitutes as shown below. If you do not have a Predecessor, Successor, or a Parallel substitution, the appropriate tabs are disabled. The default enabled tab when you open the window is the Predecessor tab.

The following information appears in the Substitution Properties window:

- From and To substitute items

- Implied Substitution - whether the item relationship is implied or directly specified

- Highest level item in the substitution chain

- Effective date for the relationship

- Disable date for the relationship

- Customer and Customer sites which accept the substitution

- Substitution set if specified

- Partial Fulfillment is allowed
Substitution Logic

The section contains description of how substitution logic functions. It contains information about:

- searching the supply chain
- chaining

Search the Supply Chain for Substitution

A demanded item or a substitute item could be available within the same organization or in a different organization within the supply chain. You can take advantage of availability of supply (both requested item and substitute items) across the supply chain and use up the inventory effectively before placing orders to make or buy the item. The search for demanded item or substitute items proceeds as follows:

- you look for demanded and substitute/s with in the same organization before going across to other organizations to fetch demanded item and substitute/s

The following figure show you this search method:
With this method, the emphasis is on use up. The availability picture of original item and substitutes guides the search. The emphasis of the search is to seek supplies from demanded item or substitute item and use it up as effectively as you can before creating supplies for the item requested. This means Oracle APS looks for on hand and scheduled receipts of demanded items and substitutes within one organization before proceeding to the next organization to repeat the same search.

**Breadth-First Search** An important point to note here is the direction of search when multiple levels of sources are involved. If you consider the following diagram, the Atlanta facility sources from Dallas and Miami, Dallas sources from Dallas-1, and Miami sources from Miami-1.

![Supply Chain for Substitution](image)

If you have item A and a substitute item A1 in all the organizations in the supply chain and if you have demand in Atlanta, the search follows the sequence mentioned below:

- Look for on hand and scheduled receipts of item A and substitute A1 at Atlanta
- Look for on hand and scheduled receipts of item A and substitute A1 at Dallas
- Look for on hand and scheduled receipts of item A and substitute A1 at Miami
- Look for on hand and scheduled receipts of item A and substitute A1 at Dallas-1
- Look for on hand and scheduled receipts of item A and substitute A1 at Miami-1

The search across organizations is guided strictly by sourcing rules, bills of distribution, and the corresponding ranks for the sources. Summarizing the search
process, Oracle APS looks for the demanded item (requested item) and all its possible substitutes within a facility and it continues to look for demanded item (requested item) and its substitutes in other facilities searching breadth first. Referring to the diagram, the search will follow:

Atlanta, Dallas, Miami, Dallas-1, and Miami-1

It is very important to note that the breadth-first search method is used in constrained plans. In optimized plans, the search is entirely driven by costs i.e., item costs, penalty costs for satisfying demand late, transportation costs etc. An optimized plan suggests transfers and substitutes based on the overall objective of the plan and costs mentioned above.

**Enforce Sourcing Splits and Substitute Supply Across Supply Chain** Oracle APS supports enforcing sourcing splits in optimized plans. This means that you can have the system adhere to the sourcing splits (while allocating supply to various sources) you mention on the sourcing rules or bills of distribution even though the splits may not be cost effective.

Supplies that you may find for demanded or substitute items across the supply chain with the intention of use up may violate the enforce sourcing splits logic. If you need the use up functionality, sourcing splits will not be enforced at least for the sources where you would expect to use up the supply efficiently. Enforce sourcing splits is enabled at the sourcing rule or the bill of distribution level; therefore, it is easy to apply the sourcing splits only to the sources you may need and not for the ones that you do not need.

**Example 1** There may be times where enforce sourcing splits conflicts with the substitution use up rule. For example, the following table shows the sourcing splits and supply for Org1 and Org2.

<table>
<thead>
<tr>
<th>Org</th>
<th>Sourcing Split</th>
<th>Supply</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org 1</td>
<td>50%</td>
<td>100 of item A</td>
</tr>
<tr>
<td>Org 2</td>
<td>50%</td>
<td>0 of item A</td>
</tr>
</tbody>
</table>

If the demand for item A is 100, according to sourcing splits, 50 of item A should come from Org 1 and 50 of item A should come from Org 2. However, since there is no supply of item A at Org 2, this cannot be accomplished. In the substitution process, the use up will override enforce sourcing splits and will take all 100 from Org 1 to meet the demand for 100 of item A.
Chaining - Multiple Levels of Substitution

If multiple items are involved in substitution, you can establish a chain of substitutions that is valid.

Example 2 If item A can be substituted for item B and item B can be substituted for item C as shown below:

A --> B
B --> C

then, you can infer that item A can be substituted for item C, and the following substitution is valid:

A --> C

Establishing and maintaining substitution relationships amongst items in a large substitution chain; for example, up to 80 items, can be very tedious and time consuming. Therefore, you need to infer certain substitutions, such as in the above example in which A --> C is inferred given the first two relationships.

If such a relationship is established and if item A is requested, you can satisfy it with supplies from A, B, or C. If item B is requested, you can satisfy it with either B or C. If C is requested, you can satisfy it with only C’s supply.

If you add effectivities as suggested in the Define a Substitution Relationship section, the substitution inference is made effective based either on the effective dates of all relationships or on the intersection of all the dates. The following table shows that the substitution rule between item A and B is effective between Day 2 and Day 10. A second substitution rule between item B and C is effective between Day 6 and Day 22. Therefore, the inferred substitution rule between item A and C is effective between Day 6 and Day 10.

<table>
<thead>
<tr>
<th>From Item</th>
<th>To Item</th>
<th>From Date</th>
<th>To Date</th>
<th>Inferred</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>B</td>
<td>Day 2</td>
<td>Day 10</td>
<td>No</td>
</tr>
<tr>
<td>B</td>
<td>C</td>
<td>Day 6</td>
<td>Day 22</td>
<td>No</td>
</tr>
<tr>
<td>A</td>
<td>C</td>
<td>Day 6</td>
<td>Day 10</td>
<td>Yes</td>
</tr>
</tbody>
</table>

End-Item Substitution Features

This section contains descriptions of substitution features available in Oracle ASCP. It contains information for the following features:
- reciprocal - unidirectional and bidirectional substitution
- preference for generating planned orders
- window for substitution
- partial order fulfillment
- effectivity (time phasing)
- customer-specific substitution rules
- simulate possible substitutions
- transfer of demands on to substitute supplies

**Reciprocal - Unidirectional and Bidirectional Substitution**

As shown in an earlier example, while you can satisfy A’s demand with B’s supply, you cannot satisfy B’s demand with A’s supply. This is referred to as unidirectional substitution. In some cases you can satisfy B’s demand with A’s supply. This is referred to as bidirectional substitution.

Referring to the diagram below, items X, Y and Z are in a unidirectional relationship, and items Y and YY are in a bidirectional relationship. Because item Y has two relationships, Oracle APS will allocate supply from item Z or item YY if you have a demand for item Y.

![Diagram of substitution relationships]

**Preference for Generating Planned Orders**

Given a group of substitutable items, there is considerable variation in how the supplies are to be created for the substitute items. This depends on the type of industry.
Field Service Repair/Replacement Business  In this business, the emphasis is more on locating original item supplies or substitute supplies and distributing items across a defined distribution channel. The demand for the item may be for any one of the items in the substitution chain. If the supplies are not found in your distribution network, you can purchase needed items, but you cannot buy older items as the manufacturer might no longer produce them. In such cases you are forced to buy the current item. This translates to creating supplies only for the highest level item in the substitution chain.

Example 3  In this example, there are four items in the substitution chain: items A1, A2, A3, and A4. The highest revision in this pool is A4 (referred to as the highest level item). You may get demand for any of the four items mentioned. If you get demand for A2, you will evaluate supply availability for A2, A3, and A4 assuming chaining and direction as A1 --> A2 --> A3 --> A4. If you do not find any supply for the demanded item, you can generate supply for highest level item which is A4.

To achieve this, set the profile option MSC: Choice of Items for which to Create Supplies in a Substitute Relationship equal to Highest Level Item.

Semiconductor Business  In semiconductor business, substitutable items are typically coproducts. Even in this scenario, the demand can be for any one of the items in the substitution relationship. In contrast to the previous scenario, here you can produce the item the customer has requested. Given that the products are going to be coproduced, you may need to create coproduct supplies for the rest of the items in the coproduct relationship.

Oracle APS plans for the capacity to produce all the coproducts for a given order because you cannot produce only one item that is part of the coproduct.

Example 4  In this example, there are four items in the substitution chain: items A1, A2, A3, and A4. The highest revision in this pool is also A4 (referred to as the highest level item). If you get a demand for A2, you will evaluate supply availability for A2, A3, and A4 assuming chaining and direction as A1 --> A2 --> A3 --> A4. If you do not find any supply, you can generate supply for the demanded item which is A2.

If items A1, A2, A3, and A4 are in a coproduct relationship, Oracle ASCP generates coproduct supplies for items A1, A3, and A4.

In addition to the two modes of generating supplies as mentioned above (being forced to buy the current item and needing to create coproduct supplies), a general requirement is to have an item attribute that controls whether you want to create new planned supplies. This may be helpful in scenarios where you have existing
supplies that you may want to plan and potentially sell, but you do not want to produce the item anymore.

All of these requirements are addressed by a combination of profile options and item attributes. You can choose one of the following methods to generate supplies using profile option MSC: Choice of Items for Which to Create Supplies in Substitute Relationship:

- Demanded Item
- Highest Level Item
- Follow Item Attributes

If you set the profile option to Follow Item Attributes, Oracle ASCP will follow the Create Supply item attribute established at the item-organization level.

Please refer to the section Appendix A Profile Options for more details on profile options.

**Resolving Conflict Between Item Attributes and Profile Options** If you employ a combination of profile options and item attributes, you may set up contradicting values.

**Example 5** In this example, there are three items: A, B, and C. Item C is the highest level item in the substitution chain. This example shows you may set up a conflict between your item attribute and profile option with unexpected results.

The profile option Choice of Item for Which to Create Supplies in Substitute Relationship can be set to:

- Demanded Item
- Highest Level Item
- Follow Item Attribute

The item attribute Create Supply for each item can be set to either Yes or No. If you select Demand Item or Highest Level item, Oracle APS ignores any item attributes.

The following table shows you what to expect when you set the Profile Option to Follow Item Attribute.
Conflicts Related to Enforce Demand Due Dates Plan: Running your plans using the plan option Enforce Demand Due Dates means that you must satisfy the demand on time. However, if you set the profile option Choice of Item for Which to Create Supplies in Substitute Relationship to Follow Item Attribute and the item attribute Create Supply for all the substitute items in the substitution chain is set to No, no supplies will be created and Enforce Demand Due Dates will be violated.

Conflict Between Choice to Create Supplies and Enabling Item in an Organization: If you have a substitution chain A → B → C and you have set the profile option Choice of Item for Which to Create Supplies in Substitute Relationship to Highest Level Item, the expectation is that Oracle APS will create supply for item C. However, item C must be enabled in the organization in which you are trying to create a supply. If item C is not enabled in the organization, Oracle APS will create supply for item B (the next highest level item in the substitution chain) and not create supply for item C.

<table>
<thead>
<tr>
<th>Profile Option: Choice of Item for Which to Create Supplies in Substitute Relationship</th>
<th>Item Attribute: Create Supply</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Follow Item Attribute</td>
<td>Yes for A, B, and C</td>
<td>Create supplies normally (default)</td>
</tr>
<tr>
<td>Follow Item Attribute</td>
<td>No for A, B, and C</td>
<td>Does not create supplies and you will get shortages</td>
</tr>
<tr>
<td>Follow Item Attribute</td>
<td>Yes for A, No for B, and Yes for C</td>
<td>Create supplies for A based on demand for A; create supplies for B based on demand for B or C</td>
</tr>
<tr>
<td>Follow Item Attribute</td>
<td>No for A, Yes for B, Yes for C</td>
<td>Create supplies for B or C based on demand for A, B, or C</td>
</tr>
<tr>
<td>Follow Item Attribute</td>
<td>No for A, No for B, Yes for C</td>
<td>Creates supplies for C based on demand for A or B</td>
</tr>
<tr>
<td>Follow Item Attribute</td>
<td>Yes for A, Yes for B, and No for C</td>
<td>Creates supplies for C based on demand for A or B</td>
</tr>
<tr>
<td>Follow Item Attribute</td>
<td>No for A, Yes for B, No for C</td>
<td>Creates supplies for B based on demand for A or B</td>
</tr>
<tr>
<td>Follow Item Attribute</td>
<td>Yes for A, No for B, No for C</td>
<td>Creates supplies for A based on demand for Item A</td>
</tr>
</tbody>
</table>
Window for Substitution

While substitutions are part of regular business process, substitutions done too far ahead of demand might not be appropriate. For example, if you find a substitute supply four weeks away from demand, you may not want to substitute as you may have a good chance of producing supply for the demanded item in the next three weeks.

A substitution window allows you to limit the time frame for the substitution. You can define the substitute window for an item using item attribute form in Oracle Inventory. The substitution window is effective in the forward direction from every demand. All substitute supplies prior to demand are eligible for substitution. Please note that the substitution window is applicable only for substitution; if you are netting supply and demand from the same item, the substitution window does not apply.

Example 6  In the time-phased supply picture shown in the following table, item A is being substituted for item B. You get a demand for 30 units of item B in time bucket 1. If substitution must happen right away, you can use A's supply for B's demand and satisfy it on time. If you can wait for two more time buckets, you will find the supply for B in time period 3; therefore, you can avoid substitution. The assumption here is you will get a demand for item A and you do not have to give up on the amount of money you could make by shipping A for A's demand.

<table>
<thead>
<tr>
<th>Item</th>
<th>Time Bucket 1</th>
<th>Time Bucket 2</th>
<th>Time Bucket 3</th>
<th>Time Bucket 4</th>
<th>Time Bucket 5</th>
<th>Time Bucket 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item A</td>
<td>25</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
</tr>
<tr>
<td>Item B</td>
<td>5</td>
<td>0</td>
<td>25</td>
<td>0</td>
<td>0</td>
<td>25</td>
</tr>
</tbody>
</table>

At the same time, if supply of 25 units in time period 3 was not available, you may not be able to wait until time period 6 to pick up the supply for item B, as delivery performance might drive you to use substitution right away.

Another aspect of substitution window might be to evaluate all native demands and supplies within a specified amount of time, and to consider only excess supply from each item as possible substitution supplies.

Continuing our example from above, you may also have demand for 20 units of item A in time period 1. In this case, you may not want to satisfy B's demand using A's supply. You may want to find out the excess after satisfying the native demand before you apply substitutions. Therefore, the demand for Item B can satisfied only
as follows: 5 units of its own supply in time period 1, 5 units of item A’s supply in time period 1, and its own supply of 20 units in time period 3.

Satisfying native demand may run contrary to prioritized demand in constrained plans. The following table shows the supply/demand picture where demand for item B can be satisfied with a supply for item A. The substitute window for both items is 3 days.

<table>
<thead>
<tr>
<th>Item</th>
<th>Time Bucket 1</th>
<th>Time Bucket 2</th>
<th>Time Bucket 3</th>
<th>Time Bucket 4</th>
<th>Time Bucket 5</th>
<th>Time Bucket 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item A (Demand)</td>
<td>20(Priority 10)</td>
<td>10(Priority 20)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Item A (Supply)</td>
<td>0</td>
<td>20</td>
<td>5</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Item B (Demand)</td>
<td>50(Priority 1)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Item B (Supply)</td>
<td>5</td>
<td>10</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>25</td>
</tr>
</tbody>
</table>

Given the logic of constrained plans, you will try to satisfy every demand based on its associated demand priority. In the above scenario, satisfying native demand and following demand priorities are at odds. Going by priority, you will consume all the supplies for item B and substitute 10 units from item A to satisfy B’s demand. This means demand from item A may not be satisfied on time because it needs to be manufactured or bought.

If your business scenario needs to give preference to native demand satisfaction within the substitute window, you can do so by setting up system level profile options. If you set up the profile option to give preference to native demand satisfaction, item B will not be able to substitute any supply from item A in the previous example. You can achieve native demand satisfaction by setting up system level profile options. Please see the section Appendix A Profile Options for details.

Substitution window is not applicable in optimized plans because the end item substitution is purely based on cost in an optimized plans

Enforced Demand due date plans (both constrained and optimized) do not consider substitution window

**Partial Order Fulfillment** In this type of substitution, the demand must be satisfied with only one type of item. If item A and item A1 are substitute items, you cannot, for example, satisfy a demand for 100 units of A with 50 units of A and 50 units of A1. You must either supply 100 units of A or 100 units of A1.
This feature is available in the Planning Details window.

**Example 7**  You can specify Partial Order Fulfillment attribute for a substitute relationship in Oracle Inventory using the Planning Details form (this form is accessible through the Item Relationship form)

In this example, items A and A1 are substitute items. Based on the supply demand view in the following table, you would substitute and satisfy the demand by allocating supply from item A1. This is enforced because the supply for item A by itself could not have satisfied the demand, and in addition, the entire demand must be satisfied by either item A or A1.

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Day 2</th>
<th>Day 15</th>
<th>Day 18</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand for A</td>
<td>0</td>
<td>50</td>
<td>0</td>
</tr>
<tr>
<td>Supply for A</td>
<td>0</td>
<td>40</td>
<td>0</td>
</tr>
<tr>
<td>Supply for A1</td>
<td>0</td>
<td>0</td>
<td>60</td>
</tr>
</tbody>
</table>

If the supply for A1 is inadequate to meet the demand, you can satisfy the demand by using 40 units of existing supply of item A and new supply of 10 units for A.

**Effectivity (Time Phasing)**

It is common to see an effective time period for substitution. This is typically used to model restrictions on use up of inventory, time phase product qualifications and engineering changes etc. You can specify substitution Effective From and To dates along with definition of substitution.

You can specify effective dates for substitution in the Planning Details form.

The effective dates for the substitution will be validated against the demand due date (Suggested Due Date) to derive the valid substitutions. Let us consider the following substitution table:

<table>
<thead>
<tr>
<th>From Item</th>
<th>To Item</th>
<th>Customer</th>
<th>Ship-to Address</th>
<th>From Date</th>
<th>To Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>X1</td>
<td>X2</td>
<td>Company A</td>
<td>75 Hill Street</td>
<td>3/1/2002</td>
<td>9/30/2002</td>
</tr>
<tr>
<td>X1</td>
<td>X3</td>
<td>Company A</td>
<td>219 Revere Blvd.</td>
<td>4/1/2002</td>
<td>10/30/2002</td>
</tr>
<tr>
<td>X2</td>
<td>X3</td>
<td>Company B</td>
<td>219 Revere Blvd.</td>
<td>6/1/2002</td>
<td>null</td>
</tr>
</tbody>
</table>
End-Item-Level Substitution

If you get demand from Company A/75 Hill Street on 4/1/2002 for item X1, you can substitute with item X2. If your demand is beyond 9/30/2002, the substitution between X1 and X2 is not possible. Similarly, if you get a demand from Company B/219 Revere Blvd. for item X1 on 6/1/2002 you can substitute with item X3. If you get a demand for item X2 after 6/1/2002, you can substitute with item X3.

Please note that if you run a constrained plan, your demand satisfied date may be different from suggested due date. The validity of the substitution is derived by comparing the suggested due date with the effective dates, not the demand satisfied date.

Customer-Specific Substitution Rules

Substitution rules can sometimes change depending on which customer site is ordering the item. Often customers qualify the plant/s producing the items. In a typical set up you will issue a different item number based on the origin of the item even if it is the same item. Item numbers issued to represent the item origin will form a basis to specify customer-specific substitution.

You will be able to set up substitutions specific to a single customer or all customers.

Example 8  There are three customers; Customer A, B, and C. Assume that they buy Integrated Circuits with varying degrees of capability, namely IC200, IC300, and IC400. Restrictions posed by the customers are as follows:

- Customer A can accept IC200 and IC300 but not IC400
- Customer B can accept IC200 and IC400 but not IC300
- Customer C can accept all the three items

You can set up the above substitutions in the following way:

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Customer</th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>IC200</td>
<td>IC400</td>
<td>Customer B</td>
<td>Address B</td>
</tr>
<tr>
<td>IC200</td>
<td>IC300</td>
<td>Customer C</td>
<td>Address C</td>
</tr>
<tr>
<td>IC200</td>
<td>IC400</td>
<td>Customer C</td>
<td>Address C</td>
</tr>
<tr>
<td>IC200</td>
<td>IC300</td>
<td>Customer A</td>
<td>Address A</td>
</tr>
</tbody>
</table>

Oracle Inventory allows you to specify customer and customer ship-to address specific substitutions.
Substitution Definition With and Without Customer and Customer Site It is possible to have customer-specific and generic substitution relationships for the same set of items. However, if you record a customer-specific rule, then the generic rules no longer apply to that customer. You will have to define an item relationship for each substitution that the customer will accept.

Example 9 Given the above understanding, let us look at an example to clarify the intended behavior.

Customer-Specific Substitution Relationships

<table>
<thead>
<tr>
<th>From Item</th>
<th>To Item</th>
<th>All Customers</th>
<th>Customer</th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>X1</td>
<td>X2</td>
<td>Y</td>
<td>Blank</td>
<td>Blank</td>
</tr>
<tr>
<td>X2</td>
<td>X3</td>
<td>Y</td>
<td>Blank</td>
<td>Blank</td>
</tr>
<tr>
<td>X1</td>
<td>X3</td>
<td>Y</td>
<td>Blank</td>
<td>Blank</td>
</tr>
<tr>
<td>X1</td>
<td>X4</td>
<td>Y</td>
<td>Blank</td>
<td>Blank</td>
</tr>
<tr>
<td>X1</td>
<td>X2</td>
<td>N</td>
<td>Company 1</td>
<td>Company 1 address</td>
</tr>
<tr>
<td>X1</td>
<td>X3</td>
<td>N</td>
<td>Company 2</td>
<td>Company 2 address</td>
</tr>
<tr>
<td>X2</td>
<td>X3</td>
<td>N</td>
<td>Company 2</td>
<td>Company 2 address</td>
</tr>
<tr>
<td>X1</td>
<td>DUMMY</td>
<td>N</td>
<td>Company 3</td>
<td>Company 3 address</td>
</tr>
</tbody>
</table>

The first four rows of the table show generic substitution relationships. That is, X1 can substitute for X2, etc. The next four rows show company-specific substitutions. Company 1 will not accept any substitutions other than X1 for X2. Company 2 will not accept any substitutions other than the X1 for X3 and X2 for X3. So even though there are generic substitution relationships, customer-specific rules overrides all other rules for that customer.

The last line of the table shows a customer that does not accept any substitutions. For this customer, you must create a dummy item that forces the system not to consider any substitutions for any items for that customer.

All other customers will accept all the generic rules in the first 4 rows of the substitution table.

If you find any substitution rule tied to a customer, the only substitution/s which are valid for the customer are the rules that are specific to a customer.
Example 10  In this example, effective dates are added on top of the definition in Example 8:

<table>
<thead>
<tr>
<th>From Item</th>
<th>To Item</th>
<th>Customer</th>
<th>Customer Address</th>
<th>From Date</th>
<th>To Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>X1</td>
<td>X2</td>
<td>Blank</td>
<td>Blank</td>
<td>null</td>
<td>null</td>
</tr>
<tr>
<td>X2</td>
<td>X3</td>
<td>Blank</td>
<td>Blank</td>
<td>null</td>
<td>null</td>
</tr>
<tr>
<td>X1</td>
<td>X3</td>
<td>Blank</td>
<td>Blank</td>
<td>null</td>
<td>null</td>
</tr>
<tr>
<td>X1</td>
<td>X4</td>
<td>Blank</td>
<td>Blank</td>
<td>null</td>
<td>null</td>
</tr>
<tr>
<td>X1</td>
<td>X2</td>
<td>Company 1</td>
<td>Company 1 address</td>
<td>3/1/2002</td>
<td>indefinite</td>
</tr>
<tr>
<td>X1</td>
<td>X3</td>
<td>Company 2</td>
<td>Company 2 address</td>
<td>4/1/2002</td>
<td>4/1/2003</td>
</tr>
<tr>
<td>X2</td>
<td>X3</td>
<td>Company 2</td>
<td>Company 2 address</td>
<td>6/1/2002</td>
<td>indefinite</td>
</tr>
<tr>
<td>X1</td>
<td>DUMMY</td>
<td>Company 3</td>
<td>Company 3 address</td>
<td>null</td>
<td>null</td>
</tr>
</tbody>
</table>

Given the above substitution table, Company 1 will not accept any substitution prior to 3/1/2002. Company 2 will not accept any substitution prior to 4/1/2002, and then will accept X1 for X3 from 4/1/2002 to 4/1/2003, and then will accept X2 to X3 from 6/1/2002. As before, Company 3 will accept no substitutions.

Simulate Possible Substitutions

Once you run a plan with a given set of substitution definitions, you may realize that more substitution definitions are possible in the near future. You will need to run the plan with possible substitutions and evaluate delivery performance and other key performance indicators.

You can associate a Substitution Set with each substitution definition in Oracle Inventory. A Substitution Set is an alphanumeric field value that you can establish to make up a set of substitutions. Substitution Set is a global entity meaning that you can establish the same Substitution Set across different instances. The following table gives examples of substitution definitions. The From and To column of the table are defined in the Item Relationship window. The rest of the columns are defined in the Planning Details window.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Substitution Set</th>
<th>Customer</th>
</tr>
</thead>
<tbody>
<tr>
<td>X1</td>
<td>X2</td>
<td>null</td>
<td>Company X</td>
</tr>
<tr>
<td>X1</td>
<td>X2</td>
<td>null</td>
<td>Company Y</td>
</tr>
</tbody>
</table>
If you run your plan without a Substitution Set, item X1 can be substituted for X2 for both Company X and Company Y. If you want to evaluate the results of substituting item X1 for item X3, you can choose Substitution Set SIM1 in the plan option and run the plan. Similarly, you can run a plan with Substitution Set SIM2 to evaluate the possibility of substituting item X1 for X4 for Company X and substituting item X1 for X5 for Company Y.

As explained above, you can choose a Substitution Set for a plan at plan option level. Oracle APS will plan using the substitution definitions tied to a Substitution Set. If you need to simulate with other possible substitutions, you can associate a different Substitution Set with a plan and run the plan. If you do not choose a Substitution Set, only the substitution relationships without a Substitution Set defined in Oracle Inventory will be considered in the plan.

Note: You must run a batch plan (as opposed to an online plan) to use substitution sets.

Transfer of Demands on to Substitute Supplies
The ability to show pegging and supply/demand details if you have substitution supply identified for a demand is important because the items that bear supply and demand are different.

One of the ways the display can be clearly shown is when you transfer the demand from original item to the substitute item for all substitutions.

Example 11 The following table shows the supply and demand for items A and B. In this example, 30 units of item B can use 25 units of item A and 5 units of its own supply to satisfy this demand.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Substitution Set</th>
<th>Customer</th>
</tr>
</thead>
<tbody>
<tr>
<td>X1</td>
<td>X3</td>
<td>SIM1</td>
<td>Company X</td>
</tr>
<tr>
<td>X1</td>
<td>X4</td>
<td>SIM2</td>
<td>Company X</td>
</tr>
<tr>
<td>X1</td>
<td>X3</td>
<td>SIM1</td>
<td>Company Y</td>
</tr>
<tr>
<td>X1</td>
<td>X5</td>
<td>SIM2</td>
<td>Company Y</td>
</tr>
</tbody>
</table>

If you run your plan without a Substitution Set, item X1 can be substituted for X2 for both Company X and Company Y. If you want to evaluate the results of substituting item X1 for item X3, you can choose Substitution Set SIM1 in the plan option and run the plan. Similarly, you can run a plan with Substitution Set SIM2 to evaluate the possibility of substituting item X1 for X4 for Company X and substituting item X1 for X5 for Company Y.

As explained above, you can choose a Substitution Set for a plan at plan option level. Oracle APS will plan using the substitution definitions tied to a Substitution Set. If you need to simulate with other possible substitutions, you can associate a different Substitution Set with a plan and run the plan. If you do not choose a Substitution Set, only the substitution relationships without a Substitution Set defined in Oracle Inventory will be considered in the plan.

Note: You must run a batch plan (as opposed to an online plan) to use substitution sets.

Transfer of Demands on to Substitute Supplies
The ability to show pegging and supply/demand details if you have substitution supply identified for a demand is important because the items that bear supply and demand are different.

One of the ways the display can be clearly shown is when you transfer the demand from original item to the substitute item for all substitutions.

Example 11 The following table shows the supply and demand for items A and B. In this example, 30 units of item B can use 25 units of item A and 5 units of its own supply to satisfy this demand.

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Item</th>
<th>Day 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand</td>
<td>A</td>
<td>0</td>
</tr>
</tbody>
</table>
Since substitution is involved between item B and item A, Oracle APS will transfer the demand from item B to item A for 25 units to account for substitution. If there are multiple items with which item B can be substituted, you will see demands on all such items. In other words, the original demand will be split into possibly multiple demands if substitutions are involved.

**Examples Illustrating Substitution Logic**

**Example for customer-specific substitution, partial order fulfillment, time phasing**

This example uses three customers. None of these customers accept a mix of original items and substitute items in any one shipment (i.e., partial orders fulfillment is not allowed); therefore, the entire shipment needs to be made up of either original items or one of the substitute items allowed based on acceptance rules described below. The substitution direction is always from higher level to a lower level i.e., supply from A1 can be used to satisfy A demand.

The following profile options and item relationship rules have been set in the following example:

**Profile Options:**

- MSC: Choice of item for which to create supplies in substitute relationship = Demanded Item.
- MSO: Choice of supply for substitution = All supplies

**Item relationship rules:**

- Partial Fulfillment = No
- Reciprocal relationship = No

**Company S Example**

A customer-specific item relationship is defined to substitute A1 for A effective until Day 6. The item attribute Substitution Window = 4 days.
As shown in the following table, the demand for product A on Day 1 can be met with on hand (qty = 5), supply (qty = 10) on Day 4, and a new planned order of 5 units for A. The supply from substitute item A1 is not enough to make up the entire order, and the supply on Day 6 is out of reach due to the 4-day substitution window. The demand on Day 7 can be met with supply of 10 units on Day 8 and a planned supply of 40 units for A, because substitution of item A1 is not valid after 6 days. Substitution did not occur because the substitute supply was not adequate to meet the order demand.

### Company R Example

A customer-specific item relationship is defined to substitute D for C, and B for A effective until Day 6. The item attribute Substitution Window = 1 day.

As shown in the following table, the demand on Day 1 for item A (qty = 20) cannot be satisfied by substitution because partial order fulfillment is not allowed. The inventory of item B (qty = 15) is inadequate to meet this demand and the supply of 5 units on Day 3 is outside the substitution window of 1 day. Therefore, it will be satisfied by 5 units of on hand, 10 units of supply from Day 8, and 5 units of planned supply.

Demand on Day 6 for item A for 30 units can be satisfied by substitution; i.e., 15 units of on hand, 5 units of supplies from Day 3, and 10 units out of 50 units from Day 6.

The demand for item C, qty = 10, on Day 2 can be satisfied by 8 units of on hand and a supply of 2 units for D scheduled on Day 2. Demand of 60 units for item C on Day 7 can be satisfied with an existing scheduled supply of 60 units on Day 7 for item D. Note that with a 1-day substitution window, the supply must be available on the same day as the demand. Future scheduled receipts will not be utilized.
End-Item-Level Substitution

Company Q Example

A customer specific item relationship is defined to substitute B for A for the next 5 days and D for C for the next 10. The item attribute Substitution Window = 2 days.

As shown in the following table, demand for 20 units of item A on Day 1 can be satisfied completely by substituting the two scheduled supplies of item B, 10 units on Day 1 and Day 3. The demand for item A on Day 7 can be satisfied using 10 units of supply on Day 8 and a new planned supply of 40 units on Day 7 as the substitution rule is not effective after Day 6. The demand for item C can be satisfied with substitution for both demands, because it’s substitution rule is effective until Day 10.

Example for Native Demand Fulfillment, Substitution Window, Partial Order Fulfillment

In the following example, A2 supply can be substituted with A1 demand. Substitution window is 2 days.

As shown in the following table, on Day 1, you have demand for both A1 and A2. Because of native demand fulfillment rule, only excess supply after fulfilling native demand can be used for substitution. Therefore, demand for A1 will not be satisfied.
by supply for A2 on Day 1. The situation is the same on Day 2; you do not have excess supply of A2 to satisfy A1’s demand. The demand for A1 on Day 1 will be met with supply for A1 on Day 3 and a planned supply of 3 units for A1. This is due to the Partial Order Fulfillment rule.

The demand for A1 on Day 2 will be satisfied with 3 units of A2 (which is excess supply of A2 from Day 3) and a planned supply of A2 for 2 units. The planned supply has to be for A2 because the rule is Partial Order Fulfillment. The supply of A2 on Day 6 is not open because of substitution window.

**Example for Search the Supply Chain for Substitution, Substitution Window, Use Up**

In this example there are three facilities: Facility 1, 2, and 3. The transfer times between facilities is 2 days; the window for substitution is 2 days. The supply and demand picture for 3 items A1, A2, A3 is shown in the following tables. A3 is the lowest level and it can accept either A1 or A2 supply. A2 can accept A1 supply, but A1 cannot accept any substitutions.

The search rules are to search Facility 1 first, Facility 2 second, and Facility 3 third.

### Facility 1

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Item</th>
<th>Day 1</th>
<th>Day 2</th>
<th>Day 3</th>
<th>Day 4</th>
<th>Day 5</th>
<th>Day 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand</td>
<td>A3</td>
<td>10</td>
<td></td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supply</td>
<td>A2</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
End-Item-Level Substitution

Facility 2

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Item</th>
<th>Day 1</th>
<th>Day 2</th>
<th>Day 3</th>
<th>Day 4</th>
<th>Day 5</th>
<th>Day 6</th>
<th>Day 7</th>
<th>Day 8</th>
<th>Day 9</th>
<th>Day 10</th>
<th>Day 11</th>
<th>Day 12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand</td>
<td>A2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>10</td>
</tr>
<tr>
<td>Supply</td>
<td>A1</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5</td>
</tr>
<tr>
<td>Supply</td>
<td>A2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5</td>
</tr>
</tbody>
</table>

Facility 3

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Item</th>
<th>Day 1</th>
<th>Day 2</th>
<th>Day 3</th>
<th>Day 4</th>
<th>Day 5</th>
<th>Day 6</th>
<th>Day 7</th>
<th>Day 8</th>
<th>Day 9</th>
<th>Day 10</th>
<th>Day 11</th>
<th>Day 12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand</td>
<td>A1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>10</td>
</tr>
<tr>
<td>Supply</td>
<td>A1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5</td>
</tr>
<tr>
<td>Supply</td>
<td>A3</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3</td>
</tr>
</tbody>
</table>

Demand on Day 3 for A3 in Facility 1 will be satisfied with 2 units of supply of A1 and 5 units of supply at Facility 2, and 3 units of supply of A3 at Facility 3. Facility 2 is the next logical facility to search based on our rules.

The 10 units of demand on Day 3 for A2 at Facility 2 will be satisfied with transferring 10 units of A1 from Facility 3, i.e., you will get a recommendation to reschedule the order to Day1 so that you can transfer it in time to make the substitution. Notice that the 5 units of supply for A1 is outside the substitution window.

The 3 units of demand on Day 6 for A3 can be met by transferring supply of A3 from Facility 3. The 10 units of demand on Day 8 for A1 can be satisfied by transferring 5 units of A1 from Facility 2 and using the 5 units of supply available in Facility 3. In both cases, you will get recommendations to reschedule the order so that you will satisfy demand on time.

General Substitution Examples

Tie between Demanded and Substitute Item Supply

Item A and A1 are substitute items. Item A can use A1’s supply to satisfy the demand. This is a one-way substitution. Substitution window is set to 5 days.
As shown in the following table, the demand on Day 2 has two supplies to consider: 60 units of its own supply on Day 50 and supply of a substitute item on Day 2. The preference is to substitute right away, i.e., apply substitute supply of 60 units on Day 2 to satisfy the demand for 60 units of item A. This goes contrary to regular planning logic of planning item by item where you would pick up supply on Day 50.

If the supply for A1 were to be on Day 15, you would not pick up substitute supply as it is outside the substitution window. If there is no time advantage and both demanded item and substitute item are available on the same day, you pick up demanded item’s supply (i.e., A1’s supply)

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Item</th>
<th>Day 2</th>
<th>Day 15</th>
<th>Between Day 16 and Day 49</th>
<th>Day 50</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand</td>
<td>A</td>
<td>60</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Supply</td>
<td>A</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>60</td>
</tr>
<tr>
<td>Supply</td>
<td>A1</td>
<td>60</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

**Search Direction and Transferring Demands**

**Example 11** A supply chain is shown in the diagram below. In the diagram M1, S1, D2, M2, D2, and P1 are Organizations. V1 is a supplier. Organization M1 sources from S1 and D2 in a ranked order. Organization D2 sources from three different sources. (Make at, Transfer from, Buy From). Your desired search sequence is M1, S1, D2, M2, P1 and V1.
The following tables show supply and demand for the organizations in the diagram.

In this example, you have two items; A and A1. A can use A1 supply due to substitution rules. Both item A and A1 are enabled in all organizations. Assume that you do not have any supplies at Organization M2, P1 and supplier V1.

**Org: M1**

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Item</th>
<th>Day 2</th>
<th>Day 5</th>
<th>Day 10</th>
<th>Day 20</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand</td>
<td>A</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Supply</td>
<td>A</td>
<td>0</td>
<td>5</td>
<td>0</td>
<td>10</td>
</tr>
<tr>
<td>Supply</td>
<td>A1</td>
<td>0</td>
<td>0</td>
<td>15</td>
<td>0</td>
</tr>
</tbody>
</table>

**Org: S1**

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Item</th>
<th>Day 2</th>
<th>Day 5</th>
<th>Day 10</th>
<th>Day 20</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand</td>
<td>A</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
Starting with a demand for 100 units of Item A in Organization M1 on Day 2, you consume 30 units of supply from A and A1 leaving you with a net demand of 70 units. A planned order demand for item A is created and pushed down to Org S1, where you will consume 20 units of supply from Item A and 10 units of supply from item A1. (Notice that the demand is pushed down for A instead of A1. If you push down the demand on A1, you run a risk of not using supply from item A). Now you are left with a net demand of 40, for which you create a planned order demand for item A and push it down to Org D2. You consume 10 units of supply from both A and A1 leaving you a net deficit of 20 units.

Now that you have exhausted all original item supplies and substitute supplies in the supply chain, you need to still produce 20 units. The creation of 20 units of supply follows the normal planning logic.

**Optimization**

So far we have seen how rules-based substitution works in Oracle APS. The logic is driven by set of rules rather than various costs that play a role in substitution decisions in an optimized plan. If you want your substitution logic to be driven purely by costs, you can run optimized plans based on costs. Substitution definition remains the same, but many of the rules described above may not be followed. Standard cost of items, carrying costs, penalty costs for satisfying the demand late, objectives chosen at the plan will affect the logic of substitution.
Exception Messages

When substitution occurs in Planning, an exception message is generated. A typical planning process may consist of analyzing exceptions generated by the plan, drilling into the details of exceptions, analyzing supply demand records using the Supply/Demand window, vertical plan and pegging. In this process you may access substitution definition and characteristics several times. Users may access the horizontal plan to get a detailed understanding of the demands placed by the substitution, supplies received as a part of substitution logic, and analyze possibilities of improving the solution based on their knowledge.

Exception Display

When the system performs a substitution, the following exception message is generated: Demand satisfied using end item substitution. These exceptions are summarized in the Substitutes and Alternates Used exception group. The following screen shot shows this exception message.
Exception Details
Oracle APS converts the demand from the original item to substitute item/s if substitute supply is found. Access the Exception Details window to view the demand that has been satisfied by the substitute item.
Use the information in the following table to specify the fields and options.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org.</td>
<td>Organization in which the exceptions occurred</td>
</tr>
<tr>
<td>Item</td>
<td>The item for which you received the demand, the exception is for this item.</td>
</tr>
<tr>
<td>Quantity</td>
<td>The quantity on the original order</td>
</tr>
<tr>
<td>Order number</td>
<td>Sales Order Number or MDS/Forecast name for the From item</td>
</tr>
<tr>
<td>Substitute item/s</td>
<td>This is the item to which the demand was transferred.</td>
</tr>
<tr>
<td>Substitute Qty.</td>
<td>The demand transferred quantity.</td>
</tr>
<tr>
<td>Substitute Org.</td>
<td>The organization at which you found the supply</td>
</tr>
</tbody>
</table>

From the end item exception, you can select either the Items or the Supply/Demand window.

If you right-mouse click from the exception detail, the following menu appears: Demand, Sources, Destination, Horizontal plan, and Vertical plan.
To view these demands, select the exceptions message and select the Supply/Demand button. The Demand window shows you each demand for that record.

**Figure 18–8  The Demand window**

You can look at pegging for each record from the Demand window to analyze replenishment for each demand. The Original Item and the Original Quantity are fields that are available in the Demand window that may be helpful in understanding substitute exceptions. These are optional fields that can be added to the window by selecting Folder > Show Fields.

If substitute supply is found in another organization, you will be able to see the original organization in the pegging details for that demand.

**Exception Details Example**  Oracle ASCP converts the demand from the original item to substitute item/s if substitute supply is found. In the following example, Plug in Card 100 can be substituted for Plug in Card 150 and Plug in Card 200. You have 50
units of Plug in Cards 150 and 200 in stock and you receive 100 units of demand for Plug in Card 100. Oracle ASCP splits the original demand (for Plug in Card 100) of 100 units into two pieces; the first will be demand for 50 units of Plug in Card 150, the second demand will be for 50 units of Plug in Cards 200. The demand has been transferred to the substitute item. The rest of this section explains how review the exception details.

Once you identify that demands have been satisfied by substitute items from exceptions, you can navigate to the Demand window from the Exception Details window. Select the record and right-click. Select Demand from the drop-down menu. This is available for each line of the exception message Demand Satisfied by Substitute End Items. The Demand window shows you all the demand splits associated with the original demand.

If you navigate to the Demands screen from the exception message Demand Satisfied by Substituting End Items for item Plug in Card 100, you will see two records in Demands window; the first will be demand for 50 units of Plug in Card 150; the second demand will be for 50 units of Plug in Cards 200. If you happen to have 10 units of Plug in Card 100 in stock you will see three records as follows:

- 10 units of demand for Plug in Card 100
- 40 units of demand for Plug in Card 150
- 50 units of demand for Plug in Card 200

**End Item Substitution Workflow for Planning**

If you plan for substitution, it is only logical to initiate the execution of the substitution from Planning. A general workflow is initiated by the Planning engine to notify relevant people in your organization of substitution decisions.

For each occurrence of the exception message: Demand Satisfied by Using End Item Substitution, a workflow is initiated and sent to the planner associated with the original item. At this point you can end the workflow or notify the Sales Representative or the Customer Contact of the substitution.

Following is a diagram of the workflow initiated by the planning engine. You will notice that there is not an alternative to change the line item based on the workflow. Users can manually change the line items as long as the orders are in a pre-booking stage.
The heading of the workflow is Demand Satisfied by Substituting End Item/s. The following details are shown in the workflow:

- **From item** - The item for which you received the demand, the exception is for this item.
- **Plan name** – Name of the plan
- **Order Number** – Optional based on the type of demand
- **Line Number** - Optional based on the type of demand
- **Original Quantity** – The requested quantity
Substitute item - Substitute item, this is the item to which the demand was transferred. These could be multiple items.

Organization – Organization at which the exceptions happened.

Substituted Quantity - The demand transferred quantity.

Substitute Supply Organization - The organization at which you found the supply.

**End Item Substitution and Oracle Global Order Promising**

Substituting supply of a higher level item (in a substitution chain) for a demand from lower level item (in a substitution chain) demand is a decision that needs to begin with Oracle Global Order Promising. Since both ASCP and Oracle Global Order Promising processes are analyzing the same data, the logic with which the substitutions are done needs to be consistent. Oracle Global Order Promising supports almost all the features mentioned in the End Item Substitution Features section. In some cases, the way Oracle Global Order Promising supports the product substitution features is slightly different from the planning engine. These will be highlighted in this section.

The following end-item substitution features are supported in Oracle Global Order Promising:

- Chaining; multiple levels of substitution
- Unidirectional and bidirectional substitution
- Generate planned orders based on the user setup
- Search the supply chain for substitution (breadth first search)
- Window for substitution (substitute supply is excess supply only, this is explained in subsequent examples)
- Effectivity (time phasing)
- Customer specific substitution rules
- Transfer of demands on to substitute supplies
- End-item substitution is only enabled for ATP queries based on planning output; it is not enabled for ATP queries based on collected data
The following topics are covered in this section:

- Examples to Explain Substitution Logic in Oracle Global Order Promising
- Display of Possible Substitutes
- Creation of Planned Supplies
- Searching Supply Chain for Substitutes
- Evaluating Supplies After Request Date
- Resolving Ties in the Substitution Chain
- Substitution in Allocated ATP
- Allocated ATP In a Supply Chain
- End Item Substitution Workflow for Oracle Global Order Promising

Examples to Explain Substitution Logic in Oracle Global Order Promising

Substitution Using Supplies by Request Date

Example 12

In this example you have three items, A, A1, and A2. A2 is the highest level of item in the substitution chain. Item A can use A1 and A2 supply, A1 can use supply from A2. The following tables show you the supply/demand picture for items in the substitution chain. In this example, there are two inquiries for Item A; one on Day 12 for 50 units and the other on Day 35 for 80 units after you schedule the first demand.

Substitution Window width: 5 days for all items

Item A

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Item</th>
<th>Day 2</th>
<th>Day 5</th>
<th>Day 10</th>
<th>Day 12</th>
<th>Day 15</th>
<th>Day 35</th>
<th>Day 40</th>
<th>Day 45</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand</td>
<td>A</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
Demand on Day 12 for item A is satisfied by consuming 50 units of A2. Even though you can use supplies from A and A1, the supplies need to be met with just one type of item because Oracle Global Order Promising does not support Partial Order Fulfillment.

The promise date for the first demand will be Day 12 with substitution details as follows:

- Item A2 - ATP quantity is 40 on Day 12

Oracle Global Order Promising will always pick up substitute supplies only if the supplies are in excess after satisfying existing committed native demand. Referring to the example, although there are 35 units of supply on Day 5 for item A2, only 33 units can be used for substitution because it needs to satisfy its own demand for 2 units.

Demand for item A on Day 35 will first consume its own supply of 80 units. Supply from item A1 will not be considered because of substitution window. The promise date for the second demand will be Day 35 with substitution details as follows:

- Item A - ATP quantity is 80 on Day 35
Production Prior to Request Date

Example 13
To illustrate the way Oracle Global Order Promising considers this next point, we will use Example 12, but we will change the supply picture as follows. The substitution window is set to 10 days for all items. There are two inquiries for Item A, one on Day 12 for 50 units and the other on Day 35 for 80 units after you schedule the first demand.

For this example, the profile option MSC: Choice of Item for Which To Create Supplies in Substitute Relationship is set to Demanded Item.

Item A

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Item</th>
<th>Day 2</th>
<th>Day 5</th>
<th>Day 10</th>
<th>Day 12</th>
<th>Day 15</th>
<th>Day 35</th>
<th>Day 40</th>
<th>Day 45</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand</td>
<td>A</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Supply</td>
<td>A</td>
<td>0</td>
<td>10</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>5</td>
<td>0</td>
</tr>
</tbody>
</table>

Item A1

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Item</th>
<th>Day 2</th>
<th>Day 5</th>
<th>Day 10</th>
<th>Day 12</th>
<th>Day 15</th>
<th>Day 35</th>
<th>Day 40</th>
<th>Day 45</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand</td>
<td>A1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Supply</td>
<td>A1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>7</td>
<td>0</td>
<td>10</td>
<td>65</td>
<td>0</td>
</tr>
</tbody>
</table>

Item A2

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Item</th>
<th>Day 2</th>
<th>Day 5</th>
<th>Day 10</th>
<th>Day 12</th>
<th>Day 15</th>
<th>Day 35</th>
<th>Day 40</th>
<th>Day 45</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand</td>
<td>A2</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Supply</td>
<td>A2</td>
<td>0</td>
<td>35</td>
<td>0</td>
<td>17</td>
<td>0</td>
<td>0</td>
<td>5</td>
<td>0</td>
</tr>
</tbody>
</table>

The first demand of 50 units will be satisfied as follows:
- Item A2 - ATP quantity is 50 on Day 12

The next demand of 80 units can be met in two ways:
Use substitute supplies from item A1 on Day 12 through Day 40, in which case the promise date is Day 40, or

Use existing supply of 10 units on Day 5 and try to produce 70 units prior to the request date of Day 35. Assume you have the capacity to produce by Day 35.

Considering these two options, Oracle Global Order Promising will recommend an ATP date of Day 35 with creation of fresh planned orders as follows:

- Planned order for 70 units of item A
- Supply of 10 units of item A on Day 5

Oracle Global Order Promising will suggest new supplies based on the profile setting if existing supplies for a demanded item or substitutes cannot meet the request on the request date.

**Substitution Using Supplies Past Request Date**

**Example 14**

This example uses the same baseline information from Example 13 with the following supply/demand. There is an ATP query for item A for 20 units on Day 10.

Use the following setup details:

- Substitution Window Width 10 days for all items
- Substitution between item A and A2 becomes effective starting on Day 15. All other substitution definitions are applicable for the entire horizon.
- Infinite Time Fence Date is Day 35

For this example, the profile option MSC: Choice of Item for Which To Create Supplies in Substitute Relationship is set to Demanded Item.

The following tables show you the supply/demand picture for items in the substitution chain.

**Item A**

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Item</th>
<th>Day 2</th>
<th>Day 5</th>
<th>Day 10</th>
<th>Day 15</th>
<th>Day 21</th>
<th>Day 30</th>
<th>Day 45</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand</td>
<td>A</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Supply</td>
<td>A</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>2</td>
</tr>
</tbody>
</table>
Item A1

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Item</th>
<th>Day 2</th>
<th>Day 5</th>
<th>Day 10</th>
<th>Day 12</th>
<th>Day 15</th>
<th>Day 21</th>
<th>Day 30</th>
<th>Day 45</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand</td>
<td>A1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Supply</td>
<td>A1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>15</td>
<td>5</td>
<td>5</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Item A2

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Item</th>
<th>Day 2</th>
<th>Day 5</th>
<th>Day 10</th>
<th>Day 12</th>
<th>Day 15</th>
<th>Day 21</th>
<th>Day 30</th>
<th>Day 45</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand</td>
<td>A2</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Supply</td>
<td>A2</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>20</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Demand on Day 10 for item A will use its own supply of 2 units on Day 5. At this point, you have exhausted all the supplies across the requested item and substitute items on or prior to the request date. The next step is to evaluate creation of fresh supplies (production) prior to the request date.

Supplies on Day 12 for item A2 are not valid because of substitution effective date. Oracle Global Order Promising will evaluate the substitution relationship effectivity on the ATP request date, and only substitution relationships valid as of the request date will be valid for the whole query. Oracle Global Order Promising will not evaluate the substitution effectivity on every day.

If the date effectivity of the substitute relationship between A and A2 were as follows: A --> A2, Effective from Day 2 to Day 10 and the relationship is not valid after Day 10; then the supply on Day 12 for A2 would be valid for the request of 20 units of Item A on D10.

If you are able to produce 4 units of item A by Day 10, which is the request date, you can satisfy 6 units out of 20 units by the request date.

Please note that when you evaluate production, Oracle Global Order Promising will evaluate the production based on the profile setting.

We still have a deficit of 14 units after using up existing supplies and possible production prior to the request date.
When you start searching for supplies and production capability in forward direction (after request date), you are trying to project the date by which you can have the entire requested quantity. In doing so, if you have supplies for the same item (native supplies), you can use them irrespective of where they may occur in the planning horizon. The only restriction is that they must be available prior to the infinite time fence date. The infinite time fence date that you specify determines the length of time that you use to evaluate the native supplies. Referring to Example 14, if you have 2 units of supplies on Day 45 for item A, the supply on Day 45 will not be used as possible supply. This is because you can produce whatever your customer needs on or after the infinite supply time fence; therefore you can present infinite time fence date as the ATP date.

The latest acceptable date determines the date prior to which the scheduling is going to be successful.

After the request date, Oracle Global Order Promising tries to either satisfy the entire deficit (14 units) by the request date either by using the scheduled receipts (explained in the Option1 section) or by creating fresh supplies (explained in the Option 2 section).

Option 1 (Using Scheduled Receipts)

Referring to Example 14, if you use scheduled receipts to fill the entire deficit, you can use 5 units of supply from item A prior to the infinite supply date, or you can use 20 units of scheduled receipts by Day 15 from item A1. If you use supplies only from item A, the request is not satisfied because you have only 11 units, i.e., 2 units of scheduled receipts prior to request date, 4 units of production prior to request date, and 5 units of scheduled receipts after the request date.

Item A2 is not a valid substitution since the substitution relationship A --> A2 was not valid on the request date. It becomes valid only on Day 15.

(Notice that you can use native supplies without any consideration of the substitution window. This is because the substitution window applies to only substitute items)

Given the above details, you can promise the order on Day 15 because you have the 20 units needed for the order for item A1.

Option 2 (Creating Fresh Supplies)

As was mentioned in Option 1, after the request date, Oracle Global Order Promising will evaluate the possibility of satisfying the entire deficit by the request date using either scheduled receipts or creating fresh supplies (in a forward direction). Assuming that you can create fresh supplies for 14 units of item A on
Day 25, Oracle Global Order Promising can establish Day 25 as the promise date with the following details:

- Prior to request date: 2 units of existing supplies (across requested and substitute items), 4 units of production
- 14 units production by Day 25

Considering both promise dates from Option1 and Option 2, Day 15 is better than Day 25. Therefore, Oracle Global Order Promising will provide a promise date of Day 15 with Option 1. If you are able to produce 14 units of supply on Day 12, the promise date will be Day 12 with Option 2.

Summary

Oracle Global Order Promising uses up all the on-hand and the scheduled receipts for requested item and its substitutes prior to the request date. Later, it tries to produce the deficit by the request date. If it is not successful in satisfying the request, it tries to project the availability date by two methods: use-up of scheduled receipts to make up the deficit or, producing the deficit quantity. Finally it provides the earliest date between the two methods.

Display of Possible Substitutes

As you enter an order and check availability using ATP Inquiry, you will see your order being satisfied by either requested item or substitute item. You will see the Original Item column, which populates the original item. Following is a screen shot of ATP work bench form showing the original item.
Example 15
If you request 100 units of item A, you will see the following details in the ATP workbench provided that Item B is substituted for Item A. This is shown in the following table.

<table>
<thead>
<tr>
<th>Item Org UOM Quantity</th>
<th>Quantity Available Qty. by Request Date</th>
<th>Original Item</th>
<th>Quantity Available by ATP Date</th>
<th>Original Item Request Date Qty.</th>
<th>Original Item ATP Date</th>
<th>Original Item ATP Date Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>B M1 Ea 100</td>
<td>Day 10 20</td>
<td>A</td>
<td>100</td>
<td>50</td>
<td>Day 20</td>
<td>75</td>
</tr>
</tbody>
</table>

The Quantity column in the table and in the form shows the amount of demand transferred to substitute item and the amount satisfied by the requested item. The Ship Date is the date on which Oracle Global Order Promising can promise the order.
Display of Detail for Requested Item

If Oracle Global Order Promising finds that substitute item is a valid option for a specific ATP query, the availability information (summary) for original item is also calculated. Referring to the table above, the column Original Item Request Date Quantity refers to the quantity of the original item available by request date. The column Original Item ATP Date provides you the date by which the entire request quantity can be provided using Original item. The column Original Item ATP Date Quantity provides you the quantity that is found on the Original Item ATP Date. The above calculation is enabled using a profile option. The calculations for the requested item are always provided if the ATP inquiry is initiated from Oracle APS. Original item calculations are provided on demand if the ATP inquiry is initiated from Oracle Order Management.

If you inquire for items that are in different ship sets or in the same ship sets, you will see the records that belong to a ship set presented together on the work bench.

ATP Pegging Details

If you find substitute supplies, Oracle Global Order Promising transfers the demand from requested item to the substitute item. ATP pegging will show supply and demand pegging for the substitute item.

Creation of Planned Supplies

As described in Preference for Generating Planned Orders on page 18-17, the item attribute Create Supply Flag and the profile option Choice of Item for Which to Create Supplies in Substitute Relationship determine the item for which Oracle Global Order Promising creates planned supplies. Oracle Global Order Promising looks at this item attribute and profile option before performing a Capable to Promise Check. Depending on the type of businesses using this feature, there may be different values for the profile option and item attributes. Please refer to Resolving Conflict Between Item Attributes and Profile Options on page 18-19 for details on how to resolve the conflicts if conflicting set up is defined by the user.

Example 16:

Consider the following example to illustrate creation of planned supplies.

There are four items in the substitution chain, items: A1, A2, A3, and A4. The highest level item in this pool is A4. You get a demand for A2 (referred to requested item), and the profile option Choice of item for which to create supplies in substitute relationship is set to Requested item. You can evaluate supply availability for A2, A3, and A4 assuming chaining and direction is A1 --> A2 --> A3 --> A4. If
you do not find any supply for the requested item, you can generate supply for requested item, which is A2.

If the item you are trying to produce happens to be a coproduct, Oracle Global Order Promising will create supplies for all items in coproduct relationships.

If your item is not an item in coproduct relationship, it may be possible to produce a substitute item instead of the demanded item, but please note that Oracle Global Order Promising will create supplies for only one item. The exception to this rule is when a requested item is involved in a coproduct relationship.

If the profile option Choice of Item for Which to Create Supplies in Substitute Relationship is set to Follow Item Attribute, and the requested item’s Create Supply flag is set to No in the Master Item form, Oracle Global Order Promising generates supplies for the next higher item in the substitution chain.

The following table summarizes all the important information for this example.

<table>
<thead>
<tr>
<th>Chaining and Direction</th>
<th>Highest Level Item</th>
<th>Requested Item</th>
<th>Profile Option: Choice of item for which to create supplies in substitute rel.</th>
<th>Create Supply Flag</th>
<th>Coproduct? Action</th>
<th>Generate Supply</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1 --&gt; A2 --&gt; A3 --&gt; A4</td>
<td>A4</td>
<td>A2</td>
<td>Demanded Item</td>
<td>yes</td>
<td>no</td>
<td>evaluate supply availability for A2, A3, and A4 generate supply for requested item</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>generate planned order for requested item and coproduct supplies for the rest of the items in the coproduct relationship</td>
</tr>
<tr>
<td>A1 --&gt; A2 --&gt; A3 --&gt; A4</td>
<td>A4</td>
<td>A2</td>
<td>Demanded Item</td>
<td>yes</td>
<td>yes</td>
<td>evaluate supply availability for A2, A3, and A4 generate supply for requested item</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>generate planned order for requested item and coproduct supplies for the rest of the items in the coproduct relationship</td>
</tr>
<tr>
<td>A1 --&gt; A2 --&gt; A3 --&gt; A4</td>
<td>A4</td>
<td>A2</td>
<td>Follow item attribute</td>
<td>yes</td>
<td>no</td>
<td>evaluate supply availability for A2, A3, and A4 generate supply for requested item</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>create supply for A2; if capacity is not found, evaluate generation of supplies for items A3 and A4, but the supplies are still created for one item</td>
</tr>
</tbody>
</table>
Searching Supply Chain for Substitutes

The order promising logic used to evaluate existing supplies follows a slightly different logic than the breadth-first logic explained previously. Order Global Order Promising will first evaluate the existing supply by request date for the requested item across the supply chain using breadth-first logic. If there is enough supply for the requested item, Oracle Global Order Promising will evaluate existing supply for substitute items one by one across the supply chain using breadth-first logic. It will stop once it finds supply for any substitute item.

If Oracle Global Order Promising needs to suggest supply, it will create supply using existing capable-to-promise logic.

Oracle Global Order Promising uses a plan-level option selection to determine if breadth-first logic needs to be applied. The plan level option is the End Item Substitution check box in the Decision Rules tab on the Plan Options window. If you select this check box, you will get the breadth-first logic for items that have end-item substitutions defined.

Example 17

The diagram below illustrates the breadth-first search concept. Items A and B are two substitute items and they are enabled in different organizations. The search for existing supply of a substitute proceeds breadth first, i.e., Oracle Global Order Promising searches for items A and B in Org1, Org2, Org3, Org4, and Org5. If you have set up your substitution, ATP searches for each item individually. If Org 3 is set to Rank 1 and Org2 to Rank 2 (not shown in the diagram), ATP follows this path: Org1, Org3, Org2, Org4, and Org5 while evaluating existing on-hand and scheduled receipts (both native and substitute supplies) across the supply chain.
In Example 17, it is assumed that both items A and B have the same sourcing rule. If substitution needs to happen in all organizations and all organizations can swap materials freely, you can expect that substitute items are enabled in all relevant organizations and sourcing rules exist for all substitute items to ship materials to all relevant organizations. If you do not establish sourcing rules, the substitution logic does not make any assumptions about sourcing rules.

**Evaluating Supplies After Request Date**

One of the purposes behind substituting is to use up all the possible supplies before creating fresh supplies. This applies to both native supplies and substitute supplies.

**Single Org Examples**

In the following examples, you are dealing with a single organization and two items, A and B, which are substitutable in one direction A --> B. The substitute window for both items across the supply chain is set to 15 days.
Example A
For Example A, the supply situation is shown in the following table:

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Item</th>
<th>Day 2</th>
<th>Day 5</th>
<th>Day 10</th>
<th>Day 12</th>
<th>Day 15</th>
<th>Day 20</th>
<th>Day 25</th>
<th>Day 45</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supply A</td>
<td>5</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Supply B</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>8</td>
<td>5</td>
<td>3</td>
<td>10</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

There is an inquiry for 10 units of item A on Day 12, and the infinite time fence date is set to Day 45. The first step is to find out the availability by the request date either by requested item or the substitute item. By request date, you have 7 units of item A and 10 units of item B. Therefore, item B is suggested as a substitute because it can fulfill the entire quantity using just one item’s supply. You will not be able to look at the ATP details and pegging for item A in this example, but you have access to summary-level information for item A. You will have full access to the ATP details and pegging for item B.

Example B
For Example B, the supply situation is shown in the following table:

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Item</th>
<th>Day 2</th>
<th>Day 5</th>
<th>Day 10</th>
<th>Day 12</th>
<th>Day 15</th>
<th>Day 20</th>
<th>Day 25</th>
<th>Day 45</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supply A</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Supply B</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>8</td>
<td>5</td>
<td>3</td>
<td>10</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

In this example, there is also an inquiry for 10 units of item A on Day 12. The first step will be to evaluate the supplies prior to request date. You have 3 units of item A and 8 units of item B. You have to evaluate the possible production prior to the request date. If you can produce 7 units of item A by Day 12 and 2 units of item B by Day 12, both items A and B will have a total supply of 10 units by Day 12. Given this scenario, Oracle Global Order Promising will promise the order on Day 12 using item A; i.e., if you have a choice between the original item and a substitute item, Oracle Global Order Promising will promise with the original item.

Example C
You now have 10 units of existing supply for item B, 5 units of supply for item A and you can produce 5 units of item A by the request date. Oracle Global Order
Promising will recommend item B because it uses up the existing supplies rather than producing item A.

**Example D**

For this example, the profile option MSC: Choice of Item for which to Create Supplies in Substitute Relationship is set to Follow Item Attributes, and the assumption is that supplies can be created for both items.

The supply situation is shown in the following table:

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Item</th>
<th>Day 2</th>
<th>Day 5</th>
<th>Day 10</th>
<th>Day 12</th>
<th>Day 15</th>
<th>Day 20</th>
<th>Day 25</th>
<th>Day 45</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supply</td>
<td>A</td>
<td>5</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>Supply</td>
<td>B</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>5</td>
<td>3</td>
<td>10</td>
<td>0</td>
</tr>
</tbody>
</table>

You have 7 units of item A by request date and 2 units of item B by the request date. Assume you do not have the capacity to produce either item A or B by request date. The availability and production of both A and B must be evaluated in the forward direction. Evaluating scheduled receipts, you can satisfy the requested quantity by using item B by Day 20. If you use the production route, assume you will not get the deficit produced until Day 40. The request here will be satisfied by item B by Day 20.

**Supply Chain Case**

The following diagram shows the supply chain for item A and B.
For this example, the profile option MSC: Choice of Item for which to Create Supplies in Substitute Relationship is set to Follow Item Attributes, and the assumption is that supplies can be created for both items.

Consider the following supply picture as shown in the following tables. The substitution window is set to 15 days for both items A and B. Assume that the lead time to transfer items across all organizations is zero. The request date is Day 10 and the request quantity is 100 units. The infinite time fence date set to Day 26.
Org 1

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Item</th>
<th>Day 2</th>
<th>Day 5</th>
<th>Day 10</th>
<th>Day 12</th>
<th>Day 15</th>
<th>Day 20</th>
<th>Day 25</th>
<th>Day 45</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supply</td>
<td>A</td>
<td>5</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>Supply</td>
<td>B</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>5</td>
<td>0</td>
<td>10</td>
<td>0</td>
</tr>
</tbody>
</table>

Org 2

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Item</th>
<th>Day 2</th>
<th>Day 5</th>
<th>Day 10</th>
<th>Day 12</th>
<th>Day 15</th>
<th>Day 20</th>
<th>Day 25</th>
<th>Day 45</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supply</td>
<td>A</td>
<td>10</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>16</td>
<td>0</td>
</tr>
<tr>
<td>Supply</td>
<td>B</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>15</td>
<td>0</td>
<td>20</td>
</tr>
</tbody>
</table>

Org 3

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Item</th>
<th>Day 2</th>
<th>Day 5</th>
<th>Day 10</th>
<th>Day 12</th>
<th>Day 15</th>
<th>Day 20</th>
<th>Day 25</th>
<th>Day 45</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supply</td>
<td>A</td>
<td>0</td>
<td>5</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>48</td>
<td>5</td>
<td>0</td>
</tr>
<tr>
<td>Supply</td>
<td>B</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>38</td>
<td>0</td>
<td>10</td>
<td>10</td>
</tr>
</tbody>
</table>

Org 5

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Item</th>
<th>Day 2</th>
<th>Day 5</th>
<th>Day 10</th>
<th>Day 12</th>
<th>Day 15</th>
<th>Day 20</th>
<th>Day 25</th>
<th>Day 45</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supply</td>
<td>A</td>
<td>0</td>
<td>10</td>
<td>5</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>63</td>
<td>5</td>
</tr>
<tr>
<td>Supply</td>
<td>B</td>
<td>0</td>
<td>55</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>23</td>
<td>5</td>
<td>0</td>
</tr>
</tbody>
</table>

Oracle Global Order Promising evaluates the supplies for items A and B individually by using up all the on-hand and scheduled receipts for a requested item and its substitutes prior to the request date. Later, it tries to produce the deficit by the request date. If it is not successful in satisfying the request, it will try to project the availability date by two methods: use-up of scheduled receipts to make up the deficit or, producing the deficit quantity. Finally it provides the earliest date between the two methods.
More details of the evaluation procedure are described below.

**Evaluating Item A Supply**
- There are 35 units of item A by request date.
- Assume you do not have the capacity to produce Item A by the request date

Production in the supply chain case refers to the distinct production paths in the supply chain. In this example, the production paths are Org1 --> Org2 --> Org5, Org1 --> Org3, and Org2 --> Org5, and Org1 itself. In addition to distinct production paths, you can also produce the items in Orgs 1, 3, and 5 independently.

- Scheduled receipts in each organization and production capability after the request date will be evaluated using the path below each organization:
  - Scheduled receipts in Org 5 and Production in Org 5:
    - Scheduled receipts are 65 on Day 25
    - Production – assume you have the capacity to produce 65 units in forward direction by Day 21.
  - Scheduled receipts in Org2 and transfer from Org5:
    - Scheduled receipts are only 18 by Day 25. Infinite supply is on Day 26.
    - Transfer from Org5 – you have the capacity to provide 65 units by Day 21
  - Scheduled receipts in Org3 and Production in Org 3:
    - Scheduled receipts are 53 by Day 25. Infinite supply is on Day 26.
    - Production – assume you have the capacity to produce 65 units in forward direction by Day 15
  - Scheduled receipts in Org1, transfer from Org2, transfer from Org3, and production in Org1:
    - Scheduled receipts are 12 by Day 25. Infinite supply is on Day 26.
    - Transfer from Org2 - you have the capacity to provide 65 units by Day 21
    - Transfer from Org3 - you have the capacity to provide 65 by Day 15
    - Production in Org1 - assume you have the capacity to produce 65 units in forward direction by Day 16
Evaluating Item B Supply

- There are 57 units of item B by request date
- Assume you do not have the capacity to produce Item B by the request date
- Scheduled receipts in each organization and production capability after the request date will be evaluated using the path below each organization:
  - Scheduled receipts in Org 5 and Production in Org 5:
    - Scheduled receipts are 28 by Day 25. Infinite supply is on Day 26.
    - Production – assume you have the capacity to produce 43 units in forward direction by Day 21.
  - Scheduled receipts in Org 2 and transfer from Org 5:
    - Scheduled receipts are 15 by Day 25. Infinite supply is on Day 26.
    - Transfer from Org 5 – assume you have the capacity to produce 43 units in forward direction by Day 21
  - Scheduled receipts in Org 3 and Production in Org 3:
    - Scheduled receipts are 48 by Day 25. Infinite supply is on Day 26.
    - Production – assume you have the capacity to produce 43 units in forward direction by Day 17
  - Scheduled receipts in Org 1 and transfer from Org 2, transfer from Org 3, and production in Org 1:
    - Scheduled receipts are 15 by Day 25. Infinite supply is on Day 26.
    - Transfer from Org 2 – you have the capacity to provide 43 units by Day 21
    - Transfer from Org 3 – you have the capacity to provide 43 units by Day 17.
    - Production – assume you have the capacity to produce 43 units in forward direction by Day 17

Based on the above calculations, you can meet the requirement either by using item A on Day 15, or item B on Day 17. Therefore, Oracle Global Order Promising will suggest Item A on Day 15, with the following details:

- 35 units of scheduled receipts of item A by the request date
- 65 units of production of item A in Org 3
Resolving Ties in the Substitution Chain

Oracle Global Order Promising provides only one item as an outcome of your query. This may lead to a situation where you may have a tie between requested item and a substitute item, if, for example, both requested and substitute items are available on the same day. In such a case, Oracle Global Order Promising will promise the order with the requested item.

In this example, items A, B, and C are three substitute items. You get a demand for 10 units of item A, and you find the supplies for both items A and B for 10 units on Day 3. Oracle Global Order Promising will suggest item A as the requested item.

If there are multiple ties and the requested item is not in the tie, Oracle Global Order Promising will suggest the nearest item in the substitution chain. If you do not have any supply for A but you can find supplies for both item B and C on the same day, Oracle Global Order Promising will suggest item B.

**Note:** When you create fresh supplies in Oracle Global Order Promising after request date, the existing scheduled receipts are not added to the availability picture. This means you do not get a consolidated picture of existing supplies and planned supplies as Oracle Global Order Promising evaluates ATP dates in the future direction (after request date). When the scenario is to create fresh supplies, you get a date based on satisfying the entire deficit by creating new supplies.

Substitution in Allocated ATP

Oracle Global Order Promising supports allocation of materials to various segments of your demands. You can define allocation rules that determine the percentage of supplies that are allocated to certain segment of demand, or you can allocate the supply based on demand priority. You can assign these allocation rules at various levels to material supplies and Oracle Global Order Promising will honor these preallocations. This provides you with control over how your supplies are consumed by various segments of your demand. Demands from segments that have higher priority can steal supply from lower segments. The following sections explain how product substitution works with allocated ATP.

Stealing Prior to Substitution

This section contains an example of how allocated ATP will work if stealing is done ahead of substitution. This is an example in which demand priority allocation is
used. In this example, you have two items: A and A1 that are substitutable. You have three demand segments called tiers: T1, T2, and T3. The substitution window is 2 days.

For this example, the profile option MSC: Choice of Item for Which to Create Supplies in Substitute Relationship is set to Follow Item Attributes, and the assumption is that supplies can be created for both items.

Assume that you have received demand for 8 units of item A at tier T1 in Day 1. Oracle Global Order Promising will steal 5 units from tier T2 and 3 units from tier T3 to satisfy the order. Please note that it does not use the substitute available at tier T1. You then receive demand for 20 units at tier T1 on Day 3 for item A1 after satisfying the first request for 8 units.

More details of the evaluation procedure are described below.

**Item A:**
1. There are 3 units of supply across all tiers.
2. Assume that you don’t have any capacity to produce item A prior to request date.
3. The deficit is 17 units.
4. As shown in the table above, you have 17 units of supply across all tiers by Day 4. Please note that forward stealing is only available when demand priority allocation is used.
5. Assume that you have the capacity to product 17 units by Day 7.
6. You can promise the order for Item A by Day 4.

**Item A1:**
1. There are 13 units of supply by request date.
2. Assume that you don’t have any capacity to produce item A1 by the request date.

3. The deficit is 7 units.

4. As shown in the table above, you have no eligible existing supplies for A1 after the request date.

5. Assume you can produce 7 units by Day 7.

Given the analysis above, Oracle Global Order Promising will promise the order by Day 4 using item A.

Oracle Global Order Promising supports stealing prior to substitution logic. Therefore, the general process is:

- Consume your own tier
- Steal from other tiers based on priority
- Evaluate Substitution

Allocated ATP In a Supply Chain

Consider the five organization supply chain set up described in Example 17. The change in the set up is that the substitution window is 2 days instead of 15 days. In the supply/demand picture in each organization shown in the following tables, you get a request for 50 units of item A, tier T1 at Day 3. The infinite time fence date is set to Day 26, and assume there is no intransit lead time.

For this example, the profile option MSC: Choice of Item for which to Create Supplies in Substitute Relationship is set to Follow Item Attributes, and the assumption is that supplies can be created for both items.

This is an example in which demand priority allocation is used.

<table>
<thead>
<tr>
<th>Tier</th>
<th>Day 1 - Item A</th>
<th>Day 1 - Item B</th>
<th>Day 2 - Item A</th>
<th>Day 2 - Item B</th>
<th>Day 3 - Item A</th>
<th>Day 3 - Item B</th>
<th>Day 4 - Item A</th>
<th>Day 4 - Item B</th>
<th>Day 5 - Item A</th>
<th>Day 5 - Item B</th>
</tr>
</thead>
<tbody>
<tr>
<td>T1</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>5</td>
<td>10</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>T2</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>1</td>
<td>0</td>
<td>4</td>
<td>2</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>T3</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>6</td>
<td>0</td>
<td>0</td>
<td>5</td>
<td></td>
</tr>
</tbody>
</table>

Business Topics 18-63
Org 2

<table>
<thead>
<tr>
<th>Tier</th>
<th>T1</th>
<th>T2</th>
<th>T3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day 1 - Item A</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Day 1 - Item B</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Day 2 - Item A</td>
<td>4</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Day 2 - Item B</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Day 3 - Item A</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>Day 3 - Item B</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Day 4 - Item A</td>
<td>2</td>
<td>4</td>
<td>6</td>
</tr>
<tr>
<td>Day 4 - Item B</td>
<td>15</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>Day 5 - Item A</td>
<td>24</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Day 5 - Item B</td>
<td>3</td>
<td>0</td>
<td>5</td>
</tr>
</tbody>
</table>

Org 3

<table>
<thead>
<tr>
<th>Tier</th>
<th>T1</th>
<th>T2</th>
<th>T3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day 1 - Item A</td>
<td>0</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>Day 1 - Item B</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Day 2 - Item A</td>
<td>0</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>Day 2 - Item B</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Day 3 - Item A</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Day 3 - Item B</td>
<td>14</td>
<td>0</td>
<td>6</td>
</tr>
<tr>
<td>Day 4 - Item A</td>
<td>2</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>Day 4 - Item B</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Day 5 - Item A</td>
<td>40</td>
<td>0</td>
<td>5</td>
</tr>
<tr>
<td>Day 5 - Item B</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Org 5

<table>
<thead>
<tr>
<th>Tier</th>
<th>T1</th>
<th>T2</th>
<th>T3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day 1 - Item A</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>Day 1 - Item B</td>
<td>0</td>
<td>2</td>
<td>6</td>
</tr>
<tr>
<td>Day 2 - Item A</td>
<td>0</td>
<td>0</td>
<td>5</td>
</tr>
<tr>
<td>Day 2 - Item B</td>
<td>0</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>Day 3 - Item A</td>
<td>0</td>
<td>1</td>
<td>6</td>
</tr>
<tr>
<td>Day 3 - Item B</td>
<td>0</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>Day 4 - Item A</td>
<td>5</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>Day 4 - Item B</td>
<td>2</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Day 5 - Item A</td>
<td>10</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Day 5 - Item B</td>
<td>10</td>
<td>0</td>
<td>5</td>
</tr>
</tbody>
</table>

Evaluating Item A Supply
- By request date there are 29 units of Item A across all tiers.
- Assume that you do not have the capacity to produce Item A by the request date.

Production in the supply chain case refers to the distinct production paths in the supply chain. In this example, the production paths are Org1 --> Org2 --> Org5, Org1 --> Org3, and Org2 --> Org5. In addition to distinct production paths, you can also produce the items in Orgs 1, 3, and 5 independently.
Scheduled receipts in each organization and production will be evaluated using the path below each organization:

- Scheduled receipts in Org 5 and Production in Org 5:
  - Scheduled receipts are 22 by Day 5
  - Production – assume you have the capacity to produce 21 units in forward direction by Day 12.

- Scheduled receipts in Org2 and transfer from Org5:
  - Scheduled receipts are 36 by Day 5
  - Production – assume you have the capacity to produce 21 units in forward direction by Day 8

- Scheduled receipts in Org3 and Production in Org 3:
  - Scheduled receipts are 60 by Day 5
  - Production – assume you have the capacity to produce 21 units in forward direction by Day 12

- Scheduled receipts in Org1 and transfer from Org 2, transfer from Org3, and production in Org1:
  - Scheduled receipts are 22 by Day 5
  - Transfer from Org2 – you have the capacity to produce 21 units by Day 5
  - Transfer from Org3 – you have the capacity to produce 21 units by Day 5.
  - Production in Org1– assume you have the capacity to produce 21 units in forward direction by Day 11

**Evaluating Item B Supply**

- By request date we have 30 units of Item B across all tiers. The assumption is that you cannot produce any item B by the request date

- Oracle Global Order Promising will evaluate scheduled receipts in each organization and production using the path below each organization:

  - Scheduled receipts in Org 5 and Production in Org 5:
    - Scheduled receipts are 22 by Day 5
End Item Substitution and Oracle Global Order Promising

- Production – assume you have the capacity to produce 20 units in forward direction by Day 12.

Scheduled receipts in Org2 and production in path Org2-->Org5:
- Scheduled receipts are 25 by Day 5
- Production – assume you have the capacity to produce 20 units in forward direction by Day 8

Scheduled receipts in Org3 and Production in Org 3:
- Scheduled receipts are 7 by Day 5. Infinite supply is on Day 26.
- Production – assume you have the capacity to produce 20 units in forward direction by Day 12

Scheduled receipts in Org1, transfer from Org2, transfer from Org3, and production in Org1:
- Scheduled receipts are 22 by Day 5
- Transfer from Org2 – you have the capacity to provide 20 units by Day 5
- Transfer from Org3 - you have the capacity to provide 20 units by Day 12.
- Production in Org1 - assume you can produce 20 units in a forward direction by Day 9.

Based on the above calculations, you can meet the requirement either by using item A on Day 5, or item B on Day 5. Therefore, Oracle Global Order Promise will suggest item A on Day 5, with the following details:

- 29 units of scheduled receipts of item A by the request date across all tiers
- 21 units of scheduled receipts of item A by Day 5.

End Item Substitution Workflow for Oracle Global Order Promising
If the decision is to substitute, a workflow will be initiated. The following is a diagram depicting this workflow. The title for the workflow that is generated is Demand Satisfied Using End Item Substitution. This workflow will be initiated upon scheduling of sales orders in Oracle Order Management.
The following details are shown in the workflow:

- From item - The item for which you received the demand, the exception is for this item.
- Order number - Sales Order Number
- Line Number – Sales Order Line Number
- Original Quantity – The requested quantity
- Substitute item/s - Substitute item, this is the item to which the demand was transferred. These could be multiple items.
- Organization – Organization at which the exceptions happened.
- Substituted Quantity - The demand transferred quantity.
Substitute supply Organization - The organization at which you found the supply.
User-Defined Alternate Decision Rules

This section discusses the following topics:

- User defined alternate decision rules for constrained plans
- User-defined alternate decision rules for optimized plans
- Planning search logic

User-Defined Alternate Decision Rules for Constrained Plans

This feature allows you to automatically select alternate routings, resources, bills of material, items, and sources.

It does this by providing decision rules giving you the ability to do the following:

- Intelligently select alternatives with the minimum data input prerequisites possible. You can run a supply chain plan that automatically selects alternate routings, BOM, resources, suppliers, internal sources, end-items and components with the minimum amount of input.

- Enforce a specified sequence of decision-making actions (which may mimic a planner’s problem resolution thought process.) The sequence in which the planning engine looks for supply using standard Oracle Application functions is transparent to the user. (For example you may specify substitutes for a given component but not alternate sources.). You can specify a global decision rule when more than one supply source can satisfy the demand. (For example if you have specified both substitutes and alternate sources, you can choose one over the other.)

- Make easier APS planning decisions because the decision-making process is more transparent. You can select alternates when the primary source of supply is unable to satisfy the demand. In doing so, you can express your preference as business rules, such as: the alternate resource should be used before looking for alternate supply and substitute components.

- Restrict planning to a universe of authorized decision-making actions (for example, permit exploration of alternate routings and substitute items but not of sourcing or permit substitute components but do not permit end item substitution, even though rules are specified for the given items at the source level.)
User Procedures

Constrained Plans and Alternate Rules - Two Methods  Please note that there are two different methods of constrained planning and the method to be used is determined by the site profile option MSO: Enable Decision Rules. If MSO: Enable Decision Rules is set to No (this is the default), you cannot use any alternate rule except for alternate resources, and to some extent, alternate suppliers. If MSO: Enable Decision Rules is set to Yes, you can select and define alternate rules. The rules are used by the planning engine according to the order in which they appear in the Decision Rules tab of the Plan Options window. For additional details, please refer to Constraint-Based Planning on page 11-1.

The following steps and diagrams outlines the procedures used to select alternates for a constrained plan. The steps provide a more in-depth explanation for the procedures shown in the diagrams.

To select alternates using a constrained plan:
1.  Perform your source data setups.
2.  Define or open the Plan Options window.
3. Set up the desired plan options using all the appropriate tabs from this window.

4. If you have set the profile option MSO: Enable Decision Rules to No, none of the following steps apply. Go to step 7.

5. If you have set the profile option to Yes, you can select the Decision Rules tab if you want to change the default settings, which are shown in the following table:

<table>
<thead>
<tr>
<th>Decision Rule</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use End Item Substitution</td>
<td>unchecked</td>
</tr>
<tr>
<td>Use Alternate Resources</td>
<td>checked</td>
</tr>
<tr>
<td>Use Substitute Components</td>
<td>checked</td>
</tr>
<tr>
<td>Use Alternate BOM/Routing</td>
<td>checked</td>
</tr>
<tr>
<td>Use Alternate Sources</td>
<td>checked</td>
</tr>
</tbody>
</table>
6. Enable or disable decision rules.

You can enable and disable the decision rules for constrained plans. These decision rules are used to derive the constrained plan, while honoring your preferences. If any of the rules are disabled, then the planning engine will not have the ability to look for supply pertaining to these rules.

The meanings of the decision rules are shown in the following table:

<table>
<thead>
<tr>
<th>Decision Rule</th>
<th>Status</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use alternate sources</td>
<td>checked</td>
<td>Use primary sources as far as possible and use alternate sources only if necessary.</td>
</tr>
<tr>
<td>Use alternate sources</td>
<td>unchecked</td>
<td>Use primary sources only. Alternate sources (sources of rank 2 or higher) will not be used as a source of supply.</td>
</tr>
<tr>
<td>Use alternate BOM/routings</td>
<td>checked</td>
<td>Use primary routing as far as possible and use alternate only if necessary.</td>
</tr>
<tr>
<td>Use alternate BOM/routings</td>
<td>unchecked</td>
<td>Use only primary BOM/Routing</td>
</tr>
<tr>
<td>Use alternate resources</td>
<td>checked</td>
<td>Use primary resource as far as possible and use alternate resource only if necessary.</td>
</tr>
<tr>
<td>Use alternate resources</td>
<td>unchecked</td>
<td>Use only primary resources</td>
</tr>
<tr>
<td>Use end item substitutions</td>
<td>checked</td>
<td>Use primary item and end item substitute, when enabled, prior to creating new planned orders.</td>
</tr>
<tr>
<td>Use end item substitutions</td>
<td>unchecked</td>
<td>Use only the demanded item. Do not use the end item substitute.</td>
</tr>
<tr>
<td>Use substitute components</td>
<td>checked</td>
<td>Use primary items as far as possible and use substitute component only if necessary.</td>
</tr>
<tr>
<td>Use substitute components</td>
<td>unchecked</td>
<td>Use primary items/components only.</td>
</tr>
</tbody>
</table>

7. Launch the constrained plan.

The following diagram is an illustration of these steps.
Features
The major features include:

- Data setup for decision rules
- Site level profile option, MSO: Enable Decision Rules
- Constrained plans based on user-enabled decision rules
Support for current APS engine’s logic and behavior for constrained plans.

Profile Option, MSO: Enable Decision Rules The site level profile option MSO: Enable Decision Rules enables or disables the Decision Rules tab in the Plan Options window. If this profile option is set to Yes, the Decision Rules tab is enabled and the decision rules you set using this tab are used; if it is set to No, the Decision Rules tab is disabled and the APS engine uses the current engine logic for planning.

The default display status of the Decision Rules tab depends on the status of the tab in the plan’s previous run. If in the previous run, this profile option was set to No, then the Decision Rules tab displays the default status (all decision rules checked) of the Decision Rules tab. If in the previous run, the profile option was set to Yes, then the Decision Rules tab displays the status of the tab as it was in the last plan run.

Decision Rules Implementation for Constrained Plans The main objective of the constrained plan is to meet demand in time. There are two options in the constraint planning mode: Enforce Demand Due Dates and Enforce Capacity. You can choose these in the Constraints tab of the Plan Options window. These are used to describe the objective of the constraint plan.

You can define the various constraints (material or resources or both) using the Constraints tab in the Plan Options window.

To invoke this option of using the decision rules for constrained plan, you set the site profile option MSO: Enable Decision Rules to Yes. The default for this profile is No. When this profile option is set to No, constrained plans will be based on the current constrained planning engine.

Criteria for Selection of Alternates It is possible to have multiple alternates for sourcing, substitute components, resources and BOM/Routing. This section deals with the use of source data setup for selection of alternates.

Alternate Sources: You can define the priority of the sources in the sourcing rule. By default, the planning engine tries to minimize the use of alternate sources. But if it necessary to use the alternate sources, then the planning engine uses the rank that you have assigned to the source for selecting the alternates. An example of such a situation is if you would like to use and exhaust the supply from the sources with a higher rank before you select one with lower rank. When there is more than one source set at the same rank, planning searches for supply in the following order:

1. Make
2. Transfer
3. Buy

If you have specified more than one source of supply of the same type, planning uses the supply at its discretion. (For example you have two make sources and both are at priority 1).

The above search assumes that you have not enforced sourcing splits. The following screens depict where you can define ranks for Alternate Sources. The first screen shows rank using Sourcing Rules. For additional information about the following two screens, please refer to the Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User Guide.

Figure 18–11 Sourcing Rule

The second screen shot shows rank using Bill of Distribution.
User-Defined Alternate Decision Rules

**Figure 18–12 Bill of Distribution**

![Bill of Distribution](image)

**Substitute component:** You can define the priority of the substitute component. By default, planning tries to minimize the use of substitutes. Also, the planning engine has an inbuilt logic that tries to use substitutes at a lower level in your BOM than close to product completion in the BOM. Planning will honor the priority that you have defined while searching for supply from the various substitutes.

The following screen shot depicts where you can define priorities for Substitute Components.
For additional information on this and other screen shots in this section, please refer to the Oracle Bills of Material User’s Guide.

The diagram below indicates the planning logic for a component B with B1 as the substitute component. As shown in the diagram, Planning will look for projected available supply of item B (on hand and existing supplies) and then projected available supply for item B1. After that, Planning will recommend creating a planned order for item B using primary BOM/Routing and alternate resources. Planning will then generate planned orders for item B1 using primary BOM/Routing and alternate resources. If additional supply is needed, Planning will use the alternate BOM/Routing for item B and then for item B1 before looking to source items B and B1 from an alternate source/facility.
Alternate Resources: By default, the planning engine tries to minimize the use of alternate resources. But if it has to use the alternates, it uses the priority you have assigned to the alternate resource while using the capacity from this resource to build supply. If more than one resource is specified at the same rank, then the planning search is at its discretion for constrained plans.

The following screen shot depicts where you can define priorities for Alternate Resources.
The rank that you specify for Replacement Group in the Operation Alternate Resources screen is the priority of the alternate resources.

**Alternate BOM/Routing:** Planning uses the combination of Bill of Material definition and the routing of a particular item to define the process. The intersection of BOM and Routing is based on the definition of the alternate designator. Bill of Material and Routings intersect to create a valid process only when the alternate designator matches.

By default, the planning process tries to minimize the use of lower priority BOM/Routing. You can specify the priority in the Routing Details form.

**Note:** In the Routing Details form, priorities for routings are unique, so you cannot assign the same priority to two different routings for a different item. However, internally you may get the same priority for two different routings. How this happens is explained in the next section.

The following screen shot depicts where you can define priorities for Alternate BOM/Routing.
User-Defined Alternate Decision Rules

Figure 18–15  Routing Details

**Default BOM/Routing Priority**  If you do not specify any priority for the BOM/Routing in the Routing Details form, the following rule will apply for calculating the default priority:

- If the alternate designator is NULL, then default priority will be internally assumed to be 1
- If you specify an alternate designator for the BOM/Routing, then the default priority will be internally assumed to be 2

**User-Specified BOM/Routing Priority**  You have the ability to specify any priority to a particular BOM/Routing. Planning uses the priority to load the particular BOM/Routing for supply derivation. The ability to specify any priority to any BOM/Routing gives you the flexibility to assign a higher priority to an alternate BOM/Routing.

For example, you can designate a BOM/Routing whose alternate designator is NULL to 2 and specify a priority of 1 to BOM/Routing that has a valid alternate designator of ALT_ROUTE_2. Planning will honor the priority and suggest BOM/Routing as defined by alternate designator ALT_ROUTE_2 before using the BOM/Routing with the alternate designator as Null.

Note: When there is more than one alternate of the same rank, then planning will use the supply at its discretion. For example for a given item A:

- BOM/Routing1: alternate designator = NULL, priority = 1
User-Defined Alternate Decision Rules

- BOM/Routing2: alternate designator = ALT_ROUTE_2, priority = 1
- BOM/Routing3: alternate designator = ALT_ROUTE_3, priority = 2

In this case, the planning engine will try to use either Routing1 or Routing2 first. Then, if necessary, it will try to use Routing2 or Routing1. Then, if necessary, it will move on to Routing3.

Note: For information on End-Item Substitutions, please refer to End-Item-Level Substitution on page 18-2.

Examples of How Alternate Decision Rules are Used

This section contains three scenarios that describe how alternate decision rules are used.

The following tables provide background information for the three scenarios.

Day 0 Demand Information

<table>
<thead>
<tr>
<th>Product</th>
<th>Demand</th>
<th>Due Date</th>
<th>Capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>60 units</td>
<td>1</td>
<td>100 units/day</td>
</tr>
<tr>
<td>A</td>
<td>120 units</td>
<td>2</td>
<td>100 units/day</td>
</tr>
<tr>
<td>A</td>
<td>80 units</td>
<td>3</td>
<td>100 units/day</td>
</tr>
</tbody>
</table>

Bill of Material for Item A

<table>
<thead>
<tr>
<th>Component (Make/Buy)</th>
<th>Op sequence</th>
<th>Quantity</th>
<th>Substitute</th>
</tr>
</thead>
<tbody>
<tr>
<td>B (Make)</td>
<td>10</td>
<td>1</td>
<td>D (Make)</td>
</tr>
<tr>
<td>C (Buy)</td>
<td>20</td>
<td>2</td>
<td>E (Make)</td>
</tr>
</tbody>
</table>

Routing for Item A

<table>
<thead>
<tr>
<th>OP Sequence</th>
<th>Operation</th>
<th>Resource</th>
<th>Alternate</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Milling</td>
<td>M10</td>
<td>M20</td>
</tr>
<tr>
<td>20</td>
<td>Grinding</td>
<td>G10</td>
<td>G20</td>
</tr>
</tbody>
</table>
Capacity information:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>M10</td>
<td>60 units/day</td>
</tr>
<tr>
<td>M20</td>
<td>60 units/day</td>
</tr>
<tr>
<td>G10</td>
<td>100 units/day</td>
</tr>
<tr>
<td>G20</td>
<td>100 units/day</td>
</tr>
</tbody>
</table>

Project available on Day 2:

<table>
<thead>
<tr>
<th>Type</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item A</td>
<td>0</td>
</tr>
<tr>
<td>Component B</td>
<td>90</td>
</tr>
<tr>
<td>Component C</td>
<td>200</td>
</tr>
<tr>
<td>Sub. Component D</td>
<td>30</td>
</tr>
<tr>
<td>Sub. Component E</td>
<td>100</td>
</tr>
</tbody>
</table>

Sourcing rule for Item A:

<table>
<thead>
<tr>
<th>Rule</th>
<th>Org</th>
<th>%</th>
<th>Priority</th>
<th>Capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make at org M</td>
<td>M</td>
<td>100</td>
<td>1 (Primary)</td>
<td>100/day</td>
</tr>
<tr>
<td>Source from org S</td>
<td>S</td>
<td>100</td>
<td>2 (Alternate)</td>
<td>60/day (lead time 1 day)</td>
</tr>
</tbody>
</table>

Suppliers and capacity:

<table>
<thead>
<tr>
<th>Supplier</th>
<th>Item</th>
<th>Capacity</th>
<th>Priority</th>
<th>Sourcing %</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test 1</td>
<td>C</td>
<td>50</td>
<td>1 (Primary)</td>
<td>50</td>
</tr>
<tr>
<td>Test 2</td>
<td>C</td>
<td>100</td>
<td>2 (Primary)</td>
<td>50</td>
</tr>
</tbody>
</table>

Scenario I:
The default ranking is shown in the following table:
User-Defined Alternate Decision Rules

The planning engine plans for the 120 units of Item A on Day 2 by combining the following two actions:

1. Use alternate resource (M2/G10) along with primary (M10/G10)
2. Use component substitutions for B (B 90 + D 30) and C (C 200 + E 40)

If the demand on Day 2 is only 90, then the solution is achieved by selecting only alternate resources (alternate resource (M20/G10) along with primary (M10/G10).

Scenario II:
The decision rule Use Substitute Components is unchecked. This makes the default ranking:

<table>
<thead>
<tr>
<th>Rank</th>
<th>Objective</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Use end item substitutions</td>
</tr>
<tr>
<td>2</td>
<td>Use alternate resources</td>
</tr>
<tr>
<td>3</td>
<td>Use substitute components</td>
</tr>
<tr>
<td>4</td>
<td>Use alternate BOM/Routing</td>
</tr>
<tr>
<td>5</td>
<td>Use alternate sources</td>
</tr>
</tbody>
</table>

The planning engine plans for 120 units of Item A on Day 2 by combining the following two actions:

1. Use alternate resource (M20/G10) along with primary (M10/G10) to make 90
2. Source 30 of Item A from Org S.

The planning engine completely ignored the opportunity of available supply from the component substitutes.
Scenario III:
The information in the following table helps to illustrate the role of Enforce sourcing splits and Enforce capacity constraints. The net demand for Item C is 200

<table>
<thead>
<tr>
<th>Supplier</th>
<th>Capacity</th>
<th>Enforce Demand Due Dates and Enforce Sourcing Splits on</th>
<th>Enforce Capacity Constraints on and Enforce Sourcing Splits off</th>
<th>Enforce Capacity Constraints on and Enforce Sourcing Splits on</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test 1</td>
<td>50 units</td>
<td>supplies 100</td>
<td>supplies 50</td>
<td>supplies 50</td>
</tr>
<tr>
<td>Test 2</td>
<td>100 units</td>
<td>supplies 100</td>
<td>supplies 100</td>
<td>supplies 100</td>
</tr>
</tbody>
</table>

Assume that Supplier Test1 has a capacity of 50 units of Item C and Supplier Test2 has a capacity of 100 units of Item C. Also, assume the net demand for item C is 200 units. If we enforce sourcing splits, then Test1 would have to supply 100 units and Test2 would also have to supply 100 units. (Assuming Enforce Demand Due Dates is enabled)

If Enforce Capacity Constraints is enabled, then Supplier Test1 would have to supply 50 units and Supplier Test2 would have to supply 100 units. Supply for 50 units would be on a different day. (Assuming Enforce sourcing splits is disabled.)

If both Enforce Capacity Constraint and Enforce Sourcing Split are enabled then Supplier Test1 would supply 50 units, Supplier Test2 would supply 100 units and the remaining 50 units would be on a different day. Please note that the Enforce Demand Due Dates and the Enforce Capacity Constraints takes precedence over Enforce Sourcing Splits. The sourcing splits are valid only for rank 1 sources and are enabled by default for a constrained plan.

Selection of Alternates for OSFM
This section contains two scenarios that describe the selection of alternates for network routing based on:

- Primary Path
- Planned Percentage

(For additional information, please see Network Routings on page 12-42). The optimize scheduling method is not supported for constrained plans that use user-defined decision rules. The following diagrams and the first table provides background information for the two scenarios.

The following diagram shows the BOM for Item A where B1 is the substitute for B.
The next diagram shows network routing for Item B. The capacity at Operation 20 is 80 per day and the capacity at Operation 30 is 40 per day. The percentage split at Operation 10 is 50% each for Operation 20 and 30.

The following diagram shows network routing for Item B1. The capacity at Operation 30 is 80 per day, and the capacity at Operation 40 is 40 per day. The percentage split at Operation 10 is 25% for Operation 20, 50% for Operation 30, and 25% for Operation 40.
The following table shows the demand for Item A.

<table>
<thead>
<tr>
<th>Demand</th>
<th>Date</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>1</td>
<td>80</td>
</tr>
<tr>
<td>A</td>
<td>2</td>
<td>120</td>
</tr>
<tr>
<td>A</td>
<td>3</td>
<td>160</td>
</tr>
</tbody>
</table>

**Scenario I**

The following table shows how supply would be affected if the scheduling method was Primary Path.

<table>
<thead>
<tr>
<th>Item</th>
<th>Date</th>
<th>Supply</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>1</td>
<td>80</td>
</tr>
<tr>
<td>A</td>
<td>2</td>
<td>120</td>
</tr>
<tr>
<td>A</td>
<td>3</td>
<td>160</td>
</tr>
<tr>
<td>B</td>
<td>1</td>
<td>80</td>
</tr>
<tr>
<td>B</td>
<td>2</td>
<td>80</td>
</tr>
<tr>
<td>B</td>
<td>3</td>
<td>80</td>
</tr>
<tr>
<td>B1</td>
<td>2</td>
<td>40</td>
</tr>
<tr>
<td>B1</td>
<td>3</td>
<td>80</td>
</tr>
</tbody>
</table>

All the demand for Item A will be met on time. To meet the demand on Days 2 and 3, substitute item B1 is selected. On Day 2, the demand for 120 is satisfied with a supply of 80 units of item B and 40 units of items B1, whereas on Day 3 the demand
for 160 units of item A requires 80 units of item B and 80 units of item B1, all using only the Primary operation sequences.

Note that there is no supply available from the alternate path when the planning method is based on the primary path.

**Scenario II**
The following table shows how supply would be affected if the scheduling method was Planned Percentage.

<table>
<thead>
<tr>
<th>Item</th>
<th>Date</th>
<th>Supply</th>
<th>Alternate</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>1</td>
<td>40</td>
<td>10-20</td>
</tr>
<tr>
<td>B</td>
<td>1</td>
<td>40</td>
<td>10-30</td>
</tr>
<tr>
<td>B</td>
<td>2</td>
<td>40</td>
<td>10-20</td>
</tr>
<tr>
<td>B</td>
<td>2</td>
<td>40</td>
<td>10-30</td>
</tr>
<tr>
<td>B1</td>
<td>2</td>
<td>10</td>
<td>10-20</td>
</tr>
<tr>
<td>B1</td>
<td>2</td>
<td>20</td>
<td>10-30</td>
</tr>
<tr>
<td>B1</td>
<td>2</td>
<td>20</td>
<td>10-40</td>
</tr>
</tbody>
</table>

All the demand for item A is met on time, but since the network scheduling method is based on Planned Percentage, both the Primary and the Alternate nodes are used to meet the demand in time. For example, item B is produced on both nodes 10-20 and 10-30 by placing a demand of 40 units per each node.

Note that the maximum capacity is constrained by the most-capacity-constraining node of the network routing.

**Simulations and User-Defined Decision Rules**

When simulating constrained ASCP plans, do not toggle the site level profile option MSO: Enable Decision Rules. Switching the profile option values and running on-line plans may lead to erroneous results.

When simulating the changes in demand priorities, keep the priorities contiguous. For example, if the original demand priority for Demand1, Demand2 and Demand3 for a demanded item were 1,2, and 3 respectively, you can change the demand priority for Demand1, Demand2 and Demand3 to 2,1, and 3 but not 2,1, and 18.

For further details on plan simulations, please refer to Simulations on page 7-1.
User-Defined Alternate Decision Rules for Optimized Plans

This feature allows you to automatically select alternate routings, resources, bills of material, items, and sources. Optimized plans provide the most cost-effective planning solution.

It does this by providing decision rules giving you the ability to do the following:

- Intelligently select alternatives with the minimum data input prerequisites possible. You can run a supply chain plan that automatically selects alternate routings, BOM, resources, suppliers, internal sources, end-items and components with the minimum amount of input.

- Enforce a specified sequence of decision-making actions (which may mimic a planner’s problem resolution thought process.) The sequence in which the planning engine looks for the most cost-effective supply using standard Oracle Application functions is transparent to the user. (For example you may specify substitutes for a given component but not alternate sources.). You can specify a global decision rule when more than one supply source can satisfy the demand. (For example if you have specified both substitutes and alternate sources, ASCP will select the most optimal solution. In case of multiple cost-effective solutions, ASCP will use the decision rule sequence to arrive at the solution.)

- Restrict planning to a universe of authorized decision-making actions (for example, permit exploration of alternate routings and substitute items but not of sourcing or permit substitute components but do not permit end item substitution, even though rules are specified for the given items at the source level.)

**Note:** The site level profile option MSO: Enable Decision Rules has no bearing on an optimized plan. The Decision Rules tab in the Plan Options window is always available for an optimized plan.

User Procedures

The following steps and diagram outline the procedures used to select alternates for an optimized plan. The steps provide a more in-depth explanation for the procedures shown in the diagrams.

To select alternates using an optimized plan

1. Define cost and penalty factors at various levels to model required behavior.
2. Perform data setups.
3. Define or open Plan Options window.

Figure 18–16 Plan Options window

4. Set up your plan parameters using all the appropriate tabs.

5. Choose the Constraints tab and select the Constrained Plan checkbox.

6. Choose the Optimization tab and select the Optimize checkbox.

7. Set up the required parameters for plan objectives and penalty factors.

8. If you want to make changes to the default decision rule, choose the Decision Rules tab. If not, skip to step 10.

9. Enable or disable decision rules.

You can enable and disable the decision rules. These decision rules are used to derive the optimized plan, while honoring your preferences. If any of the rules
are disabled, then the planning engine will not look for supply pertaining to these rules.

The meanings of the decision rules are shown in the following table:

<table>
<thead>
<tr>
<th>Decision Rule</th>
<th>Status</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use alternate sources</td>
<td>checked</td>
<td>Use primary sources as far as possible and use alternate sources only if necessary.</td>
</tr>
<tr>
<td>Use alternate sources</td>
<td>unchecked</td>
<td>Use primary sources only and alternate sources (sources of rank 2 or higher) will not be used as a source of supply.</td>
</tr>
<tr>
<td>Use alternate BOM/routings</td>
<td>checked</td>
<td>Use primary routing as far as possible and use alternate only if necessary.</td>
</tr>
<tr>
<td>Use alternate BOM/routings</td>
<td>unchecked</td>
<td>Use only primary BOM/Routing</td>
</tr>
<tr>
<td>Use alternate resources</td>
<td>checked</td>
<td>Use primary resource as far as possible and use alternate resource only if necessary.</td>
</tr>
<tr>
<td>Use alternate resources</td>
<td>unchecked</td>
<td>Use only primary resources</td>
</tr>
<tr>
<td>Use end item substitutions</td>
<td>checked</td>
<td>Use primary item and end item substitute, when enabled, prior to creating new planned orders.</td>
</tr>
<tr>
<td>Use end item substitutions</td>
<td>unchecked</td>
<td>Use only the demanded item. Do not use the end item substitute.</td>
</tr>
<tr>
<td>Use substitute components</td>
<td>checked</td>
<td>Use primary items as far as possible and use substitute component only if necessary.</td>
</tr>
<tr>
<td>Use substitute components</td>
<td>unchecked</td>
<td>Use primary items/components only.</td>
</tr>
</tbody>
</table>

10. Launch the plan.

The following diagram is an illustration of these steps.
Features

The major features include:

- Setup for the weighted objectives for optimization
- Data setup for decision rules
- Optimization based on user-defined weights for the objectives and user-enabled decision rules
Define Plan Objectives  You can prioritize the plan objectives as weights. The list of plan objectives is provided in the following table. You can define and set the weight for the objectives for each optimized plan.

<table>
<thead>
<tr>
<th>Objective</th>
<th>Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximize inventory turns</td>
<td>0 to 1</td>
</tr>
<tr>
<td>Maximize plan profit</td>
<td>0 to 1</td>
</tr>
<tr>
<td>Maximize On-time delivery</td>
<td>0 to 1</td>
</tr>
</tbody>
</table>

For additional information, please refer to Optimization on page 8-1.

Optimization Based on User-Defined Priority for Decision Rules  You have the ability to disable any decision rules for a particular plan prior to launching the plan.

The base data setup like items, bill of materials and sourcing rules are used to recommend the most optimized plan based on the objectives you have specified. User-defined decision rules and the priority of the decision rules will be honored for tie breaking amongst various cost-effective solution possibilities. For example, ASCP may suggest the use of alternate resource instead of the primary resource, if alternate resource is more cost effective than the primary resource. This is shown in the following example:

First, use the examples in the section Examples of How Alternate Decision Rules are Used section starting on page 18-81 and then also assume that the cost of making item A in Org M is $100 and the cost of buying from Supplier S is only $60. The demand for 120 units on day 2 would be satisfied by procuring 60 units from Supplier 1 and then 60 more from making 60 units of item A using resources M10 and G10 and using 60 units of item B and 120 units of item C.

The constrained plan would recommend the use of a higher ranked source (Org M) before using a lower ranked source (Supplier S); however, the optimized plan would recommend using the most cost-effective source.

However, if both making at Org M and buying from Supplier S were $100, the optimized plan would recommend the use of Org M because it is a higher ranked source.

Planning Search Logic

This section describes the planning search logic for user-defined alternate decision rules for both optimized and constrained plans. The planning logic uses a series of
steps depending on the constraints used for the plan. The planning search logic is illustrated below using the supply chain for assembly item A with end-item substitute item A1. Item A is made of B and C with B1 and C1 as the substitute components. B and C in turn need items D and E respectively. To simplify the search we will not expand the substitute component B1 and C1 and also assume the same BOM and routing for all items across Manufacturing 11 and Manufacturing 21. In addition, we have made the following two assumptions:

- there is high demand placed on the distribution center
- for optimized plans, cost effectiveness at each node across the given supply-chain is the same
User-Defined Alternate Decision Rules

Supply chain for item A

Note: For make items the sourcing rule is to make at the organization in question, except for C at Manufacturing 11, where Transfer is rank 1 and make is Rank 2.
The planning engine searches on-hand quantity and schedules receipts (item A and end item substitute A1) across each tier before creating new planned orders for the demanded item. (Please refer to End Item Substitution chapter). To look for on-hand quantity and scheduled receipts of the demanded item and the end-item substitute, ASCP uses the search logic as specified below:

1. Distribution center for item A
2. Distribution center for item A1
3. Warehouse 1 for item A
4. Warehouse 1 for item A1
5. Manufacturing 11 for item A
6. Manufacturing 11 for item A1
7. Manufacturing 21 for item A
8. Manufacturing 21 for item A1

The following diagram illustrates the tier-by-tier search logic for on-hand quantity and scheduled receipts for end items.
User-Defined Alternate Decision Rules

End Item: On-hand and scheduled receipts search

Note: For make items the sourcing rule is to make at the organization in question, except for C at Manufacturing 11, where Transfer is rank 1 and make is Rank 2.
If there is no on-hand/scheduled receipts for either A and A1 or on-hand quantity is not adequate to satisfy demand, then ASCP will create the planned orders to satisfy net demand for A, B, C, D and E in the following method:

When creating planned orders for A:

1. Transfer A from Warehouse 1 to Distribution Center
2. Make A at Manufacturing 11 using primary resource and primary BOM/Routing and Primary components B (Refer to Planning for B at Manufacturing 11 on page 18-97), C (Refer to Planning for C at Manufacturing 11 on page 18-98), D (Refer to Planning for D at Manufacturing 11 on page 18-99), and E (Refer to Planning for E at Manufacturing 11 on page 18-99)
3. Make A at Manufacturing 11 additionally using alternate resource
4. Make A at Manufacturing 11 additionally using substitute components (B1, C1 if needed)
5. Make A at Manufacturing 11 using Alternate routings/BOM
6. Make A at Manufacturing 21 using primary resource and primary BOM/Routing and Primary components B (Refer to Planning for B at Manufacturing 21 on page 18-98), C (Refer to Planning for C at Manufacturing 21 on page 18-99), D (Refer to Planning for D at Manufacturing 21 on page 18-99), and E (Refer to Planning for E at Manufacturing 21 on page 18-99)
7. Make A at Manufacturing 21 using alternate resource
8. Make A at Manufacturing 21 using substitute components (B1, C1)
9. Make A at Manufacturing 21 using Alternate routings/BOM

Planning for B at Manufacturing 11

1. Use on-hand/scheduled receipts for B in Manufacturing 11
2. Use on-hand/scheduled receipts for B1 in Manufacturing 11
3. Make B at Manufacturing 11 using primary Resources, BOM/Routing and component D (Refer to Planning for D at Manufacturing 11 on page 18-99)
4. Make B at Manufacturing 11 using alternate resources
5. Make B1 at Manufacturing 11 using primary Resources, BOM/Routing and components
6. Make B1 at Manufacturing 11 using alternate resources
7. Make B at Manufacturing 11 using alternate BOM/Routing
8. Make B1 at Manufacturing 11 using substitute components
9. Make B1 at Manufacturing 11 using alternate BOM/Routing

**Planning for B at Manufacturing 21**
1. Use on-hand for B in Manufacturing 21
2. Use on-hand for B1 in Manufacturing 21
3. Make B at Manufacturing 21 using primary Resources, BOM/Routing and component D (Refer to Planning for D at Manufacturing 21 on page 18-99)
4. Make B at Manufacturing 21 using alternate resources
5. Make B1 at Manufacturing 21 using primary Resources, BOM/Routing and components
6. Make B1 at Manufacturing 21 using alternate resources
7. Make B at Manufacturing 21 using alternate BOM/Routing
8. Make B1 at Manufacturing 21 using substitute components
9. Make B1 at Manufacturing 21 using alternate BOM/Routing

**Planning for C at Manufacturing 11**
1. Transfer from Manufacturing 21
2. Use on-hand for C in Manufacturing 11
3. Use on-hand for C1 in Manufacturing 11
4. Make C at Manufacturing 11 using primary Resources BOM/Routing and component E (Refer to Planning for E at Manufacturing 11 on page 18-99)
5. Make C at Manufacturing 11 using alternate resources
6. Make C1 at Manufacturing 11 using primary Resources BOM/Routing and components (E)
7. Make C1 at Manufacturing 11 using alternate resources
8. Make C at Manufacturing 11 using alternate BOM/Routing
9. Make C1 at Manufacturing 11 substitute component
10. Make C1 at Manufacturing 11 using alternate BOM/Routing
User-Defined Alternate Decision Rules

Planning for C at Manufacturing 21
1. Use on-hand for C in Manufacturing 21
2. Use on-hand for C1 in Manufacturing 21
3. Make C at Manufacturing 21 using primary Resources BOM/Routing and component E (Refer to Planning for E at Manufacturing 21 on page 18-99)
4. Make C at Manufacturing 21 using alternate resources
5. Make C1 at Manufacturing 21 using primary Resources BOM/Routing and components (E)
6. Make C1 at Manufacturing 21 using alternate resources
7. Make C at Manufacturing 21 using alternate BOM/Routing
8. Make C1 at Manufacturing 21 substitute component
9. Make C1 at Manufacturing 21 using alternate BOM/Routing

Planning for D at Manufacturing 11
1. Use on-hand/scheduled receipts of D at Manufacturing 11
2. Buy D from supplier 1
3. Look for alternate source of supply

Planning for D at Manufacturing 21
1. Use on-hand/scheduled receipts of D at Manufacturing 21
2. Buy D from supplier 1
3. Look for alternate source of supply

Planning for E at Manufacturing 11
1. Use on-hand/scheduled receipts of E at Manufacturing 11
2. Buy E from supplier 2
3. Look for alternate source of supply (none defined)

Planning for E at Manufacturing 21
1. Use on-hand/scheduled receipts of E at Manufacturing 21
2. Buy E from supplier 2
3. Look for alternate source of supply (none defined)
Lead-Times and User-Defined Decision Rules

When running a constrained plan with the site level profile option MSO: Enable Decision Rules set to Yes, ASCP uses the following:

- Item lead-times that are defined as item attributes
- In-transit lead-times defined between organizations
- Resource availability and usages as defined by the resources and the assembly’s routing

The lead-time item attribute is composed of preprocessing, processing, postprocessing, fixed, and variable lead-times.

The following shows how total processing lead-time and cumulative lead-times for make and buy items are calculated for user-defined decision rules:

**Make Item**

The total processing lead-time = \( ((1+\text{Queue Time Factor}) \times \text{processing lead-time}) \) (rounded).

where Queue Time Factor is the site level profile option value for MSO: Queue Time Factor.

If routing for the make item is not defined, the cumulative lead-time = fixed lead-time + (scheduled quantity \( \times \) variable lead-time).

**Buy Item:**

For a buy item, the processing lead-time is based on the most specific definition. If there is a processing lead-time assigned to the item supplier relationship, then ASCP uses that as the processing lead-time. If not, it will use the item attribute for the processing lead-time.

The total processing lead-time = preprocessing lead-time + postprocessing lead-time + processing lead-time.

The cumulative lead-time = preprocessing + fixed lead-time + (scheduled quantity \( \times \) variable lead-time) + postprocessing lead-times.

If the fixed and variable lead-times are not set, fixed lead-time assumes the value of the processing lead-time defined at the item attribute.

In transit lead-times are used for all transfers between the sourcing and destination organizations.
For the planning engine to follow the predefined sequence of selecting alternates, the derived value of the total processing lead-time and the cumulative lead-times should be the same. Any discrepancies between the total value of the two lead-times may result in ASCP not following the predefined sequence of selecting alternates.

**Pegging and User-Defined Decision Rules**

Looking at pegging may not be the method you should use to determine the sequence of selection of alternates. This is because the sequence of selection of alternates is more apparent when looking at total demand and total supply across the time bucket where there is a constraint.

For example, suppose there are two demands, D1 (150 units) and D2 (50 units) on Day 1 and Day 2 for item B, and the only way to satisfy this demand is by making 100 units with primary resource/routing/BOM and 50 units using substitute component B1 and 50 units of B with alternate BOM/routing. Then, Day 1 demand will peg to 100 units of item B using primary resource/routing/BOM and 50 units of item B using alternate BOM/routing. Day 2 demand will peg to 50 units of substitute component B1.

If you look at just the pegging for D1, 50 units of the substitute component is not used. Instead, 50 units of the alternate BOM/routing is pegged to D1. Therefore, it looks as if ASCP has broken the user-defined sequence. But, if the demand was for only 150 units, then the supply would be 100 units of item B and 150 units of substitute component B1, which follows the user-defined sequence.

**Exception Messages**

Once the planning engine runs, you may find several instances where the engine has recommended alternates. When this happens, an exception message is generated. Typical flow may consist of analyzing exceptions generated by the plan, drilling into the details of exceptions, analyzing supply demand records using Supply/Demand window, vertical plan and pegging. Users may access the horizontal plan to get a detailed understanding of the demands placed on the alternates, supplies received as a part of the user-defined decision rule, and analyze possibilities of improving the solution based on their knowledge.

**Exception Display** When the system suggests the use of alternates, it also generates required exception messages referencing the type of alternates used. These exceptions are summarized in the Substitutes and Alternates Used exception group. The following screen shot shows a typical exception message.
Figure 18-17 Exception Message

<table>
<thead>
<tr>
<th>Action Type</th>
<th>Count</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Late Sales Orders and Forecasts</td>
<td>15</td>
<td>current</td>
</tr>
<tr>
<td>Reschedules</td>
<td>2</td>
<td>current</td>
</tr>
<tr>
<td>Substitutes and Alternates Used</td>
<td>8415</td>
<td>current</td>
</tr>
<tr>
<td>Planned order uses alternate BOM Routing</td>
<td>938</td>
<td>current</td>
</tr>
<tr>
<td>Planned order uses substitute components</td>
<td>1005</td>
<td>current</td>
</tr>
<tr>
<td>Planned order uses alternate resources</td>
<td>1355</td>
<td>current</td>
</tr>
<tr>
<td>Order sourced from alternate facility</td>
<td>1317</td>
<td>current</td>
</tr>
<tr>
<td>Item Exceptions</td>
<td>35</td>
<td>current</td>
</tr>
</tbody>
</table>

Key Indicators | Horizontal Plan | Vertical Plan | Actions | Supply Chain
Organization Security

This feature restricts plan information access to authorized individuals. Oracle ASCP allow users to associate job responsibilities to organizations for security purposes. This ensures that you see/change planning data in an organization only if you have a job responsibility associated with the organization.

Examples:

- User 1 is restricted to organization M2
- User 2 has global authorization to access all organizations including organizations M1 and M2.
- User 2 creates a plan for organizations M1 and M2 (owning organization is M1). User 1 can access this plan and view and execute only the portion of this plan related to organization M2.

User Procedure Flow

The following diagram illustrates the procedure flow for assigning users and job responsibilities to organizations:

To assign users and job responsibilities to organizations:

1. Define custom responsibility in the Planning Server. To do this, sign in using the System Administrator responsibility. From the Navigator, select Security > Responsibility > Define. Fill in the appropriate fields with the appropriate information.

2. Define users and assign responsibilities. To do this, from the Navigator, select Security > User > Define. Fill in the appropriate fields.
3. Sign on using the Advanced Planning Administrator responsibility.

Note: Only users with APS Administration responsibility can access and view Organization Security.

4. From the Navigator, select Admin > Organization Security.
The Assign Organizations to Responsibilities page appears.

Figure 18–18 Assign Organizations to Responsibilities

5. In the Responsibility field, select the responsibility that you want to associate to organizations. The list of values for the Responsibility field includes all responsibilities defined in the Responsibilities form in the Planning Server. (limited to Oracle ASCP responsibilities).
6. From the Available Organizations column, select and move any organization to the Assigned Organizations column using the Move button. You can use the Move All button to select all organizations for the specified responsibility. You can use the Remove button to remove any selected organization from the Assigned Organizations column. You can also use the Remove All button to remove all selected organizations.

7. Select the Save button.

Organization Validation

Oracle ASCP restricts users to their authorized inventory organizations. The Organizations Find form displays only the authorized organizations when users attempt to open a form in Oracle ASCP for the first time:

Note: You are also restricted to the authorized organizations when you select the Change Instance/Organization menu item.

Supply Chain Plan Names Form

For the selected instance/organization, you can view and create plan names in the Supply Chain Plan Names form shown below. The system restricts accessing and viewing plans to authorized users of the owning organization.

Figure 18–19 Supply Chain Plan Names
Plan Options Form

In the Organizations tab of the Plan Options form there is a button called Add All Authorized Orgs, as show below.

![Plan Options, Organization tab](image)

When you select this button, all user-authorized organizations are displayed in the Org field.

You can select organizations for planning in the Org field. The list of values for this field is restricted to authorized organizations which can be accessed by user. This implies that the Plan Organizations Find form list of values is restricted to organizations associated to user.

**Note:** In general, the Plan Options form can be viewed and updated only if user has access to the owning organization of the plan.
Example:

Plan1 has been created in M1 (owning organization) for planning organizations M1 and M2. This means the Plan Names form in M1 includes Plan1, but the Plan Names form in M2 does not include Plan1.

The Organization Security behavior for Plan Names, Plan Options, and the Planner Workbench is summarized for different user authorizations in the following tables.

<table>
<thead>
<tr>
<th>User</th>
<th>Authorized To</th>
<th>Plan Names</th>
<th>Plan Options</th>
<th>Workbench</th>
</tr>
</thead>
<tbody>
<tr>
<td>User 1</td>
<td>M2</td>
<td>User 1 cannot view and access Plan1 in the Plan Names form</td>
<td>User1 cannot access Plan Options via the Plan Options menu entry in the Navigator.</td>
<td>User1 can view Plan1 in the left pane of the Planner Workbench, but restricted to Organization M2. However, User1 can view all planned Organizations (M1 and M2) in the Organization tab of the Plan Options form via the Plan menu entry from the tool bar in the Planner Workbench.</td>
</tr>
<tr>
<td>User 2</td>
<td>M1 and M2</td>
<td>User 2 can view and access Plan1 in the Plan Names form from organization M1. User2 can copy and launch Plan1.</td>
<td>User2 can access Plan Options via the Plan Options menu entry in the Navigator window.</td>
<td>User2 can view Plan1 in the left pane of the Planner Workbench with both organizations M1 and M2 displayed.</td>
</tr>
<tr>
<td>User 3</td>
<td>M1</td>
<td>User3 can view and access Plan1 in the Plan Names form from organization M1. User3 can copy and launch Plan1.</td>
<td>User3 can view and access Plan1 in the Plan Options form. User3 can delete planned organization M2 but cannot add organization M2. User3 can only add organization M1 to the Plan Options form.</td>
<td>User3 can view Plan1 in the left pane of the Planner Workbench with both organizations M1 and M2 displayed.</td>
</tr>
</tbody>
</table>
Topics covered in this appendix include:

- Profile Options on page A-2
Profile Options

For a complete list of all the main ASCP profile options, please refer to Implementing Profile Options Summary in the Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide.

The other topics in this section list profile options you set when configuring Oracle ASCP and Oracle Global Order Promising.

Oracle ASCP Scheduling Profile Options

**MSC: Apply Lot Modifiers in Weekly/Period Buckets** This profile option determines whether order modifiers will be considered when creating planned orders for weekly or period time buckets. Valid values:

- Yes: Consider order modifiers in these calculations.
- No: Do not consider order modifiers in these calculations.

The default value is Yes.

**MSC: Compute Project Exception** This profile option determines whether to generate project specific exceptions when running a project based plan.

- Yes: Enable the generation of project specific exceptions.
- No: Disable the generation of project specific exceptions.

The default value is Yes.

**MSC: Enable ATP Summary Mode** This profile option enables the summarization of supply and demand data following the data collection and plan launch processes. This summarized data is then available for improved efficiency inquiries in ATP summary mode. Valid values are:

- Yes: Enable ATP Summary Mode
- No: Do not enable ATP Summary Mode.

The default value is No.

**MSC: Net Change Temp Dir** This profile option stores the location of image cache used in the Plan Comparison Report. Please indicate the location in the following format: `<directory>@<subdir>` where `<directory>` should be exactly the same as the absolute path of the OA_MEDIA environment variable and `<subdir>` is the name of
a subdirectory under the OA_MEDIA directory. Please make sure that the subdir has write permissions for all.

**MSC: Purge Stg Tbl Cntr** This profile option is used to truncate the staging table during the data collection process. This value should be set to No if you are running data collections for multiple instances simultaneously to avoid data loss. This value may be set to Yes to conserve disk space if you are running data collections for single instances or as separate processes for multiple instances.

The default value is No.

**MSC: Released Only By User** This profile option controls the behavior of the planner’s workbench when releasing orders or schedule changes. It can be used to restrict the selection of changes to the specific user or to select changes from all users. The valid values are:

- **Yes:** Restrict the releases or schedule changes selected to those created by this User.
- **No:** Do not restrict releases or schedule changes selected to those created by this User. Implementing changes will select changes made by any user of this plan.

The default value is No.

**MSC: Safety Stock Project** This profile option specifies the default project that will be charged for all safety stock demands. Oracle ASCP will assign the project specified in the profile option for all the safety stock demands which originate from Non-MRP planned safety stock. If you specify safety stock requirements in Oracle Inventory for specific projects, the value in profile option will not be honored.

The list of values for this profile option will be restricted to the projects specified in Oracle Projects. This profile option is enabled at Project/Seiban level, not at the Task level.

**MSC: Sequence Cache Size** This profile option determines the size of the sequence cache. For very large plans, system performance may be marginally improved by increasing this integer value (up to 5% of the estimated number of planned orders).

The default value is 500 and is normally not changed.

**MSC: Source Setup Required** This is an internal profile used by the software during collections configuration. This value should not be manually updated.
**MSC: Sourcing History Start Date Offset (in months)**  This profile option offsets the starting date of the Sourcing history calculations and is used in conjunction with the Collections parameters, Purge Sourcing History = Yes and Recalculate Sourcing History = Yes. These settings cause Sourcing History to be deleted and calculated from the Start date determined by the profile option value (in months). If you select a high value for this profile option and there is a high volume of Source transaction data, system performance may be degraded.

This profile option is maintained on the Destination (APS) instance. The default value is null.

**MSC: Sourcing Variance Tolerance**  This profile option is utilized when Enforce Sourcing Constraints is enabled for a plan. This percentage value establishes a threshold for triggering exception messages if sourcing allocations are violated. Exceptions are generated if the difference between the user-specified sourcing allocation percentages and the plan-derived allocation percentages is greater than the Sourcing Variance Tolerance.

**MSC: Split Planned Orders for Scheduling Flexibility**  This profile option determines if planned orders that were split during optimization processing will be consolidated prior to scheduling. Possible values are:

- Yes: Do not consolidate orders prior to scheduling.
- No: Consolidate orders when possible prior to scheduling.

The default value is Yes.

**MSC: Temp Index Extent Size (Bytes)**  This profile option controls the size of the next extent when creating temporary tables while running collections or copy plan. The recommended value is calculated as the size of the index / 5. The default value is 1000000 (1 meg).

**MSC: Temp Table Extent Size (Bytes)**  This profile option controls the size of the next extent when creating temporary tables while running collections or copy plan. The recommended value is calculated as the size of the table / 5. The default value is 10000000 (10 meg).

**MSO: Allow Partial Demand Completion**  This profile option enables supply orders to be scheduled individually to partially satisfy a demand when demand is split across several supply orders. The default scheduling logic schedules all supply orders to coincide with the latest supply completion date. This method completely satisfies
the demand on that date. This functionality may be enabled for all independent demands or for Sales Orders only.

Valid values are:

- **All End Demands**: Enable Partial Demand Satisfaction for all independent demands (forecasts, sales orders, and MDS entries).
- **Sales Orders**: Enable Partial Demand Satisfaction for all Sales Order demand only.
- **None**: Default scheduling logic. Schedule all supplies to coincide completion date (latest supply date) to meet a demand.

The default value is None.

**MSO: Calculate Constraint Exceptions** This profile option determines whether constraint exceptions should be calculated for plans with Enforce Capacity Constraints selected.

Valid values are Yes or No. The default value is No.

**MSC: Day UOM** This profile option supports the Unit Of Measure conversion required for ASCP resource batching calculations. ASCP considers Batching Window in Days, but users may specify the batching window with a Unit of Measure other than Days. This profile option establishes a standard for Day Unit of Measure. Users must specify the UOM that represents the value Day using this profile option. Users must then also setup a UOM conversion between the UOM used for resources and the Day UOM specified here.

**MSO: Default Forecast Priority** This profile option contains the default priority value for forecasts and is used by the scheduling engine to determine when to schedule the forecast.

This profile option can be defined at the site level. You can update this value. The default value is 100000.

**MSO: Default Sales Order Priority** This profile option contains the default priority value for sales orders and is used by the scheduling engine to determine when to schedule the sales order.

This profile option can be defined at the site level. You can update this value. The default value is 10000.
**MSO: Firm Operations/Orders Within Time Fence**  This controls whether operations and orders that fall within the Planning Time Fence (PTF) are considered equivalent to firmed. The Planning Time Fence is specified at the organization-item level. If used, operations and orders (planned orders, work orders, purchase orders, or transfer orders) with start dates within the PTF will not be permitted to be rescheduled or cancelled. Valid values are:

- Yes: All orders with start date within the planning time will be treated as Firm.
- No: Orders with start dates within the planning time fence are subject to be rescheduled out.

**MSO: Firm Supply Allocation Window (days)**  This profile option determines a window of time during which firm supplies such as on-hand, receipts, and firmed orders are allocated based on demand priority. Without this window, you might run into a situation in which higher priority demands that are due much later would consume firm supplies that are available in the near future. The value is specified as an integer greater than 0.

This profile option can be defined at the site level. You can update this value.

**MSO: Global Batchable Flag**  This profile option enables resource batching functionality for order scheduling. The possible values are

- Yes: Enable resource batching functionality.
- No: Do not enable resource batching functionality.

The default value is No.

**MSO: Heuristic type**  This is used by the scheduling engine to determine which heuristic to use. A value of 0 corresponds to the default heuristic which proceeds priority by priority, and tries to schedule demands just in time and minimize lateness. A value of 1 corresponds to the look-ahead heuristic. This heuristic tries to reserve some time for lower priorities, so the schedule begins with the tasks of higher priorities.

This profile option can be defined at the site level. You can update this value. The default value is 0.

**MSO: HLS flat files path**  This profile option is used to specify the directory to store HLS debugging data files.
MSO: HLS Granularity Precision Profile Options

Certain quantities (usages in routings, planned order quantities, transportation lane capacities by weight by volume, and planned order start and end times) used by ASCP may in practice have fractional (non-integer) values, but for the purposes of internal processing by the ASCP planning engine are required to have integer values. ASCP addresses this problem by providing five floating-point precision profile options that act as internal multipliers. When one of the concerned quantities is encountered, it is multiplied by the appropriate floating-point precision profile option value, and the resulting equivalent integer is processed by the ASCP planning engine.

The number of floating-point precision profile options is now five. This gives you more flexibility to control the precision with which to consider each quantity, as well as more flexibility to avoid numerical overflow on 32-bit platforms, where the rule is that each equivalent integer processed by ASCP must not exceed $2.1 \times 10^9$.

The five floating-point precision profile options are: Floating Point Precision for Usages in Routing, Floating Point Precision, Floating Point Precision for Transportation Capacities (Weight and Volume), Floating Point Precision for Planning Bucket Efficiency.

MSO: Floating Point Precision for Usages in Routings  This is the internal multiplier for routing usages.

For example, in a plan, the following minimum and maximum usage and corresponding floating-point precision profile option values apply.

- Maximum Usage = 0.023256
- Minimum Usage = 0.000001
- MSO: Floating Point Precision for Usages in Routings = 1,000,000

ASCP internally converts these usages to integer numbers by multiplying them by the floating-point precision profile option value.

- Maximum Usage * Floating Point Precision = 23256
- Minimum Usage * Floating Point Precision = 1

A floating-point precision value of less than 1,000,000 would result in a modified minimum usage of zero.

MSO: Floating Point Precision  This is the internal multiplier for planned order quantities (for example, order quantities of buy items, order quantities in resource batching).
Profile Options

**Note:** The meaning of this floating point precision profile option has been changed from a general floating point precision multiplication factor to the more specific one described above.

**MSO: Floating Point Precision for Transportation Capacities (Weight)** This is the internal multiplier for transportation lane capacities by weight by day.

**MSO: Floating Point Precision for Transportation Capacities (Volume)** This is the internal multiplier for transportation lane capacities by volume by day.

**MSO: Floating Point Precision for Planning Bucket Efficiency** This determines the resolution with which date/times and durations (for example, planned order start and end times, shift start and end times, shift durations) are considered by ASCP.

For example, consider a daily planning bucket (24 hours = 86,400 seconds). Assume a value of 10,000 for Floating Point Precision for Planning Bucket Efficiency. This bucket is divided by ASCP into 10,000 equal increments of 8.64 seconds each.

An 8-hour shift would be considered by ASCP to last for $\frac{8}{24} \times 10,000 = 3333$ increments (= 28797.12 seconds), instead of the actual 28,800 seconds. This represents an approximation error of 0.01 percent.

**Note:** The default value for each of these profile options is 100.

**MSO: Maximum Activity Duration** This profile option is used to define the HLS maximum activity duration in minutes. All requirements should be less in duration than this. If null, the planning horizon duration will be used by default. In addition, there is a constraint that $<\text{MSO: Maximum Activity Duration}>$ times $<\text{MSO:}>$ should be less than the maximum integer on the platform used (2 billion on 32 bits platforms).

**MSO: Maximum Number of Prepones** This is an important scalability factor for the scheduling engine. The scheduling engine will try to schedule the operations in different orders to find a solution. As the number of order can be very large, this parameter limits the number of times the scheduling engine tries to schedule an operation. If you have many components for some items, or many small supplies answering a demand, the number of orders (between this components and this supplies) become larger, and you should reduce this parameter.
This profile option can be defined at the site level. You can update this value. The default value is 10 operations.

**MSO: Maximum Demands per Group**  This is used by the scheduling engine to determine the maximum number of demands that can be grouped together for scheduling. Within a group, the default heuristic can try different orders among the demands. The value is specified as an integer greater than 0 and smaller than the size of a slice.

This profile option can be defined at the site level. You can update this value. The default value is 5 demands.

**MSO: Maximum Demands per Slice**  This determines the number of demands in a slice. A slice is a part of the plan that is scheduled at a time. This option enables the scheduling engine to better resolve the interactions of demands on each other within a slice. In particular, the supplies shared between demands are scheduled better when the demands are in the same slice. However, making slices too large causes the scheduling engine to be slower and consume more memory.

This profile option can be defined at the site level. You can update this value. The default value is 100 demands.

**MSO: Maximum Number of Pull for Operation**  When an operation cannot be scheduled on a certain day, the scheduling engine attempts to schedule it on an earlier date (for backward scheduling). This profile option controls how many days are tried this way. This should be larger than 0. A large number of days result in degraded performance.

This profile option can be defined at the site level. You can update this value. The default value used is 8 operations.

**MSO: Maximum Resource Over-capacity**  This is used by the scheduling engine to assign resource slacks whenever it does not find the resource available and it is forced to use slacks. The value is specified as a number greater than 0.

This profile option can be defined at the site level. You can update this value.

**MSO: Network routing cycle time coefficient**  This is used by the scheduling engine to calculate the window of time allocated to schedule a network flow. This is used in conjunction with NFL Fixed Time Window. The window of time is (coefficient * <cycle time> + fixed_window).

This profile option can be defined at the site level. You can update this value. The default value is 2.
**MSO: Network routing fixed time window**  This is used by the scheduling engine to calculate the window of time allocated to schedule a network flow. This is used in conjunction with NFL Cycle Time Coefficient. The window of time is \((\text{coefficient} \times <\text{cycle time}> + \text{fixed}_\text{window})\)

This profile option can be defined at the site level. You can update this value. The default value is 0.

**MSO: NFL BACKWARD COMPRESSION PCT**  This profile defines the percentage of the actual resources capacity that the network flow takes into account. A value under 100 percent tends to offload more activities to alternate resources. The value should typically be between 10 and 100 percent.

This profile option can be defined at the site level. You can update this value. The default value is 100 percent.

**MSO: NFL FORWARD COMPRESSION PCT**  This is used in the same way as the previous profile, but for the forward scheduling phases. This profile is useful in forward phase to force the system to use alternates and limit the lateness of the activities.

This profile option can be defined at the site level. You can update this value. The default value is 100 percent.

**MSO: Reschedule Shared Supply to Influence Batching**  This profile option determines if ASCP will attempt to schedule shared supplies early to avoid item-based resource constraints prior to batch resources. Enabling this option improves the scheduled utilization of batch resources by considering earlier constraints. Possible values are:

- Yes: Consider whether scheduling shared supplies early will allow subsequent resource batching.
- No: Schedule resource batching as supplies are available.

The default value is No.

**MSO: Resource Batching Strategy**  This profile option is used to select the order scheduling strategy used in resource batching functionality. There are two methods provided:

- Nearest Date: Schedule orders to load resources nearest the due date of the order.
- Level Utilization: Schedule orders to level utilization of the resource.

The default value is Nearest Date.
**MSO: Schedule Across Breaks** This determines if the scheduling engine will start an activity before a break and end it after the break. If set to No, you should make sure that every activity has enough resource in 1 shift; otherwise, the activities are pushed to the end of the horizon.

This profile option can be defined at the site level. You can update this value. The default value is Yes (can schedule across break).

**MSO: schedule window width** This defines the window of time (expressed in days) during which the scheduling engine looks for the primary resource. If the primary resource is not present in this window, the scheduling engine tries to move to an alternate resource.

This profile option can be defined at the site level. You can update this value. The default value is 8 days.

**MSO: Sourcing Allocation Window** This profile option specifies the Allocation Percentages Satisfaction Period (APSP) which is the length of time (in days) used to satisfy the allocation percentages calculated to enforce sourcing split constraints. The constraints will be enforced in a rolling horizon manner, in multiples of the APSP.

This profile option is used in conjunction with Enforce Sourcing Constraints being enabled in the specific plan options.

Valid values are any integer $\geq 1$. The profile option default value is 7.

**MSO: Use SCO Time Aggregation** This profile option is used to determine if SCO should use different aggregate time buckets than specified in the Aggregation settings of the Plan Options. Both HLS and SCO use the values defined in the plan options. It may be desired to specify large values for daily and weekly buckets for HLS output, but this would increase SCO calculation time. This relationship can be expressed as SCO memory consumption = item–orgs * number of time buckets. The possible values are:

- True: SCO will utilize aggregate time buckets specified in MSO: Optimization Daily Aggregation Buckets and MSO: Optimization Weekly Aggregation Buckets. The period time bucket is derived.
- False: SCO and HLS will utilize the same aggregate time buckets as specified in the Aggregation tab of the Plan Options window.

The default value is False.
Oracle ASCP Optimization Profile Options

The following profile options can be used to specify default values necessary for optimization:

**MSO: Alternate Process Penalty**  This specifies the weight to use for alternate process objective in optimization. This value is specified as a number greater than 0, and is an internal value.

**MSO: Alternate Resource Penalty**  This profile option contains the weight to use for alternate resource objective in optimization. This value is specified as a number greater than 0, and is an internal value.

**MSO: Alternate Source Penalty**  This profile option contains the weight to use for alternate source objective in optimization. This value is specified as a number greater than 0 and is an internal value.

**MSO: Inventory Carrying Costs Percentage**  Use this profile option to specify the inventory carrying costs percentage for all items in the plan. The value is specified as a number between 0 and 1.

This profile option can be defined at the site level. You can update this value.

**MSO: LP Optimization Algorithm**  This profile option is used by optimization to determine what optimization algorithm will be used. The valid values are:

- 0=primal simplex
- 1=dual simplex
- 2=hybrid barrier primal
- 3=hybrid barrier dual

This profile option can be defined at the site level. You can update this value. This profile option value is defaulted internally.

**MSO: Maximum Allowable Days Late**  Use this profile option to limit the number of days by which a demand or unfirmed scheduled receipt can be moved out when optimization is turned on. This value is only used by optimization to improve performance and reduce the size of the plan for the optimization component of the Memory Based Planner. Scheduling moves demands and unfirmed scheduled receipts out as long as necessary. The value is specified as an integer greater than 0.
This profile option can be defined at the site level. You can update this value. The default value is 5.

**MSO: Optimization Daily Aggregation Buckets**  This profile option specifies the Daily Aggregation Time Bucket to be used by SCO if the profile option MSO: Use Optimization Internal Time Aggregation is set to True.

**MSO: Optimization Weekly Aggregation Buckets**  This profile option specifies the Weekly Aggregation Time Bucket to be used by SCO if the profile option MSO: Use Optimization Internal Time Aggregation is set to True.

**MSO: Penalty Cost Factor for Exceeding Material Capacity**  Use this profile option to define a global penalty cost factor for exceeding material capacity. This value is common to all items in the plan. The value is specified as a number greater than 0.

This profile option can be defined at the site level. You can update this value.

**MSO: Penalty Cost Factor for Exceeding Resource Capacity**  Use this profile option to define a global penalty cost factor for exceeding resource capacity. This value is common to all manufacturing and transportation resources in the plan. The value is specified as a number greater than 0.

This profile option can be defined at the site level. You can update this value.

**MSO: Penalty Cost Factor for Late Demands**  Use this profile option to define a penalty cost factor common to all demands. The demands include sales orders, forecasts, and safety stock. The value is specified as a number greater than 0.

This profile option can be defined at the site level. You can update this value.

**MSO: Queue Time Factor**  This contains a factor by which to increase the item lead time in optimization, so that the lead time values are close to those used in the scheduling engine. Optimization lead time is padded to include queue time, etc. This value is specified as a number greater than or equal to 0.

**MSO: Substitute Item Penalty**  Use this profile option to define an internal penalty weight to use for substitute item objective in supply chain optimization. This value is specified as a number greater than 0. This is an internal value.

**MSO: Use Optimization Internal Time Aggregation**  This profile option indicates whether optimization should use more aggregated time buckets. Allowable values are 1 (Yes), 2 (No). The default value is 2.
Profile Options

Other Oracle ASCP Profile Options:

**MSC: Default Workbench Height**  This profile option is used to specify the default workbench height. This profile option can be defined at the site level.

**MSC: Default Workbench Width**  This profile option is used to specify the default workbench width. This profile option can be defined at the site level.

**MSC: Hour UOM**  This profile option is used to specify the unit of measure (UOM). The default value is HR. This profile option can be defined at the site level.

**MSC: Map Server Host**  This profile option is used to map server host. This profile option can be defined at the site level.

**MSC: Map Server Port**  This profile option is used to map server port. This profile option can be defined at the site level.

**MSC: Plan co-products**  This profile option is used to indicate if co-products will be planned. This profile option can be defined at the site level.

**MSC: Planning Currency**  This profile option is used to specify the planning currency. The default value is US dollar. This profile option can be defined at the site level.

**MSC: Sales Orders Offset Days**  The value of this profile option is specified as a number greater than 0. Collections will pick up the completed sales orders within the offset duration.

For example, if Sales Orders Offset Days is set to 90, then all the sales orders which have completed in the past 90 days will also be collected.

This profile option can be defined at the site level. You can update this value.

**MSC: Share Plan Partitions**  The profile option is added as a workaround for test/demo scenarios where you expect a lot of plans to be created by different testers and demonstrators. This profile option is not meant for production use by the customer. If you do decide to enable it, then the number of plan partitions parameter to the concurrent program mentioned above becomes irrelevant, since only one partition is created for a plan (you can enter 1 just to be safe).
**Profile Options**

---

**Note:** If the MSC:Share Plan Partitions profile is turned on, you need to run Create APS Partitions program afterwards so that it can create the partition that every plan will share.

---

**MSC:Sourcing Rule Category Set** This profile option is used to specify the sourcing rule category set. This profile option can be defined at the site level.

---

**ILOG CPLEX Solver Profile Options**

All the following profile options are included to better control the ILOG CPLEX solver. It is not expected that these will be changed often, and if they need to be changed, it will usually be with some input from development and ILOG support. They are included here only so that you may be aware that they exist in case a situation arises where they will need to be altered.

- **MSO: Check Redundant Constraints** This profile option specifies to check for redundant constraints and eliminate them. The allowable values for this profile option are 0, 1. This value is defaulted by CPLEX.

- **MSO: CPLEX Crash Parameter** This profile option is used to determine how objective coefficients are used to select basis. The allowable values are -1, 0, and 1. This value is defaulted by CPLEX.

- **MSO: CPLEX Refactor Rate** This profile option specifies the value of the parameter to control the refactor rate. The value of this profile option is specified as an integer greater than or equal to 0. This value is defaulted by CPLEX.

- **MSO: CPLEX Scaling Factor** This profile option contains the scaling factor in CPLEX. The allowable values for this profile option are -1, 0 and 1. This value is defaulted by CPLEX.

- **MSO: Dual Simplex Parameter** This profile option is a gradient parameter for dual simplex. The allowable values for this profile option are 0, 1, 2, 3, and 4. This value is defaulted by CPLEX.

- **MSO: Global Time Limit** This profile option is a parameter used to set the global time limit before stopping optimization. This value is specified as number greater than 0. This value is defaulted by CPLEX.
**MSO: List Size for Pricing Candidates**  This profile option is a parameter to set the list size for pricing candidates. This value is specified as an integer greater than 0. This value is defaulted by CPLEX.

**MSO: LP Constraint Batch Size**  This profile option is not currently used by the software. It is intended for future use as a performance tuning mechanism to adjust the batch size of data transfer from SCO LP output to CPLEX.

**MSO: LP Markowitz Coefficient**  This profile option is used to set the Markowitz Coefficient. The allowable value is any number between 0.0001 and 0.99999. This value is defaulted by CPLEX.

**MSO: Maximum Simplex Iterations**  This profile option is a parameter to set the maximum number of simplex iterations. The value is specified as an integer greater than 0. This value is defaulted by CPLEX.

**MSO: Preprocessing Aggregator Fill**  This profile option is the preprocessor aggregator fill. The value is specified as an integer greater than 0. This value is defaulted by CPLEX.

**MSO: Preprocessing Aggregator Limit**  This profile option is a parameter to control preprocessing aggregator limit. The value is specified as an integer greater than 0. This value is defaulted by CPLEX.

**MSO: Preprocessing Flag for LP Matrix**  This contains the presolve indicator. The allowable values are 0 and 1. This value is defaulted by CPLEX.

**MSO: Primal Simplex Parameter**  This profile option is a gradient parameter for primal simplex algorithm. The allowable values are -1, 0, 1, 2, 3, and 4. This value is defaulted by CPLEX.

**MSO: Simplex Feasibility Tolerance**  This profile option is a parameter to set the simplex feasibility tolerance. The value is specified as a number between e-9 and e-4. This value is defaulted by CPLEX.

**MSO: Simplex Optimality Tolerance**  This profile option is a parameter to set the optimality tolerance for the simplex algorithm. The value is specified as a number between e-9 and e-4. This value is defaulted by CPLEX.
**Profile Options**

**MSO: Simplex Perturbation Constant**  This profile option is a parameter to set the simplex perturbation constant. The value is specified as any number greater than e-8. This value is defaulted by CPLEX.

**MSO: Simplex Perturbation Indicator**  This profile option is a simplex perturbation parameter. The allowable values are 0 and 1. This value is defaulted by CPLEX.

**MSO: Simplex Perturbation Limit**  This profile option is a parameter for the simplex perturbation limit. The value is specified as an integer greater than 0. This value is defaulted by CPLEX.

**MSO: Simplex Perturbation Parameter**  This profile option provides a perturbation constant for CPLEX. This value sets the amount by which CPLEX perturbs the upper and lower bounds on the variables when a problem is perturbed. This parameter can be set to a smaller value if the default value creates too large of a change in the problem.

**MSO: Simplex Presolve Limit**  This profile option is a parameter to set the limit on the number of presolves. The allowable values are -1, 0, and any integer greater than 0. This value is defaulted by CPLEX.

**MSO: Simplex Singularity Repair Limit**  This profile option is a parameter to set the simplex singularity repair limit. The value is specified as an integer greater than 0. This value is defaulted by CPLEX.

**MSO: Solve Dual Problem**  This profile option controls whether CPLEX solves the dual problem or the primal problem. The allowable values are 0 and 1. This value is defaulted by CPLEX.

**Oracle ASCP Flexfield Attribute Profile Option**

These profile options store the name of the flexfield column that contains the value in the corresponding table. For example, if the Aggregate Resource Name is stored in column ATTRIBUTE1, the profile option MSC: Aggregate Resource Name Flexfield Attribute will contain the value 1.

This setup is only performed during application install, so it should not be modified unless it’s necessary.

**MSC: Aggregate Resource Name Flexfield Attribute**

**MSC: Cost of Using a BOM/ Routing Flexfield Attribute**
MSC: Demand Priority Flexfield Attribute: This profile option stores the value of the attribute column that will control the demand priority.

MSC: Priority for Substitute Items Flexfield Attribute

MSC: Priority of Alternate Resources for an Operation Flexfield Attribute

MSC: Resource Group for a Line Flexfield Attribute

MSC: Resource Type for an Operation Flexfield Attribute

MSC: Simultaneous Resource Sequence Flexfield Attribute

MSO: Penalty Cost Factor for Exceeding Item Material Capacity Flexfield Attribute

MSO: Penalty Cost Factor for Exceeding Material Capacity Flexfield Attribute

MSO: Penalty Cost Factor for Exceeding Org Material Capacity Flexfield Attribute

MSO: Penalty Cost Factor for Exceeding Org Resource Capacity Flexfield Attribute

MSO: Penalty Cost Factor for Exceeding Org Transportation Capacity Flexfield Attribute

MSO: Penalty Cost Factor for Exceeding Resource Capacity Flexfield Attribute

MSO: Penalty Cost Factor for Exceeding Transportation Capacity Flexfield Attribute

MSO: Penalty Cost Factor for Late Forecasts Flexfield Attribute

MSO: Penalty Cost Factor for Late Item Demands Flexfield Attribute

MSO: Penalty Cost Factor for Late Org Demands Flexfield Attribute

MSO: Penalty Cost Factor for Late Sales Orders Flexfield Attribute

MSO: Resource Group for the Line Flexfield Attribute

---

**Oracle Global Order Promising Profile Options**

**INV: Capable to Promise** This site level profile option determines how a promise date is derived. It can have the values shown in the following table:

<table>
<thead>
<tr>
<th>Value</th>
<th>Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Enable Product Family ATP and CTP</td>
</tr>
<tr>
<td>2</td>
<td>Enable Product Family ATP</td>
</tr>
<tr>
<td>3</td>
<td>Enable ATP</td>
</tr>
</tbody>
</table>
Profile Options

<table>
<thead>
<tr>
<th>Value</th>
<th>Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>ATP/CTP Based on Planning Output (*)</td>
</tr>
<tr>
<td>5</td>
<td>ATP Based on Collected Data (*)</td>
</tr>
</tbody>
</table>

(*) new setting for this release

You can update this profile at the site level.

**INV: External ATP** Set this profile option in the Source instance if the Source is 10.7 or 11.0 instance. If Global ATP is selected, the system uses the new Global Order Promising program. If None is selected, the system uses the old ATP program.

You can update this profile at the site level. If no value is selected, the system assumes None for 10.7/11.0 instance and Global ATP for 11i instance.

**MRP: Calculate Supply Demand** Use this profile option to control whether you want to calculate Supply Demand for Order Promising check. The default value is Yes. You can update this profile at the user level.

**MRP: ATP Assignment Set** Use this profile option to indicate the name of the assignment set to use for Supply Chain Order Promising. You can update this profile at the site level in the Source instance.

**MRP: ATP Database Link** Use this profile to determine if distributed Order Promising is used or not. You can update this profile at the site level.

**MRP: Include Substitute Components** Use this profile option to indicate whether to include substitute components in Order Promising calculation. If no value is entered, the systems assumes No. You can update this profile at the site level.

**MSC: ATP Debug Mode** Use this profile option to indicate whether to enable debug messages within Oracle Global Order Promising. If no value is entered, the system assumes No. You can update this profile at the user level.

**MSC: Enable Allocated ATP** Use this profile options to indicate if Allocated Order Promising is used or not. If no value is entered, the system assumes No. You can update this profile at the site level.
MSC: Enable Allocated ATP Workflow  Use this profile option to indicate if Allocated ATP Workflow is used or not. If no value is entered, the system assumes No. You can update this profile at the user level.

MSC: ATP Assignment Set  Use this profile option to indicate the name of the assignment set to use for Global Order Promising. You can update this profile at the site level in the Planning instance.

MSC: Class Hierarchy  Use this profile to indicate which allocation hierarchy to use. There are two values for this profile:

- Demand Class: this hierarchy is a user-defined, single-level hierarchy
- Customer Class: this hierarchy has three levels: customer class, customer, and site.

If no value is entered, the system assumes Demand Class. You can update this profile at the site level.

MRP: Set Category for Backlog Form  Use this profile option to indicate which items belonging to this category set will be displayed in the Backlog Scheduling Workbench tree navigator. If no value is entered, no items are displayed in the Backlog Scheduling Workbench tree navigator. You can update this profile at the site level.

Oracle Inventory Optimization Profile Options

In addition to using ASCP Optimization profile options, Inventory Optimization uses the following profile options:

MSR: Safety Stock Holding Strategy  This profile option specifies where safety stock should be held when the carrying cost is the same for an item in the destination organization and a source organization. A value of 0 causes the safety stock to be held at the destination organization. A value of 1 causes the safety stock to be held at the source organization. The default value is 0.

MSR: Postponement Factor  This profile option specifies the maximum depth in the BOM and sourcing tree to which uncertainty (and hence safety stock) needs to be postponed. Any value greater than or equal to 0 is valid. The default value is 10.

MSR: Probability Distribution Type  This profile option is used to determine the type of probability distribution associated with forecast sets as input to Inventory Optimization. There are two options:
- Probabilities: Demand uncertainty is stated in terms of a (non-cumulative) probability distribution.
- Cumulative Probabilities: Demand uncertainty is stated in terms of a cumulative probability distribution.

The default value is Probabilities.
Topics covered in this appendix include:

- Oracle ASCP Flexfields on page B-2
- Applying Flexfields to Different Versions of Oracle RDBMS on page B-3
Oracle ASCP Flexfields

The following flexfields are used to enter penalty cost data at the appropriate levels for independent demands, items, and resources.

**Penalty Cost Factor for Late Demands (at the demand level)** Defined via a flexfield in the Forecast Items form (for forecasts) or in the Scheduling region of the Sales Orders form (for sales orders). This will be stored in the table OE_ORDER_LINES_ALL and MRP_FORECAST_DATES.

**Penalty Cost Factor for Late Demands (at the item level)** Defined via a flexfield in the Items form. This will be stored in the table MTL_SYSTEM_ITEMS.

**Penalty Cost Factor for Late Demands (at the org level)** Defined via a flexfield in the Organizations Parameters form. This will be stored in the table MTL_PARAMETERS.

**Penalty Cost Factor for Exceeding Material Capacity (at the item/vendor level)** Defined via a flexfield in the Supplier-Item Attributes form (in the header region). It will be stored in PO_ASL_ATTRIBUTES.

**Penalty Cost Factor for Exceeding Material Capacity (at the item level)** Defined via a flexfield in the Items form. It will be stored in MTL_SYSTEM_ITEMS.

**Penalty Cost Factor for Exceeding Material Capacity (at the org level)** Defined via a flexfield in the Organizations Parameters form. This will be stored in the table MTL_PARAMETERS.

**Penalty Cost Factor for Exceeding Resource Capacity (at the resource level)** Defined via a flexfield in the Department Resources form. This will be stored in the table BOM_DEPARTMENT_RESOURCES.

**Penalty Cost Factor for Exceeding Resource Capacity (at the org level)** Defined via a flexfield in the Organizations Parameters window. This will be stored in the table MTL_PARAMETERS.

**Penalty Cost Factor for Exceeding Transportation Cap. (ship method level)** Defined via a flexfield in the Inter-location Transit Times form. It will be stored in MTL_INTERORG_SHIP_METHODS.
Penalty Cost Factor for Exceeding Transportation Capacity (at the org level) Defined via a flexfield in the Organizations Parameters form. This will be stored in the table MTL_PARAMETERS.

Other APS flexfields are:

Aggregate Resource for a Resource This is defined via a flexfield in the Department Resources form. It is based on the existing flexfield ‘Aggregate Resource Id’. It is stored in the table BOM_DEPARTMENT_RESOURCES.

Priority for Substitute Items This is defined in the Substitute Components form. This is stored in the table BOM_SUBSTITUTE_COMPONENTS.

Priority for MDS Entries This is defined via a flexfield in the Master Demand Schedule Entries form. It is stored in the table MRP_SCHEDULEDATES.

Service Level (at the item level) This is defined via a flexfield in the Items form. It is stored in the table MTL_SYSTEM_ITEMS.

Service Level (at the org level) This is defined via a flexfield in the Organization Parameters form. It is stored in the table MTL_PARAMETERS.

Service Level (at the customer level) This is defined via a flexfield in the Customer Entries form. It is stored in the table RACUSTOMERS.

The following three are for 10.7 and 11.0 and 11.i.1 sources only. For 11.i.2 and beyond, they are in the forms for routings in the source.

Simultaneous Resource Sequence This is defined via a flexfield in the Operation Resources form. This is stored in the table BOM_OPERATION_REROURCES.

Alternate Resources for an Operation This is defined via a flexfield in the Operation Resources form. It is stored in the table BOM_OPERATION_REROURCES.

Priority of Alternate Resources for an Operation This is defined via a flexfield in the Operation Resources form. This is stored in the table BOM_OPERATION_REROURCES.

Applying Flexfields to Different Versions of Oracle RDBMS

All flexfields are applied as a set to the following releases of the Oracle RDBMS:
Applying Flexfields to Different Versions of Oracle RDBMS

- 10.7
- 11
- 11i

In each case, Oracle ASCP and Oracle Global Order Promising checks to whether you have existing flexfield. If you do, it does not overwrite your existing settings.

Transportation Capacity

Oracle ASCP and Oracle Global Order Promising R11i provides fields in the Inter-Location Transit Time window for setting load weight and load volume. These fields are not available in Releases 10.7 and 11.0. You should use flexfields to set these values when running either Release 10.7 or 11.0.

Creating Demand Priority Flexfield Numbers Manually

To Create Demand Priority Flexfield Number Manually

For 11 and later

1. From sysadmin responsibility, navigate to Application > Flexfields > Descriptive > Segments.
2. Double-click Segments.
   The Descriptive Flexfield Segments window appears.
3. For the Application field, click Find and select Oracle master Scheduling/MRP MRP_SCHEDULE_DATES.
4. Click Segments.
   The Segments Summary window appears.
5. Click New.
   Fill in the fields as shown in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Demand Priority</td>
</tr>
<tr>
<td>Window Prompt</td>
<td>Demand Priority</td>
</tr>
</tbody>
</table>
Applying Flexfields to Different Versions of Oracle RDBMS

6. Click Value Set.
   The Value Set window appears.

7. For Value Set Name, click Find.
   The Find Value Sets window appears.

8. From list of values, select 7/Number.

9. Click OK.

To create Profile
1. Changes responsibility to Application Developer. Select Profile.
2. Fill in the fields as shown in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column</td>
<td>Pick a right attribute column &lt;attribute col&gt; (attribute 10 for example)</td>
</tr>
<tr>
<td>Number</td>
<td>1</td>
</tr>
</tbody>
</table>

3. Save and close this window.
4. Switch responsibilities back to System Administrator.
5. Select Profile > System.
   The Find System Profile Values screen appears.
6. In the Profile field, find the Profile MRP_DMD_PRIORITY_FLEX_NUM from the List of Values.
7. Click Site.
8. Click Find.
Applying Flexfields to Different Versions of Oracle RDBMS

The System Profile Values screen appears.

9. In the site column, enter the number 10 (or whatever number you chose for column).
Topics covered in this appendix include:

- Overview of the Order Backlog Workbench on page C-2
Overview of the Order Backlog Workbench

The Order Backlog Workbench is a powerful graphic tool that enables you to easily manage existing order lines you wish to reschedule. This workbench is especially useful when a significant issue such as item availability occurs within your supply chain, manufacturing line, or distribution chain, and you need to react rapidly to reschedule groups of order lines affected by the item availability.

Once you have selected orders for scheduling, using system processing constraints and user defined controls, order lines are processed in a simulated scheduling mode and then presented for your review.

Note: You must first select and schedule order lines before you can navigate to the Order Backlog Workbench. For a complete list of the steps required for scheduling order lines with the Order Backlog Workbench, refer to the Order Backlog Scheduling Process.

During the review process, you can:

- Take actions based upon system exceptions or errors resulting from simulated scheduling
- Update or modify the simulated scheduled dates or source organizations for order lines presented
- Choose to accept or cancel all simulated order line scheduling information
- Choose to firm selected order lines for simulated rescheduling
- Choose to pick (accept) selected order line simulation results
- View Global Order Promising Pegging Detail information
- Reschedule order lines information presented in simulated schedule mode again

Once you are satisfied with your scheduling simulation results, save your changes and your new order line scheduling information is updated for order lines selected.

Order Backlog Scheduling Process

1. Define Priority Rules.

- Priority Rules to determine the processing order used when scheduling orders through the scheduler.
2. Define scheduling Sequence Rules.
   - Sequence Rules determine the actual processing order used by the scheduler during order lines scheduling.

3. Define Filter Criteria
   - Filter Criteria enables you to determine order line selection criteria for scheduling within the Order Backlog Workbench.

4. Schedule Orders using the Order Backlog Workbench
   a. Simulate Order Scheduling
      View scheduling simulation results by:
      * Exceptions
      * Order Number
      * Organization/Item
   b. Choose to:
      * Firm all or selected simulated order lines scheduling results.
      * Pick all or selected simulated order lines scheduling results.
      * Save all scheduling simulation results.
      * Cancel all scheduling simulation results.
      * Modify simulated order line schedule dates or source org’s (organizations) fields and re-simulate scheduling based upon modifications made, performing any of the functions previously listed, until satisfied.

5. Save your work. Once your simulation work is saved, simulated order line schedule dates and sources become the scheduled date and source organization for all order lines selected.
Overview of the Order Backlog Workbench

Order Backlog Workbench User Interface
The Order Backlog Workbench consists of three panes within a window:

- Navigator Tree
- Reschedule Lines Results
- Order Line Pegging Information

Navigator Tree
The Navigator tree controls the display of information for the Reschedule Lines Results and Order Line Pegging panes within the Workbench. Drill down to different levels within the Exception, Order, or Items tab to view order line and pegging information in their respective panes.

Exceptions Tab
The Exceptions tab is the default tab displayed within the Navigation Tree pane upon system display of the Order Backlog Workbench. This tab displays a tree containing order line exceptions that occurred during simulated scheduling.
Exceptions are grouped and displayed by exception type, and a corresponding number is displayed to the right of each exception tree node to denote the number of occurrences for each of the exception types that occurred during simulated scheduling.

**Exception Tree Drill Down Details**

- Exceptions
  - Exception Folder Name
  - Order Number

**Orders Tab** The Orders tab displays a folder tree of all orders selected for simulated scheduling. Orders within this folder tree are displayed in the ascending order.

**Order Tree Folder Drill Down Details**

- Sales Orders
  - Order Number
  - Independent Lines (order lines)

**Items Tab** The Items tab displays a folder tree of all items contained within order lines that were selected for simulated scheduling. Items are displayed in alpha numeric sort of the organization to which they were scheduled against.

**Item Tree Folder Drill Down Details**

- Organizations
  - Organization Name
    - Product Families
      - Product Family
    - Categories
      - Item Category Sets
        - Item Category Set code combinations
Reschedule Lines Results
The Reschedule Lines Results pane is used to display order line information based upon cursor placement within the Navigator pane.

If the Item field is highlighted in yellow, simulated scheduling encountered an error during processing, and the order line was not modified in any way. Specific scheduling error messages can be seen in the Error column.

The Reschedule Lines Results pane displays the following order line information:

- Pick check box
- Firm check box
- Item
- Order line number
- Quantity ordered
- Order line UOM
- Ship from Org (organization)
- Ship Date (Scheduled Date)
- Scheduled Arrival Date
- Available Quantity
- Group Ship Date
- Group Arrival Date
- Request Date Quantity
- Requested Ship Date
- Requested Arrival Date
- Firm Source Org (organization)
- Firm Ship Date
- Firm Arrival Date
- Latest Acceptable Date
- Ship Method
- Lead Time
- Demand Class
Overview of the Order Backlog Workbench

- Ship set
- Arrival Set
- Customer
- Location (Customer Site)
- Status (Order line status)
- Error

**Order Line Pegging**
The Order Line Pegging Information pane displays pegging information based upon the cursor location within the Navigator tree.

**Note:** If there is no information contained within the Pegging Information window based upon the cursor location within Order Backlog Workbench:

- Entity referenced within the Navigator tree is not related to pegging, such as Organization.
- The item/order line that is referenced is not ATP enabled.
- The item/order line does not currently reside in Global Order Promising collection tables.

Selecting a node element within the Order Line Pegging pane and then selecting the Details button will display the Global Order Promising Details window.

For more information on the Global Order Promising Detail window, see Oracle Advanced Planning (APS) and Scheduling and Global Order Promising User Guide.

**Selection Criteria for Scheduling with the Order Backlog Workbench**

**Prerequisite**
You must define at least one Sequencing Rule (priority rule) prior to utilizing the Order Backlog Workbench.

**Priority Rules**
Oracle APS utilizes Priority Rules to determine the processing order used when scheduling orders through the scheduler.

- You can choose to define a default scheduling order processing Priority Rule.
- You can choose to disable a Priority Rule.
- You can also choose to define single or multiple criteria within a priority rule to further define the processing order the scheduler will utilize during line scheduling.

Priority Rules are not instance specific, and are defined by selecting specific criteria that will determine the order input to the scheduler.

**Note:** At least one priority rule must be defined prior to utilizing the Order Backlog Workbench for scheduling.

**To define Priority Rules:**

1. From an APS Responsibility, navigate to the Define Priority Rules window.

2. Enter the Name for the Priority Rule.
3. Enter a Description for the Priority Rule.
4. Select the Enabled check box to enable the priority rule to be utilized by the scheduler.
5. Choose to establish whether the priority rule will be used as the default priority rule used during scheduling execution.

Select the Default check box to use the priority rule as the default rule.

---

**Note:** If another priority rule has been defined as the Default Priority Rule, and you select the Default check box, you will be presented with a decision box asking if you wish to update the current default priority rule to the rule you are currently modifying. Select Yes to update your default Priority Rule.

---

6. Select the Priority Rule criteria name in the Criteria Name field. Valid values are:

- Gross Margin
- Promise Date
- Request Date
- Sales Order and MDS Entities priority
- Scheduled Date

7. Select the criteria processing order the scheduler will use when scheduling order lines. Enter a numeric value in the Criteria Priority field.

8. Save your work.

---

**Note:** Once a Priority Rule has been successfully saved, you can only update the following information:

- Enabled check box
- Default check box

You may, however, choose to add additional criteria to the Priority Rule.

---

To schedule orders using the Order Backlog Workbench:

1. Navigate to the Order Backlog Workbench.

The Schedule Orders window appears.
2. Determine your order selection (filter criteria) for scheduling:
   - Select the Filter Criteria Name and proceed to Step 3 or
   - Select the Filter Criteria Name you wish to modify and select the Create/Edit button or
   - Select the Create/Edit button if you wish to enter new filter criteria information.
   The Criteria folder window appears.

Create your order selection criteria for scheduling. Order selection is determined by current order line status and the Filter Criteria you define.
Overview of the Order Backlog Workbench

---

**Note:** Order lines that have a current status of Shipped or Cancelled are not selected for simulated scheduling.

Order lines whose source is External (i.e. Drop ship order lines) are also not selected for simulated scheduling.

---

The Schedule Orders window utilizes Oracle Applications Folder technology to save Filter Criteria for reuse. Users can choose to create filter criteria and save it to a folder, or query an existing folder and modify the Filter Criteria. However, you are not allowed to enter Filter Criteria for scheduling without first saving the criteria to a folder.

a. Either edit the Filter Criteria for the folder selected, or enter new filter criteria. Select the Field name. Valid values are:

* Task
* Customer
* Item Name
* Order Number
* Project Number
* Promise Date
* Requested Arrival Date
* Requested Ship Date
* Scheduled Arrival Date
* Scheduled Shipped Date
* Ship from org

b. Select an operator for your criteria. Valid values are:

* Equals
* Is Not (equal)
* Less Than
* At most
* At Least
* Greater than
* Between
* Outside
* Is empty
* Is entered
* Among

c. Choose to further define your query criteria values by entering limiting values in the From and To fields. Enter values appropriate to the Field Name selected.

For example, if you are interested in displaying order lines that have a scheduled order date two weeks from today, enter the present date in the From field, and a date two weeks from the present date in the To field.

d. Save your work to a folder. From the File menu, select Save As to save your folder. When you save your folder, there are several options available. Once you have saved your folder, close the Criteria window.

For more information on using folders within Oracle Order Management, see Oracle Order Management User’s Guide, Private Folders.

For more information on folder options, see Oracle Applications Users Guide, Folders.


4. Choose whether to overwrite or preserve all existing source organizations for current order line sources during scheduling.
   - Select No to use current order line source information. Use existing sourcing rules and priority rules to determine order line schedule date.
   - Select Yes to overwrite current order line source information. Use any source for your order, based upon sourcing and priority rules for scheduling, and use the modified sourcing information during scheduling to determine order line scheduled date.
5. Choose to manually sequence the processing order during scheduling for your order lines or allow the system to schedule your order lines based upon the sequencing rule chosen by selecting the Manual Sequence button.

**Note:** If you choose to allow the system to process order lines by the Sequencing Rule chosen, proceed to Step e.

The Manual Sequence button enables a user, based upon query criteria, to schedule, sequence, Firm, or delete order lines selected for rescheduling.

a. Once you select Manual Sequence, the system will query open sales orders (based upon filter criteria) that contain order lines and then present them for display in based upon the Sequencing Rule selected.

b. Choose to Firm current order line information: Select the Firm check box if you do not want a particular order line processing sequence to be modified when selecting Apply.

For example, suppose you update sequence 1 to sequence 5, sequence 6 to sequence 8, and select the Firm check box for sequence 2. Once the Apply
button is selected, the order line associated with sequence 2 remains sequence 2.

If the Firm check box for sequence 2 had not been selected, then, based upon your user changes, the order line originally associated with sequence 2 could possibly be changed because of your re-sequencing.

c. Choose to update order processing sequence during reschedule. Select the line you wish to modify, then update the sequence number assigned to the order line.

d. Select Apply. This will save your new order line sequence to be used during rescheduling.

e. Select Schedule to initiate simulated order line scheduling. While scheduler is running, the user is presented with a Progress window to track the reschedule process.

The Progress Window continually updates a user as to the progress of rescheduling concurrent program. The following information is displayed:

- **Total Lines #**: Total order lines selected for scheduling
- **Remaining**: Total order lines remaining to be scheduled
- **Time Remaining**: Total time remaining to process order lines currently not scheduled
- **Complete**: Total order lines current completed scheduling.

- **Progress Indicator Bar**: An indicator bar that graphically displays the current order lines scheduled as a percentage of the total order lines selected for scheduling.

  Once the indicator bar reaches 100% and the Remaining field displays 0, the Ok button is enabled. Select the button to display scheduling results.

  Results are presented within the Order Backlog Workbench.

### Scheduling Order Lines with the Order Backlog Workbench

Once order lines have been scheduled and processed, users are presented with the Order Backlog Workbench, a graphical user interface that enables a user to review, manage, and process simulated order line scheduling results.

1. Review the following reschedule exceptions generated during rescheduling process:
   - Item Shortage
   - Insufficient Margin
   - Modified Source
   - Later Than Old Schedule Date
   - Later than Promise Date
   - Later than Request Date

2. Choose to modify the schedule date and source org’s (organizations) fields for order lines prior to selecting the Pick check box.

3. Choose to accept current order line scheduling information. Select the Pick check box if you wish to schedule the order line.

   You must select the Pick check box if you wish to accept the simulated scheduling information for each order line. Once you select the Pick check box, the Firm check box is also enabled.

4. Choose to Firm current order line information.

   Select the Firm check box if you:
   - Want to accept current simulation scheduling information for an order line.
   - Do not want a particular order line to be modified during any additional simulated rescheduling that may occur within the workbench for the
current workbench simulation session. See: Rescheduling Within the Order Backlog Workbench.

**Note:** If you do not select the Firm check box, when you save your changes, the simulated order line scheduling information is discarded. Your current order line scheduling information is not updated.

5. Choose to view Global Order Promising Details. If Global Order Promising information is available for an item/order line, the Details button will be enabled. Select Details to be presented with the Global Order Promising details window to review supply/demand and horizontal planning details. For more information on the Global Order Promising details window, see Oracle APS and Global Order Promising User Guide.

   - You may modify only the Schedule Date and Source Org (organization) fields for an order line.
   - You may choose to Firm an order line or group of order lines, and then process new a new scheduling simulation using the current order line information by selecting Reschedule. See: Rescheduling Within the Order Backlog Workbench.

7. Accept simulated scheduling recommendations. Select Save. Once you select Save, all simulated scheduling results for order lines that have the Pick check box enabled are committed to the database. The Order Backlog Workbench closes, and the user is presented with the Schedule Orders window.

**Note:** For order lines that have a current Exception Type of Shortage, the old schedule date is preserved. Simulated scheduling information for order lines without the Pick check box enabled are discarded, irrespective of the Firm check box setting.

Simulated scheduling information is discarded, order line information is not updated within the database, the Order Backlog Workbench closes, and the user is presented with the Schedule Orders window.
Rescheduling Within the Order Backlog Workbench

The Backlog Orders Workbench enables a user to continue to reschedule order lines based upon data contained for the last saved simulation of scheduling.

You may initially select a group of order lines with your Filter Criteria for simulation scheduling, and then, when presented with the results, choose to firm or modify a subset of your original order lines, and then run a new simulation based upon this data. You can repeatedly reschedule the information presented until satisfied.

Reschedule Order Line Simulation Data Process

1. Define scheduling Sequence Rules.
   - Determine initial order line processing sequence during simulated scheduling.

2. Define Filter Criteria
   - Determine Selection criteria for scheduling with the Order Backlog Workbench.
     a. Simulate Order Scheduling
        - Choose to:
          * Manually sequence, delete, firm, and simulate order line scheduling or
          * Simulate order line scheduling for all order line selected by your Filter Criteria.

3. Reschedule Order lines
   - Choose to:
     * Modify order line schedule dates or source org’s (organizations) fields.
     * Firm order lines.
     * Pick order lines.

4. Select Reschedule.

5. Proceed back to Step 3 until satisfied.
6. Save your work. Select Save.

Note: If, at any time during the rescheduling of simulated order line information, you decide your last simulation results were more acceptable than the current order line information displayed, select Cancel.
This appendix contains the following:

- Setup Data Control Files on page D-2
- Supplies Control Files on page D-3
- Demand Control Files on page D-3
- User-Defined Keys (UDK) on page D-4
Setup Data Control Files

The following table shows the setup data control files.

<table>
<thead>
<tr>
<th>Business Object</th>
<th>Flat File Loader’s File Name Option</th>
<th>Control Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bill of Materials</td>
<td>Bills of Material Headers</td>
<td>MSC_ST_BOMS.ctl</td>
</tr>
<tr>
<td>Bill of Materials</td>
<td>Bills of Material Components</td>
<td>MSC_ST_BOM_COMPONENTS.ctl</td>
</tr>
<tr>
<td>Bill of Materials</td>
<td>Component Substitutes</td>
<td>MSC_ST_COMPONENT_SUBSTITUTES.ctl</td>
</tr>
<tr>
<td>Items</td>
<td>Items</td>
<td>MSC_ST_SYSTEM_ITEMS.ctl</td>
</tr>
<tr>
<td>Routings</td>
<td>Routings</td>
<td>MSC_ST_ROUTINGS.ctl</td>
</tr>
<tr>
<td>Routings</td>
<td>Routing Operations</td>
<td>MSC_ST_ROUTING_OPERATIONS.ctl</td>
</tr>
<tr>
<td>Routing</td>
<td>Operation Resources</td>
<td>MSC_ST_OPERATION_RESOURCES.ctl</td>
</tr>
<tr>
<td>Resources</td>
<td>Resources</td>
<td>MSC_ST_DEPARTMENT_RESOURCE.ctl</td>
</tr>
<tr>
<td>Resource</td>
<td>Resource Availability</td>
<td>MSC_ST_RESOURCE_CHANGES.ctl</td>
</tr>
<tr>
<td>Resource</td>
<td>Resource Shifts</td>
<td>MSC_ST_RESOURCE_SHIFTS.ctl</td>
</tr>
<tr>
<td>Resource</td>
<td>Resource Groups</td>
<td>MSC_ST_RESOURCE_GROUPS.ctl</td>
</tr>
<tr>
<td>Projects and tasks</td>
<td>Project Tasks</td>
<td>MSC_ST_PROJECT_TASKS.ctl</td>
</tr>
<tr>
<td>Unit of Measure</td>
<td>Units of Measure</td>
<td>MSC_ST_UNITS_OF_MEASURE.ctl</td>
</tr>
<tr>
<td>Unit of Measure</td>
<td>Units of Measure Class Conversions</td>
<td>MSC_ST_UOM_CLASS_CONVERSIONS.ctl</td>
</tr>
<tr>
<td>Unit of Measure</td>
<td>Units of Measure Conversions</td>
<td>MSC_ST_UOM_CONVERSIONS.ctl</td>
</tr>
<tr>
<td>Item Categories</td>
<td>Category Sets</td>
<td>MSC_ST_CATEGORY_SETS.ctl</td>
</tr>
<tr>
<td>Item Categories</td>
<td>Item Categories</td>
<td>MSC_ST_ITEM_CATEGORIES.ctl</td>
</tr>
<tr>
<td>Sourcing Rules</td>
<td>Item Sourcing</td>
<td>MSC_ST_ITEM_SOURCING.ctl</td>
</tr>
<tr>
<td>Sourcing Rules</td>
<td>Inter Org Shipment Method</td>
<td>MSC_ST_INTERORG_SHIP_METHODS.ctl</td>
</tr>
<tr>
<td>Calendars</td>
<td>Calendars</td>
<td>MSC_STCALENDARS.ctl</td>
</tr>
<tr>
<td>Calendar</td>
<td>Workday Patterns</td>
<td>MSC_ST_WORKDAY_PATTERNS.ctl</td>
</tr>
<tr>
<td>Calendar</td>
<td>Shift Times</td>
<td>MSC_ST_SHIFT_TIMES.ctl</td>
</tr>
<tr>
<td>Calendar</td>
<td>Calendar Exceptions</td>
<td>MSC_STCALENDAR_EXCEPTIONS.ctl</td>
</tr>
<tr>
<td>Calendar</td>
<td>Shift Exceptions</td>
<td>MSC_ST_SHIFT_EXCEPTIONS.ctl</td>
</tr>
<tr>
<td>Resource Demand</td>
<td>Resource Requirements</td>
<td>MSC_STRESOURCE_REQUIREMENTS.ctl</td>
</tr>
</tbody>
</table>
### Supplies Control Files

The following table shows the control files for supplies.

<table>
<thead>
<tr>
<th>Business Object</th>
<th>Flat File Loader’s File Name Option</th>
<th>Control Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supplier Capacity</td>
<td>Item Suppliers</td>
<td>MSC_ST_ITEM_SUPPLIERS.ctl</td>
</tr>
<tr>
<td>Supplier Capacity</td>
<td>Supplier Capacities</td>
<td>MSC_ST_SUPPLIER_CAPACITY.ctl</td>
</tr>
<tr>
<td>Supplier Capacity</td>
<td>Supplier Flex Fences</td>
<td>MSC_ST_SUPPLIER_FLEX_FENCES.ctl</td>
</tr>
<tr>
<td>Trading Partners</td>
<td>Trading Partners</td>
<td>MSC_ST_TRADING_PARTNERS.ctl</td>
</tr>
<tr>
<td>Trading Partners</td>
<td>Trading Partner Sites</td>
<td>MSC_ST_TRADING_PARTNER_SITES.ctl</td>
</tr>
<tr>
<td>Trading Partners</td>
<td>Location Associations</td>
<td>MSC_ST_LOCATION_ASSOCIATIONS.ctl</td>
</tr>
<tr>
<td>Trading Partners</td>
<td>Sub Inventories</td>
<td>MSC_ST_SUB_INVENTORIES.ctl</td>
</tr>
<tr>
<td>Supply Chain People</td>
<td>Partner Contacts</td>
<td>MSC_ST_PARTNER_CONTACTS.ctl</td>
</tr>
<tr>
<td>Demand Class</td>
<td>Demand Class</td>
<td>MSC_ST_DEMAND_CLASSES.ctl</td>
</tr>
</tbody>
</table>

### Demand Control Files

The following table shows demand control files.

<table>
<thead>
<tr>
<th>Business Object</th>
<th>Flat File Loader’s File Name Option</th>
<th>Control Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales Orders</td>
<td>Sales Order Demands</td>
<td>MSC_ST_SALES_ORDERS.ctl</td>
</tr>
<tr>
<td>Demand Forecast</td>
<td>Forecast Demands</td>
<td>MSC_ST_DEMANDS_FORECAST.ctl</td>
</tr>
</tbody>
</table>
User-Defined Keys (UDK)

COMPANY_NAME is required only if SCE is installed. For standalone APS, this is defaulted to -1.

The following table shows user-defined keys for various business objects.

<table>
<thead>
<tr>
<th>Business Object</th>
<th>Flat File Loader’s File Name Option</th>
<th>Control Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand Forecast</td>
<td>Forecast Designators</td>
<td>MSC_ST_DESIGNATORS_FORECAST.ctl</td>
</tr>
<tr>
<td>Master Demand Schedule</td>
<td>Demand Schedule Demands</td>
<td>MSC_ST_DEMANDS_MDS.ctl</td>
</tr>
<tr>
<td>Master Demand Schedule</td>
<td>Demand Schedule Designators</td>
<td>MSC_ST_DESIGNATORS_MDS.ctl</td>
</tr>
<tr>
<td>Work Order Component Demand</td>
<td>Work Order Component Demands</td>
<td>MSC_ST_DEMANDS_WORK_ORDER.ctl</td>
</tr>
<tr>
<td>Safety Stocks</td>
<td>Safety Stocks</td>
<td>MSC_ST_SAFETY_STOCKS.ctl</td>
</tr>
<tr>
<td>Reservations</td>
<td>Reservations</td>
<td>MSC_ST_RESERVATIONS.ctl</td>
</tr>
</tbody>
</table>

**User-Defined Keys (UDK)**

COMPANY_NAME is required only if SCE is installed. For standalone APS, this is defaulted to -1.

The following table shows user-defined keys for various business objects.

<table>
<thead>
<tr>
<th>Business Object</th>
<th>Table</th>
<th>User-Defined Key (UDK)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
<td>MSC_ST_SYSTEM_ITEMS</td>
<td>SR_INSTANCE_CODE, ORGANIZATION_CODE, ITEM_NAME, COMPANY_NAME</td>
</tr>
<tr>
<td>BOM</td>
<td>MSC_ST_BOMS</td>
<td>SR_INSTANCE_CODE, ORGANIZATION_CODE, BOM_NAME (defaulted from ASSEMBLY_NAME if Null), ASSEMBLY_NAME, ALTERNATE_BOM_DESIGNATOR (null allowed), COMPANY_NAME</td>
</tr>
<tr>
<td>BOM</td>
<td>MSC_ST_BOM_COMPONENTS</td>
<td>SR_INSTANCE_CODE, ORGANIZATION_CODE, BOM_NAME (defaulted from ASSEMBLY_NAME if Null), ASSEMBLY_NAME, ALTERNATE_BOM_DESIGNATOR (can be null), OPERATION_SEQ_CODE (if null or character would be defaulted to 1), COMPONENT_NAME, EFFECTIVITY_DATE, DISABLE_DATE (can be null), COMPANY_NAME</td>
</tr>
<tr>
<td>Business Object</td>
<td>Table</td>
<td>User-Defined Key (UDK)</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>BOM</td>
<td>MSC_ST_COMPONENT_SUBSTITUTES</td>
<td>SR_INSTANCE_CODE, ORGANIZATION_CODE, BOM_NAME (defaulted from ASSEMBLY_NAME if Null), ASSEMBLY_NAME, ALTERNATE_BOM_DESIGNATOR (can be null), OPERATION_SEQ_CODE (if null or character would be defaulted to 1), COMPONENT_NAME, SUB_ITEM_NAME, COMPANY_NAME</td>
</tr>
<tr>
<td>Categories</td>
<td>MSC_ST_CATEGORY_SETS</td>
<td>SR_INSTANCE_CODE, CATEGORY_SET_NAME, COMPANY_NAME</td>
</tr>
<tr>
<td>Categories</td>
<td>MSC_ST_ITEM_CATEGORIES</td>
<td>SR_INSTANCE_CODE, ORGANIZATION_CODE, CATEGORY_SET_NAME, CATEGORY_NAME, ITEM_NAME, COMPANY_NAME</td>
</tr>
<tr>
<td>UOM</td>
<td>MSC_ST_UNITS_OF_MEASURE</td>
<td>UOM_CODE, UNIT_OF_MEASURE (if null would be defaulted by UOM_CODE), COMPANY_NAME</td>
</tr>
<tr>
<td>UOM</td>
<td>MSC_ST_UOM_CLASS_CONVERSIONS</td>
<td>ITEM_NAME, FROM_UOM_CODE, FROM_UNIT_OF_MEASURE (defaulted from FROM_UOM_CODE if null), TO_UOM_CODE, TO_UNIT_OF_MEASURE, (defaulted from TO_UOM_CODE if null), COMPANY_NAME</td>
</tr>
<tr>
<td>UOM</td>
<td>MSC_ST_UOM_CONVERSIONS</td>
<td>ITEM_NAME, UOM_CODE, UNIT_OF_MEASURE (defaulted from UOM_CODE if null), COMPANY_NAME</td>
</tr>
<tr>
<td>Demand Class</td>
<td>MSC_ST_DEMAND_CLASSES</td>
<td>SR_INSTANCE_CODE, DEMAND_CLASS, COMPANY_NAME</td>
</tr>
<tr>
<td>Resources</td>
<td>MSC_ST_DEPARTMENT_RESOURCES</td>
<td>SR_INSTANCE_CODE, ORGANIZATION_CODE, RESOURCE_CODE, DEPARTMENT_CODE, COMPANY_NAME</td>
</tr>
<tr>
<td>Resources</td>
<td>MSC_ST_RESOURCE_SHIFTS</td>
<td>SR_INSTANCE_CODE, ORGANIZATION_CODE, RESOURCE_CODE, DEPARTMENT_CODE, SHIFT_NAME, COMPANY_NAME</td>
</tr>
</tbody>
</table>
## User-Defined Keys (UDK)

### Business Object | Table | User-Defined Key (UDK)
--- | --- | ---
Resources | MSC_ST_RESOURCE_CHANGES | SR_INSTANCE_CODE, ORGANIZATION_CODE, RESOURCE_CODE, DEPARTMENT_CODE, SHIFT_NUM, FROM_DATE, TO_DATE, FROM_TIME, TO_TIME, SIMULATION_SET, ACTION_TYPE, COMPANY_NAME
Resources | MSC_ST_RESOURCE_GROUPS | SR_INSTANCE_CODE, COMPANY_NAME, GROUP_CODE
Routings | MSC_ST_ROUTINGS | SR_INSTANCE_CODE, ORGANIZATION_CODE, ROUTING_NAME (defaulted from ASSEMBLY_NAME if Null), ASSEMBLY_NAME, ALTERNATE_ROUTING_DESIGNATOR (can be null), COMPANY_NAME
Routings | MSC_ST_ROUTING_OPERATIONS | SR_INSTANCE_CODE, ORGANIZATION_CODE, ROUTING_NAME (defaulted from ASSEMBLY_NAME if Null), ASSEMBLY_NAME, OPERATION_SEQ_CODE (if null or character would be defaulted to1), ALTERNATE_ROUTING_DESIGNATOR (can be null), EFFECTIVITY_DATE, DISABLE_DATE, COMPANY_NAME
Routings | MSC_ST_OPERATION_RESOURCES | SR_INSTANCE_CODE, ORGANIZATION_CODE, ROUTING_NAME (defaulted from ASSEMBLY_NAME if Null), ASSEMBLY_NAME, OPERATION_SEQ_CODE (if null or character would be defaulted to1), RESOURCE_SEQ_CODE (if null or character would be defaulted to 1), RESOURCE_CODE, ALTERNATE_ROUTING_DESIGNATOR (can be null), ALTERNATE_NUMBER (can be null), COMPANY_NAME
Calendar | MSC_ST_CALENDARS | SR_INSTANCE_CODE, CALENDAR_CODE, COMPANY_NAME
<table>
<thead>
<tr>
<th>Business Object</th>
<th>Table</th>
<th>User-Defined Key (UDK)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calendar</td>
<td>MSC_STCALENDAR_EXCEPTIONS</td>
<td>SR_INSTANCE_CODE, CALENDAR_CODE, EXCEPTION_DATE, COMPANY_NAME</td>
</tr>
<tr>
<td>Calendar</td>
<td>MSC_ST_WORKDAY_PATTERNSS</td>
<td>SR_INSTANCE_CODE, CALENDAR_CODE, SHIFT_NAME, COMPANY_NAME</td>
</tr>
<tr>
<td>Calendar</td>
<td>MSC_ST_SHIFT_TIMES</td>
<td>SR_INSTANCE_CODE, CALENDAR_CODE, SHIFT_NAME, FROM_TIME, TO_TIME, COMPANY_NAME</td>
</tr>
<tr>
<td>Calendar</td>
<td>MSC_ST_SHIFT_EXCEPTIONS</td>
<td>SR_INSTANCE_CODE, CALENDAR_CODE,-shift_NAME, EXCEPTION_DATE, COMPANY_NAME</td>
</tr>
<tr>
<td>Material</td>
<td>MSC_ST_SUPPLIES</td>
<td>SR_INSTANCE_CODE, ORDER_NUMBER, PURCHASE_LINE_NUMBER, ORDER_TYPE = 1(PO), 8(PORecv.), COMPANY_NAME</td>
</tr>
<tr>
<td>Supply (PO)</td>
<td>MSC_ST_SUPPLIES</td>
<td>SR_INSTANCE_CODE, ORDER_NUMBER, PURCHASE_LINE_NUMBER, ORDER_TYPE = 2, COMPANY_NAME</td>
</tr>
<tr>
<td>Supply (Req.)</td>
<td>MSC_ST_SUPPLIES</td>
<td>SR_INSTANCE_CODE, ORDER_TYPE = 3(Discrete job), 7-Non-standard job, 27-Flow schedule, WIP_ENTITY_ NAME, COMPANY_NAME</td>
</tr>
<tr>
<td>Supply (WO-</td>
<td>MSC_ST_SUPPLIES</td>
<td>SR_INSTANCE_CODE, ORDER_TYPE = 14-Discrete job by-product, 15-Nonstandard job by-product, ITEM_ NAME, WIP_ENTITY_ NAME, ORDER_NUMBER, (if null defaulted by WIP_ENTITY_ NAME if null), OPERATION_ SEQ_CODE (if null or character would be defaulted to 1), COMPANY_NAME</td>
</tr>
<tr>
<td>Discrete/Flow)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supply (WO-By</td>
<td>MSC_ST_SUPPLIES</td>
<td>SR_INSTANCE_CODE, ORDER_TYPE = 5 (Plan Orders), ORGANIZATION_CODE, SCHEDULE_DESIGNATOR, SCHEDULE_LINE_NUM (or order number), COMPANY_NAME</td>
</tr>
<tr>
<td>Products)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supply (Plan</td>
<td>MSC_ST_SUPPLIES</td>
<td>SR_INSTANCE_CODE, ORDER_TYPE = 14-Discrete job by-product, 15-Nonstandard job by-product, ITEM_ NAME, WIP_ENTITY_ NAME, ORDER_NUMBER, (if null defaulted by WIP_ENTITY_ NAME if null), OPERATION_ SEQ_CODE (if null or character would be defaulted to 1), COMPANY_NAME</td>
</tr>
<tr>
<td>Orders)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supply (Plan</td>
<td>MSC_ST_DESIGNATORS</td>
<td>DESIGNATOR, ORGANIZATION_CODE, SR_INSTANCE_CODE, COMPANY_NAME</td>
</tr>
<tr>
<td>Orders)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Control Files  D-7
<table>
<thead>
<tr>
<th>Business Object</th>
<th>Table</th>
<th>User-Defined Key (UDK)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material Supply (On Hand)</td>
<td>MSC_ST_SUPPLIES</td>
<td>SR_INSTANCE_CODE, ORDER_TYPE = 18, ITEM_NAME, ORGANIZATION_CODE, SUBINVENTORY_CODE (can be null), LOT_NUMBER (can be null), PROJECT_NUMBER (can be null), TASK_NUMBER (can be null), UNIT_NUMBER (can be null), COMPANY_NAME</td>
</tr>
<tr>
<td>Material Supply (Intransit)</td>
<td>MSC_ST_SUPPLIES</td>
<td>SR_INSTANCE_CODE, ORDER_NUMBER, PURCH_LINE_NUM, ORDER_TYPE = 11 (Intransit), 12 - (Intransit Receipt), COMPANY_NAME</td>
</tr>
<tr>
<td>Material Demand (Sales Orders)</td>
<td>MSC_ST_SALES_ORDERS</td>
<td>SR_INSTANCE_CODE, SALES_ORDER_NUMBER, LINE_NUM, ORGANIZATION_CODE, COMPANY_NAME</td>
</tr>
<tr>
<td>Material Demand (WO-Discrete)</td>
<td>MSC_ST_DEMANDS</td>
<td>WIP_ENTITY_NAME, ITEM_NAME, OPERATION_SEQ_CODE (if null or character would be defaulted to1), SR_INSTANCE_CODE, ORIGINATION_TYPE = 2 (Non Standard), 3 (Standard), ORGANIZATION_CODE, COMPANY_NAME</td>
</tr>
<tr>
<td>Material Demand (Master Demand Schedule)</td>
<td>MSC_ST_DEMANDS</td>
<td>ITEM_NAME, DEMAND_SCHEDULE_NAME, SCHEDULE_LINE_NUM (Null allowed - in case of item not being demanded on the same date more than once), ORIGINATION_TYPE = 8 (MDS), ORGANIZATION_CODE, SR_INSTANCE_CODE, SCHEDULE_DATE, COMPANY_NAME</td>
</tr>
<tr>
<td>Material Demand (Master Demand Schedule)</td>
<td>MSC_ST_DESIGNATORS</td>
<td>DESIGNATOR, ORGANIZATION_CODE, SR_INSTANCE_CODE, DESIGNATOR_TYPE = (1,2), COMPANY_NAME</td>
</tr>
<tr>
<td>Business Object</td>
<td>Table</td>
<td>User-Defined Key (UDK)</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Material Demand</td>
<td>MSC_ST_DEMANDS</td>
<td>ITEM_NAME, FORECAST_DESIGNATOR, SCHEDULE_LINE_NUM (Null allowed, item not demanded on the same date more than once), ORIGINATION_TYPE = 29 (Forecast), ORGANIZATION_CODE, SR_INSTANCE_CODE, SCHEDULE_DATE, COMPANY_NAME</td>
</tr>
<tr>
<td>Material Demand</td>
<td>MSC_ST_DESIGNATORS</td>
<td>DESIGNATOR, FORECAST_SET, ORGANIZATION_CODE, SR_INSTANCE_CODE, DESIGNATOR_TYPE = 6, COMPANY_NAME</td>
</tr>
<tr>
<td>Safety Stocks</td>
<td>MSC_ST_SAFETY_STOCKS</td>
<td>SR_INSTANCE_CODE, COMPANY_NAME, ORGANIZATION_CODE, ITEM_NAME, PERIOD_START_DATE</td>
</tr>
<tr>
<td>Reservations</td>
<td>MSC_ST_RESERVATIONS</td>
<td>SR_INSTANCE_CODE, COMPANY_NAME, SALES_ORDER_NUMBER, LINE_NUM, ORGANIZATION_CODE</td>
</tr>
<tr>
<td>Resource Demand</td>
<td>MSC_ST_RESOURCE_REQUIREMENTS</td>
<td>WIP_ENTITY_NAME, ITEM_NAME, OPERATION_SEQ_CODE (if null or character would be defaulted to 1), SR_INSTANCE_CODE, ORGANIZATION_CODE, DEPARTMENT_CODE, RESOURCE_CODE, COMPANY_NAME</td>
</tr>
<tr>
<td>Supplier Capacity</td>
<td>MSC_ST_ITEM_SUPPLIERS</td>
<td>SR_INSTANCE_CODE, ORGANIZATION_CODE, VENDOR_NAME, VENDOR_SITE_CODE, ITEM_NAME, COMPANY_NAME</td>
</tr>
<tr>
<td>Supplier Capacity</td>
<td>MSC_ST_SUPPLIER_CAPACITY</td>
<td>SR_INSTANCE_CODE, ORGANIZATION_CODE, VENDOR_NAME, VENDOR_SITE_CODE, ITEM_NAME, FROM_DATE, COMPANY_NAME</td>
</tr>
<tr>
<td>Supplier Capacity</td>
<td>MSC_ST_SUPPLIER_FLEX_FENCES</td>
<td>SR_INSTANCE_CODE, ORGANIZATION_CODE, VENDOR_NAME, VENDOR_SITE_CODE, ITEM_NAME, FENCE_DAYS, COMPANY_NAME</td>
</tr>
<tr>
<td>Business Object</td>
<td>Table</td>
<td>User-Defined Key (UDK)</td>
</tr>
<tr>
<td>----------------</td>
<td>-------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>Trading Partners</td>
<td>MSC_ST_TRADING_PARTNERS</td>
<td>SR_INSTANCE_CODE, PARTNER_NAME, PARTNER_TYPE (1 – supplier, 2 – customer), COMPANY_NAME</td>
</tr>
<tr>
<td>Trading Partners</td>
<td>MSC_ST_TRADING_PARTNER_SITES</td>
<td>PARTNER_NAME, SR_INSTANCE_CODE, PARTNER_TYPE (1 – supplier, 2 – customer), TP_SITE_CODE, COMPANY_NAME</td>
</tr>
<tr>
<td>Trading Partners</td>
<td>MSC_ST_LOCATION_ASSOCIATIONS</td>
<td>PARTNER_NAME, SR_INSTANCE_CODE, PARTNER_TYPE, SR_TP_CODE, LOCATION_CODE, ORGANIZATION_CODE, COMPANY_NAME</td>
</tr>
<tr>
<td>Trading Partners</td>
<td>MSC_ST_SUB_INVENTORIES</td>
<td>ORGANIZATION_CODE, SR_INSTANCE_CODE, SUBINVENTORY_CODE, COMPANY_NAME</td>
</tr>
<tr>
<td>Trading Partners</td>
<td>MSC_ST_PARTNER_CONTACTS</td>
<td>PARTNER_NAME, SR_INSTANCE_CODE, PARTNER_TYPE, TP_SITE_CODE, COMPANY_NAME, NAME (A partner site can have only one contact)</td>
</tr>
<tr>
<td>Organizations</td>
<td>MSC_ST_TRADING_PARTNERS</td>
<td>ORGANIZATION_CODE, SR_INSTANCE_CODE, PARTNER_TYPE (3 - organizations), COMPANY_NAME</td>
</tr>
<tr>
<td>Sourcing Rules</td>
<td>MSC_ST_INTER_ORG_SHIP_METHODS</td>
<td>SR_INSTANCE_CODE, FROM_ORGANIZATION_CODE, TO_ORGANIZATION_CODE, SHIP_METHOD, COMPANY_NAME</td>
</tr>
<tr>
<td>Sourcing Rules</td>
<td>MSC_ST_ITEM_SOURCING</td>
<td>SR_INSTANCE_CODE, ITEM_NAME (null allowed), CATEGORY_NAME (null allowed), SOURCING_RULE_NAME (null allowed), ASSIGNMENT_NAME (null allowed), RECEIPT_ORGANIZATION_CODE (null allowed if global sourcing), SOURCE_ORGANIZATION_CODE, SOURCE_PARTNER_CODE (either one of source organization code or partner code can be null), SOURCE_PARTNER_SITE_CODE (null allowed), EFFECTIVE_DATE, COMPANY_NAME</td>
</tr>
</tbody>
</table>
### User-Defined Keys (UDK)

<table>
<thead>
<tr>
<th>Business Object</th>
<th>Table</th>
<th>User-Defined Key (UDK)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Projects &amp; Tasks</td>
<td>MSC_ST_PROJECT_TASKS</td>
<td>SR_INSTANCE_CODE, ORGANIZATION_CODE, PROJECT_NAME, TASK_NAME (can be null if only project information is to be provided), COMPANY_NAME</td>
</tr>
</tbody>
</table>
Index

A

a day in the life of a planner, 3-5
accessing and executing planned orders, 10-48
accessing the Aggregation tab, 17-19
accessing the Gantt Chart, 10-52
accessing the Optimization tab, 17-24
accessing the Organizations tab, 17-21
accessing the resource tool tip, 10-59
Accumulate Available, 16-62
accurate global statement of availability, 16-2
actions
  saving, 7-7
  undoing, 7-11
  viewing, 7-7
  viewing details, 7-10
actions/exceptions tab, 10-35
adding capacity, 10-66
additional scheduling heuristic, 11-15
advanced consumption features
  backward/forward consumption time windows, 5-39
  consumption level, 5-39
  demand class, 5-39
  outlier percentage, 5-39
advantages of the single plan, 5-3
aggregate resources, 12-7
  flexfields, 12-7 to 12-10
aggregation, 17-29, 17-30
aggregation levels, 5-51, 17-34
  choosing, 5-51
  product, 5-52
  resource, 5-52
time, 5-51

Aggregation tab
  accessing from the Navigator, 5-25
  window, 5-55
allocated ATP, 16-39
  assigning allocation rules, 16-43
  ATP inquiry and viewing allocations, 16-45
  ATP plan, 16-41
  ATP rule, 16-40
  business applications, 16-39
  data collection, 16-45
  define allocation rules, 16-41
  define customer class hierarchy, 16-41
  define demand classes, 16-41
  example, 16-49
  feature description, 16-39
  item attributes, 16-40
  percentages, 16-41
  priorities, 16-42
  product dependency, 16-55
Profile - INV
  Capable to Promise, 16-44
Profile - MRP
  ATP Database Link, 16-45
Profile - MSC
  Class Hierarchy, 16-44
  Enable Allocated ATP, 16-45
  Enable Allocated Workflow, 16-45
  refreshing allocations, 16-48
  resource allocation, 16-56
  setup steps, 16-40
  view allocations workbench, 16-47
allocated ATP from Advanced Supply Chain Planning, 16-46
allocated ATP from i-Store, 16-46
allocated ATP from Order Management, 16-46
allocated ATP in a supply chain, 18-63
allocated ATP using customer-class
   hierarchy, 16-52
allocated Order Promising
   assigning allocation rules, 16-43
   defining the allocation rules, 16-42
allocating demand based on historical
demand, 6-60
allocating demand to suppliers, 6-58
Allocation, 16-3
allocation priorities, 16-42
alternate resources, 12-7
   flexfields, 12-7 to 12-10
   loading, 10-66
AOL concurrent program architecture, 4-2
append planned orders, 5-41
Application Instances window
   setting up, 2-14
APS information flows, 3-2
assigning allocation rules, 16-43
assignment sets
   assignment hierarchy, 6-4
   defining, 6-3
   viewing, 6-75
associating a salesperson with a customer, 13-30
associating an item with a buyer, 13-35
associating an item with a planner, 13-34
ATP, 16-2
   API, 16-79
   Collecting Data, 16-79
   Component Substitution, 16-64
   inquiry, 16-74
Using Multiple Plans, 16-65
ATP Based on Collected Data, 16-6
ATP Based on Planning Data, 16-6
ATP for multiple supply locations, 16-2
ATP Inquiry, 16-79
ATP Methods, 16-6
ATP Scheduling, 16-79
attaching a priority rule to a supply chain
   plan, 5-49
Audit Statements report, 6-76
   running, 6-76
   viewing, 6-78
available capacity
   viewing, 10-32
Available to Promise
   See ATP, 16-22

B
Backward Consumption of Shortage, 16-62
backward forward forecast consumption
days, 5-45
backward/forward consumption time
   windows, 5-39
Basic ATP, 16-10
   ATP Inquiry, 16-11
   ATP Logic, 16-12
   ATP Rule, 16-10
   Business Application, 16-10
   Data Collection, 16-11
   From Advanced Supply Chain Planning, 16-12
   From Order Management, 16-11
   Profile - INV
      Capable to Promise, 16-11
   Profile - MRP
      ATP Database Link, 16-11
   Setup Steps, 16-10
Basic ATP From i-Store, 16-11
batch replan
   running, 7-5
bills of distribution
   See BODs, 6-2
Bills of Materials, 11-3
BODs, 6-2
   defining, 6-3
   viewing, 6-75
BOM
   reviewing, 10-51
bookmark
   creating, 7-12
borrow payback, 12-13
breadth-first search, 18-14
business flows, 3-2
by-products, 11-4
calculating resource utilization
   figure, 5-27
   graphic, 5-27
Capable to Deliver
   See CTD, 16-22
Capable to Promise
   See CTP, 16-22
capacity
   adding, 10-66
capacity exceptions, 17-54
category/demand class, 17-13
Centralized Order Promising, 16-4
centralized planning, 4-7
chaining-multiple levels of substitution, 18-16
changing duration of an operation, 10-63
checking status of an online planner session, 7-6
choosing a plan type, 5-14
choosing between global inventory and subset plans
defining plans, 17-6
choosing plan classes
   constraints, 5-18
   enforce capacity constraints, 5-18
   enforce demand due dates, 5-18
   optimization, 5-19
collaborating with suppliers, 13-4
collection strategy, 4-3
data consolidation, 4-4
detect net change, 4-4
multiprocess collection architecture, 4-4
projects/tasks and Seiban numbers, 4-5
pull architecture, 4-4
Collection Workbench, 4-3
color codes
   Gantt Chart, 10-55
combining objectives, 5-59
common planner tasks
   a day in the life of a planner, 3-5
commonality of the items produced
defining plans, 17-6
commonality of the supply base
defining plans, 17-6
comparing different optimization runs, 8-19
comparing KPIs for multiple plans, 10-24

Computation Options, 16-62
computational burden considerations, 5-62
Configuration ATP, 16-3
configurations
   support for, 4-5
   supported, 4-7
conflict between choice to create supplies and enabling item in an organization, 18-20
conflicts related to enforce demand due dates
   plan, 18-20
constrained safety stocks, 17-50
constraint types, 11-2
demands, 11-3, 11-9
items, 11-2, 11-3
   BOMs, 11-3
   byproducts, 11-4
coproducts, 12-37
ECOs, 11-3
order modifiers, 11-6
product families, 11-4
safety stocks, 11-5
   substitute components, 11-4
   lot-based jobs, 12-36
manufacturing resources, 11-2, 11-7
sourcing constraints, 11-3, 11-8
suppliers, 11-3, 11-8
transportation resources, 11-2, 11-8
constraint-based planning
   overview, 11-2
constraint-based planning rules
   additional scheduling heuristic, 11-15
   constraints
      enabling and disabling, 11-10
      rules, 11-15
Constraints tab, 5-30
consumption level, 5-39
consumption results
   example, 5-38
control files
   demand, D-3
   setup data, D-2
   supplies, D-3
controlling aggregation
   plan end date, 17-27
   plan options, 17-27
setting routing aggregation level for a time horizon, 17-30
viewing the end date for inventory plan, 17-28
coproducts, 12-37
planned order released quantity, 12-40
corporate structure
defining plans, 17-7
creating a bookmark, 7-12
creating a custom folder, 10-40
creating a plan, 3-6
creating and implementing firm planned orders, 10-48
creating and launching a global supply chain plan, 5-4
creating and launching an inventory plan, 17-7
creating demand priority flexfield numbers manually, B-4
creating profile, B-5
creation of planned supplies, 18-51
CTD, 16-2
CTO enhancements, 14-2
CTP, 16-2
custom folder, 10-40
customer submissions, 13-3
consolidating customer forecasts, 13-3
customer-specific substitution rules, 18-24

defining a priority rule, 5-48
defining an item, 13-33
defining demand class service level, 17-11
defining graphs, 10-29, 10-30, 10-31
defining plans, 5-2
choosing between global inventory and subset plans, 17-6
choosing plan classes, 5-18
commonality of the items produced, 17-6
commonality of the supply base, 17-6
controlling aggregation levels, 5-51, 17-34
corporate structure, 17-7
factors to consider when deciding to run global supply chain or subset plan, 17-7
global supply chain planning and subset planning, 5-12, 17-6
linkage among plants, 17-7
Oracle Inventory Optimization, 17-6
physical proximity of organizations being planned, 17-6
setting plan options, 5-21, 17-18
defining priority rules
order backlog workbench, C-8
defining the allocation rules, 16-42
Demand ATP From Advanced Supply Chain Planning, 16-59
demand class, 17-16
Demand Class ATP, 16-57
ATP Inquiry, 16-59
ATP Logic, 16-60
ATP Rule, 16-57
Business Application, 16-57
Data Collection, 16-59
Demand Class MPS, 16-58
Feature Description, 16-57
Item Attributes, 16-57
Profiles, 16-58
Setup Steps, 16-57
Demand Class ATP From Order Management, 16-59
Demand Class ATP versus Allocated ATP, 16-58
demand control files, D-3
demand flow diagram
multilevel ATO, 14-8
demand management, 12-24
demand priority rules, 5-47

demand schedules
  specifying sources of demand, 17-41

demand sources, 3-5

demands
  decreasing, 5-62

demand-to-make/demand-to-buy business flow, 3-3

Detailed Availability Information with Graphical Pegging Tree, 16-2
discrete jobs and purchase requisitions recommendations, 9-59
displaying the Find window, 10-56
displaying the pegging tree, 10-44
displaying the Property window, 10-58
displaying your plan horizontally, 10-26, 10-27

E
early replenishment for forecast, 9-33
early replenishment for sales order, 9-32
ECOs, 11-3
effectivity (time phasing), 18-23
effectivity in the BOM, 12-16
enabling and disabling constraints, 11-10
enabling Global Order Promising to use region level sourcing and in-transit lead time information, 16-68
enabling PTF functionality, 11-22
end-item-level substitution, 18-2
  breadth-first search, 18-14
  chaining-multiple levels of substitution, 18-16
  conflict between choice to create supplies and enabling item in an organization, 18-20
  conflicts related to enforce demand due dates plan, 18-20

  customer-specific substitution rules, 18-24
  define a substitution relationship, 18-3
  effectivity (time phasing), 18-23
  enforce sourcing splits and substitute supply across the supply chain, 18-15
  examples illustrating substitution logic, 18-28
  examples to explain substitution logic in Oracle Global Order Promising, 18-43
  exception messages, 18-36

  features, 18-16
  general substitution examples, 18-32
  optimization, 18-35

Oracle Global Order Promising, 18-42
  allocated ATP in a supply chain, 18-63
  creation of planned supplies, 18-51
  display of possible substitutes, 18-49
  evaluating supplies after request date, 18-54
  resolving ties in the substitution chain, 18-61
  searching supply chain for substitutes, 18-53
  stealing prior to substitution, 18-61
  substitution in allocated ATP, 18-61
  workflow, 18-66

  partial order fulfillment, 18-22
  preference for generating planned orders, 18-17
  reciprocal-unidirectional and bidirectional substitution, 18-17
  resolving conflict between item attributes and profile options, 18-19

  search direction and transferring demands, 18-33
  search the supply chain for substitution, 18-13
  simulate possible substitution, 18-26
  substitution logic, 18-13
  substitution set-up examples, 18-7
  transfer of demands on to substitute supplies, 18-27

  user procedures overview, 18-3
  viewing substitution display, 18-9
  window for substitution, 18-21
  workflow for planning, 18-40

  enforce capacity constraints scenario, 5-63
  enforce demand due dates scenario, 5-64
  enforce sourcing splits, 6-69
  enforce sourcing splits and substitute supply across the supply chain, 18-15

  entering a customer contact for a customer, 13-24
  entering order promising criteria, 16-74
  evaluating supplies after request date, 18-54
  examples illustrating substitution logic, 18-28
  examples of how user-defined alternate decision rules are used, 18-81
  examples to explain substitution logic in Oracle Global Order Promising, 18-43
  exceeding resource capacity, 8-18, 8-19
exception details
   days late column, 10-38
   viewing, 10-40
exception messages, 9-12
   early replenishment for forecast, 9-33
   early replenishment for sales order, 9-32
   figuring out root cause of late replenishment, 9-30
   figuring out the root cause of late replenishment, 9-32
   item exceptions, 9-12, 9-56
   items allocated across projects/tasks, 9-54
   items below safety stock, 9-44
   items that are over-committed, 9-56
   items with a shortage, 9-43
   items with a shortage in a project/task, 9-54
   items with excess inventory, 9-44
   items with excess inventory in a project/task, 9-55
   items with expired lot, 9-57
   items with negative starting on hand, 9-57
   items with no activity, 9-58
   items with repetitive variance, 9-58
   late replenishment for forecast, 9-31
   late replenishment for sales order, 9-29
   late sales orders and forecasts, 9-22
   late supply pegged to forecast, 9-27
   late supply pegged to sales order, 9-26
   making decisions based on, 9-20
   material and resource capacity, 9-34
   material constraint, 9-34
Oracle Workflow, 12-18
order at risk due to materials shortage, 9-22
order at risk due to resource shortage, 9-24
order sourced from alternate facility, 9-51
order sourced from alternate supplier, 9-52
orders to be cancelled, 9-46
orders to be rescheduled in, 9-47
orders to be rescheduled out, 9-46
orders with compression days, 9-48
past due forecast, 9-29
past due orders, 9-45
past due sales orders, 9-27
planned order uses alternate BOM, 9-49
planned order uses alternate resources, 9-51
planned order uses alternate routing, 9-49
planned order uses substitute components, 9-50
projects/tasks, 9-54
recommendations, 9-59
reschedules, 9-45
resource constraint, 9-36
resource overloaded, 9-38
resource underloaded, 9-40
shortages and excess, 9-43
substitutes and alternates used, 9-49
supplier capacity overloaded, 9-39
transportation and distribution exception messages, 9-41
transportation resource constraint, 9-41
transportation resource overloaded, 9-42
transportation resource underloaded, 9-42
exception messages and end-item-level substitution, 18-36
exception messages and user-defined alternate decision rules, 18-101
exceptions
   reviewing, 3-7
   sorting, 10-36
exceptions details
   viewing, 10-37
exceptions for multiple plan scenarios graphically comparing, 10-41
exclusive stochastic optimization solution, 1-11

F
factors affecting objectives, 5-60
factors to consider when deciding to run global supply chain or subset plan, 17-7
figuring out root cause of late replenishment, 9-30, 9-32
Find window
   displaying, 10-4, 10-56
   Gantt Chart, 10-55
firm planned orders
   creating and implementing, 10-48
firming an operation, 10-64
firming order, 3-13
fixed days supply, 11-7
fixed lot multiple, 11-6
fixed order quantity, 11-6
flexfield numbers
  creating manually, B-4
flexfields, B-1
  applying to different versions of Oracle RDBMS, B-3
  transportation capacity, B-4
flexible shift times, 11-16
flexibly tailor the scope of availability checks, 1-15
flow line scheduling, 12-18
flow manufacturing
  See Oracle Flow Manufacturing, 12-22
forecast consumption as an input to a plan, 5-35
forecast explosion
  multilevel ATO, 14-4
Forward Consumption of Shortage, 16-62

G
Gantt Chart
  accessing, 10-52
  color codes, 10-55
  Find window, 10-55
  interactive scheduling, 10-52
  rescheduling operations, 10-62
  right-click menu options, 10-56
  saving changes, 10-71
general substitution examples, 18-32
generating planned orders, 12-16
global (plan level), 17-17
global supply chain and subset plans
  choosing between, 5-12
global supply chain plan, 5-12, 17-6
  creating and launching, 5-4
  prerequisites, 5-3
  running, 5-3
  setting parameters, 17-10
graphically comparing exceptions for multiple plan scenarios, 10-41
graphs
  changing number of periods, 10-30
  choosing types of, 10-31
  defining, 10-29
  defining dynamically, 10-30, 10-31
  group netting, 12-13

H
hard and soft constraints
  setting, 11-11
hard pegging, 12-12, 12-13
  supply chain planning with, 12-13
historical demand
  allocating demand according to, 6-60
horizontal plan, 10-25
how the planning horizon relates to the time of the plan run, 5-26

I
ILOG CPLEX Solver Profile Options, A-15
implementing planning recommendations, 10-48
implicit objectives, 5-59
increasing inventory turns, 9-10
increasing margin percentage, 9-10
increasing ontime delivery, 9-11
increasing planned utilization, 9-10
Infinite Supply Time Fence, 16-61
Inherit Phantom Op Seq checkbox, 11-21
inline forecast consumption, 5-36
inquiry-to-order business flow, 3-4
interactive scheduling
  Gantt Chart, 10-52
INV-Capable to Promise
  profile options, A-18
inventory carrying costs percentage, 8-18
inventory methods, 11-5
inventory turns, 5-57, 10-22
inventory value, 9-7
INV-External ATP
  profile options, A-19
invoking CTP for batch resources, 16-67
Item Details Worksheet window, 10-76
item exceptions exception messages, 9-56
item planning information, 10-24
item workflow, 3-9
item/demand class
  setting service levels, 17-11
items
  decreasing, 5-62
  items allocated across projects/tasks, 9-54
items below safety stock,  9-44
items that are over-committed,  9-56
items with a shortage,  9-43
items with a shortage in a project/task,  9-54
items with excess inventory,  9-44
items with excess inventory in a project/task,  9-55
items with expired lot,  9-57
items with negative starting on hand,  9-57
items with no activity,  9-58
items with repetitive variance,  9-58

K
kanban planning and execution,  12-24
KPI setup,  9-8
KPIs,  9-2
  comparing multiple plans,  10-24
  cost breakdown
    calculation,  9-6
  inventory turns,  10-22
    calculation,  9-4
    increasing,  9-10
  margin
    calculation,  9-6
  margin percentage,  10-23
    calculation,  9-5
    increasing,  9-10
  ontime delivery,  10-23
    calculation,  9-6
    increasing,  9-11
  planned utilization,  10-23
    calculation,  9-5
    increasing,  9-10
  reviewing,  3-6
  reviewing item planning information,  10-24
  service level
    calculation,  9-7
  setting targets,  9-9
  tab,  10-19
  viewing,  10-20
  viewing an enlarged version,  10-21

L
late replenishment for forecast,  9-31
late replenishment for sales order,  9-29
late sales orders and forecasts,  9-22
late supply pegged to forecast,  9-27
late supply pegged to sales order,  9-26
launching a plan,  3-6
lead times and user-defined decision rules,  18-100
line design and balancing,  12-24
linkage among plants
  defining plans,  17-7
loading alternate resources,  10-66
lot-based jobs,  12-36
LRS
  See Log roll-forward server (LRS),  B-1

M
Main tab,  5-21
  accessing from the Navigator,  5-21
  making decisions based on exception
    messages,  9-20
manufacturing resources
  network routings,  12-42
  operation yield,  12-40
  resources,  11-7
  routings,  11-7
  workday calendar,  11-8
margin percentage,  5-57, 10-23
material aggregation,  5-55, 17-29
material aggregation levels
  controlling,  5-55
  setting for a time horizon,  5-55
material and resource capacity exception
  messages,  9-34
material constraint,  9-34
material workflow,  3-9
material/resource availability,  17-53
maximize inventory turns,  8-3
  specifying plan objectives,  17-33
maximize ontime delivery,  8-4
  specifying plan objectives,  17-33
maximize plan profit,  8-3
  specifying plan objectives,  17-33
maximum allowable days late,  8-19
minimum and maximum order quantity,  11-7
minimum transfer quantity,  6-37
mixed mode manufacturing
  common features, 12-2
  efficiency, 12-6
overview, 12-2
phantom routings, 12-2 to 12-5
routing effectiveness, 12-6
utilization, 12-6
model/unit number, 12-16
  generating planned orders, 12-16
model/unit effectiveness, 12-16
  effectivity in the BOM, 12-16
flow line scheduling, 12-18
model/unit number, 12-16
  pegging, 12-18
  Planner Workbench, 12-16
  unit numbers in sales orders, 12-16
WIP mass/load PO requisitions interface, 12-18
modes, 7-3
modify objectives, 3-10
modify supplier parameters, 3-12
modifying release properties, 10-49
modifying resources, 3-11
modifying supply and demand, 3-11
MRP
  Include Substitute Components, 16-65
MRP planned percent, 11-5
MRP Planning Type item attribute, 5-14
MRP-ATP Assignment Set
  profile options, A-19
MRP-ATP Database Link
  profile options, A-19
MRP-Calculator Supply Demand
  profile options, A-19
MRP-Include Substitute Components, A-19
MRP-Set Category for Backlog Form
  profile options, A-20
MSC-ATP Assignment Set
  profile options, A-20
MSC-Class Hierarchy
  profile options, A-20
MSC-Default Workbench Height
  profile options, A-14
MSC-Default Workbench Width
  profile options, A-14
MSC-Enable Allocated ATP
  profile options, A-19
MSC-Enable Allocated ATP Workflow
  profile options, A-20
MSC-Hour UOM
  profile options, A-14
MSC-Map Server Host
  profile options, A-14
MSC-Map Server Port
  profile options, A-14
MSC-Plan co-products
  profile options, A-14
MSC-Planning Currency
  profile options, A-14
MSCPLDTL.PDR_PARAMS, 10-71
MSC-Sales Orders Offset Days
  profile options, A-14
MSC-Share Plan Partitions
  profile options, A-14
MSC-Sourcing Rule Category Set
  profile options, A-15
MSO-Alternate Resource Penalty
  profile options, A-12
MSO-Alternate Process Penalty
  profile options, A-12
MSO-Alternate Source Penalty
  profile options, A-12
MSO-Check Redundant Constraints
  profile options, A-15
MSO-CPLEX Crash Parameter
  profile options, A-15
MSO-CPLEX Refactor Rate
  profile options, A-15
MSO-CPLEX Scaling Factor
  profile options, A-15
MSO-Default Forecast Priority
  profile options, A-5
MSO-Default Sales Order Priority
  profile options, A-5
MSO-Dual Simplex Parameter
  profile options, A-15
MSO-Firm Supply Allocation Window (days)
  profile options, A-6
MSO-Floating Point Precision
  profile options, A-7
MSO-Global Time Limit
profile options, A-15
MSO-Heuristic type
profile options, A-6
MSO-HLS flat files path
profile options, A-6
MSO-Inventory Carrying Costs Percentage
profile options, A-12
MSO-List Size for Pricing Candidates
profile options, A-16
MSO-LP Constraint Batch Size
profile options, A-16
MSO-LP Markowitz Coefficient
profile options, A-16
MSO-LP Optimization Algorithm
profile options, A-12
MSO-Maximum Activity Duration
profile options, A-8
MSO-Maximum Allowable Days Late
profile options, A-12
MSO-Maximum Demands per Group
profile options, A-9
MSO-Maximum Demands per Slice
profile options, A-9
MSO-Maximum Number of Prepones
profile options, A-8
MSO-Maximum Number of Pull for Operation
profile options, A-9
MSO-Maximum Resource Overcapacity
profile options, A-9
MSO-Maximum Simplex Iterations
profile options, A-16
MSO-Network routing cycle time coefficient
profile options, A-9
MSO-Network routing fixed time window
profile options, A-10
MSO-NFL BACKWARD COMPRESSION PCT, A-10
MSO-NFL FORWARD COMPRESSION PCT
profile options, A-10
MSO-Optimization Daily Aggregation Buckets
profile options, A-13
MSO-Optimization Weekly Aggregation Buckets
profile options, A-13
MSO-Penalty Cost Factor for Exceeding Material Capacity
profile options, A-13
MSO-Penalty Cost Factor for Exceeding Resource Capacity
profile options, A-13
MSO-Penalty Cost Factor for Late Demands
profile options, A-13
MSO-Preprocessing Aggregator Fill
profile options, A-16
MSO-Preprocessing Aggregator Limit
profile options, A-16
MSO-Preprocessing Flag for LP Matrix
profile options, A-16
MSO-Primal Simplex Parameter
profile options, A-16
MSO-Queue Time Factor
profile options, A-13
MSO-Reschedule Shared Supply to Influence Batching
profile options, A-10
MSO-Resource Batching Strategy
profile options, A-10
MSO-Schedule Across Breaks
profile options, A-11
MSO-schedule window width
profile options, A-11
MSO-Simplex Feasibility Tolerance
profile options, A-16
MSO-Simplex Optimality Tolerance
profile options, A-16
MSO-Simplex Perturbation Constant
profile options, A-17
MSO-Simplex Perturbation Indicator
profile options, A-17
MSO-Simplex Perturbation Limit
profile options, A-17
MSO-Simplex Perturbation Parameter
profile options, A-17
MSO-Simplex Presolve Limit
profile options, A-17
MSO-Simplex Singularity Repair Limit
profile options, A-17
MSO-Solve Dual Problem
profile options, A-17
MSO-Sourcing Allocation Window
profile options, A-11
MSO-Substitute Item Penalty profile options, A-13
MSO-Use SCO Time Aggregation profile options, A-11
MSR- Postponement Factor profile options, A-20
MSR- Probability Distribution Type profile options, A-20
MSR-Safety Stock Holding Strategy profile options, A-20
multilevel ATO
demand flow diagram, 14-8
forecast explosion, 14-4
Order Promising, 14-7
planning process, 14-4
setup required to use, 14-10
Multilevel ATO Model, 16-38
multilevel ATO with example, 14-2
Multilevel ATP From Advanced Supply Chain Planning, 16-28
Multilevel ATP From i-Store, 16-27
Multilevel ATP From Order Management, 16-27
Multilevel ATP Logic in a Single Organization, 16-28
Multilevel ATP Logic Involving Supply Chain, 16-29
Multilevel Supply Chain ATP, 16-2, 16-22
ATP Inquiry, 16-27
ATP Logic, 16-28
ATP Plan, 16-24
ATP Rule, 16-24
Business Application, 16-23
Data Collection and Running a Plan, 16-26
Example, 16-29
Feature Description, 16-22
Instance Setup, 16-26
Interlocation Transit Times, 16-25
Item Attributes, 16-23
Manufacturing Capacity, 16-25
Product Dependency, 16-38
Profile - MRP
ATP Assignment Set, 16-26
ATP Database Link, 16-26
Profile - MSC
ATP Assignment Set, 16-26
Setup Steps, 16-23
Supplier Capacity, 16-25
Supply Chain, 16-24
multiresource scheduling, 6-42

N
nervousness, 5-64
net availability, 12-6
net change, 3-12, 4-4
net change planning, 3-12
net change replan, 7-3
running, 7-5
network routings, 12-42
optimize, 12-43
planned percent, 12-43
primary path, 12-43
new time bucket for lower pane specifying, 10-61
new time bucket for right pane specifying, 10-60

O
objective functions, 5-57
choosing, 5-57
combining objectives, 5-59
implicit objectives, 5-59
inventory turns, 5-57
margin percentage, 5-57
ontime delivery, 5-58
ODS
Demand, 16-63
Supply, 16-62
ODS Load, 4-3
online planner, 7-4
batch mode planner, 7-3
online planner session checking status, 7-6
stopping, 7-7
online replan, 3-12
running, 7-5
ontime delivery, 10-23
ontime delivery objective, 5-58
operation
changing duration, 10-63
firming, 10-64
reschedule graphically, 10-63
rescheduling, 10-62, 10-65
resolving overload, 10-65
viewing information, 10-57
operation yield, 12-40
Operational Data Store (ODS), 4-2
Operational Data Store (ODS) Load, 4-2
optimization, 7-3
comparing different optimization runs, 8-19
maximize inventory turns, 8-3
maximize ontime delivery, 8-4
maximize plan profit, 8-3
objectives, 3-10
See also KPIs, 8-2
overview, 8-2
plan types, 3-10
profile options, A-12
See also KPIs, 3-10
See also plan classes, 5-20
optimization and end-item-level substitution, 18-35
optimization effects
enforce capacity constraints scenario, 5-63
enforce demand due dates scenario, 5-64
optimization effects on sourcing, 5-63
Optimization tab
accessing from the Navigator, 5-32
optimize
network routings, 12-43
optimized plan
running, 3-10
optimized plans
user-defined decision rules for, 18-88
optimized plans data requirements, 5-62
Oracle Advanced Supply Chain Planning introduction, 1-3
Oracle Applications Data Store (ADS), 4-2
Oracle Applications version, 4-5
Oracle ASCP Flexfield Attribute Profile Option, A-17
Oracle ASCP Flexfields, B-2
Oracle ASCP Optimization Profile Options, A-12
Oracle ASCP Scheduling Profile Options, A-2
Oracle Flow Manufacturing, 12-22, 12-23, 12-24, 12-25
demand management, 12-24
Oracle Global Order Promising
flexibly tailor the scope of availability checks, 1-15
introduction, 1-15
overview, 16-2
profile options, A-18
sources of supply and demand, 16-6
Order Promising from ODS-ATP Rules, 16-6
Order Promising from PDS, 16-6
Oracle Global Order Promising and end-item-level substitution, 18-42
Oracle Inventory Optimization
defining plans, 17-6
input, 17-4
introduction, 1-11
output, 17-5
overview, 17-2
Oracle Process Manufacturing, 12-26
creating a resource warehouse, 12-29
differences between production in OPM and
Oracle Applications, 12-28
effectivity, formulas, and routings, 12-31
merged organization structure, 12-26, 12-27
merging effectivities, formulas, and routings, 12-29
MPS schedule, 12-33
OPM data for Oracle ASCP, 12-26 to 12-35
OPM organizations, 12-31
plant/warehouse relationships, 12-33
recommended organization structure, 12-28
resources, 12-32
setting up and using OPM data, 12-30
unit of measure, 12-30
Oracle Project Manufacturing, 12-11
borrow payback, 12-13
group netting, 12-13
hard pegging, 12-12, 12-13
model/unit effectivity, 12-16
soft pegging, 12-12
Oracle Workflow, 13-5
exception messages, 12-18
penalty costs vs. penalty factors, 8-4
penalty factors
  exceeding material capacity, 8-10
  exceeding resource capacity, 8-14
late demand, 8-5
setting, 8-4
setting using plan options, 8-17
setting using the Optimization tab, 5-33, 8-18
performance indicators
  viewing output, 17-47
performance management
  overview, 9-2
  supply chain partners, 13-4
phantom routings, 11-21, 12-2 to 12-5
physical proximity of organizations being planned
  defining plans, 17-6
pitfalls of subset planning, 5-10
plan
  viewing undo summary, 7-9
plan classes
  choosing, 5-18
  constraints, 5-18
  enforce capacity constraints, 5-18
  enforce demand due dates, 5-18
  material and resource constrained, 5-18, 5-19
  material constrained, 5-18, 5-19
  optimization, 5-19
  optimized, 5-18, 5-20
  resource constrained, 5-18, 5-19
  unconstrained, 5-18, 5-19
plan end date
  controlling aggregation, 17-27
plan options
  Aggregation tab, 5-25, 17-19
  Constraints tab, 5-30
  controlling aggregation, 17-27
  Decision Rules tab, 5-34
  Main tab, 5-21
  Optimization tab, 5-32, 17-24
  Organizations tab, 5-28, 17-21
  selecting planned items, 17-27
  set supplier lead time variability, 17-42
  setting, 5-21
  setting penalty factors, 8-17
  setting supplier lead time variability, 17-43
specify supply types, 17-41
specifying sources of supply and demand, 17-41
specifying supply types, 17-41
using an existing plan as a demand schedule for
  new plan, 17-27
using an existing plan as a supply schedule for a
  new plan, 17-26
plan options form and organization
  security, 18-106
plan profit objective, 5-57
plan types, 3-10
  choosing a, 5-14
  MRP Planning Type item attribute, 5-14
  setting constraints, 11-13
  unconstrained, 3-10
planned order released quantity for
coproducts, 12-40
planned order uses alternate BOM, 9-49
planned order uses alternate resources, 9-51
planned order uses alternate routing, 9-49
planned order uses substitute components, 9-50
planned orders
  accessing and executing, 10-48
planned percent
  network routings, 12-43
planned utilization, 10-23
Planner Workbench, 10-12, 12-16
  drill down, 10-3
  find window, 10-3
  general navigation, 10-2
  pull-down menus, 10-5
  right-click menu options, 10-6
  tailoring, 10-11
  using left pane and navigation tree, 10-15
  using right pane and navigation tree, 10-19
Planning Data Store (PDS), 4-3
Planning Detail Report, 10-71
Planning Detail Report window, 10-73
planning horizon
  time of plan run, 5-26
planning process
  multilevel ATO, 14-4
planning recommendations
  planning, 10-48
planning search logic for user-defined decision
rules, 18-88, 18-92
Planning Server
performing tasks on the, 6-75
planning time fence, 11-21
planning time fence scenarios, 11-25
plans
creating, 3-6
launching, 3-6
preference for generating planned orders, 18-17
primary path
network routings, 12-43
priority rule
defining, 5-48
product aggregation levels
choosing, 5-52
product families, 11-4, 12-25
profile options, A-2, A-10, A-19
INV-Capable to Promise, A-18
INV-External ATP, A-19
MRP-ATP Assignment Set, A-19
MRP-ATP Database Link, A-19
MRP-Calculate Supply Demand, A-19
MRP-Include Substitute Components, A-19
MRP-Set Category for Backlog Form, A-20
MSC-ATP Assignment Set, A-20
MSC-Class Hierarchy, A-20
MSC-Default Workbench Height, A-14
MSC-Default Workbench Width, A-14
MSC-Enable Allocated ATP, A-19
MSC-Enable Allocated ATP Workflow, A-20
MSC-Hour UOM, A-14
MSC-Map Server Host, A-14
MSC-Map Server Port, A-14
MSC-Plan co-products, A-14
MSC-Planning Currency, A-14
MSC-Sales Orders Offset Days, A-14
MSC-Share Plan Partitions, A-14
MSC-Sourcing Rule Category Set, A-15
MSO- Alternate Resource Penalty, A-12
MSO- NFL FORWARD COMPRESSION
PCT, A-10
MSO- Optimization Daily Aggregation
Buckets, A-13
MSO- Optimization Weekly Aggregation
Buckets, A-13
MSO- Reschedule Shared Supply to Influence
Batching, A-10
MSO- Resource Batch Size, A-16
MSO- Resource Batching Strategy, A-10
MSO- Alternate Process Penalty, A-12
MSO- Alternate Source Penalty, A-12
MSO- Check Redundant Constraints, A-15
MSO-CPLEX Crash Parameter, A-15
MSO-CPLEX Refactor Rate, A-15
MSO-CPLEX Scaling Factor, A-15
MSO- Default Forecast Priority, A-5
MSO- Default Sales Order Priority, A-5
MSO- Dual Simplex Parameter, A-15
MSO- Firm Supply Allocation Window
(days), A-6
MSO- Floating Point Precision, A-7
MSO- Global Time Limit, A-15
MSO- Heuristic type, A-6
MSO- HLS flat files path, A-6
MSO- Inventory Carrying Costs
Percentage, A-12
MSO- List Size for Pricing Candidates, A-16
MSO- LP Constraint Batch Size, A-16
MSO- LP Markowitz Coefficient, A-16
MSO- LP Optimization Algorithm, A-12
MSO- Maximum Activity Duration, A-8
MSO- Maximum Allowable Days Late, A-12
MSO- Maximum Demands per Group, A-9
MSO- Maximum Demands per Slice, A-9
MSO- Maximum Number of Prepones, A-8
MSO- Maximum Number of Pull for
Operation, A-9
MSO- Maximum Resource Overcapacity, A-9
MSO- Maximum Simplex Iterations, A-16
MSO- Network routing cycle time
coefficient, A-9
MSO- Network routing fixed time
window, A-10
MSO- NFL BACKWARD COMPRESSION
PCT, A-10
MSO- Penalty Cost Factor for Exceeding Material
Capacity, A-13
MSO- Penalty Cost Factor for Exceeding Resource
Capacity, A-13
MSO- Penalty Cost Factor for Late
Demands, A-13
MSO-Preprocessing Aggregator Fill, A-16
MSO-Preprocessing Aggregator Limit, A-16
MSO-Preprocessing Flag for LP Matrix, A-16
MSO-Primal Simplex Parameter, A-16
MSO-Queue Time Factor, A-13
MSO-Schedule Across Breaks, A-11
MSO-schedule window width, A-11
MSO-Simplex Feasibility Tolerance, A-16
MSO-Simplex Optimality Tolerance, A-16
MSO-Simplex Perturbation Constant, A-17
MSO-Simplex Perturbation Indicator, A-17
MSO-Simplex Perturbation Limit, A-17
MSO-Simplex Perturbation Parameter, A-17
MSO-Simplex Presolve Limit, A-17
MSO-Simplex Singularity Repair Limit, A-17
MSO-Solve Dual Problem, A-17
MSO-Sourcing Allocation Window, A-11
MSO-Substitute Item Penalty, A-13
MSO-Use SCO Time Aggregation, A-11
MSR-Postponement Factor, A-20
MSR-Probability Distribution Type, A-20
MSR-Safety Stock Holding Strategy, A-20
optimization, A-12
Oracle Global Order Promising, A-18
Project MRP
implementation steps, 12-18, 12-19
Oracle ASCP setup, 12-20
Oracle Inventory setup, 12-19
Oracle Project Manufacturing setup, 12-19
planning logic, 12-21
project workflow, 3-9
projects/tasks and Seiban numbers, 4-5
projects/tasks exception messages, 9-54
Property window
displaying, 10-58
pull architecture, 4-4
pull program, 4-3

R
rank and allocation
setting, 6-58
RDBMS version, 4-5
reciprocal-unidirectional and bidirectional substitution, 18-17

recommendations
discrete jobs and purchase requisitions, 9-59
exception messages, 9-59
regional level sourcing support, 16-67
related exceptions
drill down, 10-40
related exceptions for the late replenishment viewing, 10-41
releasing order, 3-13
releasing recommendations, 10-48, 10-50
reschedule line results, C-6
reschedules exception messages, 9-45
rescheduling an operation, 10-62, 10-65
rescheduling an operation graphically, 10-63
rescheduling order line simulation data process, C-18
rescheduling within order backlog workbench, C-18
rescheduling workflow, 3-9
resize windows, 10-12
resolving conflict between item attributes and profile options, 18-19
resolving overload of an operation, 10-65
resolving ties in the substitution chain in Oracle Global Order Promising, 18-61
resource aggregation, 5-54, 17-30
resource aggregation levels
choosing, 5-52
setting for a time horizon, 5-54
resource availability
viewing, 10-34
resource constraint, 9-36
resource overloaded, 9-38
resource tool tip
accessing, 10-59
resource underloaded, 9-40
resources
aggregate, 12-7
decreasing, 5-62
modifying, 3-11
selecting to plot, 10-60
simultaneous, 12-7
viewing, 10-32
reverse actions or changes, 7-9
review constrained forecast, 3-12
review workflow notifications, 3-8
reviewing a BOM, 10-51
reviewing a BOM or supply chain bill, 10-50
reviewing exception messages, 17-54
reviewing exceptions, 3-7
reviewing KPIs, 3-6
rounding order quantities, 11-7
routing aggregation level
  setting for a time horizon, 5-56
routing aggregation levels
  controlling, 5-56
routing effectivity, 12-6
routings, 11-7
run constrained plans in ASCP, 11-21
run net change, 3-12
running a batch replan, 7-5
running a global supply chain plan, 5-3, 17-7
  prerequisites, 5-3
running an online replan, 7-5
running an optimized plan, 3-10
running an unconstrained plan, 3-10
running the Audit Statements report, 6-76

S
safety stocks, 11-4, 11-5, 17-50
safety stocks and target safety stocks, 17-50
sales order workflow, 3-9
saving actions, 7-7
saving changes
  Gantt Chart, 10-71
scheduling order lines with order backlog
  workbench, C-15
scheduling orders using order backlog
  workbench, C-9
SCP names window, 5-5
search direction and transferring demands, 18-33
search the supply chain for substitution, 18-13
searching supply chain for substitutes in Oracle
  Global Order Promising, 18-53
seeing consumption results
  steps, 5-37
Seiban numbers, 4-5
selecting planned items
  plan options, 17-27
selecting resources to plot, 10-60
selection criteria for scheduling with order backlog
  workbench, C-7
selection of alternates for OSFM, 18-84
set supplier lead time variability
  plan options, 17-42
set up
  flowchart, 2-6
setting BOM parameter, 11-21
setting constraints
  plan types, 11-13
  setting plan options, 17-31
setting demand variability, 17-34
setting hard and soft constraints, 11-11
setting item demand class service level, 17-11
setting Oracle Inventory Optimization
  constraints, 17-32
setting penalty costs, 17-44
setting penalty factor for exceeding material capacity
  hierarchy, 8-10
setting penalty factor for exceeding resource capacity
  hierarchy, 8-14
setting penalty factor for late demand
  hierarchy, 8-5
setting performance indicators, 17-46
setting plan options
  setting constraints, 17-31
setting resource aggregation levels, 5-54, 17-30
setting routing aggregation level for a time horizon
  controlling aggregation, 17-30
setting service levels, 17-10
  item/demand class, 17-11
setting supplier lead time variability
  plan options, 17-43
setting targets for KPIs, 9-9
setting the category demand class service level, 17-13
setting the customer service level, 17-15
setting the demand class service level, 17-16
setting the item service level, 17-13
setting the material aggregation level, 17-29
setting the material aggregation level for a time horizon, 5-55
setting the organization service level, 17-15
setting the resource aggregation levels for a time horizon, 5-54
setting the routing aggregation level for a time horizon, 5-56
setting up, 4-17
   Application Instances window, 2-14
   Organization window, 2-15
setting up buyers, 13-20
setting up customer contact, 13-21
setting up customer contact as a user, 13-19
setting up employees, 13-17
setting up planners, 13-19
setting up Project MRP, 12-18, 12-19
setting up supplier contact, 13-26
setting up supplier contact as a user, 13-19
setting up users, 13-18
setup data control files, D-2
setup required to use multilevel ATO, 14-10
sharing forecasts/demand plans, 13-2
forecast consumption status, 13-2
providing viewing and updating access, 13-2
viewing customer specific forecasts, 13-2
shortages and excess exception messages, 9-43
simulate possible substitution, 18-26
simulation modes, 7-3
simulation scenarios
demands, 7-2
item supply and demand, 7-2
optimization objectives, 7-3
resource availability, 7-2
supplier capacity, 7-2
supplies, 7-2
simulations, 7-3
   comparing scenarios quantitatively, 7-12
   net change replan, 7-3
   overview, 7-2
simulations and user-defined decision rules, 18-87
simultaneous resources, 12-7
   flexfields, 12-7 to 12-10
Single Level Supply Chain ATP, 16-13
   Assignment Set, 16-15
   ATP Inquiry, 16-17
   ATP Logic, 16-18
   ATP Rule, 16-14
   Business Application, 16-13
   Data Collection, 16-17
   Example, 16-18
   Inter-Location Transit Times, 16-15
   Item Attributes, 16-13
   Profile - INV
      Capable to Promise, 16-16
      Profile - MRP
         ATP Assignment Set, 16-16
         ATP Database Link, 16-16
         Setup Steps, 16-13
         Sourcing Rule, 16-14
   Single Level Supply Chain ATP From i-Store, 16-17
   Single Level Supply Chain ATP From Order Management, 16-17
   Single Level Supply Chain ATP With or Without APS, 16-16
   single-plan approach
      advantages, 5-3
   soft pegging, 12-12
   Sort Table window, 10-77
   sorting exceptions, 10-36
   sources of demand, 3-5
      specifying, 3-5
   sourcing assignment hierarchy
      viewing, 6-75
   sourcing constraints
      tolerance fences, 11-9
   sourcing percentages
      splitting demand according to, 6-59
   sourcing rules
      defining, 6-3
      supply chain, 6-2
      viewing, 6-75
   specify supply types
      plan options, 17-41
   specifying new time bucket for lower pane, 10-61
   specifying new time bucket for right pane, 10-60
   specifying plan objectives, 17-32
      maximize inventory turns, 17-33
      maximize ontime delivery, 17-33
      maximize plan profit, 17-33
   specifying sources of demand, 3-5
      demand schedules, 17-41
      supply schedules, 17-42
specifying sources of supply and demand plan options, 17-41
specifying supply types plan options, 17-41
splitting demand according to sourcing percentages, 6-59
stochastic optimization solution, 1-11
stopping an online planner session, 7-7
subset plan, 5-12, 17-6
setting parameters, 17-10
subset planning pitfalls, 5-10
scenarios, 5-9
substitute components, 11-4
substitutes and alternates used exception messages, 9-49
substitution in allocated ATP for Oracle Global Order Promising, 18-61
substitution logic, 18-13
substitution set-up examples, 18-7
supplier capacity, 7-2
delivery and reception frequency calendars, 6-9
setting a delivery and reception frequency calendar, 6-10
setting by time periods, 6-6
setting by time periods for version 10.7 or 11.0, 6-8
setting by time periods for version 11i, 6-6
setting supplier flexfences for version 10.7 or 11.0, 6-8
setting supplier specific lead time, 6-9
supplier specific planning constraints, 6-9
supplier capacity overloaded, 9-39
supplies control files, D-3
supply and demand, 3-9, 16-62
modifying, 3-11
pegging, 3-9
view pegged, 3-9
supply chain, 6-2
assignment sets, 6-3
performance management, 13-4
setting up, 6-2
sourcing rules, 6-2
viewing, 6-74, 10-45
Supply Chain ATP From Advanced Supply Chain Planning, 16-18
supply chain bill illustration, 14-4
supply chain modeling
See also supply chain, 6-2
supply chain or where used information viewing, 10-45
supply chain plan
attaching a priority rule, 5-49
supply chain plan names form and organization security, 18-105
supply chain planning, 5-2
supply chain synchronization, 12-23
supply schedules
specifying sources of demand, 17-42
support for batch resources, 16-65
support for flow schedules, 12-23
supported configurations, 4-7
T
tabs
Actions layout, 10-15
Aggregation, 5-25, 5-55, 17-19, 17-29
Constraints, 5-30, 11-12
Decision Rules, 5-34
horizontal plan, 10-25
Items layout, 10-17
Key Indicators, 10-19
Main, 5-21
Optimization, 5-32, 8-3, 17-24, 17-33
Organizations, 5-28, 17-21
Projects layout, 10-18
Resources layout, 10-18
Suppliers layout, 10-19
vertical plan, 10-25
tailoring the user interface, 10-11, 10-12
Planner Workbench
customize columns, 10-13
display preferences, 10-13

target safety stocks, 17-50

time aggregation levels
choosing, 5-51

time buckets
specifying, 10-60

Time Fence Options, 16-61
time of plan run
planning horizon, 5-26
time-phased supply and demand
viewing output, 17-48
tolerance fences
sourcing constraints, 11-9
transfer of demands on to substitute supplies, 18-27
transportation capacity
flexfields, B-4
transportation resource constraint, 9-41
transportation resource overloaded, 9-42
transportation resource underloaded, 9-42

U

unconstrained plan
running, 3-10
See also plan types, 3-10
unconstrained safety stocks, 17-50
undoing your actions, 7-11
unit numbers in sales orders, 12-16
user procedure flow for organization security, 18-103
user-defined alternate decision rules, 18-69
examples of how user-defined alternate decision rules are used, 18-81
exception messages, 18-101
lead times, 18-100
pegging, 18-101
planning search logic, 18-88, 18-92
selection of alternates for OSFM, 18-84
simulations and user-defined decision rules, 18-87
user-defined alternate decision rules for constrained plans, 18-69
user-defined alternate decision rules for optimized plans, 18-88

V

vertical plan, 10-25
Vertical Plan Worksheet window, 10-78
view the supply chain, 10-45
viewing actions, 7-7
viewing allocations, 16-47
viewing assignment sets, 6-75
viewing available capacity, 10-32
viewing bills of distribution (BODs), 6-75
viewing details on an action, 7-10
viewing exception details, 10-37, 10-40
viewing exceptions
exceptions
viewing, 10-35
viewing graphical pegging, 10-44
viewing output, 17-47
performance indicators, 17-47
time-phased supply and demand, 17-48
viewing related exceptions for the late replenishment, 10-41
viewing resource availability, 10-34
viewing resources, 10-32
viewing sourcing assignment hierarchy, 6-75
viewing sourcing rules, 6-75
viewing substitution display, 18-9
viewing supply chain or where used information, 10-45
viewing the Audit Statements report, 6-78
viewing the end date for inventory plan controlling aggregation, 17-28
viewing the plan, 12-22
viewing time-phased material and resource availability, 17-53

Index-20
viewing time-phased resource requirements, 17-51
viewing time-phased safety stocks, 17-51
viewing time-phased supply and demand, 17-49
viewing undo summary for a plan, 7-9

W
window for substitution, 18-21
windows
  Adjusting Resource Availability from the Planner
    Workbench, 9-25
  Aggregation tab, 5-25, 5-55
  Allocation Rule, 17-11
  Assign Allocation, 17-12
  Assign Allocation Rule, 16-44, 17-14, 17-17
  Assign Allocation Rule, Allocation Rule
    field, 17-12, 17-14
  ATP Criteria, 16-74
  ATP Detail, 16-77, 16-78
  Comparing Exceptions, 10-42
  Customer Information, 17-15
  Data Pull Parameters, 4-13
  Define Priority Rule, 5-48
  Exception Details, 10-37
  Exception Details for Past Due Sales
    Orders, 9-28
  Find, 10-4, 10-56
  Firm Option, 10-65
  Gantt Chart, 10-53
  Horizontal Plan, 10-27, 17-51
  Item Details Worksheet, 10-76
  Item's Supply Chain bill, 10-46
  Items, 17-13
  Key Performance Indicators (KPIs), 10-20
  Key Performance Indicators (KPIs) trend
    chart, 10-22
  KPI bar chart (enlarged version), 10-21
  KPIs Summary Chart in the Planner
    Workbench, 17-48
  Main tab, 5-22
  Material Plan tab, 10-14
  Multiple Plans Comparison, 7-13
  ODS Load Parameters, 4-15
  Online Planner Status, 7-6
  Oracle ASCP Key Performance Indicators, 9-3
  Oracle Risk Optimization Key Performance
    Indicators, 9-4
  Order Promising Workbench, 16-76
  Organization Parameters, 17-16
  Organizations tab, 5-28
  Organizations tab (setting demand
    variability), 17-35
  Pegging, 12-21
  Pegging tree, 10-44
  Plan Options, Options tab, 5-6
  Planner Workbench, 10-2
  Planner Workbench Actions tab, 9-17
  Planner Workbench Sourcing Rule, 9-36
  Planning Detail Report, 10-73
  Preferences, 12-15
  Properties, 10-8
  Property window, 10-58
  Releasing Recommendations, 10-49
  Reschedule, 10-63
  Resource Availability, 10-35, 10-67
  Resource Availability Summary, 10-66, 17-53
  Resource Tool Tip, 10-59
  Resources, 10-33, 17-52
  Resources Requirements, 10-34
  Schedule, 4-17
  SCP Names, 5-5
  Select Resources, 10-60
  Setting KPI Target Levels in Oracle BIS, 9-8
  Sort Table, 10-77
  SRO Names, 17-8
  Subinventory Netting, 5-36
  Supplier Capacity, 6-8
  Supplier Capacity Adjustment, 9-23
  Supplier Flexfences, 6-9
  Supplier Item Attributes, 6-7
  Supplier Variability, 17-43
  Supply/Demand, 17-49
  Time Buckets, 10-61
  Undo Detail, 7-11
  Undo Summary, 7-10
  Vertical Plan, 10-26
  Vertical Plan Worksheet, 10-78
  Where Used Information for an End Item, 10-47
  WIP mass/load PO requisitions interface, 12-18
  workflow enabled exceptions, 13-5
Index-22

workflow for end-item-level substitution for Oracle Global Order Promising, 18-66
workflow for planning and edit-item-level substitution, 18-40
workflow process details, 13-8
workflow process summary, 13-6
workflow setup steps, 13-17
workflows
  See also Oracle Workflow, 3-9
  See Oracle Workflow, 12-18
worksheets
  Planning Detail Report, 10-72